Legal Notices

Document and Software Copyrights
Copyright © 1998-2016 by ShoreTel Inc., Sunnyvale, California, USA. All rights reserved.
Printed in the United States of America. Contents of this publication may not be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without prior written authorization of ShoreTel, Inc. ShoreTel, Inc. reserves the right to make changes without notice to the specifications and materials contained herein and shall not be responsible for any damage (including consequential) caused by reliance on the materials presented, including, but not limited to typographical, arithmetic or listing errors.

Trademarks
ShoreTel, ShoreTel (and logo), Brilliantly Simple, Brilliantly Simple Communication, ShoreGear, ShorePhone, and ShoreWare are registered trademarks of ShoreTel, Inc. in the United States and/or other countries. The ShoreTel logo is a trademark of ShoreTel, Inc. in the United States and/or other countries.
All other copyrights and trademarks herein are the property of their respective owners.

Patents
ShoreTel products are covered by patents as listed at http://www.shoretel.com/about/patents.html.

Version Information
System Administration Guide
Document Part Number: 800-1843-01
Version: SAG_1_11/24/16
Date: November 24, 2016

Company Information
ShoreTel, Inc.
960 Stewart Drive
Sunnyvale, California 94085 USA
+1.408.331.3300
+1.408.331.3333 (fax)
www.shoretel.com
# Table of Contents

## Preface
- Objectives of this Book .................................................. 19
- Audience for this Book .................................................. 19
- Organization of this Book .................................................. 19
- Documentation Overview .................................................. 19
  - System Documentation .................................................. 20
  - Hardware Documentation ............................................... 20
  - User Documentation ................................................... 20
  - Release Notes ............................................................ 20
  - Online Knowledge Base ................................................. 20
- Document Conventions .................................................... 21

## Chapter 1 Using ShoreTel Director ....................................... 23
- Introduction to ShoreTel Director ...................................... 24
- Architectural Overview .................................................. 24
  - Multi-level Management ............................................... 24
  - Multi-user Management ................................................ 24
- Starting ShoreTel Director ................................................ 25
- ShoreTel Director Components ........................................ 25
  - Navigation Frame ....................................................... 26
  - Data Pages .................................................................... 26
  - List Pages ..................................................................... 26
  - Edit Pages .................................................................... 26
  - Diagnostics & Monitoring ................................................. 27
  - Getting Help .................................................................. 27
  - Preferences ................................................................... 27
- Product Registration ........................................................ 29
  - Information Collected through Product Registration .............. 29
  - Registration Process ..................................................... 30
  - Requesting the ShoreTel Software License Key ..................... 33
  - Installing the License .................................................... 35
- Getting Started with System Configuration ........................... 36
- External Telephone Number Formatting ................................ 39

## Chapter 2 Setting Up System Parameters ............................. 41
- Setting Dial Plan Parameters ............................................. 43
**Table of Contents**

**Chapter 4 Configuring Application Servers**

- Setting the String Parameters Used in Your Dial Plan ........................................ 43
- Increasing the Extension Length ................................................................. 46
- Creating a Digit Translation Table ............................................................... 48
- General Details on Digit Translation Tables ..................................................... 49
- Creating Digit Translation Tables ................................................................. 49
- Deleting Translation Tables ............................................................................. 50
- Security ............................................................................................................. 51
  - Specifying the Port Range for a Service Appliance ...................................... 51
  - Specifying a Range of Trusted IP Addresses ................................................. 52
- System Extensions .......................................................................................... 53
  - SNMP ............................................................................................................ 55
    - Enabling SNMP for Your ShoreTel System ................................................... 55
- Other Parameters ............................................................................................. 56
  - Accessing the Parameters in the Other Page .................................................. 56
- Client Compatibility ......................................................................................... 60
  - Implementing Client Compatibility ................................................................. 61
- Languages ....................................................................................................... 62
  - Specifying the Languages That Are Available to the System ....................... 62
- Licenses ........................................................................................................... 63
  - Viewing Your ShoreTel Licenses in ShoreTel Director ................................. 63
  - Compliance ................................................................................................... 63
  - Registering the ShoreTel Software ................................................................. 64
  - Installing License Keys .................................................................................. 65
  - Keyed License Types ...................................................................................... 66
  - Extension and Mailbox Licenses ................................................................... 68
  - Self-Audited Licenses ...................................................................................... 70
  - Sending Contact Information ....................................................................... 70
- Administrative Permissions ............................................................................... 71
  - Parameters ..................................................................................................... 72
  - Assigning an Administrative Role to a User .................................................... 75

**Chapter 3**

**ShoreTel Sites** ................................................................................................. 77

- Overview ........................................................................................................... 78
- Creating a Site ................................................................................................... 78
- Parameters ........................................................................................................ 80
- Using ShoreTel Service Appliances as a Back-up Resource ............................ 85
  - Registering a Service Appliance that is Off the Headquarters Site .................. 86
  - Creating a System Failover Mechanism for Conferencing ............................ 86

**Chapter 4**

**Configuring Application Servers** ................................................................ 89

- Overview ........................................................................................................... 90
- Distributed Voice Mail ....................................................................................... 90
  - IP Phone Limitations/Requirements ............................................................. 91
  - Communicator Limitations/Requirements ..................................................... 92
- Legacy Voice Mail Integration ........................................................................... 92
  - Integration through Simplified Message Desk Interface .............................. 92
  - Integration through Q-Signaling Protocols .................................................... 93
- Configuring Application Servers ...................................................................... 95
  - Adding Application Servers ......................................................................... 95
Chapter 7 Configuring Trunks

Overview .................................................. 167
Setting Up Trunk Groups ................................ 167
  Adding or Editing a Trunk Group ...................... 168
  Importing Local Prefixes ............................ 177
  Exporting a Local Prefix List ....................... 178
  DID Ranges ............................................ 178
  Editing the DNIS Digit Map ......................... 180
  Adding Local Area Codes ............................ 181
  Configuring Nearby Area Codes ..................... 181
  Configuring Prefix Exceptions ....................... 181
  Configuring Off-System Extensions ................. 181
  Configuring Tandem Trunking ....................... 181
  Configuring Centrex Flash .......................... 182
  Configuring Pause in Dialing – Trunk Access ....... 183

Individual Trunks ........................................ 184
  Adding or Editing a Trunk ............................ 185
  Forwarding Original Caller ID Outside a ShoreTel Network ...... 187
    When Carriers Validate the Caller ID ............ 187
    When a Carrier Does Not Validate the Caller ID .... 187
    Purpose of the Billing Telephone Number for Caller ID ....... 188
    Important Issue with Early Implementations of Original Caller ID ........ 190
    Enabling the Original Caller Information .......... 190

Introduction to ISDN Profiles ......................... 191
Caller ID Name on T1-PRI Trunks ..................... 192
  Caller ID Name with the Public Network ............. 192
  Implementing Caller ID Name on T1-PRI .............. 194
  Creating and Applying an ISDN Profile for CID Name ...... 195
  Specifying a 20-Digit SETUP Message for PRI or BRI .... 198

Euro-ISDN Channel Negotiation ....................... 200
ISDN Channel Negotiation ............................. 200
Chapter 8 Configuring IP Phones ................................................. 209

Overview ................................................................. 211
Prerequisites ............................................................ 211
IP Phone Configuration Overview .................................. 211
Configuring System Settings for IP Phones ................. 211
Call Continuation During Failover ............................. 214
Adding IP Phones to the System ................................. 215
Adding IP Phone Users ............................................. 216
Adding Anonymous Phones ..................................... 217
Viewing and Editing IP Phones on the System .......... 218
  Viewing IP Phones .................................................. 218
  Renaming an IP Phone ......................................... 219
  Deleting an IP Phone from ShoreTel Director .......... 220
  Moving an IP Phone to a Different Voice Switch .... 220
  IP Phone State Display ......................................... 221
  Displaying ShoreTel IP Phone Settings ................. 222
  Resetting a ShoreTel IP Phone .............................. 223
Customizing Ringtones .............................................. 223
  Loading Custom Ringtones Through ShoreTel Director 224
  Loading Custom Ringtones Through a Custom Configuration File 225
Customizing Wallpaper on Color Phone Displays ........... 227
  For ShoreTel IP485g and IP655 Phones .................. 227
  For ShoreTel IP265 and IP565g Phones .................. 230
Specifying Custom Applications for User Groups ............ 232
Automatic Off-Hook and Headset Preferences ............... 233
Specifying Automatic Off-Hook for Wireless Headsets .... 233
Configuring Programmable IP Phone Buttons ................. 234
  Configuring Programmable Buttons through ShoreTel Director 237
  Copying Programmable Button Configurations .......... 237
  Enabling a User to Program Buttons on a ShoreTel IP Phone 238
  Customizing Buttons on a Phone or BB24 via the Telephone Interface 239
Configuring a Hotline Button ....................................... 239
Implementing Malicious Call Trace ............................... 240
  Configuring a Programmable Button for MCT .......... 240
  Initiating a Malicious Call Trace ......................... 241
  Considerations for Using Malicious Call Trace ....... 242
Configuring VPN Phones ............................................. 243
  Description ......................................................... 243
  Implementation .................................................... 245
Configuring Simultaneous Ringing and Call Move .......... 248
  Implementing Simultaneous Ringing ....................... 249
  Disabling/Enabling Additional Phones ..................... 250
## Chapter 9 Setting Call Control Options

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Codes</td>
<td>255</td>
</tr>
<tr>
<td>Account Code Collection</td>
<td>256</td>
</tr>
<tr>
<td>Adding and Editing Account Codes</td>
<td>257</td>
</tr>
<tr>
<td>Multi-site Account Codes</td>
<td>258</td>
</tr>
<tr>
<td>Implementation</td>
<td>258</td>
</tr>
<tr>
<td>Usage</td>
<td>258</td>
</tr>
<tr>
<td>Configuring Multi-site Account Codes</td>
<td>259</td>
</tr>
<tr>
<td>Bridged Call Appearances</td>
<td>263</td>
</tr>
<tr>
<td>Example BCA Scenario</td>
<td>263</td>
</tr>
<tr>
<td>Switch Support for Bridged Call Appearances</td>
<td>264</td>
</tr>
<tr>
<td>Configuring BCA Parameters</td>
<td>264</td>
</tr>
<tr>
<td>Configuring Answer Options on an IP Phone</td>
<td>266</td>
</tr>
<tr>
<td>Bridged Call Appearance Conferencing</td>
<td>268</td>
</tr>
<tr>
<td>Answering and Joining the BCA Call</td>
<td>270</td>
</tr>
<tr>
<td>Setting Up Conferencing Ability for BCA and SCA Users</td>
<td>271</td>
</tr>
<tr>
<td>Shared Call Appearance</td>
<td>275</td>
</tr>
<tr>
<td>SCA Feature Components</td>
<td>275</td>
</tr>
<tr>
<td>Enabling a User for SCA</td>
<td>276</td>
</tr>
<tr>
<td>Creating an Assistant Account</td>
<td>279</td>
</tr>
<tr>
<td>Usage Guidelines for SCA</td>
<td>281</td>
</tr>
<tr>
<td>Inbound and Outbound SCA Calls</td>
<td>282</td>
</tr>
<tr>
<td>Blind Conferencing and the SCA User</td>
<td>283</td>
</tr>
<tr>
<td>Silent Coach</td>
<td>284</td>
</tr>
<tr>
<td>Operational Behaviors of the Silent Coach Feature</td>
<td>284</td>
</tr>
<tr>
<td>Configuring Silent Coach Permissions</td>
<td>285</td>
</tr>
<tr>
<td>Enabling the Silent Coach Warning Tone</td>
<td>285</td>
</tr>
<tr>
<td>Configuring Silent Coach Buttons</td>
<td>286</td>
</tr>
<tr>
<td>Performing Silent Coach Operations</td>
<td>287</td>
</tr>
<tr>
<td>Hunt Groups</td>
<td>289</td>
</tr>
<tr>
<td>Setting the Hunt Group to Busy</td>
<td>293</td>
</tr>
<tr>
<td>Music on Hold</td>
<td>293</td>
</tr>
<tr>
<td>Adding a Music on Hold Resource</td>
<td>293</td>
</tr>
<tr>
<td>Editing a Music on Hold Resource</td>
<td>294</td>
</tr>
<tr>
<td>Deleting a Music on Hold Resource</td>
<td>294</td>
</tr>
<tr>
<td>Playing a Music on Hold Resource</td>
<td>294</td>
</tr>
<tr>
<td>Paging Groups</td>
<td>295</td>
</tr>
<tr>
<td>Adding Overhead Paging to Paging Groups</td>
<td>296</td>
</tr>
<tr>
<td>Configuration</td>
<td>296</td>
</tr>
<tr>
<td>Multi-site Paging Groups</td>
<td>298</td>
</tr>
<tr>
<td>Paging Groups Operation</td>
<td>299</td>
</tr>
<tr>
<td>Configuring Paging Groups</td>
<td>300</td>
</tr>
<tr>
<td>Priority Group Paging</td>
<td>301</td>
</tr>
<tr>
<td>Pickup Groups</td>
<td>303</td>
</tr>
<tr>
<td>Configuring Pickup Groups</td>
<td>304</td>
</tr>
<tr>
<td>Route Points</td>
<td>306</td>
</tr>
<tr>
<td>Parameters</td>
<td>307</td>
</tr>
<tr>
<td>Call Control Options</td>
<td>310</td>
</tr>
<tr>
<td>Distributed Routing Service</td>
<td>310</td>
</tr>
</tbody>
</table>
# Table of Contents

**Chapter 10** Configuring Users .............................................. 335  
Overview ................................................................. 337  
Specifying a Class of Service ................................................. 337  
Configuring a COS ......................................................... 337  
Telephony Features Permissions .............................................. 338  
Call Permissions ........................................................... 345  
Voice Mail Permissions ....................................................... 348  
Configuring User Groups ....................................................... 351  
Viewing User Groups ........................................................... 351  
Creating a User Group ......................................................... 352  
Configuring a User Account ..................................................... 354  
Using the Individual Users Page .............................................. 354  
Configuring Users .............................................................. 356  
Voice Mail Password Recommendations ..................................... 368  
System Directory Record ............................................................ 368  
Configuring Active Directory ..................................................... 369  
Active Directory Implementation .................................................. 369  
Enabling AD Integration on a ShoreTel System .................................. 369  
Configuring Active Directory on a New System ................................ 370  
Synchronizing AD and Director User Records ................................ 375  
Bulk Provisioning of User Accounts ........................................... 376  
User Management Utilities ....................................................... 378  
User Import Tool ............................................................... 378  
Batch Update Utility ............................................................ 383  
Notify Users ................................................................. 386  
Extension Lists ................................................................. 387  

**Chapter 11** Configuring Client Applications .............................. 389  
ShoreTel Communicator for Windows ......................................... 391  
Installing ShoreTel Communicator .......................................... 391  
Configuring for Instant Messaging ............................................. 394  
Presence ........................................................................ 396  
Setting the Maximum Contact List Size ..................................... 398  
Enabling SoftPhone for Users .................................................... 399
# Table of Contents

## Chapter 12 Configuring User Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private Numbers</td>
<td>444</td>
</tr>
<tr>
<td>Configuring Call History Privacy</td>
<td>445</td>
</tr>
<tr>
<td>Using Extension Assignment</td>
<td>446</td>
</tr>
<tr>
<td>Special Considerations</td>
<td>447</td>
</tr>
<tr>
<td>Configuring Permission Settings</td>
<td>448</td>
</tr>
<tr>
<td>Configuring Extension Assignment</td>
<td>449</td>
</tr>
<tr>
<td>Configuring On-Network Extension Assignment</td>
<td>450</td>
</tr>
<tr>
<td>Inbound Call Management</td>
<td>451</td>
</tr>
<tr>
<td>Find Me</td>
<td>451</td>
</tr>
<tr>
<td>Automated Call Handling</td>
<td>455</td>
</tr>
<tr>
<td>Personalized Call Handling</td>
<td>460</td>
</tr>
<tr>
<td>Call Intervention Methods</td>
<td>465</td>
</tr>
<tr>
<td>Whisper Page</td>
<td>465</td>
</tr>
<tr>
<td>Monitoring Extensions from an IP Phone</td>
<td>467</td>
</tr>
<tr>
<td>Call Handling Mode Delegation</td>
<td>471</td>
</tr>
<tr>
<td>Intercom, Whisper Paging, Barge In, Record, and Monitor</td>
<td>473</td>
</tr>
</tbody>
</table>

## Chapter 13 Configuring Voice Mail

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Distribution Lists</td>
<td>478</td>
</tr>
<tr>
<td>AMIS Voice Mail</td>
<td>480</td>
</tr>
<tr>
<td>AMIS Restrictions</td>
<td>481</td>
</tr>
<tr>
<td>Enabling AMIS</td>
<td>482</td>
</tr>
<tr>
<td>Creating AMIS Systems</td>
<td>483</td>
</tr>
<tr>
<td>Disabling AMIS Systems</td>
<td>485</td>
</tr>
<tr>
<td>Chapter 14</td>
<td>Configuring the Auto Attendant</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Overview</td>
<td></td>
</tr>
<tr>
<td>Multiple Auto Attendants</td>
<td></td>
</tr>
<tr>
<td>Menus</td>
<td>Adding and Editing an Auto-Attendant Menu</td>
</tr>
<tr>
<td></td>
<td>Configuring an Auto-Attendant Menu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 15</th>
<th>Configuring Schedules</th>
<th>519</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td></td>
<td>520</td>
</tr>
<tr>
<td>Accessing the Scheduling Page</td>
<td></td>
<td>520</td>
</tr>
<tr>
<td>Configuring the On-Hours Schedule</td>
<td></td>
<td>521</td>
</tr>
<tr>
<td>Holiday Schedule</td>
<td>Configuring the Holiday Schedule</td>
<td>524</td>
</tr>
<tr>
<td>Custom Schedule</td>
<td>Configuring a Custom Schedule</td>
<td>525</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 16</th>
<th>Configuring Workgroups</th>
<th>527</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td></td>
<td>528</td>
</tr>
<tr>
<td>Call Routing for Workgroups</td>
<td></td>
<td>528</td>
</tr>
<tr>
<td>Call Distribution</td>
<td></td>
<td>528</td>
</tr>
<tr>
<td>Call Queuing</td>
<td></td>
<td>529</td>
</tr>
<tr>
<td>Workgroup Communicator</td>
<td></td>
<td>530</td>
</tr>
<tr>
<td>Reporting on Workgroups</td>
<td></td>
<td>531</td>
</tr>
<tr>
<td>Workgroup Description</td>
<td></td>
<td>531</td>
</tr>
<tr>
<td>Workgroups List Page</td>
<td></td>
<td>532</td>
</tr>
<tr>
<td>The Workgroup Configuration Parameters</td>
<td></td>
<td>533</td>
</tr>
<tr>
<td>Selecting a DNIS Trunk Group for DNIS Routing</td>
<td></td>
<td>540</td>
</tr>
<tr>
<td>Editing Workgroup Membership</td>
<td></td>
<td>541</td>
</tr>
<tr>
<td>Navigating the Workgroup Membership Edit Page</td>
<td></td>
<td>542</td>
</tr>
<tr>
<td>Adding or Removing an Agent from a Workgroup</td>
<td></td>
<td>542</td>
</tr>
<tr>
<td>Changing the Member Position to Affect Selection</td>
<td></td>
<td>543</td>
</tr>
<tr>
<td>Changing an Agent's Status or Access License</td>
<td></td>
<td>543</td>
</tr>
<tr>
<td>Configuring the Behavior of the Call Queue</td>
<td></td>
<td>544</td>
</tr>
<tr>
<td>Introduction to Specifying the Call Queue</td>
<td></td>
<td>544</td>
</tr>
<tr>
<td>Definitions of Call Queue Parameters</td>
<td></td>
<td>546</td>
</tr>
</tbody>
</table>

| Setting Voice Mail User Group Permissions | 486 |
| AMIS Test Mailbox                          | 486 |
| Delivery and Notification                  | 486 |
| Escalation Profiles and Other Mailbox Options | 487 |
| Voice Mail Reports                         | 496 |
| Summary Report                             | 496 |
| Server Report                              | 497 |
| Voice Mail Synchronization with Gmail for Business | 500 |
| Background                                 | 500 |
| Voice Mail Synchronization Terms           | 500 |
| Behavioral Details                         | 501 |
| Configuration                              | 504 |
# Table of Contents

**Chapter 17 Managing the System Directory** ................................................. 567

- System Directory .................................................................................. 568
- Adding an Off-system Directory Entry ................................................... 569
- Go to This User Link ............................................................................. 571

**Chapter 18 Session Initiation Protocol** ..................................................... 573

- Overview .............................................................................................. 575
- Introduction to SIP Profiles ................................................................... 575
  - Current and Legacy Support for SIP Functions .................................. 575
  - A Note about SIP Profiles for Interoperability ................................. 576
- Operational Behaviors of ShoreTel SIP Trunks ...................................... 576
  - Resource Allocation on a Switch ....................................................... 577
  - Conferencing and SIP Trunks ........................................................... 577
  - Dual Tone Multi-frequency Support ................................................. 578
  - Extension Assignment over SIP Trunks ............................................ 578
  - General SIP Feature Consideration ................................................. 578
  - Digit Translation across SIP Trunks .................................................. 579
- Setting Up SIP Trunks on Voice Switches .............................................. 579
  - Configuring SIP Trunks ...................................................................... 580
  - Creating a SIP Trunk Group ............................................................. 584
  - Creating a SIP Trunk .......................................................................... 591
  - SIP Trunk Profiles ............................................................................ 593
- Setting Up 3rd-Party SIP Phones and ATAs ............................................ 602
  - Network Elements ............................................................................ 602
  - Supporting SIP Devices ..................................................................... 603
  - User Features ...................................................................................... 605
  - System Features ................................................................................ 608
  - User Assignment ................................................................................ 609
  - Configuring SIP Extensions ............................................................. 610
- Integrating ShoreTel SIP with Unified Messaging from Third-party Vendors ........................................... 619
  - Considerations for Integrating with Third-party UM ......................... 619
  - Configuring a ShoreTel SIP Unified Messaging Server ..................... 620

**Chapter 19 Maintenance** ......................................................................... 627

- Overview of System Maintenance Tasks ................................................. 629
- Viewing System Information with Quick Look ...................................... 629
  - Opening the Quick Look Page ......................................................... 630
  - Switch Information in Quick Look ................................................... 630
  - Server and Appliance Information in Quick Look ............................ 630
  - Conferencing Information in Quick Look ........................................ 631
  - Applying Commands in Quick Look ................................................ 632
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing System Status with the Dashboard</td>
<td>669</td>
</tr>
<tr>
<td>Selecting the Time Period</td>
<td>669</td>
</tr>
<tr>
<td>Call Volume</td>
<td>670</td>
</tr>
<tr>
<td>Call Quality</td>
<td>671</td>
</tr>
<tr>
<td>Bandwidth Utilization</td>
<td>672</td>
</tr>
<tr>
<td>Highest Trunk Group Usage</td>
<td>673</td>
</tr>
<tr>
<td>Highest Feature Usage</td>
<td>674</td>
</tr>
<tr>
<td>Highest Average CPU Usage</td>
<td>675</td>
</tr>
<tr>
<td>Viewing the Topology of Your System</td>
<td>676</td>
</tr>
<tr>
<td>Navigating the Topology Map</td>
<td>681</td>
</tr>
<tr>
<td>Viewing System Topology</td>
<td>682</td>
</tr>
<tr>
<td>Viewing Site Topology</td>
<td>683</td>
</tr>
<tr>
<td>Viewing Site Connectivity</td>
<td>684</td>
</tr>
<tr>
<td>Viewing Server Connectivity</td>
<td>685</td>
</tr>
<tr>
<td>Viewing Switch Connectivity</td>
<td>685</td>
</tr>
<tr>
<td>Monitoring the Status of ShoreTel Components</td>
<td>686</td>
</tr>
<tr>
<td>Monitoring System Status</td>
<td>686</td>
</tr>
<tr>
<td>Monitoring Site Status</td>
<td>690</td>
</tr>
<tr>
<td>Monitoring Switch Status</td>
<td>693</td>
</tr>
<tr>
<td>Monitoring Server Status</td>
<td>707</td>
</tr>
<tr>
<td>Monitoring IP Phone Status</td>
<td>714</td>
</tr>
<tr>
<td>Monitoring Trunk Group Status</td>
<td>717</td>
</tr>
<tr>
<td>Monitoring Voice Mail Status</td>
<td>719</td>
</tr>
<tr>
<td>Monitoring Make Me Conferencing Status</td>
<td>721</td>
</tr>
<tr>
<td>Monitoring Audio/Web Conferencing Status</td>
<td>722</td>
</tr>
<tr>
<td>Monitoring IM Status</td>
<td>723</td>
</tr>
<tr>
<td>Monitoring Connect Sync Status</td>
<td>724</td>
</tr>
<tr>
<td>Monitoring Alerts</td>
<td>724</td>
</tr>
<tr>
<td>Clearing Alerts</td>
<td>725</td>
</tr>
<tr>
<td>Monitoring Call Quality</td>
<td>726</td>
</tr>
<tr>
<td>Aspects of Call Quality</td>
<td>726</td>
</tr>
<tr>
<td>Call Quality Page</td>
<td>727</td>
</tr>
<tr>
<td>Viewing High-Level Call Quality</td>
<td>729</td>
</tr>
<tr>
<td>Viewing Call Quality Details for a Particular Call</td>
<td>729</td>
</tr>
<tr>
<td>Finding All Recent Calls for a Site</td>
<td>730</td>
</tr>
<tr>
<td>Finding Calls for a Particular User and Time Range</td>
<td>730</td>
</tr>
<tr>
<td>Sorting Calls Using the Call Quality Indicator</td>
<td>731</td>
</tr>
<tr>
<td>Diagnosing Switch or Phone Problems through Remote Packet Capture</td>
<td>731</td>
</tr>
<tr>
<td>Remote Packet Capture List Pane</td>
<td>732</td>
</tr>
<tr>
<td>Starting Remote Packet Capture</td>
<td>734</td>
</tr>
<tr>
<td>Stopping Remote Packet Capture</td>
<td>735</td>
</tr>
<tr>
<td>Viewing Remote Packet Capture Log Files</td>
<td>736</td>
</tr>
<tr>
<td>Viewing System Topology</td>
<td>669</td>
</tr>
<tr>
<td>Selecting the Time Period</td>
<td>669</td>
</tr>
<tr>
<td>Call Volume</td>
<td>670</td>
</tr>
<tr>
<td>Call Quality</td>
<td>671</td>
</tr>
<tr>
<td>Bandwidth Utilization</td>
<td>672</td>
</tr>
<tr>
<td>Highest Trunk Group Usage</td>
<td>673</td>
</tr>
<tr>
<td>Highest Feature Usage</td>
<td>674</td>
</tr>
<tr>
<td>Highest Average CPU Usage</td>
<td>675</td>
</tr>
<tr>
<td>Viewing the Topology of Your System</td>
<td>676</td>
</tr>
<tr>
<td>Navigating the Topology Map</td>
<td>681</td>
</tr>
<tr>
<td>Viewing System Topology</td>
<td>682</td>
</tr>
<tr>
<td>Viewing Site Topology</td>
<td>683</td>
</tr>
<tr>
<td>Viewing Site Connectivity</td>
<td>684</td>
</tr>
<tr>
<td>Viewing Server Connectivity</td>
<td>685</td>
</tr>
<tr>
<td>Viewing Switch Connectivity</td>
<td>685</td>
</tr>
<tr>
<td>Monitoring the Status of ShoreTel Components</td>
<td>686</td>
</tr>
<tr>
<td>Monitoring System Status</td>
<td>686</td>
</tr>
<tr>
<td>Monitoring Site Status</td>
<td>690</td>
</tr>
<tr>
<td>Monitoring Switch Status</td>
<td>693</td>
</tr>
<tr>
<td>Monitoring Server Status</td>
<td>707</td>
</tr>
<tr>
<td>Monitoring IP Phone Status</td>
<td>714</td>
</tr>
<tr>
<td>Monitoring Trunk Group Status</td>
<td>717</td>
</tr>
<tr>
<td>Monitoring Voice Mail Status</td>
<td>719</td>
</tr>
<tr>
<td>Monitoring Make Me Conferencing Status</td>
<td>721</td>
</tr>
<tr>
<td>Monitoring Audio/Web Conferencing Status</td>
<td>722</td>
</tr>
<tr>
<td>Monitoring IM Status</td>
<td>723</td>
</tr>
<tr>
<td>Monitoring Connect Sync Status</td>
<td>724</td>
</tr>
<tr>
<td>Monitoring Alerts</td>
<td>724</td>
</tr>
<tr>
<td>Clearing Alerts</td>
<td>725</td>
</tr>
<tr>
<td>Monitoring Call Quality</td>
<td>726</td>
</tr>
<tr>
<td>Aspects of Call Quality</td>
<td>726</td>
</tr>
<tr>
<td>Call Quality Page</td>
<td>727</td>
</tr>
<tr>
<td>Viewing High-Level Call Quality</td>
<td>729</td>
</tr>
<tr>
<td>Viewing Call Quality Details for a Particular Call</td>
<td>729</td>
</tr>
<tr>
<td>Finding All Recent Calls for a Site</td>
<td>730</td>
</tr>
<tr>
<td>Finding Calls for a Particular User and Time Range</td>
<td>730</td>
</tr>
<tr>
<td>Sorting Calls Using the Call Quality Indicator</td>
<td>731</td>
</tr>
<tr>
<td>Diagnosing Switch or Phone Problems through Remote Packet Capture</td>
<td>731</td>
</tr>
<tr>
<td>Remote Packet Capture List Pane</td>
<td>732</td>
</tr>
<tr>
<td>Starting Remote Packet Capture</td>
<td>734</td>
</tr>
<tr>
<td>Stopping Remote Packet Capture</td>
<td>735</td>
</tr>
<tr>
<td>Viewing Remote Packet Capture Log Files</td>
<td>736</td>
</tr>
</tbody>
</table>

## Chapter 21 System Backup and Restore ............................................ 739

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>741</td>
</tr>
<tr>
<td>Introduction to Backup and Restore</td>
<td>741</td>
</tr>
<tr>
<td>Estimated Backup and Restore Times</td>
<td>742</td>
</tr>
<tr>
<td>Backup Strategy</td>
<td>743</td>
</tr>
<tr>
<td>Restoration</td>
<td>743</td>
</tr>
<tr>
<td>Configuring the Backup and Restore Scripts</td>
<td>744</td>
</tr>
<tr>
<td>Configuring the Headquarters Server or DVS to Back Up Files</td>
<td>744</td>
</tr>
</tbody>
</table>
# Table of Contents

- **CDR Database** ............................................. 856
  - Creating a CDR Archive Database ............................. 857
  - Call Table .................................................. 857
  - Enumeration Tables: Use for the Call Table .................. 860
- **Connect Table** ............................................. 860
  - Connect Table Field Descriptions ............................ 861
  - Enumeration Tables Used for Connect Table .................. 864
- **MediaStream Table** .......................................... 867
- **AgentActivity Table** ......................................... 869
  - Enumeration Tables Used for AgentActivity .................. 871
- **QueueCall Table** ............................................ 871
  - Enumeration Tables Used for QueueCall ....................... 874
- **QueueStep Table** ............................................. 875
- **Web Tables** .................................................. 876
  - Audio Only Conference ....................................... 876
  - Web Only Conference ......................................... 876
  - Audio & Web Conference ...................................... 876
  - Web Session Table ........................................... 876
  - Web Attendee Table ........................................... 877

**Appendix C**  **Centralized Dial Number (DN)** .................. 879
Preface

This preface provides information about the objectives, organization, and conventions of the ShoreTel System Administration Guide.

Objectives of this Book

This guide explains how to use ShoreTel Director to configure, administer, and maintain the ShoreTel system.

The planning and installation procedures are described in the Planning and Installation Guide for ShoreTel 14.1.

Audience for this Book

This guide is written for the person who uses ShoreTel Director to administer and maintain the ShoreTel system.

Organization of this Book

This guide's organization reflects the order of the ShoreTel system's initial configuration.

The Getting Started section in the next chapter provides an ordered checklist to use on the first time you configure the system.

Documentation Overview

The ShoreTel system is documented as described in the following sections.
System Documentation

The following system documents are in the documentation folder on the ShoreTel USB flash drive and can also be accessed from ShoreTel Director:

- The *Planning and Installation Guide* provides information on how to plan the implementation of the ShoreTel system, as well as how to install the necessary hardware, data communications, and telecommunications elements.

- The *System Administration Guide* (this guide) provides detailed information on how to administer and maintain the ShoreTel system using ShoreTel Director. This includes task-based information, as well as screen-by-screen information regarding ShoreTel Director.

Hardware Documentation

The following hardware installation documents are packaged with their associated ShoreTel voice switch or ShoreTel IP phone and appliances:

- *ShoreTel Voice Switch Quick Install Guide*
- *ShoreTel IP Phone Quick Install Guide*
- *Conferencing and Instant Messaging Planning and Installation Guide*

If the system includes the ShoreTel Enterprise Contact Center Solution, refer to the *ShoreTel Enterprise Contact Center Solution Administration Guide* and the *ShoreTel Enterprise Contact Center Solution Planning and Installation Guide*.

User Documentation

End-user documentation is installed during the ShoreTel Communicator installation. To access it, choose the **Help > Contents and Index** menu item within the ShoreTel Communicator application.

The *Telephone User Interface Analog Quick Reference* and the *Telephone User Interface IP Phone Quick Reference* are available from the ShoreTel website, as well as from ShoreTel Director.

Release Notes

The *Software Release Notes* provide information about new releases and new features as well as issues that relate to new installations and upgrades. This document resides in the documentation folder on the associated ShoreTel USB flash drive and can also be accessed from ShoreTel Director.

Online Knowledge Base

To access additional information or to resolve issues on ShoreTel Director, you can use the ShoreTel Technical Knowledgebase, accessible from the ShoreTel website at www.shoretel.com.
Document Conventions

The following conventions are used in this guide:

- Data-entry fields, hypertext links, control buttons, keywords, and other items within the system management interface are in a **boldface** font.

- Information that you enter in data fields are in a data_entry font.
CHAPTER 1

Using ShoreTel Director

This chapter describes how to use ShoreTel Director. The following topics are included:

- Introduction to ShoreTel Director ................................................................. 24
- Architectural Overview .................................................................................. 24
  - Multi-level Management ............................................................................. 24
  - Multi-user Management ............................................................................. 24
- Starting ShoreTel Director ............................................................................. 25
- ShoreTel Director Components ..................................................................... 25
  - Navigation Frame ....................................................................................... 26
  - Data Pages ................................................................................................. 26
  - List Pages .................................................................................................. 26
  - Edit Pages .................................................................................................. 26
  - Diagnostics & Monitoring ......................................................................... 27
  - Getting Help ............................................................................................... 27
  - Preferences ................................................................................................. 27
- Product Registration ....................................................................................... 29
  - Information Collected through Product Registration ................................. 29
  - Registration Process .................................................................................. 30
  - Requesting the ShoreTel Software License Key ......................................... 33
  - Installing the License ................................................................................ 35
- Getting Started with System Configuration ................................................... 36
- External Telephone Number Formatting ....................................................... 39
Introduction to ShoreTel Director

ShoreTel Director is a web-based administration and maintenance tool for managing a ShoreTel system from anywhere on an IP network. ShoreTel Director lets you manage all users, trunks, call control features, and voice applications (voice mail, call detail recording, automated attendant, workgroups, unified messaging, IM, and desktop call control).

Architectural Overview

The main ShoreTel server hosts the web site for ShoreTel Director using Microsoft Internet Information Server. When you launch a web browser and navigate to the ShoreTel Director web site, the server provides HTML web pages from which you can add to, delete from, and edit the configuration of the system. When you click Save, your change is sent to the server and saved in the ShoreTel database. All other system components are automatically and immediately notified and updated.

In addition to the configuration panels, ShoreTel Director has a maintenance interface for the ShoreTel system. When you navigate to a maintenance panel in ShoreTel Director, system status is displayed, and you can issue maintenance commands. The commands are passed to and executed by the server. If the network includes distributed ShoreTel remote servers, you can navigate from the main server to each distributed server through ShoreTel Director to view status and issue commands to the distributed server.

Multi-level Management

The ShoreTel system provides in-depth access levels to ShoreTel Director. System parameters for administrative permissions allow many administrative roles to be defined so as to provide only as much access to the system as each user requires. By default, the initial system administrator has access to everything on the system. However, by using the administrative permissions pages, you can define site administrators, directory list managers, read-only users, and more. Each user who needs to access ShoreTel Director can be assigned a level of permission tailored for his needs.

Multi-user Management

ShoreTel Director allows simultaneous access to ShoreTel Director by multiple users. To ensure data integrity, the database is locked during save transactions in ShoreTel Director. If another user tries to save changes while the database is locked, ShoreTel Director advises the user that the changes were not saved; the user simply needs to save the changes again.

Most changes to the database are completed within one second, so the probability of attempting to save while the database is locked is low.

If two users open the same record at the same time, the last save takes precedence because the system processes changes serially. If two users open the same record at the same time and the first user deletes the record, the second user receives an error message upon trying to save the record.
Starting ShoreTel Director

ShoreTel Director is a web application hosted on a ShoreTel server and accessed over the network. Before starting ShoreTel Director, you need the Uniform Resource Locator (URL) for ShoreTel Director, your user ID, and a password, supplied by your system administrator.

To start ShoreTel Director:

1. Launch a browser.
2. In the URL field, enter the following:
   
   \[http://<ShoreTel server name> | <IP address>/ShoreWareDirector\]

3. Click Go or press Enter.

4. In the Username field, type your user name or the default user name ("admin").

5. In the Password field, type your password or the default password ("changeme").

6. Click Login.

The system displays one of the following pages:

- When you log into a new system for the first time, the ShoreTel Director Welcome page appears.
- Upon subsequent logins, if the system is not registered the License Requirements page appears. For more information about registration, see Product Registration on page 29.

ShoreTel Director Components

ShoreTel Director is the administration interface for the ShoreTel system. This section briefly explains how to use ShoreTel Director.
Navigation Frame

The navigation frame is located on the left side of the ShoreTel Director page and provides access to the following information and menus:

- **Build**: Indicates the version of the ShoreTel system that you are running.
- **Logoff**: Lets you log out of the ShoreTel Director as the current user.

**Note**

You are automatically logged off after 60 minutes of inactivity unless you are viewing the Quick Look page, a Switch maintenance page, or the Call Details report page.

- **Administration**: Lets you configure the ShoreTel system.
- **Maintenance**: Lets you view status information about the components installed in your system.
- **Reporting**: Lets you run ShoreTel reports.
- **Documentation**: Lets you download ShoreTel product documentation.

Data Pages

Data pages display on the right side of the ShoreTel Director page. These pages let you add, delete, or edit system configuration parameters, view status, and issue commands. These pages are designed as list pages, edit pages, and maintenance pages.

The records on each list page are presented in a default sort order. Most pages allow you to change the sort order by clicking a column heading. Elements in the column are rearranged in ascending order only.

To assist enterprises with large amounts of data, several configuration pages offer searching and sorting of the data used in a pertinent field. For example, when selecting members of a hunt group, you can search for last names, extensions, and more. If more data is returned than fits the window, you can page up and down through the results. Hunt groups, extension lists, workgroup agents, and call handing delegation offer paging.

List Pages

List pages identify objects that are created in the system in the category that you have selected. These pages generally provide categorical information about the objects.

Edit Pages

To display for viewing or editing the profile of an object in a List page, click on the object. Principal list objects are shown in bold characters. Values used to define the principal object that are themselves configurable are underlined. You can click such values to view and edit their parameters.
The **New**, **Add new**, and **Go** links and **New** buttons allow you to add objects to the system configuration. Clicking the prompt may display a configuration page or a dialog box.

Edit pages let you view and edit object profiles. Edit pages have control buttons at the top of the page. **Table 1** on page 27 provides information about the control buttons. To activate these buttons, you must enter a value in any field. Some edit pages also have a bar with tabs that open additional configuration pages for the object. You must click **Save** to save your changes.

### Table 1: Control Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new object profile by using default values.</td>
</tr>
<tr>
<td>Copy</td>
<td>Creates a copy of the current object profile that you can use to create a new object profile. Some values, such as extension numbers, are automatically generated for the new profile.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the changes you make to the profile.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the current profile from the system.</td>
</tr>
<tr>
<td>Reset</td>
<td>Reverts to the last saved profile.</td>
</tr>
</tbody>
</table>

**Note**

Individual data-entry fields, drop-down lists, and option buttons are described in the appropriate sections throughout each chapter.

### Diagnostics & Monitoring

To get detailed status information about the components in your ShoreTel system, you can use the Diagnostics & Monitoring solution included in ShoreTel Director. You access the system through the link in the Maintenance section in the navigation pane. In addition to providing component status information, the Diagnostics & Monitoring system provides a system dashboard, a topology map, alerts, call quality information, and remote packet capture functionality.

### Getting Help

To get help that pertains to the page you are working on, you can press the F1 key or click the **Help** link in the data-entry frame, which provides access to the relevant chapter from this guide. From the navigation frame, you can access this complete guide, or other system documentation, by clicking the **Documentation** link to expand the list of guides.

### Preferences

ShoreTel Director saves certain preferences in cookies on the client PC for ease of use. The Preference page shown in **Figure 1** lets you configure some of these preferences, including the way to record auto-attendant prompts and certain default settings. To view this page, click Preferences under the Administration link in ShoreTel Director (described later in this chapter).
The selectable parameters in the Administrator’s Preference window are as follows:

- **The Play and Record Using area** lets you specify one of the following methods for recording and playing an auto-attendant prompt:
  - PC: This selection is for recording and playing a greeting through a microphone and PC loudspeaker. A sound card must exist in the computer for this option.
  - Telephone: Select to play and record by use of a telephone handset. For this option, **Call Number** must have the telephone number or extension the system can use to call you.

- **The Sorting Order area** lets you specify the default column used to sort users on the Individual Users page.

- **The “Add New” Defaults area** lets you set global default values that the system uses for creating new profiles. The parameters for which you can set values include:
  - User Group
  - Trunk Group
  - Trunk Group Type
  - Switch Type

For each parameter, click the field and select the value that you want to use from the drop-down list.
In addition to the preferences that are explicitly exposed, ShoreTel Director keeps other preferences as cookies and uses them to predict good defaults when it adds new records. The following information is also stored locally in cookies:

- Extension numbers
- DID numbers
- Sort order for every list page

Product Registration

After installing or upgrading, you must register the new ShoreTel software.

**Note**

If registration is not received by ShoreTel within 45 days of installation, access to Director is denied (Director is locked).

If you have previously submitted your contact information to ShoreTel, it gets automatically submitted during subsequent upgrades if the system is connected to the Internet.

Information Collected through Product Registration

When a customer performs an upgrade or performs a fresh install and requests license keys, the following information is collected through product registration:

- Contact information
- License key list:
  - features activated
  - features available for activation for each licensed feature
- Server MAC address
- Sales Order Number (for initial installations only)
- Switch inventory:
  - switch types
  - MAC addresses
  - serial numbers
- Installed software version information:
  - product name
  - build number
Registration Process

The software can be registered automatically, over the internet, or through email. When registering automatically or over the internet, registration data is transmitted to ShoreTel over a secure connection to ensure integrity and privacy.

The software is registered automatically for upgrades that meet the following prerequisites:

- Contact Information is saved in Director before starting the upgrade process.
- A valid ShoreTel system license key is installed before starting the upgrade process.
- Your system can connect through the internet to the ShoreTel support web site (https://support.shoretel.com).

For new installations or upgrades that do not meet these prerequisites, you are prompted to register the software the first time you launch Director after installing or upgrading. You can choose to register the software over the internet or through email.

Note
Registration over the internet is quicker than registration through email.

If an installation does not have adequate or current licenses, ShoreTel Director opens at the License Preview page when you have completed or skipped registration. See Requesting the ShoreTel Software License Key on page 33 for information.

Registering Automatically

1. Install or upgrade ShoreTel software.

2. Start up ShoreTel HQ Services and log in to ShoreTel Director.

   Registration information is sent over the internet to ShoreTel. Upon receipt, a response is sent. When the response is received, a Compliance Token is created on the Headquarters server, and Director is unlocked.
Registration Process Using ShoreTel Director

3. Confirm registration:
   a. Click Administration > System Parameters > Contact Information to navigate to the Contact Information page.
   b. Click Refresh this page.

      The Reminder Notification message is no longer posted.

If Registration is Not Received by ShoreTel

If registration information is not received by ShoreTel (for any reason), Director submits the information every hour for seven days after upgrading.

If the process is unsuccessful, you must submit the Contact Information again (over the internet or through email) as often as necessary until registration is completed.

If registration is not completed in 45 days, Director is locked.

Registering Over the Internet

1. Upgrade or install ShoreTel software, and launch Director.

2. Do one of the following to display the Contact Information page:
   - When prompted to register, click Now.
   - Click Administration > System Parameters > Contact Information.

3. Enter the requested information in the applicable fields.

   The Server MAC Address field is automatically populated with information from the ShoreTel Server. You should change this information only if you want a license for a server other than the one to which you are currently connected. If you have changed this information but instead want the defaults, click Refresh this page.

   The Sales Order Number is on the ShoreTel packing slip. (Supplying this information is optional for system upgrades.)

4. Click Now next to Register and request product verification.

   The License Preview page is displayed. See Requesting the ShoreTel Software License Key on page 33.

5. Click Submit.

   Registration information is sent over the internet to ShoreTel. Upon receipt, a response is sent. When the response is received, a Compliance Token is created on the Headquarters server, and Director is unlocked.
6. Confirm registration:
   a. Exit and then relaunch Director.
   b. Navigate to the Contact Information page.
   c. Click Refresh this page.
      The Reminder Notification message is no longer posted.

If Registration is Not Received by ShoreTel

If registration information is not received by ShoreTel (for any reason), Director submits the information periodically for seven days after installation.

If the process is unsuccessful, you must submit the Contact Information again (over the internet or through email) as often as necessary until registration is completed.

If registration is not completed in 45 days, Director is locked.

Registering by Email

1. Upgrade or install ShoreTel software, and launch Director.

2. Do one of the following to display the Contact Information page:
   - When prompted to register, click Now.
   - Click Administration > System Parameters > Contact Information.

3. Enter the requested information in the applicable fields.
   The Server MAC Address field is automatically populated with information from the ShoreTel Server. You should change this information only if you want a license for a server other than the one to which you are currently connected. If you have changed this information but instead want the defaults, click Refresh this page.
   The Sales Order Number is on the ShoreTel packing slip. (Supplying this information is optional for system upgrades.)

4. Click Now next to Register and request product verification.
   The License Preview page is displayed. See Requesting the ShoreTel Software License Key on page 33.

5. Click Save to File.
   Follow the steps required to save the (SLR) file on your desktop.
6. Email the SLR file to ShoreTel at licensekeyrequest@shoretel.com.

Upon receipt, a response is sent containing a compliance token granting access to Director. This token (or, license key) is associated with the Server MAC address and a System Build Number.

7. Verify the compliance token.
   a. Click Administration > System Parameters > Product Verification.
      The Product Verification page is displayed.
   b. Enter the Compliance Token and click Verify.
      If the token is valid, a confirmation message is displayed.

8. Confirm registration:
   a. Exit then relaunch Director
   b. Navigate to the Contact Information page.
   c. Click Refresh this page.
      The Reminder Notification message is no longer posted.

If Registration is Not Received by ShoreTel

If registration information is not received by ShoreTel (for any reason), you must submit the Contact Information again (over the internet or through email) as often as necessary until registration is completed.

If registration is not completed in 45 days, Director is locked.

Requesting the ShoreTel Software License Key

After completing and registering the Contact Information form, the License Preview page appears as shown in Figure 2. You must request a license key.
Requesting a License Key

1. Review the information in the License Preview page.

2. Do one of the following:
   - Click **Print** at the top of the page to print the information.
   - Click **Submit** to send the request immediately to ShoreTel, Inc. After verifying the information, ShoreTel emails the license key within three business days.
   - Click **Save to File** to save the request for later submission.

After you have registered ShoreTel Director, the Quick Look page appears shown in Figure 3.
Installing the License

When you receive your licence keys, you must install them in ShoreTel Director. To install the license, do the following:

1. View the license packet that you received from ShoreTel.
2. Launch ShoreTel Director.
3. In the ShoreTel Director menu click Administration > System Parameters > Licenses > Keys. The License Key page appears.
4. Click New at the top of the page. The License Key Info dialog box appears.
5. In the Key field, enter the license key that you received from ShoreTel.
6. In the Comment field, enter a description of the license.
7. Click Save.
8. Repeat Steps 4 through 7 for each license key that you have to install.
Getting Started with System Configuration

This section lists a summary of tasks to perform to configure your system for the first time. This list also follows the order in which this guide is organized. Before you begin configuring the system, make sure it has been properly installed as described in the ShoreTel Planning and Installation Guide.

- Launch ShoreTel Director. See Starting ShoreTel Director on page 25 for information about launching ShoreTel Director.

- Register the ShoreTel software and request a license key or keys. See Requesting the ShoreTel Software License Key on page 33 for information about registering ShoreTel software and requesting license keys.

- We encourage prompt registration in ShoreTel Director so that we have the current information about your ShoreTel products and installation.

- Install your license key or license keys if you have them. You have up to 45 days to install the licenses. After this time, you cannot continue to use the ShoreTel software. See Installing the License on page 35 for information about installing license keys.

  Until you have updated all required licenses, ShoreTel Director will continue to open to the License Requirements page after login.

- Configure system parameters using the System Parameters link:
  a. Install any new licenses your installation requires from the Licenses page.
  b. Specify the dialing conventions to use throughout the system in the Dialing Plan page. See Setting Dial Plan Parameters on page 43 for more information about dialing plans. The dialing conventions include extension length as well as the dialing plan reservations for extensions and trunk access codes.
  c. Configure the system’s extensions from the System Extensions page. See System Extensions on page 53 for more information about system extensions. Review the default system extensions and, if necessary, change them if the system must use these defaults for other purposes.
  d. Specify the languages you want to make available for the system. (Be sure you have appropriate licenses for the languages.)
  e. Review the password and log file settings on the Other page. See Other Parameters on page 56 for more information about other configurable parameters. ShoreTel created the defaults to apply widely, so they can probably remain at their current values.

- Create and configure the sites that you want your ShoreTel system to have using the Sites navigation link. For more information, see Chapter 3, ShoreTel Sites on page 77.
Click the Headquarters link on the Site list page, and review the following default Headquarters site parameters:

- Country location for the site
- Local area codes for 7-digit and 10-digit dialing
- Emergency call back number (if using ISDN PRI or SIP trunks)
- Time zone (for correct date and time for caller ID telephones)
- Admission control bandwidth (for multiple-site configurations)
- SIP Proxy

**Note**

You cannot configure Night Bell Switch or Paging Extension until the proper switch is configured. For more information, see Chapter 3, ShoreTel Sites on page 77.

Before you can configure Operator Extension or Fax Redirect Extension, you must configure the proper users. For more information, see Configuring Users in the ShoreTel System Administration Guide. You will need to return to this page later.

Set the IP address range for the IP phones at any remote sites. You define IP address ranges so that IP phones are assigned to the correct site. IP phones not assigned to a remote site are associated with Headquarters.

Configure additional sites if desired. For more information, see Chapter 3, ShoreTel Sites on page 77.

Configure additional ShoreTel application servers by using the Application Servers page. For more information, see Chapter 4, Configuring Application Servers on page 89. For each additional server, do the following:

- Name the server and assign it to a site.
- Create the ShoreTel server.
- Set the voice mail and auto-attendant extensions.
- Assign a user group to the server.

Configure ShoreTel voice switches using the Switches page. For more information, see Chapter 5, Configuring Voice Switches on page 111.

a. Select the role that you want the switch to perform for the site.

b. Identify the site where you want to use the switch.

c. Select the switch model you want to use.

d. Create the switch profile.

e. Provide a name and description and use the Find Switches button to discover each voice switch on the network.

f. Specify the ShoreTel server that you want to manage the switch.
g. Each ShoreTel voice switch must have a valid IP address from a DHCP server on the ShoreTel server, or an address statically configured from the maintenance port (24, T1, and E1 only).

- Configure IP phones using the IP Phones link. For more information, see Chapter 8, Configuring IP Phones on page 209.
  
  a. Add IP phone ports to ShoreTel voice switch-120/24, ShoreTel voice switch 90, ShoreTel voice switch-60/12, ShoreTel voice switch 50, ShoreTel voice switch-40/8, ShoreTel voice switch 220T1/T1A/E1, ShoreTel voice switches SG 30, SG-30 BRI, SG-90 BRI, SG-90 BRIV, and ShoreTel voice switch-T1/E1 voice switches supporting IP phones. For each port you assign to IP phones, the switch supports five IP phones. For more information, Chapter 8, Configuring IP Phones on page 209.
  
  b. Set the boot parameters for the IP phones. ShoreTel IP phones are set to find boot information from a DHCP server. If your installation has other requirements, use the IP phone set-up menu to set server and boot configuration parameters. For more information, see the ShoreTel Planning and Installation Guide.

You can speed up the installation by using the Extension Assignment feature. For more information, see Using Extension Assignment on page 446.

- Configure the following users before you add general users to the system:
  
  a. During installation, a system administrator is set up. Assign a person at your site to this role. When you assign a system administrator, the default user ID and password must be changed. Make a note of the new user ID and password, since the defaults (admin and changeme) will no longer be available.
  
  b. Configure an operator for each site. See Administrative Permissions on page 71 for more information. This is the extension reached when 0 is dialed from the telephone. Note that operators can span sites.
  
  c. Configure a “user” as the Fax Redirect extension for each site.
  
  d. Configure a user as the default Personal Assistant for all other users. This is the user that calling parties are routed to when they dial “0” in a user’s mailbox. It is important that you configure the default Personal Assistant before adding the bulk of the users so that appropriate defaults can be assigned. If you omit this step, you may have to spend time reconfiguring the users later.
  
  e. Configure the Call Handling Mode Defaults and assign the Personal Assistant.

- Complete configuration of sites:
  
  a. Return to each site and complete the configuration for Night Bell, Paging, Operator, and Fax Redirect.
  
  b. If you have added additional servers, return to each Site edit page and reconfigure as appropriate.

- Configure all trunk groups and trunks:
  
  a. Configure trunk groups from the Trunk Groups page. You can modify the default trunk groups, add new trunk groups, and assign individual trunks for Make Me conferencing.
b. Configure the trunks from the Individual Trunks page. For the ShoreTel voice switch-T1, return to the Switch edit page and assign all the channels on the T1 to the proper trunk group.

- Configure the users from the Users pages:
  a. Configure the user groups, including all the Class of Service (COS) permissions from the User Group edit page. You can modify the default user groups or add new trunk groups. Be sure to grant access to any new trunk groups you have added.
  b. Configure all the users from the Individual Users edit page.
  c. Configure any anonymous telephones from the Anonymous Telephone edit page.

- Configure call control parameters from the Call Control link. Set up hunt groups and paging groups, as needed.

- Configure voice mail parameters and system distribution lists from the Voice Mail Options and System Distribution Lists pages.

- Configure the auto-attendant parameters from the Auto-Attendant edit pages, and configure each auto-attendant menu from the Menus page.

- Set schedules from the Schedules link. These may be used by the auto-attendant or paging groups.

- Configure the workgroups from the Workgroups edit page:
  a. Configure the workgroup.
  b. Configure the call handling modes.
  c. Configure the queue, including prompts.

- Configure the system directory from the System Directory edit page:
  If you use Microsoft Exchange and Microsoft Outlook, you can leverage Contacts on the Exchange Server for common contact information.

  If using the ShoreTel Enterprise Contact Center Solution, you must configure it. Refer to the ShoreTel Enterprise Contact Center Administration Guide and the ShoreTel Enterprise Contact Center Installation Guide for information.

---

External Telephone Number Formatting

Unlike ShoreTel Communicator, which has a location as a reference point, ShoreTel Director is global and has no inherent location; it has no inherent relationship to local exchanges or countries.

The rules for entering numbers in ShoreTel Director are as follows:

- All external numbers in ShoreTel Director must be entered in canonical format, as follows:
Using ShoreTel Director External Telephone Number Formatting

+C… (A…) S…

“+” = International designation
“C” = Country code
“A” = Area code (also known as a city code)
“S” = Subscriber number

- DID Numbers must be entered in canonical format, as in the following example:
  +1 (408) 331-3300 (U.S., Canada)

- Message notification destinations must be entered in canonical format and must not include a trunk access code. The number is presented back to the user in canonical format, as in the following example:
  +1 (408) 331-3300 (U.S., Canada)

- System directory entries must be entered in canonical format. The number is presented back to the user in canonical format, as in the following example:
  +1 (408) 331-3300 (U.S., Canada)

- Call forward destinations must be entered in canonical format and must include a trunk access code. The number is presented back to the user in canonical format with the trunk access code in front of the number, as in the following example:
  9+1 (408) 331-3300 (U.S., Canada)

Off-system extensions can be used as call forward destinations, but they should not include a trunk access code (for example, 8 or 9).

Table 2 gives examples for all the countries supported by ShoreTel Director. For more information about international planning and installation, see the ShoreTel Planning and Installation Guide.

### Table 2: International Phone Number Examples

<table>
<thead>
<tr>
<th>Phone Number</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>+1(408) 331-3300</td>
<td>U.S., Canada</td>
</tr>
<tr>
<td>+31 70 348 6486</td>
<td>Netherlands</td>
</tr>
<tr>
<td>+33 8 36 68 31 12</td>
<td>France</td>
</tr>
<tr>
<td>+34 91 845 6078</td>
<td>Spain</td>
</tr>
<tr>
<td>+44 20 7634 8700</td>
<td>UK</td>
</tr>
<tr>
<td>+49 69 571903</td>
<td>Germany</td>
</tr>
<tr>
<td>+55 61 429 7777</td>
<td>Brazil</td>
</tr>
<tr>
<td>+60 3 2693 5188</td>
<td>Malaysia</td>
</tr>
<tr>
<td>+61 2 9360 1111</td>
<td>Australia</td>
</tr>
<tr>
<td>+65 736 6622</td>
<td>Singapore</td>
</tr>
<tr>
<td>+852 2508 1234</td>
<td>Hong Kong</td>
</tr>
</tbody>
</table>
Setting Up System Parameters

This chapter describes how to specify system-wide parameters by using ShoreTel Director. The topic sections in this chapter are as follows:

Setting Dial Plan Parameters ................................................................. 43
  Setting the String Parameters Used in Your Dial Plan ............................. 43
  Increasing the Extension Length ............................................................ 46
Creating a Digit Translation Table ................................................................ 48
  General Details on Digit Translation Tables ............................................. 49
  Creating Digit Translation Tables ............................................................. 49
  Deleting Translation Tables ..................................................................... 50
Security ...................................................................................................... 51
  Specifying the Port Range for a Service Appliance ................................. 51
  Specifying a Range of Trusted IP Addresses ............................................ 52
System Extensions ...................................................................................... 53
  Enabling SNMP for Your ShoreTel System .............................................. 55
SNMP ......................................................................................................... 55
  Enabling SNMP for Your ShoreTel System .............................................. 55
Other Parameters ....................................................................................... 56
  Accessing the Parameters in the Other Page ............................................ 56
Client Compatibility ..................................................................................... 60
  Implementing Client Compatibility ......................................................... 61
Languages .................................................................................................. 62
  Specifying the Languages That Are Available to the System ................... 62
Licenses ....................................................................................................... 63
  Viewing Your ShoreTel Licenses in ShoreTel Director ......................... 63
  Registering the ShoreTel Software ......................................................... 64
Setting Dial Plan Parameters

The dial plan defines the numbering convention your ShoreTel system uses to route calls. The system uses the dial plan to parse dialed numbers—whether from internal users or the Public Switched Telephone Network (PSTN)—and to direct calls appropriately. The dial plan can include extensions, site codes (pre-extensions), access codes for trunks, and permission codes.

This section describes how to set the parameters for creating number strings in a dial plan. These parameters are set using the Dial Plan page in ShoreTel Director. This page lets you:

- Specify the lead digit used in a string.
- Specify the number of digits included in a string.

**Note**
You cannot reduce the number of digits included in an extension after the parameter is set.

- Specify how the string is used in the system.

Before beginning, review the ShoreTel system deployment and topology and the local Telco dial plan and dial rules for each ShoreTel site.

**WARNING!**
After you set and save a leading digit parameter, you cannot change it in the following situations:

- The leading digit is an extension prefix. In addition, be aware that setting extension prefixes is a one-time activity. If you leave any extension prefixes unused, you cannot assign them later.
- The leading digit is an extension digit that already has extensions configured starting with that digit.
- The leading digit is configured as the leading digit of a trunk access code for a trunk group.

In these cases, after the change is saved the field is unselectable.

Setting the String Parameters Used in Your Dial Plan

1. Launch ShoreTel Director.
2. Click **Administration > System Parameters > Dial Plan**. The Edit Dialing Plan page appears as shown in Figure 4.
3. In the Digit column, identify the number or character to use for the leading digit in this string.

**Note**
All available digits are pre-configured as lead dial strings. Reconfigure only those dial strings for special-purpose uses.
4. In the **Reservation** field next to the digit, select the parameter to use for this digit string. See Table 4 for information on available parameters.

**WARNING!**
Extensions must not conflict with the leading digits of emergency telephone numbers, since the ShoreTel system allows users to dial emergency numbers with or without a trunk access code. If you are deploying a global voice network, this must be considered for all emergency numbers.

5. Repeat Step 3 and Step 4 for all applicable digits.

6. Click **Save** when finished.

**WARNING!**
Once you set and save the Reservation parameter, it cannot be changed. The field is unselectable after the change is saved.

---

### Table 3: System Parameters Page: Dial Plan Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Extension Digits</td>
<td>Shows the number of digits currently uses in ShoreTel extensions. The default is 3 digits.</td>
</tr>
<tr>
<td>Increase Extension Length</td>
<td>Allows you to increase the number of digits used in ShoreTel extensions.</td>
</tr>
<tr>
<td>Dialing Plan</td>
<td>This section allows you to set parameters used for extension numbers. You must specify how you want the ShoreTel system to interpret each dialable, leading digit.</td>
</tr>
<tr>
<td>Digit</td>
<td>The numeric and ASCII characters used as leading digits.</td>
</tr>
<tr>
<td>Reservation</td>
<td>Lets you set the extension parameters to use with each leading digit. See Table 4 for information about extension options.</td>
</tr>
</tbody>
</table>
### Table 4: Reservation Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Extension Prefix (n digits)   | Lets you specify the number of digits used in extension prefixes that have this leading digit. Extension prefixes can be up to 7 digits.  
The Configure Extension Prefix Warning window appears with a list of each of the sites in your system. Next to the list of sites you will find a blank field that requires you to enter the desired extension prefix. This prefix will be appended to every dialed number at that particular site. Make sure to back up the system before clicking Save. |
| Extensions                    | Reserve this digit as the leading digit in an extension.  
The digit “0” cannot be reserved as the lead digit in extensions. |
| Not Used                      | Does not allow this digit to be used as a lead digit.                        |
| Operator                      | Reserve this digit for use as the extension used to access the ShoreTel operator. The default value is zero (0). In international applications, zero is often used as the access code for trunks. This sets a potential for conflict. ShoreTel recommends that international customers standardize globally on a single trunk access code for the purposes of network call routing (for example, use “9” for all trunk groups). |
| Trunk Access Codes [1 Digit]  | Reserves this digit for use as a trunk access code.  
When you make a number the leading digit in a trunk access code, using the same number as the leading digit in extensions can cause the system to misroute calls. |
| Trunk Access Codes [2 Digit]  | Reserves this digit as the lead digit in two-digit trunk access codes.  
When you make a number the leading digit in a trunk access code, using the same number as the leading digit in extensions can cause the system to misroute calls. |
| Trunk Access Codes [3 Digit]  | Reserves this digit as the lead digit in three-digit trunk access codes.  
When you make a number the leading digit in a trunk access code, using the same number as the leading digit in extensions can cause the system to misroute calls. |
Increasing the Extension Length

You can increase the number of digits for phone extensions from the three-digit default to five digits. To match the new number when you increase the number of extension digits, you must also add one or more numbers to the beginning of that extension for existing numbers, including mailboxes, menus, and distribution lists. Be sure that the added number or numbers do not conflict with other access codes in the system’s dial plan.

Increasing the Number of Digits for Phone Extensions

1. Launch ShoreTel Director.

2. Navigate to Administration > System Parameters > Dialing Plan. The System Parameters: Edit Dial Plan page appears, as illustrated in Figure 4. (This figure also shows the warning that ShoreTel Director displays when someone clicks on the Increase Extension Length button in the upper part of this page.)

3. Click Increase Extension Length. The Increase Extension Length Warning dialog appears as shown in Figure 4.

4. Click Yes to increase the extension length. The Increase Extension Length popup appears as shown in Figure 4.
Figure 4: System Parameters Page for Editing Dial Plans

Figure 5: Increasing the number of Extension Digits
5. Use the small scroll list just below “Select your new extension length” to select the number of digits for ShoreTel extensions.

6. In the Enter the number(s) to pre-pend to your current extension field, enter the number or numbers that appear at the beginning of extensions.

WARNING!
Be sure the numbers that you pre-pend to the extension do not conflict with other numeric strings in the dial plan. For example, the pre-pended numbers should not conflict with trunk access codes, the operator extension, emergency numbers, and so on.

7. Click OK to apply the change.

8. Click Save after completing all changes to the dial plan.

Creating a Digit Translation Table

This section describes how to create a digit translation table. After introductory information digit translation tables, the topics consist of:

- General Details on Digit Translation Tables
- Creating Digit Translation Tables
- Deleting Digit Translation Tables

A digit translation table is a remedial solution for an environment with overlapping or conflicting dial plans on different (but connected) phone systems. A digit translation table resolves differences in the numbers of digits in the dial plans.

A digit translation table converts numbers between either of the following:

- The dial plan of a non-ShoreTel system and the dial plan of a ShoreTel system
- Different dial plans on separate ShoreTel networks

Through the digit translation table, you can adjust the extension format in a ShoreTel dial plan to the format in another dial plan of another phone system. You can specify:

- The number of digits
- The lead digit for numbers in each system

Note
The use of a digit translation table must follow after careful planning. For guidance on how to plan the use of digit translation tables, refer to the current ShoreTel Planning and Installation Guide.
After a digit translation table exists, it is applied (as needed) to trunks and application servers. The application of digit translation tables is described in the following chapters:

- Chapter 4, Configuring Application Servers on page 89, for applying translation tables to servers
- Chapter 7, Configuring Trunks on page 165, for applying translation tables to ISDN trunk groups
- Chapter 18, Session Initiation Protocol on page 573, for applying translation tables to SIP trunk groups

**General Details on Digit Translation Tables**

When the ShoreTel system applies a table, the direction of the routed call determines whether digits are added or deleted.

When resolving possible differences between dial plans, the system administrator should specify number translation so that its operation is invisible to users. Methods for achieving smooth operation are described in the current ShoreTel Planning and Installation Guide.

In general, a system translates the numbers of digits when it passes calls between it and another phone system. However, the particular system that performs the translation is the choice of the system administrator. One of multiple ShoreTel systems or the system from another manufacturer can perform the translation. The decision can be based on which system provides the most convenient or efficient point of translation.

You can associate the digit translation table with:

- A trunk that bridges systems
- The Simplified Message Desk Interface (SMDI) module in an application server so that users can access their legacy voice mailbox

In either case, users do not have to change their dialing habits.

**Creating Digit Translation Tables**

1. Launch ShoreTel Director.

2. Navigate to Administration > System Parameters > Digital Translation Tables. The Digital Translation List page appears as shown in Figure 6.

   ![Figure 6: Digit Translation List Page](image)

3. Create a new translation profile as follows:
   
a. Click **New** to add an entry. The Table Entries page opens (Figure 7).
Figure 7: Digital Translation Table Entries Page

b. In the Name field, type a name for this translation profile.

c. Click Save. The New button is activated.

d. Click the New button. The Digit Translation Info dialog box appears as shown in Figure 8.

Figure 8: Digit Translation Page and Entry Dialog Box

e. In the Original Digits field, enter the string to translate.

f. In the Replacement Digits field, enter the replacement string.

g. Click Save.

Translation table lists appear in profiles for trunk groups and application servers when Simplified Message Desk Interface (SMDI) is selected as the voice mail interface.

Deleting Translation Tables

1. Launch ShoreTel Director.

2. Navigate to Administration > System Parameters > Digital Translation Tables. The Digital Translation List opens, as shown in Figure 6 on page 49.

3. Mark the checkbox next to the digit translation table to delete.

4. Click the Delete button.
Security

This section describes two security-related configurations for a ShoreTel network. The first configuration is a port range that can be used for audio and video traffic throughout the network. The other configuration is for trusted IP address ranges for the ShoreTel service appliances (such as the SA-100 and SA-400) in the DMZ.

**Note**

Unless ShoreTel's default port range conflicts with ports in the network, you can keep the defaults. Only the low-end port number is configurable, as this section describes.

**Note**

This section provides no guidance for choosing the IP address ranges to specify. This choice should have been made before this configuration task, as a part of the network planning and formulation of the security policy for the network.

Specifying the Port Range for a Service Appliance

Ports in the configured range are available to all ShoreTel applications and devices, such as ShoreTel voice switches, servers, IP phones, ShoreTel Communicator, and Softphone.

When you specify the first port number, the system automatically adjusts the value of the last port to provide the maximum number of supported ports. This is illustrated in Figure 9.

*Figure 9: Specifying the Port Number Range*

Specifying the Starting Port Number of the Range

1. Launch ShoreTel Director.
2. Navigate to Administration > System Parameters > Security > Port Configuration.
   
   The Port Configuration Edit page opens (Figure 9).
3. In the First UDP Port field, enter a port number that is 1024 or higher.
   
   The value for the Last UDP Port is automatically adjusted based on the value you entered.
4. Click **Save**.

**Specifying a Range of Trusted IP Addresses**

The configuration for the trusted IP address range provides choices among the private IP address ranges (see Figure 10). For this configuration task, select one of the ranges and then specify one or more ranges of trusted IP addresses.

![Figure 10: Specifying a Range of Trusted IP Addresses](image)

**Note**

The default state of the private IP addresses includes the entirety of each range. Therefore, the IP ranges are completely open and insecure. After you specify a trusted IP address range, we strongly recommend that you delete the other ranges, as the configuration steps describe. If necessary, you can re-create these ranges.

The example in the steps that follow is a ShoreTel network with two trusted IP address ranges that start with 10. To specify the range of trusted IP addresses:

1. Launch ShoreTel Director.

2. Navigate to **Administration > System Parameters > Security > Trusted IP Ranges**.

   The Trusted IP Ranges page opens. (Figure 9 shows this page and the pop-up window that appears after you select Range-2.)

3. Click on **Range-1**.

   The popup window for the address range appears.
4. Type an IP address for the low end. For this example, type 10.1.1.1.
5. Type an IP address for the high end. For this example, type 10.1.1.100.
6. Click Save in the popup. This window stays open.
7. Click Next in the popup. The default range for Range-2 opens (Figure 10).
8. Type an IP address for the low end. For this example, type 10.2.2.0.
9. Type an IP address for the high end. For this example, type 10.2.2.255.
10. Click Save and then Close in the Trusted IP Range Info popup.
11. Put a mark in the check box next to Range-3 (for this example).
12. Click Delete at the top of the Trusted IP Address Ranges page.
13. Click Save at the top of the Trusted IP Address Ranges page.

If you need to re-create a trusted address scheme by using one of the deleted private IP address ranges, start by clicking New at the top of the Trusted IP Address Ranges page. Remember to delete the obsolete range.

---

**System Extensions**

Services such as voicemail, account codes, auto-attendant, Make-me conferences, and ShoreTel conferences associated with the ShoreTel HQ site have system-wide application. These services, when enabled on the HQ site, are automatically assigned an extension on the HQ server. That extension can be used by any user anywhere on the system to access the service though the service may be executed at the server site that is local for the user.

You can view and modify extensions assigned to these system-wide services using the System Extensions page. To access the System Extension page:

1. Launch ShoreTel Director.
2. Select Administrator > System Parameters > System Extension.

The Edit System Extensions page appears. Table 5 describes the fields on the Edit System Extensions page.

### Table 5: System Extension Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice Mail</td>
<td>This section provides information about system-wide voicemail extensions.</td>
</tr>
<tr>
<td>Voice Mail Extension</td>
<td>The extension the system uses for forwarding calls to voicemail.</td>
</tr>
</tbody>
</table>
### Voice Mail Login Extension
This is the extension that users use to log into their voice mailbox. We recommend that users be allowed to dial in from outside the company to retrieve voicemail. Typically, you direct this number to an auto-attendant menu and configure the menu with a single-digit action of “Go To Menu” using the Voice Mail Login Extension parameter.

### Voice Mail Broadcast Mailbox
The extension users use to broadcast a voicemail message to all users.

### Account Codes
This section provides information about system-wide account code extensions.

- **Account Code Extension**: This is the extension on the headquarters SoftSwitch associated with the account codes application. When account code collection is optional or forced, calls are routed to this extension for an account code prompt. See also the "Account Codes" section on page 255.

### Music On Hold
This section provides information about file-based Music on Hold (MOH).

### Music On Hold Extension
The extension for the system-wide file-based MOH. This extension is created during system installation.

### Auto-Attendant
This section provides information about system-wide auto-attendant extensions.

### Auto-Attendant Extension
The extension for the system-wide auto-attendant.

### Backup Auto-Attendant Extension
The extension you want to use as an auto-attendant backup in case the Headquarters server fails.

The backup auto-attendant (BAA) provides basic inbound call routing in case the auto-attendant on the ShoreTel server is unavailable. In addition, it answers calls routed to voice mail in case voice mail on the ShoreTel server is unavailable.

The BAA is also used when extensions are unreachable during a network or switch outage and the Admissions Control Bandwidth is exceeded.

Callers who are accessing the ShoreTel system over a SIP trunk can access the BAA in the same manner as users who are accessing the system via all other trunk types. **ShoreTel** supports RFC2833 (DTMF), so if the voice-mail server is down, external callers can enter an extension by using DTMF to ring the extension of the user they are trying to reach.

### Make Me Conference
This extension lets users create conferences with up to six participants on a ShoreTel voice switch if the conference capability is so configured.

### Make Me Conference Extension
This section provides information for conferences that use the ShoreTel Service Appliance.

---

**Table 5: System Extension Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice Mail Login Extension</td>
<td>This is the extension that users use to log into their voice mailbox. We recommend that users be allowed to dial in from outside the company.</td>
</tr>
<tr>
<td>Voice Mail Broadcast Mailbox</td>
<td>The extension users use to broadcast a voicemail message to all users.</td>
</tr>
<tr>
<td>Account Codes</td>
<td>This section provides information about system-wide account code extensions.</td>
</tr>
<tr>
<td>Account Code Extension</td>
<td>This is the extension on the headquarters SoftSwitch associated with the account codes application. When account code collection is optional or forced, calls are routed to this extension for an account code prompt. See also the &quot;Account Codes&quot; section on page 255.</td>
</tr>
<tr>
<td>Music On Hold</td>
<td>This section provides information about file-based Music on Hold (MOH).</td>
</tr>
<tr>
<td>Music On Hold Extension</td>
<td>The extension for the system-wide file-based MOH. This extension is created during system installation.</td>
</tr>
<tr>
<td>Auto-Attendant</td>
<td>This section provides information about system-wide auto-attendant extensions.</td>
</tr>
<tr>
<td>Auto-Attendant Extension</td>
<td>The extension for the system-wide auto-attendant.</td>
</tr>
<tr>
<td>Backup Auto-Attendant Extension</td>
<td>The extension you want to use as an auto-attendant backup in case the Headquarters server fails.</td>
</tr>
<tr>
<td>Make Me Conference</td>
<td>This extension lets users create conferences with up to six participants on a ShoreTel voice switch if the conference capability is so configured.</td>
</tr>
<tr>
<td>Make Me Conference Extension</td>
<td></td>
</tr>
<tr>
<td>ShoreTel Conference</td>
<td>This section provides information for conferences that use the ShoreTel Service Appliance.</td>
</tr>
</tbody>
</table>
The ShoreTel voice switches support Simple Network Management Protocol (SNMP) agents for the Ethernet interface. These agents provide Management Information Base II (MIB-II) statistics and allow the ShoreTel voice switches to be integrated into standard network management applications.

ShoreTel has tested and supports the HP OpenCall network management console.

ShoreTel recommends that you configure your SNMP management station to launch ShoreTel Director automatically when you click a ShoreTel device.

### Enabling SNMP for Your ShoreTel System

1. Launch ShoreTel Director.
2. Click **Administration > System Parameters > SNMP**.

The Edit SNMP page appears as shown in Figure 11.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension</td>
<td>The system-wide extension internal users use to initiate a conference using the Service Appliance.</td>
</tr>
<tr>
<td>External Number</td>
<td>Main external telephone number users can dial to access a Service Appliance conference.</td>
</tr>
<tr>
<td>Additional Calling Information</td>
<td>Allows you to specify other external telephone numbers users can use to access Service Appliance conferences. These numbers can be local to remote sites.</td>
</tr>
</tbody>
</table>

![Figure 11: SNMP Edit Page](image-url)
3. In the **Read-Only (Get)** field, enter the SNMP community string the network uses for read-only SNMP messages.

4. In the **Read/Write (Get/Set)**, enter the SNMP community string the network uses for read and write SNMP messages. Currently, there are no SNMP writable objects in ShoreTel's voice switches.

5. In the **IP Address of Trap Receivers** section, type the IP address of up to five destinations that should receive SNMP traps. The destination IP address must have an installed SNMP trap listener (on UDP Port 162).

**Other Parameters**

A mix of system-wide site parameters are configured through the Other option in the System Parameters menu. Table 6 contains descriptions of the parameters in this page.

**Accessing the Parameters in the Other Page**

1. Launch ShoreTel Director.

2. Navigate to **Administration > System Parameters > Other**.

   The Edit Other Parameters page appears (Figure 12).
Figure 12: Editing Other System Parameters
## Table 6: Elements in Edit Other Parameters Page

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Max Voice Mail Errors</td>
<td>This value is the number of times a user can fail when attempting to log into voicemail from a phone. When the user fails this number of login attempts, the system gives a message to the user and terminates the call.</td>
</tr>
<tr>
<td>Min Voice Mail Password Length (2–26)</td>
<td>The mandatory minimum number of digits for a voicemail password.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If <strong>Min Voice Mail Password Length</strong> is changed, the new users default password length will be set accordingly.</td>
</tr>
<tr>
<td>Min Client Password Length (4–26)</td>
<td>The minimum number of characters for the password that a user enters to log into the ShoreTel Communicator application or ShoreTel Director.</td>
</tr>
<tr>
<td>Max Client Password Length (4–26)</td>
<td>The maximum number of characters for the password that a user enters to log into the ShoreTel Communicator application or ShoreTel Director.</td>
</tr>
<tr>
<td>HQ / DVS Log File Storage</td>
<td></td>
</tr>
<tr>
<td>Max Days (1–30)</td>
<td>The number of days that the headquarters server keeps a log file entry for a server event before deleting it.</td>
</tr>
<tr>
<td>Max Size (10–250000)</td>
<td>The maximum megabytes in the server’s log file.ian</td>
</tr>
<tr>
<td><strong>ShoreTel Voice Switch / Small Office Appliance</strong></td>
<td></td>
</tr>
<tr>
<td>&quot;admin&quot; Password</td>
<td>The password for accessing the administrator account on ShoreTel voice switches; the system allows the following characters: !#$%&amp;'()*+,-.0123456789:;=@ABCDEFGHIJKLMNOPQRSTUVWXYZ[]^_`abcdefghijklmnopqrstuvwxyz{</td>
</tr>
<tr>
<td></td>
<td>The system disallows the following characters: ? &quot; &lt;&gt;</td>
</tr>
<tr>
<td>&quot;root&quot; Password</td>
<td>The password for accessing the root account on ShoreTel voice switches. The system allows the following characters: !#$%&amp;'()*+,-.0123456789:;=@ABCDEFGHIJKLMNOPQRSTUVWXYZ[]^_`abcdefghijklmnopqrstuvwxyz{</td>
</tr>
<tr>
<td></td>
<td>The system disallows the following characters: ? &quot; &lt;&gt;</td>
</tr>
<tr>
<td>Log File Storage</td>
<td>ShoreTel voice switches use the two global parameters that follow for storing log files on the HQ server.</td>
</tr>
<tr>
<td>Max Days (1-30)</td>
<td>The number of days that the server keeps a log file entry for a voice switch before deleting it.</td>
</tr>
<tr>
<td>Max Size (10-500)</td>
<td>The maximum number of megabytes in a log file on the server for a voice switch.</td>
</tr>
</tbody>
</table>
Table 6: Elements in Edit Other Parameters Page (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Appliance</td>
<td></td>
</tr>
<tr>
<td>Enable Exchange Connector</td>
<td>Mark this checkbox to enable Exchange Synchronization for ShoreTel conferences.</td>
</tr>
<tr>
<td>Exchange Server</td>
<td>This parameter is the fully-qualified domain name (FQDN) or IP address of the Exchange Server to which the ShoreTel Service Appliance connects for Exchange Synchronization.</td>
</tr>
<tr>
<td>Username and Password</td>
<td>A service appliance uses these values to authenticate against the Exchange server before the Exchange server does the synchronization. This user must have permission to manage the calendars of other Exchange users.</td>
</tr>
<tr>
<td>Service Appliance Log File</td>
<td>Service appliances use the global parameters that follow for storing log files.</td>
</tr>
<tr>
<td>Storage</td>
<td></td>
</tr>
<tr>
<td>Max Days (1-30)</td>
<td>The number of days that the HQ server keeps an entry in the log files for ShoreTel Service Appliances.</td>
</tr>
<tr>
<td>Max Size (10-60000)</td>
<td>The maximum number of megabytes in a log file for a ShoreTel Service Appliance.</td>
</tr>
<tr>
<td>IM (System-wide parameters for IM)</td>
<td></td>
</tr>
<tr>
<td>Domain Name</td>
<td>The domain name (FQDN) for IM.</td>
</tr>
<tr>
<td>Enable Offline Messaging</td>
<td>Mark this checkbox to store messages for users who are off-line. Users can see these IM messages when they go on-line. Without this enable, the system drops messages to users who are off-line.</td>
</tr>
<tr>
<td>Enable TLS</td>
<td>Mark this checkbox to allow encryption through transport layer security (TLS).</td>
</tr>
<tr>
<td>Session Timeout (10-600)</td>
<td>The number of minutes the system lets an IM message stay open without a response from the recipient.</td>
</tr>
<tr>
<td>Client Compatibility and Upgrades</td>
<td></td>
</tr>
<tr>
<td>Prevent Users from Initiating Client Upgrades</td>
<td>Mark this check box to prevent clients from upgrading their Communicator application if they have not received an upgrade notification. We recommend enabling this parameter when you use the Silent Client Upgrade feature in connection with Active Directory to install client software on remote machines.</td>
</tr>
</tbody>
</table>
Client Compatibility

The Client Compatibility feature provides greater control to organizations over which versions of Communicator they deploy during a ShoreTel system upgrade. This feature is designed to reduce the impact of system upgrades. Client Compatibility lets you upgrade the servers first and then the clients. Spreading the upgrade over time is less demanding on the IT staff and allows users to upgrade at their own convenience.

The Client Compatibility feature lets you specify the earliest version of Communicator that the system supports and suggests an earliest version that clients can use without upgrading. System Administrators can implement the V Minus 1 Compatibility functionality through ShoreTel Director by configuring two system-wide settings.

### Minimum Allowed Client Versions
Type the earliest version number of ShoreTel Communicator available to users. Users receive a notice when Communicator software and in need of an upgrade. The default value is the earliest version of Communicator that the system software accepts.

### Minimum Suggested Client Version
Type the earliest recommended version number of Communicator for users. Users receive a notice when the Communicator software is out of date. However, with this parameter, the system does not require a software upgrade. The default value is the earliest version that the system software accepts (same value as Minimum Allowed Client Version).

### Active Directory Integration

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable AD Integration</td>
<td>Mark this checkbox to enable the system to use Active Directory for authentication.</td>
</tr>
<tr>
<td>AD Path</td>
<td>Enter the path that the system uses for Active Directory.</td>
</tr>
</tbody>
</table>

### Gmail Configuration

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Email</td>
<td>Enter the OAuth2 client email from the Google OAuth2 management page to configure voice mail synchronization with email. See &quot;Voice Mail Synchronization with Gmail for Business&quot; section on page 500 for more information.</td>
</tr>
<tr>
<td>Private Key</td>
<td>Enter the private key generated in the Google Apps web page. See &quot;Voice Mail Synchronization with Gmail for Business&quot; section on page 500 for more information.</td>
</tr>
<tr>
<td>Domain Name</td>
<td>Enter the name of the premier or educational account name. See &quot;Voice Mail Synchronization with Gmail for Business&quot; section on page 500 for more information.</td>
</tr>
</tbody>
</table>
Implementing Client Compatibility

1. Launch ShoreTel Director.

2. Click **Administration > System Parameters > Other**. The System Parameters Edit Other Parameters page appears as shown in Figure 12.

3. Scroll to the Client Compatibility and Upgrade section to do the following:
   - Mark the **Prevent Users from Initiating Client Upgrades** checkbox to hide the client upgrade option in Communicator. With this setting, users can upgrade only after they receive a notification.
   - In the **Minimum Allowed Client Version** field, type the number of the earliest version of ShoreTel Communicator that clients can use. The default value is the earliest version the system software supports.
   - In the **Minimum Suggested Client Version** field, type the earliest version of Communicator that clients can use. Clients receive an upgrade message if the Communicator version goes out of compliance. However, with this parameter, the system does not require a software upgrade.

4. Click the **Save** button to save your changes.

When a version of Communicator falls below the minimum *suggested* version but is later than the minimum *allowed* version, the system sends a notification to users with a Communicator version in this state. A dialog box appears with the upgrade notification that lets the user upgrade immediately. A user that chooses to upgrade later must use the Upgrade function in the Communicator Help menu. When the user selects the Upgrade option, a series of wizard windows open that guide the user through the upgrade.
Languages

A ShoreTel system can support more than one language at a time. To add one or more languages beyond the default (free) language of the customer’s choice, the customer must buy a license for each additional language. (For example, if two licenses are enabled, then the customer buys one license.) Furthermore:

- When a customer buys a keyed license for each additional language, up to 10 additional licenses can be associated with one key.
- For more than 10 additional language licences, an additional key is needed.

The supported languages in the current release are as follows:

- Danish
- German
- English (Australia)
- English (UK)
- English (US)
- Chinese (Traditional)
- Korean
- Spanish (CALA, Latin America)
- Spanish (Castilian, Spain)
- French
- Italian
- Japanese
- Dutch
- Norwegian
- Portuguese (Brazil)
- Portuguese (Portugal)
- Swedish
- Chinese (Simplified)

The functional areas for which a specific language can be configured are as follows:

- Sites
- Auto-Attendant Menus
- Users
- Workgroups
- Route Points
- Trunk Groups

**Specifying the Languages That Are Available to the System**

1. Launch ShoreTel Director.
2. Click Administration > System Parameters > Languages.
   
   The Languages page appears.

3. For each language that the ShoreTel system must support, select the checkbox in the Enable column.

4. Click Save.

Licenses

This section describes ShoreTel's feature licenses.

Viewing Your ShoreTel Licenses in ShoreTel Director

1. Launch ShoreTel Director.

2. Click Administration > System Parameters > Licenses > Requirements.
   
   The License Requirements page appears.

   The License Requirements page lists licenses that are available for the ShoreTel system and the quantity of acquired licenses for each type of license. You can use this page to track and manage all licenses.

   The licenses are divided into keyed and self-audited licenses. Self-audited licenses do not have a key associated with them. They are tracked on the license page as a tool to assist system administrators in tracking the number required based on the current configuration versus the number that have been purchased, which they enter manually.

   Five Communicator licenses, each of which corresponds to a Communicator type, span the Communicator feature set. ShoreTel defines four of these licenses as Keyed Licenses.

Compliance

If your system is out of compliance, ShoreTel Director offers 45-days to comply with the license requirements by either removing unneeded configurations and/or by ordering additional licenses. The 45-day grace period allows you to make ad hoc, unplanned changes that could temporarily exceed your license limits, but gives you time to get back into compliance.

WARNING!

Do not upgrade unless you are already in license compliance. If you upgrade and you are out of compliance, you will only have 45 days before being locked out of ShoreTel Director. Contact your ShoreTel Partner or ShoreTel Installed Base Business Services Team at Shorecare_admin@shoretel.com if you have any outstanding license issues.
Registering the ShoreTel Software

You must register your ShoreTel system software and obtain a system key before you can use the system. This is done using ShoreTel Director. After you registered and apply for licenses, ShoreTel acknowledges your submission in an email and mails your system key within 3-5 days. You have 45 days to install your system key.

**WARNING!**
After upgrading to a new version, you will have 45 days to ensure the new key is installed. If it is not installed, you are locked out of ShoreTel Director.

To register the software and request a system key:

1. Launch ShoreTel Director.
2. Click **Administration > System Parameters > Licenses > Requirements**.
   The License Requirements page appears.
3. Click the **Register and Request System License Key** button.
   The Contact Information page appears.
4. At a minimum, enter the information requested in the “Register and request system key” and Primary Contact sections. Be sure to include the sales order number for your purchase. Table 7 describes the elements that appear on the Edit Contact page.
5. Click the **Now** button at the top of the form to send in your request.

<table>
<thead>
<tr>
<th>Table 7: Elements on the Edit Contact Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
</tr>
<tr>
<td>Partner Name</td>
</tr>
<tr>
<td>Company Name</td>
</tr>
<tr>
<td>Address</td>
</tr>
<tr>
<td>City</td>
</tr>
<tr>
<td>State/Province</td>
</tr>
<tr>
<td>Postal Code</td>
</tr>
<tr>
<td>Country</td>
</tr>
<tr>
<td>Main Phone</td>
</tr>
<tr>
<td>Main E-mail</td>
</tr>
</tbody>
</table>
Installing License Keys

1. View the license packet that you received from ShoreTel.

2. Launch ShoreTel Director and in the ShoreTel Director menu click Administration > System Parameters > Licenses > Keys.

   The License Keys page appears.

3. Click the New button at the top of the page.

   The License Key Info dialog box appears as shown in Figure 13.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server MAC Address</td>
<td>MAC address of the server where the ShoreTel Headquarters server is installed.</td>
</tr>
<tr>
<td>Sales Order Number</td>
<td>The sales order number. This number is required only if license numbers have not been entered in ShoreTel Director.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the administrator responsible for the ShoreTel system. This field is required.</td>
</tr>
<tr>
<td>Title</td>
<td>Job title of the administrator responsible for the ShoreTel system. This field is required.</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone number of the administrator responsible for the ShoreTel system. This field is required.</td>
</tr>
<tr>
<td>Pager</td>
<td>Pager number of the administrator responsible for the ShoreTel system. This field is required.</td>
</tr>
<tr>
<td>E-mail</td>
<td>E-mail address of the administrator responsible for the ShoreTel system. This field is required.</td>
</tr>
<tr>
<td>Secondary Contact</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the back up administrator ShoreTel can contact regarding the ShoreTel system.</td>
</tr>
<tr>
<td>Title</td>
<td>Job title of the back up administrator ShoreTel can contact regarding the ShoreTel system.</td>
</tr>
<tr>
<td>Phone</td>
<td>Phone number of the back up administrator ShoreTel can contact regarding the ShoreTel system.</td>
</tr>
<tr>
<td>Pager</td>
<td>Pager number of the back up administrator ShoreTel can contact regarding the ShoreTel system.</td>
</tr>
<tr>
<td>E-mail</td>
<td>E-mail address of the back up administrator ShoreTel can contact regarding the ShoreTel system.</td>
</tr>
</tbody>
</table>
4. In the Key field, enter the license key that you received from ShoreTel.

5. In the Comment field, enter a description of the license.

6. Click **Save**.

   The license activates, and the information appears in the License Key page.

**Keyed License Types**

Keyed licenses are added by entering a license key string obtained from the reseller or vendor. Embedded in the license key are the type and number of licenses associated with that key. Once a valid key is entered, the system decodes it and details the type and number of licenses added. Keyed licenses are additive, and more than one can be entered into ShoreTel Director over time.

These licenses are counted in the Keyed Licenses section on the License Requirements page in ShoreTel Director. The licenses are grouped according to the following categories:

- **ShoreTel System License**: This count includes licenses required on a per-system basis.
- **ShoreTel Additional Site License**: This count includes licenses required for each site beyond the main headquarter location. For installed base customers, when you upgrade and request your new system key, you will automatically receive additional site licenses for all configured sites.
- **ShoreTel Extension License**: This count includes all extensions licensed by both Extension Only and Extension and Mailbox licenses.
- **ShoreTel Mailbox License**: This count includes all mailboxes licensed by both Mailbox Only and Extension and Mailbox licenses.
- **ShoreTel SoftPhone License**: This count includes SoftPhone licenses, which are issued on a per-user basis. Obtain and install one licence for each SoftPhone user.

- **ShoreTel Additional Language License**: This count includes licenses if more than one language is enabled.

- **ShoreTel Mobile Access License** is required for each client that is enabled for Communicator for Mobile.

- **ShoreTel SIP Phone License** is a keyed license that enables the system to support one SIP device through a SIP proxy. (ShoreTel 400-Series IP phones do not require this type of license.)

- **ShoreTel SIP Trunk License** is a keyed license required to enable physical and virtual SIP trunks.

- **ShoreTel Standard Resolution Video License** is a keyed license that enables Communicator to support one point to point video session at VGA resolution (640x480).

- **ShoreTel High Resolution Video License** is a keyed license that enables Communicator to support one point to point video session at XGA resolution (1024x768).

- **ShoreTel Operator Access License** is a keyed license that provides access to the following:
  - All functions available through Workgroup Supervisor Communicator
  - Advanced Buddy List functions, including pickup, unpark, edit buddies' active call properties, and edit call notes of buddies
  - Call recording
  - Bridged Call Appearance Monitor

- **ShoreTel Professional Access License** is a keyed license that provides access to the following:
  - All functions available through Personal Communicator
  - Instant Messaging Presence
  - Contact Viewer
  - Call recording (available from GA15 Release)

- **ShoreTel Workgroup Agent Access License** is a keyed license that provides access to the following:
  - All functions available through Professional Communicator
  - Ability to transfer calls by dragging and dropping call cells into the buddy list
  - Call recording (available from GA15 Release)
  - Workgroup access utilities, including login, log out, and wrap up
  - Workgroup Queue Monitor

- **ShoreTel Workgroup Supervisor Access License** is a keyed license that provides access to the following:
  - All functions available through Workgroup Agent Communicator
  - Call recording
  - Workgroup Agent Monitor
- **ShoreTel External Unified Messaging SIP Link**

- **ShoreTel Audio Conference License** is a keyed license that is necessary for each audio port that you want to use in conferences managed by a ShoreTel Service Appliance.

- **ShoreTel Web Conference License** is a keyed license that enables web ports for use in conferences managed by a ShoreTel Service Appliance.

- **ShoreTel Virtual Switch SIP Trunk License** is a keyed license that supports SIP trunks connected to ShoreTel virtual SIP trunk switches. The system requires one license for each SIP trunk connected to a ShoreTel virtual SIP trunk switch.

- **ShoreTel Virtual Switch Phone License** is a keyed license that supports devices connected to ShoreTel virtual phone switches. The system requires one license for each device connected to a ShoreTel virtual phone switch.

### Extension and Mailbox Licenses

Systems require one extension license for each configured extension-only user. If more than one key is installed, the number purchased is the sum of all valid keys. Extension-only users have an extension but no ShoreTel mailbox. They may have external mailboxes that can accessed using Simplified Message Desk Interface (SMDI).

Systems require one Mailbox license for each configured Mailbox-only user. If more than one key is installed, the number purchased is the sum of valid keys. Mailbox-only users are only those users with ShoreTel mailboxes that may use SMDI.

Systems require one Combo license for each user configured for Extensions and Mailboxes. If more than one key is installed, the number purchased is the sum of all valid keys.

Table 8 lists the features are available through Extension, Mailbox, and Combo licenses.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Combo</th>
<th>Extension Only</th>
<th>Mailbox Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>PBX features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use SoftPhone (requires SoftPhone license)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Make call, take call, etc.</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Voicemail features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure call handling modes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Forward calls to configured destination</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Create and play greetings</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Table 8: Licensed Extension and Mailbox Feature Availability
### Table 8: Licensed Extension and Mailbox Feature Availability (Continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Combo</th>
<th>Extension Only</th>
<th>Mailbox Only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the Personal Assistant</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Notification escalation</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Configure Find Me</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>System call handling schedule</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create call handling notes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Assign Extension</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Record name</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Automated attendant features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dial by number, name</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Transfer to / Go to extension</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Message by number, name</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extension Assignment</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Member of a hunt group</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Member of a workgroup</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Communicator features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communicator: Standard, Professional, Workgroup Agent, Workgroup Supervisor, Operator</td>
<td>Yes</td>
<td>No Mailbox Features</td>
<td>No extension features</td>
</tr>
<tr>
<td>Extension monitor</td>
<td>Yes</td>
<td>Operator only features</td>
<td>No</td>
</tr>
<tr>
<td>Agent monitor</td>
<td>Yes</td>
<td>No mailbox features</td>
<td>No</td>
</tr>
<tr>
<td>Queue monitor</td>
<td>Yes</td>
<td>No mailbox features</td>
<td>No</td>
</tr>
<tr>
<td>voicemail viewer</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Call history</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>System directory</td>
<td>Yes</td>
<td>No mailbox features</td>
<td>No extension features</td>
</tr>
<tr>
<td>Outlook features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fwd voicemail as wav attachment</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>voicemail form integration</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Outlook Contact/Quick Dialer</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
Self-Audited Licenses

For the following types of self-audited licenses, if the usage exceeds the current number of licences, you will be notified until licensed capacities meet or exceed usage:

- **ShoreTel Personal Access License**: This count includes the number of ShoreTel Personal Communicator licenses needed.

- **ShoreTel Remote Server Software**: This count includes licenses that correspond to additional ShoreTel servers, defined in ShoreTel Director, that correspond to additional voicemail servers. Up to 20 additional ShoreTel remote servers can be configured beyond the initial or Headquarters server.

- **ShoreTel TAPI Application Server**: This count includes licenses for remote TAPI Application Servers that have the “Allow Voice Mailboxes” check box deselected. The number purchased should match the number of deprioritized servers that exist at a particular site.

- **ShoreTel Phone API License**: This count includes licenses for the Phone API. (For more information, contact ShoreTel Professional Services for the appropriate SDK document.)

The license status page has been enhanced to easily be printed or sent via e-mail for purposes of license compliance verification. No license status will be transmitted without explicit action on the part of the administrator.

Sending Contact Information

After providing the required information on the System Parameters Edit Contacts page, you can send it to ShoreTel, Inc. in one of two ways—by email or by regular mail.

- To send the registration information by email, click **Send**. This generates an email message to registration@shoretel.com. It also requires that the SMTP service on the server be properly configured and that the server be connected for email. You can resend the contact information at any time by updating the page and clicking Send.
The MAC address for each ShoreTel voice switch is also included in the registration email.

- To print the registration information for mailing via regular mail, click **Print**. Mail the registration information to the following address:

  Global Support Services — Product Registration  
  ShoreTel, Inc.  
  960 Stewart Drive  
  Sunnyvale, CA 94085

## Administrative Permissions

The Administrator Permissions pages allow the System Administrator to assign and delegate administrative roles to users at one or more sites. Expand the Administrative Permissions link to see all the administrative links. They include:

- Administrators
- Roles

Click the Roles link to see the Administrative Roles list page. This page shows the administrative roles that have been created and summarizes their permissions.

### Administrative Roles

The **Administrative Roles** page allows the System Administrator to assign and delegate administrative roles to users at one or more sites. Expand the **Administrative Permissions** link to see all the administrative links. They include:

- Administrators
- Roles

Click the Roles link to see the Administrative Roles list page. This page shows the administrative roles that have been created and summarizes their permissions.

![Administrative Roles List Page](image)

**Figure 14: Administrative Roles List Page**

Clicking the New button or an administrative title from the Role column invokes the Edit Administrative Roles page (see Figure 15). From here, you can define a new administrative role or change the permissions for an existing role.

To delete a role, select the check box to the left of the entry and then click **Delete**. Note that if the last role with Administrative Permissions Management enabled is removed, then the default **admin** account (as created during initial installation) is re-activated and given complete administrative permissions.
Parameters

Click parameters to enable permissions. Permissions are additive; that is, the more selections, the greater the permissions. Select as many or as few as are needed for the administrative role being defined. For example, a company with one system administrator may have all parameters turned on. As another example, an administrative assistant may have permission to change Distribution Lists at one site.

- **Name**: This is the name of the Administrative Role.
- **Administrative Permissions Management**: This check box assigns permission to create new administrative roles and to assign them to any and all levels of user. This is a powerful permission and should be limited to your lead administrator(s).

- **Account Code Management**: This check box assigns permission to add, change, and delete Account Codes for all sites. As an example of specialized use, very often a department other than Information Technology wants to manage account codes and needs no other permissions. This permission is granted for all sites.

- **System Directory Management**: This check box assigns permission to add, change, and delete entries in the System Directory. This permission is granted for all sites.

- **Report Generation Management**: This check box assigns permission to generate Call Detail Record (CDR) reports via Director from a local host or a remote server.

- **All Other System Management**: This check box controls permission to set dialing plans, system-wide extensions, including route point and workgroup extensions, sites, IP phone options, digit translation tables, voicemail options, auto-attendant options and schedules, user groups, trunk groups, local prefixes, DNIS digit maps, classes of service, call control, system parameters such as password length, AMIS options, call handling defaults, event filters, licenses, extension lists, hunt groups, paging groups, and contact information. This permission is granted for all sites.

- **User Management**: Permission to add, change, and delete users may be granted for all sites or for a set of selected sites. Click All Sites to grant permission system-wide. Click Selected Sites to limit permissions, then highlight the sites to be permitted, and click Add to move them to the permitted list.

  Users whose home ports are at the site(s) selected can be managed by an authorized administrator. This permission allows changes only to users who have no administrative role (that is, for whom none of the four administrative check boxes is checked). Also, changes cannot be made to a user’s administrative role. Only Administrative Permissions Management grants permission to change administrative roles.

  Deny permission by clicking None.

- **User Group Assignment**: The permission to add users to or move users between user groups can be granted for all sites or for a set of selected sites. Click All User Groups to grant permission system-wide. Click Selected User Groups to limit permissions; highlight the user groups to be permitted; and click Add to move them to the permitted list. Select all groups you might be moving users to or from.

  Permission is not extended to adding, changing, or deleting User Group options and Class of Service settings (an administrator would need All Other System Management permission).

  Note that checking the All User Groups includes all user groups currently existing as well as those created after permission is first granted.

  Deny permission by checking None.

- **Distribution List Membership Assignment**: Permission to add or remove users on existing Distribution Lists may be granted for all lists or for a set of selected lists. Click All Distribution Lists to grant permission system-wide. Click Selected Distribution Lists to limit permissions, then highlight the lists to be permitted, and click Add to move them to the permitted list.
Note that permission to create or delete lists is not granted here (an administrator would need All Other System Management permission).

Deny permission by checking None.

- **Basic Workgroup Management:** Permission to add or change options for workgroups may be granted for all workgroups or for a set of selected workgroups. Click All Workgroups to grant permission system-wide. Click **Selected Workgroups** to limit permissions, then highlight the workgroups to be permitted, and click **Add** to move them to the permitted list.

Workgroup attributes not given change permission with this option include workgroup Name, Extension, Backup Extension, DID, DNIS, User Group, Mailbox, Accept Broadcast Messages, Include in Dial By Name, and Make Number Private (an administrator would need All Other System Management permission).

Note that checking the All Workgroups includes all workgroups currently existing as well as those created after permission is first granted.

Deny permission by checking None.

- **Site Management:** Permission to add and alter sites and their related switches, trunks, IP phones, and servers may be granted for all sites or for a set of selected sites. Permission includes access to Quick Look at permitted sites. Permission includes adding and deleting anonymous phones at permitted sites.

Attributes excluded from permission include Trunk Groups (an administrator would need All Other System Management permission).

Deny permission by checking None. Click All Sites to enable changes to all sites in the system. Click Selected Sites and Add sites from the list to enable access to less than all sites in the system.

The initial administrator set up during installation has full permissions. When upgrading the ShoreTel system, current System Administrators are granted full permissions. Current Technical Support users have no permission to change parameters but are allowed to read all pages.

For some Director pages where read-only permission is given to some parameters because all parameters on the page may not be changed, the read-only fields will be grayed out.

ShoreTel Director is delivered with the following default Administrative Roles:

- Accounts and Directories
- Call Center
- Everything Except
- HQ Site
- Reporting
- System Administrator
- Technical Support
- Test Admin Role
- Test Role

The various default roles, along with their permissions, are shown Figure 16.
Assigning an Administrative Role to a User

From Administrative Permissions, click the Administrators link to reach the Administrator List page.

The Administrator List page (Figure 18) shows the administrative role assigned to each user. A user may have only one administrative role assigned. New users are created with no administrative role assigned to them.
After defining the various Administrative Roles, you select which users will be assigned which roles.

To assign an administrative role to a user, click New from the Administrators List page. The pop-up lets you type a User name or click Search to select from a list of users. Then assign a Role from the drop-down list.

Users with no administrative role may not log in to ShoreTel Director.

If desired, you can assign users to the “Reporting” administrative role, which will allow them to run web-based CDR reports while preventing them from doing anything else to modify the configurations in ShoreTel Director.

Click Delete on the Administrator List page to delete users from the list.

You may delete a user by checking the box to the left of a name and clicking the Delete button. Note that you cannot delete all users. At least one user must remain on the list to preclude the occurrence of no one being left to administer the system.
CHAPTER 3

ShoreTel Sites

This chapter contains the following sections, to explain the configuration of a ShoreTel site:

- Overview ................................................................................................................... 78
- Creating a Site .......................................................................................................... 78
- Parameters................................................................................................................ 80
- Using ShoreTel Service Appliances as a Back-up Resource ................................. 85
  - Registering a Service Appliance that is Off the Headquarters Site .................. 86
  - Creating a System Failover Mechanism for Conferencing ............................... 86
Overview

The ShoreTel site is a logical concept designed to help the customer organize the telephony environment. Sites can accommodate geographical requirements, where the external environment affects outbound calls or logical requirements, such as a need to separate users who have advanced functions from standard users. Once a site exists, you can assign servers, switches, appliances, users, other sites, and so on, to it.

You assign features to a site. For example, a site has a country, local area code, site operator, and an admission control setting.

The ShoreTel system has a default site name of “Headquarters.”

Creating a Site

Complete the following steps to create a site:

1. Launch ShoreTel Director.

2. Click Administration > Site. The Sites page appears as shown in Figure 19.

3. In Add new site in, select the country for the site.

4. Click Go. The Edit Site page appears as shown in Figure 20.
<table>
<thead>
<tr>
<th><strong>Sites</strong></th>
<th><strong>Edit Site</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit this record</strong></td>
<td><strong>Refresh this page</strong></td>
</tr>
<tr>
<td>Name:</td>
<td>Headquarters</td>
</tr>
<tr>
<td>Service Appliance Conference Backup Site:</td>
<td>Drop-down list</td>
</tr>
<tr>
<td>Country:</td>
<td>United States of America</td>
</tr>
<tr>
<td>Language:</td>
<td>English (US)</td>
</tr>
<tr>
<td>Parent:</td>
<td>Top of Tree</td>
</tr>
<tr>
<td>Local Area Code:</td>
<td>408</td>
</tr>
<tr>
<td>Additional Local Area Codes:</td>
<td>Edit</td>
</tr>
<tr>
<td>Caller's Emergency Service Identification (CESID):</td>
<td>(e.g., +1 (408) 331-3900)</td>
</tr>
<tr>
<td>Time Zone:</td>
<td>(UTC-8:00) Pacific Time (US &amp; Canada), Pacific Standard Time</td>
</tr>
<tr>
<td>Night Bell Extension:</td>
<td>None</td>
</tr>
<tr>
<td>Night Bell Switch:</td>
<td>Edit Night Bell Call Handling</td>
</tr>
<tr>
<td>Paging Extension:</td>
<td>None</td>
</tr>
<tr>
<td>Paging Switch:</td>
<td>Search</td>
</tr>
<tr>
<td>Operator Extension:</td>
<td>None</td>
</tr>
<tr>
<td>FAX Redirect Extension:</td>
<td>Search</td>
</tr>
<tr>
<td>SMTP Relay:</td>
<td>Ping</td>
</tr>
<tr>
<td>Network Time Protocol Server:</td>
<td></td>
</tr>
<tr>
<td>Bandwidth:</td>
<td></td>
</tr>
<tr>
<td>Admission Control Bandwidth:</td>
<td>0 kbps</td>
</tr>
<tr>
<td>Intra-Site Calls:</td>
<td>High Bandwidth Codecs</td>
</tr>
<tr>
<td>Inter-Site Calls:</td>
<td>Low Bandwidth Codecs</td>
</tr>
<tr>
<td>FAX and Modem Calls:</td>
<td>Fax Codecs - High Bandwidth</td>
</tr>
<tr>
<td>SIP Proxy:</td>
<td></td>
</tr>
<tr>
<td>Virtual IP Address:</td>
<td>None</td>
</tr>
<tr>
<td>Proxy Switch 1:</td>
<td>None</td>
</tr>
<tr>
<td>Proxy Switch 2:</td>
<td>None</td>
</tr>
<tr>
<td>Emergency Number List:</td>
<td>911 Add More...</td>
</tr>
</tbody>
</table>

*Figure 20: Site Edit Page*
For descriptions of the Sites Edit page parameters, see Table 9. For descriptions of the Bandwidth parameters, see Table 10.

### Table 9: Sites Edit Page Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name of a new or existing site. It must be unique.</td>
</tr>
<tr>
<td>Service Appliance Conference</td>
<td>A ShoreTel Service Appliance, such as the SA-100 and SA-400, can have a role as a back-up resource. For the configuration details, see Using ShoreTel Service Appliances as a Back-up Resource on page 85.</td>
</tr>
<tr>
<td>Backup Site</td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td>This is the name of the country in which the site is located.</td>
</tr>
<tr>
<td>Language</td>
<td>This is the default language for the site. You must obtain a license to enable more than one language. For more information see the Licenses on page 63.</td>
</tr>
</tbody>
</table>
| Parent                           | The default parent site is Headquarters. Headquarters does not display the drop-down list of sites. Sites other than Headquarters must select a parent. This server is used for two purposes:  
  - By ShoreTel Director to provide a default server when new users are added  
  - By the call control software in the ShoreTel voice switches so that it knows where to route calls that request voice mail service  
    Only valid parent sites appear in the drop-down list. Child sites and the site currently being edited do not appear. |
| Use Parent As Proxy              | This allows the child site to use the parent site trunk for non-routable calls (911, 611, 011, etc.) if no trunks are available at the child site. The proxy site must be in the same country as the child site. |
| Extension Prefix                 | The On-Net Dialing feature enables the division of phone numbers into two separately managed parts, an extension prefix, which is similar in concept to a site code, and a user extension. This division offers greater flexibility and facilitates integration with legacy phone systems.  
  The Extension Prefix field will not appear in this window until after you have modified the Dialing Plan window, thus enabling the On Net Dialing feature. |
Local Area Code

This defines the local area code of the site so that users can dial local numbers without an area code. In the United States, this is the area code used for seven-digit dialing. For example, when the user dials an access code followed by seven digits at the site, this is the area code they are dialing.

This also defines the area code that is considered local from a call permissions point of view.

Additional Local Area Codes

In the United States, this defines area codes that can be dialed using 10-digit dialing instead of 1+10-digit dialing. For example, if the site is in an overlay area with multiple local area codes that require 10-digit dialing, you can be consistent with the dialing plan in your region by entering the additional area codes in this parameter.

This also defines additional area codes that are considered local from a call permissions point of view.

Caller’s Emergency Service Identification (CESID)

The Caller’s Emergency Service ID (CESID) is the telephone number sent to the service provider when a user dials an emergency services number (e.g., 911 in the U.S.). This feature is only applicable to T1 PRI trunks. Refer to Appendix A, Emergency Dialing Operations for more information.

Time Zone

This is the site’s time zone that is associated with the ShoreTel switches. It is used to deliver the correct time and date to caller ID telephones.

Night Bell Extension

This is the extension that is used to ring the site’s night bell. This extension must be associated with a ShoreTel switch audio output port that you specify as the next parameter. This extension is unique.

You must configure the appropriate switch before assigning the night bell extension.

Night Bell Switch

This is the ShoreTel switch associated with the night bell extension. The night bell extension can share the same switch port as the paging extension.

Paging Extension

This is the extension used for your overhead paging system. This extension must be associated with a ShoreTel switch audio output port that you specify as the next parameter. There is only one paging extension per site.

You must assign switches to the site and select the switch that will support the paging extension before you can save a paging extension.
### Table 9: Sites Edit Page Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paging Switch</td>
<td>This is the ShoreTel switch associated with the paging extension. The paging extension can share the same switch port as the night bell extension. <strong>Note:</strong> This switch must not be a voicemail model switch.</td>
</tr>
<tr>
<td>Operator Extension</td>
<td>This is the extension to which the user is transferred when he or she presses the operator digit for the site (typically “0”). You must configure the appropriate user before assigning the operator extension. This extension is not the Personal Assistant extension defined in the user’s personal options. The Personal Assistant lets the user define the destination to which the caller is transferred after the caller presses “0” upon hearing the user’s voice mail prompt. Instead of the operator’s extension, this extension could belong to an administrative assistant or a colleague.</td>
</tr>
</tbody>
</table>
| FaxRedirect Extension   | When a fax tone is detected in an incoming call, the system automatically transfers the fax call to the fax redirect extension. Each site can have its own fax redirection number. The choice of the fax redirection number to use depends on whether the user or voice mail answers the call, as follows.  
  - If the user answers the fax call, the system uses the fax redirection extension at the user’s site.  
  - If the call is answered by voice mail, the Auto-Attendant or other menu, or a workgroup’s queue step menu, the fax redirection extension at the site where the call originated is used. This is the site with the trunk that processed the inbound external call.  
  The fax redirection extension must be an existing user. |
| SMTP Relay              | Specifies the IP address or FQDN (fully-qualified domain name) of the server to use as the SMTP relay for all voicemail enabled switches on this site.  
  - Ping – Click to verify the SMTP Relay field contains a valid entry. |
| Network Time Protocol Server | Specifies the IP address for the NTP server. |
### Bandwidth Parameters

Table 10: Bandwidth Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admission Control Bandwidth</td>
<td>This defines the bandwidth that voice streams can consume between the local site and all other sites. The caller hears a “network busy” prompt if this value is exceeded. To compute the admission control value for the site, refer to Chapter 3, Network Requirements and Preparation in the Planning and Installation Guide.</td>
</tr>
<tr>
<td>Intra-Site Calls (calls within a site)</td>
<td>This drop-down list has the types of encoding available for making calls within a site.</td>
</tr>
<tr>
<td>Inter-Site Calls (calls between sites)</td>
<td>This drop-down list has the types of encoding used for calls between ShoreTel sites.</td>
</tr>
<tr>
<td>Fax and Modem Calls</td>
<td>This drop-down list has the types of encoding used for faxing or for calls made from a modem.</td>
</tr>
</tbody>
</table>

### SIP Proxy Parameters

SIP Proxy parameters support the ShoreTel SIP extensions. Refer to Introduction to SIP Profiles on page 575 for more information about SIP network elements.

Table 11: SIP Proxy Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual IP Address</td>
<td>This parameter defines the IP address of the site’s SIP Proxy Server and Registrar server. The IP address is independent of the switch that performs the server functions. SIP extensions require that this parameter is set to a valid address.</td>
</tr>
<tr>
<td>Proxy Switch 1</td>
<td>This setting designates the switch that performs the site’s SIP server functions. The drop down menu lists all switches assigned to the site. SIP extensions require a setting for this parameter.</td>
</tr>
<tr>
<td>Proxy Switch 2</td>
<td>This setting designates the switch that performs the site’s SIP server functions when the switch specified by Proxy Switch 1 is not available. This parameter is optional.</td>
</tr>
</tbody>
</table>
Table 11: SIP Proxy Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Number List</td>
<td>This is the list of numbers that can be dialed at the site with or without a trunk access code for emergency services. Note that this number must not conflict with any extensions.</td>
</tr>
<tr>
<td></td>
<td>- Trunk Access Code Required – When this checkbox is selected, a caller must dial the Trunk Access Code before dialing the specified emergency number. If not selected, entering the Trunk Access Code before the Emergency number is permitted, but not required, to complete the call.</td>
</tr>
<tr>
<td></td>
<td>- Data Entry Field – Enter the exact emergency number required to contact the associated Emergency Service Provider. If Trunk Access Code Required is selected, you can also enter a number in canonical format.</td>
</tr>
<tr>
<td></td>
<td>- Add More – Click this button to create additional data entry fields for entering additional emergency numbers. Each site is permitted to have a maximum of ten emergency numbers to accommodate locations where multiple emergency service numbers are required.</td>
</tr>
</tbody>
</table>

Edit IP Phone Address Map | This link opens the IP Phone Address Map Info page for specifying the IP address range for sites other than Headquarters. Refer to Figure 21.

Figure 21: IP Phone Address Map Edit Page
All IP phones are assigned to Headquarters by default. If Headquarters is your only site, you do not need to set IP address ranges. If you have more than one site with IP phones, you must set an IP address range for each site other than Headquarters.

This page is also accessible from the IP Phone Address edit page. For more information, refer to Chapter 8, Configuring IP Phones on page 209.

### Table 12: IP Phone Address Map Info Fields

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>If you are setting the IP address range for a site other than the one shown in the Site drop-down list, select it from the list.</td>
</tr>
<tr>
<td>Low IP Address</td>
<td>This is the lowest IP address in the range of addresses.</td>
</tr>
<tr>
<td>High IP Address</td>
<td>This is the highest IP address in the range of addresses.</td>
</tr>
<tr>
<td>Caller’s Emergency Service Identification (CESID)</td>
<td>Enter the Caller’s Emergency Service ID to be used for IP phones in this IP address range. Enter, for example, +1 (408) 555-5555. This is the telephone number sent to the service provider when a user dials an emergency services number, such as 911 in the U.S., and does not have a DID number or is in a user group for which the DID number is not to be used as CESID. This feature is only applicable to ISDN PRI trunks.</td>
</tr>
<tr>
<td>Teleworkers</td>
<td>This call is an inter site call by the use of inter site codecs. The receiving site adjusts the bandwidth of the teleworker’s call at the receiving end.</td>
</tr>
</tbody>
</table>

---

**Using ShoreTel Service Appliances as a Back-up Resource**

This section describes how to configure two forms of backup that a service appliance can provide.

---

**Note**

An headquarters site does not have any installed service appliances.

**Note**

The main server fails at a site that also has a service appliance.
Registering a Service Appliance that is Off the Headquarters Site

To ensure that all system users have access to service appliance functions when the Headquarters site has no installed service appliances, you can register a service appliance at the Headquarters site as a backup. Registering the back-up site with the Headquarters server establishes a hierarchical branch that gives service appliance services to all users throughout the network.

Registering a Backup Service Appliance Site on the Headquarters Server

Complete the following steps to register a backup service appliance site on the headquarters server:

1. Launch ShoreTel Director.
2. Click Administration > Sites. The Sites page appears.
3. In the Site column, select Headquarters server site. The configuration page for the Headquarters site opens.
4. In the Service Appliance Conference Backup Site scroll list, select the site to use as a back-up site.

   Note
   The backup site can be a logical site.

5. Click Save.

Creating a System Failover Mechanism for Conferencing

The ShoreTel system can ensure that conference resources remain available if the ShoreTel site server to which the service appliance is registered fails. While registering a service appliance at a site, you can also specify a back-up ShoreTel site server that the system can use to access the service appliance if the primary site fails.

Assigning a Service Appliance as a Backup ShoreTel Site Server to Ensure Conferencing Resources after a Failover

Complete the following steps to assign a service appliance as a backup site server:

1. Launch ShoreTel Director.
2. Click Administration > Sites. The Sites page appears.
3. In the Site column, select the ShoreTel server to which the Service Appliance that you wish to associate with a backup site is registered. The configuration page for the site appears.
4. In Service Appliance Conference Backup Site, select the that you want to use as a backup site.
Note
The back-up site must be physically separate from the primary site.

Note
The back-up site can be a logical site.

5. Click Save.
This chapter describes how to set up ShoreTel servers. The topics discussed include:

- Overview ................................................................. 90
- Distributed Voice Mail .................................................. 90
  - IP Phone Limitations/Requirements ................................. 91
  - Communicator Limitations/Requirements ......................... 92
- Legacy Voice Mail Integration .......................................... 92
  - Integration through Simplified Message Desk Interface .......... 92
  - Integration through Q-Signaling Protocols ......................... 93
- Configuring Application Servers ....................................... 95
  - Adding Application Servers ........................................ 95
  - Configuring Application Servers ................................... 98
  - Extension List Mapping .............................................. 103
- ShoreTel Distributed Database ........................................ 104
  - Benefits of a Distributed Database ................................. 104
  - Important Considerations and Warnings ......................... 105
  - Configuration of Distributed Database Service .................. 105
  - Distributed Database Status ....................................... 107
- Fax Server Connection to a ShoreTel Switch ....................... 109
Overview

The ShoreTel system supports not only distributed call control, but also distributed voice application servers. Distributed servers are extremely valuable for two purposes:

- Reducing WAN bandwidth by providing local voice mail and auto-attendant services
- Increasing the scale of the system

Even though there are multiple servers, the ShoreTel system provides a single image of your entire network. The system is currently certified to support up to 21 servers, one main server, and up to 20 distributed servers. Consider adding a server at a site when the site exceeds 100 users. Add a new server for every 1,000 users.

The distributed servers run the following voice applications:

- **Voice Mail** – Each server supports 254 simultaneous voice mail or auto-attendant connections. The voice mail system uses SMTP to transport composed messages between the distributed servers. The ShoreTel system also supports linking to legacy voice mail systems using AMIS protocols.

- **File-Based Music on Hold** – The system uses SMTP to distribute MOH files to the distributed servers.

- **Auto-Attendant** – The system supports up to 1000 menus that are hosted on every server, and each server provides 64 voice mail/auto-attendant connections.

- **Configuration** – The system enables users to log in and make configuration changes, such as call handling modes, from their ShoreTel Communicators client or from the Communicator for Mobile call handling mode client if it is supported.

- **Maintenance** – The system provides a web site accessible through ShoreTel Director for the maintenance of all the remote servers.

The distributed voice applications use a Remote TAPI Service Provider that relies on the call control information from the main server. Using redundant network paths to the main server can improve reliability of the remote server.

**Distributed Voice Mail**

The ShoreTel system uses distributed voice mail to provide high voice mail availability. Each ShoreTel remote server includes an instance of the telephony platform, allowing voice mail and auto-attendant services to maintain full functionality during short-term WAN outages. The enhanced Distributed voice mail on the ShoreTel DVS allows users with mailboxes on the DVS to receive and pick up voice mail messages without depending on WAN connectivity to the headquarters server. The message waiting indicator (MWI) lights correctly update regardless of WAN connectivity.

Additionally, incoming calls can still reach the automated attendant, access the dial-by-name directory, and reach the intended local party during a WAN outage. If a party cannot be directly reached due to a WAN outage and his or her call handling is configured to send unanswered calls to voice mail, the call...
is processed by the local voice mail server. Callers hear a generic greeting, including the called party's recorded name, and can leave a message that is later forwarded to the home voice mail server for the addressee.

Similarly, the enhanced DVS provides greater Communicator availability during WAN outages. If the WAN loses connectivity, users will retain full Communicator functionality as long as there is a DVS at the same site as the users, the users voice mailboxes are on that server, and the DVS is managing the switch that manages the users' phones.

Although each voice mail server is autonomous in delivering voice services, it still must have connectivity to the configuration data stored on the headquarters server in order to make configuration changes. Specifically, users on an isolated remote server would not be able to change call handling modes or make other changes that require modification to the configuration data on the headquarters server.

**IP Phone Limitations/Requirements**

Basic connectivity, which is connectivity between the phone and the switch that is controlling the phone, is required. All aspects of the phone's operation are functional when this basic connectivity exists, with the following exceptions:

- For the ShoreTel 100-Series, 200-Series, and 500-Series IP phones, the Directory feature requires connectivity between the switch and a headquarters server or distributed voice server (DVS) that controls that switch.

- For the ShoreTel 400-Series IP phones, the Directory, History, visual voicemail, user options, and phone user interface assignment features rely on connectivity to the headquarters server or distributed voice server. The ShoreTel IP655 phone also relies on connectivity to the server for Directory, History, and visual voicemail features.

- Options features, Changes to Call Handling Mode (CHM), Wrap-Up: In addition to basic connectivity, these features require either connectivity between the switch and an headquarters server or DVS that controls that switch. In addition, if the aforementioned switch is a DVS, connectivity is required between that server and the headquarters server or Distributed Database (DDB) services must be enabled for the DVS. Further, connectivity between the DVS and the headquarters server is required for successful synchronization between the Replication Master and Slave databases.

Switch-to-switch extension monitoring: This condition exists when a programmed button requires monitoring activity on an extension that is serviced by a different switch than the one that controls the phone. For example, if switch A, which is the phone's switch, is controlled by server X, and switch B, which is the monitored extension's switch, is controlled by server Y, then servers X and Y may be a DVS or the headquarters server. For proper functionality of the switch-to-switch extension monitoring, the following conditions must exist:

- Switch A must be able to talk to server X.
- Server X must be able to talk to server Y.
- Server Y must be able to talk to switch B.
- If X and Y are the same, connectivity is, of course, assumed to exist.
Auxiliary information about incoming calls, such as trunk information and called workgroup information, requires connectivity between the switch and a headquarters server or DVS that controls that switch.

Communicator Limitations/Requirements

The following list details limitations and requirements for using Communicator:

- **Communicator**: Communicator utilizes two communications channels, TAPI and CSIS. TAPI is used to communicate with the server that manages the switch that manages the user's phone regardless of whether the phone is an analog or IP phone. CSIS is used to communicate with the user's voice mail server. These two servers are often the same device. As long as the client can reach these two servers, Communicator is fully functional.

- **First-time Communicator users**: When a user logs into Communicator for the first time, CSIS and TAPI both communicate with the headquarters server to find out which server they need to use. Thus, for first-time users, a connection is required between the client and the headquarters server regardless of where voice mail and extensions are serviced.

- **Workgroup functionality**: If users are configured to have workgroup functionality, they can access the mailboxes of all workgroups to which they belong. This requires connectivity to the server(s) on which those mailboxes reside.

Legacy Voice Mail Integration

Integration through Simplified Message Desk Interface

ShoreTel integrates with legacy phone systems for customers who would like to have the freedom and flexibility to continue to use their legacy systems while migrating toward a newer IP telephony solution. The legacy system must continue to work flawlessly regardless of whether calls are traversing the ShoreTel PBX on their way to the legacy voice mail system, or they are traversing the legacy PBX on their way to ShoreTel voice mail.

To address these needs, ShoreTel uses the Simplified Message Desk Interface (SMDI) protocol. SMDI allows dissimilar voice mail and PBX systems to work together. The protocol evolved at a time when voice mail services and PBX services were provided by separate physical devices, and enabled the disparate devices to share information over an out-of-band serial cable connection.

There are two modes of operation with respect to integrating a ShoreTel system and a legacy system using SMDI:

- **External voice mail** – In this configuration, the legacy system provides voice mail services while the ShoreTel system acts as the PBX for users.

- **ShoreTel voice mail** – In this configuration, the ShoreTel system provides voice mail services while the legacy system acts as a PBX for users.
Voice mail extension lengths for the legacy voice mail system may be different from the ShoreTel voice mail extension lengths. In this case, digit translation information is required. For more information about digit translation tables, refer to Creating a Digit Translation Table on page 48.

For more information about integration to legacy voice mail systems using SMDI, refer to the Planning and Installation Guide.

Integration through Q-Signaling Protocols

ShoreTel supports the integration of the ShoreTel Unified Communications solution with other PBX platforms and the Q-Signaling protocol (QSIG) supplemental services for call diversion and message-waiting indication. Refer to Integration through Q-Signaling Protocols on page 93 for details about configuring basic QSIG services. This integration allows a voice mail system located on either side of the QSIG link to be used by other system administrators to configure a ShoreTel user for voice mail that is hosted on a legacy PBX system using the same QSIG trunks on the same system.

QSIG is a Common Channel Signaling (CCS) protocol that runs over the ISDN D-channel for signaling between nodes in a Private Integrated Services Network (PISN). QSIG supports call setup, call tear down, and transparency of features such as message waiting, camp-on, and callback.

The current release of ShoreTel supports both ECMA and ISO versions of QSIG.

Configuring ShoreTel Users for External Voice Mail with QSIG

The process for configuring QSIG External Voice Mail involves the following activities:

- Configuring a QSIG Tie Trunk to integrate with the external system. Refer to Chapter 7, Configuring Trunks on page 165 for details about configuring tie trunks.

- Defining QSIG Server integration

- Configuring a User Group for use of external QSIG Voice Mail

- Creating an Extension-Only user in the User Group

Use the following steps to configure QSIG External Voice Mail:

1. Launch ShoreTel Director.

2. Click Administration > Voice Mail > External Voice Mail (QSIG) menu. The External Voice Mail Servers (QSIG) page appears as shown in Figure 22.
3. Select a site and click its name to open External Voice Mail, shown in Figure 23.

4. Type the Name of the integration and the Pilot Number for the voice mail. The pilot number is typically the OSE number for voice mail login or redirection.

5. Configure a User Group that uses external QSIG voice mail by selecting External Voice Mail, QSIG in the drop-down list for Voice Mail Interface Mode.
Configuring Legacy Users for ShoreTel Voice Mail through QSIG

The following steps describe the procedures necessary to configure an external user with ShoreTel voice mail service with QSIG External Voice Mail.

1. Launch ShoreTel Director.
2. Click Administration > Application Servers > HQ / DVS. In the Voice Mail Interface: field, select Mode: as None from the drop-down list.
3. Configure a Mailbox-Only account for the external user. The external user is now configured for ShoreTel voice mail on the ShoreTel system.

See the Planning and Installation Guide for sample use cases for implementing legacy users with ShoreTel Voice Mail QSIG.

Important Considerations

The following list includes important considerations to make when configuring application servers:

- The diversion implementation on both sides is not limited to voice mail service. Diversion due to call-forwarding, for example, is signaled by the same methods.
- Some ShoreTel features, such as Find Me, can result in multiple trunks being used to host a call.
- No QSIG channel usage is available for secondary calls. Refer to ShoreTel's Norton Option 11C QSIG application note for more details on configuring this feature.

Configuring Application Servers

Adding Application Servers

The Application Servers > Headquarters/DVS link in the ShoreTel Director navigation frame provides access to the Application Servers list, which is shown in Figure 26. The Application Servers list page is presented in alphabetical order.
By default, a ShoreTel system is configured with one server at the headquarters site. Additional sites must have been configured before the steps in this section become available. For more information on adding remote sites, see Chapter 3, ShoreTel Sites on page 77.

![Application Servers List](image)

**Figure 26: Application Servers List**

**Note**

With DDB enabled, if you upgrade the HQ server with unsupported client ID, country, or language, you must manually re-sync the HQ server.

**Adding a New Server**

1. In **Add new application server at site**, select the site.
2. Click **Go**. The Application Servers edit page appears as shown in **Figure 27**.
3. Enter parameters for the new server as described in the Configuring Application Servers on page 98.

4. Click Save.

**Editing an Existing Server**

1. Select a server from the list in the Name column. The Application Servers edit page appears as shown in Figure 27.

2. Change parameters as needed for the new server.

3. Click Save.
Configuring Application Servers

Figure 27 on page 97 displays the Application Servers Edit page. Table 13 includes a list of parameters configured on this page.

Base Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name of a new or existing server.</td>
</tr>
<tr>
<td>Host IP Address</td>
<td>This is the IP address of the server. If you enter the server host name, Director resolves the IP address when you click <strong>Ping this Server</strong>. You can also use the <strong>Ping this Server</strong> button to test the connectivity between your client PC and the new server. In system configurations that support Failover, this parameter specifies the Primary Server IP address. Refer to Chapter 21, System Backup and Restore on page 739 for Failover information.</td>
</tr>
<tr>
<td>Secondary IP Address</td>
<td>This is the IP address of the back-up server that can begin active control if a system error causes a failover. See Chapter 21, System Backup and Restore on page 739 for information on system failover, backup, and restore.</td>
</tr>
<tr>
<td>Site</td>
<td>This is the physical location of the server. The location of the server is used to calculate bandwidth consumption for the purposes of admission control.</td>
</tr>
<tr>
<td>SoftSwitch Name</td>
<td>This is the name of the SoftSwitch on the server you are editing. ShoreTel automatically creates a SoftSwitch for each server on the system.</td>
</tr>
<tr>
<td>Maximum Trunks for Voice Mail Notification (1 - 200)</td>
<td>This is the maximum number of trunks that can be used in the event of a voice mail notification. If many escalation profiles have been configured, it may be desirable to set this to a relatively low number to prevent notifications from overwhelming the system and making it impossible for users to make an outbound call.</td>
</tr>
<tr>
<td>Account Code Local Extension</td>
<td>This is the account code for local extensions. This is set automatically for the HQ server. For DVS, this is set manually.</td>
</tr>
<tr>
<td>Enable File Based Music on Hold</td>
<td>Select this check box to enable file based MOH streaming from this server.</td>
</tr>
<tr>
<td>Music on Hold Local Extension</td>
<td>This is the extension used by the music-onhold server. This extension must be configured when file-based MOH is enabled.</td>
</tr>
</tbody>
</table>
Voice Mail and Auto-Attendant

Table 14: Voice Mail and Auto-Attendant Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice Mail Extension</td>
<td>This extension is used by the voice mail server.</td>
</tr>
<tr>
<td>Voice Mail Login Extension</td>
<td>This extension is used to log in to the voice mail server.</td>
</tr>
<tr>
<td>Auto-Attendant Extension</td>
<td>This extension is used by the auto-attendant server.</td>
</tr>
<tr>
<td>Assigned User Group</td>
<td>This is the assigned user group for the server. Because voice mail places outbound calls, the server must have assigned permissions.</td>
</tr>
<tr>
<td>Default Auto-Attendant Menu</td>
<td>Each server can have a different default auto-attendant menu. This is the menu reached when none is specified - for instance, when a caller dials 9 to escape from voice mail and return to the auto-attendant.</td>
</tr>
</tbody>
</table>

Database

Specifies whether the MySQL database is to be distributed and stored locally on the headquarters system. See the ShoreTel Distributed Database on page 104 for information on ShoreTel Distributed Database service.

External Voice Mail Parameters

Figure 28 shows the Application Servers Edit page when Simplified Message Desk Interface is set to External Voice Mail. The configurable parameters in this window are described in Table 15.
## Table 15: External Voice Mail Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Voice Mail</td>
<td>If this application server is to function as a PBX for a legacy voice mail system, select this option.</td>
</tr>
<tr>
<td>COM Port (1-10)</td>
<td>This is the COM port used by SMDI.</td>
</tr>
<tr>
<td>Message Desk Number (1-999)</td>
<td>The Message Desk default is 1. Valid values are 1 through 999. Set the number that the voice mail system expects. This parameter is most often set to 1, since only one system will be using the SMDI link. In some configurations, however, a number of SMDI links can be daisy-chained together and the Message Desk Number value is used to allow each system to know which data belongs to it.</td>
</tr>
<tr>
<td>Number of Digits (2-32)</td>
<td>This field sets the number of digits the ShoreTel system sends in the SMDI extension fields. Set this number to the value the voice mail system expects, most commonly 7 or 10. If the number of digits and the ShoreTel system extension value differ, the extension number is padded. For example, if ShoreTel needs to send extension 456 and the Number of Digits field is equal to 7, extension 0000456 is sent. If no padding is desired, the Number of Digits field would be set to 2 in this example. Then, only 456 is sent.</td>
</tr>
<tr>
<td>Translation Table Use for Call Data</td>
<td>This check box indicates that the digit translation table is to be used for call data, when checked. Both Translation Table boxes may be checked at the same time.</td>
</tr>
<tr>
<td>Translation Table Use for MWI Data</td>
<td>This check box indicates that the digit translation table is to be used for Message Waiting Indicator data, when checked. Both Translation Table boxes may be checked at the same time.</td>
</tr>
<tr>
<td>Extension List (extension - port - logical terminal number)</td>
<td>The SMDI message must contain the user extension, port number, and logical terminal number (exact trunk number). Note that these extensions forward to the Backup Auto-Attendant on No Answer or Busy.</td>
</tr>
</tbody>
</table>
External Voice Mail parameters

Figure 29 displays the Application Servers Edit page when Simplified Message Desk Interface is set to ShoreTel Voice Mail. The configurable parameters in this window are described in Table 16.

Table 16: External Voice Mail Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShoreTel Voice Mail</td>
<td>If this application server is to function as a voice mail server for a legacy PBX, check this box.</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>Select the trunk group to be used by the legacy PBX for voice mail traffic.</td>
</tr>
<tr>
<td>COM Port (1-10)</td>
<td>This is the COM port used by SMDI.</td>
</tr>
<tr>
<td>Message Desk Number (1-999)</td>
<td>The Message Desk default is 1. Valid values are 1 through 999. Set the number that the voice mail system expects. This parameter is most often set to 1, since only one system will be using the SMDI link. In some configurations, however, a number of SMDI links can be daisy-chained together and the Message Desk Number value is used to allow each system to know which data belongs to it.</td>
</tr>
</tbody>
</table>
Number of Digits (2-32)  This field sets the number of digits the ShoreTel system sends in the SMDI extension fields. Set this number to the value the voice mail system expects, most commonly 7 or 10. If the number of digits and the ShoreTel system extension value differ, the extension number is padded. For example, if ShoreTel needs to send extension 456 and the Number of Digits field is equal to 7, extension 0000456 is sent. If no padding is desired, the Number of Digits field would be set to 2 in this example. Then, only 456 is sent.

Translation Table  Select a translation table from the drop-down list. For information on creating translation tables, see Creating a Digit Translation Table on page 48.

Use for Call Data  This check box indicates that the digit translation table is to be used for call data, when checked. Both Translation Table boxes may be checked at the same time.

Use for MWI Data  This check box indicates that the digit translation table is to be used for Message Waiting Indicator data, when checked. Both Translation Table boxes may be checked at the same time.

Use Flash to Route Calls  Select this checkbox to use flash, such as a short hang-up, to provide signaling instructions to a PBX, to route calls between the ShoreTel voice mail system and the legacy PBX. Enabling this feature may result in a more efficient trunk allocation.

Note that analog trunks support the use of flash for this purpose, but other types of trunks, such as T1, do not.

Clear this checkbox to prevent the system from attempting to use flash to route calls.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Digits (2-32)</td>
<td>This field sets the number of digits the ShoreTel system sends in the SMDI</td>
</tr>
<tr>
<td>Translation Table</td>
<td>extension fields. Set this number to the value the voice mail system</td>
</tr>
<tr>
<td>Use for Call Data</td>
<td>This check box indicates that the digit translation table is to be used for</td>
</tr>
<tr>
<td>Use for MWI Data</td>
<td>This check box indicates that the digit translation table is to be used for</td>
</tr>
<tr>
<td>Use Flash to Route Calls</td>
<td>Select this checkbox to use flash, such as a short hang-up, to provide</td>
</tr>
</tbody>
</table>

Note that analog trunks support the use of flash for this purpose, but other types of trunks, such as T1, do not.

Clear this checkbox to prevent the system from attempting to use flash to route calls.
To add extension list mapping to an application server configured for external voice mail, click Add found near the bottom of the Application Servers edit page. The External Voice Mail dialog box appears as shown in Figure 30.

Extension List Mapping

Enter the Extension to be used to access the legacy voice mail system. Also enter the physical Port to be assigned to the extension. And finally, include the Logical Terminal Number for the extension. Trunks in the trunk group that sends calls to external voice mail use a Logical Terminal Number. Make as many entries as are necessary.

For application servers configured for ShoreTel voice mail, select a translation table from the Translation Table drop-down list. For more information on creating a digit translation table, see Creating a Digit Translation Table on page 48.
ShoreTel Distributed Database

Organizations with remote sites often rely on the headquarters location to host and maintain the database for the entire company. A database at the headquarters gives convenient access to IT groups for upgrades and real-time maintenance activities.

Customers can also deploy a read-only copy of the ShoreTel database on ShoreTel's Distributed Application Servers. Using a distributed database speeds up local queries and can reduce network traffic. Scalability is improved because the headquarters server is not a bottleneck for database accesses.

Applications on the Distributed Application Servers typically connect to a copy of the database that runs on the local server.

Three write operations are possible on the local Distributed Application Server, as follows:

- User-changes to Call Handling Mode
- Agent logins and logouts
- Re-synchronization of SIP phone registration

All other write operations are performed on the database at the headquarters server.

Note

Initial registration for SIP phones still requires a write to the headquarters server. Also, initial login of users and agents requires write operations to a headquarters server.

Benefits of a Distributed Database

This section outlines some of the benefits of activating the DDB feature.

- Availability – A server at a remote site with a DDB can run without disruption if the headquarters server becomes unavailable. If necessary, the system administrator can reboot the remote server without connectivity to the headquarters server.

- Scalability – Implementing a DDB on remote servers can reduce the workload on the Headquarters. The remote server can respond to queries locally.

- A distributed database also provides the following benefits:
  - ShoreTel Communicator users do not need access to the headquarters server to modify CHM.
  - Normally, the administrator does not need to perform additional tasks after completing the initial configuration. The database on the headquarters server acts as the replication master, and remote servers are replication slaves.
  - Updates from the remote server automatically go to the headquarters database. All applications continue working without changes while the headquarters system is unavailable and continue to work while the headquarters database is receiving updates.
Important Considerations and Warnings

This section contains important information for system administrators who are configuring servers.

- Voice Mailbox Server switches do not host copies of the database.
- In the current release, the Distributed Database feature and the Distributed Workgroups feature cannot be active on the same ShoreTel system at the same time. The choice for which feature is more important for the current release depends on the needs of the customer.
- When DDB is active, changing the name of the remote application server (DVS) breaks the database replication. To re-establish DDB replication between the headquarters and the DVS servers, delete the log file and then manually re-synchronize the databases. The log file is located at \C:\Shoreline Data\Database\ShoreTelConfig\Data\relay-log.info.
- When the DVS is down for an extended period of time and then comes back up, the DDB is not automatically re-synchronized with the headquarters database. In this case, you must manually re-synchronize the databases.

Configuration of Distributed Database Service

Configuring the Replication Master and Slave

The ShoreTel installer configures the headquarters database as the replication master by enabling replication for new installations and for upgrades. By default, the ShoreTel installer installs a MySQL instance on every remote server. However, this MySQL instance is not a writable copy of the ShoreTel database.

All applications on the remote server normally point back to the headquarters database by default. For an application to use the local copy of the MySQL database, certain configuration steps are necessary.

Configuring Distributed Application Servers to Host the ShoreTel Database

The Headquarters/DVS Edit Server page contains a section for specifying the location of the database server. See Database in Figure 31.
Administrators can create a local database by selecting the appropriate check box. The database instance can be created on the remote server as needed.

For example, a Distributed Voice Server can use the headquarters database when initially installed. As the demands on the headquarters server increase, the administrator may decide to add a local database instance on the DVS and configure the applications on the DVS to use the local database. ShoreTel provides a drop down list that will allow the DVS to switch to other databases, thus allowing for local or default database operation. For DVS’s not configured with a local database, including VMBs, the administrator needs to select a proper database, usually a database server on the same site. Otherwise, the default action is to use the headquarters database.

When Create Local Database is unchecked, the local database instance will be removed. If the local database is referenced by other DVS’s, the operation will fail. If the DVS that hosts the database is the only one that references the database, deletion of the local database will be allowed. The DVS will then be switched to use the headquarters database.

**Note**

To reduce network traffic, we recommend that the database dump file be compressed before transferring.

**Steps for Configuration of Replication Servers**

After the Remote Application Server or DVS is configured to use a local database, the following steps need to be completed to start the replication process.
1. Back up the database on the headquarters system with the replication log position and transfer the dump file from the headquarters system to the DVS system.

**Note**
To reduce network traffic, we recommend that the database dump file be compressed before transferring.

2. Modify the my.ini file to enable the replication slave on the local DVS.

3. Set up the replication master and start replication services using the SQL command.

4. Restart the MySQL service to complete the configuration process.

5. Restore the dump file on the DVS to create the local database instance and set the replication log position.

**Note**
These steps involve operations on both the headquarters and the DVS systems and must be coordinated to ensure proper operation.

### Distributed Database Status

#### DDB in Quick Look

The Quick Look page in ShoreTel Director shows the database replication status in the Servers area. If a DDB is present, a small disk icon under the DB heading on the server line indicates the server has a database instance. Green and red color coding shows replication status. Refer to Figure 32 for examples of these features.

To see status for more services in addition to the database on the server and to start or stop individual services, click the name of the server.
DDB in the Main Server Maintenance Menu

The database section in the Main Server Maintenance page, shown in Figure 33, shows the master status, which includes the master log file name and master log position. These fields are in the Database area, just above the center of Figure 33. Administrators can compare this information with the slave database information on the DVS maintenance page to determine how far out of sync the remote database instance and headquarters system might be. If connectivity to the headquarters server is long-term, you can manually synchronize the systems. The synchronization point is the last snapshot performed on the master database. Clicking the Snapshot button at the bottom of the Database area triggers an instant snapshot of the database that is used for synchronization or installation purposes.

The link shown in Figure 33 that opens the popup for starting or stopping the database update service is ShoreTel-DBUpdate Svc.

Refer to Chapter 19, Maintenance on page 627 for information about maintenance windows and procedures.
Fax Server Connection to a ShoreTel Switch

A ShoreTel Voice Switch can connect directly to a fax server. End-users can receive faxes sent to their primary phone. When a call is answered either by the original called user or through call forwarding, the system redirects it to the fax redirection extension.
The fax redirection extension is the first port allocated to the fax server. When multiple switch ports are
dedicated to the fax server, a fax call to the user phone is redirected to the first port connected to the
fax server. If the first port is busy with a call, the fax goes to the next port.

The sequence of events for a fax call is as follows:

1. When the fax call is answered by the user’s primary ShoreTel phone, the ShoreTel switch
   immediately sends the original user’s extension as DTMF.

2. The fax server detects the completion call when the loop current switches off.

3. When the fax call is complete, the fax server looks up the user extension in its configuration and
   then routes the fax to the called user.

The fax can go to the user as an email attachment if the fax server is configured to support this
function.

For more information on fax server integration, refer to the Planning and Installation Guide.
This chapter provides a general overview of the ShoreTel Voice Switches and information on how to configure them through ShoreTel Director. A ShoreTel Voice Switch connects to the IP network over a 10/100/1000M Ethernet port.

For more information about the features supported outside the U.S. and Canada, see Appendix A, "International Planning and Installation" in the ShoreTel Planning and Installation Guide.

Topics discussed include:

Switch Types ........................................................................................................... 113
   ShoreTel 1-U Half-Width Voice Switches.......................................................... 113
   ShoreTel 1-U Full Width Voice Switches........................................................... 114
   Virtual Switches .............................................................................................. 114
Switch Resources ................................................................................................... 114
   Analog Circuits.............................................................................................. 115
   Digital Circuits............................................................................................... 115
   IP Phone Ports............................................................................................... 115
   SIP Trunks ...................................................................................................... 116
   SIP Proxies .................................................................................................... 116
Configuration Parameters ....................................................................................... 116
   IP Phone, SIP, and Make Me Conference Support........................................... 117
   Backup Operator .......................................................................................... 117
ShoreTel Director Pages for Voice Switches........................................................... 117
   Configuring Primary Voice Switches and Service Appliances ...................... 117
   Voice Switches Page ..................................................................................... 119
   Failover for IP Phones: Spare Switch............................................................ 129
ShoreTel Voice Switches that Can Be Spare Switches ........................................ 131
Adding a Spare Switch to the System ............................................................... 131
Enabling IP Phone Failover ............................................................................ 132
Temporarily Disabling IP Phone Failover ....................................................... 133
Performing a Manual Fail Back ..................................................................... 133
Restoration ..................................................................................................... 133
Configuring Softswitches ................................................................................. 136
T.38 Support on ShoreTel Switches ............................................................... 137
Usage ............................................................................................................ 137
Important Considerations .............................................................................. 138
Enabling T.38 on a ShoreTel Switch ............................................................... 139
Third-Party T.38 Configuration Support ......................................................... 140
Switch Types

The following types of ShoreTel voice switches are available:

- 1-rack unit (RU or just U) Half-width Switches (1 U is 1 3/4 inches)
- 1-U Full Width Switches
- Virtual switches

The sections that follow briefly introduce each switch family. See the “ShoreTel Voice Switches” appendix in the *ShoreTel Planning and Installation Guide* for details about voice switches. This appendix includes LED behavior, interface details, capacity, and front panel illustrations.

ShoreTel 1-U Half-Width Voice Switches

The ShoreTel 1-U Half-Width Switch family is the most recent ShoreTel Voice Switch design. These switches can support ShoreTel IP phones, softphones, SIP trunks, and SIP devices. 1-U Half-Width Switches have a smaller footprint, use less power, and have lower heat dissipation requirements than earlier ShoreTel Voice Switches. These switches offer higher granularity in the number of IP users supported, allowing customers to precisely program the switch to satisfy their requirements. The switches can be stacked or mounted in a standard 19-inch rack. Rack mounting 1-U Half-Width Switches requires the ShoreTel Dual Tray. One or two switches are inserted side-by-side into the Dual Tray, which is then mounted into the 19-inch rack. Note that “V” voice switches support both voice mail and auto-attendant applications.

ShoreTel 1-U Half-Width Voice Switch models include:

- ShoreTel Voice Switch 90V
- ShoreTel Voice Switch 90
- ShoreTel Voice Switch 50V
- ShoreTel Voice Switch 50
- ShoreTel Voice Switch 30
- ShoreTel Voice Switch 90BRIV
- ShoreTel Voice Switch 90BRI
- ShoreTel Voice Switch 30BRI
- ShoreTel Voice Switch 220T1
- ShoreTel Voice Switch 220T1A
- ShoreTel Voice Switch 220E1
- ShoreTel Voice Switch T1k
- ShoreTel Voice Switch E1k
ShoreTel 1-U Full Width Voice Switches

The ShoreTel 1-U Full Width Switch family models support analog, IP, Session Initiation Protocol (SIP), T1, and E1 voice and data streams. Full width switch models can be stacked or mounted in a standard 19-inch equipment rack. These switches have a height of 1 U and an RJ21X connector for connection to analog phones and trunks. They also have redundant Ethernet LAN connections to ensure availability.

The ShoreTel 1-U Full Width Voice Switch models include:

- ShoreTel Voice Switch 24A
- ShoreTel Voice Switch T1
- ShoreTel Voice Switch E1

Virtual Switches

With the proper ShoreTel license and VMware software configuration, ShoreTel offers the capability to configure the following types of virtual switches:

- A ShoreTel Virtual Phone Switch (vPhone Switch) can support up to 1,000 IP phones, depending on the configuration. In addition, virtual phone switches support the following features:
  - Backup auto attendant
  - Make Me conferences
  - Hunt groups
  - Pick up groups
  - Bridged call appearance
  - Extension monitoring

- A ShoreTel Virtual Trunk Switch (vTrunk Switch) can support up to 500 SIP trunks, depending on the configuration. In addition, virtual trunk switches support backup auto attendant.

Note

If a vTrunk or a vPhone switch is not using the default private IP addresses, the switch does not communicate with other system switches. See Specifying a Range of Trusted IP Addresses on page 52.

Switch Resources

ShoreTel voice switches provide telephony, IP phone, and SIP phone resources to ShoreTel users. Each voice switch offers a combination of resources that can be customized to support specific, individual configurations.

This section describes the resources available on ShoreTel voice switches. The description for each model details the features available on the switch.
Analog Circuits

Voice switches offer three analog circuits: Extensions, DID trunks, and Loop Start trunks.

- **Extensions**: Extensions are telephony foreign exchange station (FXS) circuits that:
  - Transmit and receive voice signals
  - Supply power to phones
  - Provide the ring signals and dial tone
  - Indicate on-hook or off-hook state

  ShoreTel Director shows extensions as *analog ports*. They are assigned to user extensions.

- **DID Trunks**: DID trunks support inbound the Loop Reversal trunks that provide DID service from the central office. DID trunks are assigned to trunk groups.

- **Loop Start Trunks**: Loop start trunks are foreign exchange office (FXO) circuits that support inbound and outbound calls on IP phones. These trunks accept ring signals, go on-hook and off-hook, and transmit and receive voice signals. Extensions (shown in ShoreTel Director as analog ports) are assigned to trunk groups.

---

**Note**

ShoreTel Director pages show analog extensions as *ports*. For example, the heading under which extensions are displayed in ShoreTel Director is labeled “Port.”

Digital Circuits

ShoreTel offers T1, E1, and BRI digital circuits that support Channel Associated Signaling (CAS) and Integrated Digital Service Network (ISDN) signaling through various 1-U Half-Width and 1-U Full-Width switches. Circuit channels are configured in ShoreTel Director Switch Edit pages.

IP Phone Ports

ShoreTel voice switches support varying numbers of ShoreTel IP phones, as specified by the Switch Edit page in ShoreTel Director. IP phone resources are allocated as follows:

- **Port Allocation**: Switch processing resources that support Digital and Analog ports on most ShoreTel Voice Switches can be reallocated to support five IP phone ports. For example, resources on a switch that supports 12 analog ports can be reallocated to support 60 IP phone ports.

- **Built-in Capacity**: Many switches provide processor resources that support IP phones without disabling telephony ports. Resources allocated to support IP phones cannot support SIP trunks or SIP proxies.
SIP Trunks

ShoreTel Voice Switches support varying numbers of SIP trunks, as specified by the Switch’s Edit page in ShoreTel Director. SIP trunk resources are allocated as follows:

- Port Allocation: Switch processing resources that support Digital and Analog ports on most ShoreTel Voice Switches can be reallocated to support five SIP trunks. For example, resources on a switch that supports 12 analog ports can be reallocated to support 60 SIP trunks.

- Built-in Capacity: Many switches provide processor resources that support IP phones without disabling telephony ports. Resources allocated to support IP phones cannot support SIP trunks or SIP proxies.

SIP Proxies

ShoreTel switches support varying numbers of SIP proxies, as specified by the ShoreTel Director > Administration > Voice Switches/Service Appliances > Primary > Voice Switches page. SIP proxy resources are allocated as follows:

- Port Allocation: Switch processing resources that support Digital and Analog ports on most ShoreTel switches can be reallocated to support 100 SIP proxies. For example, resources on a switch that supports 12 analog ports can be reallocated to support 1200 SIP proxies.

- Built-in Capacity: Many switches provide processor resources that support IP phones without disabling telephony ports. Resources allocated to support SIP proxies cannot support SIP trunks.

Configuration Parameters

Before configuring your switches in ShoreTel Director, you must determine the IP and MAC address assignments for each voice switch. Refer to the ShoreTel Planning and Installation Guide for more information about getting an IP address for each voice switch.

The items that you need before you begin configuring your switches are:

- Type of each voice switch you are configuring.
- Internet Protocol (IP) address of each switch.
- Ethernet address (MAC address) of each switch.

For ShoreTel 1-U Full-Width and Half-Width voice switch models, the type of the switch and the Ethernet address (MAC address) of the switch are printed on the rear panel of each voice switch.
IP Phone, SIP, and Make Me Conference Support

If the system is using IP phones, SIP devices, or SIP trunks, you must allocate ports on ShoreTel voice switches. Each allocated port supports one of the following configurations:

- 5 IP phones
- 5 SIP trunks
- 100 SIP devices
- 1 conference port

Make Me conference is used when a third-party SIP endpoint or ShoreTel Mobility is involved in a conference call with three or more participants (the maximum is six participants). All the Make Me conference settings are valid in this situation. Although only three parties are involved in a conference call involving a SIP endpoint or a ShoreTel Mobility, four Make Me conference ports are reserved as this is an enforced rule for all Make Me calls. For information about the conference involving a SIP trunk, see Conferencing and SIP Trunks on page 577.

Make Me conference is also used when four or more ShoreTel 400-Series IP phones are involved in a conference call.

If you do not reserve sufficient ports for IP phones on the voice switches, the ShoreTel system does not recognize some or possibly all IP phones. For more information about ShoreTel system requirements, see the ShoreTel Planning and Installation Guide.

Backup Operator

ShoreTel Voice Switches feature a backup operator in case the site operator is unreachable due to a network outage. For most switches, the backup operator is on the same port as the Power Fail Transfer port. To use this feature, select the port to match the switch model:

- Port 1 and 12 on the ShoreTel Voice Switch 50V.
- Port 1 and 12 on the ShoreTel Voice Switch 90V.
- Port 12 on the ShoreTel Voice Switch 30, ShoreTel Voice Switch 50, ShoreTel Voice Switch 90, and ShoreTel Voice Switch 220T1A.

ShoreTel Director Pages for Voice Switches

After a ShoreTel voice switch has been installed, you can configure its parameters in the ShoreTel Director pages. This section describes the pages for configuring and monitoring ShoreTel voice switches. Subsequent sections provide details about the switch parameters.

Configuring Primary Voice Switches and Service Appliances

The Primary Voice Switches/Service Appliances page (Figure 34) lists the ShoreTel switches installed in the ShoreTel network. To access the page:

1. Launch ShoreTel Director.
2. Click Administration > Platform Hardware > Voice Switches/Service Appliances > Primary.

The Primary Voice Switches/Service Appliance page shown in Figure 34 appears.

![Figure 34: Primary Voice Switches/Service Appliances Page](image)

On the Primary Voice Switches/Service Appliances page:

- Each row corresponds to one voice switch or Service Appliance installed in the ShoreTel network.
- Each column corresponds to a switch parameter. These parameters are described in Table 17 on page 118.

### Table 17: Voice Switch/Service Appliance Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the switch or Service Appliance. Clicking a name takes you to the Voice Switches page, where you can modify the switch configuration.</td>
</tr>
<tr>
<td>Quick Launch</td>
<td>Link for launching the Conference Administration page. Clicking a link lets you open the Conference Administration page for a Service Appliance.</td>
</tr>
<tr>
<td>Description</td>
<td>Describes the switch. This field is an optional entry that typically tells where the switch is located or describes how it is used. For example, the switch description might indicate the wiring closet where the switch is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Name of the site where the switch is located.</td>
</tr>
<tr>
<td>Server</td>
<td>Name of server configured to manage the switch.</td>
</tr>
<tr>
<td>Database Server</td>
<td>Name of the database server the device uses for backup.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of switch.</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the switch.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>MAC address of the switch.</td>
</tr>
<tr>
<td>Serial Number</td>
<td>Serial number of the device.</td>
</tr>
<tr>
<td>IP Phones in Use</td>
<td>Number of IP phones connected through the switch.</td>
</tr>
<tr>
<td>IP Phones Capacity</td>
<td>Number of IP phones the switch can support based on the number of ports reserved for IP phones.</td>
</tr>
<tr>
<td>SIP Trunks in Use</td>
<td>Number of SIP trunks connected through the switch.</td>
</tr>
</tbody>
</table>
Adding a New Switch at a Site

1. Choose the site from the Add new switch/appliance at site drop-down list.
2. Choose the type of switch from the of type drop-down list.
3. Click Go.

   The Voice Switches page for the specified switch appears.

Voice Switches Page

On the Voice Switches page, you can configure the identification and operating parameters of switches installed in the ShoreTel network. ShoreTel Director provides a specific page for each available ShoreTel switch that lists only the relevant parameters for that switch.

The Voice Switches page typically consists of three sections, as described in Table 18 on page 120.

### Table 17: Voice Switch/Service Appliance Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP Trunks Capacity</td>
<td>Number of SIP trunks the switch can support based on the number of ports reserved.</td>
</tr>
<tr>
<td>SIP Proxy Capacity</td>
<td>Number of SIP proxies the switch can support.</td>
</tr>
<tr>
<td>Conference Capacity</td>
<td>Number of ports reserved for conferences.</td>
</tr>
<tr>
<td>Hunt Groups</td>
<td>Number of hunt groups the switch is hosting.</td>
</tr>
<tr>
<td>Jack Based Music Source</td>
<td>Indicates whether there is a jack-based music source for music-on-hold.</td>
</tr>
<tr>
<td>File Based Music Source</td>
<td>Indicates whether there is a file-based music source for music-on-hold.</td>
</tr>
</tbody>
</table>
The parameters on the Voice Switches page vary according to the type or model of switch you are configuring. The voice switch parameters are described in the Table 19.

Table 18: Voice Switches Page

<table>
<thead>
<tr>
<th>Section</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area to configure identification and signaling settings</td>
<td>Lists relevant switch parameters. The list of parameters in this section depends on the type of switch being added to the ShoreTel network.</td>
</tr>
<tr>
<td>Switch graphic</td>
<td>Displays the switch's front panel between the parameter section and the port table. This display appears only for voice switches. The connector graphic displays the port type assignment through the use of corresponding color blocks, which are illustrated in Figure 35. Hover your cursor over the LEDs in the connector graphic to see more information about the trunk group to which the port is assigned. The switch port graphical view appears at the bottom of the edit page. It shows the port, IP phone, Conference, SIP trunks, description, jack number, and location. Clicking a telephone or trunk port link opens the Port edit page for the port.</td>
</tr>
<tr>
<td>Port table</td>
<td>Lists and configures each port or channel on the switch.</td>
</tr>
</tbody>
</table>

Figure 35: Port Type Assignment

Voice Switch Parameters

The parameters on the Voice Switches page vary according to the type or model of switch you are configuring. The voice switch parameters are described in the Table 19.
Table 19: Voice Switch Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the voice switch.</td>
</tr>
<tr>
<td>Download switch image</td>
<td>For virtual switches, click this link to download the virtual switch image from the <code>&lt;Drive&gt;:\inetpub\ftproot</code> directory (or other default FTP location) on the Headquarters or distributed voice server. This link provides a means to install a virtual switch image on a client machine. You could also manually copy the switch image to your client computer.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the switch. This optional entry typically describes where the switch is located or how it is used. For example, the switch description might indicate the wiring closet where the switch is located.</td>
</tr>
<tr>
<td>Site</td>
<td>Site where the switch resides. This is a read-only parameter. If you want to move the switch to another site, you must move all the associated users and trunks, delete the switch from the current site, and add the switch to the new site.</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the switch.</td>
</tr>
<tr>
<td></td>
<td>If your DHCP server is running, click Find Switches and use the resulting dialog box to select an IP address. This also adds the switch’s MAC address in the Ethernet Address field. If the DHCP server is not running, you must manually enter the switch’s IP address and MAC address in this field.</td>
</tr>
<tr>
<td>Ethernet Address</td>
<td>MAC address that is printed on the back panel of the switch.</td>
</tr>
<tr>
<td></td>
<td>If the DHCP server is running and you clicked Find Switches to select an IP address, the switch’s MAC address has already been added in this field. If the DHCP server is not running, you must manually enter the switch’s MAC address in this field.</td>
</tr>
<tr>
<td>Server to Manage Switch</td>
<td>Server that manages the switch. Select the appropriate server from the drop-down list.</td>
</tr>
<tr>
<td>Caller's Emergency Service Identification (CESID)</td>
<td>Telephone number sent to the service provider when an emergency services number is dialed from a user extension number. This parameter is not present on switches that do not contain ports that can be assigned to a user extension – SG T1, SG E1, SG T1k, and SG E1k.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Appendix A, Emergency Dialing Operations.</td>
</tr>
</tbody>
</table>
Configuring Voice Switches

Built-in Capacity Allocates switch resources to support IP phones, SIP trunks, and SIP proxies on the ShoreTel network. Resource availability varies for each ShoreTel model.

- To allocate IP phone and SIP trunk resources, enter the desired number of resources in the data entry boxes.
- To determine the allocated SIP proxy resources, subtract the number of available resources from the sum of the entered numbers, and then multiply the difference by 20.

For example, the SG-90 provides 30 resources. If 5 resources are allocated for IP phones and 5 resources are allocated for SIP trunks, then 400 SIP proxy resources are available: \((30 - (5+5)) \times 20\).

Built-in IP Phone Capacity For a virtual phone (vPhone) switch, the number of IP phones that the virtual switch supports.

Built-in SIP Trunk Capacity For a virtual trunk (vTrunk) switch, the number of SIP trunks that the virtual switch supports. This number is calculated based on the number of CPU cores configured in the virtual machine, as follows:

- For a small virtual trunk switch with a capacity of 100 SIP trunks, the virtual machine has 4-7 CPU cores configured.
- For a medium virtual trunk switch with a capacity of 200 SIP trunks, the virtual machine has 8-23 CPU cores configured.
- For a large virtual trunk switch with a capacity of 500 SIP trunks, the virtual machine has 24 or more CPU cores configured.

Configured Max IP Phone capacity Configures the virtual phone (vPhone) switch with the maximum number of phones that can be registered. This parameter is set to a default value of 1000, and the user can enter the value of any integer from 0 (no phones allowed to register to the switch) to 1000.

The lower value between Built-In Phone Capacity and Configured Max IP Phone capacity parameters is used for the purpose of IP phones load balancing.

Built-in Make Me Conference Capacity For a virtual phone (vPhone) switch, the number of Make Me conferences that the virtual switch supports.

Table 19: Voice Switch Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Built-in Capacity</td>
<td>Allocates switch resources to support IP phones, SIP trunks, and SIP proxies on the ShoreTel network. Resource availability varies for each ShoreTel model.</td>
</tr>
<tr>
<td></td>
<td>- To allocate IP phone and SIP trunk resources, enter the desired number of resources in the data entry boxes.</td>
</tr>
<tr>
<td></td>
<td>- To determine the allocated SIP proxy resources, subtract the number of available resources from the sum of the entered numbers, and then multiply the difference by 20.</td>
</tr>
<tr>
<td></td>
<td>For example, the SG-90 provides 30 resources. If 5 resources are allocated for IP phones and 5 resources are allocated for SIP trunks, then 400 SIP proxy resources are available: ((30 - (5+5)) \times 20).</td>
</tr>
<tr>
<td>Built-in IP Phone Capacity</td>
<td>For a virtual phone (vPhone) switch, the number of IP phones that the virtual switch supports.</td>
</tr>
<tr>
<td>Configured Max IP Phone capacity</td>
<td>Configures the virtual phone (vPhone) switch with the maximum number of phones that can be registered. This parameter is set to a default value of 1000, and the user can enter the value of any integer from 0 (no phones allowed to register to the switch) to 1000.</td>
</tr>
<tr>
<td></td>
<td>The lower value between Built-In Phone Capacity and Configured Max IP Phone capacity parameters is used for the purpose of IP phones load balancing.</td>
</tr>
<tr>
<td>Built-in Make Me Conference Capacity</td>
<td>For a virtual phone (vPhone) switch, the number of Make Me conferences that the virtual switch supports.</td>
</tr>
<tr>
<td>Built-in SIP Trunk Capacity</td>
<td>For a virtual trunk (vTrunk) switch, the number of SIP trunks that the virtual switch supports. This number is calculated based on the number of CPU cores configured in the virtual machine, as follows:</td>
</tr>
<tr>
<td></td>
<td>- For a small virtual trunk switch with a capacity of 100 SIP trunks, the virtual machine has 4-7 CPU cores configured.</td>
</tr>
<tr>
<td></td>
<td>- For a medium virtual trunk switch with a capacity of 200 SIP trunks, the virtual machine has 8-23 CPU cores configured.</td>
</tr>
<tr>
<td></td>
<td>- For a large virtual trunk switch with a capacity of 500 SIP trunks, the virtual machine has 24 or more CPU cores configured.</td>
</tr>
</tbody>
</table>
Enable Jack Based Music on Hold

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Jack Based Music on Hold</td>
<td>Enables the jack-based music-on-hold port. Select or clear this check box to enable or disable this feature. This parameter enables and disables jack-based music on hold for all trunks, including SIP trunks, and cannot be applied to a specific trunk type. Each site requires a separate music-on-hold source. To save bandwidth, music is not available between sites across the WAN. Enabling or disabling MOH for a switch affects only the local region associated with that switch. If MOH is enabled for a remote site but the headquarters switch has MOH disabled, then people calling into the headquarters switch will not hear music when placed on hold. Callers who dial into the remote site will, of course, hear music when placed on hold. A music source, such as a CD player, must be connected to the Music On Hold jack on the front panel of the switch. Jack Based Music On Hold Gain (-49 to 13): Specifies the gain (in dB).</td>
</tr>
</tbody>
</table>

Table 19: Voice Switch Parameters (Continued)
Enable File Based Music on Hold

Enables the file-based music-on-hold port. Select or clear this check box to enable or disable this feature. This parameter enables or disables file-based music on hold for all trunks, including SIP trunks, and cannot be applied to a specific trunk type.

Each server can be a source of music on hold. If the Headquarters server has music on hold enabled, by default its associated sites and servers inherit this setting. To save bandwidth, music on hold can also be enabled on other servers.

When a switch has file-based music on hold enabled, all sites associated with that switch have music on hold enabled. For example, if a switch at the Headquarters site has file-based music on hold enabled, this MOH source also applies to all child sites and servers. If a switch at a remote site has music on hold enabled, then any child sites associated with that switch can use that MOH source.

Because the Headquarters server is the parent server, it cannot obtain its music-on-hold source from a switch at a remote site. For example, if MOH is enabled for a switch at a remote site but the Headquarters switch has MOH disabled, then people calling into the remote site hear music when placed on hold, but callers dialing into a switch at the Headquarters site do not hear music when placed on hold.

Music on Hold Local Extension: This is the extension used by the music-on-hold server. This extension is set manually when file-based MOH is enabled.

Maximum Concurrent Music On Hold Calls (1-9): This is the maximum number of calls that can simultaneously access music on hold on this switch. This is a maximum limit, not a guaranteed number. (The concurrent call limit for the 90V switch is 1-9; for the 50V switch, the limit is 1-5.)

Use Analog Extension Ports as DID Trunks

Configures all analog extensions as analog DID trunks. 1-U Half-Width analog extension ports cannot be individually configured as DID trunks, but by selecting this parameter, you can configure all analog extensions as analog DID trunks. When this parameter is selected, analog ports on the switch cannot be assigned to a user extension port.

This parameter is not available on 1-U Full Width switches. You can configure analog extensions on these switches as Analog DID trunks from the Director Edit Trunk page.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable File Based Music on Hold</td>
<td>Enables the file-based music-on-hold port. Select or clear this check box to enable or disable this feature. This parameter enables or disables file-based music on hold for all trunks, including SIP trunks, and cannot be applied to a specific trunk type. Each server can be a source of music on hold. If the Headquarters server has music on hold enabled, by default its associated sites and servers inherit this setting. To save bandwidth, music on hold can also be enabled on other servers. When a switch has file-based music on hold enabled, all sites associated with that switch have music on hold enabled. For example, if a switch at the Headquarters site has file-based music on hold enabled, this MOH source also applies to all child sites and servers. If a switch at a remote site has music on hold enabled, then any child sites associated with that switch can use that MOH source. Because the Headquarters server is the parent server, it cannot obtain its music-on-hold source from a switch at a remote site. For example, if MOH is enabled for a switch at a remote site but the Headquarters switch has MOH disabled, then people calling into the remote site hear music when placed on hold, but callers dialing into a switch at the Headquarters site do not hear music when placed on hold. Music on Hold Local Extension: This is the extension used by the music-on-hold server. This extension is set manually when file-based MOH is enabled. Maximum Concurrent Music On Hold Calls (1-9): This is the maximum number of calls that can simultaneously access music on hold on this switch. This is a maximum limit, not a guaranteed number. (The concurrent call limit for the 90V switch is 1-9; for the 50V switch, the limit is 1-5.)</td>
</tr>
<tr>
<td>Use Analog Extension Ports as DID Trunks</td>
<td>Configures all analog extensions as analog DID trunks. 1-U Half-Width analog extension ports cannot be individually configured as DID trunks, but by selecting this parameter, you can configure all analog extensions as analog DID trunks. When this parameter is selected, analog ports on the switch cannot be assigned to a user extension port. This parameter is not available on 1-U Full Width switches. You can configure analog extensions on these switches as Analog DID trunks from the Director Edit Trunk page.</td>
</tr>
</tbody>
</table>
T1 Signaling Parameters

The Voice Switches page for T1 switches configures T1 circuit Layer 3 and Layer 1 parameters. These parameters are displayed for the SG T1, SG 220 T1, and SG 220T1A switches. For descriptions of the T1 signaling parameters, see Table 20 on page 125.

Table 20: T1 Signaling Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layer 3 – Network Layer Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Protocol Type</td>
<td>Specifies the protocol type. From the drop-down list, select one of the following protocols:</td>
</tr>
<tr>
<td></td>
<td>- CAS</td>
</tr>
<tr>
<td></td>
<td>- ECMA QSIG Master</td>
</tr>
<tr>
<td></td>
<td>- ECMA QSIG Slave</td>
</tr>
<tr>
<td></td>
<td>- ISDN Network</td>
</tr>
<tr>
<td></td>
<td>- ISDN User</td>
</tr>
<tr>
<td></td>
<td>- ISO QSIG Master</td>
</tr>
<tr>
<td></td>
<td>- ISO QSIG Slave</td>
</tr>
<tr>
<td>Central Office Type</td>
<td>Specifies the central office type. From the drop-down list, select one of the following central office types:</td>
</tr>
<tr>
<td></td>
<td>- 4ESS</td>
</tr>
<tr>
<td></td>
<td>- 5ESS</td>
</tr>
<tr>
<td></td>
<td>- DMS-100</td>
</tr>
<tr>
<td></td>
<td>- NI-2 (National ISDN-2)</td>
</tr>
<tr>
<td>Call by Call Service (4ESS only)</td>
<td>Specifies whether a user can access different services, such as an 800 line or WATS line, on a per-call basis. This parameter is available only when Central Office Type is set to 4ESS.</td>
</tr>
<tr>
<td>Enable Outbound Calling Name</td>
<td>Sends the caller name with the caller ID for outbound calls. The default is disabled.</td>
</tr>
<tr>
<td><strong>Layer 1 – Physical Layer Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Clock Source</td>
<td>Configures the clock source for the switch. From the drop-down list, select either Master or Slave. Typically the switch is slave to the central office. The default is Slave.</td>
</tr>
<tr>
<td>Framing Format</td>
<td>Configures the framing format for the ShoreTel T1 switch. From the drop-down list, select either ESF or D4, depending on the type of T1 service you receive. The default is ESF.</td>
</tr>
</tbody>
</table>
**E1 Signaling Parameters**

The E1 Signaling parameters are displayed for the SG E1 and SG 220E1 switches. Table 21 describes the E1 signaling parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layer 3 – Network Layer Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Protocol Type</td>
<td>Specifies the signaling protocol. From the drop-down list, select one of the following protocols:</td>
</tr>
<tr>
<td></td>
<td>• ISDN User</td>
</tr>
<tr>
<td></td>
<td>• ISDN Network</td>
</tr>
<tr>
<td></td>
<td>• ISO QSIG Master</td>
</tr>
<tr>
<td></td>
<td>• ISO QSIG Slave</td>
</tr>
<tr>
<td></td>
<td>• ECMA QSIG Master</td>
</tr>
<tr>
<td></td>
<td>• ECMA QSIG Slave</td>
</tr>
<tr>
<td>Central Office Type</td>
<td>Specifies the central office type. The ShoreTel-E1 supports a single signaling type per country, which is typically Euro-ISDN(TBR4). This parameter is active only if Protocol Type is set to <strong>ISDN User</strong> or <strong>ISDN Network</strong>.</td>
</tr>
<tr>
<td>Enable Outbound Calling Name</td>
<td>Sends the caller name with the caller ID for outbound calls.</td>
</tr>
<tr>
<td></td>
<td>The default is disabled.</td>
</tr>
<tr>
<td><strong>Layer 1 – Physical Layer Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Clock Source</td>
<td>Configures the clock source for the switch. From the drop-down list, select either Master or Slave. Typically the switch is slave to the central office. The default is Slave.</td>
</tr>
<tr>
<td>Framing Format</td>
<td>Specifies whether the framing format is enabled or disabled. ShoreTel E1 switches support the CRC-4 framing format.</td>
</tr>
</tbody>
</table>
BRI Signaling Parameters

The BRI signaling parameters are displayed for ShoreTel switches that support BRI. Four BRI spans are displayed, but the ShoreTel 30 BRI supports only one BRI span. Table 22 on page 127 describes the BRI signaling parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analog Ports</strong></td>
<td></td>
</tr>
<tr>
<td>Port Type</td>
<td>Configures the port resources. From the drop-down, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- Available: Configures the port resources to support either an extension port or DID trunk. Port capabilities depend on the ShoreTel switch model.</td>
</tr>
<tr>
<td></td>
<td>- Conference: Configures the port resources for Make Me conferencing. Reserve as many ports as you need to support the maximum number of conferences you will permit to occur simultaneously. For example, if you will allow two three-way calls at the same time, reserve 6 ports. The minimum number of ports that can be reserved for Make Me conferencing is four. Note that only four analog ports are available on the SG 90BRI and the 90BRI V switches for Make Me conferencing. Also, note that non-Make Me conferencing ports are available on the SG30BRI switch.</td>
</tr>
<tr>
<td></td>
<td>- Trunk: Configures the port as an analog trunk assigned to the Trunk Group specified by the Trunk Group parameter.</td>
</tr>
<tr>
<td></td>
<td>- 5 IP Phones: Configures the resource to support 5 IP phones.</td>
</tr>
<tr>
<td></td>
<td>- 5 SIP Trunks: Configures the resource to support 5 SIP trunks.</td>
</tr>
<tr>
<td></td>
<td>- 100 SIP Proxy: Configures the resource to support 100 SIP proxies.</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>Specifies the Trunk Group to which the port is assigned. This parameter is available only when Port Type is set to Trunk. Port tables do not include the Trunk Group column for switches that do not provide Loop Start Trunks.</td>
</tr>
<tr>
<td>Description</td>
<td>Lists a descriptive name for the switch port. Description is an optional field.</td>
</tr>
<tr>
<td>Jack Number</td>
<td>Lists the patch-panel jack number to which the port is connected. Jack Number is an optional field.</td>
</tr>
</tbody>
</table>
### Table 22: BRI Signaling Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Comment field option for typing location information about a port.</td>
</tr>
<tr>
<td>Digital Ports</td>
<td></td>
</tr>
<tr>
<td>Enable Span as BRI</td>
<td>Activates the corresponding Digital Channels as a BRI span. When this parameter is not selected, the Channel resources are available for reallocation to support IP phones, SIP trunks, or SIP proxies.</td>
</tr>
<tr>
<td>Layer 3 Parameters – Network Layer</td>
<td></td>
</tr>
<tr>
<td>Protocol Type</td>
<td>Specifies the signalling protocol.</td>
</tr>
<tr>
<td></td>
<td>* ISDN User and ISDN Network are ISDN signalling protocols.</td>
</tr>
<tr>
<td></td>
<td>* QSIG is an ISDN based signalling protocol used for signalling between PBXs in a private network.</td>
</tr>
<tr>
<td>Central Office Type</td>
<td>The ShoreTel-E1 supports a single signaling type per country, which is typically Euro-ISDN. This parameter is active only if Protocol Type is set to ISDN User or ISDN Network.</td>
</tr>
<tr>
<td>Layer 2 Parameters – Data Link Layer</td>
<td></td>
</tr>
<tr>
<td>Signaling</td>
<td>Specifies the signaling type. From the drop-down list, select either Point-to-Point or Point-to-Multipoint.</td>
</tr>
<tr>
<td>Digital Channels – For switches that provide digital channels</td>
<td></td>
</tr>
<tr>
<td>Port Type</td>
<td>Configures the port resources as follows:</td>
</tr>
<tr>
<td></td>
<td>* Available: Indicates that the channel resources is available for assignment.</td>
</tr>
<tr>
<td></td>
<td>* Trunk: Configures the port as an digital trunk assigned to the Trunk Group specified by the Trunk Group parameter.</td>
</tr>
<tr>
<td></td>
<td>* 5 IP Phones: Configures the resource to support 5 IP phones.</td>
</tr>
<tr>
<td></td>
<td>* 5 SIP Trunks: Configures the resource to support 5 SIP trunks.</td>
</tr>
<tr>
<td></td>
<td>* 100 SIP Proxy: Configures the resource to support 100 SIP proxies.</td>
</tr>
<tr>
<td></td>
<td>* Unavailable: Indicates that digital channel is not available, such as in the case of a fractional T1 circuit.</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>Specifies the Trunk Group to which the port is assigned.</td>
</tr>
<tr>
<td></td>
<td>This parameter is available only when Port Type is set to Trunk.</td>
</tr>
</tbody>
</table>
Failover for IP Phones: Spare Switch

To ensure high availability of IP phones, ShoreTel provides failover mechanisms, as follows:

- One mechanism is the redistribution of IP phone service by the Headquarters server after a switch fails. This mechanism involves resource planning and configuration but does not involve extra equipment.

- The other mechanism involves an extra voice switch that is reserved as a *spare switch*.

IP phones can have immediate reassignment when the voice switch to which they are assigned does not respond.

When the failover function is configured, IP phones send a keep-alive message to their switch every 60 seconds. If the switch fails to reply after four consecutive keep-alive messages, the IP phone sends a request to the Headquarters server for reassignment. If the Headquarters server determines that the switch is not available and that other switches at the site can support additional phones, the server distributes IP phones’ service to the remaining site switches. If redistribution cannot meet the needs of a deployment, another mechanism can.

If resources are insufficient and a *spare switch* is available, the Headquarters server activates the spare switch as a site resource and reassigns the remaining IP phones to it. The Headquarters server records these failover transactions so it can restore regular service after the problem is corrected. If resources are still insufficient even after the Headquarters server activates a spare switch, the affected IP phones remain unavailable to users until the problem is solved.

Failover for ShoreTel IP phones is transparent to the end user. A keep-alive function ensures that failover can occur without users taking remedial actions on their phones and even during a phone call. If the user tries to use the phone before failover takes place, the phone automatically queries the Headquarters server for reassignment when the assigned switch does not respond. When implemented, the failover transaction occurs within seconds. However, if resources are not available, failover cannot occur and the user is unable to use the phone.

### Table 22: BRI Signaling Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Optional comment field that lists a descriptive name for the switch port.</td>
</tr>
<tr>
<td>Tx Gain (db)</td>
<td>Specifies the gain added to received digital signals. The default is 0 dB.</td>
</tr>
<tr>
<td>Jack Number</td>
<td>Optional comment field that can contain the patch-panel jack number to which the port connects.</td>
</tr>
<tr>
<td>Rx Gain (db)</td>
<td>Specifies the gain added to transmitted digital signals. The default is 0 dB.</td>
</tr>
<tr>
<td>Fill Down</td>
<td>Duplicates the contents of the first row of the data entry field in all other rows. The channel number, in parenthesis, is appended to the contents of the Description field.</td>
</tr>
</tbody>
</table>
Upon a switch failure, the phones are reassigned in the order that they notify the Headquarters server of the switch’s unavailability. If the resources are available, the network’s failover operation takes up to about four minutes after initial detection of a voice switch failure.

The ShoreTel system provides for two levels of switch failover to assure high availability of IP phones. The first level involves setting aside capacity on site switches to handle failover situations. This method is referred to as N+1. In N+1 applications, you deploy more switches (hence ports) than your absolute need. The ShoreTel system automatically implements load balancing when it assigns IP phones to switches so that the load is always evenly distributed. An example of an N+1 application is the following:

A site has 99 users on 3 ShoreTel Voice Switch 50s. The configuration on each switch assigns 33 IP phones keeps 17 ports in reserve (33 + 17 = 50). If one of the switches fails, the Headquarters server reassigns the 33 IP phones to the 2 functioning switches.

The second level of failover involves a spare switch that provides failover protection. Certain switch models can serve as a spare, and the ShoreTel system does not assign IP phones to these spare switches during normal operation.

If a voice switch fails and the Headquarters server cannot reassign all of the IP phones to the remaining switches at the site, the Headquarters server activates the spare switch at the affected site and reassigns the remaining IP phones from the failed switch to the spare. Reassignment should be a temporary state—until the problem that triggered that failover is solved.

The spare switch provides basic telephony functionality and cannot support such functions as hunt groups, trunk access, Backup Auto-attendant, analog extensions, trunks, media proxy, Make Me conference ports, and so on. However, Extension Assignment is supported.

Spare switch failover support is hierarchical. Spare switches provide failover support for IP phones installed on the same site only. Moreover, spare switches provide failover support for IP phones at or below the level where the switch is installed. This means that a switch installed on a child site cannot be used to provide failover for IP phones installed on the parent site or any site connecting through the parent site. It can be used to provide failover for child sites below it in the hierarchy. Indeed, when necessary, the system searches the entire, relevant hierarchy until it finds an available spare switch it can use for failover. You can also install spare switches on the Headquarters server sites to provide universally accessible failover for all sites on the system.

The next section describes how to configure spare switches.
ShoreTel Voice Switches that Can Be Spare Switches

The following ShoreTel Voice Switches can serve as spare switches:

- ShoreTel Voice Switch 120/24
- ShoreTel Voice Switch 40/8
- ShoreTel Voice Switch 60/12
- ShoreTel Voice Switch 50
- ShoreTel Voice Switch 90
- ShoreTel Voice Switch 220T1
- ShoreTel Voice Switch 220E1
- ShoreTel Voice Switch 90BRI
- ShoreTel Voice Switch 220T1A
- ShoreTel Voice Switch 30
- ShoreTel Voice Switch 30BRI
- ShoreTel vPhone Virtual Switch

**Note**

- ShoreTel voicemail switches (such as the 90V and the 50V) cannot be spare switches.
- The ShoreTel vTrunk Virtual Switch cannot be a spare switch.
- Spare switches cannot change languages while they are carrying traffic. Language incompatibilities are indicated by a **Firmware upgrade available** message when the switch is configured for a site with a different language.

Adding a Spare Switch to the System

This section describes how to configure a switch to be a spare. The physical installation of a spare switch is the same as the installation of a primary switch. (For details about how to install primary and spare switches in a ShoreTel network, refer to the *ShoreTel Planning and Installation Guide*.)

The information required to configure a spare switch is as follows:

- IP address for the spare switch
- Ethernet address of the switch (located on a label on the back of the switch)
- Name of the server to manage the switch

To configure a ShoreTel voice switch as a spare:

1. Launch ShoreTel Director.
2. Click **Administration > Platform Hardware > Voice Switches/Service Appliances > Spare**.
   
   The Spare Voice Switches page appears.
3. Select the site for the spare switch in the **Add new spare switch at site** drop-down list.
4. Select the switch type to add as a spare by selecting a switch model in the **of type** drop-down list.

   The Edit Switch page appears.

5. In the **Name** field, enter the name to identify this switch in the system.

6. In the **Description** field, enter a description for this switch.

7. In the **IP Address** field, enter the IP address assigned to the switch. If the switch is located on the same network segment as the Headquarters server, you can use the **Find Switch** function to locate the IP address.

8. In the **Ethernet Address** field, enter the Ethernet address for the switch.

9. In the **Server to Manage Switch** field, select the server that you want to manage the switch.

10. Click **Save**.

    **Note**

    - We recommend that you do not select a switch that has Music On Hold enabled to manage the spare switch. Doing so could mean sending MOH across the WAN, which ShoreTel does not support.

    - We recommend that you do not select a switch with CESID configured. The spare switch can be temporarily deployed in a remote location.

**Enabling IP Phone Failover**

You must configure the system to allow IP phones to failover. To set the parameter to allow IP phones to failover, do the following:

1. Launch ShoreTel Director.

2. Click **Administration > IP Phones > Options**.

   The IP Phone Options page appears.

3. Select the **Enable IP Phone Failover** check box.

4. Click **Save**.

5. For ShoreTel 100-Series, 200-Series, 500-Series, and 600-Series IP phones, reboot the phones to apply the new setting for the parameter.
Temporarily Disabling IP Phone Failover

For some maintenance tasks, you temporarily disable IP phone failover (such as for system-wide maintenance work).

1. Launch ShoreTel Director.
2. Click Maintenance > Quick Look.
   The Quick Look page appears.
3. Select the Temporarily Disable IP Phone Failover Across Sites check box. When this feature is enabled, spare switches do not fail over throughout the system.

Note
Be sure to reverse this process to enable IP phone failover when the maintenance task is finished.

Performing a Manual Fail Back

The Maintenance – Switches Summary page displays a section listing the Spare Switches at the specified site. This section indicates the activity level of the spare switch and, when active, the site where the spare switch is deployed.

Manual failbacks are performed on the Maintenance – Switches Summary page by accessing the drop-down list for the desired switch and selecting Fail Back.

Restoration

The spare switch is designed as a temporary measure to ensure that IP phone users have basic phone connectivity if their primary switch fails. To ensure that users have their full connectivity, you must repair or replace the failed primary switch as soon as possible. This section describes the following aspects of restoring normal operation after a failover occurs:

- How to re-assign the original primary switch profile to a new switch.
- How to move IP phones from the spare switch to the restored primary switch.
- How to fail back the spare switch to the spare state.

Reassigning the Primary Switch Profile to a Replacement Switch

If you must physically replace a primary switch that fails, you can re-assign the original switch profile to the new physical switch rather than create a new profile. This section describes how to re-assign the switch profile.

Requirements

- Obtain a replacement switch that has the same capabilities as the failed switch.
- Physically install the replacement switch on the same network as the old switch.
Assign the new switch an IP address. Refer to the ShoreTel Planning and Installation Guide for more information about IP address assignment.

Unplug the port connections (telephones, trunks) from the existing voice switch and plug them into the new voice switch.

To reassign the switch profile:

1. Launch ShoreTel Director.
2. Click Administration > Platform Hardware > Voice Switches/Service Appliances > Primary.
3. Click the name of the voice switch to replace.
   The Edit Switch page for the switch appears.
4. Do one of the following:
   - In the IP Address field, enter the IP address (or Ethernet address) of the new switch that is replacing the inoperative switch.
   - Click Find Switches, and then select the new voice switch.
5. Click Save.
   The switch might take up to two minutes to come on-line.

Note
You can use Quick Look or Diagnostics & Monitoring to confirm that the new voice switch is on-line.

Moving IP Phones to the Primary Switch

1. Launch ShoreTel Director.
2. Click Administration > IP Phones > Individual IP Phones.
   The IP Phones page appears.
3. In the By Sites field, select the site where the failover has occurred and you want to perform restoration.
4. In the By Switches field, select All Switches.
5. In the Show Page field, select the page that contains the IP phones that you want to move. Each page is identified by the page number and the name of the first and last phone listed on that page.
6. Use the Site column to identify phones that have failed over to the spare switch, and select the check box to the left of the names of the phones that you want to move to the primary switch. (The MAC or IP address is often used as the name.)
7. In the field to the left of the Move button, select the switch to which you want to move the IP phones.

8. Click Move.

The phones are moved to the target primary switch.

Note: You can select multiple phones to move at one time. The phones do not have to be registered to the same switch.

Failing Back the Spare Switch

After you move the IP phones to the primary switch on the site, you must manually fail back the spare switch. To fail back the spare switch:

1. Launch ShoreTel Director.

2. Click Maintenance > Quick Look.

   The Quick Look page appears.

3. Select the site where the failover occurred and to which the spare switch is currently assigned.

   The Voice Switches and Service Appliances Summary page appears.

4. In the Spare Switches section, identify the spare switch to fail back, and in the Command column field, select Failback.

   The failback process starts.

Note: Calls that are currently in progress are dropped during the move to the target switch.

Note: Calls that are currently in progress are dropped during the move to the target switch.

Note: Make sure that there are zero (0) IP phones connected to the switch. (The listing in the IP Phones column should be 0/N, where 0 is the number of phones currently registered with the switch and N is the switch capacity.)

The process takes a few minutes to complete and includes rebooting the spare switch. When the process is complete and successful, the spare switch returns to the spare state. To verify that the switch has returned to the spare state, do the following:

1. Launch ShoreTel Director.

2. Click Administration > Platform > Voice Switches/Service Appliances > Spare.

   The Spare Voice Switches page appears.
3. Verify the following:
   - The Current Site column is empty.
   - The IP Phones in Use column lists zero (0).

## Configuring Softswitches

A softswitch hosts virtual users to whom a physical telephone port is not assigned on any ShoreTel Voice Switch. A softswitch can host all voice mail, auto-attendant, and workgroup extensions as well as route points. A softswitch is automatically created for each server added to the ShoreTel system.

To configure the softswitch, follow these steps:

1. Launch ShoreTel Director.

2. Click Administration > Platform Hardware > Voice Switches/Service Appliances > Primary.

   The Primary Voice Switches/Service Appliances page appears.

3. In the Name column, click on the softswitch you want to configure. (Although “SoftSwitch” is the default name of every softswitch, you can refer to the Type column to identify other softswitches. “SW” is the type for all softswitches.)

   The Edit SoftSwitch page appears. The parameters on the Edit SoftSwitch page are described in Table 23.

### Table 23: Softswitch Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the softswitch. The default name is SoftSwitch.</td>
</tr>
<tr>
<td>Description</td>
<td>Descriptive name of the softswitch.</td>
</tr>
<tr>
<td>Site</td>
<td>Softswitch location. The location of the softswitch is a read-only parameter and cannot be changed. The default name of the main site is Headquarters, which can be changed on the Edit Site page. A softswitch always resides at the main site.</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the switch that supports the softswitch. The IP address is specified in the Server page.</td>
</tr>
</tbody>
</table>
T.38 Support on ShoreTel Switches

T.38 works in conjunction with SIP and is implemented as a fax codec on ShoreTel's half-width voice switches. (Full-width voice switches do not support T.38.) T.38 can be used on SIP-enabled voice switches (if the switch supports T.38), servers, and SIP endpoints.

On all switches, T.38 functions as a gateway.

**Note**

If a switch does not support T.38, the ShoreTel system can translate T.38 for that switch. If a switch does not support T.38 or is configured not to use T.38, it can use pass-through (voice band data) to transport faxes.

*Figure 36* shows how T.38 supports fax transmission between two sites.

---

**Usage**

The fax capability is enabled by default on the half-width switches. Only the UDPTL format (UDP packet for transporting faxes) is supported. Fixed redundancy is available on all calls.

ShoreTel implements T.38 through a gateway on the ShoreTel switches. Parameters for the T.38 UDPTL packets (those UDP packets used to transport fax) are negotiated through the session description protocol (SDP). The negotiation follows the offer/answer exchange model for SIP between ShoreTel Voice Switches SIP trunks and a SIP-based, third party device, such as an IP fax extension.

Between ShoreTel voice switches, the system uses ShoreSIP. The system uses SIP only if SIP-based, third-party, end points or SIP trunks are encountered about the fax codec list—the built-in fax codec list (high bandwidth and low bandwidth) are enough. ShoreTel considers the fax codec list to be adequate and, therefore, customers should not need to add to it.
An extension that is labeled as a fax server can also be used as a site-specific fax redirect destination. Be sure that extensions designated as fax extensions are not forwarded to other phones or trunks that use the Anyphone feature, otherwise fax operation is impacted.

### Important Considerations

T.38 support is subject to the following considerations:

- The following ShoreTel Voice Switches do not support T.38. For these and older switches, G711/L16 clear channel is used for fax purposes.
  - ShoreTel - 8
  - ShoreTel - 12
  - ShoreTel - 40
  - ShoreTel - 60
  - ShoreTel 120
  - ShoreTel - T1
  - ShoreTel - E1
  - ShoreTel - 24a

- The fax machine/fax server behind the ShoreTel PBX should disable the V.34 feature to keep the fax from using G711/Linear clear channel for better performance.

- V.34 Faxes are not supported.

- ShoreTel supports only T.38 in UDPTL form. T.38 calls in RTP or TCP form are not supported.
ShoreTel does not support either IP media or RFC2833-based fax tone detection (in RFC2833, ShoreTel only supports DTMF but no named telephony events), therefore ShoreTel cannot detect a fax tone coming from an SIP end-point. The exception is a SIP connection that is established with a physical port on a ShoreTel switch. In this case, the ShoreTel switch can detect a fax tone from the SIP endpoint and either switch to fax mode or redirect the call.

ShoreTel depends on fax CNG tone detection or T.38 invite to redirect an incoming fax call. If the fax connection is established with one SIP based endpoint (such as SIP extension or SIP trunk), ShoreTel depends on SIP invite to either establish a fax connection or redirect the call to a pre-configured fax device.

T.38 is not supported on SIP-BRI.

ShoreTel supports modem speeds up to 9600 at V.29. ShoreTel does not support V.17 or V.34.

Enabling T.38 on a ShoreTel Switch

T.38 is the first codec in the list of codec members for “Fax Codecs - Low Bandwidth” and “Fax Codecs - High Bandwidth” in ShoreTel Director.

“Fax Codecs - High Bandwidth” is the default codec list selected when a site is created.

For more information on the default codec lists available from ShoreTel, see Codec Lists on page 315.

1. Launch ShoreTel Director.
2. Click Administration > Call Control > Codec Lists.
   The Codec Lists page is displayed.
3. In the Description column, select the fax codec profile for which you want to enable T.38 support or click New to create a new codec profile.
4. Make sure that T.38 appears in the Codec List Members field in the position that reflects your preference for the order the switch should use for fax calls.
5. Click Save.
6. Click Administration > Sites.
   The Sites page is displayed.
7. Select the site on which you want to enable the T.38 codec.
   The Edit Site page is opened.
8. In the Fax and Modems Calls field, select a fax profile in which the T.38 codec is enabled.
9. Click Save.
Third-Party T.38 Configuration Support

ShoreTel T.38 implementation also supports GFI Software/Brooktrout SR140. For the configuration procedure, see the following ShoreTel application note:

ST-10238: How to configure GFI Software/Brooktrout SR140 with the ShoreTel System

For more information about configuring additional ShoreTel-supported, third-party solutions, contact the ShoreTel Innovation Network Partner Program at the following URL:

http://www.shoretel.com/partners/technology/certified_partners.html
This chapter describes the ShoreTel voicemail switches that support voicemail services. In addition to the regular voice switching functionality, these voice switches have a subset of the server functionality that ShoreTel provides. The chapter contents are as follows:

Overview ................................................................. 143
Functional Description ......................................................... 143
  Switch Capacity of a Voicemail-enabled Switch ......................... 143
  Voice Switch Functions ...................................................... 144
  Server Functions ............................................................ 145
  Connectivity Requirements .................................................. 146
Utilities ................................................................. 147
  Accessing Voicemail Model Switch Utilities ............................. 147
  STCLI ................................................................. 149
  Specifying a Static IP Address ............................................ 150
Implementing the Voice Switch Functionality .............................. 151
  Adding and Configuring a Voicemail-enabled Switch .................. 151
  Replacing a Switch .......................................................... 152
  Upgrading a Switch .......................................................... 152
  Configuring Voice Mail ..................................................... 153
  Specifying Root and Administrator Passwords ....................... 155
  Configuring Automatic Backup for a Switch ............................ 157
  Configuring a Target Server for Backup .................................. 158
Booting and Restarting ....................................................... 161
  Specifying a Time Source ................................................ 162
  Reboot Methods .......................................................... 162
Voicemail Model Switches

Monitoring Memory Usage for a Voicemail Model Switch ........................................... 163
  CF Memory Usage ...................................................................................................... 163
  Log File Size and Age ............................................................................................. 163
Configuring Service Appliances .................................................................................. 164
Overview

The voicemail-enabled switches are specially-equipped voice switches that provide voicemail services and access to auto attendant menus for telephones that the switch is hosting. These voicemail-enabled switches store voicemail on Compact Flash (CF) cards. They provide local access to voicemail. A ShoreTel Distributed Voice Server (DVS) rather than the Headquarters server controls the voicemail-enabled switches.

The Auto Attendant menus, greetings, and prompts reside in permanent flash memory. For routine protection of voice mail, backup and restore tasks are configurable through ShoreTel Director. If a switch becomes disabled, the information on the CF card can migrate to another switch of the type.

V Model Switches differ from other ShoreTel Voice Switches in the following ways:

- V Model switches have a slot on the side of the chassis for accessing the CF card.
- V Model switches provide Voicemail and auto attendant services normally provided by the Main Server or a Distributed Server.
- V Model switches run on Linux. (On other ShoreTel Voice Switches, the operating system is VxWorks. ShoreTel Servers run Microsoft Windows.)
- V Model switches do not support Simplified Message Desk Interface (SMDI).

Functional Description

This section outlines the capacities and capabilities of the voicemail-enabled switches. These voice switches are similar to other 1-U Half Width Voice Switches, but they also have permanent flash and Compact Flash memory to provide a subset of the sever functions of voicemail, automated scripts, and other services.

Switch Capacity of a Voicemail-enabled Switch

This section lists the capacities of the voicemail-enabled switches. It contains:

- Some network-wide values
- Voice switch capacity
- Server capacity

The global capacity of these voicemail-enabled switches is as follows:

- Maximum Voicemail Enabled Switches in a ShoreTel network: 500
- Maximum simultaneous calls to voicemail boxes on a switch: 9
- Maximum CF card capacity in the current release: 2 GB

A voicemail-enabled switch utilizes only the codecs that reside on the switch. As with other 1-U, half-width switches, the switch’s codecs cannot serve as a G.729 proxy.
Voice Switch Functions

The voicemail-enabled switches provide the same types of voice services as other 1-U, half-width switches. Table 24 lists the voice switching capabilities for each model of voicemail-enabled switch.

A voicemail-enabled switch utilizes only the codecs that reside on the switch. As with other 1-U half width switches, the on-board codecs cannot serve as a G.729 proxy.

**Note**

A voicemail-enabled switch has two analog ports on the faceplate. The upper port accepts line input from a radio or CD player; the lower port can drive an amplifier of a paging system.

<table>
<thead>
<tr>
<th>Switch Element</th>
<th>90V</th>
<th>90BRIV</th>
<th>50V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog telephony</td>
<td>12 ports</td>
<td>4 extension ports</td>
<td>6 ports</td>
</tr>
<tr>
<td></td>
<td>8 ports support trunks</td>
<td>4 ports support trunks</td>
<td>2 ports configurable as extensions or DID trunks</td>
</tr>
<tr>
<td></td>
<td>4 ports configurable as extensions or DID trunks</td>
<td>4 ports configurable as extensions or DID trunks</td>
<td></td>
</tr>
<tr>
<td>IP and SIP resources</td>
<td>Built-in capacity, independent of telephony support, any combination of:</td>
<td>Built-in capacity, independent of telephony support, any combination of:</td>
<td>Built-in capacity, independent of telephony support, any combination of:</td>
</tr>
<tr>
<td></td>
<td>30 IP phones</td>
<td>30 IP phones, 30 SIP trunks or 600 SIP proxies</td>
<td>30 IP phones, 30 SIP trunks or 600 SIP proxies</td>
</tr>
<tr>
<td></td>
<td>30 SIP trunks</td>
<td>600 SIP proxies</td>
<td>600 SIP proxies</td>
</tr>
<tr>
<td></td>
<td>600 SIP proxies</td>
<td>Requires reallocation of telephony resources:</td>
<td>Requires reallocation of telephony resources:</td>
</tr>
<tr>
<td></td>
<td>90 IP Phones</td>
<td>90 IP Phones, or:</td>
<td>90 IP Phones, or:</td>
</tr>
<tr>
<td></td>
<td>90 SIP trunks</td>
<td>90 SIP trunks, or:</td>
<td>90 SIP trunks, or:</td>
</tr>
<tr>
<td></td>
<td>1800 SIP proxies</td>
<td>1800 SIP proxies max.</td>
<td>1800 SIP proxies max.</td>
</tr>
</tbody>
</table>

Voicemail boxes | 90 | 90 | 50 |
Server Functions

A voicemail-enabled switch supports a subset of the server functions that a ShoreTel Headquarters or Distributed Voice Server provides. The sub-sections that follow describe the server features of the voicemail-enabled switches.

Voicemail Capacity

A voicemail-enabled switch provides voicemail services to local users under normal conditions. If resource utilization reaches its limit, a DVS can provide services to the users.

Switch functions and Server routines run under Linux. The voicemail-enabled switches use Qmail instead of SMTP.

The total time for voicemail recordings depends on the capacity of the CF card. A 1-GB CF card can hold up to 1500 minutes of audio. Therefore, each user on a ShoreTel Voice Switch 90V can have about 15 minutes of voicemail.

When a user requests voicemail through an IP phone, a voicemail-enabled switch provides the messages directly to the IP Phone. In contrast, when a user requests voicemail through the computer, the voicemail-enabled switch first sends the message to a Headquarters or DVS. The server sends the message to ShoreTel Communicator on the user’s computer.

When the CF card is full, callers cannot leave a voice message and instead hear a recorded message that the mailbox is full.
File-Based Music on Hold Capacity

A voicemail-enabled switch can provide file-based MOH services.

Conferencing on a Voicemail-enabled Switch

Linux-based voicemail-enabled switches can conference up to six people in one conversation, very much like the VxWorks-based regular switches. To host more than one conference at a time, the switch must reserve more of the configurable DSP computing power.

Auto-Attendant Menus

Each voicemail-enabled switch receives a copy of the system's Auto-attendant menus.

Recorded Name Storage

When configuring their voicemail, users can record their name to an audio file. The recording is part of the greeting to callers. The switch stores the greetings only for the users whose mailbox resides on the switch. (Headquarters and DVSs keep the recorded name files for the other users.) When a voicemail-enabled switch requires an audio file that it does not have, it gets the file from the Headquarters server or a DVS.

Voicemail Prompts

All non-English voicemail prompts reside on the Headquarters Server and simultaneously on all Distributed Servers. A voicemail-enabled switch can keep a subset of the prompts. It can hold prompts in the local, default language and three other languages.

Connectivity Requirements

Voicemail and Auto-attendant availability requires connectivity to the boot-time server so the switch can read the configuration database on the Headquarters server. Voicemail and the Auto-attendant on a voicemail-enabled switch are not active until it connects to the Headquarters server. The voicemail-enabled switches do not require a restart to enable voicemail support and Auto-attendant if the initial connectivity was established after the initial boot.

Voicemail and auto attendant services require that the switch has connectivity with a Network Time Protocol (NTP) server.

System backup requires FTP server connectivity. When backing up data, it goes to the Main Server or to any computer with FTP server capabilities that supports RFC 959, the MDTM command, and the SIZE command.

Although a DVS can manage a voicemail-enabled switch, the switch applications still need access to the database on the Headquarters server. Examples of the applications that run on a voicemail-enabled switch are voicemail and the Telephone Management System (TMS).

Personal Communicator connects only to the Main Server or a Distributed Server, even for users whose host port is on a voicemail-enabled switch.
Utilities

This section describes the utilities available for voicemail switches.

Accessing Voicemail Model Switch Utilities

ShoreTel switch utilities are accessible through the Maintenance port, an SSH client, or an MS windows program executed from a command prompt on the Headquarters server or a distributed server. The following sections describe utility access methods.

The switch accepts requests from MS Windows CLIs only when they run on the local host, the controlling Distributed server, or the Main ShoreTel server. The switch accepts requests from remote CLIs run from an SSH client.

Accessing Utilities from the Serial Port

Switch utilities and the UBOOT command interface are accessible through the maintenance port located on the faceplate. The state of the switch at the time of Maintenance port access determines the available utility.

- During normal switch operation, the maintenance port accesses a specified Linux shell. The default shell is the ShoreTel command line interface (STCLI).
- During a switch boot, the maintenance port accesses UBOOT.

Accessing ShoreTel utilities through the maintenance port:

1. Connect one end of a serial cable to a computer with a terminal emulator program installed.
2. Connect the male end of the serial cable to the maintenance port on the front panel of the ShoreTel switch.
3. Launch the terminal emulation using the following settings for the serial port:
   - Speed: 19.2 Kbs
   - Data bit: 8 bits
   - Stop bit: 1
   - Parity: No parity
   - Flow Control: None
4. Click **OK**.
   The ShoreTel command line interface appears.
5. Choose one of the following courses of action:
   - If the interface shows that the switch has a Linux operating system:
     1. Type the user ID and password as required. The default values are “admin” and “root” respectively. (Root is available only through a serial connection.)
2. At the command line, enter **STCLI**.

   The STCLI interface opens.

   - Do nothing if the interface shows that UBOOT is being used; a user ID and password are not required.

   Refer to **STCLI** on page 149 for a description of STCLI. UBOOT is described in the *ShoreTel Maintenance Guide*.

**Accessing Utilities from SSH**

ShoreTel provides access to several Voicemail Model utilities through a Linux BASH command line, which you can access through an SSH client. Free SSH clients, such as PuTTY, are available through the Internet.

To access the Linux utilities, including all Voicemail Model command line interfaces, use the admin account. Logging into the admin account opens the STCLI interface.

1. Open an SSH client access page.

   The PuTTY Configuration page appears, as shown in **Figure 37**.

   ![PuTTY Configuration Page](image)

   **Figure 37: PuTTY Configuration Page**

2. On the PuTTY Configuration page, do the following:

   a. In the **Host Name (or IP address)** field, enter the IP address of the switch.

   b. In the **Port** field, enter 22.

   c. Click **Open**.

   The command prompt window opens.

3. At the command prompt, enter **admin** and then press Enter.

   The **STCLI** command prompt opens.
**STCLI**

**STCLI** is the ShoreTel command line interface (CLI) that allows you to view switch configuration information, manually set the IP address, reboot or shut down the switch, and archive log files.

During the launch of the **STCLI** (as described in Accessing Utilities from the Serial Port on page 147 and Accessing Utilities from SSH on page 148), the main **STCLI** menu appears (Figure 38).

![Figure 38: STCLI Login and Main Menu](image)

Exiting **STCLI** returns the user to the Admin account BASH shell. To close the window, type Exit on the Linux command line.

**Table 25** describes the **STCLI** commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 – Exit</td>
<td>Logs you out of Shortel commands. You must exit ShoreTel commands before running svccli.</td>
</tr>
<tr>
<td>1 – Show Version</td>
<td>Displays the version of system software on the switch.</td>
</tr>
<tr>
<td>2 – Show System Configuration</td>
<td>Displays the current values for the system parameters that are viewable through ShoreTel commands.</td>
</tr>
</tbody>
</table>
Specifying a Static IP Address

The default configuration of new ShoreTel voice switches is to use DHCP to obtain an IP address. To ensure that a DHCP lease is not lost, ShoreTel recommends that you assign a permanent or static IP address to voice switches. You can use DHCP reservations to assign a permanent IP address to a unit or you can manually assign a static IP address. This section describes how to set a static IP address using the ShoreTel command line interface (STCLI).

1. Access the STCLI interface, as STCLI on page 149 describes.

2. Type a 3 on the command line to select Change System Configuration. The STCLI window displays the Change System Configuration options.

3. Type a 6 on the command line to select Enable/Disable DHCP. The STCLI window displays the DHCP options.
4. Type 0 on the command line to select Manual Configuration.

5. Change the network parameters as required to support the fixed address from the Change System Configuration entry line.

6. After completing changes to the configuration, type `exit` to close the STCLI.

7. Reboot the switch.

Implementing the Voice Switch Functionality

This section describes how to implement the voice switch functionality on the switches that also host email. ShoreTel Director supports the following tasks:

- Adding a new voicemail model switch to a ShoreTel server, described in Adding and Configuring a Voicemail-enabled Switch on page 151
- Configuring voice mail, described in Configuring Voice Mail on page 153
- Specifying Linux root and administrator passwords, described in Specifying Root and Administrator Passwords on page 155
- Specifying maximum size and age of log files stored on the CF card, described in Log File Size and Age on page 163
- Configuring backup of voice mail and enabling its automatic activation, described in Configuring Automatic Backup for a Switch on page 157
- Monitoring memory usage on the CF card, described in Monitoring Memory Usage for a Voicemail Model Switch on page 163

Adding and Configuring a Voicemail-enabled Switch

After physically connecting a voicemail-enabled switch to the network, the system administrator adds the switch to the system through ShoreTel Director.

1. Launch ShoreTel Director.

2. Click Administration > Platform Hardware > Voice Switches/Service Appliances > Primary.

   The Primary Voice Switches/Service Appliances page appears.

3. In the Add new switch/appliance at site field, select the site where you want to add the switch.

4. In the of type field, select the model of the switch to add to the site.

5. Click Go.

   The Edit Switch page appears.

6. Complete each field according to the plan for this switch and network.
Refer to Configuring Voice Switches on page 111 for instructions on configuring a ShoreTel Voice Switch.

The switch configuration window for Voice Model Switches contains voice mail and back-up options in addition to voice switch options available for other switches. Refer to Configuring Voice Mail on page 153 for instructions on configuring voice in mail. Refer to Configuring Automatic Backup for a Switch on page 157 for instructions on configuring system back-up.

Replacing a Switch

When replacing a voicemail-enabled switch, CF card retains the voicemail contents. The card can go into the replacement switch if the switch is the same model as the original.

To replace a voicemail-enabled switch and retain the voicemail on the original switch:

1. Remove the original switch from the ShoreTel network.
2. Remove the plate covering the memory slot on the left side of the original switch.
3. Remove the CF card from the memory slot.
4. Remove the plate covering the memory slot on the left side of the replacement switch.
5. Insert the CF card into the memory slot and replace the memory slot cover.
6. Connect the replacement switch into the network.
7. In ShoreTel Director, open the Switches window by selecting Administration-> Switches.
8. Open the Edit ShoreTel Switch page by clicking the name of the replaced switch.
9. Enter the MAC address of the new switch in the Ethernet Address field and press the Save button at the top of the page.
10. Boot the V-switch and configure the normal settings (IP/NTP/Server/etc.)
11. Log into the Linux shell of the V-switch and execute the following commands.

```bash
    cd /cf/shorelinedata
    rm -f MACADDRESS.txt
```

Upgrading a Switch

Upgrading a voicemail-enabled switch uploads new switch firmware and server software to the device. Switch upgrades are necessary when to maintain compatibility with the remainder of the system when the ShoreTel system is upgraded. A voicemail-enabled switch allows the following upgrade methods:

- Restart and Reboot operations

  Restart and reboot options that also upgrade the switch software and firmware when a new version is available in the system. Restart and Reboot are initiated through Director Switch Maintenance pages.
Upgrading the firmware of a voicemail-enabled switch at a remote site requires a minimum bandwidth of 384 Kbps between the switch and the FTP server the provides the new firmware. A remote upgrade might be impossible if the minimum bandwidth is not available. The firmware upgrade requires 45 minutes at the minimum bandwidth; higher bandwidth reduces the upgrade time.

**Configuring Voice Mail**

Voicemail is configured through one of the following ShoreTel Director pages:

- **Edit Application Servers** - To access, select Administration > Application Servers > HQ/DVS, and then select the desired V Model Switch.

  The V model features in the Application Servers window are the same as on other platforms except that on a V model switch:

  - Enabling and configuration of automatic daily backup is included.
  - Simplified Message Desk Interface (SMDI) is disabled.

  Figure 39 shows the Application Servers window for the switch HQVMB-50

![Figure 39: Configuring Voice Mail through Application Servers Window](image)

- **Edit Switches** - To access, select Administration > Platform Hardware > Voice Switches / Service Appliances > Primary, and then select the desired V Model Switch. Figure 40 shows the voicemail parameters part of the window.
Configuring File-Based Music on Hold

File-based MOH can be configured for application servers and Voicemail Enabled Switches. After file-based MOH is configured, you can then select the MOH file to use for the following:

- **DNIS** - See Editing the DNIS Digit Map on page 180.
- **System-wide default** - See Other Parameters on page 56.

---

**Note**

If the MOH file is defined for DNIS, it is played first. If the MOH file is not defined for DNIS, the MOH file defined for UserGroups is played. If the MOH file is not defined for UserGroups, the MOH file defined for the System-wide Default is played. If no MOH file is defined for DNIS, UserGroups, or the System-wide Default, the audio input jack is used.

---

**Configuring MOH for an Application Server**

1. In Director, click **Administration > Application Servers > HQ/DVS**.
2. Select the server to configure.
   
   The HQ/DVS Edit Server page appears.
3. Select the **Enable File Based Music On Hold** check box.
4. (Optional) In the **Maximum Concurrent Music On Hold Calls** field, enter the maximum number of concurrent calls to allow for MOH. This is a maximum limit, not a guaranteed number.
Configuring MOH for a Voicemail Enabled Switch

1. In Director, click Administration > Platform Hardware > Voice Switches/Service Appliances > Primary.

2. Select the Voicemail Enabled Switch to configure.
   The Voice Switches Edit page appears.

3. Select the Enable File Based Music On Hold check box.

4. (Optional) In the Maximum Concurrent Music On Hold Calls field, enter the maximum number of concurrent calls to allow for MOH. This is a maximum limit, not a guaranteed number.

Specifying Root and Administrator Passwords

The voicemail-capable voice switches provide access to command line interfaces (CLIs) for diagnostics and advanced configuration tasks. Other than specifying a fixed IP address, CLI access is not required for typical switch operation and maintenance.

ShoreTel provides two default accounts for accessing these CLIs:

- Admin: This account is for configuring tasks that require CLI access.
- Root: The user with a root account has access to all internal Linux commands.

**WARNING!**
ShoreTel recommends using the Root command only under direct supervision of ShoreTel personnel. The root admin does not restrict command scenarios that can render the switch unusable.

You can use ShoreTel Director to change the passwords for logging into these accounts. To change the passwords logging into the ShoreTel Voice Switch CLI accounts:

1. Launch ShoreTel Director.

2. Click Administration > System Parameters > Other. The Edit Other Parameters page appears as shown in Figure 41.
3. In the first **admin** password field, type the password to use for the admin account.

The password must have a minimum of 4 ASCII characters and a maximum of 26 ASCII characters. The system permits the following characters:

```
!#$%&'()*+,-.0123456789:;=@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_/
`abcdefghijklmnopqrstuvwxyz{|}~
```

The system does not allow the following characters:

```
? " <>
```

4. In the second **admin** password field, retype the password that you entered into the first field.

5. In the first **root** password field, type the password to use for the root account.

The password must have a minimum of 4 ASCII characters and a maximum of 26 ASCII characters. The system permits the following characters:

```
!#$%&'()*+,-.0123456789:;=@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_/
`abcdefghijklmnopqrstuvwxyz{|}~
```

The system does not allow the following characters:

```
? " <>
```

6. In the second **root** password field, retype the password that you entered into the first field.

7. Click **Save**.
Configuring Automatic Backup for a Switch

Due to the limited CF card capacity, we recommend daily backup of voice mail and Auto-Attendant data. Automatic backup begins immediately after the server completes its daily house-keeping operation. (The house-keeping utilities are built-in and remove log files and old voice mails based on the configuration data in the Director.) In addition:

- Automatic backup stores voicemail, auto attendant data, and switch log files to an FTP server. After completion of the daily file-system cleanup tasks, the switch begins automatic backup. A timestamp is appended to the name of files copied to the target server.

- Automatic backup provides a source for the most recent day’s voice mail and other data in the event of a system failure. It is not intended to be an archive of voice messages or a source for retrieving deleted voice mail.

Note

A voicemail-enabled switch relies on the ftpsync facility to synchronize its local (or source) directory to the back-up server (or target) directory. Therefore, the server must support ftpsync as described in RFC 959. The server must also support the MDTM and SIZE commands. FTP servers in Windows Server 2008 and 2012 meet these requirements.

Configuring automatic backup for a switch:

1. Launch ShoreTel Director.
2. Click Administration > Platform Hardware > Primary. The Primary Voice Switch/Service Appliances page appears.
3. Select the switch to configure for automatic backup. The Edit page for that switch appears.
4. Scroll down to the Backup section and do the following:
   a. Check the Enable Daily Backup checkbox.
   b. In the IP address field, enter the IP address of the FTP server to back the switch files up.
   c. In the FTP Port field, enter the port number that the switch is to use to communicate with the recipient FTP server.
   d. In the Directory field, enter the path to the file on the FTP server to which you want to back the switch files up.
   e. In the User ID field, enter the user name that the switch is to use to access the FTP server files for backup.
   f. In the first Password field, enter the password that the switch is to use to access the FTP server files for backup.
   g. In the second Password field, enter the same password that the switch is to use to access the FTP server files for backup.
   h. Click Save.
Configuring a Target Server for Backup

Backing up V model switch voice mail requires a target FTP server. A ShoreTel Main Server or a third-party server can function as the recipient of V Model Switch backup files.

This section describes an FTP server configuration, using a Windows server as the recipient. (Detailed instructions on configuring Windows servers are available in the article How To Set Up Isolated FTP Site at [http://support.microsoft.com/kb/555018](http://support.microsoft.com/kb/555018).) The section first lists the configuration data entered into Director. The subsequent list shows the information entered at the server, including configuration data from the V model switch.

On the server, perform the following:

1. Using the Windows Computer Management dialog, add a new FTP site

   In Figure 42, an FTP site named “ShoreTelBackup” is added.

   ![Figure 42: The New Target Server is Identified](image)

2. For the new server, specify the IP address and port number

   In Figure 43, the IP address is 10.1.1.42. and port is 5555.
3. In the ShoreTel Backup Properties page, specify the local path. 

In Figure 44, the local path is \ShoreTelBackup.

4. In the FTP Site Creation Wizard, specify that the user is isolated. Figure 45 shows the correct setting.
5. Type a name and description of the FTP server in the General page (Figure 46).

6. Enable the following options:
   - User cannot change password
   - Password never expires.

7. Verify the resultant path of the configured server, as shown in Figure 47.
Boot and Restarting Voicemail Models Switches

ShoreTel 14.2 System Administration Guide 161

**Rebooting and Restarting**

Rebooting and restarting voicemail-enabled switches have different scopes.

- Rebooting a voicemail-enabled switch also reboots the Linux kernel and everything that a kernel reboot entails.
  
  A reboot takes much longer than a restart.

- Restarting a voicemail-enabled switch reboots only the ShoreTel application layer.

  On ShoreTel switches running on VxWorks, rebooting and restarting are identical.

Under certain conditions, initiating a restart reboots the switch. One example of such a condition is when a switch upgrade is available.

When a ShoreTel voice switch boots, it requires an IP address to connect to the network and an application program. ShoreTel voice switches are set to use a DHCP server for an IP address and to retrieve the application from the switch’s flash memory.

ShoreTel recommends using static IP parameters configured via the serial port, as this is much more reliable. When using DHCP, ShoreTel recommends using DHCP reservations for each switch to ensure that DHCP leases are not lost.

If a DHCP server is not available, you can set the IP address manually from the switch’s maintenance port from STCLI.

**Figure 47: After Configuring the FTP Server is Finished**
If the switch fails to load the application from flash and does not have the IP address of the ShoreTel server, you can set the IP address and boot parameters by connecting to the maintenance port and using the configuration menu. The configuration menu allows you to set the IP address of the switch and enter the ShoreTel server (boot host) IP address.

A voicemail-enabled switch can be brought up by a regular boot (flash memory-sourced) or by a software upgrade boot.

### Specifying a Time Source

ShoreTel servers maintain an internal time-of-day (TOD) clock, which is initialized by input received at boot time from an NTP server. ShoreTel servers use the time of day clock to mark voicemail and track other transactions.

The voicemail-enabled switches begin server operations only after they receive an initial TOD input. If the time is not available from a designated source at boot time, the V Model switch supports all switch operations and will periodically poll for the time of day setting. After receiving the a time of day setting, the V model switch begins server operations.

The NTP server can be specified through DHCP or as a static address. If no address is specified, the V Model switch polls NTP servers at addresses specified by an internal configuration list. The internal configuration list includes the Headquarters server and Internet based NTP servers.

- If an IP address is listed that does not point at an NTP server, the V Model switch will not begin server processes until the address is corrected.
- If the IP address points at a server that is not available, the V Model switch periodically polls the IP address for the NTP server. When the server becomes available, the V Model switch begins performing server operations after it polls the server and receives the time of day setting.

After the server becomes available, rebooting the V model switch may be faster than waiting for it to poll the NTP server.

### Reboot Methods

**Flash Boot**

The standard method for booting a ShoreTel voice switch is to boot from the switch’s flash memory. When a ShoreTel switch is first powered on, it reads the boot parameters stored on the non volatile memory, which instructs the switch to load software from flash memory. When the software starts, it loads its configuration, which is also stored in flash memory.

**Default Button**

The Default Button is the small “paperclip” button on the left side of the switch. Pressing this button replaces the two configuration files with their default variants. The Compact Flash is not affected.

Pressing this button and holding for 10 seconds, in addition to replacing the configuration files, removes all files from the Compact Flash.
FTP Boot

Booting from FTP is available when you cannot boot the switch from internal memory. When booting a switch from FTP, the operating system and software are loaded from the FTP site identified in the boot parameters. The loaded files define a default configuration.

Voicemail services on the switch are disabled after booting from FTP and are restarted only by booting from Flash. After an FTP boot, the switch can perform telephony functions as those available through other ShoreTel switches. V model switches started with an FTP boot can operate only as a voice switch (controlling phones, trunks, and call routing).

FTP boot is typically used for troubleshooting and also supports maintenance tasks and the backup and restore facilities. FTP boot supports certain maintenance functions, such as an emergency boot if the flash becomes damaged.

Monitoring Memory Usage for a Voicemail Model Switch

To avoid disk space problems for a voicemail model switch, you need to monitor and manage Compact Flash (CF) memory and log files to ensure adequate disk space.

You can monitor disk space for voicemail model switches using either of the following methods, which are both available in the Maintenance menu of ShoreTel Director:

- The Diagnostics & Monitoring system displays status of voicemail model switches. For more information, see Monitoring Voice Mail Status on page 719.

- Quick Look and Maintenance > Voice Mail Servers both provide status and other maintenance information for voice mail servers. For more information, see Monitoring Voice Mail Servers on page 645.

In addition to monitoring memory usage through Diagnostics & Monitoring or Quick Look, you can create an event filter to send you an email message if memory usage is high.

CF Memory Usage

Typical CF card capacities are 1 GB, 2 GB, and 4 GB. The proper planning of voice mail usage and aging can help prevent excessive buildup of voice mail on the CF card. If the CF card becomes full, it cannot accept new voice mail.

Log File Size and Age

Due to the constraints on CF memory space, you should limit the amount of disk space that log files consume. When you add a voicemail-enabled switch to the system, you can modify the values for the maximum size and age of log files. You do this through the Administration > System Parameters > Other page in ShoreTel Director.
Configuring Service Appliances

Before you can use ShoreTel conferencing or instant messaging, you must configure any Service Appliances attached to your system. For detailed configuration procedures, refer to the *Conferencing and Instant Messaging Planning and Configuration Guide*. 
CHAPTER 7

Configuring Trunks

This chapter describes how to configure trunks and trunk groups in ShoreTel Director. The topics in this chapter are:

Overview .......................................................................................................................... 167
Setting Up Trunk Groups ............................................................................................... 167
   Adding or Editing a Trunk Group .............................................................................. 168
Importing Local Prefixes .............................................................................................. 177
Exporting a Local Prefix List ......................................................................................... 178
DID Ranges ................................................................................................................... 178
Editing the DNIS Digit Map .......................................................................................... 180
Adding Local Area Codes .............................................................................................. 181
Configuring Nearby Area Codes ................................................................................ 181
Configuring Prefix Exceptions ..................................................................................... 181
Configuring Off-System Extensions .......................................................................... 181
Configuring Tandem Trunking ..................................................................................... 181
Configuring Centrex Flash ........................................................................................... 182
Configuring Pause in Dialing – Trunk Access ............................................................. 183
Individual Trunks .......................................................................................................... 184
   Adding or Editing a Trunk .......................................................................................... 185
Forwarding Original Caller ID Outside a ShoreTel Network ........................................ 187
   When Carriers Validate the Caller ID ...................................................................... 187
   When a Carrier Does Not Validate the Caller ID ...................................................... 187
   Purpose of the Billing Telephone Number for Caller ID .......................................... 188
   Important Issue with Early Implementations of Original Caller ID.......................... 190
   Enabling the Original Caller Information .................................................................. 190
Introduction to ISDN Profiles................................................................. 191
Caller ID Name on T1-PRI Trunks .......................................................... 192
  Caller ID Name with the Public Network.............................................. 192
  Implementing Caller ID Name on T1-PRI ........................................... 194
  Creating and Applying an ISDN Profile for CID Name....................... 195
Specifying a 20-Digit SETUP Message for PRI or BRI .......................... 198
Euro-ISDN Channel Negotiation ............................................................. 200
  ISDN Channel Negotiation ............................................................... 200
  ISDN Profile to Enable ISDN Channel Negotiation.......................... 200
  Switch Settings for Euro-ISDN Channel Negotiation......................... 202
Euro-ISDN Channel Negotiation ............................................................. 200
  Connected Number Display for Outside Callers ............................... 203
  Creating ISDN Profile for Called Number Display............................ 203
ISDN Profile for RNIE............................................................................ 205
  Number Sequence in the Q.931 SETUP Message............................... 206
  Creating an RNIE ISDN Profile.......................................................... 207
Overview

Before beginning, you should understand the different trunk types and trunk features that the ShoreTel system supports.

- A very thorough description of the types of trunks and their associated features is included in the Planning and Installation Guide, Chapter 5, “Trunk Planning and Ordering.”
- A detailed description of how the dialing plan, network call routing, and digit manipulation operate is included in the Planning and Installation Guide.

For more information about the features supported outside the U.S. and Canada, refer to the Planning and Installation Guide.

For an overview of the various trunk types and trunk features, refer to the “Trunk Planning and Ordering” chapter in the Planning and Installation Guide.

Setting Up Trunk Groups

Click Trunk Groups under the Trunks link in the navigation pane to open the Trunk Groups window, as shown in Figure 48.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Site</th>
<th>Trunks</th>
<th>DID</th>
<th>Destination</th>
<th>Access Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Loop Start</td>
<td>Analog Loop Start</td>
<td>Headquarters</td>
<td>0</td>
<td>No</td>
<td>8156777</td>
<td>9</td>
</tr>
<tr>
<td>ATT 9K Incoming</td>
<td>Digital Trunk In</td>
<td>Headquarters</td>
<td>8</td>
<td>Yes</td>
<td>8156777</td>
<td>9</td>
</tr>
<tr>
<td>ATT FDD18122</td>
<td>Digital Trunk In</td>
<td>Headquarters</td>
<td>46</td>
<td>Yes</td>
<td>8156777</td>
<td>9</td>
</tr>
<tr>
<td>ATT T12 P307C33</td>
<td>Digital Trunk In</td>
<td>Headquarters</td>
<td>8</td>
<td>Yes</td>
<td>8156777</td>
<td>9</td>
</tr>
<tr>
<td>Digital Loop Start</td>
<td>Digital Loop Start</td>
<td>Headquarters</td>
<td>0</td>
<td>No</td>
<td>8156777</td>
<td>9</td>
</tr>
<tr>
<td>Digital Loop Start</td>
<td>Digital Loop Start</td>
<td>Headquarters</td>
<td>0</td>
<td>No</td>
<td>8156777</td>
<td>9</td>
</tr>
</tbody>
</table>

Figure 48: Trunk Groups List Page

The following table provides definitions for the parameters on the Trunk Groups page:

Table 26: Trunk Groups

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of an existing trunk group. Clicking a name invokes the Trunk Group edit page, where you can edit the trunk group configuration.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of trunk group.</td>
</tr>
<tr>
<td>Site</td>
<td>The trunk group site. Be aware that a trunk group cannot span sites. For information about configuring sites, refer to Chapter 3, ShoreTel Sites on page 77.</td>
</tr>
</tbody>
</table>
### Adding or Editing a Trunk Group

To add a new trunk group, on the Trunk Groups list page, specify a site from the Add new Trunk Group at site drop-down list, select a trunk group type from the "of type" drop-down list, and click Go. To edit an existing trunk group, click a trunk group from the list of trunk groups in the Name column on the Trunk Groups list page.

When you add a new trunk group or click the name of an existing trunk group in the Trunk Groups list, the applicable Trunk Group edit window is opened.

**Figure 49** and **Figure 50** show the entire Trunk Group editing page for SIP trunks.

**Table 27** provides definitions for the Edit Trunk Group parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunks</td>
<td>The number of trunks in the trunk group.</td>
</tr>
<tr>
<td>DID</td>
<td>Indicates whether the trunk supports DID.</td>
</tr>
<tr>
<td></td>
<td>A trunk group that supports DID must support at least one of the following services:</td>
</tr>
<tr>
<td></td>
<td>- DID</td>
</tr>
<tr>
<td></td>
<td>- DNIS</td>
</tr>
<tr>
<td></td>
<td>- Extension</td>
</tr>
<tr>
<td></td>
<td>For Analog Loop Start and Digital Loop Start trunks, there is no DID or DNIS or extension option. The only available option is destination.</td>
</tr>
<tr>
<td>Destination</td>
<td>The destination where the system routes incoming calls.</td>
</tr>
<tr>
<td></td>
<td>Destinations include the auto-attendant, the operator, or an individual extension. According to the options set, incoming calls can be routed, in order, to the following end points:</td>
</tr>
<tr>
<td></td>
<td>- DNIS</td>
</tr>
<tr>
<td></td>
<td>- DID</td>
</tr>
<tr>
<td></td>
<td>- Extension</td>
</tr>
<tr>
<td></td>
<td>- Destination</td>
</tr>
<tr>
<td></td>
<td>Destination is always available as the last choice for routing.</td>
</tr>
<tr>
<td>Access Code</td>
<td>The access code for the trunk group.</td>
</tr>
</tbody>
</table>
Figure 49: Trunk Group Edit Page Part 1
Configuring Trunks

Adding or Editing a Trunk Group

Table 27: Edit Trunk Group Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the new or existing trunk group.</td>
</tr>
<tr>
<td>Site</td>
<td>Name of the trunk group site.</td>
</tr>
<tr>
<td>Language</td>
<td>Language for the trunk group. Select a language from the drop-down list.</td>
</tr>
<tr>
<td>Enable SIP Info for G.711 DTMF Signaling</td>
<td>Applies to SIP trunks only. Select the check box to enable the use of the SIP INFO method to send a DTMF digit.</td>
</tr>
<tr>
<td></td>
<td>Enable this check box when using third-party SIP devices that do not support DTMF negotiation as described in RFC 2833.</td>
</tr>
<tr>
<td></td>
<td>If the device does not support RFC 2833 and this check box is not enabled, DTMF negotiation fails.</td>
</tr>
<tr>
<td>Profile</td>
<td>Profile for SIP trunk groups.</td>
</tr>
<tr>
<td></td>
<td>Select a SIP trunk profile in the drop-down list. When you save the trunk group configuration, this profile applies to all trunks in the group.</td>
</tr>
<tr>
<td></td>
<td>For information about a SIP trunk profile, see SIP Trunk Profiles on page 593.</td>
</tr>
<tr>
<td></td>
<td>Profiles are also available for PRI and BRI trunk groups. In addition, ISDN profiles are available for PRI/BRI trunks.</td>
</tr>
</tbody>
</table>
Enable Digest Authentication | Applies to SIP trunks only. From the drop-down list, select whether you want to use digest authentication for None, Inbound-Only, Outbound-Only, or All messages. Enter the user name and password if digest authentication for SIP trunks is selected (or, enter the user name and password obtained from the SIP ITSP service provider). This field can not be set to "None" if SIP Trunk registration is required by SIP ITSP.

Inbound Settings

Number of Digits from the CO | Specifies the maximum number of digits expected from the Central Office (for User PRI configured trunks). Digit collection terminates when the maximum number of digits is received, the digit collection timeout is reached, or an exact match is found. The number of digits from the CO applies to all Trunk groups except Analog Loop Start and Digital Loop Start. Network PRI trunks connected to legacy PBXs collect digits from the legacy PBX side. When the ShoreTel system detects a trunk access code, it ignores the Number of Digits from the CO parameter and routes the call according to the dialing plan.

DNIS | Specifies whether the trunk group supports DNIS. When you select DNIS, click Edit DNIS Map to add or delete entries in the DNIS Map. DNIS does not apply to Analog Loop Start or Digital Loop Start trunks.

DID | Specifies whether the trunk group supports DID. When you select DID, click Edit DID Range to add or edit the DID Range as well as view the DID Digit Map. DID does not apply to Analog Loop Start or Digital Loop Start trunks.
### Table 27: Edit Trunk Group Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension</td>
<td>Routes calls directly to an extension based on the digits received from the Central Office without any additional configuration. You can use this option when configuring a tie trunk connected to a legacy PBX. Be aware that the extension length must match the number of digits from the CO. Extension does not apply to Analog Loop Start or Digital Loop Start trunks.</td>
</tr>
<tr>
<td>Translation Table</td>
<td>When using the On-Net Dialing feature, this parameter allows you to specify a digit translation table that is used to strip one or more digits from calls between two systems with extensions of different lengths.</td>
</tr>
<tr>
<td>Prepend Dial In Prefix</td>
<td>When using the On-Net Dialing feature, this parameter allows you to add one or more digits to calls between two systems with extensions of different lengths.</td>
</tr>
<tr>
<td>Use Site Extension Prefix</td>
<td>When using the On-Net Dialing feature, this parameter allows you to specify a site extension prefix that will be added to calls from a system that does not have a prefix to another system that does have a prefix.</td>
</tr>
<tr>
<td>Tandem Trunking</td>
<td>Allows legacy voice systems to use a ShoreTel system for outbound dialing. The ShoreTel system supports network-side PRI, which enables ShoreTel systems to flexibly support digital tie trunks to other systems. Tandem Trunking does not apply to Analog Loop Start or Digital Loop Start trunks.</td>
</tr>
<tr>
<td>User Group</td>
<td>Tandem calls are associated with a user group for outbound trunk selection. Inbound calls recognized as tandem calls are then redirected to an outbound trunk based on the call permissions and trunk group access associated with the user group set in Director.</td>
</tr>
<tr>
<td>Prepend Dial In Prefix</td>
<td>When needed, you can specify a dial-in prefix that is pre-pended to digits collected on tandem calls. The concatenated set of digits is then used in outbound trunk selection for the tandem call.</td>
</tr>
</tbody>
</table>
### Destination

Destination number for inbound calls. All inbound calls are routed to a destination, such as an extension (user, workgroup, or route point) or a specific menu. If other destination options are configured, this destination parameter is the last-choice destination.

Inbound calls first try to match a DNIS entry, then a DID entry, followed by an Extension entry, and finally Tandem Trunking. If no match is found, the inbound call is routed to the destination you set. If you create a trunk group, the destination is the default auto-attendant.

An individual trunk group cannot have overlapping DID or DNIS numbers (received digits).

Users, Menus, Workgroups, and Route Points can have only one DID number, but can have multiple DNIS entries.

### Outbound Settings

#### Outbound

Activates the outbound settings. Select the Outbound check box to activate the outbound settings. If the Outbound check box is not selected, the outgoing fields are greyed out.

#### Access Code

Trunk access code for this trunk group. Typically the access code in the U.S. and Canada is 9.

#### Local Area Code

Local area code for this trunk group. Use this area code for Network Call Routing and Digit Manipulation.

#### Additional Local Area Codes

Used for Network Call Routing and Digit Manipulation. Click Edit to enter any additional area codes that are typically associated with overlay area codes.

#### Nearby Area Codes

Nearby area codes that are cost-free for this trunk group.

#### Billing Telephone Number (BTN)

Enables the switch to forward an original caller’s ID when a received call is redirected by one of ShoreTel’s forwarding features. For example, if an outside caller dials a ShoreTel user whose Find-Me setup specifies a cell phone, the cell phone can show who dialed the ShoreTel number. The applicable forwarding features are Find Me, some Call Handling modes, PSTN Failover, Extension Assignment, Allow Additional Phones to Ring Simultaneously, and Extension Reassignment. For more information, see Purpose of the Billing Telephone Number for Caller ID on page 188.

BTN does not apply to Analog Loop Start or Digital Loop Start trunks.

### Trunk Services

#### Local

Enables local calls. Select this check box to enable local calls.

---

**Table 27: Edit Trunk Group Parameters (Continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination</strong></td>
<td>Destination number for inbound calls. All inbound calls are routed to a destination, such as an extension (user, workgroup, or route point) or a specific menu. If other destination options are configured, this destination parameter is the last-choice destination. Inbound calls first try to match a DNIS entry, then a DID entry, followed by an Extension entry, and finally Tandem Trunking. If no match is found, the inbound call is routed to the destination you set. If you create a trunk group, the destination is the default auto-attendant. An individual trunk group cannot have overlapping DID or DNIS numbers (received digits). Users, Menus, Workgroups, and Route Points can have only one DID number, but can have multiple DNIS entries.</td>
</tr>
<tr>
<td><strong>Outbound Settings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Outbound</strong></td>
<td>Activates the outbound settings. Select the Outbound check box to activate the outbound settings. If the Outbound check box is not selected, the outgoing fields are greyed out.</td>
</tr>
<tr>
<td><strong>Access Code</strong></td>
<td>Trunk access code for this trunk group. Typically the access code in the U.S. and Canada is 9.</td>
</tr>
<tr>
<td><strong>Local Area Code</strong></td>
<td>Local area code for this trunk group. Use this area code for Network Call Routing and Digit Manipulation.</td>
</tr>
<tr>
<td><strong>Additional Local Area Codes</strong></td>
<td>Used for Network Call Routing and Digit Manipulation. Click Edit to enter any additional area codes that are typically associated with overlay area codes.</td>
</tr>
<tr>
<td><strong>Nearby Area Codes</strong></td>
<td>Nearby area codes that are cost-free for this trunk group.</td>
</tr>
<tr>
<td><strong>Billing Telephone Number (BTN)</strong></td>
<td>Enables the switch to forward an original caller’s ID when a received call is redirected by one of ShoreTel’s forwarding features. For example, if an outside caller dials a ShoreTel user whose Find-Me setup specifies a cell phone, the cell phone can show who dialed the ShoreTel number. The applicable forwarding features are Find Me, some Call Handling modes, PSTN Failover, Extension Assignment, Allow Additional Phones to Ring Simultaneously, and Extension Reassignment. For more information, see Purpose of the Billing Telephone Number for Caller ID on page 188. BTN does not apply to Analog Loop Start or Digital Loop Start trunks.</td>
</tr>
<tr>
<td><strong>Trunk Services</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Local</strong></td>
<td>Enables local calls. Select this check box to enable local calls.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Long Distance</strong></td>
<td>Enable long-distance calls. Select this check box to enable long-distance calls.</td>
</tr>
<tr>
<td><strong>National Mobile (not shown)</strong></td>
<td>Enables users to call mobile numbers. This option appears only for PRI trunks in countries with caller-pays billing plans (for example, Ireland). Clear the check box if you do not want to incur the associated costs of allowing users to call mobile phones in caller-pays environments.</td>
</tr>
<tr>
<td><strong>International</strong></td>
<td>Enables international calls.</td>
</tr>
</tbody>
</table>
| **Enable Original Caller Information** | Enables the switch to forward an original caller’s ID when a received call is redirected by one of ShoreTel’s forwarding features. For example, if an outside caller dials a ShoreTel user whose Find-Me setup specifies a cell phone, the cell phone can show who dialed the ShoreTel number. This parameter applies to the following forwarding features:  
  - Find Me  
  - Some Call Handling modes  
  - PSTN Failover  
  - Extension Assignment  
  - Allow Additional Phones to Ring Simultaneously  
  - Extension Reassignment  
  For more informations about enabling original caller information, see Enabling Original Caller Information on page 177.  
  Enable Original Caller Information does not apply to Analog Loop Start trunks. |
| **n11 (for example, 411 or 611, but not 911)** | Enables telephone service calls for service such as directory assistance or repair. This option is not available for every country. |
| **911**                           | Enables emergency 911 calls. This option is not available for every country. To support 911 in the U.S., at least one trunk group per site must allow 911 calls. For a detailed description of 911 support, see Appendix A, Emergency Dialing Operations. |
| **Easy Recognizable Codes (ERC)** | Enables services such as toll-free dialing for easily recognized codes like 800, 888, or 900. This option is not available for every country. |
| **Explicit Carrier Selection**    | Enables you to specify a particular long-distance carrier. The format of the access code is 1010xxx; for example, 1010811. |
| **Operator Assisted (for example, 0+)** | Enables the trunk group to dial the operator. |

Table 27: Edit Trunk Group Parameters (Continued)
Table 27: Edit Trunk Group Parameters(Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller ID not blocked by default</td>
<td>Enables the system to pass Caller ID information by default on outbound calls. To block all calls, clear this option. This option is not available for every country. In the United States, the user can override this option with Vertical Service Codes.</td>
</tr>
<tr>
<td>Enable Pulse Dialing (not shown)</td>
<td>Enables pulse dialing. This check box appears only for Analog Loopstart Trunk Groups created in Director for a region or country where pulse dialing is available. Dialed digits are sent through the selected trunk group to the CO in the form of pulses. The ON Duration, OFF Duration, and GAP Duration between digits is specified by a region or country.</td>
</tr>
</tbody>
</table>

**Trunk Digit Manipulation**

Trunk Digit Manipulation controls how the trunk group manipulates the telephone number before outpulsing the digits to the central office.

Note: All North American dial-plan numbers are converted into the 1+10-digit format internally before they are passed to the trunk group for digit manipulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove leading 1 from 1+10D</td>
<td>Drops the leading 1 from a dialed number. Dialing only ten digits is required by some long-distance service providers. If you provide a local prefix list, seven digits are dialed for all entries in the list (Local Area Code only, not Additional Local Area Codes).</td>
</tr>
<tr>
<td>Remove leading 1 for Local Area Codes (for all prefixes unless a specific local prefix list is provided below)</td>
<td>Drops the leading 1 for the local area codes (Local and Additional Local). Dialing only ten digits for local area codes, particularly with overlay area codes, is required by some local service providers. If a local prefix list is provided, the leading “1” is removed for the all entries in the list.</td>
</tr>
<tr>
<td>Dial 7 digits for Local Area Code (for all prefixes unless a specific local prefix list is provided below)</td>
<td>Enables the trunk to dial numbers in the local area code with seven digits. Some local service providers require this capability.</td>
</tr>
<tr>
<td>Local Prefixes</td>
<td>Enables you to specify a list of local prefixes. Click Go to Local Prefixes List to view, add, or edit the local prefixes for the site. When you use a local prefix list, prefixes that are not in the prefix list are considered long distance and require a long distance trunk service. Local prefixes can be imported from a CSV file. For more information, see Importing Local Prefixes on page 177.</td>
</tr>
<tr>
<td>Prepend Dial Out Prefix</td>
<td>Enables you to specify a dial-out prefix. The dial-out prefix is prepended to the dial-out string that results from the other rules. (The dial-out prefix is not applied to off-system extension calls.) A dial-out prefix is typically required when connecting to, and leveraging the trunks on, a legacy PBX.</td>
</tr>
</tbody>
</table>
### Table 27: Edit Trunk Group Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off-System Extensions</td>
<td>Enables you to add or edit off-system extensions. Click <strong>Edit</strong> to add or edit extension ranges that can be accessed through this trunk group. Off-system extensions are typically used for setting up a tie trunk to a legacy PBX and configuring coordinated extension dialing. For more information, see Escalation Profiles and Other Mailbox Options on page 487. The dial-out prefix and digit manipulation rules are not applied to off-system extensions.</td>
</tr>
<tr>
<td>Translation Table</td>
<td>Enables you to specify the digit translation table used by the system to strip one or more digits from calls between two systems with extensions of different lengths. ShoreTel does not apply inbound digit treatment to digit strings beginning with a trunk access code (such as 9) as would occur in tie trunk configurations. Digit strings beginning with a trunk access code are routed according to the dial plan. A user group named Account Codes Service is created for use by the Account Codes Service. It is not available for assignment to users, but it may be edited.</td>
</tr>
</tbody>
</table>
Enabling Original Caller Information

The Enable Original Caller Information parameter is a starting point for other tasks that you must perform to transmit the original caller ID. For descriptions of these tasks, see the following sections:

- For details about forwarding the original caller ID, see the Forwarding Original Caller ID Outside a ShoreTel Network on page 187.
- For the class of service (COS) that a user must have to ensure that the forwarding of an outside call is permitted, see the Specifying a Class of Service on page 337.
- The function Send Incoming Caller ID must be enabled for call forwarding features such as Find-Me, External Assignment, and Allow Additional Phones. This enable is illustrated in Chapter 12, Configuring User Features. Refer to the description in Find Me and External Assignment subsection of the Forwarding Original Caller ID Outside a ShoreTel Network on page 187.
- To respond to carriers who do not validate the caller ID in a SETUP message for an original caller ID, see the "ISDN Profile for RNIE" on page 205. This advanced (and rarely needed) task follows the tasks described in the Forwarding Original Caller ID Outside a ShoreTel Network on page 187.

**WARNING!**

In ShoreTel Releases 11, 10.2, 10.1, and 10, the forwarding of the original caller ID to an outside device relied on custom dial plan elements from ShoreTel TAC. If TAC implemented such a custom dial plan, TAC must remove the elements related to this function before the current capability can work. (This issue does not exist for customers whose new installation contains the present implementation described in this book.) If a system with such a dial plan is upgraded, problem behaviors related to call forwarding or original caller ID can show up. Some possible behaviors are:

- Forwarded calls go to the user’s voice mail instead of out the trunk.
- Forwarded calls are rejected by the carrier.

Upgraded customers who know or suspect that such a plan has been used should contact TAC for help. However, some customers might not know that a custom dial plan has been used for original caller ID and should, therefore, monitor the call forwarding and caller ID performance after an upgrade.

Importing Local Prefixes

You can import or export local prefixes in CSV format. Local prefix lists can be purchased or obtained free from various web sites.

Importing local prefixes from a CSV file:

1. Navigate to the Trunk Group profile for which you want to import local prefixes.
2. Scroll to the Local Prefix section at the bottom of the page and click Go to Local Prefixes List.
   
   The Local Prefix page appears.
3. Click Add New List.
The Edit Local Prefix page appears.

4. Click the **Import** button.

   The Import Local Prefixes dialog box appears.

5. In the field, enter the path and name of the CSV file to import or click **Browse** to search for the file.

6. Click **Upload**.

   The Local Prefixes edit page appears.

7. Edit the list as needed. You can rename the list and add, edit, or remove prefixes.

8. Click **Save**. The list is now available from the Local Prefix drop-down list.

### Exporting a Local Prefix List

1. Navigate to the Trunk Group profile that contains the list that to export.

2. Scroll to the Local Prefix section at the bottom of the page and click **Go to Local Prefixes List**.

   The Local Prefix page appears.

3. Click the list you want to export.

   The Local Prefixes edit page appears.

4. Click the **Export** button.

   Your web browser opens the file in a new window.

5. Specify where you want the file and save it as a text file.

### DID Ranges

Direct Inward Dialing (DID) is a feature offered by telephone companies for use with their customers' PBX systems, where the telephone company allocates a range of numbers to a customer's PBX. As calls are presented to the PBX, the number that the caller dialed is also given, allowing the PBX to route the call to the intended party.

A DID range is a list of consecutive (non-overlapping) DID numbers assigned to a Trunk Group. A DID number can be assigned to multiple trunk groups.

Available DID **numbers** are DID numbers within a range that are not assigned to a user or entity within the context of that range. **Note that DID number availability within a range does not consider DNIS assignments.** Although numbers assigned as a DNIS number are still enumerated as available within a DID range, attempts to assign these DID numbers will be unsuccessful.

DID assignment field and range indication fields are listed on the User, Workgroup, Route Point, Menu, Hunt Group, and Bridged Call Appearance pages.
Creating a DID Range

To set a DID range, click Edit DID Range from the appropriate Edit Trunk Group page to invoke the DID Range page.

For each block of DID numbers, enter the base phone number and the number of phone numbers supplied by that block in the appropriate fields, and click “Add this record.” When finished, click Save. You can configure multiple ranges per trunk group.

To view a configured DID Digit Map (Figure 51), click View DID Digit Map. From here, you can view pertinent information about each DID number in the ShoreTel system.

Assigning DID Numbers from a Range

DID assignment sections on Director pages consist of two parameters: DID Range and DID Number. Figure 52 displays these parameters on the Edit User page. Other affected pages are constructed similarly.
The DID Range parameter displays the complete base phone number and trunk group name.

- To authorize the user to use a DID number, select the checkbox located left of the DID Range text.
- Access the drop-down menu to specify the DID Range from which the entity's DID number will be selected. Each DID Range corresponds to a trunk group and lists the number of available numbers.

- A link to the System Directory page is located right of the DID Range data entry field.

Administrators can assign a DID number by viewing the System Directory page to find an available DID number, then selecting the number from the drop-down list. Unassigned numbers within a DID range may not be available if the number is assigned as a DNIS in the same trunk group.

- The DID Number parameter assigns the specified DID number to the entity. The prefix located left of the data entry field and the range located right of the data entry field are based on the selected DID Range.

### Editing the DNIS Digit Map

1. Navigate to the Trunk Group that is to support DNIS.
2. Click the Edit DNIS Map button to open DNIS Digit Map.
3. In the Add this record field in the Received Digits column, type the DNIS number that the telephone company sends.
4. To create an identifier for the map, type a description in the field in the Dialed Number column. The description can include up to 26 alpha and numeric characters. This description appears to call recipients and in call detail reports (CDRs).
5. Do one of the following to specify the extension to which the DNIS is routed:
   - To map the DNIS to an internal extension, click the Extension radio button and enter the extension you want to use in the Destination field. (You can click the Search button to view the list of available extensions.)
   - To map the DNIS to an off-system extension, click the Off-System radio button, select the extension range that includes the extension you want to use, and enter the extension you want to use in the Destination field.
7. Click Add this record.
Adding Local Area Codes

1. To configure additional local area codes, click the associated button on the Trunk Group edit page. The Addition Local Area Codes dialog box appears.

2. Click **New** to add an additional local area code, or click **Remove** to delete an area code.

Configuring Nearby Area Codes

1. To configure nearby area codes, click the associated button on the Trunk Group edit page (see Figure 49 on page 169). The Nearby Area Codes dialog box appears.

2. Click **New** to add a nearby area code or **Remove** to delete one.

Configuring Prefix Exceptions

1. To configure the local prefixes list, click the link **Go to Local Prefixes List** located near the bottom of the Trunk Group edit page.

   The Local Prefixes dialog box appears.

   **Note**
   
   If you click **Delete**, changes take place immediately.

2. To configure local prefixes, click **Add new list** or an existing list to display the Local Prefixes dialog box.

3. Enter the prefix extensions.

4. To save your changes, click **OK**.

Configuring Off-System Extensions

If you are using off-system extensions, you can list them by clicking the Edit button on the Trunk Group edit page. Off-system extensions are typically used when setting up a tie trunk to a legacy PBX and configuring coordinated extension dialing.

Configuring Tandem Trunking

Tandem trunking treats digits on an incoming trunk call as a PSTN number. Received digits are tested against DNIS, DID, Extension, and Tandem Trunking, in that order. When Tandem Trunking is enabled, the number of digits from the CO may have no effect if the first digit(s) matches a Trunk Access Code. To define trunk access and call permissions, associate a user group with the tandem trunk group.
Any Dial In Prefix is pre-pended to each set of inbound digits. You can use DNIS/DID/Extension matching with a Dial In Prefix.

When using NI-2 signaling on PRI trunks—for example in a tie trunk scenario—Caller ID name is also captured, when available, on all inbound calls. For outbound calls, the Caller ID name is delivered for calls that are made to off-system extensions, but not generally for all outbound calls.

Tandem calls are reported in the Trunk Detail and Trunk Summary reports, with incoming and outgoing legs reported according to the reports' formats.

### Configuring Centrex Flash

**Note**

Centrex Flash configuration is required only on Analog Loop Start trunks.

You can program Centrex Flash on a custom button so that a ShoreTel user can transfer a call to another number in the PSTN. The following sequence begins when the user presses that customized button:

1. A flash is generated on the current call.
2. The central office presents dial tone to the ShoreTel user.
3. The user can then dial any PSTN number.
4. Upon hearing the ring-back tone, the ShoreTel user completes the transfer by hanging up the handset.

For Centrex Flash configuration steps, see Configuring Programmable IP Phone Buttons on page 234.

**Note**

Because the user is directly connected to the central office, certain items disappear from consideration, as follows:

- No access code is required.
- No permissions are checked.
- No account code is supported.
- No CDR logging of the second call occurs.

Centrex Flash is useful in branch offices or small office environments with a limited number of analog Centrex lines. If an external caller needs to be transferred to an external number, the two trunks are cleared (instead of quickly busying-out the trunks after a few transfers). In this way, the feature reduces the number of physical trunks needed to transfer calls because no trunks are in use after the transfer is completed.

Centrex transfer is supported only on analog loop-start trunks. If the call is not on an analog loop-start trunk, the operation has no effect.
The trunk that transports the call must be configured on one of the following switches:

- ShoreTel Voice Switch 40/8
- ShoreTel Voice Switch 60/12
- ShoreTel Voice Switch 120/24
- ShoreTel Voice Switch 30
- ShoreTel Voice Switch 50 and 50v
- ShoreTel Voice Switch 90 and 90v
- ShoreTel Voice Switch 220T1A (on analog loop-start trunk ports only)

This feature replaces a trunk-to-trunk transfer in which two trunks are tied up for the duration of the call. The current call must be connected and be a two-party call.

## Configuring Pause in Dialing – Trunk Access

The Pause in Dialing – Trunk Access feature allows the insertion of commas (,) into Prepend Dial Out prefix of a trunk group to specify one-second pause periods during the transmission of pulse digits. Pause periods are permitted in the following trunk group types that send digits as pulses:

- Analog Loop Start
- Digital Loop Start
- Digital Wink Start

### Note

**Example:** Assume the prepend dial-out prefix of an analog trunk group is “9,”. When a user dials “914085551111”, the following pulse-digit sequence is transmitted on the trunk: “9< silence for two seconds>14085551111”.

Commas are permitted anywhere within the Prepend Dial Out Prefix.

Feature restrictions include:

- The pause cannot be used to insert account codes.
- Commas in Communicator dial strings are ignored.
- Commas in dial strings sent by other TAPI applications are ignored.

To enter a dial pause for a specific trunk group, perform the following:

1. Launch ShoreTel Director.
2. Click **Administration -> Trunks -> Trunk Groups**.
3. Select the trunk group for which you want to introduce a dial pause.
The Trunk Groups Edit page for the selected group appears.

4. Enter the code in the Prepend Dial Out Prefix data entry field located near the bottom of the page.

5. Press the **Save** button at the top of the page.

## Individual Trunks

This section explains how to configure individual trunks after you have created the associated trunk groups, as described in **Setting Up Trunk Groups** on page 167.

To open the Trunks by Group page, click Trunks from the navigation pane, and then click Individual Trunks. The Trunks by Group page appears.

To select a trunk group, select a site from the **Add new trunk at site** drop-down list, then select a trunk group from the **In trunk group** drop-down list, and click **Go**. The trunks in the selected trunk group are listed.

For descriptions of the columns in the Trunks by Group page, see the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name of an individual trunk in the group. Click an entry in the <strong>Name</strong> column to open the Trunks edit page to edit the individual trunk’s parameters.</td>
</tr>
<tr>
<td>Group</td>
<td>This is the trunk group name. Click a group name to invoke the Trunk Group edit page and edit the trunk group’s parameters.</td>
</tr>
<tr>
<td>Type</td>
<td>This is the trunk type (e.g., analog DID, analog loop start, SIP, etc.)</td>
</tr>
<tr>
<td>Site</td>
<td>This is the location of the trunk and can be the Headquarters location or one of the remote locations.</td>
</tr>
<tr>
<td>Switch</td>
<td>This is the IP host name of the ShoreTel voice switch to which the individual trunk is connected.</td>
</tr>
<tr>
<td>Port/Channel</td>
<td>This is the port number or channel to which the individual trunk is connected.</td>
</tr>
<tr>
<td>SIP IP Address</td>
<td>This IP address applies to SIP trunks only and corresponds to the SIP ITSP.</td>
</tr>
</tbody>
</table>
Adding or Editing a Trunk

Whether you want to add trunk or edit an existing trunk, use the Edit Trunk page.

Non-SIP Trunk Parameters

The parameters on the Trunks editing page for non-SIP trunk appear in Figure 53.

The parameters on the Edit Trunk page are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>This is the name of the site at which the trunk and trunk group are located.</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>This is the name of the trunk group to which the trunk group belongs. You cannot change the name of the trunk group on this page.</td>
</tr>
<tr>
<td>Name</td>
<td>This text-entry field lets you enter the name of the individual trunk.</td>
</tr>
<tr>
<td>Switch Channel</td>
<td>This drop-down list lets you select the channel to which this trunk connects.</td>
</tr>
<tr>
<td>Jack #</td>
<td>This is the patch-panel jack number that is associated with the trunk’s switch port. This is an optional parameter.</td>
</tr>
</tbody>
</table>

Figure 53: Trunks Edit Page
SIP Trunk Parameters

This section describes the parameters in the Trunks edit page for SIP trunks (Figure 54).

![Figure 54: SIP Trunks Edit Page](image)

The SIP Trunk parameters are described in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>This is the name of the site at which the trunk and trunk group are located.</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>This is the name of the trunk group to which the trunk group belongs. This field is informational and cannot be changed on this page.</td>
</tr>
<tr>
<td>Name</td>
<td>This text-entry field lets you enter the name of the individual trunk.</td>
</tr>
<tr>
<td>Switch</td>
<td>This drop-down list lets you select the switch to which this trunk connects.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the SIP ITSP Service Provider (or, the IP address of ShoreTel Switch on a second ShoreTel system in case of a SIP Tie Trunk).</td>
</tr>
<tr>
<td>Number of Trunks</td>
<td>Type the maximum number of trunks that this trunk group supports. This parameter is visible only at the time a trunk is first created.</td>
</tr>
</tbody>
</table>
Forwarding Original Caller ID Outside a ShoreTel Network

This section describes the configuration tasks for ensuring that the original caller ID goes out an ISDN trunk when a call to a ShoreTel phone is forwarded outside the ShoreTel deployment. This section applies to a trunk group regardless of the way that carriers and service providers (carriers for short) validate caller ID, but it also describes some of the operational behaviors related to forwarding the original caller ID and the different ways that carriers validate caller ID.

When a ShoreTel switch forwards a call out a trunk, the Q.931 SETUP message contains information about the original caller. However, the carriers are not uniform in the way they validate caller IDs and might not be clear to the ShoreTel customer. ShoreTel's response to these differences are described in this section.

This section focuses on the following areas:

- Enabling the Enable Original Caller Information function.
- After Enable Original Caller Information is enabled on a trunk group, other capabilities are enabled or requirements activated (such as "Send Incoming Caller ID" in an individual user’s configuration).
- Reasons for using the Billing Telephone Number field for a trunk group.

When Carriers Validate the Caller ID

Many carriers validate the caller ID to ensure that the number is within the range of DID numbers that they have on record for the ShoreTel customer. If the number is outside the range, a carrier could reject the call but usually checks the redirecting number field to find a number within the DID range.

If a call enters a ShoreTel network and is then forwarded out an ISDN trunk to a remote device, the number of the forwarded caller can be outside the DID range on record. If the caller ID is outside the DID range, the carrier can check the content of the Redirecting Number Information Element (RNIE) to see if the number that forwarded the call is within the DID range. The redirecting number belongs to ShoreTel user whose phone forwarded (redirected) the original call. Therefore, the contents of the RNIE field can match the carrier’s records. The result is that the call is forwarded, and the far end device can display the ID of the original caller.

Although most carriers that verify the RNIE inevitably send the intended caller ID, some carriers automatically forward the RNIE contents instead of the original caller ID. In this situation, the original caller ID does not reach the outside terminating device.

When a Carrier Does Not Validate the Caller ID

Some carriers and service providers do not validate the caller ID, so they do not determine what to provide at the destination phone. Therefore, a ShoreTel user who is remote and wants to see the original caller ID might not see the caller ID even with the correct configuration on the ShoreTel Voice
Switch. To address this uncertainty, ShoreTel supports an *RNIE ISDN profile* that determines what the carrier should display (even though the provider does not validate the caller ID). For a description of this mechanism, see the ISDN Profile for Redirecting Number Information Element section.

**Purpose of the Billing Telephone Number for Caller ID**

In general, the billing telephone number (BTN) is used by carriers for billing a ShoreTel customer. In contrast, a different role exists for the Billing Telephone Number field in the Trunk Group configuration. This field is not for billing purposes but rather for supporting an alternative to individual user DIDs when an alternate is needed. For example, for a switch to forward the original caller ID, the ShoreTel user who redirects the call outside must have a DID and a Caller ID entry (in the Individual Users edit window) that fit within the trunk group’s DID range. However, for a variety of reasons, a user might not have a DID or a number within the trunk’s DID range. For example, a ShoreTel user at a remote site would have a telephone number that is outside the range at the location of the server. In this case, the contents of the Billing Telephone Number field go in the RNIE space instead of that user’s DID number.

The Enable Original Caller Information check box and the Billing Telephone Number field are in the Trunk Groups page shown in Figure 55. The Billing Telephone Number field becomes active and is auto-filled with the CESID configured on the server when the Enable Original Caller Information check box is marked.
Figure 55: Trunk Groups Editing Window

A Q.931 SETUP message contains information elements for the caller ID and a redirecting number. The carrier normally finds the caller ID to be within the DID range for the trunk. If the caller ID is outside the range, the provider checks the RNIE field to determine whether the number that redirected the call is within the DID range. If the ShoreTel user does not have a DID to serve as the caller ID, the Billing Telephone Number field in the Trunk Groups window can provide the redirecting number. This field can contain one of several types of phone numbers.
The preferable order of values to have in the Billing Telephone Number field is as follows:

1. The first number in the trunk group’s DID range (the default).
2. The actual billing telephone number of the ShoreTel customer (and used by the carrier for billing purposes), typed into the field by the system administrator.
3. The CESID (if the trunk group is configure to support CESID).

The Billing Telephone Number field is activated and populated with the base number of the DID range when the Enable Original Caller Information function is enabled.

Note
In Release 11.1, the Billing Telephone Number field was added to the Trunk Groups editing window. Some customers who upgrade might not know about this field. Regardless, the field is automatically populated with the base number of the DID range when the original caller ID function is enabled.

Important Issue with Early Implementations of Original Caller ID

This section can be skipped for new installations of Release 11.2, 12.1, 12.2, and so on, because the issue does not exist for new installations.

Before the current release, implementation of Original Called Information relied on a custom dial plan. When a ShoreTel deployment with this custom dial plan is upgraded to Release 11.2, 12.1, 12.2, and so on, the ShoreTel TAC must remove such a custom dial plan because it interferes with the current function.

Upgraded customers who know or suspect that such a plan has been used should contact TAC for help. However, some customers might not know that a custom dial plan has been used for original caller ID and should, therefore, monitor the call forwarding and caller ID performance after an upgrade.

If a system with such a dial plan is upgraded, problem behaviors related to call forwarding or original caller ID can show up. Some possible behaviors are:

- Forwarded calls go to the ShoreTel user’s voicemail instead of out the trunk.
- Forwarded calls are rejected by the carrier.

Enabling the Original Caller Information

When the Enable Originating Caller Information box for a trunk group is marked, the function is enabled. To enable the function for forwarding original caller ID:

1. Navigate to Administration–>Trunks–>Trunk Groups.
2. Select an existing trunk group or create a new trunk group.
3. Check the Enable Originating Caller Information check box under the Trunk Services heading (Figure 55 on page 189). After this enable, the Billing Telephone Number text entry box becomes active and shows the base number of the DID range by default (if DID range has been configured).

4. If necessary, type a value in the Billing Telephone Number field.

5. Click **Save** as needed when other trunk group configuration steps are done.

---

### Introduction to ISDN Profiles

ISDN profiles let the system administrator specify functions that extend the normal capabilities of ShoreTel trunks. The additional capabilities are enabled in the ISDN profile by the specification of information elements (IEs). After its creation, the purpose-specific ISDN profile is applied as needed to one or more PRI T1, BRI, or PRI E1 trunk groups. ISDN profiles are advanced tools because their purpose is outside the normal use of a ShoreTel Voice Switch.

In the two-stage implementation process, a function-specific ISDN profile with one or more manually typed parameters first is created and subsequently applied to a trunk group.

Example applications of ISDN profiles are as follows:

- For WANs in which a carrier or service provider does not automatically add the CID name, a caller ID (CID) name can be added to outbound calls. For the detailed description of this function, see **Caller ID Name on T1-PRI Trunks** on page 192.

- In Europe, up to 25 digits for a SETUP can be required for ISDN BRI and PRI. To provide these digits, the ShoreTel switch normally passes 20 digits in the SETUP message but can add 5 digits when necessary. For a description of this capability, see **Specifying a 20-Digit SETUP Message for PRI or BRI** on page 198.

- To meet a requirement of compliance testing in Europe, an outbound call can carry the progress indicator value 8. This ISDN profile for this function should be applied on a trunk only during a period of compliance testing.

- In Europe, an ISDN profile can direct the switch to support ISDN channel negotiation by the central office (only for outbound calls from a ShoreTel switch in the current release). For a description of this capability, see **Euro-ISDN Channel Negotiation** on page 200.

- In Europe, an ISDN profile can be created that allows an outside caller to a ShoreTel user to see a number of the ShoreTel user that answers the call. This feature is supported for carriers or service providers configured with PRI or BRI. For a description of this capability, see **BRI Signaling Parameters** on page 127.
Caller ID Name on T1-PRI Trunks

The function Caller ID Name on T1-PRI lets a ShoreTel Voice Switch add the user name to caller ID (CID) information in an outbound call. The new function is available on T1-PRI trunks but not BRI or E1-PRI trunks.

Before Release 11.2, ShoreTel Voice Switch did not send the user’s name to carriers or service providers. Nevertheless, in the U.S., carriers and service providers could add the caller number and caller name (if the call originates on a ShoreTel Voice Switch).

**Note**

Caller ID Name on T1-PRI is optional because most ShoreTel installations utilize the default state of ShoreTel’s underlying CID mechanism. Therefore, only certain installations need the functionality of Caller ID Name on T1-PRI. ShoreTel created this function specifically for non-U.S. customers whose carrier or service provider needs the support of Caller ID Name on T1-PRI. Whether this function is really needed can be determined through consultation with the carrier or service provider if the actual need is unclear.

Caller ID Name with the Public Network

This section gives an overview of the current handling of Caller ID names in outbound and inbound calls.

**Inbound**

In North America, some carriers can provide a Caller ID (CID) name in addition to the CID number. In the current release, ShoreTel voice switches support CID name on T1 PRI trunks. A carrier or service provider can deliver the CID name by using either a display message or facility message method. The method depends on the protocol used, as follows:

- In a display message over NI-1
- In a facility message over NI-2

For CID name in an inbound call, ShoreTel switches support both methods at the same time, so no special configuration is required on a ShoreTel switch to accommodate the arrival of CID names.

**Outbound**

ShoreTel T1 voice switches can send a CID name in an outbound call by using either a display message or a facility message. However, in contrast to inbound calls with a CID name, all outbound calls are configured to use either the display message or facility message method. The choice of method for outbound calls must be specified in Director. Even as ShoreTel T1 voice switches support only NI-2 protocol, it is possible to create an ISDN profile for using NI-2 protocol and then specify either the display message or facility message method for outbound CID name delivery. The ISDN profile for this purpose is described in the ISDN Profiles section.
The message method must match the method that the carrier or service provider expects. For example, if a carrier uses NI-1, programming NI-2 with the display method might be possible, such that the carrier accepts the outbound caller ID name from ShoreTel.

The steps for selecting the message method and protocol are in the “Implementation” section. The implementation steps are for outbound calls only.

**Caller ID Name on T1-PRI Background Details**

This section contains additional details that readers should understand before going into the Implementation section.

Outside the U.S.—as in Canada, for example—the carrier or service provider might insert the geographic or metropolitan origin of the call as the CID name (“Coquitlam,” for example). However, to send the actual user name of the caller, some carriers or service providers outside the U.S. require the information provided by Caller ID Name on T1-PRI. Therefore, for customers in Canada and elsewhere who want a CID name to accompany the call, this function enables a ShoreTel Voice Switch to provide the CID name information.

**Enabling the Outbound Caller ID**

Some configuration steps for CID are common regardless of the carrier or service provider. These steps are independent of the Caller ID Name on T1-PRI function but are nevertheless included in the implementation steps. An example of such a mandatory step is the enable for sending CID on an outbound call. This enable is called Enable Outbound Calling Name and is located in the editing window for Switches > Primary. This enable is mandatory for sending a name in the CID, but in some countries a carrier or service provider might require the additional configuration that is supplied by an ISDN profile configured specifically for the purpose of facilitating Caller ID Name on T1-PRI.

**ISDN Profiles**

For Caller ID Name on T1-PRI, a critical element is defined in an ISDN profile. Thereafter, the ISDN profile is applied to a trunk group. ISDN profiles are advanced tools that can be used to specify important information for a variety of features. In the case of Caller ID Name on T1-PRI, the ISDN profile specifies the means for sending the user name (if the carrier or service provider requires this support). The ISDN profile that might be needed for sending a user name is described in the implementation steps.

As has been emphasized, the customer must know what the carrier or service provider expects for the ISDN message method. However, even when the expected method is known, an administrator might have to perform a simple experiment to determine which of the two possible categories of each method is required. The following list shows the possible methods related to CID (see implementation steps for actual use):

- CallerIDSendMethod – display
- CallerIDSendMethod – displaypcc
- CallerIDSendMethod – facility
- CallerIDSendMethod – facilitypcc
The choice for using the "pcc" version of a method is not based on information that the carrier provides. For example, if a customer has settled on the display method (CallerIDSendMethod = display) in the ISDN profile and correctly applied the profile to the pertinent trunk group but the CID name is not received at the far end, then an alternative ISDN profile (with CallerIDSendMethod = displaypcc) must be applied to the trunk group. (After an ISDN profile is created, it must also be applied to the appropriate trunk groups, as described in the Implementing Caller ID Name on T1-PRI on page 194.)

**Character Limit and Name Masking**

The maximum number of characters that a CID name can support is 34. Although ShoreTel supports up to 34 characters, a carrier or service provider might truncate the CID name. It might, for example, pass only 16 or even 12 characters. This possibility is one of the reasons that customers must know the support provided across the cloud and consult as needed with the carrier or service provider.

**Note**
For reasons of privacy, the actual name can be masked by insertion of a generic label, as described in the Implementation section.

**Implementing Caller ID Name on T1-PRI**

In the configuration descriptions that follow, the first (and mandatory) step for enabling CID name is described. Actually, this step is necessary to enable CID name transmission from any ShoreTel environment. Subsequent sections describe how to specify and apply the ISDN profile with the display method in an environment that requires it for Caller ID Name on T1-PRI.

**Note**
Before enabling the Caller ID Name on T1-PRI function, the administrator should have prior knowledge or else consult the customer's carrier or service provider to determine how it delivers the CID name end-to-end and, therefore, whether the display method is required. (See also Creating and Applying an ISDN Profile for CID Name.) Furthermore, although the ShoreTel Voice Switch sends the caller ID name when configured to do so, ShoreTel cannot guarantee the results at the far end. ShoreTel cannot guarantee that carriers or service providers deliver caller ID names at the far end or that they support overwriting of the user name with a user-specified word (described in the configuration steps). Also, in some cases, parameters on 3rd-party gateways might require modification before the caller ID name can be delivered.

**Enabling Outbound Calling Name**

The first step for enabling the CID name is to enable the trunk for outbound calling name regardless of whether the network calls for an ISDN profile to activate Caller ID Name on T1-PRI:

1. Navigate to Administration → Switches → Primary.
   
   The list of primary switches appears. Note the list of switches in the Name column.

2. Click the name of a T1 ShoreTel Voice Switch with the PRI trunk that is to send the CID name.
The Edit ShoreGear 220T1 Switch window appears (Figure 56). The switch in this example is Canada PRI T1 - B.

3. Select ISDN User in the Protocol Type drop-down list.
4. Select NI-2 in the Central Office Type drop-down list.
5. Mark the Enable Outbound Calling Name checkbox. This checkbox is just above the area labeled Layer 1.

**Creating and Applying an ISDN Profile for CID Name**

This section defines the ISDN profile for Caller ID Name on T1-PRI and describes how to apply the ISDN profile to a T1-PRI trunk.

**Overview**

In most deployments, the default ISDN system profile is already part of the configuration, and the default ISDN system profile has already been associated with the trunk group. If a new ISDN profile is required, the following tasks are involved and are described in their own subsection:

- Creating an ISDN profile for Caller ID Name on T1-PRI
- Associating the ISDN profile with a trunk group
The ISDN profile for Caller ID Name on T1-PRI specifies a method for delivering a CID name to the carrier or service provider. In all deployments, the default facility method is enabled, but for some WANs, the display, displaypcc, or facilitypcc method is required. To use one of these latter message methods, a new ISDN profile must be created.

**Specifying the Display Method in the ISDN Profile**

To meet the interoperability requirements for CID name as needed in some environments, the system administrator creates an ISDN profile that specifies one of two display methods for sending CID names. (If the need for the display method is not a certainty, readers should refer to ISDN Profiles and other conceptual descriptions of the CID Name on T1-PRI function in this section.)

The name for a new ISDN profile must differ from the default profile name SystemISDNTrunk. (Figure 57 shows the default ISDN system profile.)

The system administrator subsequently associates the new profile with a trunk group in the Edit PRI Trunk Group window, as described in the section Enabling Caller ID Name and the ISDN Profile on a Trunk Group.

**Specifying an ISDN Profile for the Display Method**

Specifying a new ISDN profile for CID name:

1. Log into ShoreTel Director.

2. Click **Administration > Trunks > ISDN Profiles** to open the ISDN Profiles page shown in Figure 57.

![ISDN Profiles Window in Director](image)

   **Figure 57: ISDN Profiles Window in Director**

3. Click **New** to open Edit ISDN Trunk Profile, as shown in Figure 58.
4. In the Name field, type the name to use for this ISDN profile. You cannot use the name “SystemISDNTrunk.”

5. Check the Enable checkbox.

6. In the Custom Parameters area, type the following:

   **CallerIDSendMethod** – display (or displaypcc, as needed)

7. Click **Save**.

   The next task is to associate the ISDN profile with one or more T1-PRI trunks.

### Enabling Caller ID Name and the ISDN Profile on a Trunk Group

If an ISDN profile with the facilitypcc, display, or displaypcc method exists, the system administrator associates it with a correct T1-PRI trunk, as described in this section. Not shown here is how the system administrator configures the PRI trunk group in a manner that is similar to other PRI trunk groups (but in this case, an ISDN profile is associated with the trunk).

At the bottom of the Edit PRI Trunk Group window, the administrator enables (or disables) the caller ID function by checking (or unchecking) the Enable Caller ID box.

Many companies might choose to hide the personal name of the caller and instead insert the company name. As the following steps show, a text box associated with CID name lets the system administrator specify a label to overwrite all outbound CID names (and thus mask the call initiator’s name). The behavior is as follows:

- If the administrator checks the Enable Caller ID box and leaves the ‘When Site Name is used for the Caller ID, overwrite it with’ field empty, the caller’s name goes to the carrier or service provider.
### Configuring a PRI trunk group to present the CID to the service provider:

1. Log onto ShoreTel Director.
2. Click **Administration > Trunk Groups**.
   - The Trunk Groups page appears.
3. Select a PRI trunk group by clicking on the trunk group name.
   - The Edit PRI Trunk Group page appears.
4. Select the appropriate ISDN Profile by using the Profile pull-down menu.
5. At the bottom of the Outbound section of the Edit PRI Trunk Group, select the **Enable Caller ID** check box.
6. (Optional) As needed, type a label for overwriting all individual caller names with this label in the CID display at the far end.
7. Click the **Save** button at the top of the Edit PRI Trunk Group window.

### Specifying a 20-Digit SETUP Message for PRI or BRI

In Europe, a SETUP message with up to 25 digits can be required for ISDN BRI and PRI trunks. To provide 25 digits when necessary, a ShoreTel Voice Switch adds 5 digits to the 20 digits it normally sends in the U.S.

After the terminal equipment (TE) initially receives the SETUP ACK message from the network terminal (NT), the ShoreTel TE can send five digits to the network terminal in the subsequent INFO message if the situation requires those digits.

For the implementation of this messaging, the ShoreTel switch indicates when the extra 5 digits are not needed (thus, a 25-digit SETUP message is the default). As the configuration steps illustrate, a message named Sending Complete indicates that the additional 5 digits are not needed. Note that, by itself, the Sending Complete message does not directly pertain to the European requirement for 25-digits in a SETUP message. It just says that, for no specific reason, more digits are not required. This message is delivered in 1 of 2 ways:

- The Setup Complete message can go out after the SETUP ACK message arrives. This behavior is the default and does not involve an ISDN profile at all.
- The administrator can specify that Sending Complete goes inside the SETUP message.

Creating an ISDN profile in Director that specifies the Sending Complete transmission:

1. Click **Administration > Trunks > ISDN Profiles** in Director. As Figure 59 shows, the ISDN Profiles window lists all existing ISDN profiles by name, the enable status of each profile, and a check box for selecting a profile.
2. Click the **New** button to start a new profile. The Edit ISDN Trunk Profile window opens, as shown in Figure 60.

3. In the Name field, type a name for the profile.

   **Note**
   The name of the default profile SystemISDNTrunk is reserved and cannot be used for new profiles. Put another way, the default ISDN profile cannot be modified.

4. In the Custom Parameters area, type one of the following two strings:
   - OVLSendCmpWithSetup – yes
   - OVLSendCmpWithSetup – no
where **yes** means the Sending Complete message is carried in the SETUP message, and **no** means the Sending Complete message is transmitted by the ShoreTel Voice Switch after the switch receives the Setup Acknowledge message.

5. Put a mark in the Enable checkbox to enable this profile.

6. Click **Save**.

When ready to apply the ISDN profile to a trunk group, select the profile in the drop-down scroll list in the Trunk Group editing window for the targeted trunk group. After you click the Save button (after completing any other configuration steps), the ISDN profile applies to the trunk group.

---

### Euro-ISDN Channel Negotiation

A ShoreTel Voice Switch can be configured in Director to allow a central office (CO) to negotiate the choice of an outbound ISDN channel on a PRI or BRI.

This feature is supported for Euro ISDN for PRI and BRI.

**Note**

This feature does not apply to inbound calls. Also, this feature is not supported for North America ISDN protocols (for example, NI2, DMS, and ESS).

---

### ISDN Channel Negotiation

A ShoreTel system selects the outbound ISDN bearer channel and does not negotiate with the central office (CO) for the choice of channel. This behavior is called exclusive mode.

In Europe (or in any ETSI-compliant network), an ISDN profile can be configured in Director to enable the ShoreTel Voice Switch to allow the CO to negotiate the channel.

The behavior that supports negotiation is called preferred mode. Although this function is available to BRI, it is more relevant to PRI.

The following trunk and switch settings are available in Director after an ISDN profile is created:

- The ISDN profile is selected in the drop-down scroll list near the top of the Trunk Groups editing window. When this choice and other configuration steps are saved, the ISDN profile is applied to the trunk group.

- In the Voice Switch window (**Administration > Platform Hardware > Voice Switches**), the Layer 3 area has two critical parameters for ISDN channel negotiation: the Central Office Type must be Euro ISDN, and the Protocol Type must be ISDN User.

---

### ISDN Profile to Enable ISDN Channel Negotiation

For backwards compatibility, the default for channel negotiation remains exclusive mode. Therefore, ISDN channel negotiation must be enabled through an ISDN profile that enables the preferred mode.
To enable ISDN channel negotiation, create an ISDN profile in Director as follows:

1. Navigate to **Administration > Trunks > ISDN Profiles** (Figure 61).

   The ISDN Profiles window lists all existing ISDN profiles by name, the enable status of each profile, and a check box for selecting a profile.

   ![Figure 61: List of Existing ISDN Profile](image)

   **Note**
   The name of the default profile SystemISDNTrunk is reserved and cannot be used for new profiles. (In other words, the default ISDN profile cannot be modified.)

2. Click **New** to start a new profile.

   The Edit ISDN Trunk Profile window appears (Figure 62).

3. In the Name field, type a name for the profile (ISDNCustomizedProfile, for example).

4. In the Custom Parameters area, type the following string:

   ```plaintext
   ChannelPreferredMode=yes
   ```

   **Note**
   Custom Parameters are case sensitive.

5. Click the Enable check box. (The profile still must be applied to specific trunk groups.)

6. Click **Save**.

7. Complete the related configuration steps in the Trunk Editing and Switch Editing windows.
For the switch parameters that apply to ISDN channel negotiation, perform the following steps in Director:

1. Navigate to Administration > Platform Hardware > Voice Switches/Server Appliances > Primary (or Spare).

2. Select an existing switch or start a new switch.

3. For configuration of this function, select ISDN User in the Protocol Type drop-down menu (under the "Layer 3" heading located mid-screen).

4. For configuration of this function, select Euro-ISDN in the Central Office Type drop-down menu (under the "Layer 3" heading located mid-screen).

5. Click Save when all other necessary switch parameters are selected.
Euro-ISDN Profile for Connected Number Display

An ISDN profile can be created in Director that allows an outside caller to a ShoreTel user to see a number of the ShoreTel user that answers the call.

This feature is supported for carriers or service providers configured with Euro-ISDN PRI or BRI.

**Note**

This feature is not supported for ShoreTel deployments for North America Protocol (for example, NI2, DMS, and ESS). Also, this feature is not supported for ISO QSIG or ECMA QSIG.

Connected Number Display for Outside Callers

When an outside caller calls a ShoreTel user and the ShoreTel user answers the call, the phone number of the ShoreTel user is sent back to the outside caller through the ISDN Connect message. The phone number of the ShoreTel user can be the user's DID or BTN of the trunk group.

The following trunk and switch settings are available in Director after an ISDN profile is created:

- To apply the ISDN profile to a trunk group, select the profile in the drop-down scroll list near the top of the Trunk Groups editing window. After the trunk group configuration is saved, the ISDN profile is applied to the trunk group.

- The billing telephone number (BTN) should be specified (in addition to the ISDN profile) for the trunk group for the following reasons: If the final recipient’s ShoreTel extension lacks a DID or has a privacy configuration, the switch sends the BTN to the outside caller.

- In the voice switch window (Administration > Platform Hardware > Voice Switches), the Layer 3 parameters include two critical parameters for this function: the Central Office Type must be set to Euro ISDN, and the Protocol Type must be set to ISDN User.

Creating ISDN Profile for Called Number Display

An ISDN profile for controlling the display of the ShoreTel user’s number on the caller’s phone can have one of three possible keyword settings and results, as follows:

- useBTN - The ShoreTel Voice Switch sends only the BTN in the Trunk Group in the CONNECT message to the service providers or carrier. The caller can see the Connect Number Display.

- present - The outside caller can see the number of the ShoreTel user answering the call. The number of the user can be DID or the BTN in the Trunk Group.

- restrict (default) - Neither the BTN nor the DID of the called ShoreTel user goes into the CONNECT message back to the central office. The caller sees no ID for the ShoreTel user.

To create an ISDN profile in Director that allows a caller to see the ShoreTel user’s DID (keyword – present), perform the following steps:

1. Navigate to Administration > Trunks > ISDN Profiles (Figure 63).
The ISDN Profiles window lists all existing ISDN profiles by name, the enable status of each profile, and a checkbox for selecting a profile.

2. Press the New button to start a new profile.

The Edit ISDN Trunk Profile window is opened (Figure 64).

3. In the Name field, type a name for the profile (CalledDIDdisplay, for example).

4. In the Custom Parameters area, type the following string:

   ConnectedLine – present

5. Click the Enable checkbox. (The profile still must be applied to specific trunk groups.)

6. Click the Save button.

7. Now, complete the related configuration steps in the Trunk Editing and Switch Editing windows.

---

**Note**
The name of the default profile SystemISDNTrunk is reserved and cannot be used for new profiles. (In other words, the default ISDN profile cannot be modified.)

**Note**
The Custom Parameters are case sensitive.

---

**Figure 63: List of Existing ISDN Profile**
This section defines the ISDN profile for the Redirecting Number Information Element (RNIE) and describes how to apply it to a trunk group. This profile's purpose is to ensure delivery of an original caller ID to a remote device when the carrier or service provider does not validate the caller ID fields and, therefore, has no strategy for delivering the caller ID. Specifying RNIE ISDN profiles is an advanced task for a network scenario where the default state of the trunk group is not appropriate after original caller ID is enabled (as described in Forwarding Original Caller ID Outside a ShoreTel Network on page 187).

Note
No consultation with the carrier is necessary for the use of an RNIE ISDN profile even though, in general, knowledge of how the carrier or service provider communicates at the trunk level is helpful.
Number Sequence in the Q.931 SETUP Message

The RNIE ISDN profile determines which of two possible sequences the ShoreTel Voice Switch places the caller ID and the RNIE in the outbound Q.931 SETUP message. The two sequences are simply the reverse of each other. The correct sequence depends on how the carrier processes the SETUP message. Rather than depending on operational information from the provider, the customer decides on which ISDN profile to use based on whether the original caller IDs are reaching the far-end destination after a call-forwarding feature sends the calls out an ISDN trunk.

After trying both sequences in the ISDN profiles, if the original caller ID does not reach the far-end device, the customer should ensure that the other configuration requirements of caller ID are correct. As described later in this section, even if the ShoreTel Voice Switch is correctly performing its task of forwarding the original caller ID outside the local network, conditions in the WAN might obstruct the successful arrival of caller ID at the destination.

The outbound Q.931 SETUP message has two caller ID fields, as follows:

- One number is the caller ID. This number is either of the following:
  - The ShoreTel user’s DID or the contents of the Billing Telephone Number field when the user has dialed out
  - The number of the outside caller who called the ShoreTel user and whose call was subsequently forwarded out the trunk

- The other number is the redirecting number—the ShoreTel number that forwarded the original call if call-forwarding was performed. (If the call is not forwarded, there is no redirecting information.) The redirecting number can be one of the following:
  - The DID of the ShoreTel user who forwarded the call (if the user has a DID).
  - When necessary, the contents of the Billing Telephone Number: this redirecting number can be the base number in a trunk’s DID range, the ShoreTel customer’s BTN, or the CESID. These alternatives to the DID are described in Purpose of the Billing Telephone Number for Caller ID on page 188.

---

**Note**

- If a carrier forwards an original caller ID to yet another provider, such as a CLEC, the subsequent provider might reject the call. This call rejection could be due to the subsequent provider utilizing the caller ID and RNIE in the opposite sequence of the first provider to transport the call. In this case, when the customer has determined that forwarded calls are being rejected at the far end and has consulted with ShoreTel TAC, an ISDN profile cannot help. The way to re-establish delivery of the forwarded calls through the CLEC—but without original caller ID—is to disable the Enable Original Caller Information until carriers and service providers find a way to interoperate in a way that ensures delivery of caller ID.

- Different carriers or carrier regions can use different call parameters. Therefore, we recommend that a unique ISDN profile be created for each trunk group.
Creating an RNIE ISDN Profile

An RNIE ISDN profile can have one of two lines that specify its effect. The line must be typed according to the following syntax:

- **SEND_BTN_AS_RNIE** – <yes|no>

  Default: **SEND_BTN_AS_RNIE** – no

The meaning of the Yes/No selection is as follows:

- **SEND_BTN_AS_RNIE** – no: The calling party number is presented with Billing Telephone Number (BTN). The *caller ID* is sent as the redirecting number (if “Enable Original Caller Information” is checked).

- **SEND_BTN_AS_RNIE** – yes: The calling party number is presented with the caller ID. The contents of the Billing Telephone Number field is sent as the redirecting number (if “Enable Original Caller Information” is checked).

Creating an RNIE ISDN profile:

1. Click **Administration >Trunks > ISDN Profiles** (or SIP Profiles for the same functionality on SIP trunks).

2. Click **New** at the top of the window (or the name of an existing profile as needed). See Figure 65.

3. Type a name for a new RNIE ISDN profile, such as RNIE2. The name of the default profile (SystemISDNTrunk) cannot be used.

5. Do one of the following:

- To specify that the switch presents the contents of the Billing Telephone Number field from the trunk group’s configuration, type the following string in the Custom Parameters field:
  - SEND_BTN_AS_RNIE – no

- To specify that the switch presents the caller ID, type the following string in the Custom Parameters field:
  - SEND_BTN_AS_RNIE – yes

---

Note

This setting is also the default state of the trunk group.

6. Click **Save** when each profile is done.

When the time comes to apply the profile to a trunk group, select the profile’s name in the Trunk Groups editing window (near the top of the window) for the selected trunk group.
CHAPTER 8

Configuring IP Phones

This chapter discusses how to configure IP phones. It contains the following information:

Overview ........................................................................................................................................ 211
Prerequisites ................................................................................................................................ 211
IP Phone Configuration Overview ................................................................................................. 211
Configuring System Settings for IP Phones .................................................................................. 211
Call Continuation During Failover.................................................................................................... 214
Adding IP Phones to the System ....................................................................................................... 215
Adding IP Phone Users ................................................................................................................... 216
Adding Anonymous Phones ............................................................................................................ 217
Viewing and Editing IP Phones on the System .............................................................................. 218
Viewing IP Phones .......................................................................................................................... 218
Renaming an IP Phone ..................................................................................................................... 219
Deleting an IP Phone from ShoreTel Director .................................................................................. 220
Moving an IP Phone to a Different Voice Switch ............................................................................. 220
IP Phone State Display .................................................................................................................... 221
Displaying ShoreTel IP Phone Settings ............................................................................................ 222
Resetting a ShoreTel IP Phone ........................................................................................................ 223
Customizing Ringtones ................................................................................................................... 223
Loading Custom Ringtones Through ShoreTel Director ............................................................... 224
Loading Custom Ringtones Through a Custom Configuration File ............................................... 225
Customizing Wallpaper on Color Phone Displays ........................................................................... 227
For ShoreTel IP485g and IP655 Phones ........................................................................................... 227
For ShoreTel IP265 and IP565g Phones ............................................................................................ 230
Automatic Off-Hook and Headset Preferences ............................................................................... 233
Specifying Automatic Off-Hook for Wireless Headsets ........................................... 233
Configuring Programmable IP Phone Buttons ......................................................... 234
  Configuring Programmable Buttons through ShoreTel Director ......................... 237
  Copying Programmable Button Configurations ............................................... 237
Enabling a User to Program Buttons on a ShoreTel IP Phone ............................ 238
Customizing Buttons on a Phone or BB24 via the Telephone Interface .......... 239
Configuring a Hotline Button .................................................................................. 239
Implementing Malicious Call Trace ...................................................................... 240
  Configuring a Programmable Button for MCT ............................................... 240
  Initiating a Malicious Call Trace ................................................................. 241
  Considerations for Using Malicious Call Trace ............................................. 242
Configuring VPN Phones ....................................................................................... 243
  Description ...................................................................................................... 243
  Implementation .............................................................................................. 245
Configuring Simultaneous Ringing and Call Move ................................................ 248
  Implementing Simultaneous Ringing .............................................................. 249
  Disabling/Enabling Additional Phones ............................................................. 250
  Implementing Call Move ............................................................................... 250
Overview

ShoreTel supports IP phones connected through ShoreTel voice switches. After installing the phones, configuring IP phones is a straightforward process that involves defining settings in ShoreTel Director.

Prerequisites

Before configuring IP phones through ShoreTel Director, be sure that you’ve addressed the following prerequisites which involve setting up your network and installing the phones:

- Add and configure ShoreTel voice switches to support IP phones. For information on allocating switch ports for IP phone support, see Chapter 5, Configuring Voice Switches.
- Set IP address ranges. For more information, see the ShoreTel Planning and Installation Guide.
- If you are using static IP addresses, set the boot parameters in the individual IP phones. For more information, see the ShoreTel Planning and Installation Guide.

When you have completed the installation process, connect the ShoreTel IP phones to the network. Phones connected to the network register themselves with the ShoreTel system.

IP Phone Configuration Overview

Configuring ShoreTel IP phones involves the following steps, many of which are optional:

- Configure system settings
- Add IP phones to the system
- View and edit IP phones
- Customize ringtones
- Customize wallpaper
- Specify custom applications for user groups
- Specify automatic off-hook for wireless headsets
- Configure programmable IP phone buttons
- Configure VPN phones
- Configure simultaneous ring and call move

Configuring System Settings for IP Phones

In addition to configuring the IP address range for phones, which you did as part of the installation process, you need to set IP phone options.

1. Launch ShoreTel Director.
2. Click Administration > IP Phones > Options.
The IP Phone Options Edit page is displayed.

3. Enter values or accept the defaults for the parameters, which are described in Table 31.

**Note**

The “Server to Manage Switch” option is disabled for IP Phone Configuration Switches.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| IP Phone Configuration Switch 1 | The switch designated to handle initial service requests from IP phones in the ShoreTel system. The switch communicates with the ShoreTel server to determine which switch manages calls for a particular IP phone. The IP addresses of these switches are downloaded to the IP phones whenever the IP phones are booted.  
If you do not assign a switch, the ShoreTel system automatically assigns the first two ShoreTel voice switches added to the system that are managed by the Headquarters server.  
This setting does not apply to ShoreTel 400-Series IP phones, as they automatically receive the IP addresses of all switches in the system that support IP phones. The phones use any one of the switches in this list for initial contact before they are assigned to a particular switch. |
| IP Phone Configuration Switch 2 | An optional second configuration switch designated to handle initial service requests from IP phones in case the first configuration switch fails.  
This setting does not apply to ShoreTel 400-Series IP phones, as they automatically receive the IP addresses of all switches in the system that support IP phones. |
| User Group for Unassigned Phones | Unassigned IP phones are available for users configured for Any IP Phone. From the drop-down list, select the user group that has the call permissions you want unassigned IP phones to have. |
| IP Phone Announcement | A message that appears on all supported IP phones in the system. The text can be up to 19 characters long.  
For ShoreTel 200-, 500-, and 600-Series IP phones, the message appears left-justified on the phone. To center the message, insert leading spaces in the text.  
For ShoreTel IP480, IP480g, and IP485g phones, the message is centered. The message does not appear on the IP420 phone. |
| IP Phone Password | This field sets the administrative password for IP phones in the ShoreTel system. It is used only with ShoreTel IP phones that require a password. The default is “1234”. It can be 1–8 digits long. |
Enable IP Phone Failover

For all ShoreTel 100-, 200-, 500-, and 600-Series IP phones, when this check box is selected IP phones send a keep-alive message to their call manager voice switch every four minutes. If a response is not received, the IP phone attempts to contact an alternate switch. Changing the state of this field requires these phones to be rebooted, which can take several minutes. Phones could drop calls because of the reboot process.

For ShoreTel 400-Series IP phones, when this check box is selected failover is enforced by the Headquarters server and the switch rather than through keep-alive messages from the phones. These phones do not require a reboot when you change the state of this field.

For more information, see Call Continuation During Failover on page 214.

Delay After Collecting Digits

The timeout period, in milliseconds, for operations that involve transferring calls. This setting applies to all users and can be set only once for the entire system. You cannot configure different timeout periods for different features or for different users, and users cannot configure the timeout period through ShoreTel Communicator or the IP phone interface.

This delay behavior applies to the following features: blind transfer operations related to conference calls, dialing from the Directory, intercom, on-hook dialing, park, pickup, redial, transfer, and unpark. For ShoreTel 400-Series phones, there is no delay for on-hook dialing or dialing from the Directory or History.

Users aren’t required to press a soft key to initiate these operations. Instead, the operations occur automatically at the expiration of this timeout period. After all of the necessary digits (which could vary based on the site’s dialing plan) have been entered, digit collection stops and the timeout period begins counting down. At the end of the countdown, which can be as short as one second, the call is transferred. The default is 3 seconds.
Call Continuation During Failover

ShoreTel provides the **Enable IP Phone Failover** option to enable a phone to move from a failed switch to another switch automatically rather than waiting for the current switch to come back up or for the administrator to manually move the phone to another switch. This feature is applicable to ShoreTel IP phones, third-party SIP extensions, and service appliances. SoftPhone does not support continuation of calls through failover.

The **Enable IP Phone Failover** option is enabled on the IP Phones Options edit page, as described in Configuring System Settings for IP Phones on page 211.

When the **Enable IP Phone Failover** option is enabled and the voice switch handling a call becomes unavailable during a call, the phone goes through two failover stages:

- **Pending Failover** is the period between when the phone does not receive the expected acknowledgement signal from its voice switch until the time that an alternate switch is assigned to perform call management tasks for the phone. This period typically lasts 2 to 4 minutes after the switch becomes unavailable.

- **Failover** is the period after the alternate switch is assigned to perform call management tasks for the phone.

**Behavior of ShoreTel 400-Series IP Phones During Failover**

For ShoreTel 400-Series IP phones, switch failover is relatively transparent to phone users, regardless of whether the **Enable IP Phone Failover** option is selected. If a switch fails, any active calls remain active, and the phone automatically hunts for a new switch to bind to. If the user tries to make a call during Pending Failover stage, the phone hunts for a new switch to use for the outbound call. A “No Service” message is displayed on the phone only if the phone is unable to bind successfully with a different voice switch.

The amount of time it takes for failover to occur depends on whether the phone is idle when the switch failure occurs:

- If the phone is idle, the failover happens approximately 4 minutes after the switch failure is detected.

- If the user tries to make a call during the switch failure, the failover is initiated 5 seconds from the time the call is dialed so that the call can be completed.

**Behavior of ShoreTel 100-, 200-, 500-, and 600-Series IP Phones During Failover**

When a phone enters the Pending Failover stage, calls in progress remain active. Call control options, including soft key operation, are unavailable during this time. Users cannot initiate new calls, and the phone display remains frozen during pending failover.

When **Enable IP Phone Failover** is not enabled, all active calls remain active when the phone enters the Failover stage, but the phone does not move to another voice switch. When a phone is in this state, the user cannot make new outgoing calls or receive new incoming calls until the voice switch is again operational or the administrator moves the phone to another voice switch.
When *Enable IP Phone Failover* is enabled, active calls are maintained through the beginning of the failover stage until the normal completion of the call. All pending failover restrictions remain in place after the phone enters the Failover stage until calls maintained through Failover initiation are completed.

**ShoreTel IP Phones – Local Endpoint**

A local endpoint is the source (calling) IP phone that is controlled by the failed switch during a failover. During the Pending Failover stage, the telephone user interface displays a “No Service” message until the phone is assigned to a new switch. Call control operations are not available on surviving calls. All inbound calls to the local endpoint are routed to the destination specified by the current Call Handling Mode.

During the Failover stage, the telephone user interface displays “Failover Mode” while surviving calls remain active. Pressing phone keys generates a “No Service” message on the phone interface. Call control operations on surviving calls remain unavailable. All inbound calls to the local endpoint are routed to the destination specified by the current Call Handling Mode. After the surviving call is concluded, the ShoreTel IP phone returns to normal operation.

**ShoreTel IP Phone – Remote Endpoint**

A remote endpoint is the target (called) endpoint that the functioning switch controls during failover. During failover, remote endpoint ShoreTel IP phones can hang up the call, place the call on hold, or retrieve the call from hold. All other soft key operations are unavailable for the duration of the call. The ShoreTel IP phone continues displaying call information until the end of the call. Call control operations on other calls remain available.

**Behavior of Third-party SIP Phones During Failover**

This feature causes no changes to messages displayed by SIP devices. Failover procedures and restrictions are applicable to third-party SIP phones. Call control operations initiated from third-party SIP phones on failover calls are not available.

**Behavior of Trunks During Failover**

ShoreTel releases the trunk only after the remote side goes on hook. System cleanup procedures, executed every two hours, release trunks that were left hanging.

**Adding IP Phones to the System**

After you add IP phones to your ShoreTel system they are in the Available state. You can then configure them for specific users or as anonymous phones.
Adding IP Phone Users

You can add IP phone users to the system using one or both of the following methods:

- Use the Any IP Phone method to add users by allowing users to assign their own phone from their desktop and voice mail. This method simplifies the setup of multiple new users.
- Assign a specific IP phone to a user.

Using the Any IP Phone Method to Add Phones for Multiple Users

This procedure describes how to configure a user to use any IP phone. For information about creating users, see Chapter 10, Configuring Users.

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
   The Individual Users page appears.
3. Add a new user or select an existing user as follows:
   - To add a new user, in the Add new user at site field select the site for the new user and click Go.
   - To select an existing user, click the user’s name.
     The Edit User page appears.
4. Scroll to the Primary Phone Port parameter, and do the following:
   - Click the IP Phones radio button.
   - In the drop-down list, select Any IP Phone.
   - Click Save.
5. In the User Group field, select a user group from the drop-down list.

Note
Select a user group with a Class of Service telephony profile that allows extension reassignment. For more information about extension reassignment, see Telephony Features Permissions on page 338.

6. Click Save.
7. To use this profile to create another user, click Copy and repeat steps 4 through 6.
8. Instruct users to assign their extension to their phone by logging in to the voicemail system or using the phone interface.
Adding Anonymous Phones Configuring IP Phones

Assigning an IP Phone to a Specific User

You can assign IP phones through the Edit User page, one user at a time.

1. Launch ShoreTel Director.
2. Click Users > Individual Users in the navigation frame.
3. Add a new user or select an existing user as follows:
   - To add a new user in the Add new user at site field, select the site for the new user and click Go.
   - To select an existing user, click the user’s name.
     The Edit User page appears.
4. In the Primary Phone Port section, click IP Phones; in the drop-down list, select the specific IP phone’s MAC address.
5. Complete the user profile. (For information about user settings, see Configuring Users on page 335.)
6. Click Save.

Adding Anonymous Phones

Anonymous phones provide flexibility within the ShoreTel system by making additional ports or IP phones available without assigning them to any particular user extension. When configured as anonymous telephones, these ports and IP phones cannot receive calls but do have access to dial tone. If they have the proper Class of Service (COS) permissions, users can assign their extensions to these phones through the voicemail system or the telephone user interface. When a user assigns a port or IP phone to an extension, it receives calls until the user unassigns it. For more information on how to use the Extension Assignment feature, see Using Extension Assignment on page 446.

The Anonymous Telephones page lets you configure anonymous telephone ports and IP phones. The Anonymous Telephones page first lists any Vacated Telephones. A vacated telephone is a telephone that is configured as the home port or IP phone of a user on the system, but that user is currently assigned to another telephone and no other user is assigned to the vacated home phone.

1. Launch ShoreTel Director.
2. Click Administration > Users > Anonymous Telephones.
3. Do one of the following:
   - To add a new anonymous telephone port, click Add This Record.
   - To delete an anonymous telephone port from the ShoreTel system, click Delete next to a record. This also disconnects any calls that are in progress on the port.
4. Make any other changes, as necessary. See Table 32 for details.
5. Click Save.
To allow you to manage IP phones, ShoreTel Director includes pages for viewing and editing IP phones on the system:

- You can view and edit IP phones on the IP Phones page. For more information, see Viewing IP Phones.
- You can view the status of IP phones through the Diagnostics & Monitoring system. For more information, see Monitoring IP Phone Status on page 712.

IP phones are assigned to the Headquarters site if they are not assigned to another site through IP address mapping, but you can move IP phones to a different site. When you assign a specific IP phone to a user, the user belongs to the site where the IP phone is located.

For details about editing user information, see Chapter 10, Configuring Users.

### Viewing and Editing IP Phones on the System

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned User Group</td>
<td>The user group that all Anonymous phones are assigned to.</td>
</tr>
<tr>
<td>Jack #</td>
<td>The name of the telephone jack associated with the vacated port. This is typically the physical telephone jack that the telephone plugs into.</td>
</tr>
<tr>
<td>Switch</td>
<td>The switch that the vacated telephone port is associated with.</td>
</tr>
<tr>
<td>Port</td>
<td>The physical switch port number or IP phone MAC address that identifies the vacated telephone.</td>
</tr>
<tr>
<td>Current User</td>
<td>The name of the user who is currently using the anonymous telephone port or IP phone.</td>
</tr>
<tr>
<td>Current Ext</td>
<td>The extension of the user who is currently using the anonymous telephone port or IP phone.</td>
</tr>
</tbody>
</table>

### Viewing IP Phones

1. Launch ShoreTel Director.

2. Navigate to Administration > IP Phones > Individual IP Phones.

   The IP Phones page, which shows all phones in the system, is displayed.
3. If you want to filter the list of phones, do the following:
   
   a. In the **By Sites** field, in the drop-down list select the site where the phones you want to view reside.
   
   b. In the **By Switches** field, in the drop-down list select the switch to which the phones you want to view are assigned.
   
   c. Click **Find Now**.

   The IP phones for the selected site and switch are displayed.

---

**Note**

ShoreTel Technical Support does not perform troubleshooting on any model of IP phone (such as ShoreTel IP Phone 210) that has a designation of “Unsupported.” The designation appears in the “Phone Type” column on the far right side of the IP Phones page.

---

### Renaming an IP Phone

You can change the name of an IP phone from the IP Phones page. By default, IP phones are listed by MAC address in the Name column of the IP Phone List section of the IP Phones page.

1. Launch ShoreTel Director.

2. Click **Administration > IP Phones > Individual IP Phones**.

3. If you want to filter the list of phones, do the following:

   a. In the **By Sites** field, in the drop-down list select the site where the phone you want to rename resides.

   b. In the **By Switches** field, in the drop-down list select the switch to which the phone you want to rename is assigned.

   c. Click **Find Now**.

   The IP phones for the selected site and switch are displayed.

4. In the Name column, click the phone to rename.

   The Edit IP Phone dialog box opens.

5. In the **Name** field, type a new name for the phone.

6. Click **Save**.
Deleting an IP Phone from ShoreTel Director

Tip
If you use MUTE 25327# (CLEAR) to clear a phone’s configuration, the phone is automatically deleted from ShoreTel Director.

1. Launch ShoreTel Director.

2. Click **Administration > IP Phones > Individual IP Phones**.

3. If you want to filter the list of phones, do the following:
   a. In the **By Sites** field, in the drop-down list select the site where the phone you want to delete resides.
   b. In the **By Switches** field, in the drop-down list select the switch to which the phone you want to delete is assigned.
   c. Click **Find Now**.

   The IP phones for the selected site and switch are displayed.

4. Select the check box of the IP phone that you want to delete.

   WARNING!
   Make sure that you have the selected the correct phone and that no other phones are selected.

5. Click **Delete**.

   A dialog box requests confirmation.

6. Click **Yes** to delete the phone.

7. If you wish to add the IP phone back into the system, you must reboot the IP phone. It will be reconfigured during the boot process and become available again. (A ShoreTel 400-Series IP phone automatically re-registers with the system and displays the Available state, without rebooting.)

Moving an IP Phone to a Different Voice Switch

To move an IP phone to a destination switch at a remote site, the remote site must have an IP address range defined. You may not move an IP phone to a switch on a remote site if the IP address of the phone is not within the IP address range defined for the destination site.

The IP address range restrictions apply only to switches at remote sites. You can move an IP phone across switches at the Headquarters site without entering an IP address range for the Headquarters site. However, if the phone’s IP address is within a range mapped to a remote site, you cannot move that phone to a switch at the Headquarters site.
If you plan to move ShoreTel 400-Series IP phones from one ShoreTel system to another, you must clear each phone’s configuration by using MUTE 25327# (CLEAR). The best approach for clearing a phone’s configuration depends on how your system is configured:

- If your installation uses DHCP Option 156, press the MUTE key followed by 25327#. Wait for the phone to finish clearing and start rebooting (phone screen goes blank and message-waiting indicator light illuminates briefly), and then unplug the phone so that it does not reregister with the system when it reboots.

- If your installation does not use DHCP Option 156, press the MUTE key followed by 25327#.

Clearing a phone’s configuration while the phone is connected to the ShoreTel system automatically removes the phone from ShoreTel Director. If you clear a phone’s configuration while the phone is not connected to the system, you must manually remove the phone from ShoreTel Director.

To move an IP phone:

1. Launch ShoreTel Director.

2. Click Administration > IP Phones > Individual IP Phones.

3. If you want to filter the list of phones, do the following:
   a. In the By Sites field, in the drop-down list select the site where the phone you want to move resides.
   b. In the By Switches field, in the drop-down list select the switch to which the phone you want to move is assigned.
   c. Click Find Now.

   The IP phones for the selected site and switch are displayed.

4. Click the check boxes for the IP phones you want to move.

5. In the Move field, select the switch to which you want to move the phone.

6. Click Move.

   A dialog box requests confirmation.

7. Click Yes to move the phone.

**IP Phone State Display**

ShoreTel IP phones display the following states:

- **Available**: The phone has no user assigned to it. Calls can be placed from the phone, but it does not receive calls. The Caller ID is “Unknown.”

- **<UserName> <User Ext>**: The phone is assigned to <UserName>.

- **Anonymous**: The user can make a call but cannot receive calls. The Caller ID is “Caller ID Unknown.” The phone can be in this state for either of the following reasons:
The assigned user has activated the Extension Assignment feature on another phone.

The ShoreTel administrator has explicitly configured anonymous phones that do not have assigned users.

- **Unavailable:** The phone was once in the ShoreTel system but has been removed through ShoreTel Director. The phone has no dial tone and is not functional. (This state does not apply to ShoreTel 400-Series IP phones.)

### Displaying ShoreTel IP Phone Settings

You can display the phone’s current IP parameter settings by entering a key sequence from the phone’s keypad.

#### On ShoreTel 100-, 200-, 500-, and 600-Series IP Phones

1. With the phone on hook, press the **MUTE** key followed by `4636#` (**INFO#**).

   The phone displays a parameter or group of parameters.

2. Press `#` to advance the display or `*` to exit.

   The phone resumes normal operation after the last parameter or group of parameters has been displayed.

#### On ShoreTel 400-Series IP Phones

1. With the phone on hook, press the **MUTE** key followed by `4636#` (**INFO#**).

   The **Admin Options** menu opens.

2. Use the navigation key pad and the selector button to scroll through and open the submenus as necessary to see the phone’s settings.

   For descriptions of the parameters, see the *ShoreTel Maintenance Guide*.

3. To close the Admin options menu, do one of the following:
   - On the IP420, with **Exit** highlighted press the selector button on the navigation key pad.
   - On the IP480, IP480g, and IP485g, press the **Exit** soft key.
Resetting a ShoreTel IP Phone

You can reset a phone by entering a key sequence from the phone’s keypad.

**On ShoreTel 100-, 200-, 500-, and 600-Series IP Phones**

1. With the phone on hook, press the MUTE key followed by 73738# (RESET#).
   The phone displays the Reset Phone? prompt.
2. Press # to reboot.
   The phone reboots and applies settings.

**On ShoreTel 400-Series IP Phones**

1. With the phone on hook, press the MUTE key followed by 73738# (RESET#).
   The phone displays the Reset phone screen.
2. Do one of the following:
   - On the IP420, with Reset highlighted, press the selector button on the navigation key pad.
   - On the IP480, IP480g, and IP485g, press the Reset soft key.
   The phone reboots and applies settings.

Customizing Ringtones

ShoreTel IP phones offer multiple sets of different ringtones that users can select on their phones. Each set has one tone for internal calls and one tone for external calls. ShoreTel IP phones also support the ability to load custom ringtones on an IP phone so that users can distinguish the sound of their phone’s ringtone from their neighbors’ ringtones.

To use custom ringtones, you must save them to the proper location on the server. The default directory for ringtones is `<drive>\inetpub\ftproot\wav\ringtone`. In addition, for 400-Series IP phones, WAV files must be converted to PCM files, as described below.

After the custom ringtones are saved on the server, the way that you specify the ringtone file names depends on the phone model:

- For the ShoreTel IP655 and the 400-Series IP phones, you specify custom ringtones for a particular user group through the User Groups page in ShoreTel Director. When custom ringtones are assigned in this manner, the existing sets of ShoreTel ringtones are preserved.
- For ShoreTel 100-, 200-, and 500-Series IP phones, you specify custom ringtones through a configuration file. When ringtones are customized through configuration files, the custom ringtone set displaces one of the existing sets of ShoreTel ringtones.

The ringtones are downloaded to the IP phone through FTP or HTTP.
Custom ringtones have the following requirements or restrictions:

- Custom ringtones must be in Waveform audio file format (.wav). ShoreTel does not offer custom ringtones, nor does it provide tools for creating or managing the custom WAV files, but numerous web sites offer free WAV downloads.

- Phones support the following formats:
  - µ-law: 8-bit, 8 kHz, 16 kHz, monaural
  - α-law: 8-bit, 8 kHz, 16 kHz, monaural
  - 16-bit, 8 kHz, monaural -or- 16-bit, 16 kHz, monaural

- Most ShoreTel phone models can have up to two custom tones. Their combined size must be less than 750 KB. ShoreTel 400-series IP phones can have up to 10 pairs of custom ringtones, without this size restriction.

- ShoreTel Director imposes ringtone size restrictions for ShoreTel IP655 and 400-Series models. Custom ringtones for ring pairs 5-8 can be up to 100 KB each. Custom ringtones for ring pairs 9-14 (available only for the 400-Series phones) can be up to 300 KB each.

- WAV files can be any time length within the size restrictions. If a WAV file is less than six seconds, the phone pads the ring out to a six-second length before it repeats the WAV file. WAV files longer than six seconds are repeated.

Custom ringtones for ShoreTel 400-Series IP phones use PCM audio format (.pcm) rather than WAV format (.wav). Custom ringtone WAV files are converted to PCM format automatically or by running a batch file, as follows:

- During the ShoreTel installation or upgrade process, any existing custom ringtone WAV files in the \wav\ringtone subdirectory are automatically converted to PCM, and they are available for use by the 400-Series phones.

- If you add WAV files for custom ringtones after the ShoreTel installation or upgrade process, WAV files must be converted to PCM audio format before you can download them to the 400-Series phones. To convert WAV files to PCM format, run wav2pcm.bat, which resides in \inetpub\ftproot\wav\ringtone. Running wav2pcm.bat converts all WAV files in the \wav\ringtone subdirectory to PCM format and stores the new ringtone files in \inetpub\ftproot\pcm\ringtone.

When you select custom ringtones for 400-Series phones on the Edit User Groups page in ShoreTel Director, the system automatically uses the corresponding .pcm file for the .wav file you select.

### Loading Custom Ringtones Through ShoreTel Director

For the ShoreTel IP Phone 655 and the 400-Series IP phones, you specify custom ringtones for a particular user group through ShoreTel Director.

1. Launch ShoreTel Director.
2. Click Administration > Users > User Groups.
3. Click the user group name for which you want to configure options, or create a new user group.
The User Groups – Edit User Group page opens.

4. Scroll to the **Ringtones** section near the bottom of the page, and for one or more ringtones, specify a name and select an audio file from the drop-down list.

---

**Note**

ShoreTel IP655 can use ringtones through Ring Pair 8. ShoreTel 400-Series IP phones can use ringtones through Ring Pair 14.

5. Click **Save**.

## Loading Custom Ringtones Through a Custom Configuration File

For ShoreTel 100-, 200-, and 500-series phones, you can specify custom ringtones through a configuration file. The high-level process is as follows:

1. Identify the WAV files you want to use as ringtones. You can either create the files yourself or obtain them from another source, such as a website. Put the files on a server that is accessible to the IP phone by anonymous FTP. (This server does not have to be the same as the host of the configuration files.) The default directory for ringtones is `<drive>\inetpub\ftproot\wav\ringtone`.

2. Create or edit the custom configuration file for a specific phone or a phone model.

3. Reboot the phone so that it retrieves the information in the configuration file and downloads the WAV files. At boot time, the phone indicates the success or failure of phone-specific configuration download and the WAV download.

To specify that a phone or phones should use custom ringtones, you insert two configuration parameters, WaveRinger1 and WaveRinger2, in a custom configuration file. These parameters identify the name and location of the custom ringtones that the IP phone downloads (by FTP) to the phone's RAM at boot time. **Table 33** provides more details.

For example, to load one of the custom ringtones, you could replace **L/r14** (Ring 4 External) and **L/r15** (Ring 4 Internal) with the name and location of the file containing the new custom ringtone, using the symbols shown in **Table 34**.

Replacing internal and external ringtones in separate sets (for example, Ring 2 external and Ring 4 internal) is also possible, but only one set of ringtones can be active at a time. Activating either set of ringtones activates only one of the custom ringtones at a time.
You can add the parameters listed in Table 33 to the custom configuration file for a specific phone or all phones of a certain model:

- For a specific phone, create a phone-specific custom configuration text file and store it in the same directory as the standard IP phone configuration files. The name of the phone-specific file contains the MAC address of the phone that you want to receive the custom ringtone. You can find the address on the sticker on the back of the phone. The name of the phone-specific configuration file is as follows:

  \[\text{shore}_{\text{MAC Address}}.\text{txt}\]

  where "MAC Address" is the MAC address and all the letters in the MAC address should be in upper case.

- To load the same custom ringtone onto several IP phones at the same time, edit the custom configuration file for a particular phone model. (For example, the custom configuration file name for the IP560 is S6custom.txt.) Be aware that loading ringtones on all phones of a certain model could cause ringtone confusion if the phones are concentrated in one area of a building.

### Table 33: WaveRinger1 and WaveRinger2 Configuration Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>WaveRinger1</td>
<td>Up to 64 ASCII Characters</td>
<td>Used to assign one Wave File to any of the ringtones defined in Table 34 on page 226. The first value is the ringtone, and the second value is the location of the file on the FTP server. Examples: WaveRinger1 L/rg 192.168.0.20/audio/dave.wav WaveRinger2 L/r1 192.168.0.20/audio/dave.wav</td>
</tr>
<tr>
<td>WaveRinger2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 34: Ringtones and Symbols

<table>
<thead>
<tr>
<th>Ringtone</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard - External ring</td>
<td>L/rg</td>
</tr>
<tr>
<td>Standard - Internal ring</td>
<td>L/r1</td>
</tr>
<tr>
<td>Ring 2 - External ring</td>
<td>L/r10</td>
</tr>
<tr>
<td>Ring 2 - Internal ring</td>
<td>L/r11</td>
</tr>
<tr>
<td>Ring 3 - External ring</td>
<td>L/r12</td>
</tr>
<tr>
<td>Ring 3 - Internal ring</td>
<td>L/r13</td>
</tr>
<tr>
<td>Ring 4 - External ring</td>
<td>L/r14</td>
</tr>
<tr>
<td>Ring 4 - Internal ring</td>
<td>L/r15</td>
</tr>
</tbody>
</table>
Customizing Wallpaper on Color Phone Displays

The default location for custom configuration files is `<drive>:\inetpub\ftproot\phoneconfig`. For more details about using custom configuration files, see the *ShoreTel Maintenance Guide*.

The ShoreTel IP265, IP485g, IP565g, and IP655 phone models offer color displays. These phones include default images that you can specify for the wallpaper on the phone display, but you can also configure these phones to display custom wallpaper images that you download from a server.

The process and graphics specifications for using custom wallpaper images vary based on the IP phone model.

For ShoreTel IP485g and IP655 Phones

To use a custom wallpaper image on a ShoreTel IP485g or IP655 phone, you create the image, add the image file to the server, and use the User Groups page in ShoreTel Director to assign the image to a particular user group. The particular wallpaper image that is displayed can be set in the user’s personal options in ShoreTel Director or through the phone’s Options menu. This section describes how to create and assign custom wallpaper images.

In addition, this section explains how to modify the “Standard” wallpaper image that IP485g phones include. To change the default wallpaper image for this “Standard” file, you specify the new image in a custom configuration file for the phone.

Creating Custom Wallpaper Images

Wallpaper images need to be in the Portable Network Graphics (.png) file format in the following dimensions:

- For the IP485g, wallpaper images are 480x272 pixels.
- For the IP655, wallpaper images are 640x480 pixels.

You can create .png files using Microsoft Paint or any other graphics editing program. A simple approach for creating a custom image that is the correct size is to use one of the wallpaper images provided by ShoreTel as a template.
To create a graphic file that can be used as a wallpaper image:

1. Locate the wallpaper images that were loaded on your system when you installed the ShoreTel server by looking in one of the following default directories:

   `<drive>:\inetpub\ftproot\Wallpaper\480x272c\`
   `<drive>:\inetpub\ftproot\Wallpaper\640x480c\`

2. Open one of the .png files in this directory by using MS Paint or another graphics editing program.

3. Verify that the image has the following attributes:
   - For IP485g
     - Width – 480 pixels
     - Height – 272 pixels
   - For IP655
     - Width – 640 pixels
     - Height – 480 pixels

4. Save a copy of the image, or use Save As to save a new file.

5. Verify that the old file and the new file exist in one of the following locations, as appropriate:
   - `<drive>:\inetpub\ftproot\Wallpaper\480x272c\`
   - `<drive>:\inetpub\ftproot\Wallpaper\640x480c\`
   - wherever your custom wallpaper images are stored

6. Change the image to create your custom image, while retaining the size of the original image.

7. Click **Save**.
Assigning Custom Wallpaper Images to a User Group

1. Launch ShoreTel Director.
2. Click Administration > Users > User Groups.
   The User Groups page opens.
3. Click the user group name for which you want to configure options, or create a new user group.
   The User Groups - Edit User Group page opens.
4. Scroll to the Wallpaper section at the bottom of the page, and for one or more wallpaper images, specify a name and select an image from the drop-down list.
5. Click Save.

Specifying a Custom Wallpaper Image for a User

After wallpaper images are assigned to a particular user group, they can be assigned to any user in that user group.

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
   The Individual Users page opens.
3. Click the name of the user for which you want to configure options, or create a new user.
   The Users - Edit User page opens.
4. Select the Personal Options tab.
5. In the Wallpaper field, select an image from the drop-down list.
6. Click Save.

Specifying a Custom Wallpaper Image on a Phone

Users can select a wallpaper image through the Options menu on the phone.

Specifying a Custom Image for the Standard Wallpaper Image

In general, you configure the custom wallpaper images through ShoreTel Director. However, if you want to specify a custom image for the Standard image, you do that by adding text to the configuration file in the phone configuration directory on the Headquarters server.

The following procedure uses the default directories. Depending on how your system was installed, your root path might be different.

1. Save the custom wallpaper image file on the Headquarters server in the following directory, as appropriate for the phone model:
2. Access the <drive>:\inetpub\ftproot\phoneconfig directory on the Headquarters server, and edit the configuration files as follows to specify an image to use as the Standard wallpaper image:

- For the IP485g phone, add the following lines to custom_IP485g.txt:

  ```
  [user]
  wallpaperStandardFilename=<image file name>.png
  ```

- For the IP655 phone, add the following line to swecustom.txt:

  ```
  wallpaper1Phone "<image file name>.png"
  ```

When you use this method, the image’s label on the phone is Standard. You cannot modify the label.

3. Reboot the phones so that they apply the new setting.

4. Verify that the phones display the new wallpaper file for the Standard wallpaper setting.

### For ShoreTel IP265 and IP565g Phones

To use a custom wallpaper image, you must first create the image and then specify it in a custom configuration file.

#### Creating Custom Wallpaper Images

For ShoreTel IP265 and IP565g phones, the wallpaper is 320x240 pixels and uses an uncompressed 256-color.bmp file format. Each of the 256 colors is defined by a 24-bit RGB value. Bitmap files can be composed using MS Paint or any other editor that can create Paint-compatible files.

To create a graphic file that can be used as a wallpaper image:

1. Open the image in Microsoft Paint.
2. Verify that the image has the following attributes:
   - Width – 320 pixels
   - Height – 240 pixels
   - Colors – Colors

3. Click OK to close the dialog box.

4. Click File > Save As.

   The Save As dialog box appears.

5. In the Save as type field, select 24-bit Bitmap (*.bmp;*.dib).

6. In the File Name field, enter the name to use for the file.

7. Click Save.

Downloading the File to Several Color-Screen IP Phones

The wallpaper file that each IP phone displays is specified in configuration files located in the phone configuration directory on the Headquarters server. In standard ShoreTel installations, the phone configuration directory is <drive>:\Inetpub\ftproot.

ShoreTel specifies one text file for each phone model that defines default characteristics for all phones of that model type on the system. You specify the default wallpaper for phones of a specific model by adding a line to its corresponding configuration file.

To load a custom wallpaper image on all phones of a specific model type:

1. Save the wallpaper file on the Headquarters server in the following directory:

   <drive>:/Inetpub/ftproot

2. Access the <drive>:/Inetpub/ftproot directory on the Headquarters server.

3. Open the custom configuration file for the phone model:

   - For IP265, open s36custom.txt
   - For IP565g, open s6ccustom.txt

4. Add the following line to the open file: Wallpaper2pixmap abc.bmp, entering the name of the wallpaper file in place of abc.bmp, and then save and close the file.

   **Note**
   For example, if the wallpaper file is name logo.bmp, enter Wallpaper2pixmap logo.bmp in the configuration file.

5. Open the configuration file for the phone model:

   - IP265: open shore_s36.txt
   - IP565g: open shore_s6c.txt
6. Verify that the file contains the one of the following lines, or add the line if it is not present:
   - IP265: Include s36custom.txt.
   - IP565g: Include s6ccustom.txt.

7. Reset the phones.

8. Verify that each phone displays the new wallpaper file.

### Downloading a Custom Wallpaper Image to a Single Phone

The individual configuration files for a phone override the default settings for individual IP phone models. You can assign custom wallpaper files to individual IP phones by modifying the corresponding phone configuration file.

1. Save the wallpaper file on the Headquarters server in the following directory:
   <drive>:/Inetpub/ftproot

2. Access the <drive>:/Inetpub/ftproot directory on the Headquarters server.

3. Create a text file named shore_xxxxxx.txt, where xxxxx is the MAC address of the phone. Use lower case text when naming the file.

   The MAC address is a 12-digit number that uniquely identifies each device. This address is printed on the white bar code located on the bottom of the phone.

   - Add a line in the open file with the following format: Wallpaper2pixmap abc.bmp, where abc.bmp is the name of the wallpaper file, then save and close the file. For example, if the wallpaper filename is logo.bmp, enter Wallpaper2pixmap logo.bmp.

4. Reboot the phone.

5. Verify that the phone displays the wallpaper file.

### Specifying Custom Applications for User Groups

For certain phone models, such as the ShoreTel Phone IP655, in addition to specifying ringtones and wallpaper, you can specify configuration options for applications through the User Group page in ShoreTel Director.

1. Launch ShoreTel Director.

2. Click Administration > Users > User Groups.
3. Click the user group name for which you want to configure options, or create a new user group. The User Groups – Edit User Group page opens.

4. In the Available Applications section, use the drop-down lists to select applications that reference URLs.

5. Click Save.

Automatic Off-Hook and Headset Preferences

You can set a user’s automatic off-hook preference in ShoreTel Director, and users can set this preference in ShoreTel Communicator or through the interface on some phone models. In ShoreTel Director and ShoreTel Communicator, the automatic off-hook preference is combined with the headset type, but some phone models provide the headset type as a separate option, which leads to the following differences in behavior:

- For the IP480, IP480g, and IP485g phones, the automatic off-hook preference (speaker or headset) and the headset type (wired or wireless) are separate options that a user can set in the phone interface. As a result, the headset type preference remains in effect regardless of the automatic off-hook setting. In other words, a user can select the speakerphone as the automatic off-hook setting while still specifying a preference for headset type.

- The IP420 phone interface does not provide the capability to change the preferences for automatic off-hook or headset type. If a user’s headset type is set to wireless headset and the user assigns his or her extension to a phone that does not have a wireless headset attached, the user cannot use the headset button or automatic off-hook on the phone until this preference is changed in ShoreTel Communicator. Alternatively, the speakerphone or handset could provide audio path. In addition, on IP420 phones, after a user has unassigned his or her extension from a phone and the phone returns to an Available or Anonymous state, the headset type always reverts to the wired headset preference.

- For ShoreTel IP phone models other than the 400-Series models, the automatic off-hook preference includes the headset type, just as in ShoreTel Director and ShoreTel Communicator. As a result, if you or the user change a user’s automatic off-hook preference from wireless headset to speaker on these models, the phone reverts to a wired headset setting.

Specifying Automatic Off-Hook for Wireless Headsets

ShoreTel has incorporated electronic automatic off-hook functionality into various IP phone models. These ShoreTel IP phones work with the Plantronics CS50 wireless headset. Users who have purchased this supported headset model can answer or end calls by pressing the activation button on their headset when they hear their phone ring. If they are too far from their phone to hear it ring, the headset will generate an audible cue to announce incoming calls.
This feature is supported on the following ShoreTel IP phone models:

- IP565g
- IP560g
- IP560
- IP485g
- IP480g
- IP480
- IP420
- IP265
- IP230
- IP212k

Using this feature defeats auto on-hook and off-hook behaviors.

You can configure this feature through the phone, ShoreTel Communicator, or ShoreTel Director. The procedure for using ShoreTel Director is as follows:

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
3. Click the user name.
   The Edit User page appears.
4. Click the Personal Options tab.
5. Scroll down to Automatic Off-Hook Preference and select the Wireless Headset radio button.
6. Click Save.

Configuring Programmable IP Phone Buttons

An administrator or user can change the functions associated with programmable buttons on ShoreTel IP phones or button boxes. These programmable buttons function as shortcuts for operations that would normally require pressing two or three buttons to accomplish the same task. For example, the action associated with the bottom button on an IP560 could be configured to speed dial a particular extension or external number. The button above that could be set to perform overhead paging, and so on.

Table 35 lists the supported functions that can be programmed through ShoreTel Director. Not all programmable functions apply to all phone models.

All of the custom buttons are configurable except for the top right button, which is permanently set to provide call appearance information (that is, the ringing indicator and call timer information). After a function is assigned to a button, users can enter a label that appears on the display next to the custom button. The length of the label depends on the phone model, and labels might be truncated on certain phone models.
You can configure custom buttons through ShoreTel Director on behalf of a user, or you can enable permissions for an individual user so that the user can modify the custom buttons on the IP phone through the telephone interface. The functions that a user can assign to a programmable button using the telephone interface vary depending on the phone model. On IP230, IP480, IP480g, and IP485g, these functions are limited to Dial Number and Call Appearance.

The programmable button feature is supported on all ShoreTel multiline models except the IP420.

### Table 35: Supported Programmable Button Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Login</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Agent Logout</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Agent Wrap-Up</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Barge In</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Bridged Call Appearance</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Call Appearance</td>
<td>None</td>
<td>Not supported on Button Box</td>
</tr>
<tr>
<td>Call Move</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centrex Flash</td>
<td>None</td>
<td>Refer to <a href="#">Configuring Centrex Flash</a> on page 182.</td>
</tr>
<tr>
<td>Change CHM</td>
<td>Change Call Handling Mode</td>
<td></td>
</tr>
<tr>
<td>Change Default Audio Path</td>
<td>Audio Call Path</td>
<td></td>
</tr>
<tr>
<td>Conference Blind</td>
<td>Extension or external number</td>
<td></td>
</tr>
<tr>
<td>Conference Consultative</td>
<td>Extension or external number</td>
<td></td>
</tr>
<tr>
<td>Conference Intercom</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Dial Mailbox</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Dial Number (Speed Dial)</td>
<td>Extension or external number</td>
<td></td>
</tr>
<tr>
<td>Group Pickup</td>
<td>Extension</td>
<td></td>
</tr>
<tr>
<td>Hotline</td>
<td>Extension</td>
<td></td>
</tr>
<tr>
<td>Intercom</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Malicious Call Trace</td>
<td>Mailbox</td>
<td>Event logs are sent to the specified mailbox.</td>
</tr>
<tr>
<td>Monitor Extension</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Page</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Park</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Park and Page</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Pickup</td>
<td>Extension or none</td>
<td></td>
</tr>
</tbody>
</table>
### Table 35: Supported Programmable Button Functions (Continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup Night Bell</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Pickup/Unpark</td>
<td>Extension or none</td>
<td>Uses internal presence to determine which operation to perform</td>
</tr>
<tr>
<td>Phone Application</td>
<td>Application</td>
<td></td>
</tr>
<tr>
<td>Record Call</td>
<td>Mailbox</td>
<td>Operates on selected call, but only external calls can be recorded. Pressing a second time stops the recording. Call recordings can be saved in the mailbox of the initiating client (by leaving the mailbox field blank) or can be routed to an alternate mailbox by typing a mailbox number in the field.</td>
</tr>
<tr>
<td>Record Extension</td>
<td>Extension or mailbox</td>
<td>Only an extension involved in an external call can be recorded. Call recordings can be saved in the mailbox of the initiating client (by leaving the mailbox field blank) or can be routed to an alternate mailbox by entering a mailbox number in the field.</td>
</tr>
<tr>
<td>Send Digits Over Call</td>
<td>Extension</td>
<td></td>
</tr>
<tr>
<td>Silent Coach</td>
<td>Extension</td>
<td></td>
</tr>
<tr>
<td>Silent Monitor</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Toggle Handsfree</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Toggle Lock/Unlock</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Transfer Blind</td>
<td>Extension or external number</td>
<td></td>
</tr>
<tr>
<td>Transfer Consultative</td>
<td>Extension or external number</td>
<td></td>
</tr>
<tr>
<td>Transfer Intercom</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Transfer to Mailbox</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Transfer Whisper</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Unpark</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Unused</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Whisper Page</td>
<td>Extension or none</td>
<td></td>
</tr>
<tr>
<td>Whisper Page Mute</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
Configuring Programmable Buttons through ShoreTel Director

1. Launch ShoreTel Director.
2. Click on the Administration > Users > Individual Users.
3. Click the name of the user whose phone you want to modify.
4. Click the Personal Options tab.
5. Click the Program IP Phone Buttons link.

   The Program IP Phone Buttons page appears.

6. In the Device Type field, select IP Phone or a particular Button Box.
7. For each button that you want to configure, do the following:
   a. In the first Function field, select the category for this button.
   b. In the second field, select the function to associate with a particular button. For descriptions of the functions, see Table 35 on page 235.
   c. In the Long Label and Short Label fields, type a label to appear next to the button on the phone LED display to remind the user of the button’s function, as follows:
      - The Short Label field applies to most ShoreTel multiline phones and can be up to 6 characters, but only the first 5 characters display on most phones; the ShoreTel BB24 and IP212k can display 6 characters.
      - The Long Label field applies to the ShoreTel IP655, IP480, IP480g, and IP485g models.
   d. When applicable, enter the appropriate information in the fields that appear in the Target section.
   e. Certain functions require a destination, but for other functions (such as speed-dial or blind transfer) a destination is optional. Some functions take only extensions, and some take any type of phone number.
8. Click Save.

Copying Programmable Button Configurations

The Copy IP Phone Buttons page allows a system administrator to copy the programmable button configuration from one user to another, thus reducing the tedious work of configuring IP phone buttons.

1. Launch ShoreTel Director.
2. Click **Administration > Users link > Individual Users**.
   The Individual Users page appears.

3. Click on the name of the user whose IP phone you would like to modify.
   The Edit User page appears.

4. Click the Personal Options tab.

5. Locate the Program IP Phone Buttons link and click the **Copy** button.
   The Copy IP Phone Buttons dialogue box appears.

6. Click **Search** to find the user whose programmable button configurations you want to copy.

7. Select the devices whose programmable button configurations you want to copy.

8. Click **Copy** to duplicate the programmable button configuration from one user to another.

### Enabling a User to Program Buttons on a ShoreTel IP Phone

**Note**
The default for new Class of Service (Telephony) profiles is to have this feature disabled, thus preventing users from modifying their own custom buttons.

1. Launch ShoreTel Director.

2. Click **Administration > Users > Individual Users**.

3. Click the name of the user whose profile you would like to modify to enable the user to customize IP phone buttons.
   The Edit User page appears.

4. Click the **Go to this User Group** link.
   The User Groups page for the user group to which the user is associated appears.

5. For COS – Telephony, click **Go to this Class of Service**.
   The Class of Service page appears.

6. Select the **Allow Customization of IP Phone Buttons and Communicator Monitor Windows** check box.

7. Click **Save**.
Customizing Buttons on a Phone or BB24 via the Telephone Interface

Through the telephone interface, users can customize programmable buttons on ShoreTel IP phones or the BB24. ShoreTel IP230 and 400-Series IP phones support a limited set of programmable button functionality to be programmed from the phone, and other ShoreTel IP phones allow a broad set of functions to be programmed. For details on customizing programmable buttons from the telephone interface, see the user guide for the particular phone model.

Note
ShoreTel 400-Series IP phones do not support the BB24.

Configuring a Hotline Button

A Hotline is a bi-directional ringdown circuit accessed through IP phone or Communicator buttons. A hotline call is initiated by pressing the assigned button. Hotline calls can be configured as speed dial or intercom calls. To configure a hotline button, do the following:

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
3. Click the name of the user whose phone you want to modify.
4. Click the Personal Options tab.
5. Click the Program IP Phone Buttons link.
   The Program IP Phone Buttons page appears.
6. In the Device Type field, select IP Phone or a particular Button Box.
7. Identify the button # that you want to configure and do the following:
   a. In the first Function field, select the All or Telephony.
   b. In the second field, select Hotline.
   c. In the Long Label and Short Label fields, type a label to appear next to the button on the phone LED display to remind the user of the button's function. (For details about labels, see Configuring Programmable Buttons through ShoreTel Director on page 237.)
   d. In the Extension field, enter the extension to which you want the call to connect.
   e. In the Call Action field, select the method you want to use for making the connection.
8. Click Save.
Implementing Malicious Call Trace

ShoreTel provides organizations with the ability to report a malicious call by requesting ShoreTel Communicator trace and record the source of the incoming call. Organizations can provide users with the Malicious Call Trace (MCT) capability to initiate a sequence of events that trace a call when malicious intent is suspected.

MCT enables the ShoreTel phone user to identify the source of malicious calls. A user, who receives a malicious call from the PSTN over an ISDN trunk supporting MCT, can initiate a MCT on the ShoreTel phone by pressing a programmable button, entering a star code sequence, or using the Communicator toolbar button.

After the user initiates the MCT process, the ShoreTel Windows Event Log is notified and the user receives an urgent email confirming the action along with an audible tone. The system provider is notified through the PSTN of the malicious nature of the call. This allows the system provider to take action, such as notifying legal authorities.

**Note**

MCT is an ISDN feature. It is implemented on BRI and PRI trunks to ISDN service providers that support the feature. The ShoreTel implementation of MCT supports the ETSI standard that is configurable on switches that support Euro-ISDN. Trace information is not provided to or displayed on the ShoreTel user phones.

Configuring a Programmable Button for MCT

1. Launch ShoreTel Director.
2. Click **Administration > Users > Individual Users**.
3. Click on the name of the user whose phone you want to modify.
4. Click the Personal Options tab.
5. Click the **Program IP Phone Buttons** link.
   The Program IP Phone Buttons page opens.
6. In the **Device Type** field, select IP Phone or a particular Button Box.
7. Identify the button # that you want to configure and do the following:
   - In the first Function field, select the **All** or **Telephony**.
   - In the second field, select **Malicious Call Trace**.
   - In the **Long Label** and **Short Label** fields, type a label to appear next to the button on the phone LED display to remind the user of the button’s function. (For details about labels, see Configuring Programmable Buttons through ShoreTel Director on page 237.)
   - In the **Mailbox** field, select the user mailbox to which event logs should go.
e. In the **Call Action** field, select the method to use for making the connection.

8. Click **Save**.

### Initiating a Malicious Call Trace

You can initiate a malicious call trace through a star code, a programmable button, or the ShoreTel Communicator Toolbar button.

#### By Using a (*) Star Code

On a ShoreTel IP phone, third-party SIP phone, analog phone, or Extension Assignment device the user needs to place the suspected malicious call on hold and then enter the MCT star code (*21) to start the tracing process.

**Example:** The user receives an incoming malicious call. Using a ShoreTel IP phone, third-party SIP phone, Analog phone or Extension Assignment device the user presses the hold button and then enters *21 to start the trace sequence. Once the trace sequence starts, a confirmation tone will be played prior to returning to the call to indicate that an MCT request has been initiated, an event is logged in Director, record call is attempted to the local extension’s mailbox, and an urgent email is sent to the recipient of the call.

#### By Using a Programmable Button

On a ShoreTel IP phone, the user presses the IP Programmable Button to start the tracing process.

**Example:** The user receives an incoming malicious call. Using a ShoreTel IP phone with programmable keys, the user presses the programmable key which will start the trace sequence. Once the trace sequence starts, a confirmation tone will be played to indicate that an MCT request has been initiated, an event is logged in Director, record call is attempted to the configured extension's mailbox, and an urgent email is sent to the recipient of the call.

#### By Using the Communicator Toolbar Button

Using ShoreTel Communicator, the user presses the Communicator Toolbar button to start the tracing process.

Using Softphone, the user presses the IP Programmable Button to start the tracing process. The signal requesting MCT initiation is sent to the switch via TMS.

---

**Note**

Communicator does not support the initiation of MCT using the star code.
Example

The user receives an incoming malicious call via Communicator or a softphone, the user can press the programmable toolbar key which will start the trace sequence. Once the trace sequence starts, a confirmation tone will be played to indicate that an MCT request has been initiated, an event is logged in Director, record call is attempted to the configured extension's mailbox, and an urgent email is sent to the recipient of the call.

Considerations for Using Malicious Call Trace

When setting up your system, keep the following considerations in mind:

- The ShoreTel MCT feature will only work with carriers supporting ETSI standard EN 300 130-1 V1.2.4.
- ShoreTel switches support the malicious call identification originating function (MCID-O) only. They do not support the malicious call identification terminating function (MCID-T). If the switch receives a notification from the network of a malicious call identification, it ignores the notification.
- The MCT feature is supported only for incoming calls from the ISDN network.
- The service provider must have MCID functionality enabled for the feature to work.
- ShoreTel ISDN interface on the ShoreTel E1/BRI switches must have the Protocol Type set to ISDN User with the Central Office Type set to Euro ISDN. When MCID is initiated on a third-party SIP phone by putting a call on hold and initiating the star code *21 sequence, after the successful initiation of the signal the previous call continues to be held. User needs to manually unhold the call. For ShoreTel IP phones and analog phones, the held call is connected back after MCT initiation.
- Malicious Call Trace confirmation tone is not given to third-party SIP phones. Calls on third-party SIP phones are not automatically taken off hold.
- ShoreTel Communicator and Softphone does not support initiation through the star code sequence.
- Mobile Communicator does not support the Malicious Call Trace feature.
- Malicious Call Trace confirmation tone signals an invocation attempt. It does not signal that the MCT request was successfully received at the connected network (CO). The MCT response is not processed by the ShoreTel ISDN stack.
- Malicious Call Trace phone programmable button may configure a target mailbox for recording the call, but MCT initiated via star code will always be recorded to the initiating user’s mailbox (no way to specify target).
- Malicious Call Trace attempt can only be issued once per call.
- Malicious Call Trace invocation is only valid while the call is established.
- Malicious Call Trace is not supported on conference calls created on a ShoreTel PBX.
- Intercommunication/Networking considerations. MCID caller info on calls between different networks is subject to agreement between the service providers.
Configuring VPN Phones

The VPN phone capability allows remote workers to have a full and familiar IP phone experience. For remote IP phones using the ShoreTel system, secure audio communication between the remote phone and the Headquarters site is provided through open VPN SSL tunnels. To support VPN Phone, ShoreTel offers two VPN Concentrators capable of supporting up to 100 calls through VPN tunnels.

VPN capability is supported on ShoreTel IP phones IP655, IP565g, IP560g, and IP230g.

Note
VPN capability is not supported on ShoreTel 400-Series IP phones.

Description

Terms

Secure Socket Layer (SSL): A cryptographic protocol that provide secure communications on the Internet.

Point to Point Protocol (PPP): A data link protocol used to establish a direct connection between two nodes over serial cable, phone line, trunk line, cellular telephone, specialized radio links, or fiber optic links

Virtual Private Network (VPN): A computer network in which some internode links are facilitated via open connections or virtual circuits through a larger network instead of via physical wires. The link-layer protocols of the virtual network are said to be tunneled through the larger network. One common application is secure communications through the public Internet.

VPN Concentrator: A gateway that provides secure access to a corporate network for remote devices through VPN tunnels.

Stunnel: A multi-platform program that provide SSL tunnels between a remote device and a VPN gateway.

Tunnel: An link between two networks (such as LANs) that are connected by a larger network (such as a WAN or the Internet). Tunnel packets containing messages exchanged by the smaller networks are encapsulated into packets that facilitate routing through the larger network. Each VPN communication session establishes a tunnel, which is removed when the session is finished.

Feature Summary

VPN Phone provides secure audio communications for ShoreTel IP Phones located remotely from ShoreTel switches through open VPN SSL tunnels.

The feature includes an Open SSL VPN client in the ShoreTel IP phone and an Open SSL VPN Gateway. The Open SSL structure allows the traversal of firewalls implemented by many enterprises for blocking VPN tunnels.
Components

VPN Phone implementation requires two components – a VPN Concentrator and a ShoreTel IP phone capable of communicating over a VPN.

VPN Concentrator

The SSL based VPN Concentrator enables remote ShoreTel IP phones to establish secure voice communications with through the local ShoreTel PBX through SSL VPN tunnels. For every tunnel, a virtual PPP interface is created on VPN Concentrator and a peer PPP interface is created on the remote ShoreTel IP phone. Signaling and media streams go through the PPP interface and are secured by SSL encryption.

ShoreTel offers two VPN Concentrator Models:

- **VPN Concentrator 5300LF/5300LF2** – supports a capacity of 100 calls.
- **VPN Concentrator 4500/4550** – supports a capacity of 10 calls.

The [VPN Concentrator 4500/5300 Installation and Configuration Guide](#) provides additional information about the ShoreTel VPN Concentrators.

VPN Phone Licenses

ShoreTel licenses VPN Phone usage on a stunnel basis. Establishing a stunnel uses a license, which becomes available when the tunnel is discontinued.

Network Configuration

The VPN Concentrator is located at ShoreTel's Main Site, connected to the same LAN as local ShoreTel switches and the Main ShoreTel server. Refer to the [VPN Concentrator 4500/5300 Installation and Configuration Guide](#) for specific deployment options based on the router and firewall configuration of the ShoreTel network.

Stunnel Establishment

Each remote device is assigned a user name and password that is recognized by the VPN Concentrator. Phone logging into the Concentrator are authenticated through the verification of its user name and password. When the phone is successfully authenticated, the Concentrator establishes a stunnel to that phone, after which it can receive and make phone calls through the ShoreTel system. The stunnel remains in place until the phone sets the VPN parameter to off or the Concentrator times out all stunnel connections.

Establishing a stunnel requires an available VPN phone license. If the number of active stunnels equals the number of available licenses, the VPN Concentrator will not establish new stunnels until an existing stunnel is disconnected.
Phone Calls

After a stunnel is established from the ShoreTel IP phone to the Concentrator, VPN phone calls are performed from the ShoreTel IP Phone in the same manner as if the phone is located on the same LAN as the VPN Concentrator. The VPN Concentrator manages the connection from the phone to the ShoreTel system.

Implementation

Implementing ShoreTel VPN phones involves the following high-level steps:

1. Installing the VPN Concentrator
2. Modifying system settings in ShoreTel Director
3. Configuring the ShoreTel IP phone

The following sections describe the VPN phone implementation process.

Installing the VPN Concentrator

Refer to the VPN Concentrator 4500/5300 Installation and Configuration Guide for instructions on physically inserting the VPN Concentrator into the network. The guide also describes web browser pages that configure the VPN concentrator. The following sections describe the pages and fields that require configuration.

Initial Configuration

The VPN Concentrator is shipped with the pre-configured IP address 192.168.1.1 for the LAN port.

Accessing the VPN Concentrator Web Interface Pages

1. Assign static IP address 192.168.1.2 with subnet 255.255.255.0 to the Ethernet interface of the computer that is connected to the LAN port.
2. Launch a web browser on the PC and access the following URL:


3. Enter the following parameter values to log into the system:

   - Username – root
   - Password – default

Network Page

The Network page defines the IP address through which the VPN Concentrator is accessed. To access the Network page, select Network in the blue Configuration Menu on the left side of the page.
Enter the appropriate values in the following data entry fields:

- **LAN Interface Settings**: Enter the IP address by which other LAN devices will access the VPN Concentrator.
- **WAN Interface Settings**: Enter the IP address by which remote devices can access the VPN Concentrator.

### Stunnel Page

The Stunnel page specifies setup characteristics about the Stunnels that facilitate communications between the concentrator and the remote phones. To access the Stunnel page, select Stunnel in the blue Configuration Menu on the left side of the page.

Verify that the following parameters are set properly:

- Stunnel Enable is selected.
- Stunnel Server IP Address is set to the LAN address of the VPN Concentrator, as specified on the Network page.
- Stunnel Server Port Number is set to 443.

### Route Page

The Route page defines the static routes to networks or servers on the LAN. To access the Route select **System > Route** in the blue Configuration Menu on the left side of the page.

To add a static route:

1. Enter the subnet address and mask in the IP Network and Netmask data fields, respectively.
2. Enter the IP address that accesses the Gateway server of the added network.
3. Press the Submit button.

### Usernames’ List Page

The Username Configuration page defines the user accounts that are allowed Stunnel access to the VPN Concentrator. To access the Username’s List select **Stunnel > Username Database** in the blue Configuration Menu on the left side of the page.

To add a user account:

1. Enter the username and password for the user in the Username and Password data fields, respectively.
2. Re-enter the password in the Confirm Password data entry field.
   - The Password and Confirm Password data entry field contents must be identical.
3. Press the Submit button.
Modifying System Settings in ShoreTel Director to Support VPN Phones

ShoreTel Director assigns codecs on the basis of the site assignment of the ShoreTel IP phone’s IP address. Assigning the IP address block allocated to the VPN Concentrator to a specific site assures that the switch uses the proper codec when handling VPN Calls.

To set the IP address range:

1. Launch ShoreTel Director.
2. Click Administration > IP Phones > IP Phone Address Map.
   The IP Phone Address Map List page appears.
3. Click the New button.
   The IP Phone Address Map Info page appears.
4. In the Site Name field, select the VPN site.
5. In the Low IP Address field, enter the lowest IP address of the block allocated to VPN calls. The IP address must be valid for the network where the site is located.
6. In the High IP Address field, enter the highest IP address of the block allocated to VPN calls.
7. Click Save.

Note
Refer to Table 119 on page 788 for configuration recommendations for Emergency 911 related features on VPN phones.

Configuring ShoreTel IP Phones to Make VPN Calls

ShoreTel IP phones are manually configured to establish a stunnel with the VPN concentrator. After the phone is configured and placed on a WAN port (such as the internet), it attempts to communicate with the Concentrator. ShoreTel does not provide DHCP options for automatically setting these parameter values at startup.

The parameters to set are as follows:

- **VPN Gateway**: This parameter specifies the WAN IP address of the VPN Concentrator to which the ShoreTel IP phone connects. Default value is 0.0.0.0.
- **VPN Port**: This parameter specifies the port number of the VPN Concentrator to which the ShoreTel IP phone connects.
- **VPN**: This parameter, when set to On, enables VPN Phone on the ShoreTel IP phone. Default setting is Off.
- **VPN User Prompt**: This parameter, when set to On, programs the ShoreTel IP phone to prompt the user for a VPN user name after completing a power cycle.
- VPN Password Prompt: This parameter, when set to On, programs the ShoreTel IP phone to prompt the user for a VPN password after completing a power cycle.

- FTP: This parameter specifies the IP address of the RTP server from which the phone requests VPN Phone software upgrades. When set to the default value of 0.0.0.0, the phone solicits upgrades from the IP address of the VPN Gateway.

**Manually Configuring a ShoreTel IP Phone**

1. Press the Mute button, then enter SETUP#.

2. Enter the phone’s password, followed by #.

3. Press # to step through the phone options.

**Note**

SETUP translates numerically to 73887.

**Configuring the VPN User Name and Password**

The user name and password is stored in non-volatile RAM on the phone. Power cycling and normal phone operations have no effect on the stored name and password. The VPN Concentrator authenticates the ShoreTel IP phone when the phone attempts to establish a stunnel by verifying the phone’s username and password is included in the user accounts on the Usernames’ List page.

New ShoreTel IP phones are shipped with this memory location vacant. The first time a user power cycles the phone with the VPN parameter set to On, the phone prompts the user for a username and password. The phone prompts for these values if the VPN User Prompt and VPN Password Prompt parameters are set to On; otherwise, the ShoreTel IP phone continues using the previous memory contents when attempting to establish a stunnel.

**Configuring Simultaneous Ringing and Call Move**

Simultaneous ringing allows a ShoreTel user to configure up to two additional phones to ring in addition to their assigned phone. You can configure simultaneous ringing for a user from their user page in ShoreTel Director, or a user can configure it through ShoreTel Communicator. The feature can also be configured from some phone interfaces.

When the feature is configured, calls to the ShoreTel extension of the user ring the primary phone and all additional configured phones simultaneously. For convenience, the user can turn the feature on or off to stop the simultaneous ringing at any time.

Incoming calls to simultaneous ringing devices are presented as standard calls with standard ringtone. A ring delay can be configured for additional destinations that allows the preferred phone to ring first.

After a simultaneous ringing call is established, the user may move the call between the simultaneous ringing devices. The Call Move mechanism can be initiated through a ShoreTel IP phone soft key, a programmed button, ShoreTel Communicator, or star code *23.
Implementing Simultaneous Ringing

Administrators can enable simultaneous ringing through the Class of Service Edit Telephony Features Permissions page. Any ShoreTel user’s profile may be configured for simultaneous ringing. After a ShoreTel user’s profile is configured for simultaneous ringing, their extension becomes preferred. This preferred user can be configured as a standard system extension, external Extension Assignment, SoftPhone, VPN phone, third-party SIP phone, or Analog phone.

Modifying Class of Service

Before users can enable simultaneous ringing of their phones, you must first modify the default Class of Service to provide the necessary permissions.

1. Launch ShoreTel Director.
2. Click Administration > Users > Class of Service.
3. In the Telephony Features Permissions section, select an existing Class of Service feature set to modify or click Add New to create a new Class of Service.
   The Edit Telephony Features Permissions page appears.
4. Select the Allow External Call Forwarding and Find Me Destinations check box.
5. Select the Allow Additional Phones to Ring and to Move Calls check box.
6. In the Scope section, click a radio button to specify the type of calls on which to allow users of this class of service to use these features.
7. Click Save.

Configuring Simultaneous Ringing in ShoreTel Director

You can configure simultaneous ringing for a user through ShoreTel Director, and users can configure it through ShoreTel Communicator or the phone interface.

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
   The Individual Users page appears.
3. Click the name of the user whose profile you want to modify, or create a new user.
4. Click the Personal Options tab.
5. Click External Assignment and Additional Phones.
   The Find Me, External Assignment and Additional Phones page is displayed.
6. In the Additional Phones section, for each phone you want to configure do the following:
   a. For Ring Delay, in the drop-down list select the number of times the preferred extension should ring before the additional phones ring.
b. In the Phone section, click a radio button to indicate the additional destination you want to ring as follows:

- **None**
- **Extension**: Enter or select a ShoreTel extension.
- **External**: Enter the dialable number of an external phone.

---

**Note**
For details about device types allowed for additional extensions, see Other Considerations for Call Move on page 251.

---

c. In the **Number of Rings** field, enter the number of times you want the phone to ring before the call is rerouted.

d. In the **Activation** field, select the method the user is to use to answer calls:

- **Accept call by answering**: Requires the user to remove the phone from the hook and speak.
- **Accept call by pressing ‘1’**: Requires the user to press 1 on the phone to signal that they are answering.

7. Click **Save**.

---

**Disabling/Enabling Additional Phones**

Through ShoreTel Communicator or the phone interface, users can turn Additional Phones on or off as needed. Consult the ShoreTel Communicator documentation or the phone user guides for details.

---

**Implementing Call Move**

The ShoreTel system supports call move, which allows users to switch from one phone device to another without disrupting the conversation. For instance, if a user is participating in a conference call, the user can easily move the call from the desk phone to a cell phone and leave the office, without disrupting the conference.

---

**Call Move from an IP Phone or ShoreTel Communicator**

The user can move a call as follows:

- When the call is on the assigned phone and the user presses the Move soft key on the phone or uses the Move Call action in ShoreTel Communicator, the following events happen:
  - The call goes on hold. Simultaneous ringing on idle phone(s) lasts until the user picks up one of the phones. (The preferred phone does not ring.) Until the user picks up the call, the caller hears silence.
  - Additional phones start ringing with no ring delay.
  - Ringing on Additional phones stops after the user answers the call on the Additional phone.
When the user answers the Additional phone, the call is moved to that Additional phone.

- When the call is on one of the Additional Phones and the user presses the Move soft key on the assigned phone or uses the Move Call action in ShoreTel Communicator, the conversation is immediately switched to the assigned phone.

**Call Move Using Star Code on a Mobile Phone**

To activate Call Move, dial *23 (at the dial tone).

Simultaneously ringing idle phones ring until the user answers one of them. Until then, the caller hears silence.

Additional destinations will ring.

When the call is answered on the additional phone, the call is moved to the new device.

**Cancelling Call Move**

- Unhold the call, or execute *23 code again.
- If the Cancel is successful, the call is retrieved.

**Other Considerations for Call Move**

- Only SIP extension type phones (including the ShoreTel 400-Series IP phones), external numbers, or off-system extension (OSE) devices can be configured as additional devices.
- If a conference call is in progress, the call move operation is not allowed.
- Call Move pull functionality is not supported from additional destinations.
- Call Move push functionality is supported on SIP trunks only if they support DTMF signaling using SIP INFO.
- Call Move pull functionality is not supported from ShoreTel Communicator.
- The only supported star code sequences from additional destinations is *23.
- Communicator only displays calls on assigned phone.
- Call Move or Simultaneous Ringing on/off is not supported from ShoreTel Mobile Communicator.
- When OSE is configured as additional phone, care should be taken to make sure the call is directly placed to OSE and not AA.
- When a cell phone is configured as an additional phone, care should be taken to set the activation mode to ‘answer by pressing 1’ so that when the call is redirected to cell phone voicemail, other simultaneous ringing destinations do not stop ringing.
- If the preferred user is a workgroup agent, the WrapUp soft key is displayed instead of the AddOn/AddOff soft key (or the Add’l phone soft key on the IP485g). However, if the user receives a personal call (not a WorkGroup/Contact Center call), the Move soft key is displayed.
CHAPTER 9

Setting Call Control Options

This chapter provides information about configuring the system-wide call control features of the ShoreTel system. The topics include:

- Account Codes ................................................................. 255
- Account Code Collection .................................................. 256
  Adding and Editing Account Codes ..................................... 257
- Multi-site Account Codes ................................................ 258
  Implementation ............................................................... 258
  Usage ............................................................................. 258
  Configuring Multi-site Account Codes ................................ 259
- Bridged Call Appearances ............................................... 263
  Configuring BCA Parameters ........................................... 264
  Configuring Answer Options on an IP Phone ...................... 266
- Bridged Call Appearance Conferencing ............................. 268
  Answering and Joining the BCA Call ................................ 270
  Setting Up Conferencing Ability for BCA and SCA Users ...... 271
- Shared Call Appearance .................................................. 275
  SCA Feature Components .............................................. 275
  Enabling a User for SCA .................................................. 276
  Creating an Assistant Account ........................................ 279
  Usage Guidelines for SCA ................................................. 281
  Inbound and Outbound SCA Calls ................................... 282
  Blind Conferencing and the SCA User .............................. 283
- Silent Coach .................................................................. 284
  Operational Behaviors of the Silent Coach Feature ............ 284
Configuring Silent Coach Permissions ............................................................. 285
Enabling the Silent Coach Warning Tone ....................................................... 285
Configuring Silent Coach Buttons ................................................................. 286
Performing Silent Coach Operations ............................................................. 287
Hunt Groups ..................................................................................................... 289
  Setting the Hunt Group to Busy ................................................................. 293
Music on Hold ................................................................................................. 293
  Adding a Music on Hold Resource .............................................................. 293
  Editing a Music on Hold Resource ............................................................. 294
  Deleting a Music on Hold Resource ........................................................... 294
  Playing a Music on Hold Resource ............................................................ 294
Paging Groups ............................................................................................... 295
  Adding Overhead Paging to Paging Groups ................................................ 296
  Configuration .............................................................................................. 296
Multi-site Paging Groups .............................................................................. 298
  Paging Groups Operation ........................................................................... 299
  Configuring Paging Groups ....................................................................... 300
Priority Group Paging .................................................................................... 301
Pickup Groups ............................................................................................... 303
  Configuring Pickup Groups ...................................................................... 304
Route Points ................................................................................................. 306
  Parameters ................................................................................................. 307
Call Control Options ..................................................................................... 310
  Distributed Routing Service ...................................................................... 310
  Parameters ................................................................................................. 311
Bandwidth Management and Codec Negotiation ........................................... 314
  Codec Lists ................................................................................................. 315
  Codec Negotiation ..................................................................................... 317
  Adding, Editing or Deleting Supported Codecs ......................................... 317
  Working with Codec Lists ........................................................................ 319
Enabling Intersite Video ................................................................................ 321
Automatic Ringdown ...................................................................................... 321
  Dedicated Circuit Ringdown .................................................................... 322
  Phone Delayed Ringdown ...................................................................... 325
  Ringdown Implementation ....................................................................... 325
Media Encryption ........................................................................................... 330
System Support ............................................................................................. 331
Supported Platforms ...................................................................................... 331
Account Codes

Account codes are typically used to assist ShoreTel users in the billing of their clients. For example, if a law firm wants to keep track of the length of calls to their clients so that they may later bill those clients for services rendered, they can enter an account code that corresponds to that client before dialing the client's phone number. At the end of the call, the call length, time, and date are entered in a record, thus helping the firm to keep track of the calls made to each of their clients.

Account codes can vary in length and be flexibly formatted. You can configure the system to require users to enter an account code for outbound calls in a mandatory or optional fashion. In this way, the account code can also function to prevent unauthorized employees from dialing long-distance numbers.

ShoreTel supports wildcard characters in account codes. This enhancement allows the system to surpass the previous limit of 50,000 account codes so that an almost unlimited number of account codes can be supported. The wildcard character – a question mark – can be entered in place of DTMF digits in the account code.

The use of wildcards introduces less strict validation of the account code entered by the user. Rather than checking each individual code, a length check is performed instead. The introduction of wildcards into the account codes does not impact the ability of the system to assign an account code to individual clients.

You can create account codes with non-numeric characters, but these characters are discarded during code collection. The following table gives example account codes and shows how the Account Codes Service interprets the code.

<table>
<thead>
<tr>
<th>Sample Account Code</th>
<th>Recorded Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales 200</td>
<td>200</td>
</tr>
<tr>
<td>1001-3</td>
<td>10013</td>
</tr>
<tr>
<td>1.234A</td>
<td>1234</td>
</tr>
<tr>
<td>3000 Exec 2</td>
<td>30002</td>
</tr>
</tbody>
</table>

Account code collection is enabled on the basis of user groups, with the collection of account codes set to one of the following states:

- Disabled
- Optional
- Forced

For information about account codes and user groups, refer to Creating a User Group on page 352.

Call Detail Reports include details of account codes associated with outbound calling. Account Codes have a dedicated user group that defines the call permissions. When a user makes a call that requires Account Code service, the user’s user group defines the trunk access.
Account Code Collection

When account code collection is enabled or required for a user group, calls placed via the telephone or through ShoreTel Communicator are routed to the account code extension. The Account Codes Service prompts the user to enter an account code followed by the “#” key. If the account code entered does not match the digits in a stored account code, an explanation message is played and the user can enter an account code again. When a matching account code is collected, the call is placed according to the originally dialed number.

The call permissions define which dialed numbers will be directed to the Account Codes Service for user groups configured with account codes. For calls that are redirected to the account codes extension, the call will be completed with the trunk access and call permissions of the Account Codes Service.

This structure imposes two sets of permissions to outbound calls:

1. The call permissions for the user group of the user that places the call are used to determine whether an account code must be collected or not.

2. The call permissions for the Account Codes Service user group determines whether calls are finally placed or if the intercept tone is played.

Account code restrictions do not affect calls that are forwarded to external numbers. Instead, the Class of Service settings control the forwarding of calls to external numbers. For more information, see Specifying a Class of Service on page 337.

The Account Codes Service applies to the system extensions on the SoftSwitch that is running on the headquarters (HQ) server only. If the HQ SoftSwitch is not reachable by the originating ShoreTel voice switch, the call is processed according to the setting for the caller's user group.

Specifically, during loss of connectivity, the user group configuration determines the following call handling:

- For end users who have optional account code collection, the system places their calls.

- For users who have forced account code collection, the system automatically rejects their call attempts.

You can set up account codes for collaborative voice and data conferencing. Document sharing is a feature allowed in a 2-way or Make Me Conference call. Up to 20 documents can be dragged and dropped during the call. You can create associated project codes on the ShoreTel Service Appliance for tracking purposes.
Adding and Editing Account Codes

To configure the account code wildcard feature, use the following procedure:

1. Launch **ShoreTel Director**.
2. Click **Administration > Call Control > Account Codes**.

   The Account Codes page appears, as shown in **Figure 66**.

   ![Account Codes Page](image)

   **Figure 66: Account Codes Page**

   **Note**

   The Filter Account Code section lets you search for an existing account code by name or account code. To search, enter the beginning string of the name or account code in the Name or Account Code field and click **Find Now**. To display the entire list, leave both fields blank and click **Find Now**.

3. Click **New**.

   The Account Code Info dialog box opens (**Figure 67**).

   ![Account Code Info Dialog Box](image)

   **Figure 67: Account Code Info Dialog Box**

4. In the **Name** field, enter a name for the account code.
5. In the **Account Code** field, enter an account code.
Account codes can include up to 20 alpha-numeric characters and must include at least one digit. Digits are significant characters and may not be replicated as a particular string. For example, the system identifies 8888, p88q88, and abc8de8fg8hij8 as the same code: 8888.

6. Click **Save** to create the account.

7. To create another account, click **Next**.

Account codes are enabled on the basis of user groups. For more information, see Configuring User Groups on page 351.

---

**Multi-site Account Codes**

Many organizations need to track calls made to clients so that they can bill the clients for the time they spend on the call. The Multi-site Account Codes feature allows the ShoreTel Headquarters server, a Distributed Voicemail Server, or a ShoreTel voicemail switch to validate account codes. This feature benefits customers by distributing the processing of the account code validation load, thus eliminating any single point of failure for account codes validation. Account Codes is an easy-to-use tool that helps businesses identify and invoice for client calls.

Account code validation is performed by the Headquarters server by default. Outbound external calls are redirected to the Headquarters server for account code validation. Once the account code is validated, the call is redirected to the originally dialed external number.

The Multi-site Account Codes feature adds the capability of allowing a Distributed Voicemail Server or ShoreTel voicemail-enabled switch to validate account codes. In addition, if the Distributed Voice Server or ShoreTel voicemail-enabled switch is unavailable, the Account Code validation migrates to another ShoreTel server or ShoreTel voicemail-enabled switch (following the site’s hierarchy). This process helps account code validation to be more reliable in a multi-site environment.

---

**Implementation**

To successfully configure your ShoreTel system with Multi-site Account Codes, you must complete the following configuration activity:

- Change the System-wide Account Code Extension
- Change the Account Codes Local Extension for the Headquarters server
- Add the Account Codes Local Extension to the distributed voicemail server
- Add the Account Code Local Extension to the ShoreTel voicemail-enabled switch

---

**Usage**

To use Account Codes, the user picks up the phone and dials an external number. The call is redirected to a ShoreTel Server or ShoreTel voicemail-enabled switch, and the user is prompted to enter an account code. The person enters the account code and presses the # key. If the user enters a valid account code, the call is recorded in the database and redirected to the external destination. The ShoreTel system administrator can then run account code reports to show the time, date, and length of the call.
If the user repeatedly dials an incorrect account code, and the ShoreTel system administrator has configured the caller’s user group such that it is mandatory to enter an account code (Forced), the call will be dropped.

If the user repeatedly dials an incorrect account code, and the ShoreTel system administrator has configured the caller’s user group such that it is optional to enter an account code (Optional), the call will proceed to the external number, but it will not be recorded in the database and made available to Account Code reports.

### Configuring Multi-site Account Codes

To configure multi-site account codes, you need to:

- Review the system wide account code extension and change it if it conflicts with the existing dial plan.
- Change the account code local extension for the Headquarters server.
- Add the account code local extension to the DVS.
- Add the account code local extension to the voicemail-enabled switch.
- Change users’ call permissions to restrict outbound external calls.

### Changing the System-wide Account Code Extension

The system-wide Account Code Extension is populated by default when the ShoreTel software is installed on the Headquarters server. If the system-wide Account Code Extension conflicts with the existing customer dial plan, the administrator can change the Account Code Extension.

1. Launch ShoreTel Director.

2. Click **Administration > System Parameter > Systems Extensions**.

   The System Extensions edit page appears, as shown in **Figure 68**.
3. In the Account Code Extension field, change the extension.

4. Click Save.

### Changing the Account Code Local Extension for the Headquarters Server

The Account Code Local Extension is populated by default for the Headquarters Server only.

1. Log into ShoreTel Director.

2. Click on the Administration > Applications Servers > HQ/DVS.

   The HQ/DVS Servers page appears.

3. Select your headquarters server.

   The HQ/DVS Edit Servers page for the headquarters server appears, as shown in Figure 69.
In the Account Code Local Extension field, enter the account code that you want to use for the Headquarters server.

Adding the Account Code Local Extension to the Distributed Voicemail Server

The Account Code Local Extension is not populated by default for distributed voicemail servers (DVSs). The administrator must manually enter the extension.

1. Log into ShoreTel Director.

2. Click on the Administration > Applications Servers > HQ/DVS. The HQ/DVS Servers page appears.

3. Select the Distributed Voicemail Server to which you want to assign an account code. The HQ/DVS Edit Servers page for the DVS server appears similar to that shown in Figure 69 above.

4. In the Account Code Local Extension field, enter the account code that you want to use for the DVS server.

5. Click Save.
Adding the Account Code Local Extension to the ShoreTel Voicemail-enabled Switch

The Account Code Local Extension is not populated by default for ShoreTel voicemail-enabled switches. The administrator must manually enter the extension.

1. Log into ShoreTel Director.

2. Click **Platform Hardware > Voice Switches/Service Appliances > Primary**.

   The Primary Voice Switches/Service Appliances page appears.

3. Select a ShoreTel voicemail switch (50V or 90V) to which to add an account code local extension.

   The Edit Voice Switches page for the voice switch appears as shown in Figure 70.

4. In the Account Code Local Extension field, enter an account code for local extensions.

5. Click **Save**.

![Figure 70: Edit Voice Switch Page for Voicemail Switch](image)

**Additional Configuration Requirements**

Once the system has been configured to validate account codes, the ShoreTel system administrator must restrict the users’ call permissions so that outbound external calls are not permitted.
Bridged Call Appearances

A Bridged Call Appearance (BCA) is an extension that is shared among multiple users. A BCA has an internal extension number and call stack depth. Each user with the same BCA sees the same BCA extension number, and the number of calls that can reside on that BCA is its call stack depth. The maximum BCA stack size is 24.

Some characteristics of a BCA are as follows:

- It does not require a license.
- It is assigned to a ShoreTel voice switch.
- It supports Call Handling Mode.
- It cannot be controlled by a schedule.

A user answers a BCA call by pressing a ShoreTel IP phone button that is assigned to a BCA call stack position. Calls to a BCA occupy distinct call appearance buttons and are identified by their position in the call stack. ShoreTel IP phone buttons that answer calls are configured to handle calls to a specific call stack position of a BCA. A button can be programmed for each position in the call stack.

Example BCA Scenario

The system administrator configures a BCA with an extension of 118 and a call stack depth of 3. The ShoreTel IP phones of three users are configured to handle calls to the BCA as follows:

- User One has one button that answers calls from Stack Position #1.
- User Two has one button that answers calls from Stack Position #2.
- User Three has three buttons configured to answer BCA calls. The first button answers calls to Stack Position #1, the second button answers calls to Stack Position #2, and the third button answers calls to Stack Position #3.

The first incoming call to the BCA arrives on Stack Position #1. User Two cannot answer this call. A second call to the BCA will arrive on Stack Position #2 if the first call is still active. User One cannot answer that call. User Three is the only user that can answer calls that arrive on Stack Position #3.

When a call stack position on a BCA receives a call, the button on each phone configured for that stack position flashes green to indicate an incoming call. When the call is answered, the LED on the phone of the person that answers it turns solid green while the other BCA stack buttons are red (without BCA conferencing) or orange (when BCA Conferencing has been enabled for the BCA).

A user places a call from a BCA by pressing a programmed ShoreTel IP phone button. The LED on the outbound caller’s phone becomes solid green, and the buttons associated with the BCA stack position on all other phones become solid red. If the call is placed on hold, the button LED for the applicable call stack position on all phones indicates a call on hold.

Pressing the top-most BCA custom button for outbound calls does not necessarily access trunk 1. No one-to-one correlation exists between the custom buttons programmed for BCA extensions and a particular trunk. The system administrator can associate trunks with BCA extensions through a variety of approaches.
A caller ID number can be associated with a BCA. The following rules determine which caller ID number is displayed at the far end for an outbound BCA call:

- Outbound to an internal extension – the name and number of the user that initiated the BCA call is sent. If the user is “private,” the caller ID is blank.
- Outbound to an external number – the system sends the first number in the following list that is available:
  - Outbound caller ID number that is assigned to the BCA
  - DID number assigned to the BCA
  - External identification or caller ID number of the user who initiates the BCA call
- Outbound to an external emergency number (such as 911) – the emergency identification or the user’s CESID number is sent.

The system can be configured to display the caller ID on inbound calls. It can also be configured to enable, disable, or delay inbound call ringing.

Switch Support for Bridged Call Appearances

ShoreTel one-rack unit (1-U) Half Width and 1-U Full Width voice switches support BCAs with the following limits:

- Up to 24 BCA extensions can be configured on a switch.
- Up to 128 BCA extensions (on other switches) can be monitored.
- A maximum of 32 phones can be configured to point to the same BCA extension.

Configuring BCA Parameters

1. Launch ShoreTel Director.
2. Click Administration > Call Control > Bridged Call Appearances from the Main Menu.
   
The Bridged Call Appearance List page appears, as shown in Figure 71.

3. Click New (or select an existing BCA profile to edit).
   
The Edit Bridged Call Appearances page appears, as shown in Figure 72.
4. Set the parameters for the BCA profile as described below:

- **Name**: This field specifies the label by which other ShoreTel Director panels and ShoreTel devices identify the BCA.

- **Extension**: This field specifies the extension on which the BCA receives a call.

- **Backup Extension**: This field specifies the extension that receives calls for the BCA when the switch that supports the BCA is out of service.

  If another BCA serves as the Backup Extension, the two BCAs must be assigned to different switches.

- **DID**: This field specifies the DID number assigned to the BCA. See **DID Ranges** on page 178 for additional information about DID numbers and ranges.

- **DNIS**: This field specifies the DNIS information sent on outbound BCA calls.

- **Outbound Caller ID**: This field specifies the Caller ID number that the system sends on an outbound BCA call.
Note

When placing an outgoing call using the BCA call control option, the following rules are applied in determining the caller ID. For outgoing BCA calls, CID sent out is configurable through the registry setting:

```
KEY_LOCAL_MACHINE/SOFTWARE/ShorelineTeleworks/TelephonyManagementServer/Settings/
SwitchDebug/"debug_options send_bca_cid 0/1.
```

- If the registry is set to 0, the name and number of the user using the BCA are displayed. If the user’s private flag is set, then the caller ID is blocked or a “private” caller ID is displayed on the call.
- If the registry is set to 1, the name and number of the BCA are displayed. If BCA’s private flag is set, then the caller ID is blocked or a “private” caller ID is displayed on the call.

- **Include in System Dial by Name Directory**: When this parameter is enabled, the BCA extension appears on a ShoreTel IP phone display when the user presses the Directory button.

- **Make Number Private**: This parameter designates the BCA extension as Private. The Private setting is described in Private Numbers on page 444.

- **Switch**: This field specifies the ShoreTel voice switch to which the BCA is assigned.

- **Call Stack Depth**: This field specifies the number of calls that the BCA can simultaneously handle.

- **No Answer Number of Rings**: This field specifies the No Answer condition for a call to a BCA.

- **Call Forward Destination**: These fields specify the number that should receive inbound BCA calls that are not answered in either of the following situations:
  - **Call Stack Full**: This number receives calls that are unanswered when the BCA already has the number of calls specified by the call stack depth setting.
  - **No Answer**: This number receives calls that are unanswered after the number of rings specified by the No Answer Number of Rings setting.

5. Click **Save**.

**Configuring Answer Options on an IP Phone**

This section describes how to configure BCA buttons. Users answer BCA calls by pressing the green-flashing button. BCA buttons are configured to answer calls at a specific stack position of a BCA extension.
**Note**

IP phone buttons can also be configured so that a BCA call is answered when the user lifts the handset or presses either the speaker or headset button.

1. Launch ShoreTel Director.

2. Select **Administration > Users > Individual Users** from the Director menu.

   The Individual Users page appears.

3. Select the user you want to configure with BCA capability.

   The Edit User page appears.

4. Click the **Personal Options** tab.

5. Click **Program IP Phone Buttons**.

   The Program IP Phone Buttons page appears.

**Note**

To use the phone button profile of another user to configure the current user, click **Copy**.

6. In the Device Type field, select the device that the user will use to answer calls.

7. In the first function field, select **All** or **Telephony**.

8. In the second function field, select **Bridged Call Appearance**.

   The Bridged Call Appearance options appear in the Target pane, as shown in Figure 73.

![Program IP Phone Buttons](image)

**Figure 73: BCA Parameters in Program IP Phone Buttons Page**

9. Set the BCA IP phone button parameters as follows:

   - **Extension**: This parameter identifies the BCA to which the button responds.
- **Call Stack Position**: This parameter specifies the individual calls to the BCA extension that the IP Phone Button can access.

- **Ring Delay Before Alert**: This parameter specifies the number of inaudible rings for an inbound call on the IP phone before the ringing on the phone becomes audible. Valid settings include:
  - **None**: No delay—starting with the first ring, the phone rings audibly.
  - **1, 2, 3, or 4**: The phone begins playing the audio alert after this number of rings.
  - **Don’t Ring**: The phone never plays the audio alert.

- **Show Caller ID on Monitored Extensions**: This option specifies when the caller ID for the inbound call appears on the extension. Choices are Never, Only When Ringing, and Always. The Always choice means the caller ID remains during the conversation.

- **Enable Auto-Answer When Ringing**: The impact of this option is as follows:
  - When this option is selected, the inbound BCA call is answered when the user either presses the IP phone button, takes the handset off-hook, presses the speaker button, presses the headset button, hook-flashes, or presses an unused call appearance button.
  - When this option is not selected, the inbound BCA call is answered when the user presses the IP phone button programmed for the BCA or presses the Answer button.

- **No Connected Call Action**: These radio buttons program the phone’s ringdown behavior as follows:
  - **Answer Only**: Select this option to disable ringdown.
  - **Dial Tone**: Select this option to configure the phone as the recipient on a ringdown circuit.
  - **Dial Extension**: Select this option to configure the button as the initiating end of a ringdown circuit when the recipient is an IP phone on the ShoreTel network.
  - **Dial External**: Select this option to configure the button as the calling end of a ringdown circuit when the recipient is a device that is not on the ShoreTel network.

Refer to **Configuration Pages in ShoreTel Director** on page 326 for more information about configuring Ringdown.

10. Click **Save**.

---

**Bridged Call Appearance Conferencing**

This section describes BCA conferencing. BCA conferencing is available to regular BCA users and SCA users (and their assistants).

Bridged Call Appearances are set up to be private by default, so a BCA or SCA user with a call in progress cannot be joined by other BCA users on the same extension. However, the default setting can be changed to allow others to join, and an override on the phone lets the owner of the call lock or unlock the conference regardless of the default.
When a call is made to the BCA line, the flashing orange BCA button turns green when the user answers the BCA call. Other BCA users see either of the following on this line:

- A solid orange LED if conferencing is allowed: If the button is orange, the BCA user can press the button to join the BCA call in progress.
- A solid red LED if conferencing is disallowed: If the button is red, users cannot join the active BCA call unless the owner of the call presses the Unlock button on his or her phone.

Figure 74 on page 269 shows an outside call to a BCA line.

With permission, a BCA user can join the active BCA call by pressing the orange BCA button on the phone. Figure 75 on page 271 shows that other BCA users have joined a BCA call. In Figure 75, note that the caller directly connects to the original BCA users’ ShoreTel IP phone. The phone of each additional BCA user is transferred to a ShoreTel voice switch with available Make Me Conference ports that directly connects each additional BCA user.

![Bridged Call Appearance Call](image)

*Figure 74: Call to a Bridged Call Appearance*
Answering and Joining the BCA Call

When a call comes in to a BCA line, the color of the BCA button indicates if the BCA call is ringing, has been answered, is private, or allows conferencing.

- When the BCA line is ringing, the BCA button programmed on each ShoreTel IP Phone blinks green.
- The first user who picks up the line sees a solid green button labeled for the BCA.
- Other users of the BCA see either an orange or red button, as follows:
  - If the button is orange, the user can press the button to attempt to join the call. If enough Make Me Conference ports are available and the maximum number of allowed conferenced parties has not been reached, the user is added to the active bridged call.
  - If the BCA button is red and the user presses the button, an error message displays on the phone and the user is not able to join the conference call.
Setting Up Conferencing Ability for BCA and SCA Users

The BCA conference parameters for either the SCA or regular BCA users are located at the bottom of the Edit Bridged Call Appearance page.

For the selected BCA user, the entire window is active. For an SCA user, only the conference area of the BCA edit window is activated. The reason is that BCA parameters for the SCA user are inherited from the SCA account. Therefore, the rest of the BCA configuration window remains inactive (grayed out).

Specifying Conferencing Settings for a Regular BCA User

This section describes how to enable conferencing for a regular BCA user. The configuration consists of the enable, default privacy setting, and the enable of a tone that sounds when another party joins the conference.
To override the default privacy setting for the current BCA call, press the Lock/Unlock soft key on the ShoreTel IP phone (with the green LED). The text above the soft key describes the action to be applied to the active call. (The soft key text label toggles between Lock and Unlock.) For example, to make the call private, the user with the call presses the Lock soft key. To make the call available for conferencing, the user presses the Unlock soft key.

**Note**
For more information on assigning BCA to IP phone buttons, see Configuring Answer Options on an IP Phone on page 266.

1. Log into ShoreTel Director.
2. Click **Administration > Call Control > Bridged Call Appearances**.
   
   The Bridged Call Appearance List page appears, as shown in Figure 77 on page 274.
3. Click the **New** button or click an existing Bridged Call Appearance profile.
   
   The Edit Bridged Call Appearance page appears, as shown in Figure 76 on page 273.
4. Select the **Allow Bridged Conferencing** check box to enable the BCA conference facility for an SCA user or regular BCA users.
5. In the Default Privacy Setting section, do one of the following:
   
   - Select the **Other Parties Can't Join** radio button to designate that privacy is initially enabled for active BCA calls. Other users of the BCA are restricted from joining the active call. This is the default behavior.
   - Select the **Other Parties Can Join** radio button to designate that the privacy feature is not initially enabled for active BCA calls. Other users of the BCA are allowed to join the active call.
6. Select the **Provide Tone When Parties Join** check box if you want a tone to sound when a party joins the BCA conference.
7. Click **Save**.
8. Assign the BCA to the appropriate ShoreTel IP phones. For more information on assigning the BCA to IP phone buttons, see Configuring Answer Options on an IP Phone on page 266.
9. Configure the appropriate number of Make Me Conference ports on a ShoreTel voice switch that is available to the site.
Enabling the BCA Conference Ability for an SCA User

Editing the Bridge Conference Appearance page lets you:

- Enable the executive’s conference ability
- Set the privacy default (the default for permitting or locking out other users)
- Enable the join-in tone

The SCA user always owns the conference call and can decide when other BCA users are admitted to the conference. An SCA user can override the default privacy setting by toggling the Lock/Unlock soft key on the phone.

1. Launch ShoreTel Director.

2. Click Administration > Call Control > Bridged Call Appearances.

Figure 76: Edit Bridged Call Appearance
The Bridged Called Appearances List page appears. (See Figure 77 for an example of a Bridged Call Appearances List that includes SCA users.)

SCA users are differentiated in the list using the format `<first name>_<last name>_<extension>`, where

- `first name` represents the first name of the user.
- `last name` represents the last name of the user.
- `extension` represents the user’s extension (for SCA or regular BCA user).

3. Click the SCA user name in the Name column.

The Edit Bridged Call Appearance page appears, as shown in Figure 76 on page 273.

4. Check the Allow Bridged Conferencing check box.

The default privacy choice and the join tone are enabled.

5. In the Default Privacy Setting section, do one of the following:

   - Select the Other Parties Can’t Join radio button to designate that privacy is initially enabled for active BCA calls. Other users of the BCA are restricted from joining the active call. This behavior is the default.
   - Select the Other Parties Can Join radio button to designate that the privacy feature is not initially enabled for active BCA calls. Other users of the BCA are allowed to join the active call.

6. Check the Provide Tone When Parties Join check box to have a tone sound when a party joins the BCA conference.

7. Click Save.
Shared Call Appearance

The Shared Call Appearance (SCA) feature provides call appearances that are shared between an executive (the SCA user) and an assistant (configured as a regular BCA user). The assistant can monitor the SCA user’s call appearances to facilitate call handling and conferencing needs. With SCA, an assistant can help executives with their communication needs by making or answering calls on behalf of the executive and by setting up phone conferences. The assistant is not restricted to supporting an executive and can receive other telephony capabilities through ShoreTel Director. The system has the flexibility to support multiple executives and assistants for different call-handling arrangements.

For telephone conferences, the SCA user and assistant have the following:

- BCA conferencing
- Blind conferencing
- Regular conferencing abilities that all IP phone users have

BCA conferencing lets an assistant or executive set up conference calls so that when the executive is ready he or she can enter the conference by pressing the SCA button on the IP phone. The assistant can stay in the conference, leave the conference, or be locked out of the conference by the executive.

SCA relies on BCA as an underlying technology to support its functionality. All IP phone models except IP420, IP115 and IP110 support SCA. Analog phones do not support SCA.

SCA Feature Components

This section describes the main feature components of SCA. It divides components into different non-conference and conference-related areas.

Associated Bridged Call Appearance

An Associated Bridged Call Appearance (aBCA) is a bridged call appearance that is associated with an executive extension. Associated BCAs differ from other BCAs as follows:

- In ShoreTel Director, an aBCA is specified in the Edit User page instead of the Bridged Call Appearance page.
- aBCAs are created when a ShoreTel extension is converted to an executive extension.

Non-conference Functionality

When a regular user is enabled for SCA, the system automatically creates an associated BCA (aBCA) and gives it an aBCA extension number.

Nearly all the BCA parameters that could be selected for the regular BCA user are fixed. Only the label for each SCA button can be specified.
The settings for SCA IP programmable buttons are fixed at the following values:

- Ring Delay before Alert: None
- Show Caller ID on Monitored Extensions: Always
- Button push actions default: (unused)
- No Connection Call Action: Dial tone
- Call Stack Position: Automatically ordered (no manual ordering allowed)

The SCA call stack positions are automatically set and not manually configurable in ShoreTel Director. However, call stack positions are automatically reordered if a button is specified to be other than an SCA. The SCA buttons are reconfigured around the new button type.

**Note**

For a button box, the system does not auto-shift call stack positions.

When a regular user is enabled for SCA, each regular call appearance converts to an SCA. Standard call appearances do not exist for the SCA user, and no SCA button can be converted back to a regular call appearance unless the SCA configuration is removed by disabling SCA.

**BCA Conference Parameters**

The BCA conference parameters are configured in the Call Control > Edit Bridged Call Appearances window for a specific BCA or aBCA. For a description of the conferencing setup for an SCA user, see Enabling the BCA Conference Ability for an SCA User on page 273. The conference parameters are:

- The Allow Bridged Conferencing setting
- The Default Privacy setting—an enable for letting other BCA users join the conference (can be overridden by the executive user on a per-call basis)
- A tone that sounds when a party joins a conference

**Enabling a User for SCA**

This section first introduces the program flow for specifying an SCA user configuration and then gives the steps for this task. The other, standard configuration tasks for a user are described in Chapter 10, Configuring Users on page 335.

**Program Flow for Configuring SCA Users and BCA Conferencing**

This section outlines a sequence of steps that a system administrator might follow to set up a new SCA user and assistant and enable BCA conferencing. The purpose of this outline is to promote smoother execution of the configuration steps. Readers who are already very familiar with BCA and SCA can go directly to the steps for specifying the accounts for SCA users and assistants as well as BCA conferencing for the executive.

In general, the configuration flow for creating an SCA user is as follows:
A system administrator navigates to **Users > Individual Users**, selects a site in the drop-down scroll box labeled “Add new user at site:” in the upper left corner, and clicks the GO button next to that scroll box.

After configuring and saving the user account basics—thus creating a regular user account—the system administrator enables Shared Call Appearances in the lower half of the Edit User (General) window. For a new user, the basic user parameters must be saved before Director activates the Shared Call Appearances enable. This requirement is also pointed out in the pertinent configuration step.

When Shared Call Appearances is enabled, the system automatically creates and numbers an associated BCA (aBCA) for the SCA.

The system automatically generates the aBCA extension number and displays it in the Associated BCA box within the Edit User window. The system administrator can change the generated number, for example, according to network planning guidelines that mandate such numbers exist in a certain range (for resource management purposes).

---

**Note**

Once saved, an SCA user’s aBCA extension cannot be changed unless Shared Call Appearances is disabled for the user.

---

The aBCA is deleted if the system administrator reverts the SCA user back to a normal user by clearing the user’s Shared Call Appearances check box in the Edit User panel.

---

**Note**

Before the Shared Call Appearances check box can be cleared, certain programmed items must be cleared. The system administrator must clear:

- All of the assistant’s IP buttons that monitor the executive’s aBCAs
- The assistant’s Communicator toolbar programming for monitoring the executive’s aBCA (if present)

In summary, implementation tasks for a new SCA user and regular BCA user (assistant) have the following sequence:

1. Create the new regular user account that is intended for the SCA user.
2. Convert the new user to an SCA (executive) user by enabling SCA.
3. Configure the IP phone buttons that the SCA user’s account calls for.
4. On the Bridged Call Appearances page, enable conference ability, select the default privacy setting, and enable the join-tone for the executive. (For details on these parameters, see Setting Up Conferencing Ability for BCA and SCA Users on page 271.)
5. Create a new regular BCA user to have an assistant’s phone setup; configuration includes the executive’s extensions that the assistant monitors. For details, see Creating an Assistant Account on page 279.
Creating a New Executive User

The configuration tasks in this section apply to a new executive (SCA) user and a new administrator (regular BCA) in a subsequent section. Other types of steps for configuring a new user apply to the executive and administrator accounts, but they are largely omitted here. For details on user accounts, see Chapter 10, Configuring Users on page 335.

Creating a user with the SCA user:

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
3. In the Add new user at site field, select the site for the new user, and then click Go.

   The Users-Edit Users page appears, displaying some defaults that are specific to the site and the server.
4. In the First Name and Last Name fields, type a first and last of the new user. (As a subsequent step shows, ShoreTel Director displays first name, last name, and extension number in a specific format.)
5. In the Access License field, select Professional or Operator. (ShoreTel Communicator requires the Operator license to display the BCA Window.)
6. In the Primary Phone Port section, click the IP Phones radio button and select a specific phone in the drop-down list. (If an IP phone model of sufficient capability is not recognizable in the list of MAC addresses, the right phone can be determined by matching the IP phone model number to a MAC address in Administration > IP Phones > Individual IP Phones.)
7. Check the Shared Call Appearances check box.
8. In the Associated BCA, enter a number for the extension.

   The next available extension number is automatically generated when Shared Call Appearances is enabled. The number can be changed. If the system administrator has an organized scheme for extension numbers, manual entry is a logical choice. A manually entered alternative could be valuable if an auto-generated number is outside the number management scheme and, therefore, possibly confusing.
Creating an Assistant Account

The steps in this section focus on configuring a regular BCA user to monitor the executive’s call appearances. The description omits many common details for configuring a regular user. For these details, see Chapter 10, Configuring Users on page 335.
After creating the assistant as a regular BCA user in Edit Users, the system administrator proceeds with configuring the assistant to monitor the executive’s phones, as follows:

1. Save the regular user parameters in the Edit User > General tab.

2. Select the Personal Options tab.

3. Click the Program IP Phone Buttons link.

   The Program IP Phone Buttons page appears.

4. In the Device Type field, select the type of device the assistant uses.

5. In the first function field, select All or Telephony.

6. In the second function field, select Bridged Call Appearance. The Bridged Call Appearance options appear in the Target pane.

   BCA parameters for assistant-monitoring of an executive’s call appearances are available, but the executive’s aBCA first must be selected after a search for it.

7. Click the Search button.

   The Dialing Numbers-Webpage Dialog appears.

8. Select an aBCA with whom to associate the assistant. aBCAs are listed using the format: <first name>_<last name>_<extension>.

9. Configure other BCA parameters as needed. (For more information about BCA parameters, see Configuring Answer Options on an IP Phone on page 266.)

10. Configure other call appearance buttons as needed for this executive (or for other executives after searching the same pop-up window described in Step 7).

11. Repeat as needed the configuration steps for each executive call appearance.

**Note**

Making all the executive’s call appearances visible to the assistant is not required: If an executive wants one or more lines to be invisible to the assistant, the administrator omits the requested number of hidden lines from the assistant’s configuration.

The No Answer Number of Rings and Call Forward Destination parameters reflect the initial values of these parameters. However, the real-time state of these parameters can change, based on the activity of the user. For a regular BCA user, these parameters are editable in the BCA window in ShoreTel Director. In contrast, for an SCA user (tied to an aBCA), these parameters are grayed out in the window because the SCA user inherits the parameters when the system creates the aBCA. Thereafter, if the SCA user is changing these parameters in real time, the changes are actually inherited in the aBCA, but the BCA page in Director is not updated to reflect the changes. Put another way, ShoreTel Director continues to reflect the initial value of these two SCA parameters.
12. Click **Save** when the configuration is complete.

Usage Guidelines for SCA

This section contains SCA usage scenarios and suggestions.

**Note**

When an executive extension is routed to a phone that does not have programmable buttons, the executive extension behaves as a normal extension. Eventually, when the executive’s calls are routed to a phone with programmable buttons, the behavior of the extension reverts back to an executive extension.

Bridged Call Appearance Monitoring

The Bridged Call Appearance Monitor is a ShoreTel Communicator window that displays all Bridged Call Appearances accessible to the user’s extension through all devices assigned to the user. The BCA Monitor consolidates all of a user’s aBCA activity into a single panel.

The Bridged Call Appearance Monitor is available in ShoreTel Communicator only if the Access License for the user is Operator.

In ShoreTel Communicator, because calls are tracked as BCA calls in the BCA monitor window, the active call cell disappears when a call is put on hold, and the held call can be viewed only in the BCA monitor window.

aBCA is hidden in the phone directory list so that users do not accidently call an aBCA instead of the executive. However, as with regular BCAs, the system administrator can configure an aBCA as the destination of a trunk group or the targeted extension of a programmable button function. The system administrator has the discretion to decide how to use aBCA.

Placing an executive extension call on hold parks the call on the aBCA. Held calls on an executive extension are viewable in the Bridged Call Appearance Monitor in ShoreTel Communicator or in the IP phone display.

Assistant Users

Assistant accounts need no special configuration for the monitoring of the executive’s call appearances other than the assignment of programmable buttons for IP phones. However, for monitoring of executive call appearances in ShoreTel Communicator, the assistant’s Access License must be Operator.

Hotline

A typical SCA setup includes a hotline circuit between an executive and assistant. They use a hotline circuit to communicate requests, responses, and status of calls.

To land a call on a hotline button for intercom or speed dial, both parties must have a hotline-programmed button. In the absence of this programming, the offered call is processed as a regular call.
Hotline calls and Extension Monitor calls to an executive extension that are picked up are not bridged. For details on how to configure a hotline button, see Copying Programmable Button Configurations on page 237.

**Note**
A hotline intercom call uses the intercom permissions of the user. Therefore, the rules that apply to that user’s regular intercom call also apply to a hotline-intercom call.

### Inbound and Outbound SCA Calls

This section describes the typical actions that executives and assistants take when the assistant takes a call on behalf of an executive and when the assistant places a call on behalf of the executive. In this section, blind conferencing is not used. Examples of blind conferencing are provided in Blind Conferencing and the SCA User on page 283.

#### Assistant Support for Inbound Calls

The following scenario describes a typical sequence of actions when an assistant takes a call on behalf of an executive.

1. The inbound call triggers a flashing orange light on the IP phone of both the assistant and the executive. If the Access License of the executive and assistant is Operator, ShoreTel Communicator also signals the incoming call. (The executive could just pick up the call and preempt the assistant’s involvement with this call.)

2. The assistant answers the call on the flashing BCA button and could, for example, get the caller’s name and purpose.

3. The assistant puts the call on hold.

**Note**
The executive call timer is reset if the executive puts the call on hold.

4. The assistant presses the hotline button shared with the executive.

5. The assistant tells the executive of the call in progress (on hold) and gives pertinent information about the call.

6. The executive picks up the call by pressing the flashing orange SCA button.

**Note**
Internal users who call an executive see the called party ID aBCA while the phone is ringing and the actual executive number after the call is picked up.
Assistant Support for Outbound Calls

The following scenario describes a typical sequence of actions when the assistant sets up a call for the executive.

1. The assistant accesses one of the executive’s call appearances by pressing an appropriate IP phone or ShoreTel Communicator button.
2. The assistant calls the intended recipient of the executive’s call.
3. The assistant places the called party on hold.
4. The assistant presses the hotline button to the executive.
5. The assistant tells the executive of the call in progress (on hold) and provides information about the call as needed.
6. The executive takes the call by pressing the flashing orange button that the assistant has identified.

**Note**

An executive extension’s redial list shows only outbound calls.

Blind Conferencing and the SCA User

This section illustrates blind conferencing and the SCA user in two contexts. In one situation, the assistant receives a call on behalf of the executive while the executive is already on a call. In the other context, the executive is on a call but then asks the assistant to call someone and conference the called party into the existing call.

Blind Conferencing of an Inbound Call

1. The executive is currently on a call with party number one.
2. The assistant receives a call from a second party.
3. The assistant determines that the executive is on a call and wants the second party to join the executive’s call.
4. The assistant hotlines the executive to say that the second party is on the line and ready to join the call.
5. The hotline call ends, and the executive is connected back to party one, and the assistant is connected back to party two.
6. The assistant initiates a conference and selects the executive’s call into which party two must join. After the conference connection is completed, parties one and two are in the same call.
Blind Conferencing of an Outbound Call

1. The executive is on the phone with party one and uses the hotline to ask the assistant to bring another party into the call.
2. The executive goes back on-line with party one.
3. The assistant calls party two.
4. The assistant hotlines the executive to say that party two is ready to join.
5. The assistant adds party two by initiating the blind conference and then pushing the button for the executive’s active call appearance.

Silent Coach

Silent Coach is a client feature that lets a user (the initiator) intervene in another user’s active call and communicate with that user (the recipient). The initiator can speak to the recipient and listen to all other call participants on the call. The recipient is the only call participant that can hear the initiator.

The right to use Silent Coach is set by the system administrator. The system administrator also specifies the users (recipients) whose calls the initiator can monitor. A Telephony Class of Service (COS) assigns Silent Coach rights. Silent Coach can be initiated through various ShoreTel IP Phone models or through ShoreTel Communicator.

Operational Behaviors of the Silent Coach Feature

The following are details about Silent Coach Behavior:

- Silent Coach lets the initiator switch between Silent Monitor, Barge In, and Silent Coach functions for the same call.
- Silent Coach sessions can be initiated through ShoreTel IP Phone or ShoreTel Communicator programmable buttons, ShoreTel Communicator menu options, and star code calls from other calling devices.
- The initiator of a Silent Coach session can change the session to a Silent Monitor or Barge In session. Silent Monitor sessions can be changed into a Silent Coach sessions.
- The recipient can place the original call on hold to engage in a two-way conversation with the Silent Coach initiator. At the end of this conversation, the user can resume or terminate the original call.
- Silent Coach cannot be initiated with users who are on conference calls.
- A call with an active Silent Coach session cannot be transferred or converted to a conference call.
- The recipient cannot record calls while Silent Coach is active.
Configuring Silent Coach Permissions

Silent Coach access is controlled through Telephony COS settings. Permissions for monitoring calls or having calls monitored are configured through the Silent Monitor / Silent Coach option on the Telephony Class of Service Edit panel. To configure Silent Coach for a Telephony Class of Service:

1. Launch ShoreTel Director.
2. Click Administrator > Users > Class of Service.
3. In the Telephony Features Permissions section, click the feature profile that you want to configure or “Add new” to create a new feature profile.

   The Edit Telephony Features Permission page appears.

4. Scroll down to the Silent Monitor / Silent Coach Other’s Calls section and do the following:
   - Check the Allow Initiation check box.
   - In the Accept section, select one of the following radio buttons with the permission you want users with this COS to have to monitor calls:
     - **None**: Select to not allow users to monitor calls.
     - **All**: Select to allow users to monitor all calls.
     - **From Only**: Select this option to allow users to monitor specific call participants. In the From Only field, select the only participant for whom calls are monitored.

5. Click Save.

Enabling the Silent Coach Warning Tone

ShoreTel provides an option for playing a Silent Coach Warning Tone to all call participants when a Silent Coach session is initiated and if the Silent Coach Warning Tone option is enabled. The Warning Tone setting applies to all Silent Coach sessions on the system. When a user transitions between Silent Coach and Silent monitor, the warning tones start/stop are based on the silent coach or silent monitor warning tone setting.

1. Launch ShoreTel Director.
2. Click Administration > Call Control > Options.

   The Call Control Options Edit page appears.

3. Check the Enable Silent Coach Warning Tone check box.

Note

The following devices do not support session transitions, coach consulting, and coach resumption.

- Analog phones
- IP110
Configuring Silent Coach Buttons

ShoreTel IP Phone and ShoreTel Communicator programmable buttons can be configured to initiate a Silent Coach session with a specific user or to query the caller for a Silent Coach destination. The configuration processes for ShoreTel IP Phone and ShoreTel Communicator programmable buttons are almost identical.

Configuring an IP Phone button to initiate Silent Coach:

1. Launch ShoreTel Director.
2. Click **Administration > Users > Individual Users**.
   The Individual Users page appears.
3. Select the user that you want to be able to initiate the silent coach feature.
   The Edit User page appears.
4. Click the **Personal Options** tab.
5. Click the **Program IP Phone Buttons** link.
   The Program IP Phone Buttons page appears.
6. For the IP phone button that you want the user to use, select **All** or **Telephony** in the first Function field.
7. In the second Function field, select **Silent Coach**.
   The Target pane in the Program IP Phone Buttons page appears.
8. In the Long Label and Short Label fields, type a label to appear next to the button on the phone LED display to remind the user of the button’s function. (For details about labels, see Configuring Programmable Buttons through ShoreTel Director on page 237.)
9. To program the button to monitor the calls of a specific user, enter the user’s extension in the Extension field.

---

**Note**

If this field is left blank, pressing the IP phone button prompts the initiator to enter a number in the Telephone User Interface before the session begins.

10. Click **Save**.
Performing Silent Coach Operations

A user can initiate silent coach functionality through any of the following methods:

- ShoreTel Communicator programmable button
- ShoreTel Communicator menu option
- ShoreTel IP Phone programmable button
- On any phone, enter *22 and the target extension.

Initiating Silent Coach Operations with ShoreTel Communicator

ShoreTel Communicator supports two methods of initiating Silent Coach operations – from menu options and by pressing a tool bar button.

Performing a Silent Coach from a ShoreTel Communicator Menu

1. Perform one of the following:
   - Click the Application Button, then select Dial > Silent Coach.
   - Select Dial > Silent Coach from the main menu.
   - Right click the System Tray ShoreTel icon select Dial > Silent Coach.

   ShoreTel Communicator displays the Silent Coach dialog box.

2. Enter an extension or select an item from the drop-down list.

3. Click the Silent Coach button at the bottom of the panel.

Performing a Silent Coach from a ShoreTel Communicator Tool Bar Button

1. Press the programmable Silent Coach button.

   ![Note]

   - If the button specifies a Silent Coach recipient, the system immediately initiates a Silent Coach session with that user. Skip the remaining steps.
   - If the button does not specify a Silent Coach recipient, ShoreTel Communicator displays the Silent Coach dialog box. In this case, continue to the next step.

2. Enter an extension or select from the drop-down list.

3. Click the Silent Coach button.

Transitioning a Silent Coach Session into a Silent Monitor or Barge In Session

- Right click the call cell and select the desired session type on the context menu.

  Figure 78 displays the context menu during a Silent Monitor Session.

- If available, press the Monitor or Barge In programmable button.
Figure 78 displays Silent Monitor, Silent Coach, and Barge In programmable buttons.

The same process transitions a Silent Monitor session into a Silent Coach session.

**Initiating Silent Coach Operations with ShoreTel IP Phones**

To perform a Silent Coach from a ShoreTel IP Phone programmable button, press the Silent Coach button.

- If the button specifies a Silent Coach recipient, the system immediately initiates a Silent Coach session with that user. Disregard the remaining steps.
- If the button does not specify a Silent Coach recipient, enter the recipient’s name or number in the Telephone User Interface.

ShoreTel Communicator displays the Silent Coach dialog box. In this case, continue to the next step.

**Performing a Silent Coach from any system phone,**

- Enter the \*22 code, followed by the number of the target extension.
ShoreTel phones display soft key options while a Silent Monitor option is active.

Soft key options available to the Silent Coach initiator:

- **SilMon**: Transitions the session into a Silent Monitor session
- **Barge**: Transitions the session into a Barge In call.
- **Show**: Displays all call participants in the Telephone User Interface
- **Hangup**: Terminates the Silent Monitor session.

The soft key options available to the Silent Coach recipient are as follows:

- **Consul**: Places the active call on hold and establishes a two-way voice path with the Silent Coach initiator.
  
  While the recipient consults with the initiator, soft key options include:
  
  - **Resume**: Restarts the recipient's original call.
  - **Show**: Displays all of the call participants.
  - **HangUp**: Terminates the call.

- **Show**: Displays all call participants in the Telephone User Interface.
- **Hangup**: Terminates the Silent Monitor session.

### Hunt Groups

The Hunt Groups list page is shown in [Figure 79](#).

![Hunt Groups List Page](image)

**Figure 79: Hunt Groups List Page**

Clicking on a group name shows the details for the hunt group, as shown in [Figure 80](#).
Hunt groups allow a call to be offered to a limited set of user extensions with no reporting, queuing, sophisticated schedules, log-in, log-out, or wrap-up states. Each hunt group is composed of an ordered list of no more than 16 users. A maximum of 8 hunt groups totalling no more than 16 members can be assigned to a single switch. If your requirements are more complex, you should use workgroups.

*Figure 80: Configuring Hunt Groups*
Rather than being reliant on the Headquarters server, a hunt group can be assigned to the switch closest to the agents and/or trunks associated with it. The switch controls the hunting, with no dependency on the server. Hunt groups have an extension number and, optionally, can also have a DID and/or DNIS number. They can be call forward extensions for users, workgroups, route points, personal assistants, site fax redirect extensions, site operator extensions, and the target for trunk groups. They are also allowed as the backup destination for workgroups and route points. This can be useful to allow some basic call handling when the workgroup server is not reachable.

The caller ID displayed for a hunt call is the external caller's ID.

A user may belong to more than one hunt group. In addition, a user assigned to a workgroup may also be assigned to hunt groups. Each call is hunted as a new call; that is, if the hunt mode is top down, each new call begins hunting from the top of the list. In this case, the person at the top of the list will get most of the calls.

### Hunt Group Parameters

**Required Fields**

- **Name**: This is the name of the hunt group. Each hunt group name must be unique.
- **Extension**: This is the extension number of the hunt group. Each hunt group extension must be unique.
- **Backup Extension**: This is the backup extension of the hunt group. If the hunt group is unreachable or the switch is down, calls can be directed to this extension. A backup extension may be another hunt group, a workgroup, a route point, or a user.
- **DID**: You can assign one DID number to a hunt group.

Check the first box to select DID. Make a selection from the drop-down list of area codes. This is an optional field.

Refer to DID Ranges on page 178 for additional information about DID numbers and ranges.

- **Distribution Pattern**: Click either Top Down or Simultaneous. Top Down hunts sequentially through the ordered list of group members. Simultaneous rings all group members at the same time. The first to answer is presented with the call. The default is Top Down.

- **Rings Per Member**: The default is 2 rings. All group member extensions ring with the same number of rings. If the phone is not answered, the hunt continues on to the next group member.

- **No Answer Number of Rings**: The default is 6 rings. This value determines the number of ring backs a caller will hear while the call is being hunted. Once this value is exceeded, the call is sent to the No Answer Destination.

**Optional Fields**

- **DNIS**: The Edit DNIS Map button invokes the Select DNIS Trunk Group dialog box. This lets you select a trunk group for DNIS routing. Only trunk groups that are configured for DNIS will be presented in the dialog box. You can assign multiple DNIS numbers to a hunt group.

DNIS is typically used to route 800-number calls to a workgroup or application.
Setting Call Control Options

- **Include in System Dial By Name Directory:** This check box includes the hunt group in the auto-attendant dial-by-name directory. No name is recorded for a hunt group. When a hunt group is chosen, the extension is announced by a generic message.

- **Make Number Private:** Marking check box makes the hunt group extension private. When the hunt group is private, the system directory does not show it, and it does not appear in the Communicator dialing lists. See also Configuring a User Account on page 354.

- **Switch:** Select from the drop-down list of available switches. This is the switch that will host the hunt group and do the hunting of calls

- **Call Stack Depth:** This lets you specify the maximum number of simultaneous calls that can be “stacked” on the hunt group extension. When this number is met, additional inbound calls will be routed to the Busy Destination.

  Default value is 8. Valid entries are 1 through 16.

- **Call Member When Forwarding All Calls:** Default is disabled. When enabled, even if a group member’s call handling mode is Call Forward Always, the call is offered to the member.

- **Skip Member if Already on a Call:** Default is disabled. When enabled, even if a group member’s call stack is not full, if the member’s phone is busy or currently being offered a call, the new call is not offered to the member.

- **Busy Destination:** An alternate call destination can be specified for calls to be sent when all members of the hunt group are busy and the call stacks are full.

- **No Answer Destination:** An alternate call destination should be specified for times when no member answers a call. The hunt will continue until the No Answer Number of Rings value is exceeded, after which callers are sent to this No Answer Destination.

- **On-Hours Schedule:** From the drop-down list, select an on-hours schedule or None. Selecting None causes all calls to be treated as if it is on-hours.

- **Holiday Schedule:** From the drop-down list, select a holiday schedule or None. Holidays are handled the same as off-hours.

- **Off-Hours/Holiday Destination:** Each hunt group can have a call forward destination for use during the off-hours state.

**Informational Field**

- **Current Call Handling Mode:** You can configure several call handling modes for the hunt group: On-Hours, Off-Hours, or Holiday. The default is On-Hours.

- **Choose Members:** Click a member name and then click Add to add a member to the Hunt Group. Members can be removed and re-ordered, as well. This is useful since the Hunt Group membership is an ordered list.

**Note**

You can use filters to sort available members into an order that makes your selection process easiest for you.
Setting the Hunt Group to Busy

Users with correct permissions can set the hunt group to a busy state from the Switch Maintenance page or from the telephone user interface by using a star code (*18) followed by the hunt group extension. A confirmation prompt is played to confirm the state of the hunt group following entry of the star code. The *18 code is used to place the hunt group back into service, as well.

You can busy out the hunt group when all members are unavailable. Calls are then forwarded to the Busy Destination. After a switch reboots, the hunt group is available, by default.

Hunt groups may also be busied out or returned to service from the Switch Maintenance page. From the Maintenance Quick Look page, select the switch that handles the hunt group, select a hunt group, and then change the busy state.

**Note**
The Administrator can not set the hunt group to a busy state from the Diagnostic and Monitoring page.

Music on Hold

All file-based MOH resources are uploaded using Director and are stored on the HQ server. Whenever a new MOH resource is added to the HQ server, the resource is automatically distributed to all DVS/VMBs that have file-based MOH enabled. The MOH resource is then stored and accessed locally on each DVS/VMB.

Disk space usage of MOH files is shown on the Director’s Voicemail Maintenance page.

The play time of the MOH is tracked for each call. When a caller is placed on hold, they will hear the MOH resource from the beginning. If the caller is taken off hold and put back on hold, the MOH file is paused and starts again where it left off.

For information about configuring file-based MOH for application servers and Voice Mail Model Switches, see Specifying Root and Administrator Passwords on page 155.

Adding a Music on Hold Resource

You can add an audio file to use as a music on hold resource. All MOH audio files must be CCITT μ-Law, 8 KHz, 8-bit, mono WAV formatted files.

**Note**
The maximum size for an MOH file is 6835 KB. Files larger than 6835 KB cannot be distributed to the DVS servers.

1. Launch ShoreTel Director.
2. Click Administration > Call Control > Music on Hold > Files.
3. Click **New**.
   
The Edit MOH Resource dialog box appears.

4. Enter a name for the MOH resource in the **MOH Resource Name** field.

5. Click the **Browse** button next to the **File** field.

6. Navigate to and select the file to add as a MOH resource, and then click **Open**.

7. Click **Save** to add the MOH resource.

### Editing a Music on Hold Resource

You can edit the name of a MOH resource or change the audio file associated with a MOH resource.

1. Launch ShoreTel Director.

2. Click **Administration > Call Control > Music on Hold > Files**.

3. Click the name of the resource to edit.
   
The Edit MOH Resource dialog box appears.

4. Make the desired changes to the MOH resource, and then click **Save**.

### Deleting a Music on Hold Resource

Deleting a MOH resource file deletes the file from the HQ server and all DVS/VMBs that the file was previously distributed to.

1. Launch ShoreTel Director.

2. Click **Administration > Call Control > Music on Hold > Files**.

3. Select the check box to the left of the MOH resource to delete.

4. Click **Delete**.
   
   A confirmation dialog box appears.

5. Click **OK** to delete the MOH resource.

### Playing a Music on Hold Resource

You can play MOH resources from Director, or you can play resources over a phone by calling the global or local MOH extension.
Playing a MOH Resource from Director

When you play a MOH resource from Director, the resource is played either through the PC or through a telephone, depending on how the Director Administrator’s Preferences are set. See Preferences on page 27 for information about setting the Play and Record Using parameter.

1. Launch ShoreTel Director.
2. Click Administration > System Parameters > Music on Hold.
3. Click the name of the resource to play.
   The Edit MOH Resource dialog box appears.
4. Click Play.

Playing MOH resources from a Phone

You can play the MOH resources from a phone by dialing the local or global MOH extension. For information about file-based MOH extensions, see the following:

- "System Extensions" on page 53
- "Configuring Application Servers" on page 95
- "Voice Switch Parameters" on page 120

Playing MOH Resources from a Phone

1. Dial the global or local MOH extension.
   The first MOH resource in the MOH Resources list is played.
2. Press # to cycle through all MOH resources.

Paging Groups

As an alternative to using an in-house paging system, you can broadcast a message over a group of speakerphones with the Paging Groups feature. This feature allows a system administrator to designate groups of extensions that can be paged by dialing a single system extension and recording your message. This feature can be a cost-effective alternative for environments that do not already have an overhead paging system installed.

Tip

ShoreTel recommends using a medium sized or larger system configuration to efficiently use paging groups. Refer to the ShoreTel Planning and Installation Guide for information about system requirements and capacities.
For environments that have an overhead paging system, Paging Groups can target your message to a select group of individuals within the organization while not exposing the message to everyone in the building, as would happen with an overhead page.

**Adding Overhead Paging to Paging Groups**

A Paging Extension is an extension that sends a page announcement to a site’s overhead paging system when a user calls that extension.

A Paging Extension can belong to a Paging Group. By adding a Paging Extension to a Paging Group, a user can do both of the following at the same time:

- Broadcast a message to a select group of user extensions
- Send the message to the overhead paging system

Adding multiple Paging Extensions to an extension list provides the ability to page the overhead paging system of multiple sites simultaneously.

Other characteristics of ShoreTel's paging facility are as follows:

- When a Paging Group message goes to an on-hook IP phone, the speaker on that IP phone announces the page.
- When a page goes to an IP phone or analog phone that is already on a call, the treatment of the page is as a normal call.
- Call handling does not apply to paging calls.
- A page can go to a maximum of 100 extensions at one time. Refer to the Quick Installation Guide provided with your switch to determine the switch IP phone capacity and plan accordingly depending on the number of extensions you want to be able to page.
- After receiving a request to play a paging message, the workgroup server adds a short pause to synchronize the audio across multiple phones. This pause (of up to 6 seconds) allows calls to all affected extensions to connect to the server, after which the server begins playing the message.

This pause synchronizes the audio paging on a group of devices to reduce the possibility of the phones playing the message at different times (which could create annoyance if the phones are close to each other). For more information, see Product Bulletin 0200 on the ShoreTel website.

**Configuration**

To specify the people who receive a page, create a list of user extensions. For the purpose of paging, members of this extension list must belong to a user group that allows overhead paging. For information about creating extension lists, see Extension Lists on page 387.

*Group paging* is an alternative to calling a paging number. Auto-Attendant can support group paging for internal users (if group paging meets the customer’s paging needs). Group paging is not available to external callers.

The Paging Groups List (Figure 81) shows the existing paging groups and has provisions for adding or deleting a group or opening an existing group for editing.
Select an existing group for editing or click New to add a new paging group. The Paging Groups edit page is shown in Figure 82.

The fields on the Paging Groups edit page are:

- **Name**: Each paging group must have a unique name.
- **Extension**: Each paging group must have a unique extension number.
- **Group paging server**: In the drop-down list, select the server to host the paging group paging.
- **Include in System Dial By Name Directory**: This check box includes the paging group in the auto-attendant dial-by-name directory. No name is recorded for a paging group. When a paging group is chosen, the extension is announced by a generic message. This is an optional field.
Setting Call Control Options

Multi-site Paging Groups

- **Make Number Private:** This check box makes the paging group extension private. When the paging group is private, it is not listed in the system directory and does not appear in the Communicator dialing lists.

- **Enable priority paging:** Select this check box to enable priority group paging.

- **Deliver group page via:** Select one of the following options to specify the phone output to use to play the paging message.
  - **Speakerphone** plays the paging message on the phones speaker.
  - **Active audio path** plays the paging message on the active media source, such as a headset or handset.

- **No Answer Number of Rings:** The default is 2 rings. This is always used for analog phones. It is used for IP phones if the phone is busy. This is a required field.

- **Extension List:** Select the name of the extension list to be used as the paging group from the drop-down list.

- **Group paging synchronization delay:** Specifies the amount of time the server waits to connect to all extensions in the paging group prior to sending the paging message to the phones.

  A synchronization delay reduces the perception of audio echo when paging large groups of phones. For more information, see Product Bulletin 0200 on the ShoreTel website.

Multi-site Paging Groups

The distributed nature of business often requires that business tools available to employees in the corporate headquarters also be available to remote office workers. One such business tool is a paging system. Many businesses need to have a quick way to alert employees that a customer needs assistance or that a call is waiting.

The Multi-site Paging Group feature allows employees to be paged in each remote office in an efficient manner. Multi-site Paging Groups is a ShoreTel enhancement that improves paging efficiency by allowing the audio for the page to be recorded and sent from a local ShoreTel Voicemail Server. This reduces any impact on WAN bandwidth for pages made within the Headquarters and the remote offices including any dependency on the Headquarter server.

- The Multi-site Paging Group feature allows users to pick up a phone and dial a single system extension to page a group of telephones. With Multi-site Paging Groups, the administrator can now configure local paging extensions for each site.

- The Multi-site Paging Group functionality can be implemented on the Headquarters Server and Distributed Voice Mail Servers. This feature is configured in a similar manner to the Paging Group feature implemented in previous releases.

**Note**

Group paging is not available on voicemail-enabled switches.
Figure 83 shows a two-site implementation where each site has a Paging Group. With Multi-site Paging Groups, both pages are recorded and sent by their local server with no impact on WAN bandwidth.

![Multi-site Paging Groups Diagram]

**Note**

There is no additional licensing requirement to implement Multi-site Paging Groups. This feature is not implemented on ShoreTel voicemail-enabled switches.

**Paging Groups Operation**

To use Paging Groups, a person picks up a phone, dials the Paging Group extension, records a page message, and hangs up the phone. The Paging Group Server then attempts to play the page on each phone referenced by the Extension List configured for the Paging Group.

To reduce the perceived audio delay of paging multiple phones in the same room, the ShoreTel system waits to verify that the extensions referenced on the Extension List are ready to receive the page. This delay period is specified in the Group Paging Synchronization Delay field in the Paging Groups edit page.
Be aware of the following considerations when you implement paging groups:

- The maximum number of extensions that can be paged at one time is 100.
- Group paging is not available to external callers.
- Group paging is not available on voice switches.

**Configuring Paging Groups**

After the Extension Lists are created, you can assign the Extension Lists to Paging Groups. The following steps outline the procedure to configure a Paging Group:

1. Launch ShoreTel Director.

2. Select **Administration > Call Control > Paging Groups**.
   
   The Paging Group List page is displayed.

3. Click **New** to create a new paging group, or click an existing paging group to modify the parameters.
   
   The Edit Paging Group page is displayed.

4. Specify parameters for the page group as follows:
   
   - **Name**: The unique name of the paging group. This is a required field.
   
   - **Extension**: The extension number of the paging group. Each paging group extension must be unique. This is a required field.
   
   - **Group Paging Server**: Select the Headquarters server or one of the distributed voice servers. The server selected will be the source of the audio streamed to the telephones during the page. The default server is set to Headquarters.
   
   - **Include in System Dial By Name Directory**: This check box includes the paging group in the auto-attendant dial-by-name directory. No name is recorded for a paging group. When a paging group is chosen, the extension is announced by a generic message.
   
   - **Make Number Private**: This check box makes the paging group extension private. When the paging group is private, it is not listed in the system directory and does not appear in the Communicator dialing lists.
   
   - **No Answer Number of Rings**: The default is 2 rings. This is always used for analog phones. It is used for IP phones if the phone is busy. This is a required field.
   
   - **Extension List**: Select the name of the extension list to be used as the paging group from the drop-down list. This is a required field.
   
   - **Group Paging Synchronization Delay**: The time in seconds that the server will wait to connect to all phones in the extension list prior to sending the audio stream to the phones. This delay was introduced to reduce the perception of audio echo when paging large groups of phones. The default time is set to 3 seconds. This is a required field.

5. Click **Save**.
Priority Group Paging

Many organizations rely on paging for critical communications with their employees. However, calls that are made to an IP phone from a paging server typically show up as normal or non-urgent calls when the phone is in use. In these instances the individual being paged has no idea of the priority of the page, and there is no guarantee that the individual will suspend their current call to listen to the page being delivered.

Priority Group Paging provides a method for designating groups of extensions that can be paged by dialing a single system extension and recording a message.

When Priority Group Paging is enabled, recipients of a Priority Group Page or forced page hear the audio of the page whether or not they are on a call. If the intended recipient is on an active call, that call will be automatically be placed on hold before the page is played. When the page completes, the call that was placed on hold will automatically resume.

Priority paging handles Hold/Transfer/Conference in the same way as Paging Groups. A call ends when the user presses Hold, Transfer, or Conference.

Priority paging allows the server to act as a media relay from source to the recipient. The call controller or the switch plays a limited role.

**Note**
The Priority Paging feature provides new functionality to the page recipient. There are no changes in the core paging implementation.

1. Launch ShoreTel Director.
2. Click **Administration > Call Control > Paging Groups**.
   
The Paging Groups page opens.
3. Click the **New** button to create a new Paging Group.
   
The Edit Paging Group page appears as shown in **Figure 84**.
4. Edit the following fields on the Edit Paging Group page:

- **Group Paging Server**: The server hosting the Workgroup. All Distributed Voicemail Servers are listed, but voicemail-enabled switches are not listed.

- **Make Number Private**: This check box makes the paging group extension private. When the paging group is private, it is not listed in the system directory and does not appear in the Call Manager dialing lists.

- **Enable Priority Paging**: This check box enables Priority Group Paging. The default is unchecked.

- **Deliver Group Page via**: This check box allows the administrator to configure the preferred audio path on the phone to deliver the page.
  - **Speakerphone**: The page is played on the speaker.
  - **Active Audio Path**: The page is played on the active media source, such as a headset or handset.

- **No Answer Number of Rings**: This field is required. Default is 2 rings. This is always used for analog phones. It is used for IP phones if the phone is busy.

- **Extension List**: Select the name of the extension list to be used as the paging group from the drop-down list.

- **Group Paging Synchronization Delay**: This required field specifies the time in seconds that the server waits to connect to all phones in the extension list prior to sending the audio stream to the phones. A synchronization delay reduces the perception of audio echo when paging large groups of phones. The default time is 3 seconds.

5. When finished, click **Save**.
Important Considerations

- When a previously held call is restored, the audio path of the original call is retained. However, in a special case—when the page is over a speaker phone and the user decides to “cradle” the handset, for example—the audio path is not restored to the previous audio path. The audio path would be speaker phone. This exception is for Handset only—the headphone should work as expected. The problem with Handset is that, today’s ShoreTel IP Phones are not notified when the user puts the handset in the cradle (and is on speaker).

- Page-over-Page is not supported, i.e. if you issue a Priority page to an extension, while the extension is already being paged, the page is presented as an incoming call. This is because we do not have priorities set for page groups. In other words, if there were priorities assigned to PGs a page-over-page would result in a lower priority page being put on hold and the higher priority page being auto answered.

- Other Paging group limitations apply. SIP/Analog/OAE page will still be delivered, but the calls cannot be auto answered.

Pickup Groups

Pickup Groups is a traditional PBX and key system feature used in group environments that allows users to answer any ringing phone in that group. The feature works best in places where a set of people work together on a daily basis, such as design firms. If a group member is away from her desk and across the room when her phone rings, she can quickly answer the call from another person's IP phone by pressing the relevant soft key or programmable button, or by using a simple star command (*13 + extension) from an analog phone.

Similarly, if she is out of the office and her phone rings, anyone can answer her call from another phone with a simple ‘group pickup’ command and take a note for her.

User extensions are added to an extension list and then this list is associated with a pickup group. The pickup group has its own extension (e.g., x3755), but this extension is invalid, cannot be dialed, and thus acts more like a code than an actual dialable extension.

- Pickup groups can be associated with a programmable toolbar button, or with a programmable button on an IP phone, or on IP phones that have soft keys.

- The user whose phone will be picked up must have class of service “Call Pickup Allowed” to use this feature. However, other users need not be members of the pickup group to pickup a call.

- This feature is not supported on the following legacy ShoreTel switch models: ShoreTel T1 and ShoreTel E1.

- The pickup feature will support:
  - 24 members per group
  - 16 groups per switch
  - The members assigned to all pickup groups on a switch cannot exceed 80
  - A single user can be a member of up to 5 pickup groups
A single switch can host a combined total of up to 24 hunt groups, bridged call appearances, and pickup groups.

This feature can be accessed in three different ways:

- **IP Phone** – If a programmable button has been configured for this feature, the user can press the button, or key, and enter the extension for the pickup group to answer the call.

- **Communicator** – If one of the pre-programmed buttons in Communicator has been set up for pickup groups, a user can enter the extension of the group to answer the call. If the key has already been programmed with the extension of the pickup group, then it is not necessary to enter the extension.

- **Analog Phone** – The user can enter the *13 command from the keypad, followed by the pickup group extension to answer calls from an analog phone.

### Configuring Pickup Groups

Configuring the Pickup Groups feature consists of two separate tasks. First, you must create an extension list and populate it with the extensions of the members that will belong in this group. Second, you must create and name the pickup group and associate it with the extension list you just created.

### Creating the New Extension List for a Pickup Group

1. Launch ShoreTel Director; type the user ID and password; and click on **Login**.
2. Click **Administration > Users > Extension Lists** to display Extension Lists.
3. Click the **New** button to create a new extension list.

   The Edit Extension List page appears as shown in **Figure 85**.

4. Enter the desired name in the **Name** field.
5. Select one or more users from the list on the left pane, and click the Add button to move them over to the Extension List Members pane on the right.

6. Click Save to store your changes.

Creating a new pickup group and associate it with an extension list:

1. Launch ShoreTel Director still open, click on the Call Control link.

2. Click on the Pickup Groups link to display a window similar to the one shown in Figure 86:

   ![Figure 86: Pickup Groups Page](image)

3. Click New to display the Edit Pickup Group page (see Figure 87).

   ![Figure 87: Edit Pickup Group](image)

4. Enter a name for the new Pickup Group in the Name field.

5. The Extension field will auto-populate.

6. Click on the Switch drop-down menu and select the appropriate switch for this group. You should select the switch that is physically closest to the members of the group.

7. Click the Extension List drop-down menu and select the extension list that you just created in the previous task.

8. Click Save to store your changes.
Route Points

Route points allow third-party applications complete access to call control signalling (using TAPI) and the actual voice media stream (using TAPI and WAV APIs). Configuring a route point enables calls to be terminated and controlled by a server on the network. To configure a route point, click the Route Points link under Call Control in the navigation frame. The Route Points list page is shown in Figure 88.

![Figure 88: Route Points List Page](image)

Then click Add new to invoke the Route Point edit page (shown in Figure 89).
Parameters

The parameters that appear on the **Route Point** edit page are as follows:

- **Name**: This is the name of the route point.
- **Extension**: This is the extension number of the route point. Each route point extension must be unique. This is a required field.

---

**Figure 89: Route Point Edit Page**

<table>
<thead>
<tr>
<th>Parameters Setting Call Control Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameters</strong></td>
</tr>
<tr>
<td><strong>Name</strong>: This is the name of the route point.</td>
</tr>
<tr>
<td><strong>Extension</strong>: This is the extension number of the route point. Each route point extension must be unique. This is a required field.</td>
</tr>
</tbody>
</table>
If you change the existing extension number to a new number and there is an associated mailbox, messages will be retained.

- **DID**: You can assign one DID number to a route point. This field is optional. See DID Ranges on page 178 for more information about DID numbers and ranges.

- **DNIS**: The Edit DNIS Map button invokes the Select DNIS Trunk Group dialog box. This lets you select a trunk group for DNIS routing. Only trunk groups that are configured for DNIS will be presented in the dialog box. You can assign multiple DNIS numbers to a workgroup. This is an optional field.

  DNIS is typically used to route 800-number calls to a workgroup or application.

- **Language**: Select the route point language from the drop-down list.

- **User Group**: This drop-down list is for assigning a user group to the route point. This field is required.

  The route point requires permissions just as a user does. For example, the route point call to external call forwarding needs access to trunk groups and has a mailbox. For details on user groups, see Configuring User Groups on page 351.

- **Route Point Server**: This required field selects the server that provides route point services for third-party applications. Third-party applications gain control of calls handled by the ShoreTel system through route points.

  We recommend that the route point server be a separate server from the headquarters server and not be configured with mailboxes.

- **Mailbox (server)**: This provides the route point with a mailbox on the associated server. If you change the server, all messages are automatically moved to the new server. The default mailbox server is the headquarters server. This is a required field.

- **Accept Broadcast Messages**: This check box enables the route point mailbox to receive broadcast messages. This is an optional field.

- **Include in System Dial by Name Directory**: This check box includes the route point in the auto-attendant dial-by-name directory. This is an optional field.

- **Make Number Private**: This check box makes the route point extension private. When the route point is private, it is not listed in the system directory and does not appear in the Communicator dialing lists. This is an optional field.

- **Fax Redirect**: This check box enables fax redirection. When the route point answers a call and a fax tone is detected, the fax is redirected away from the route point to the headquarters fax extension. This is an optional field.

- **Call Stack Depth**: This lets you specify the maximum number of simultaneous calls that can be “stacked” on the route point extension. When this number is met, additional inbound calls will be routed to the call forward busy destination.

  Valid entries are 1 through 200.
- **Recorded Name**: The Record, Play, Enter, and Import buttons let you record a name for the route point. The Recorded Name is used as part of the default mailbox greeting as well as in the dial-by-name directory. This is an optional field.

You can use a PC microphone and speakers or a telephone to play and record within ShoreTel Director. Please refer to the auto-attendant options for more information.

You can also import prompts into ShoreTel Director. Prompts must be recorded as µ-law WAV files.

- **Voice Mail Password**: This is the password used for accessing a route point voice mailbox over the telephone. Enter a password in the first text-entry field and again in the Confirm field. This is a required field. The system allows only numbers for this password. The default password is “1234.”

- **Schedule**: You can configure schedules for the On-Hours, Holiday, and Custom modes that automatically change the call handling of the route point. The rules for schedules are:

  - For custom time, use Custom mode.
  - For holiday time, use Holiday mode.
  - For on-hours time, use On-Hours mode.
  - Otherwise, use Off-Hours mode.

If no schedules are specified, the system uses On-Hours mode.

The Edit this schedule link provides a quick way to navigate to the associated schedule. This field is optional.

- **Call Handling Call Forward**: These buttons let you specify when calls are forwarded. The conditions are Always, No Answer/Busy, and Never.

  - **Always**—The Always condition forwards calls to the number specified in the Always Destination parameter immediately when a call is received.
  - **Busy**—The Busy condition forwards calls to the Busy Destination immediately if the user’s call stack is full.
  - **No Answer**—This condition forwards calls if nobody answers the call.
  - **No Answer Number of Rings**—Sets the number of rings after which a no answer condition is assumed to exist.

  This is a required field.

  - **Always Destination**—When the Always call forward condition is selected, calls are forwarded immediately to this extension. You can also forward calls to an external number (access code required).
  - **Busy Destination**—When the No Answer/Busy call forward condition is selected, calls are forwarded to this extension immediately if the user’s call stack is full. You can also forward calls to an external number, but an access code is required.
  - **No Answer Destination**—When the No Answer/Busy call forward condition is selected, calls are forwarded to this extension after the specified number of rings. You can also forward calls to an external number (access code required).
Mailbox Greeting: This lets the user record a greeting for his or her mailbox, using the Record, Play, Erase, and Import buttons. This is on by default.

Assistant: Each route point can have a personal assistant, which is the destination a calling party is transferred upon dialing “0” in the route point mailbox. This is an optional field.

Enable Calling Message Notification: This check box enables message notification for this call handling mode. The manner in which the user is notified is determined by the user’s message notification settings. The recommended default is off.

Call Control Options

This section explains how to set the Call Control Options.

Distributed Routing Service

Distributed Routing Service (DRS) lets a large system scale beyond 100 switches to up to a total of 500 switches (including softswitches). DRS is optional on systems up to 100 switches but must be enabled on systems with 101 or more switches.

When Distributed Routing Service is disabled, ShoreTel switches in a system build an internal routing database from the peer-to-peer communication with other switches. Each ShoreTel switch contains routing information for all endpoints in the system including information regarding trunk selection for outbound calls. When calls are placed from any extension, each switch is able to route the call to the correct ShoreTel switch based on its internal routing database.

When Distributed Routing Service is enabled, ShoreTel switches only exchange routing information with other switches at the same site rather than exchanging routing information with every other switch in a multi-site system. Although each ShoreTel switch only maintains routing information within its site, each ShoreTel server also includes an instance of the Distributed Routing Service which maintains system-wide routing information. When calls are initiated, ShoreTel switches contact the Distributed Routing Service in order to find the ShoreTel switch or switches needed to complete the call.

In a system with more than one ShoreTel server, the ShoreTel switches may contact an alternate instance of the routing service if the primary instance is not reachable. ShoreTel servers have a hierarchical relationship and switches first try to contact the nearest instance of the Distributed Routing Service in the hierarchy. If that instance of DRS is not reachable, the instance of DRS at the parent server in the hierarchy will be contacted as a fallback. If both instances of DRS are not reachable the switch will make a best effort to route the call based on its internal routing tables built from communicating with peer ShoreTel switches at the same site.
Parameters

The parameters on the Call Control Options edit page are as follows:

General Parameters Area in the Options Window

- **Use Distributed Routing Service for call routing**: Enables Distributed Routing Service (see preceding explanation.)

- **Enable Monitor / Record Warning Tone**: When a two-way or Make Me Conference call is monitored or recorded, checking this box causes a tone to be played that warns of monitoring or recording. This option is enabled by default.

  Deselect this check box to enable silent recording. Silent recording allows operators and supervisors to hide the fact that they are recording agents' calls by “silently” recording those calls. This behavior can be desirable in certain situations, such as for monitoring the telephone manners of an employee.

  When the recording is silent or hidden, Communicator offers no visual or audible indication that the call is being recorded. The periodic beeping sound (used to notify call participants that their calls are being recorded) is suppressed.

  **Note**
  **Example**: ShoreTel does not warrant or represent that your use of call monitoring or recording features of the Software will be in compliance with local, state, federal or international laws that you may be subject to. ShoreTel, Inc. is not responsible for ensuring your compliance with all applicable laws.

  Before disabling the warning tone, you may wish to consult with legal counsel regarding your intended use.

- **Enable Silent Coach Warning Tone**: You can set this parameter to play a Silent Coach Warning Tone to all call participants when a Silent Coach session is initiated. The Tone setting applies to all Silent Coach sessions on the system. When a user transitions between Silent Coach and Silent monitor, the warning tones start/stop based on the silent coach or silent monitor warning tone setting.

- **Generate an event when a trunk is in use for N minutes**: You can set this parameter to generate an event log when a trunk has been in use for the specified time period.

- **Park Timeout after NNNNNN seconds**: You can set how long a call will remain on park before the call returns to the party that parked the call. The timeout is in seconds and can have a value from 1 to 100,000 seconds. Unchecking the Park Timeout check box allows calls to be parked indefinitely.

- **Hang Up Make Me Conference after NN minutes of silence**: The default timeout is 20 minutes. If a conference is silent for the set length of time, a hang-up will be forced.

- **Delay before sending DTMF to Fax Server**: Enter the milliseconds of delay after which the DTMF information is sent to the fax server. Consult the fax server documentation to obtain the fax server delay parameters.
DTMF Payload Type (outbound): The default is 102. It can be configured to a value (96-127) that allows for more precise matching to the requirements of a specific SIP provider. After it is configured, this value is propagated to the entire ShoreTel system (switches, servers, and softphones) during SIP negotiation. Conference bridges and all 3rd party SIP devices require manual configuration of the Payload Type by the system administrator based on that device. After manual configuration is complete, the device must be restarted. The ShorePhone IP 8000 conference phone always uses the DTMF payload type as 101 even if the Director setting is different. For inbound calls to the IP 8000 phone, the phone honors the requested payload type from the inbound endpoint.

---

SIP Parameters in the Call Control Options Window

- **Realm:** This parameter is a name the administrator uses for a protected area (realm) to which the SIP authentication parameters are applied. For digest authentication, each domain of this type defines a set of usernames and passwords that the system uses for granting access.

- **Enable SIP Session Timer:** Select this check box to have keepalive heartbeats sent to SIP endpoints.

- **Session Interval (90-3600):** Enter the number of seconds in the Session Interval field to specify the keepalive interval at which heartbeats will be broadcast. The heartbeat is sent out at the specified period and if no response is received, the session is dropped. (See RFC 4028 for details on this parameter.)

- **Refresher:** Use the Refresher drop-down menu to specify whether the SIP Session Timer will be applied to the caller or callee. Choices are None, Caller UAC, and Caller UAS. (See RFC 4028 for details on this parameter.)

Voice Encoding and Quality of Service in the Call Control Options Window

- **Maximum Inter-Site Jitter Buffer:** This parameter sets the maximum size of the jitter buffer. A larger jitter buffer might result in more delay between calling parties, which might degrade the quality of service. The buffer range is 20–400 msec. The default is 300 msec.

- **DiffServ/TOS Byte:** This parameter configures DiffServ/ToS for voicemail, workgroup, account code collection (ACC), and contact center calls. The value in this field must be a decimal number in the range 0–255. The default is 184. This setting applies to all ShoreTel servers in a ShoreTel system. To enable a new DiffServ/ToS setting, you must reboot all ShoreTel servers.

---

**Note**

ToS is an eight-bit field in the IP Packet Header. It is used to accommodate applications that require real-time data streaming, as specified by RFC 3168. The ToS fields contains a six-bit Differentiated Services Code Point and a two-bit Explicit Congestion Notification field.
- **Media Encryption**: This option specifies the encryption method used by ShoreTel to protect payload packets. For more information, refer to Media Encryption on page 330.

- **Admission control algorithm assumes RTP header compression is being used**: To enable this feature, select the check box.

- **Always Use Port 5004 for RTP**: By default, this box is checked. This option is not available on systems that utilize SIP extensions, SIP trunks, or Softphone.

**Note**
RTP dynamically selects a UDP port per media stream from the range of configured ports. Configure your firewall to allow RTP traffic as needed.

All IP Phones and switches must be rebooted for settings to take effect. Failure to reboot may result in one way media.

**Call Control Quality of Service**

- **DiffServ/TOS Byte**: This parameter configures DiffServ/ToS for call control traffic from/to ShoreTel switches, servers, and phones. The value in this field must be a decimal number in the range 0–255. The default is 104.

  This setting applies to all ShoreTel servers in a ShoreTel system. This value should not be greater than the Voice Encoding and Quality of Service DiffServ/TOS Byte value.

**Note**
This parameter does not configure call control signaling traffic from ShoreTel Communicator residing on the data network or from third party TSP installations. This traffic is usually configured to reset all data traffic to DSCP of zero.

**Video Quality of Service in the Call Control Options Window**

- **DiffServ/ToS Byte**: This parameter configures the DiffServ/ToS field in the IP Packet Header of the Video Call payload packet. The value in this field must be a decimal number in the range 0–255. The default is 136. Changing this setting does not affect active video sessions. The updated value is applied to new video sessions. Communicator recognizes the new value without being restarted.

**Trunk-to-Trunk Transfer and Tandem Trunks in the Call Control Options Window**

This lets you manage trunk-to-trunk transfers when the Allow Trunk-to-Trunk Transfer parameter is enabled on the Class of Service, Edit Telephony Features Permissions page. For details, see Telephony Features Permissions on page 338.
The ShoreTel system supports trunk-to-trunk transfers, which allow a user to transfer an external caller to an external number. Since this feature can lead to unwanted toll charges, the system also supports a class of service permission that only grants this feature to selected user groups. To grant this permission, you enable the Allow Trunk-to-Trunk Transfer parameter on the Telephone Features Permissions class of service edit page.

Users with trunk-to-trunk transfer permission might accidently transfer an external caller to an external number without realizing it. This can lead to "hung" trunks, resulting in the inability to make outbound calls or take inbound calls.

The ShoreTel system lets you manage trunk-to-trunk transfers using the Call Control Options page. This lets you eliminate unwanted trunk-to-trunk transfers while ensuring that valid trunk-to-trunk transfers are not dropped.

The following are considered trunk-to-trunk transfers:

- A user is talking with an external party and transfers the external party blindly or consultatively to an external number.
- A three-party conference call is taking place with one user and two external parties, and the user drops from the call.

An external party forwarded to an external number by a user’s call handling mode is not a trunk-to-trunk transfer.

- **Hang up after N minutes of silence**: Enabling this parameter automatically drops trunk-to-trunk transfers after both parties have been silent for the specified time period. The default time period is 60 minutes.
- **Hang up after N minutes**: Enabling this parameter automatically hangs up the trunk-to-trunk transfer after the defined time period. This parameter should be set only if truly needed and set for a long period. The default period is 480 minutes.

## Bandwidth Management and Codec Negotiation

ShoreTel supports a variety of codecs. Codec negotiation during voice call setup is facilitated by data structures, including codec lists and profiles.

Bandwidth management and codec negotiation tools available through ShoreTel Director include:

- Codec lists that are configurable through ShoreTel Director
- Video codec support
- A ShoreTel Director parameter that permits intersite video sessions
- A SIP codec negotiation method that complies with RFC 3264
Codec Lists

Codec lists enumerate a set of codecs. ShoreTel Director defines two types of codec lists:

- Supported codecs
- Preferred codecs

Supported Codecs

The Supported Codecs list is a comprehensive list of all codecs available to system devices. When ShoreTel is initially installed, the Supported Codecs list comprises the set of codecs provided by ShoreTel and available on ShoreTel IP phones. Administrators can add codecs to support SIP devices that may use codecs not initially provided by ShoreTel.

In ShoreTel Director, the Supported Codecs page lists the audio codecs that are available to devices making voice calls through ShoreTel. These codec lists are used when negotiating call parameters. Although most commonly used codecs are listed on this page, the system can also support other codecs if you add them to the list.

The Supported Codecs list also indicates the bandwidth required by each codec. The bandwidth numbers are used by ShoreTel to allocate bandwidth as voice calls are initiated and terminated.

The contents of the Supported Codecs list, including the bandwidth settings, are passed to all switches in the system, where they are used for selecting codecs for individual call sessions.

Preferred Codec Lists

Preferred codec lists are subsets of the supported codecs list. Preferred codec lists are referenced by sites within a ShoreTel system to designate the codecs used for intersite and intrasite voice calls. ShoreTel provides six default codec lists that cannot be deleted or modified. You can define additional lists through ShoreTel Director.

The default codec lists provided with the ShoreTel system are listed in Table 37.

Table 37: Codec Lists

<table>
<thead>
<tr>
<th>Codec List Name</th>
<th>Codecs Included in List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Codecs — High Bandwidth</td>
<td>T.38</td>
</tr>
<tr>
<td></td>
<td>L16/8000</td>
</tr>
<tr>
<td></td>
<td>PCMU/8000</td>
</tr>
<tr>
<td></td>
<td>PCMA/8000</td>
</tr>
<tr>
<td>Fax Codecs — High Bandwidth</td>
<td>L16/8000</td>
</tr>
<tr>
<td>Passthrough</td>
<td>PCMU/8000</td>
</tr>
<tr>
<td></td>
<td>PCMA/8000</td>
</tr>
<tr>
<td>Fax Codecs — Low Bandwidth</td>
<td>T.38</td>
</tr>
<tr>
<td></td>
<td>PCMU/8000</td>
</tr>
<tr>
<td></td>
<td>L16/8000</td>
</tr>
<tr>
<td></td>
<td>PCMA/8000</td>
</tr>
</tbody>
</table>
### Table 37: Codec Lists (Continued)

<table>
<thead>
<tr>
<th>Codec List Name</th>
<th>Codecs Included in List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Codecs — Low Bandwidth Passthrough</td>
<td>PCMU/8000, L16/8000, PCMA/8000</td>
</tr>
<tr>
<td>High Bandwidth Codecs</td>
<td>G722/8000, BV32/16000, L16/8000, PCMU/8000, DVI4/8000, iLBC/8000, BV16/8000, G729/8000, PCMA/8000</td>
</tr>
<tr>
<td>Low Bandwidth Codecs</td>
<td>BV32/16000, DVI4/8000, iLBC/8000, BV16/8000, G729/8000, PCMU/8000, PCMA/8000</td>
</tr>
<tr>
<td>Medium Bandwidth Codecs</td>
<td>G722/8000, BV32/16000, PCMU/8000, DVI4/8000, iLBC/8000, BV16/8000, G729/8000, PCMA/8000</td>
</tr>
<tr>
<td>Very High Bandwidth Codecs</td>
<td>L16/16000, G722/8000, BV32/16000, L16/8000, PCMU/8000, DVI4/8000, iLBC/8000, BV16/8000, G729/8000, PCMA/8000</td>
</tr>
<tr>
<td>Very Low Bandwidth Codecs</td>
<td>iLBC/8000, G729/8000, PCMU/8000, PCMA/8000</td>
</tr>
</tbody>
</table>
Codec Negotiation

ShoreTel supports simultaneous audio, video, and data codec negotiations to facilitate multimedia sessions between SIP endpoints (as defined by RFC 3264). Codecs specified in the Supported Codecs list are offered during session parameter negotiations.

The ShoreTel negotiation process that supports RFC 3264 is as follows:

1. The calling device sends the list of codecs it supports to the ShoreTel switch servicing the call.

2. The ShoreTel switch that controls the calling device compiles a codec list. The codec list contains all codecs contained in the following:
   - The calling device’s codec list
   - One of the site’s codec lists – intersite, intrasite, or fax – depending on the call type

   Codecs on the combined list are sorted as specified by the selected site codec list.

3. (Intersite Calls only) The ShoreTel switch that controls the destination device modifies the codec list by removing all codecs that are not listed on the destination site’s codec list.

4. The ShoreTel switch controlling the destination device sends the codec list to the destination device.

5. The destination device replies by sending a list of one or more codecs to the originating device. This list typically includes the highest priority codec from the received codec list that it can support.

6. The two devices begin sending RTP streams using the highest priority codec listed in the destination device’s reply.

Adding, Editing or Deleting Supported Codecs

You can add, edit, or delete codecs on the Supported Codecs page in ShoreTel Director. Fields on the Supported Codecs page are as follows:

- **Name**: This parameter is the fully qualified codec ID string of the codec. ShoreTel uses this string to specify codecs while negotiating with other calling devices.

  The codec ID string consists of the name and sampling rate of the codec. Although the codec name usually reflects the name by which the codec is commonly known, PCMA specifies a G.711 codec (A-law) and PCMU specifies a G.711 codec (µ-law).

- **Bandwidth (in kbps)**: This parameter identifies the bandwidth required by the codec. ShoreTel uses this figure when allocating bandwidth resources.

- **Default**: This informational parameter, which you cannot edit, specifies the source of the codec entry:
  - **Yes** indicates a codec that was provided with the ShoreTel system. Default codecs cannot be removed from the list.
  - **No** indicates a codec that was added by a system administrator. These codecs can be removed from the list.
Adding a New Codec

1. Launch ShoreTel Director.

2. Select **Administration > Call Control > Supported Codecs**.
   The Supported Codecs page is displayed.

3. Click **New** at the top of the page.
   The Supported Codec Info popup is displayed.

4. In the **Name** field, enter the fully qualified codec ID string. (The field must be entered exactly as expected by devices that negotiate call parameters.)

5. In the **Bandwidth** field, enter the codec bandwidth.

**Note**
Use care in entering values in the **Bandwidth** field. Entering incorrect numbers in this field compromises ShoreTel's ability to manage bandwidth resources.

6. Click **Save**.
   The new codec is now included on the Supported Codecs page.

Editing a Codec

1. Launch ShoreTel Director.

2. Select **Administration > Call Control > Supported Codecs**.
   The Supported Codecs page is displayed.

3. Click the name of the codec to be edited.
   The Supported Codec Info popup is displayed.

4. Change the values in the **Name** and/or **Bandwidth** fields.

5. Click **Save**.
   The edited codec is now included on the Supported Codecs page.

Deleting a Codec

1. Launch ShoreTel Director.

2. Select **Administration > Call Control > Supported Codecs**.
   The Supported Codecs page is displayed.

3. Select the check box for the codec you want to delete.
4. Click **Delete**.

5. Click **OK** to confirm.

The displayed Codec Lists page no longer includes the deleted codec.

---

**Working with Codec Lists**

Codec lists are subsets of the codecs supported by the ShoreTel system. The Codec Lists page provides a roster of Codec Lists configured in the system. On the Edit Site page in ShoreTel Director, you select Codec list names to specify the codecs used for intersite and intrasite calls.

ShoreTel provides default codec lists that cannot be modified or deleted. These are shown in Table 37. The codecs within each list are in priority order.

The Edit Codec Lists page, shown in Figure 90, lets you modify the codec list specified in the **Name** field. All codecs available on the system, as defined by the Supported Codecs page, are listed in either of the following two lists:

- The **Choose Codec** list shows the codecs available on the system that are not in the specified codec list.
- The **Codec List Members** list shows the codecs that are included in the specified codec list.

**Adding a New Codec List**

1. Launch ShoreTel Director.

2. Select **Administration > Call Control > Codec Lists**.

   The Codec Lists page is displayed.

3. Click **New**.

   The Edit Codec Lists page is displayed.

4. Type the name of the new codec list in the **Name** field.

5. Populate the new codec list by doing any of the following:

   - To add a codec to the codec list, select the desired codec from the **Choose Codecs** list and then click the **Add** button between the lists.
   - To change the position of a codec within the Codec List Members table, select the desired codec in that list and click the **Move Up** or **Move Down** buttons between the lists.

6. Do one of the following:

   - To save changes to a codec list, click **Save** at the top of the page.
   - To use the displayed codec list as a template for a new list, click **Copy** at the top of the page.

**Deleting a Codec List**

1. Launch ShoreTel Director.
2. Select **Administration > Call Control > Codec Lists**.

   The Codec Lists page is displayed, and each line on the page corresponds to a Codec List.

3. Select the check box next to the codec list you want to delete, and then click **Delete** at the top of the page.

**Viewing or Editing a Codec List**

1. Launch ShoreTel Director.

2. Select **Administration > Call Control > Codec Lists**.

   The Edit Codec Lists page is displayed, and each line on the page corresponds to a Codec List.

3. Click the name of the codec list that you want to view or edit.

4. Do one of the following:

   - To add a codec to the codec list, select the desired codec from the **Choose Codecs** list and then click the **Add** button between the lists.

   - To remove a codec from the codec list, select the desired codec in the **Codec List Members** list and then click the **Remove** button between the lists.

   - To change the position of a codec within the Codec List Members table, select the desired codec in that list and click the **Move Up** or **Move Down** buttons between the lists.

   - To save changes to a codec list, click **Save** at the top of the page.

   - To use the displayed codec list as a template for a new list, click **Copy** at the top of the page.

   - To revert the codec list to the last saved version, click **Reset** at the top of the page.

![Figure 90: Edit Codec Lists Page](image-url)
Enabling Intersite Video

Intersite video refers to a video communication between more than one ShoreTel site. The trunk protocol that supports video communication is SIP. Intersite video is enabled through a Telephony Class of Service check box. For information on the Telephony Class of Service, see Telephony Features Permissions on page 338.

ShoreTel does not allocate bandwidth for video calls. Consequently, heavy traffic on the network can have an impact on video conferences and even audio communication.

To enable intersite video:

1. Launch ShoreTel Director.
2. Click Administration > Users > Class of Service.
   
   The Class of Service page is displayed.

3. Click the name of the desired Telephony Features Permissions Class of Service in the top table of the page.

   The Edit Telephony Features Permissions page is displayed.

4. Do one of the following:

   - To allow members of the current Class of Service to participate in video calls, select the Allow Intersite Video Calls check box.

   - To prevent access to video calls, clear the Allow Intersite Video Calls check box.

Automatic Ringdown

An automatic ringdown circuit comprises predefined devices at the circuit endpoints and is configured to ring a recipient device immediately after an initiating device goes off hook. Automatic ringdown calls are completed without dialing or any other signaling other than the initiating device going off hook.

The simplest example of an automatic ringdown circuit consists of two points, with one telephone at each end of the circuit. When the telephone at one end goes off-hook, the phone at the other end immediately rings. Phones without dials may be used on each end of the circuit.

Ringdown circuits may be unidirectional or bidirectional.

- In unidirectional circuits, calls always originate from the same end of the network. A device on a receiving endpoint going off hook has no effect on the initiating endpoint device.

- In bidirectional circuits, both ends can initiate and receive automatic ringdown calls.
Dedicated Circuit Ringdown

ShoreTel IP Phones with call appearance buttons and the ShoreTel Button Box support Dedicated Circuit Ringdown. A call appearance button is programmed for Ringdown by configuring it as a Bridged Call Appearance and selecting a Ringdown option. When using ShoreTel IP Phones as both calling and receiving devices, an IP Phone button on both device must be configured for Ringdown. ShoreTel also supports external devices as ringdown recipients.

A ringdown call is initiated by pressing the ringdown button on a calling device. The ringdown button on the recipient device blinks; the recipient device can be configured to ring or remain silent on an inbound ringdown call. The ringdown call is answered on the recipient phone either by lifting the handset or pressing the blinking ringdown button. If the phone is configured to remain silent when a ringdown call is incoming, the blinking button must be pressed to answer the call.

ShoreTel IP Phones can be configured for one-way or two-way ringdown. When phones are configured for one-way ringdown, one phone is defined as the recipient device; pressing the ringdown button on that device will not initiate a call to the phone on the other end of the circuit. When phones are configured for two-way operation, pressing the ringdown button on either device initiates a call to the device on the other end of the circuit.

To force a device to ring until it is answered, the call stack depth for Bridge Call Appearances supporting ringdown should be set to 1 and call handling mode transfers should be disabled by selecting No Answer.

The following sections describe four typical ringdown configurations.

Basic One-to-One Ringdown

Basic one-to-one ringdown, as depicted in Figure 91, is enabled by configuring a Call Appearance button on each phone as a Bridged Call Appearance (BCA). During an incoming ringdown call, the BCA button on the recipient device blinks.

ShoreTel supports one-way or two-way ringdown in this configuration.

One-to-many Ringdown

ShoreTel supports one-to-many ringdown operation. When the Ringdown BCA is pressed on the calling device, Extension A in Figure 92, the corresponding button on all recipient devices programmed to receive the ringdown call flashes Green and off. When the call on one of the recipient devices is answered, the Ringdown button on the other devices is Red. If the answering device places the call on hold, the call is parked to the Bridged Call Appearance and is available for all of the recipient devices. Conference calls involving a ringdown number that is placed on hold is not parked onto the BCA extension.
ShoreTel supports two-way ringdown for the one-to-many configuration. When a ringdown call is placed from a recipient device (Extension B in Figure 92), the BCA button on the other recipient devices (Extensions C and D) becomes solid red when Extension A answers the call, indicating that the line is busy. Pressing these red buttons has no effect. If Extension A does not answer the ringdown call, the phone rings until the caller on Extension B hangs up or the call handling mode for Extension A handles the call.

**Multiple Ring Down Buttons**

ShoreTel IP Phones with sufficient call appearance buttons support multiple ringdown circuits. In Figure 93, Extension A is configured to support two ringdown circuits:

- One ringdown circuit with Extensions B, C, and D at the other end.
- One ringdown circuit with Extension E at the other end.

This configuration requires four Bridge Call Appearance extensions: two BCA extensions for Extension A; one BCA extension shared by Extensions B, C, and D; and one BCA extension for Extension E.
Ring Down to an External Device

Ringdown to an external device is supported by programming the ringdown button to access a trunk group that has a unique trunk access code and contains only one trunk. When the user presses the ringdown button, it accesses that trunk.

To place a call over a ringdown circuit to an external device, the user enters the trunk access code in addition to the phone number of the device. For instance, when configure a analog trunk group to service the ringdown call, the default trunk access code of 9 must be dialed to place a ringdown call.

This trunk is not required to be reserved solely as the ringdown circuit. Any user can dial this trunk access code to select this trunk. If the trunk is busy, pressing the ringdown button generates a busy signal. “Enable CHM” only applies for an incoming call. It is not applicable for an outbound call. To enable ringdown buttons on the ShoreTel devices (Extensions B, C and D in Figure 94), the BCA extension must be configured on the Trunk Groups page.
Phone Delayed Ringdown

ShoreTel permits IP phones that provide a dial tone to perform ringdowns by taking the handset off hook. If a number is not dialed within a specified period after taking the phone off hook, a ringdown call is directed to the predefined recipient device.

When the ringdown device goes off hook by lifting up handset or pressing the speaker or headset buttons, the ringdown number is dialed if a digit is not entered within the configured ringdown delay period. If a digit is entered within this period, the ringdown call is not performed.

Analog phones to which a user extension is assigned can receive incoming calls even when configured for delayed ringdown calls. When an anonymous user is assigned to the port, the device cannot receive incoming calls if it is configured to make delayed ringdown calls.

Ringdown Implementation

Automatic ringdown circuits may also be configured in a one-to-many topology. In these circuits, one initiating device rings a group of phones on the other circuit endpoints.

Automatic ringdowns are activated on ShoreTel IP Phones by pushing an IP Phone Call Appearance button or lifting a handset on a dedicated ringdown device. These actions cause the recipient device to continuously ring until the call is answered or the calling party ends the call. The Call Handling Mode on the recipient device is ignored for ringdown calls. Automatic ringdown is supported only by phone; Communicator does not support automatic ringdown.

ShoreTel implements Ringdown through the following methods:

- **Dedicated Circuit Ringdown**: Ringdown is immediately initiated when a programmed Call Appearance button is pushed or a specified device goes off hook. The ringdown call is answered on the recipient device by pressing the corresponding Call Appearance button or taking the device off hook.

- **Phone Delayed Ringdown**: ShoreTel permits IP phones that provide a dial tone to perform ringdowns by taking the handset off hook. If a number is not dialed within a specified period after taking the phone off hook, a ringdown call is directed to the recipient device.
Configuration Pages in ShoreTel Director

Ringdown circuits are implemented by configuring IP phone buttons for circuit endpoints through ShoreTel Director. Delayed ringdown circuits are configured from the Edit User – General page.

Configuring IP Phone Buttons

You configure IP phone buttons for ShoreTel users on the Program IP Phone Buttons page. To access the Program IP Phone Buttons page, open the Edit User – Personal Options page for the desired user, and then click Program IP Phone Buttons.

BCA Ringdown Parameters

- **Dial Tone**: Select this option to configure the phone as the recipient on a ringdown circuit. Buttons configured with Dial Tone cannot initiate ringdown calls.

- **Dial Extension**: Select this option to configure the button as the initiating end of a ringdown circuit when the recipient is an IP phone located on the ShoreTel network. The Extension data entry field specifies the Bridged Call Appearance that is dialed when the IP Phone button is pushed. Buttons configured to perform ringdown calls can also receive ringdown calls.

- **Dial External**: Select this option to configure the button as the calling end of a ringdown circuit when the recipient is a device not located on the ShoreTel network. The data entry field specifies the phone number that is dialed when the IP phone button is pushed; the trunk access code required to access the trunk group dedicated to this ringdown circuit must be included as part of the phone number.

Configuring a Delayed Ringdown Circuit

Delayed ringdown circuits are configured on the bottom third of the Edit User – General page for the user extension that initiates the ringdown call.

Delayed Ringdown Circuit parameters include:

- **Delayed Ringdown**: Select this check box to enable Delayed Ringdown for the extension. If this parameter is not enabled, all other Ringdown parameters are not selectable.

- **Extension**: Select this option to specify a ShoreTel extension as the recipient device, and then enter the extension of the recipient device in the corresponding field.

- **External Number**: Select this option to specify a phone outside of the ShoreTel network as the recipient device, and then enter the phone number of the recipient device, including the Trunk Access Code of the ringdown trunk, in the corresponding field.

- **Ringdown Delay**: Enter the period of time that the phone waits after the user picks up the handset before initiating the ringdown call. Enter 0 in this field to cause the phone to immediately dial the ringdown device whenever the handset is picked up.
Ringdown Procedures

The following sections describe the procedures required to implement various ringdown circuit configurations.

Implementing a One-to-One Unidirectional Ringdown Circuit

Unidirectional ringdown circuits require two Bridged Call Appearances – one for the calling device and one for the recipient device. Both devices in this procedure are ShoreTel extensions.

1. Create two Bridged Call Appearances as follows:
   a. Launch ShoreTel Director.
   b. Click Administration > Call Control > Bridged Call Appearances.
   c. Click New.
      The Edit Bridged Call Appearance page appears.
   d. Set parameters for a new profile. (For more information about creating a Bridged Call Appearance profile, see Configuring BCA Parameters on page 264.)

2. Program an IP phone button on the calling device to make ringdown calls, as follows:
   a. Click Administration > Users > Individual Users.
      The Individual Users page appears.
   b. Select the user that you want to allow to use BCA.
      The Edit User page appears.
   c. Click the Personal Options tab.
   d. Click Program IP Phone Buttons.
      The Program IP Phone Buttons page appears.
   e. In the Device Type field, select the device the user uses for bridged calls.
   f. For the button that you want to program for the user, do the following:
      1. In the first Function field, select All or Telephony.
      2. In the second Function field, select Bridged Call Appearance.
      3. In the Long Label and Short Label fields, type a label to appear next to the button on the phone LED display to remind the user of the button’s function. (For details about labels, see Configuring Programmable Buttons through ShoreTel Director on page 237.)
      4. In the Extension field, enter the extension number of the BCA profile with which you want to associate the user.
5. In the Call Stack Position field, select the call escalation order with which you want to associate the user.

6. In the Ring Delay Before Alert field, select the number of times that you want the phone of the user to ring before an automatic message is played.

7. In the Show Caller ID on Monitored Extension field, click the radio button for the value that describes when you want the caller ID of this user to display for calls the user monitors.

8. Check the **Enable Auto-Answer When Alerting** check box to the user to use standard means for answering phone calls.

9. In the No Connected Call Action section, click the radio button for how the call is to be handle when there is not answer.

   g. Click **Save**.

3. Program an IP phone button on the recipient device to receive ringdown calls, as follows:
   
a. Create a button for a second user as described in Step 2 above.

   b. Enter the second Bridged Call Appearance extension number created in Step 1 in the Extension Field located to the right of the button function selection fields.

   c. Select **Dial Tone**, located below the Extension Field.

   d. Click **Save**.

### Implementing a One-to-One Bidirectional Ringdown Circuit

Creating a bidirectional ringdown circuits differs from creating a unidirectional circuit in that the recipient device is configured to make ringdown calls. Both devices in this procedure are ShoreTel extensions.

1. Create two Bridged Call Appearances.

   Bridged Call Appearances are listed in the Bridged Call Appearance list page, which is accessed by selecting **Administration > Call Control > Bridged Call Appearances** from the Director menu. Click **New** at the top of this page to create new BCAs.

2. Program an IP phone button on the calling device to make ringdown calls, as follows:
   
a. Launch ShoreTel Director.

   b. Click **Administration > Users > Individual Users**.

   c. In the First Name column, click the name of the desired user.

      The Edit User page appears.

   d. Click the **Personal Options** tab.

   e. Click the **Program IP Phone Buttons** link.

      The Program IP Phone Buttons page appears.
f. In the first Function field, select All or Telephony.

g. In the second Function field, select Bridged Call Appearance.

Bridged Call Appearance parameters populate the Target pane.

h. Enter the first Bridged Call Appearance extension number created in Step 1 in the Extension Field located right of the button function selection fields.

i. Select Dial Tone, located below the Extension field, and enter the second Bridged Call Appearance number created in Step 1 in the corresponding data entry field.

j. Click Save.

3. Program an IP Phone Button on the recipient device to make ringdown calls, as follows:

   a. Repeat Step a through Step e (under Step 2) for the recipient user’s extension.

   b. Enter the second Bridged Call Appearance extension number created in Step 1 in the Extension Field located right of the button function selection fields.

   c. Select Dial Tone, located below the Extension field, and enter the first Bridged Call Appearance number created in Step 1 in the corresponding data entry field.

   d. Click Save.

Creating One-to-Many Ringdown Circuits

The process for creating a one-to-many ringdown circuit differs from creating a One-to-One circuit in that the process of configuring the recipient devices is repeated for each recipient device in the ringdown network.

Implementing a Delayed Ringdown Circuit

A unidirectional delayed ringdown circuit requires one Bridged Call Appearance that is assigned to the recipient end of the circuit.

1. Create one Bridged Call Appearance.

2. Program a phone to make ringdown calls, as follows:

   a. Open the Individual User list page in Director by selecting Administration > Users > Individual Users from the main menu.

   b. Open the Edit User page by clicking the First Name of the desired user in the Individual User List.

   c. Click the General tab.

   d. Select Delayed Ringdown and do one of the following:

      • Click the Extension radio button and enter the Bridged Call Appearance extension that you want to associate with the user.
Click the **External Number** radio button and enter the external number that you want to associate the user with in the field.

e. In the **Ringdown Delay** field, enter the amount of time in seconds that you want the system to wait for the receiver to respond before dialing the ringdown number.

The delay period is the time between when the handset is lifted and when the ringdown call is initiated.

3. Program an IP phone button on the recipient device to receive ringdown calls, as follows:

a. Open the Individual User list page in Director by selecting **Administration > Users > Individual Users** from the main menu.

b. Open the Edit User page by clicking the First Name of the desired user in the Individual User List.

c. Select **Personal Options** on the page selection bar at the top of the page.

d. Click **Program IP Phone Buttons** to open the Program IP Phone Buttons page.

e. Select **Bridged Call Appearance** as the function for the desired IP button.

f. Enter the initiator’s extension number in the Extension Field located right of the button function selection fields.

h. Select **Dial Tone**, located below the Extension Field.

h. Click **Save**.

**Creating a Ringdown Circuit with an External Endpoint**

The process for creating a ringdown circuit to an external endpoint differs from the procedure for circuits with internal endpoint as follows:

- The number of the recipient device is entered in External Number data entry fields instead of the Extension data fields.

- These fields are located in the Program IP Phone Buttons page and the Edit User page.

- The external number must be accessed through a specific trunk that is configured as the only trunk within a trunk group.

- The number of the recipient device includes the Trunk Access Code of the specified trunk group.

**Media Encryption**

ShoreTel encrypts RTP (payload) packets within the ShoreTel network. Call control packets are encrypted on ShoreTel 400-Series IP phones. Call control packets are not encrypted on older ShoreTel IP phones.
System Support

Encryption is enabled or disabled through ShoreTel Director on a system basis only and cannot be enabled for individual devices or selected calls. End users have no control over which calls are encrypted. Changing the system encryption setting does not alter calls that are in progress; unencrypted calls in progress when encryption is enabled remain unencrypted until the calls are terminated.

System administrators enable and select an encryption algorithm through ShoreTel Director. The following encryption options are available:

- None
- SRTP - 128 bit AES
- 128 bit ShoreTel Proprietary

**Note**

In ShoreTel 14 and later releases, ShoreTel Proprietary media encryption is available only if the system was upgraded from an earlier version of the ShoreTel system in which ShoreTel Proprietary encryption was enabled.

The ShoreTel 930D- and 400-Series IP phones do not support the ShoreTel proprietary encryption setting, and hence plays a loud static for the duration of a call. To stop hearing to the loud static you must browse to **Administration > Call Control... > Options** page and select **SRTP - 128 bit AES** in the Media Encryption: field.

SRTP with AES and authentication has a significant impact on the system load when a large number of media channels are encrypted.

SRTP-AES encryption is available on ShoreTel 9 and later systems. It does not require a license.

Supported Platforms

Switches and Codecs

Encryption is supported by the following ShoreTel voice switches:

- All voicemail-enabled switches
- All 1-U Half Width switches
- All 1-U Full Width switches

Switches do not support SRTP with linear (LRNB/8000) or wide-band (LRWB/16000) codecs. When SRTP is enabled, codec negotiation excludes these codecs.

ShoreTel switches support a maximum of 36 encrypted media streams. This limitation potentially impacts switches that provide T1 or E1 channels with high three-way conference call traffic.

Each channel in a three-way conference requires two media stream encryption resources, limiting switches to 18 encrypted channels for three-way conferences. In this scenario, all remaining trunks provided by the switch are blocked while 18 channels are engaged in three-way conference calls.
Switches can service any combination of two-way (one encrypted media stream) and three-way (two encrypted media streams) calls that do not exceed 36 media streams. Analog ports on the SG-220T1A are included in this limitation.

**Phones and Applications**

Encryption is supported for all ShoreTel IP phones that run on a ShoreTel network. SoftPhone, which is available through Communicator, does not support encryption.

Assuming that Media Encryption is enabled in ShoreTel Director, whether media encryption is in effect for a particular call depends on the type of phones involved in the call, as follows:

- All calls involving only ShoreTel 400-Series IP phones are encrypted.
- All calls involving only older ShoreTel IP phones (MGCP phones) are encrypted.
- All calls involving both ShoreTel 400-Series IP phones and older ShoreTel phones are not encrypted. However, if all callers using one type of phone drop out of a mixed-phone conference call, leaving only callers with the same type of phone in the call, then the call is encrypted.

ShoreTel Communicator and ShoreTel IP phones (except for ShoreTel IP110 and IP115 phones) display a padlock icon for each call with active SRTP encryption. The Call History list also uses the padlock icon to indicate encrypted calls. The padlock icon indicates the call is secure on the ShoreTel network; ShoreTel cannot guarantee call security outside of the network, such as calls that terminate across an analog or digital trunk.

![Note]

The padlock icon does not appear when Proprietary Encryption is active.

ShoreTel service appliances support SRTP-AES encryption. For some other ShoreTel products, the following distinctions might be important to keep in mind:

- If the Headquarters server is hosting voicemail and Auto-Attendant, it does not encrypt the media stream by using SRTP-AES encryption.
- If the voicemail-capable switches (such as the ShoreTel Voice Switch 90V) are hosting voicemail and Auto-Attendant, the switch encrypts the media stream.
- The IP 8000 Conference Phone does not support SRTP-AES encryption.

Phones that do not support SRTP cannot perform barge in, whisper, or silent monitor functions on calls that are using SRTP encryption. When added to a call using SRTP, new parties using devices that do not support SRTP exchange unencrypted media streams. SRTP does not address user registration, call setup, or signaling-related security.

**To configure media encryption:**

1. Launch ShoreTel Director.
2. Click **Administration > Call Control > Options**.

The Call Control Options page appears.
3. In the **Media Encryption** field, select **SRTP - 128 bit AES**.

4. Click **Save**.
This chapter describes how to create a user account and configure all parameters that relate to the user. This chapter provides the needed information for two contexts of user configuration. One context is a new ShoreTel installation.

For a new installation, the system administrator is configuring all of the system components that precede the creation of individual user accounts.

The other context is an established ShoreTel network. In this case, the reader can bypass the prerequisite sections and use just the information in Configuring a User Account on page 354 to add a new user or view existing user accounts.

The topics in this chapter include:

Overview ................................................................. 337
Specifying a Class of Service ....................................................... 337
  Configuring a COS ............................................................... 337
  Telephony Features Permissions .............................................. 338
Call Permissions ................................................................. 345
  Voice Mail Permissions .......................................................... 348
Configuring User Groups .......................................................... 351
  Viewing User Groups .............................................................. 351
  Creating a User Group .......................................................... 352
Configuring a User Account .......................................................... 354
  Using the Individual Users Page .............................................. 354
  Configuring Users ................................................................. 356
  Voice Mail Password Recommendations .................................. 368
System Directory Record .......................................................... 368
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Active Directory</td>
<td>369</td>
</tr>
<tr>
<td>Active Directory Implementation</td>
<td>369</td>
</tr>
<tr>
<td>Enabling AD Integration on a ShoreTel System</td>
<td>369</td>
</tr>
<tr>
<td>Configuring Active Directory on a New System</td>
<td>370</td>
</tr>
<tr>
<td>Synchronizing AD and Director User Records</td>
<td>375</td>
</tr>
<tr>
<td>Bulk Provisioning of User Accounts</td>
<td>376</td>
</tr>
<tr>
<td>User Management Utilities</td>
<td>378</td>
</tr>
<tr>
<td>User Import Tool</td>
<td>378</td>
</tr>
<tr>
<td>Batch Update Utility</td>
<td>383</td>
</tr>
<tr>
<td>Notify Users</td>
<td>386</td>
</tr>
<tr>
<td>Extension Lists</td>
<td>387</td>
</tr>
</tbody>
</table>
Overview

To create user accounts on a new ShoreTel system, perform the steps in this chapter in the following order:

1. Specify the classes of service (COS).
2. Create the user groups.
3. Create individual user accounts.

For a new system, have the following information available to expedite the creation of new user accounts:

- A list or outline of the COSs that are appropriate for the ShoreTel deployment and available for assignment to user groups
- A list or outline of user groups to which individual users are assigned
- A list of new users to add to the system

Note

A new ShoreTel system has sets of default COSs and user groups.

The Users link in the Director navigation pane provides access to the pages for Individual Users, User Groups, Class of Service (COS), Notify Users, Anonymous Telephones, Extension Lists, Batch Update Utility, and Call Handling Mode Defaults.

Specifying a Class of Service

A Class of Service (COS) specifies a set of features and privileges. A user’s assigned COS determines the features that user can access. ShoreTel defines three types of service classes: telephony features, call permissions, and voicemail permissions.

Configuring a COS

1. Launch ShoreTel Director.
2. Click Administration > Users > Class of Service.

The Class of Service page appears as shown in Figure 95.
Descriptions and instructions for configuring the users’ permissions for telephony features, outside calling, and voice mail are in the following sections:

- **Telephony Features Permissions** on page 338
- **Call Permissions** on page 345
- **Voice Mail Permissions** on page 348

### Telephony Features Permissions

This section describes the Classes of Service that can be configured from the Telephony Features Permissions edit page. Telephony features permissions are assigned to user groups and define how users can use their telephone features, such as call stack depth, paging, and call forwarding to an external number.

#### Configuring a Telephony Feature COS

1. Navigate to the Class of Service window.
2. Click one of the preconfigured COS profiles (Fully Featured, Minimally Featured, or Partially Featured) or the Add New link to create a new class of service for Telephony Features.

   The Edit Telephony Features Permissions page for the class of service you select displays.

3. Specify the COS parameters, as defined in Table 38.
**Table 38: Class of Service Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies a descriptive name of the COS that you are creating or editing.</td>
</tr>
<tr>
<td>Max. Call Stack Depth</td>
<td>Specifies the maximum number of simultaneous calls that can be “stacked” on a user’ extension. When this number is reached, additional inbound calls are routed to the call forward busy destination. Valid entries are 1–16.</td>
</tr>
<tr>
<td>Max. Buddies Per User</td>
<td>Specifies the number of individuals that a service class member can designate as a contact in Communicator. Users can monitor presence status of their contacts. Valid entries are 1-500.</td>
</tr>
<tr>
<td>Max. Personal Contacts</td>
<td>Specifies the maximum number of personal contacts that a user with this COS can have in ShoreTel Communicator.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To enable users to upload personal contacts, you must select the <strong>Allow Upload of Personal Contacts to Server</strong> check box on this page.</td>
</tr>
<tr>
<td>Max. Parties in Make Me Conference</td>
<td>Specifies the maximum number of parties that can be included in any Make Me Conference call made from your site. Select the number of parties from the drop-down list. The default value is 3, and the value range is 3 through 6.</td>
</tr>
<tr>
<td>IM Presence Invitation Handling</td>
<td>Designates the default method of handling requests for viewing IM presence status. Each user can specify personal handling methods through ShoreTel Communicator.</td>
</tr>
<tr>
<td>Allow Call Pickup</td>
<td>Enables call pickup. Call pickup allows users to pick up any ringing extension (including the night bell) or pick up any parked call.</td>
</tr>
</tbody>
</table>
Allow Trunk-to-Trunk Transfer | Enables trunk-to-trunk call transfers. Examples of trunk-to-trunk transfers include the following call scenarios:
- An internal party is talking with an external party. The internal party transfers the external party either blindly or consultatively to an external party by using the telephone or ShoreTel Communicator.
- During a three-party conference call that has one internal party and two external parties, the internal party drops out of the call by using the phone (its handset or buttons) or by using ShoreTel Communicator.

**Note:** Trunk-to-trunk transfer does not refer to the transfer of a call from an external party to an external number by a user’s Call Handling Mode (specifically, Allow External Call-forwarding).

When enabled, trunk-to-trunk transfer is automatic and bypasses toll-related call permissions. If a potential exists for toll fraud by employees who could abuse this feature, selectively limit permission to a few user groups (such as executive and sales user groups). If this parameter is enabled, you can manage the trunk-to-trunk feature in the Call Control Options page.

Allow Overhead and Group Paging | Allows users to dial any site paging extension and make an announcement by using the overhead paging system or group paging.

Allow Make Hunt Group Busy | Allows users to perform the following actions:
- Busy-out a hunt group.
- Return the hunt group to service by keying *18 on the telephone keypad.

You can also use Quick Look Maintenance to busy out or return a hunt group to service. Calls are forwarded to the Busy Destination in the Hunt Groups page.

If a hunt group it busied out during a holiday or an off-hours schedule, the schedule takes precedence.

Allow Extension Reassignment | Allows users to reassign their extension to another telephone.

Allow PSTN Failover | Allows site-to-site calls that fail over proprietary routes to be automatically rerouted over a PSTN number. You must enter the PSTN number to use in case of failure on the User edit page.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Allow Trunk-to-Trunk Transfer | Enables trunk-to-trunk call transfers. Examples of trunk-to-trunk transfers include the following call scenarios:
- An internal party is talking with an external party. The internal party transfers the external party either blindly or consultatively to an external party by using the telephone or ShoreTel Communicator.
- During a three-party conference call that has one internal party and two external parties, the internal party drops out of the call by using the phone (its handset or buttons) or by using ShoreTel Communicator.

**Note:** Trunk-to-trunk transfer does not refer to the transfer of a call from an external party to an external number by a user’s Call Handling Mode (specifically, Allow External Call-forwarding).

When enabled, trunk-to-trunk transfer is automatic and bypasses toll-related call permissions. If a potential exists for toll fraud by employees who could abuse this feature, selectively limit permission to a few user groups (such as executive and sales user groups). If this parameter is enabled, you can manage the trunk-to-trunk feature in the Call Control Options page. |
| Allow Overhead and Group Paging | Allows users to dial any site paging extension and make an announcement by using the overhead paging system or group paging. |
| Allow Make Hunt Group Busy | Allows users to perform the following actions:
- Busy-out a hunt group.
- Return the hunt group to service by keying *18 on the telephone keypad.

You can also use Quick Look Maintenance to busy out or return a hunt group to service. Calls are forwarded to the Busy Destination in the Hunt Groups page.

If a hunt group it busied out during a holiday or an off-hours schedule, the schedule takes precedence. |
| Allow Extension Reassignment | Allows users to reassign their extension to another telephone. |
| Allow PSTN Failover | Allows site-to-site calls that fail over proprietary routes to be automatically rerouted over a PSTN number. You must enter the PSTN number to use in case of failure on the User edit page. |
### Table 38: Class of Service Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Caller ID Name and Number for Other Extensions</td>
<td>Allows a user to see incoming caller ID. The impact of this setting is system-wide; for example, it determines whether caller ID appears for any other user extension, in Communicator, on phone displays, and elsewhere.</td>
</tr>
<tr>
<td>Enumerate Individual Held Calls for Unpark</td>
<td>Authorize users to view individual calls parked on another user’s call stack. A user require this authorization to specify the call to be unparked from another user’s stack.</td>
</tr>
<tr>
<td>Allow Customization of IP Phone Buttons and Communicator Monitor Windows</td>
<td>Allow users to configure the programmable buttons on their ShoreTel IP Phone or BB24 device. Clear the check box to prevent users from being able to configure custom buttons. For example, this action prevents users from being able to configure their phones to monitor the extension of another user and requires that Extension Monitor and other features to be set up by a system administrator.</td>
</tr>
<tr>
<td>Show Extensions with Different Prefixes in Directory</td>
<td>Displays extensions that have different prefixes. The On-Net Dialing feature often cause a remote site to have a different prefix from a headquarters site. Enabling this check box causes all extensions (including the remote) to appear in the directory.</td>
</tr>
<tr>
<td>Allow Collaboration Features</td>
<td>Enables document sharing. For more information, see Chapter 11, Configuring Client Applications on page 389.</td>
</tr>
<tr>
<td>Allow Recording of Own Calls</td>
<td>Allows a user to record a call. This function is also affected by the Enable Monitor/Record Warning Tone parameter. For more information, see Chapter 9, Setting Call Control Options on page 253.</td>
</tr>
<tr>
<td>Allow Intersite Video Calls</td>
<td>Enables users to participate in video call with users at other ShoreTel sites. Intersite video traverses SIP trunks.</td>
</tr>
</tbody>
</table>
| Allow Call Notes                              | Enables the Call Notes feature in ShoreTel Communicator. This feature enables users to make text notes during calls. Notes appear in the call history.  

**Note:** If you disable the Call Notes feature in ShoreTel Director, existing notes remain available for users to view but will not be editable.                                                                                                                                                                                                 |
| Show Call History/Call Details                | Select this check box to enable call activity tracking. Call detail records are recorded for all calls and call history is available from the phone redial and will show in the ShoreTel Communicator call history.  

Clear this check box to enable Call History Privacy. Users can place and receive calls without the calls being tracked and recorded in the call detail records. In addition, the calls will not be available from the phone redial and will not show in the ShoreTel Communicator call history. |
### Class of Service Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Upload of Personal Contacts to Server</td>
<td>Enables users to upload contacts in ShoreTel Communicator.</td>
</tr>
<tr>
<td>Directed Intercom/Group Paging</td>
<td>Enables the Directed Intercom/Group Paging feature. For more information about configuring this feature, see Intercom, Whisper Paging, Barge In, Record, and Monitor on page 473.</td>
</tr>
<tr>
<td>Whisper Paging</td>
<td>Enables the Whisper Pager feature. For more information about configuring this feature, see Intercom, Whisper Paging, Barge In, Record, and Monitor on page 473.</td>
</tr>
<tr>
<td>Barge In</td>
<td>Allows users to barge in on other users with Allow Barge enabled. Note: Barge In permits one party to join an existing call as a fully conferenced participant. When barge in is initiated, a brief intrusion tone is played to the other participants and (if present) the monitor/record warning tone is discontinued. For more information, see Call Handling Mode Delegation on page 471.</td>
</tr>
<tr>
<td>Record Other’s Calls</td>
<td>Enables users to record the call of another user. For example, a supervisor could record the call of an agent. For more information, see Intercom, Whisper Paging, Barge In, Record, and Monitor on page 473. The Selectable Mailboxes feature allows recorded calls to be automatically placed into mailboxes other than the mailbox of the user who recorded the call. For more information, see Chapter 8, Configuring IP Phones on page 209. When you record another user’s call, the system plays a warning tone. To disable the tone, see the General Parameters Area in the Options Window on page 311.</td>
</tr>
<tr>
<td>Silent Monitor/Silent Coach Other’s Calls</td>
<td>Allows a supervisor to monitor a phone call of a user and to speak to the user without the other party hearing. For more information, see Intercom, Whisper Paging, Barge In, Record, and Monitor on page 473.</td>
</tr>
<tr>
<td>Allow Call Handling Changes</td>
<td>Allows users to make the following changes to their call handling settings: Current Mode: Select this check box to allow users to change their current call handling mode from ShoreTel IP Phone IP phones and Personal Communicator. Detailed Settings: Select this check box to allow users to change all call handling settings, such as call forward destinations, from Personal Communicator.</td>
</tr>
</tbody>
</table>
### Table 38: Class of Service Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Allow External Call-Forwarding and Find Me Destinations | Allows users to forward incoming call to an external number:  
  - Allow External Assignment: Select this check box to allow users to assign their extension to a PSTN phone for use with the Extension Assignment feature. If you select this check box is marked, the user can use a cell phone or home phone as an extension in the ShoreTel network.  
  - Allow Additional Phones to Ring Simultaneously and to Move Calls: Select his check box to allow users to configure one or two additional phones to ring at the same time as their main ShoreTel phone. The user can specify the phone number of additional phones in ShoreTel Communicator, or the Administrator can configure these numbers through the ShoreTel Director Individual Users page (**Personal Options > External Assignment and Additional Phones**). After a simultaneous ringing call is established, the user can move the call between devices by using a ShoreTel IP phone.  
  **Note:** The user can suspend this function by using ShoreTel Communicator. Also, an optional ring delay can be configured by the Administrator to let the main telephone ring a configurable number of times before the additional phones start ringing. |
| Scope                                               | Configures the following call permission levels for the COS:  
  - Local Only: Allows forwarding or extension reassignment only to local or additional local area codes, as defined on the Site edit page.  
  - National Long Distance: Allows forwarding or extension reassignment to long-distance numbers within the country, as defined on the Site edit page.  
  - National Mobile: Allows forwarding or extension reassignment to mobile numbers. Since some countries use caller-pays mobile calling, do not select this option to avoid incurring the associated costs of calls being sent to a mobile phone.  
  - International Long Distance: Allows forwarding or extension reassignment to international numbers, as defined on the Site edit page.  
  - All Calls: Allows forwarding or extension reassignment to any number, including Carrier Select, Operator Assisted, and 900 numbers. This capability is enabled by default. |
Table 38: Class of Service Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrictions</td>
<td>Applied to calls in addition to the Scope. Follow these rules for specifying restrictions:</td>
</tr>
<tr>
<td></td>
<td>• The comma-separated restriction expressions have a limit of 50 characters, total (including commas and semicolons).</td>
</tr>
<tr>
<td></td>
<td>• Numbers must be entered in canonical format, including the international designation “+” and country code. For example, to restrict forwarding to the 408 area code in the U.S., use +1408.</td>
</tr>
<tr>
<td></td>
<td>• Non-routable calls (311, 411, etc.) for a country must be designated by the country code plus the “/” character. For example, to restrict forwarding to 311 in the U.S., use 1/311.</td>
</tr>
<tr>
<td></td>
<td>• Each field can contain multiple entries as long as they are separated by commas or semicolons.</td>
</tr>
<tr>
<td></td>
<td>• Multiple entries must be separated by commas or semicolons and can consist only of the numerals 0–9, “x,” “/,” or “+.”</td>
</tr>
<tr>
<td></td>
<td>• Access codes (such as 9) must not be included.</td>
</tr>
<tr>
<td></td>
<td>• The wildcard of “x” can be used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When a call is both restricted and permitted, it is permitted. For example, restricting +1 408 and permitting +1 408 331 restricts all calls to the 408 area code except those to 408 331-xxxx.</td>
</tr>
</tbody>
</table>
Call Permissions

This section describes the types of call permissions the ShoreTel administrator can set. Call permissions are classes of service that specify the type of call users are allowed to dial. Call permissions are assigned to user groups. Figure 96 shows the Call Permissions edit page.

Table 38: Class of Service Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Permissions | Applied in addition to the Scope. Follow these guidelines for specifying permissions:  
- The comma-separated permission expressions have a limit of 50 characters, total (including commas and semicolons).  
- Numbers must be entered in canonical format including the international designation “+” and country code. For example, to permit forwarding to the 408331 area code and prefix in the U.S., use +1408331. 
- Non-routable calls (311, 411, and so on) for a country must be designated by the country code plus the “/” character. For example, to permit forwarding to 311 in the U.S., use 1/311.  
- Each field can contain multiple entries as long as they are separated by commas or semicolons.  
- Multiple entries must be separated by commas or semicolons and can consist only of the numerals 0–9, “x,” “/,” or “+.”  
- Access codes, such as 9, must not be included.  
- The wildcard of “x” can be used.  
When a call is both restricted and permitted, it is permitted. For example, restricting +1 408 and permitting +1 408 331 restricts all calls to the 408 area code except those to 408 331-xxxx. |
### Table 39: Call Permissions Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Shows the descriptive name of the COS being added or edited.</td>
</tr>
<tr>
<td>Scope</td>
<td>Defines the following general permission levels for the COS:</td>
</tr>
<tr>
<td></td>
<td>- Internal Only: Allows calls only to internal extensions and to the configured emergency number.</td>
</tr>
<tr>
<td></td>
<td>- Local Only: Allows calls only to local or additional local area codes, as defined on the Site edit page.</td>
</tr>
<tr>
<td></td>
<td>- National Long Distance: Allows calls to long-distance numbers within the country, as defined on the Site edit page.</td>
</tr>
<tr>
<td></td>
<td>- National Mobile: Allows calls to mobile numbers within the country, as defined on the Site edit page.</td>
</tr>
<tr>
<td></td>
<td>- International Long Distance: Allows calls to international numbers, as defined on the Site edit page.</td>
</tr>
<tr>
<td></td>
<td>- All Calls (Default): Allows calls to any number, including 900, Operator Assisted, and Carrier Select numbers. It supports use of Vertical Service Codes.</td>
</tr>
</tbody>
</table>
Restrictions

Applied in addition to the Scope setting. The rules for specifying restrictions are as follows:

- For this COS, the maximum number of characters in the comma-separated restriction expressions is 255.
- Numbers must be entered in canonical format including the international designation “+” and country code. For example, to restrict calls to the 408 area code in the U.S., type +1408.
- Non-routable calls (311, 411, and so on) for a country must be designated by the country code plus the “/” character. For example, to restrict 311 in the U.S., type 1/311.
- Each field can contain multiple entries as long as they are separated by commas or semicolons.
- Multiple entries must be separated by commas or semicolons and can consist only of the numerals 0–9, “x,” “/,” or “+.”
- Access codes, such as 9, must not be included.
- The wildcard of “x” can be used.

**Note:** If a call is both restricted and permitted, it is permitted. This behavior can be used to create a filter. For example, restricting +1 408 and permitting +1 408 331 restricts all calls to the 408 area code except those to 408 331-xxxx.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrictions</td>
<td>Applied in addition to the Scope setting. The rules for specifying restrictions are as follows:</td>
</tr>
<tr>
<td></td>
<td>- For this COS, the maximum number of characters in the comma-separated restriction expressions is 255.</td>
</tr>
<tr>
<td></td>
<td>- Numbers must be entered in canonical format including the international designation “+” and country code. For example, to restrict calls to the 408 area code in the U.S., type +1408.</td>
</tr>
<tr>
<td></td>
<td>- Non-routable calls (311, 411, and so on) for a country must be designated by the country code plus the “/” character. For example, to restrict 311 in the U.S., type 1/311.</td>
</tr>
<tr>
<td></td>
<td>- Each field can contain multiple entries as long as they are separated by commas or semicolons.</td>
</tr>
<tr>
<td></td>
<td>- Multiple entries must be separated by commas or semicolons and can consist only of the numerals 0–9, “x,” “/,” or “+.”</td>
</tr>
<tr>
<td></td>
<td>- Access codes, such as 9, must not be included.</td>
</tr>
<tr>
<td></td>
<td>- The wildcard of “x” can be used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If a call is both restricted and permitted, it is permitted. This behavior can be used to create a filter. For example, restricting +1 408 and permitting +1 408 331 restricts all calls to the 408 area code except those to 408 331-xxxx.</td>
</tr>
</tbody>
</table>
Voice Mail Permissions

This section describes the classes of service that you configure from the Voice Mail Permissions edit page, shown in Figure 97. Voice mail permissions are assigned to user groups, providing users with specific usage of the ShoreTel voice mail system.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions</td>
<td>Applied in addition to the Scope setting. The rules for entering restrictions are as follows:</td>
</tr>
<tr>
<td></td>
<td>- For this COS, the maximum number of characters in the comma-separated permission expressions is 255.</td>
</tr>
<tr>
<td></td>
<td>- In general, numbers must be entered in canonical format including the international designation “+” and country code. For example, to permit calls to the 408331 area code and prefix in the U.S., use +1408331.</td>
</tr>
<tr>
<td></td>
<td>- Non-routable calls (311, 411, and so on) for a country must be designated by the country code plus the “/” character. For example, to permit 311 in the U.S., use 1/311.</td>
</tr>
<tr>
<td></td>
<td>- Each field can contain multiple entries as long as they are separated by commas or semicolons.</td>
</tr>
<tr>
<td></td>
<td>- Multiple entries must be separated by commas or semicolons and can consist only of the numerals 0–9, “x,” “/,” or “+.”</td>
</tr>
<tr>
<td></td>
<td>- Access codes, such as 9, must not be included.</td>
</tr>
<tr>
<td></td>
<td>- The wildcard of “x” can be used.</td>
</tr>
<tr>
<td></td>
<td>Note: If a call is both restricted and permitted, it is permitted. This behavior can be used to create a filter. For example, restricting +1 408 and permitting +1 408 331 restricts all calls to the 408 area code except those to 408 331-xxxx.</td>
</tr>
</tbody>
</table>
The parameters on the Voice Mail Permissions edit page are shown in the following table:

**Table 40: Voice Mail Permissions Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Describes the name of the COS record that you are creating or editing.</td>
</tr>
<tr>
<td>Incoming Message Length (0 - 3600)</td>
<td>Specifies the maximum length of an incoming voice mail message.</td>
</tr>
<tr>
<td></td>
<td>■ Default: 300 seconds</td>
</tr>
<tr>
<td>Incoming Max. Messages (0 - 500)</td>
<td>Specifies the maximum number of messages that can be queued in a mailbox, including new and saved messages.</td>
</tr>
<tr>
<td></td>
<td>■ Default: 50 seconds</td>
</tr>
<tr>
<td>Outgoing Message Length (0 - 3600)</td>
<td>Specifies the maximum message length that a user can record before sending a message to another extension. This parameter controls both</td>
</tr>
<tr>
<td></td>
<td>■ Default: 300 seconds</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not confuse this message with the user’s personal voice mail greeting.</td>
</tr>
<tr>
<td>Enable Voice Mail Callback</td>
<td>Enables users with this COS to call back a caller after listening to a voice mail from the caller on a telephone.</td>
</tr>
</tbody>
</table>

**Figure 97: Voice Mail Permissions Edit Page**

![Voice Mail Permissions Edit Page](image)
### Configuring Users Voice Mail Permissions

#### Lifespan of Voicemail Password (30 - 365)
- Enables users to set the lifespan of their voice mail password.
- To increase system security, ShoreTel recommends that you enable this feature.
  - Default: 90 days
- The password change applies to the following Dialed Number types:
  - User extensions
  - Workgroup extensions
  - Route point extensions
  - External user extension

#### Days in Advance of Password Expiration Before Warning (1 - 30)
- Specifies the number of days before their password expires that users are notified about the upcoming expiration of their password.
  - Default: 7 days
- **Note**: If you do not enable this warning, password expiration warning messages are not sent to the COS members.

#### Allow Access to Broadcast Distribution List
- Allows users to have access to the company-wide distribution list. A user with this permission can broadcast voice mail messages to all users.

#### Allow Access to System Distribution Lists
- Allows users to access system distribution lists.

#### Allow Message Notification
- Enables message notification.
  - Default: Enabled

#### Allow Message Notification to External Number
- Enables message notification to an external number. This parameter cannot be enabled unless Allow Message Notification is also enabled.
  - Default: Enabled

#### Allow Downloading Voice Messages as WAV Files
- Allow users to download voice messages as WAV files.

#### Voice Mail Prompt Style
- Selects one of the following prompt styles:
  - ShoreTel
  - Legacy Voice Mail TUI
  - Default: ShoreTel

### Table 40: Voice Mail Permissions Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lifespan of Voicemail Password (30 - 365)</td>
<td>Enables users to set the lifespan of their voice mail password. To increase system security, ShoreTel recommends that you enable this feature.</td>
</tr>
<tr>
<td>Days in Advance of Password Expiration Before Warning (1 - 30)</td>
<td>Specifies the number of days before their password expires that users are notified about the upcoming expiration of their password.</td>
</tr>
<tr>
<td>Allow Access to Broadcast Distribution List</td>
<td>Allows users to have access to the company-wide distribution list. A user with this permission can broadcast voice mail messages to all users.</td>
</tr>
<tr>
<td>Allow Access to System Distribution Lists</td>
<td>Allows users to access system distribution lists.</td>
</tr>
<tr>
<td>Allow Message Notification</td>
<td>Enables message notification.</td>
</tr>
<tr>
<td>Allow Message Notification to External Number</td>
<td>Enables message notification to an external number. This parameter cannot be enabled unless Allow Message Notification is also enabled.</td>
</tr>
<tr>
<td>Allow Downloading Voice Messages as WAV Files</td>
<td>Allow users to download voice messages as WAV files.</td>
</tr>
<tr>
<td>Voice Mail Prompt Style</td>
<td>Selects one of the following prompt styles:</td>
</tr>
<tr>
<td>Auto-Delete</td>
<td></td>
</tr>
</tbody>
</table>
Configuring User Groups

This section describes how to create or modify a user group. The information in this section applies to a new ShoreTel installation or an existing system. Configuring user groups is the second major phase in the creation of user accounts in a new system.

Viewing User Groups

The User Groups page includes a list of default ShoreTel user groups. To view the user groups:

1. Launch ShoreTel Director.
2. Click Administration > Users > User Groups.

The User Groups page appears.

For definitions of the columns on the User Groups page, see the Table 41.
Creating a User Group

1. Launch ShoreTel Director.

2. Click Administration > Users > User Groups.

   The User Groups page displays.

3. Click Add new. The Edit User Group page displays.

For definitions of the User Groups parameters, see Table 42.

### Table 41: User Groups Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user group.</td>
</tr>
<tr>
<td>Telephony Features</td>
<td>Telephony features permissions COS associated with the user group.</td>
</tr>
<tr>
<td>Call</td>
<td>Call permissions COS associated with the user group.</td>
</tr>
<tr>
<td>Voice Mail</td>
<td>Voice mail COS associated with the user group.</td>
</tr>
<tr>
<td>Account Codes</td>
<td>Account code collection mode set for the user group. For more information, see the Multi-site Account Codes on page 258.</td>
</tr>
<tr>
<td>Voice Mail Interface</td>
<td>Voice mail interface COS associated with the user group.</td>
</tr>
<tr>
<td>DID as CE SID</td>
<td>Indicates whether a DID number should be sent as the Caller’s Emergency Service ID number for a 911 emergency call.</td>
</tr>
</tbody>
</table>

### Table 42: User Groups Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the descriptive name of the group.</td>
</tr>
<tr>
<td>COS - Telephony</td>
<td>Specifies the telephony features permissions COS associated with the user group.</td>
</tr>
<tr>
<td>COS - Call Permissions</td>
<td>Specifies the call permission COS is associated with a user group.</td>
</tr>
<tr>
<td>COS - Voice Mail</td>
<td>Specifies the voice mail permissions COS record associated with the user group.</td>
</tr>
</tbody>
</table>
**Table 42: User Groups Parameters (Continued)**

| Parameter                                                      | Definition                                                                                                                                                                                                 |
|                                                               |                                                                                                                                                                                                          |
| Send Caller ID as Caller’s Emergency Service Identification (CESID) | Specifies whether the caller ID configured on the User’s page is the telephone number sent to the service provider when a user dials an emergency services number. If this option is not selected, the outbound caller ID will be either the user’s DID or the site’s CESID. Default value: Enabled For more information about setting up emergency dialing, see Appendix A, *Emergency Dialing Operations*. |
| Send DID as Caller’s Emergency Service Identification (CESID)   | Specifies whether this telephone number is sent to the service provider when a user dials an emergency services number. If this option is not selected and Send Caller ID as Caller’s Emergency Service Identification is also not selected, the outbound caller ID becomes the site’s CESID. For more information about setting up emergency dialing, see Appendix A, *Emergency Dialing Operations*. |
| Account Code Collection                                        | Specifies one of the following account code collection modes for the user group:                                                                                                                           |
|                                                                | ▪ Disabled: Account collection is not active for this group.                                                                                                                                               |
|                                                                | ▪ Optional: Users are prompted to enter an account code. If no account code is entered, the call is completed without account code records.                                                                  |
|                                                                | ▪ Forced: Users must enter an account code for all calls outside the bounds of the call permissions set for the user.                                                                                     |
|                                                                | For more information about account codes, see the Multi-site Account Codes on page 258.                                                                                                                    |
| Show Communicator users a list of account codes when dialing   | Allows Communicator users to select an account code from the complete list of account codes when prompted for an account code. Disable this feature to restrict the user’s access to account codes. |
| Outgoing Trunk Groups (Access Code)                           | Enables you to select the trunk groups to which this user group has access for outgoing calls. You can assign multiple trunk groups for this user group.                                                 |
Configuring a User Account

This section describes how to create or modify a user account for either a new deployment or an existing ShoreTel system.

Using the Individual Users Page

To access the Individual Users page, click Administration > Users > Individual Users. The Individual Users page displays, as shown in Figure 98.
Using the Individual Users Page

Configuring Users

Figure 98: Individual Users List Page

Use the Arrow buttons near the top of the page to scroll through pages of user names. To specify the number of records that appear on a page, select a value from the Records per Page drop-down list. The default value is 25 records in a page.

To add a new user to a site, select the site from the drop-down list at the top of the page, and click Go. The Edit User page displays. For more information about configuring a user, see Configuring Users on page 356.

The Individual Users list page displays the following information:

- First Name: The first name of the user.
- Last Name: The last name of the user.

**Note**

When an administrator types the first and last name (even before clicking Save), the system generates a default Client Username (often called the Client User ID or just User ID). This Client Username consists of the first letter of the first name and the complete last name. For more information, see Configuring Users on page 356.

- Site: The site associated with the user.
- User Group: The user group that is associated with the user.
- Access License: The type of access license determines the capabilities that a user’s ShoreTel Communicator can provide.
- Extension: The user's extension.
- Mailbox: The user's voice mailbox.
- Switch: The switch associated with the user.
- Port: The port associated with the user or the MAC address of an IP phone.
- Status: This shows the user’s telephone port status. “Home” indicates that the user is at his or her home telephone port; Assigned indicates otherwise.
Configuring Users

A user account has many details, so the Edit User page has the following tabs for opening additional configuration pages:

- **General Tab** on page 356
- **Personal Options Tab** on page 364
- **Distribution Lists Tab** on page 367
- **Workgroups Tab** on page 367

**General Tab**

General information about new and existing users is provided under the General tab on the Edit User page. Many data entry fields are automatically filled from other Director fields.

For more information about the parameters on General tab, see Table 43.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Specifies the first name of a user, fax machine, conference room, or virtual user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Specifies the last name of the user.</td>
</tr>
</tbody>
</table>
| Number     | Specifies the user’s extension.  
  **Note**: When configuring a new user, this field populates automatically with a number based upon a local cookie that was stored the last time a new user was configured. |
License Type

Sets one of the following license types from the drop-down menu:
- Extension and Mailbox
- Extension-Only
- Mailbox-Only

For Extension-Only licenses:
- The voice mail server drop-down menu and associated check boxes are disabled.
- User groups with SMDI ShoreTel voice mail are not available.

For Mailbox-Only licenses:
- User groups with SMDI External voice mail are not available
- Ports cannot be assigned to Mailbox-Only users.
- Extension Assignment is not available to Mailbox-Only users, regardless of the COS settings.

**Note:** ShoreTel capacity is licensed by user license type. Make sure you have licenses for all users and required types.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Type</td>
<td>Sets one of the following license types from the drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>- Extension and Mailbox</td>
</tr>
<tr>
<td></td>
<td>- Extension-Only</td>
</tr>
<tr>
<td></td>
<td>- Mailbox-Only</td>
</tr>
<tr>
<td></td>
<td>For Extension-Only licenses:</td>
</tr>
<tr>
<td></td>
<td>- The voice mail server drop-down menu and associated check boxes are disabled.</td>
</tr>
<tr>
<td></td>
<td>- User groups with SMDI ShoreTel voice mail are not available.</td>
</tr>
<tr>
<td></td>
<td>For Mailbox-Only licenses:</td>
</tr>
<tr>
<td></td>
<td>- User groups with SMDI External voice mail are not available</td>
</tr>
<tr>
<td></td>
<td>- Ports cannot be assigned to Mailbox-Only users.</td>
</tr>
<tr>
<td></td>
<td>- Extension Assignment is not available to Mailbox-Only users, regardless of the COS settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> ShoreTel capacity is licensed by user license type. Make sure you have licenses for all users and required types.</td>
</tr>
</tbody>
</table>
Configuring Users

10

Table 43: Edit User Parameters: General Tab (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access License</td>
<td>Specifies one of the following access levels for ShoreTel Communicator:</td>
</tr>
<tr>
<td></td>
<td>■ Personal (default): Provides desktop call control, visual voice mail, call history, instant messaging, and directory services, as well as options to control call handling and message notification. This level does not require a special license.</td>
</tr>
<tr>
<td></td>
<td>■ Professional: Provides access Instant Messaging, Presence, Contact Viewer, and SoftPhone. A video license is also provided to users who have rights to Professional Communicator, providing access to VGA video.</td>
</tr>
<tr>
<td></td>
<td>■ Workgroup Agent: Provides access to workgroup features, including login, logout, wrap-up, queue monitor, and shared workgroup mailbox, plus the ability to transfer calls by dragging and dropping call cells into the buddy list. Does not include access to video.</td>
</tr>
<tr>
<td></td>
<td>■ Workgroup Supervisor: Provides access to the agent monitor, in addition to all features available to workgroup agents. Provides call recording feature.</td>
</tr>
<tr>
<td></td>
<td>■ Operator: Provides access to XGA Video and detailed information about destination extensions, including access to an extension monitor, in addition to all the features available to the workgroup supervisor (including call recording).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> From GA15 Release, the call recording feature is available for personal, professional, and workgroup agent access license types.</td>
</tr>
<tr>
<td>Enable Contact Center Integration</td>
<td>Enables integration of ShoreTel Communicator with Contact Center.</td>
</tr>
<tr>
<td>Caller ID</td>
<td>Specifies the caller ID number for outbound calls.</td>
</tr>
<tr>
<td></td>
<td>A caller ID entered here will take precedence over the user’s DID and the site’s CESID number (both for normal outbound and 911 calls). If no number is entered, the user’s DID or the site’s CESID will be used for outbound caller ID.</td>
</tr>
<tr>
<td></td>
<td>This feature is available only for outbound calls on a T1 PRI trunk.</td>
</tr>
<tr>
<td>DID Range</td>
<td>Selects the did range for the user.</td>
</tr>
<tr>
<td></td>
<td>Before you can specify a DID range, DID services must be configured against the desired trunk group, which is enabled by default if a DID trunk group is configured.</td>
</tr>
<tr>
<td>DID Number</td>
<td>Specifies the DID number for the user.</td>
</tr>
</tbody>
</table>
### PSTN Failover

Specifies the PSTN number to be dialed to complete a failed site-to-site call. Enables you to select the following PSTN Failover options:
- None
- External Number
- DID

The user must have a Class of Service that has **Allow PSTN Failover** enabled. For more information, see the [Specifying a Class of Service](#) on page 337.

If there is no available bandwidth or if a WAN is down for a site to site call and if the call destination has no PSTN failover, the call is directed to voice mail.

### User Group

Enables you to associate a user group with the user.

- Default: Executives

**Note**: You can set the default user group by clicking [Administration > Preferences](#) and choosing a new default user group.

### Site

Selects the site for the user. This setting filters the list of switch ports that you must select from as well as provides a different default DID number, if available.

### Language

Selects the language that this user will hear for voice mail prompts. Select from the available languages in the drop-down list.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
</table>
| PSTN Failover | Specifies the PSTN number to be dialed to complete a failed site-to-site call. Enables you to select the following PSTN Failover options:  
- None  
- External Number  
- DID  

The user must have a Class of Service that has **Allow PSTN Failover** enabled. For more information, see the [Specifying a Class of Service](#) on page 337.  
If there is no available bandwidth or if a WAN is down for a site to site call and if the call destination has no PSTN failover, the call is directed to voice mail. |
| User Group    | Enables you to associate a user group with the user.  
- Default: Executives  

**Note**: You can set the default user group by clicking [Administration > Preferences](#) and choosing a new default user group. |
| Site          | Selects the site for the user. This setting filters the list of switch ports that you must select from as well as provides a different default DID number, if available. |
| Language      | Selects the language that this user will hear for voice mail prompts. Select from the available languages in the drop-down list. |
### Primary Phone Port

Enables you to select the primary phone port for the user from the following types:

- IP Phones
- Ports
- Softswitch

If you are assigning an analog port and do not specify a port, ShoreTel Director selects the next available port.

If you select **IP Phone**, the drop-down list displays **Any IP Phone** as the default. For information about the Any IP Phone feature, see Chapter 12, *Configuring User Features* on page 443.

If you select **Port**, the drop-down list displays the available ports.

To create a user without a port (a virtual user), select **SoftSwitch** as the home port.

**Note:** Assigning users to an analog port or SoftSwitch for their home port can cause the loss of phone service if the user selects the **Go Home** option in Communicator. ShoreTel recommends that Extension Assignment users be assigned Any IP phone as their home port.

### Current Port

Indicates the user’s current switch port. This shows which switch port the user has assigned himself or herself. This field cannot be changed directly. Change the current port setting to the home port by clicking **Go Home**.

Clicking **Go Home** causes the system to force the user back to the home telephone. This option is useful when a temporary user is no longer using that phone.

### Jack #

Displays the patch-panel jack number associated with the user’s switch port may be recorded.

### Mailbox Server

Enables the user’s voice mailbox. The drop-down list allows you to select the server to host this mailbox.

Default: Enabled.

### Escalation Profiles and Other Mailbox Options

Enables you to specify other mailbox options. For more information, see *Escalation Profiles and Other Mailbox Options* on page 487.

### Accept Broadcast Messages

Enables individual users receive broadcast messages.

Default: Enabled.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include in System Dial By Name Directory</td>
<td>Causes the user’s name to be included in the auto-attendant’s dial-by-name directory. Default: Enabled</td>
</tr>
<tr>
<td>Make Number Private</td>
<td>Removes this number from the system directory and call handling destination lists. For more information about private numbers, see Private Numbers on page 444.</td>
</tr>
</tbody>
</table>
| Fax Support                                   | Ensure that FAXes are clearly and reliably transmitted. From the drop-down menu, select one of the following options:  
  - User - No Redirect. Extension is connected to a user; do not redirect inbound Fax calls.  
  - User - Redirect. Extension is connected to a user; redirect inbound Fax calls to site Fax redirect extension.  
  - Fax Server. Extension is connected to a Fax server; do not redirect inbound fax calls but pulse DTMF digits.  
  - Fax Machine. Extension is connected to a fax machine; do not redirect inbound fax calls.  
  - Non-T38 Data Terminal  
  - Non-T38 Fax Server  
  Note: This option freezes the jitter buffer and disables the echo canceller at the beginning of the call and applies to environments that use SIP PSTN gateways.                                                                                                         |
| Allow Video Calls                             | Allows the user to make video calls. Video calls are a licensed feature. From the drop-down menu, select one of the following options:  
  - None (Disables video capability for this user.)  
  - Standard Resolution  
  - High Resolution                                                                                                                                                                                                                                                    |
| Allow Telephony Presence                      | Allow the user to access the telephony presence information about other users.  
  **Note:** Telephony presence indicates a user’s availability for accepting voice calls.                                                                                                                                                                                                                                             |
| Shared Call Appearances Associated BCA        | Enables a user participate in Shared Call Appearances functions. For more information, see Bridged Call Appearance Conferencing on page 268.                                                                                                                                                                                                  |
### Table 43: Edit User Parameters: General Tab (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow Use of Softphone</strong></td>
<td>Enables the user to have access to the Softphone option in Communicator.</td>
</tr>
</tbody>
</table>
| **Allow Phone API** | Enables the phone API, which allows third-party applications to run on certain ShoreTel IP phone models. Check with ShoreTel Technical Support for models that support this feature.  

*Note:* Selecting this checkbox enables the IP phone associated with this user to go into PAPI browser mode, thus allowing the phone to run those third-party applications. |
| **Allow Mobile Access** | Enables Communicator for Mobile (CM) to run on this user’s mobile device.  

*Note:* To use ShoreTel Mobility Router as the primary registered device for this user, do not check this check box. For more information, see the *ShoreTel Mobility Router Administration Guide* for ShoreTel Mobility 8.0 or later.  

*Note:* The CM client software consists of a small Java applet that is installed on a mobile device, such as a BlackBerry. The CM software provides remote/mobile users with an interface similar to ShoreTel Communicator. |
| **Allow Enhanced Mobility with Extension** | Enables you to select or enter an extension to add a user’s mobile device as an additional phone on the user extension. A SIP extension is automatically created for the mobile client phone on the system (the SIP Phone License increments after the user phone is registered).  

If the user’s two additional phones are already allocated, you can replace one with the number of the new mobile extension.  

*Note:* To use ShoreTel Mobility Router as the primary registered device for this user, do not check this check box. For more information, see the *ShoreTel Mobility Router Administration Guide* for ShoreTel Mobility 8.0 or later.  

*Note:* To enable simultaneous ringing for the mobile extension, configure the User Group settings. |
### Table 43: Edit User Parameters: General Tab (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delayed Ringdown</strong></td>
<td>Enables delayed ringdown for the extension. You must enable Delayed Ringdown before you can specify the following parameters:</td>
</tr>
<tr>
<td></td>
<td>- Extension: Select this option to specify a ShoreTel extension as the recipient device, then enter the extension of the recipient device in the corresponding data entry field.</td>
</tr>
<tr>
<td></td>
<td>- External Number: Select this option to specify a phone outside of the ShoreTel network as the recipient device, then enter the phone number of the recipient device, including the Trunk Access Code of the ringdown trunk, in the corresponding data entry field.</td>
</tr>
<tr>
<td></td>
<td>- Ringdown Delay: Enter the period of time that the phone waits after the user picks up the handset before initiating the ringdown call. Enter 0 in this field to cause the phone to immediately dial the ringdown device whenever the handset is picked up.</td>
</tr>
<tr>
<td><strong>Client Username</strong></td>
<td>Specifies the username that the user types to log into the ShoreTel system.</td>
</tr>
<tr>
<td></td>
<td>Although the system generates a default username, which consists of the first letter of the first name and the full last name of the user, the system administrator can change the User ID to any string that follows these rules:</td>
</tr>
<tr>
<td></td>
<td>- Maximum length: 50 characters</td>
</tr>
<tr>
<td></td>
<td>- Allowed characters: a - z, A - Z, 0 - 9, _, -, ., @ (underscore, dash, period, “at” symbol)</td>
</tr>
<tr>
<td><strong>Client Password</strong></td>
<td>Specifies the password that a user enters when logging in to the system from the ShoreTel Communicator or ShoreTel Director.</td>
</tr>
<tr>
<td></td>
<td>Default: changeme (Users get prompted to change this password when they log in for the first time.)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> ShoreTel recommends that you do not change this password, because it is used by users who are configuring their Communicator for the first time.</td>
</tr>
<tr>
<td><strong>Voice Mail Password</strong></td>
<td>Specifies the password that users enter when logging into their voice mailbox from the telephone. Characters in this field appear as asterisks.</td>
</tr>
<tr>
<td></td>
<td>The default password is 1234. Users are prompted to change it the first time they log into the system. We recommend that the default password be kept as the default because users who are configuring their telephone for the first time use 1234.</td>
</tr>
</tbody>
</table>
To configure the personal options for new and existing users, click the **Personal Options** tab on the **Edit User** page. After making entries, click the link at the bottom of the page to return to the user’s edit page.

For more information about the parameters on the Edit User Personal Options page, see Table 44.
### Table 44: Edit User Personal Options Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current Call Stack Size</strong></td>
<td>Specifies the maximum number of calls, including active and held calls, that an extension can handle simultaneously.</td>
</tr>
<tr>
<td></td>
<td>When this number is exceeded, calls are either given a busy tone or forwarded, depending on the call handling mode that is currently in effect.</td>
</tr>
<tr>
<td></td>
<td>Value range: 1 - 16</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The value specified in the call stack size of the user’s COS becomes the upper limit.</td>
</tr>
<tr>
<td><strong>Ring Type</strong></td>
<td>Enables you to select the ring type from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>Most ShoreTel IP phone models allow the user to load customized ring tones onto a phone, so each user can have a unique ring tone. For more information, see the Customizing Ringtones on page 223.</td>
</tr>
<tr>
<td></td>
<td>Note: Ring type is a personal option for the user, not a phone configuration. When a user moves from phone to phone, their ring type follows.</td>
</tr>
<tr>
<td><strong>Wallpaper</strong></td>
<td>Specifies the default wallpaper or background for the phone.</td>
</tr>
<tr>
<td><strong>Automatic Off-Hook Preference</strong></td>
<td>Specifies one of the following devices that automatically gets activated for incoming and outgoing calls:</td>
</tr>
<tr>
<td></td>
<td>- Speaker</td>
</tr>
<tr>
<td></td>
<td>- Headset</td>
</tr>
<tr>
<td></td>
<td>- Wireless Headset</td>
</tr>
<tr>
<td></td>
<td>- Bluetooth Headset</td>
</tr>
<tr>
<td></td>
<td>For configuration instructions, see Specifying Automatic Off-Hook for Wireless Headsets on page 233.</td>
</tr>
<tr>
<td><strong>Handsfree Mode</strong></td>
<td>Enables handsfree mode. When enabled, dial tone is disabled so that the user can use a headset or speakerphone to answer and make calls from the desktop client.</td>
</tr>
<tr>
<td></td>
<td>Default: Disabled</td>
</tr>
<tr>
<td><strong>Call Waiting Tone Enabled</strong></td>
<td>Enables call-waiting tone.</td>
</tr>
<tr>
<td></td>
<td>Default: Enabled</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The system plays different call waiting tones for calls waiting on the primary extension and those waiting on a monitored BCA extension.</td>
</tr>
</tbody>
</table>
### Configuring Users

#### Trunk Group Access Code
Enables you to select a trunk group access code from the drop-down list. Although the drop-down list contains trunk groups, this parameter only affects the access code. When you select this parameter, the user does not need to configure the trunk access code on his or her phone.

#### Mailbox for Recorded Calls
Specifies the mailbox to be used for recorded calls. The maximum recording length is determined by the voice mail class of service for the destination mailbox.

#### Program IP Phone Buttons
Displays the Program IP Phone Buttons page. For more information, see Configuring Programmable IP Phone Buttons on page 234.

Click **Copy** to copy another user’s IP phone button configuration. For more information, see Copying Programmable Button Configurations on page 237.

#### Program Communicator Toolbars
Displays the Program Communicator Toolbars page. For more information, see Creating a Personal Programmable Toolbar on page 404.

#### External Assignment and Additional Phones
Displays the Find Me, External Assignment and Additional Phones page. For more information, see Find Me and External Assignment Page on page 452.

#### Personalized Call Handling Rules
Displays the Personalized Call Handling Rules page.

#### Current Call Handling Mode
Allows the system administrator to set the current call handling mode for the user. Users can also select and edit each call handling mode from their phone.

Default: Standard

For more information, see Automated Call Handling on page 455.

#### Delegation
Displays the Call Handling Mode Delegation page. You can delegate call handling management for an individual user to one or more other users, such as an administrative assistant.

#### Outlook Automated Call Handling
Enables a user’s Microsoft Outlook Calendar to control his or her call handling mode.

---

### Table 44: Edit User Personal Options Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Group Access Code</td>
<td>Enables you to select a trunk group access code from the drop-down list. Although the drop-down list contains trunk groups, this parameter only affects the access code. When you select this parameter, the user does not need to configure the trunk access code on his or her phone.</td>
</tr>
<tr>
<td>Mailbox for Recorded Calls</td>
<td>Specifies the mailbox to be used for recorded calls. The maximum recording length is determined by the voice mail class of service for the destination mailbox.</td>
</tr>
<tr>
<td>Program IP Phone Buttons</td>
<td>Displays the Program IP Phone Buttons page. For more information, see Configuring Programmable IP Phone Buttons on page 234. Click <strong>Copy</strong> to copy another user’s IP phone button configuration. For more information, see Copying Programmable Button Configurations on page 237.</td>
</tr>
<tr>
<td>Program Communicator Toolbars</td>
<td>Displays the Program Communicator Toolbars page. For more information, see Creating a Personal Programmable Toolbar on page 404.</td>
</tr>
<tr>
<td>External Assignment and Additional Phones</td>
<td>Displays the Find Me, External Assignment and Additional Phones page. For more information, see Find Me and External Assignment Page on page 452.</td>
</tr>
<tr>
<td>Personalized Call Handling Rules</td>
<td>Displays the Personalized Call Handling Rules page.</td>
</tr>
<tr>
<td>Current Call Handling Mode</td>
<td>Allows the system administrator to set the current call handling mode for the user. Users can also select and edit each call handling mode from their phone. Default: Standard For more information, see Automated Call Handling on page 455.</td>
</tr>
<tr>
<td>Delegation</td>
<td>Displays the Call Handling Mode Delegation page. You can delegate call handling management for an individual user to one or more other users, such as an administrative assistant.</td>
</tr>
<tr>
<td>Outlook Automated Call Handling</td>
<td>Enables a user’s Microsoft Outlook Calendar to control his or her call handling mode.</td>
</tr>
</tbody>
</table>
Distribution Lists Tab

A distribution list lets a user send a voice mail message to multiple users at one time. Each distribution list has a descriptive name and distribution list number associated with it. See System Distribution Lists on page 478 for details about adding and populating Distribution lists.

Users can be associated with the distribution lists from either the Distribution Lists options on the Edit User page or the System Distribution List edit page. When a user is associated with a distribution list, that user receives messages sent to that list.

To display the Distribution Lists page, click the Distribution Lists tab on the Edit User page.

The Distribution List Memberships box shows the distribution lists that are currently available:

- To add a user to a distribution list, select the appropriate check box.
- To remove a user from a distribution list, deselect the check box.

Users can be associated with more than one distribution list.

Workgroups Tab

The Workgroups tab in the Edit User page lets you edit a user’s workgroup membership. Users can belong to multiple workgroups; however, a user’s login status is the same for all workgroups of which he is a member. For a description of the Workgroup feature, see Chapter 16, Configuring Workgroups on page 527.

The Workgroups page shows the workgroup lists that are currently available:

- To add a user to a workgroup, select the appropriate check box.
- To remove a user from a workgroup, deselect the check box.

Table 44: Edit User Personal Options Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Call Handling Modes</td>
<td>Enables you to set up the following call handling modes:</td>
</tr>
<tr>
<td></td>
<td>- Standard</td>
</tr>
<tr>
<td></td>
<td>- In a Meeting</td>
</tr>
<tr>
<td></td>
<td>- Out of Office</td>
</tr>
<tr>
<td></td>
<td>- Extended</td>
</tr>
<tr>
<td></td>
<td>- Custom</td>
</tr>
<tr>
<td></td>
<td>For more information, see Automated Call Handling on page 455.</td>
</tr>
<tr>
<td>Find Me</td>
<td>Displays the Find Me, External Assignment and Additional Phones page. For more information, see Find Me and External Assignment Page on page 452.</td>
</tr>
<tr>
<td>Escalation Profiles and Other Mailbox Options</td>
<td>Displays the Escalation Profiles and Other Mailbox Options page. For more information, see Escalation Profiles and Other Mailbox Options on page 487.</td>
</tr>
</tbody>
</table>
For the Agent State, select **Logged In** to activate membership in the selected workgroups.

**Voice Mail Password Recommendations**

ShoreTel recommends you follow these guidelines for creating secure voice mail passwords:

- When creating a new user, assign the user a more complex initial PIN.
- Educate end users to change the default PIN to a more complex one (avoid PINs with simple digit patterns such as 1111 or 4321, and so on).
- Check CDRs regularly to detect any abnormal calling activities, such as calls coming and going to a country with which you are not doing business.
- If your business does not require international dialing, prevent international call-back from voicemail by restricting the relevant user group to local and long-distance calls only.
- Increase voicemail PIN length to at least 6 digits system-wide. A longer PIN is more secure and creates more number combinations.
- Enable email alerts for system event ID 1113 for repeated Voicemail login access failures.
- Use the ShoreTel Simple Password Detection Application

**Simple Password Detection Application**

The Simple Password Detection Application is a standalone application that runs on a ShoreTel server. It can detect easy-to-crack voicemail and conferencing PINs and report affected users.

For voicemail, the user is instructed to change his or her voicemail PIN the next time he or she tries to log in.

The Simple Password Detection application is shipped as a standalone Windows executable. It is also available on the ShoreTel support website.

**System Directory Record**

To access the **System Directory Edit User** page, follow these steps:

1. Click **Administration > System Directory**.

   The **System Directory** page displays.

2. To find a user, you can filter the results by selecting a site from the drop-down list. You can also click on one of the column headings to sort the list by the entries in that column.

3. Perform one of the following actions:

   - To add a new user, click **New**.
   - To edit an existing user, click the user name.
Configuring Active Directory

Directory services store organization information and settings in a central, organized, accessible database. Active Directory (AD) is the Microsoft application that implements AD on Windows based systems. AD is widely deployed among large enterprises.

The ShoreTel AD implementation supports the synchronization of user records between the ShoreTel database and other applications that use AD on Windows-based networks.

ShoreTel AD includes the following features:

- Authentication of AD Users, as described in Authenticating AD Users on page 372.
- Synchronizing AD Directory and ShoreTel Director user records, as described in Synchronizing AD and Director User Records on page 375.
- Bulk Provisioning of User Accounts, as described in Bulk Provisioning of User Accounts on page 376.

Active Directory Implementation

Active Directory Integration is an optional ShoreTel feature that is disabled by default. Systems that disable AD Integration do not recognize links to the Active Directory for properties attached to system users and do not provide AD authentication, synchronization, or provisioning services.

When AD Integration is enabled, only users that have administrative permissions can log into ShoreTel Director. This requirement means that at least one administrator role must be defined. It also means that users who need access to ShoreTel Director must receive an administrative role.

Enabling AD Integration on a ShoreTel System

Active Directory is enabled from the Edit Other System Parameters page, as shown in Figure 99, is accessed through ShoreTel Director by selecting Administration > System Parameters > Other. To enable Active Directory, select Enable AD Integration located at the bottom of the page, then enter the Active Directory path in the data entry field.
Configuring Active Directory on a New System

The procedure in this section enables AD integration on a new system. The procedure includes the initial user-configuration and the assignment of administrative permissions.

Creating a new Administrative User for Active Directory

1. Log into the Active Directory account through which ShoreTel Director is accessed.
2. Access ShoreTel Director by entering the default credentials:
   - username – admin
   - password – changeme

   If the system presents a challenge to register, do so now or select Later.
3. Navigate to Administration > Users > Individual Users.

WARNING!
At least one user account must have administrative rights before Active Directory is enabled because AD does not allow a user to log in through the default admin account.

Configuring Active Directory on a New System on page 370 describes a procedure that includes the required user and administrative assignment steps for enabling AD on a new ShoreTel system.
4. If necessary, add a new user to the ShoreTel system that uses the Client Username that matches the Active Directory login name.

5. To assign administrative rights to the new user account, click Administration > System Parameters > Administrative Permissions > Administrators.

The Administrator List page displays.

6. Click New.

The Administrator Info page displays.

7. Select the new Active Directory user that you created in Step 4.

8. For the Role, select System Administrator from the drop-down list.

9. Click Save.

The new system administrator you created gets added to the Administrator List page.

Enabling AD Integration

1. To open the Edit Other Parameters page, click Administration > System Parameters > Other.

The Edit Other Parameters page displays.

2. Select the Enable AD Integration check box located at the bottom of the page.

3. Enter a valid AD path in the AD Path data entry field.

4. When prompted to save changes and close the window, click OK and Yes.

You get logged out of Director.

5. Log in to Director again by using the name created in Step 4.

6. Enter the default password: changeme.

7. Open the Edit User page for the new user and enable Active Directory for this user. Include the domain and User ID (the Client Username).

8. Log out of ShoreTel Director and close the window.

Whenever ShoreTel Director is subsequently launched with this username and domain, the user is automatically logged into Director.

Mapping Active Directory Attributes to ShoreTel Fields

ShoreTel user records contain eleven data fields that map directly to Active Directory records. The following is a list of these data fields, categorized by the Director page that sets their ShoreTel value.

Edit User Page

- **First Name**: Active Directory field capacity is 64 characters; ShoreTel capacity is 50.
- **Last Name**: Active Directory field capacity is 64 characters; ShoreTel capacity is 50.
- Email Address
- **Client User ID**: Active Directory length is limited to 20 characters.

### System Directory
- Home Phone
- Work Phone
- Pager
- Cell Phone
- Fax Phone

### ShoreTel Database (does not appear in Director)
- **LDAP-GUID**: Used internally by the ShoreTel system when performing subsequent user updates from the AD database.

### Authenticating AD Users

ShoreTel supports AD authentication for users who log into Communicator, Web Client, and Director, permitting access to these programs without providing the ShoreTel username or password.

- AD users who log into Director and Communicator are authenticated through Single Sign On (SSO) with their current network credentials. Users are not required to re-enter credentials to access these applications.
- AD users who log into Web Client are authenticated through Explicit Authentication. With Explicit Authentication, a user must re-enter credentials each time he or she accesses the application.

### Director

When AD Integration is enabled, user access to ShoreTel Director includes the following restrictions:

- Only users with a domain account can log into Director.
- Only users with administrative permissions can log into Director.
- Users do not need to log into their domain account to access Director.
- Users do not need their ShoreTel account configured for Active Directory (AD Users) to access Director.

### Director Access Scenarios

#### AD User Logged into the Domain

If ShoreTel users with an AD configuration try to access Director without entering network credentials who log into the domain network go directly to the Director Quick Look page.

When a user with AD access logs out, the browser displays a ShoreTel login (Figure 100).
Configuring Active Directory on a New System

Configuring Users

ShoreTel 14.2 System Administration Guide 373

Figure 100: Director Login Page – AD User

Non-AD User Logged into the Domain

A user who is not configured for AD in the ShoreTel system and initiates login to the domain network is directed to a Director Login page, as shown in Figure 101. The user logs into Director from this screen by entering a ShoreTel username and password.

Figure 101: Director Login Page – Non-AD User

Users not Logged into the Domain

Users attempting to access Director without first logging into the domain network are initially routed to a domain login page, as shown in Figure 102. After entering network credentials, users are routed to the appropriate page. AD users are routed to the Quick Look page, and non-AD users are directed to a login page.
Communicator

When AD Integration is enabled, access to Communicator is available to all system users, including users who have no domain account or are not configured as ShoreTel AD users.

Initial Configuration

When installing Communicator, users authenticated through AD are not queried for their credentials; they are immediately prompted for the server name after which wizard panels guide them through the setup process.

Users that are not authenticated through AD are required to enter their name, password and server name. After verifying the user’s credentials, Communicator guides the user through the setup process.

Logging into Communicator

Attempts to log into Communicator after the initial setup are handled on the basis of the user’s AD configuration. Active Directory users are authenticated by SSO through the verification of their AD credentials. Users not configured for Active Directory are authenticated through the verification of their ShoreTel username and password, as previously loaded through their Communicator account. In either case, users are typically not required to re-enter their username or password each time they open Communicator from their computer.

Communicator behavior after an authentication failure is not changed by this feature.

User Name – Telephony Options Page

The User Name data field at the top of the Options and Preferences: Telephony page displays the User name of the Communicator account. This field is read only for users authenticated through AD credentials, as shown in Figure 103.
Web Client

When AD Integration is enabled, access to the Web Client is available all users systems, including users without domain accounts or not configured as ShoreTel AD users.

Attempts to log into Web Client always require the user to enter credential information. Domain members configured as ShoreTel Active Directory members enter their Active Directory user name and password and are authorized through Explicit Authentication. All other users enter their ShoreTel username and password.

Synchronizing AD and Director User Records

Director provides an interface for adding, updating, and deleting AD users from the ShoreTel database. Synchronization is performed on individual users and does not affect the AD directory.

Enabling AD for a ShoreTel User

When AD Integration is enabled, the first parameter the Edit User: General page enables Active Director for the user.

To enable Active Director for a user, enable the Active Directory User option at the top of the page, then enter the domain\user name for the user, as shown in Figure 104.
Figure 104: Enabling Active Directory for a User

Updating AD Fields

Active Directory users can synchronize user account records with contents from the Active Directory database by pressing the Sync from AD button located left of the user’s Active Directory userid. Pressing the Show From AD button displays parameter settings for the users; Active Directory account.

The Show From AD and Sync From AD buttons are inactive for users accessing this page that are not configured as AD users.

Removing AD Users

When an administrator attempts to delete a user with an AD account, ShoreTel displays a warning and requires confirmation before it removes the record from the ShoreTel database.

Bulk Provisioning of User Accounts

ShoreTel supports the bulk provisioning of user accounts from AD records through a two-step process:

1. Export of AD records to a CSV file
2. Import of CSV records to the ShoreTel user database

Exporting AD Records

ShoreTel provides a VBScript file to export records from an AD database to a CSV file. The VBScript file can be used as a template for specific ShoreTel system requirements. Figure 105 shows the parameter section of the file.
Figure 105: Sample ldaptocsv.vbs File, Parameter Sections

The parameter section in Figure 105 has two subsections:

- The Top Section receives values from the AD database for each imported file. As indicated in the comments section, one value can be assigned to individual fields for all users by entering the value in place of the quotes.

- The Bottom section is a data template containing non-AD fields that are saved to the CSV file. The values entered in these fields are assigned to all records retrieved from the AD database.

The following command line entry executes the AD-to-CSV file import:

```bash
cscript ldaptocsv.vbs outputCSVfile LDAPpath [modifiedInLastN#OfDays]
```

where

- `outputCSVfile` specifies the name of the output file.
- `LDAPpath` specifies the path to the AD database.
- `[modifiedInLastN#OfDays]` is an optional delimiter in the form of a number of days: It lets you import the active directory entries but only entries that have been modified in the past number of days specified by modifiedInLastN#OfDays. This delimiter can reduce the amount of information that the system has to import.

The resulting CSV file can be modified though a spreadsheet program to customize user settings for import to the ShoreTel database.
Exporting the CSV File

**DBImport.exe** is the executable file that imports CSV contents to the ShoreTel database.

**DBImport.exe** supports SIP servers. SIP server names can be entered in the pre-existing voicemail server field. **DBImport.exe** determines the user’s Access License type and the user group voicemail interface mode that the system uses to look up the voicemail server name.

To support AD record imports, the following fields are supported by **DBImport.exe**:

- **LDAP-User flag**: a flag that indicates the user settings came from an AD database.
- **LDAP-GUID**: a data field that creates an association between an AD record and the corresponding ShoreTel record.
- **LDAP-DomainName**: specifies the name of the user’s domain network.

The following command line entry imports CSV records into the ShoreTel database.

```
Dbimport -log DbLog.log -err DbErr.err <inputCSVfile>
```

User Management Utilities

User Import Tool

The database import utility lets a system administrator perform a single action to make changes for all users in a system. The utility increases the ease and speed with which a system administrator can modify information for large groups of users.

The administrator creates a spreadsheet by using an application, such as Microsoft Excel, and then modifies the user data in the spreadsheet in a “free form” approach (instead of modifying each user’s information within ShoreTel Director).

After the user information has been modified within the spreadsheet, the data can be exported to a CSV format, and this CSV file can be imported into the ShoreTel system.

Details

- The import tool supports modify/delete/insert operations, allowing a system administrator to add users, delete users, or modify the account of an existing user.
- Using the import tool does not require scheduled downtime. However, when importing large files that contain many rows of information, performance may be affected as the database is frequently queried. So depending on the size of the imported file and the type of information that is being added or modified, it may be recommended to perform the import during off hours.
In the current release, the ShoreTel system does not support the ability to export user data into a CSV file.

The Import utility does not allow the administrator to specify the Users’ Home Port. The Home Port parameter is automatically set to SoftSwitch within each User record added or modified by an import.

---

**Note**

Home Port can be changed by using the HomePhoneMACAddress Database Import Field.

Table 45 provides information about field headers that must appear as the first row in the CSV file that is imported. The fields can be in any order, but all fields are mandatory and case sensitive and must contain data.

**Table 45: Field Headers for CSV File**

<table>
<thead>
<tr>
<th>Database Import Field</th>
<th>Database Field Name</th>
<th>Accepted Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extension</td>
<td>UserDN</td>
<td>Number</td>
</tr>
<tr>
<td>FirstName (String)</td>
<td>TabAddresses.FirstName</td>
<td>String</td>
</tr>
<tr>
<td>LastName (String)</td>
<td>TabAddresses.LastName</td>
<td>String</td>
</tr>
<tr>
<td>GuiLoginName (String)</td>
<td>GuiLoginName</td>
<td>String</td>
</tr>
<tr>
<td>GUIPassword (String)</td>
<td>GUIPassword</td>
<td>String</td>
</tr>
<tr>
<td>UserLicenseType (Code)</td>
<td>LicenseTypeID</td>
<td>Extension-Mailbox Extension-Only Mailbox-Only</td>
</tr>
<tr>
<td>CallerID (String)</td>
<td>CIDNumber</td>
<td>A full canonical number (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>UserGroup</td>
<td>UserGroupID</td>
<td>(Code. Must be one of the existing User groups configured on the system.)</td>
</tr>
<tr>
<td>Site</td>
<td>Site</td>
<td>(String Name - Must be one of the existing Site Name)</td>
</tr>
<tr>
<td>Language</td>
<td>DN.LanguageID</td>
<td>Value should be a language name (e.g. “English (US”)”).</td>
</tr>
<tr>
<td>VMServer</td>
<td>VMServerID</td>
<td>Value should be a VM server, SIP server, or QSIG server name, depending on user's user group interface mode.</td>
</tr>
<tr>
<td>CallStackSize</td>
<td>CurrentCallStackSize</td>
<td>Number</td>
</tr>
<tr>
<td>AcceptBroadcasts</td>
<td>Mailboxes.NoReceiveBroadcasts</td>
<td>Boolean DB value is opposite of input value</td>
</tr>
</tbody>
</table>
### Table 45: Field Headers for CSV File (Continued)

<table>
<thead>
<tr>
<th>DataBase Import Field</th>
<th>DataBase Field Name</th>
<th>Accepted Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>MakeNumberPrivate</td>
<td>DN.Hidden</td>
<td>Boolean</td>
</tr>
<tr>
<td>DialByName</td>
<td>DN.ExcludeFromDialByName</td>
<td>Boolean, DB value is opposite of input value</td>
</tr>
<tr>
<td>AllowSoftPhone</td>
<td>AllowSoftPhone</td>
<td>Boolean</td>
</tr>
<tr>
<td>ClientType</td>
<td>ClientType</td>
<td>Personal, Professional, Workgroup Agent, Workgroup Supervisor, Operator</td>
</tr>
<tr>
<td>EmailDomain</td>
<td>TabAddresses.EmailAddress</td>
<td>String</td>
</tr>
<tr>
<td>ConferenceServer</td>
<td>BridgeID</td>
<td>String Name - Must be the existing Service Appliance Name or “None”</td>
</tr>
<tr>
<td>ConferenceServerUserID</td>
<td>BridgeUserID</td>
<td></td>
</tr>
<tr>
<td>ConferenceServerPassword</td>
<td>BridgePassword</td>
<td>The system permits the following characters: !#$%&amp;'()*+,- .0123456789;=:@ABCDEFGHJKLMNPQRSTUVWXYZ[]^_`abcdefghijklmnopqrstuvwxyz{</td>
</tr>
<tr>
<td>RingType</td>
<td>RingToneID</td>
<td>Value must be a ring tone name: Standard, Ring 2, Ring 3, Ring 4</td>
</tr>
<tr>
<td>CallWaitingToneEnabled</td>
<td>CallWaitingToneEnabled</td>
<td>Boolean</td>
</tr>
<tr>
<td>HeadsetAudioPath</td>
<td>UseHeadsetAudioPath</td>
<td>Number</td>
</tr>
<tr>
<td>HeadsetMode</td>
<td>HeadsetMode</td>
<td>Boolean</td>
</tr>
</tbody>
</table>
Table 45: Field Headers for CSV File (Continued)

<table>
<thead>
<tr>
<th>Database Import Field</th>
<th>Database Field Name</th>
<th>Accepted Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSTNFailOverType</td>
<td>PSTNFailOverTypeID</td>
<td>None, External DID</td>
</tr>
<tr>
<td>PSTNFailOverNumber</td>
<td>PSTNFailOverNumber</td>
<td>A full canonical number (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>DIDRange</td>
<td>DIDDigitMap.DIDRangeID</td>
<td>A full canonical number base of range (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>DIDNumber</td>
<td>DIDDigitMap.Digits</td>
<td>A full canonical number (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>VoiceMailboxForRecordedCalls</td>
<td>VoiceMailboxForRecordedCalls</td>
<td>An existing valid extension (or can be left blank)</td>
</tr>
<tr>
<td>MustChangeTUIPassword</td>
<td>MustChangeTUIPassword</td>
<td>Boolean</td>
</tr>
<tr>
<td>MustChangeGUIPassword</td>
<td>MustChangeGUIPassword</td>
<td>Boolean</td>
</tr>
<tr>
<td>EnableCC</td>
<td>ContactCenterIntegration</td>
<td>Boolean</td>
</tr>
<tr>
<td>MustRecordName</td>
<td>MustRecordName</td>
<td>Boolean</td>
</tr>
<tr>
<td>HomePhoneMACAddress</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HomePhoneNumber</td>
<td></td>
<td>A full canonical number base of range (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>WorkPhoneNumber</td>
<td>TabAddresses.WorkPhone</td>
<td>A full canonical number base of range (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>PagerPhoneNumber</td>
<td>TabAddresses.PagerPhone</td>
<td>A full canonical number base of range (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>CellPhoneNumber</td>
<td>TabAddresses.CellPhone</td>
<td>A full canonical number base of range (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>FAXPhoneNumber</td>
<td>TabAddresses.FAXPhone</td>
<td>A full canonical number base of range (such as +1 (408) 331-3300)</td>
</tr>
<tr>
<td>LdapUser</td>
<td>LDAPUser</td>
<td>“Non-LDAP user” “Active Directory”</td>
</tr>
<tr>
<td>LdapGuid</td>
<td>LDAPGuid</td>
<td>String</td>
</tr>
<tr>
<td>LdapDomainName</td>
<td>LDAPDomainName</td>
<td>String</td>
</tr>
<tr>
<td>AllowPapi</td>
<td>AllowPAPI</td>
<td>Boolean</td>
</tr>
<tr>
<td>MCMAAllowed</td>
<td>MCMAAllowed</td>
<td>Boolean</td>
</tr>
</tbody>
</table>
Additional considerations:

- String names fields must exist in the system. For example, if a new user is to be created in site New York. “New York” must exist as a site name. String names are case-sensitive.

- For fields that are code in nature, specify the description to be displayed as it appears in Director. Data validation translates the displayable value to the appropriate code. Note that the descriptions are case-sensitive.

- Boolean fields can be true/false or 1/0.

- All fields are mandatory when adding new users.

- When updating an existing user, fields left blank will not change existing values.

**Example:** Figure 106 illustrates the spreadsheet values before the Director import.

The following procedure describes the process of importing data from a CSV file into the user database. This procedure assumes that you have already successfully exported the data from the spreadsheet into a CSV file, and stored that file in the proper location.

1. Verify that the CSV file to be imported is located on the Headquarters server and in the following location:

   C:\ProgramFiles\ShorelineCommunications\ShoreWareServer

Adding Users

- These fields are required to add a user with DB Import: FirstName, LastName, GUIPassword, TUIPassword, GUILoginName.

- The Extension field is optional when adding a user. If not provided, it will be automatically assigned.

- Any blank or omitted fields will be left unchanged.

Updating Users
Batch Update Utility

- “Enter the Extension and any fields to be updated.
- “Any blank or omitted fields will be left unchanged.

Deleting Users

- “Enter the Extension and leave all other fields blank to delete a user.

2. Open the command prompt window in the directory shown above and run the following command:

```
Dbimport -log DbLog.log -err DbErr.err <CSV-file>
```

- `-err` is the flag to create an error log file.
- `error.log` is the file where error messages will be stored.
- `CSV-file` is the name of the file.

The import adds any new users and modifies any existing users in the user database as indicated in the CSV file.

When a user is updated, he or she is assigned to “Any IP Phone” on the IQ server.

**Batch Update Utility**

The Batch Update Utility lets you make changes to multiple users at the same time. It lets you find a set of users and globally change certain parameters. Due to the scope of this change, it is recommended to stop all ShoreTel voice services before running a batch update. Run the batch update utility during off hours as it may drop calls in the system.

The following list shows all possible criteria for locating a set of users:

- Server
- User Group
- Personal Assistant
- Home Site
- Home Switch

The following list shows the parameters that you can globally change for the selected users:

- Server
- User Group
- E-mail Domain Name
- Personal Assistant (for all call handling modes)
- Default Trunk Access Code
- Collaboration Server
Using the Batch Update Utility

1. Launch ShoreTel Director with administrator privilege.

2. Click Administration > Users > Batch Update Utility. The Batch Update Utility page appears in Figure 107.

![Batch Update Utility Page](image)

Figure 107: Batch Update Utility Page

3. Check the check box for criteria you want to use.

4. In the criteria field, select the parameters that you want to use.

5. Repeat steps 3 and 4 for each criteria you want to use.

6. Click Find. The Batch Update Utility Update page updates with user names and extensions, as Figure 108 shows.
7. In the Select from list, highlight the users to change and click the Add button. The users move to the Users to update field, as Figure 109 shows.

8. In the Select Update Action field, select the change type that you want to implement, as Figure 110 shows.
Click the **Update** button at the top of the page to initiate the change. Feedback on the action appears in the Update Results field, as Figure 111 shows.

**Note**

If you selected Change VMServer to option, a message appears indicating that the transfer of user mailbox data may still be in progress. Verify that the SMTP queue folder (<drive>:\Inetpub\mailroot\Queue) on the sending server(s) is empty before restarting/shutting down the sending/receiving server(s).

When the change is complete, you can make additional batch updates.

**Note**

Restart the voice services after finishing the batch changes.

The Notify Users page, shown in Figure 112, enables you to notify users that their ShoreTel client – Communicator or Communicator for Mobile – has been installed or upgraded. Once the user receives notification that their client application has been installed, the user can begin configuring personal options and use the application.

**Invoking Automatic Notification**

1. Launch ShoreTel Director with administrator privilege.
2. Click Administration > Communicator > Notify Users. The Notify Users page appears as shown in Figure 112.

![Notify Users Page](image1)

3. In the Send Email for field, select the ShoreTel client to which you want to send notification.

4. In the Notify section, select the option that you want to initiate. The options include the following:
   - Click the **All users** radio button to notify all users using the selected client.
   - Click the **All users on this server** radio button and in the field select the ShoreTel server to notify all users using the selected client on the ShoreTel server you select.
   - Click the **All users not yet notified** radio button to notify all users using the selected client who have not been notified.
   - Click the **This one user** radio button and use the Search field to select a specific user to notify to upgrade their client.

5. Click **Send Email** to send the notification e-mail.

**Extension Lists**

The Extension Lists page lets you create user groups that can be used by group paging and departmental auto-attendant. To create an extension list, do the following:

1. Launch ShoreTel Director with administrator privilege.

2. Click **Administration > Users > Extension Lists**. The Extension Lists page appears as shown in Figure 113.

![Extension Lists](image2)
3. Click **New** to create a new list. The Edit Extension Lists page appears as shown in Figure 114.

![Figure 114: Edit an Extension List](image)

4. In the **Name** field, enter the name that you want to use for this extension list.

5. In the Filter Users By section, do either of the following to specify how you want to sort users to include in this extension list as follows:
   - In any of the filter fields (First Name, Last Name, and Extension) enter the initial characters or numbers on which you want to search.
   - In the **Sort** field, select the criteria that you want for listing the directory.
   - Click **Apply**. The sorted list appears in the Choose Member field. The field lists up to 50 members.

   **Note**
   The Show Page field groups the member entries into segments. You can use this field to select segment that you want to appear in the field.

6. Select the members that you want to include in the extension list and click **Add**. The members appear in the Extension List Members field.

7. Click **Save**.
This chapter describes ShoreTel applications that users access during their regular activities. This chapter assumes that ShoreTel communicator is already installed on the client computer. For information about client-computer hardware, operating system, and software requirements and installation instructions, refer to the ShoreTel Planning and Installation Guide. The topics in this chapter include:

ShoreTel Communicator for Windows ............................................................. 391
  Installing ShoreTel Communicator ................................................................. 391
  Configuring for Instant Messaging ................................................................. 394
  Presence ........................................................................................................ 396
  Setting the Maximum Contact List Size ......................................................... 398
  Enabling SoftPhone for Users ...................................................................... 399
  Video Calls .................................................................................................... 399
  Programming Personal Communicator Toolbars .......................................... 401
Contact Center Integration with Communicator ........................................ 410
  Description .................................................................................................... 410
  Accessing Contact Center Agent Toolbar Functions .................................. 412
  Configuration .............................................................................................. 413
  Configuring Call Center Options through Communicator ........................... 416
  Integrating ShoreTel Communicator with Enterprise Contact Center ......... 416
  ECC Agent Queue .......................................................................................... 419
  ShoreTel Communicator Availability of Workgroup Controls to ECC Agents for Failover ................................................................. 421
Communicator for Mobile ............................................................................. 424
  Supported Configurations ............................................................................ 425
  Supported Devices for ShoreTel Communicator for Mobile ........................ 426
Requirements ................................................................................................... 428
Administrator Configuration .............................................................................. 429
ShoreTel Director Configuration ....................................................................... 433
Client Configuration Information Delivery ......................................................... 434
Configuring Information upon First-Time Use ................................................... 435
Upgrading Communicator for Mobile ................................................................. 438
Troubleshooting Tips for Communicator for Windows ....................................... 441
 Logging and Tracing Window ........................................................................... 441
 Investigating a Possible Break between ShoreTel Communicator and a CAS. 441
Troubleshooting Tool for Communicator for Mac ............................................. 442
ShoreTel Communicator for Windows

This section describes the resource requirements and installation steps for the ShoreTel Communicator client application. For a complete list of Communicator features, see the *ShoreTel Communicator for Windows User Guide*.

Through the graphical user interface in the ShoreTel Communicator application, a user can manage phone calls, voice mail, and personal system settings. The application supports all access types and related feature sets. ShoreTel Communicator supports five types of access:

- Personal access
- Professional access
- Workgroup Agent access
- Workgroup Supervisor access
- Operator access

Except for Personal access, the ShoreTel Communicator features require additional licenses or specific administrative authorization. For example, ShoreTel SoftPhone and Standard Resolution Video are covered by the Professional access license.

The following server platforms support ShoreTel Communicator:

- Windows 2008 Terminal Server, 32-bit, SP2
- Windows 2008 Terminal Server, 64-bit R2
- Windows 2008 Terminal Server, 64-bit (not R2)
- Windows Server 2012 Terminal Server, 64-bit, Standard and Data Center
- Citrix Xenapp 6.0 on Windows 2008, 32-bit, SP2
- Citrix Xenapp 6.5 on Windows 2008, 64-bit R2

Installing ShoreTel Communicator

The topics for the installation of Communicator in this section are as follows:

- Installation on a 64-bit or 32-bit Windows server
- Particular steps that are unique to a large network that uses Microsoft Corporation’s Active Directory
- Installation of Communicator for Windows
- Microsoft Lync IM Server 2010
Platform Supports

The platform terminal servers that ShoreTel Communicator supports are 64-bit and 32-bit versions of Windows 2008 R2.

Installing ShoreTel Communicator

1. Install Microsoft.Net Framework Version 3.5 or higher for Windows machines.

Note

The ShoreTel installation software does not include .Net Framework. This software is available from Internet sources or from a software vendor.

2. Install Communicator for Windows.

Installing Communicator for Windows on a 64-bit platform puts files in the following:

- The default location is C:\Program Files (x86)
- The location of 32-bit client dll files is C:\Windows\SysWow64

Installation in a Large Deployment that Uses Active Directory

Some unique requirements exist for the installation of ShoreTel Communicator in a large deployment that uses Active Directory. This section outlines both the manual and the automated installation of ShoreTel Communicator in a large site with Active Directory. The decision for how to proceed depends on the following key factors:

- Whether manual (local) or remote installation is used
- Presence on the server of .NET Framework version 3.5 or higher
- Access to the World Wide Web (if .NET Framework 3.5 is not on the server)

The version of .NET Framework that is used should be the 32-bit version for a 32-bit server or the 64-bit version for a 64-bit server.

Manual Installation

.NET Framework can be manually installed in one of two scenarios. In one scenario, the Prerequisites folder contains .NET Framework 3.5 (or higher). In the other scenario, .NET Framework 3.5 does not exist at all on the ShoreTel server. If the required version of .NET Framework does not exist on the system, Web connectivity is required during installation.

Manual Setup with .NET Framework in the Prerequisites Folder

The ability to install ShoreTel software manually depends on the availability of .NET Framework 3.5. If the Prerequisites folder contains .NET Framework 3.5 (along with other needed files), the system administrator can run setup.exe while the system is disconnected from the Web. If the system does not already have .NET Framework, the system must have an operational connection to the Web.
Manual Setup with .NET Framework Absent

If the Prerequisites folder does not contain .NET Framework 3.5, the system must have Web connectivity because, when the system administrator runs setup.exe, the system automatically downloads .NET Framework 3.5.

Automated Setup

If the system administrator is using automated (remote) installation to set up ShoreTel Communicator in a large network that uses Active Directory, the administrator must push the following packages in the order listed below by using Microsoft Corporation's Group Policy Object (GPO) or another deployment tool:

1. Microsoft .NET Framework 3.5 (not located in the Prerequisites folder). Either .NET Framework exists on the system or the system must be connected to the Web (so that initiation of setup.exe causes a download of .NET Framework.)

2. Interop Assemblies (located in the Prerequisites folder) should contain Primary Interop Assemblies for 2007 and VSTO (Visual Studio Tools for Office).

3. Communicator (CMWin), located in the Setup folder.

Installing Communicator for Windows

To install ShoreTel Communicator for Windows, enter the following URL in a browser:

- http://<ShoreTel_server_name>/shorewareresources/clientinstall

**Note**

- Windows hotfix KB978637 must be installed prior to the installation of ShoreTel Communicator on a 64-bit Windows 7 system.
- In some PC configurations, SDA drivers used in ShoreTel Communicator for Windows may disable Microsoft Windows 7 Aero during Web conferences active presentation share or during installation.

Installing Communicator for Mac

ShoreTel Communicator supports all Mac platforms. (See the ShoreTel Communicator for Mac Client User Guide for more details about the Mac client.)

Start the download and install ShoreTel Communicator for Mac by entering the following URL (for the ShoreTel Communicator Install webpage hosted by ShoreTel Director):

- http://<serverIPaddress>/ShoreTelresources/Clientinstall/

where serverIPaddress is the IP Address of the ShoreTel Headquarters server.

(This action is the same action used for ShoreTel Communicator for Windows.)

A disk image file (.dmg) subsequently downloads and automatically mounts. You can then install it on the Mac.
To install ShoreTel Communicator for Mac, drag and drop the ShoreTel Communicator Icon into the Mac Application folder.

Configuring for Instant Messaging

Instant messaging (IM) is the real-time transmission of text between two system users. Instant messages are sent from and received through a message window. Instant messages do not use call cells.


ShoreTel Communicator for Windows supports IM. It enables users to communicate with third-party instant messaging servers that support SIP/SIMPLE protocols. To provide IM in ShoreTel Communicator, the deployment must use one of the following:

- A ShoreTel Service Appliance, such as the SA-100 or SA-400
- Microsoft's Lync IM Server
- ShoreTel Converged Conferencing (legacy)

ShoreTel Service Appliances

The ShoreTel SA-100 and SA-400 also support ShoreTel instant messaging and presence information exchanges. For more information, refer to the Conferencing and Instant Messaging Planning Installation and Administration Guide.

Setting up the System Server

The following presence servers and protocols support ShoreTel Instant Messaging:

- ShoreTel Service Appliances support IM transmissions through HTTPS.
- Microsoft Office Communications Server, Version 2007: ShoreTel supports IM transmissions through TCP, TLS, and UDP.
- Microsoft Lync IM Server 2010: When using Microsoft Lync IM Server, ShoreTel supports IM transmissions through TCP, TLS, and UDP.

ShoreTel allows multiple presence servers on a system. Each user can be assigned to only one presence server. Users can exchange instant messages only with other users assigned to the same presence server.

To associate a presence server with the ShoreTel system:

1. Launch ShoreTel Director.
2. Click Administration > Application Servers > IM Servers. The IM Server List page appears.
3. Click the New button. The IM Server Info dialog box pops up.
4. In the Name field, enter a name for this IM profile.
5. In the **Server Type** field, select the type of server for IM.
6. In the **Protocol** field, enter the protocol that the IM server uses.
7. In the Host field, enter the fully qualified domain name (FQDN) of the IM device to use to provide IM services for this profile.
8. Check the **Override Default Port** checkbox if the server is using a port other than 5222.
9. Press the **Save** button in the IM Server popup.
10. Click **Ping** next to the Host box in the IMServer Info page to verify that the host is accessible. If the ping is successful, you can save the configuration.
11. Click **Save** in the IMServer Info popup.

When changing the Presence Server version, access the IM Server popup and enter the presence version in the Server Type data entry field.

**Configuring a User for Instant Messaging**

For a user to have IM functionality, the administrator enables the access, and the user activates the service in ShoreTel Communicator > Tools > Options > Instant Messaging. For a description of how to enable IM for a user, see **Enabling Instant Messaging for a System User** on page 395. The Communicator for Windows User Guide has instructions for configuring instant messaging options in the user’s Communicator window.

---

**Note**

Users with any type of Access License can use IM.

**Enabling Instant Messaging for a System User**

1. Launch ShoreTel Director.
2. Click **Administration > Users > Individual Users**. The Individual User List page appears. Configuration steps for IM access are confined to the General page for the individual user page.
3. In the First Name column, select the user that you want to enable. The Edit User page appears in **Figure 115**.

*Figure 115: Instant Messaging Settings on the Edit User Page*
4. Verify that the First Name and Last Name parameters list the user for which you are enabling Instant Messaging.

5. Mark the **Allow Telephony Presence** check box.

6. Select a service appliance for an IM server (such as the SA-100 or SA-400) or other appliance in the Server/Appliance scroll list. See Figure 115 for this user by scrolling down to the Instant Message Settings section and field.

7. In the IM ID data entry field, enter the address through which the user receives and sends Instant Messages. The address should be the same as it is configured on the Microsoft Lync IM Server or Microsoft Office Communicator Server.

---

**Note**

If a ShoreTel Service Appliance is used for instant messaging, this field is not necessary and does not appear.

8. Press the “Save” button at the top of the page to enable the changes.

9. Verify that the presence server is configured to authorize access by the address specified for the user in Step 7.

   Consult the user documentation for the presence server for instructions on authorizing user access.

10. Do the following to advise the user to verify access to the presence server:

    a. Opening the “Options and Preferences” page from the user’s Communicator Main Window.
    b. Selecting Instant Messaging in the Menu on the left side of the page.
    c. Entering the user’s username and password for the Microsoft Lync IM Server in the Account Information section at the top of the page.
    d. Pressing the Reconnect button.

   The Status Bar in the Main window displays the results of Communicator’s attempt to access the presence server.

---

**Presence**

Presence is a ShoreTel feature that identifies, uses, and distributes the availability of system users and other personal contacts. Presence information allows users to verify the availability of other users before attempting to contact them. Presence improves overall enterprise productivity by reducing calls to unavailable parties and by providing the enhanced ability to immediately schedule meetings, events, and communication sessions based on the availability of desired participants. Users can also choose when to receive Instant Messages by changing their presence settings.

Communicator for Windows defines three presence settings for each user:

- Telephony presence indicates a user's availability to accept voice calls.
Instant Messaging presence indicates a user’s availability to engage in IM conversations.

Combined presence is a single setting that indicates user availability on the basis of Telephony and IM presence status.

Communicator automatically adjusts the presence status of users as they use system resources. Users can also manually adjust their status at any time.

A user can monitor the presence of a maximum of 500 other contacts. Administrators configure the number of contacts a user can monitor by setting the maximum contact list size, as described in the Setting the Maximum Contact List Size on page 398.

Configuring a User for Presence

Telephony presence is available to users of all Communicator types. IM presence is available to users authorized to use Professional, Operator, Workgroup Agent, or Workgroup Supervisor Communicator. Director settings control user access to both presence types.

Configuring Presence for a User is a two step process:

1. The administrator enables presence for the user.
   
   The Enabling Presence for a User on page 397 describes the process of enabling presence for a user.

2. The user configures presence user options.
   
   Refer to the Communicator for Windows User Manual for instructions on configuring presence user options from the user’s Communicator window.

Enabling Presence for a User

1. Launch ShoreTel Director.

2. Click Administration > Users > Individual Users. The Individual Users page appears.

3. In the First Name column, click on of the desired user. The User page appears.

4. Verify the First Name and Last Name parameters list the user for which instant messaging is being enabled.

5. Check the Allow Telephony Presence check box.

6. Click Save.

Enabling a user for IM Presence

Users that are authorized for IM are automatically configured for IM presence.
Setting the Maximum Contact List Size

Contacts are directory entries whose information is organized into specialized lists called Contact Lists to provide convenient access by a ShoreTel Communicator user. Contacts are selected from directories accessible to Communicator, including the System Directory, Personal directory or Microsoft Outlook. Contact Lists, which are normally accessed from the Communicator main page, provide quick access to regular directory entries without navigating through the directory menus. Users can perform tasks on Contact List entries that are available from other directories such as initiating voice call or instant messages, handing active calls, and sending email or voice messages.

The maximum ShoreTel Contact List size is 10-100,000 contacts for each user. The size of each user’s Contact List is controlled through a Class of Service setting.

Note

By default, users of ShoreTel Communicator can upload contacts. In Director, no facility is available for enabling or disabling a user’s ability to upload contacts. The upload enable is global—either all users have the ability or no users have the ability to upload contacts from Communicator. Customers with a need to turn off the users’ ability to upload contacts must contact ShoreTel TAC or the channel partner for assistance in disabling the contact upload capability.

To set the maximum Contact List size for a selected Class of Service:

1. Open the Class of Service list page by selecting **Administration > Users > Class of Service** in the Director Menu.

2. Open the Edit Telephony Features Permissions page by clicking the name of the selected Telephony Features Permissions class of service at the top of the Class of Service list page.

3. Enter the maximum Contact List size in the Max. Buddies Per User field located at the top of the Edit Telephony Features Permissions page, as shown in Figure 116.

![Figure 116: Setting the Maximum Contact List Size for a Class of Service](image_url)

The maximum Contact List size specified by a class of service is imposed upon a user when the COS is assigned to that user.
Enabling SoftPhone for Users

Softphone is a completely integrated software component of Communicator for Windows. SoftPhone users participate in voice calls and listen to messages through a headset or speakers with a microphone without additional hardware. The Edit User – General page in Director enables users to access to Softphone.

To enable Softphone access for a user:

1. Open the Individual User list page in Director by selecting Administration > Users > Individual Users from the main menu.
2. Open the Edit User page by clicking on the First Name of the desired user in the Individual User List.
3. Verify the First Name and Last Name parameters list the user for which Softphone service is to be enabled.
4. Verify that the General menu tab is selected on the page selection bar at the top of the page.
5. Select the Allow Use of SoftPhone parameter, located in the center of the page.
6. Click Save at the top of the page to enable the changes.

Video Calls

ShoreTel supports video calls between two Communicator users with primary phones that are communicating directly. Users can add video to a new or existing call when the following conditions are true for both users:

- Users have set up the addition of video to calls in ShoreTel Communicator > Tools > Options and Preferences > Video. (A user also has the option in Communicator to decline a request for a video call.)
- Instances of Communicator must be communicating through a ShoreTel server.

ShoreTel supports video calls through the Scalable Video Coding (SVC) codec (the Annex G extension of the H.264/MPEG-4 AVC video compression standard.)

The video call feature has the following restrictions:

- ShoreTel does not support video-only calls.
- Callers must have a primary phone (not SoftPhone).
- ShoreTel does not support server-based star-configurations or interoperability with video solutions from vendors other than ShoreTel.
Enabling Video Calls for Users

This section describes how to enable video call usage in an individual user’s configuration. Regardless of the individual user enable, the User Group to which he or she belongs must have a Class of Service that enables Allow Intersite Video Calls.

To enable Video call access for an individual user:

1. Open the Individual User list page in Director by selecting Administration > Users > Individual Users from the main menu.
2. Open the Edit User page by clicking the First Name of the user in the Individual User List.
3. Verify that the First Name and Last Name parameters list the user for which Video is to be enabled.
4. Verify that the General menu tab is selected at the top of the page.
5. Select the option from the Allow Video Calls drop-down menu located in the center of the page. The drop-down menu options include
   - None: The user cannot make or receive video calls.
   - Standard Resolution: The user can perform VGA resolution video calls.
6. Click Save at the top of the page to enable the changes.

Enabling Intersite Video Calls

Allow Intersite Video Call is a Class of Service parameter. Members of a COS can conduct video calls only if this parameter is enabled. (The permission for an individual to have video call ability is in the Edit User page for the user.)
To enable intersite video calls for a class of service:

1. Open the Class of Service list page by selecting **Administration > Users > Class of Service** in the Director Menu.

2. Open the Edit Telephony Features Permissions page by clicking the name of the selected Telephony Features Permissions class of service at the top of the Class of Service list page.

3. Select the **Allow Intersite Video Calls** parameter on the top portion of the Edit Telephony Features Permissions page.

4. Click **Save**.

### Programming Personal Communicator Toolbars

Programmable Toolbars for Communicator are similar to regular toolbars in that they extend across the top of the Communicator user interface. However, the buttons in these new toolbars can be programmed with common operations in a manner similar to the programmable buttons on some IP phone models.

Once a user’s toolbar buttons have been configured, the user can perform many basic telephony operations just by clicking a button in Communicator. For example, a button could be configured to “speed dial” another extension or open up the user's default browser to a programmed URL when clicked.

In addition, Programmable Toolbars provide the foundation for integrating ShoreTel Communicator with Contact Center’s Agent Toolbar. End users can assign Contact Center functions to the buttons on the Communicator Toolbar and control their contact center state while accessing call control functions from a single, unified interface.

### Details

- Toolbars must be configured by the system administrator via ShoreTel Director.

- Toolbars can be configured per-user (see **Creating a Personal Programmable Toolbar** on page 404) or globally (see the **Creating a Global Programmable Toolbar** on page 407).

- Up to 6 toolbars can be defined per user, with each toolbar supporting up to 24 programmable buttons.

- Each user can additionally inherit up to 3 global toolbars through their user group.

- Each toolbar can exist on a separate row in the UI or toolbars can share a row.

- Rows can be docked or moved around the top portion of the window as a group.

- Individual toolbars can be shown or hidden from the View menu in the Communicator user interface.

- Buttons may combine an operation with a parameter (such as a user extension), allowing one-click access to commonly performed operations, such as blind-transferring to a particular user.
Buttons assigned with a particular operation will be disabled when their corresponding menu items are disabled. For example, some of the Contact Center function buttons are not available as menu items, thus ensuring that the system administrator can easily block access to those functions on a per-user basis.

Buttons that are associated with an extension (such as Blind Transfer or Extension Monitor) will show the Communicator-user when the monitored party has call activity. Additional presence information appears if the user hovers the cursor over the associated button.

The user can have any and all toolbars active at once.

Supported operations are listed on the following page.

**Supported Operations**

- Add/Modify Contact
- Agent Login
- Agent Logout
- Agent Wrap-Up
- Answer
- Answer Call Center Call
- Assign to Last External Number (Extension Assignment / Extension)
- Barge In
- Blind Transfer Agent
- Bridged Call Appearance
- Change CHM
- Change Default Audio Path
- Conference
- Conference Blind
- Conference Consultative
- Conference Intercom
- Consult Transfer Agent
- Dial Mailbox
- Dial Number (Speed Dial)
- Edit Call Note
- End Wrap-Up
- Execute DDE command
- Extend Wrap-Up
- Go Home
- Group Pickup
- Hangup
- Help
- Hold
- Intercom
- Invoke Command line
- Invoke URL
- Login Group
- Login Primary Groups
- Logout Group
- Logout Primary Groups
- Monitor Extension
- Open Agent Monitor
- Open Conference Mgr
- Open Control page
- Open Directory
- Open Extension Monitor
- Open External Assignment
- Open History Viewer
- Open Queue Monitor
- Open Soft Phone
- Open Voice Mail
- Page
- Park
- Park and Page
- Pickup
Creating a Personal Programmable Toolbar

To configure the buttons of a user's Communicator Programmable Toolbar, follow the instructions below:

- Pickup Night Bell
- Record Call
- Record Extension
- Reinsert Busy Call
- Reinsert Terminated Call
- Reinsert Unanswered Call
- Release with Code
- Resume/Release
- Run Contact Center App
- Send Digits Over Call
- Set Agent ID
- Silent Monitor
- Supervisor Help
- To AA
- To VM
- Toggle Handsfree
- Transfer
- Transfer Blind
- Transfer Consultative
- Transfer Intercom
- Transfer to Mailbox
- Transfer Whisper
- Unpark
- Whisper Page
- Whisper Page Mute
- Wrap Up Code
1. Launch ShoreTel Director and enter the user ID and password.

2. Click **Administration > Users > Individual Users**. The Individual User page appears.

3. Select the user whose profile you want to edit. The Edit User page appears.

4. Click the **Personal Options** tab. The Personal Options tab appears as shown in Figure 117.

![Figure 117: Personal Options Tab](image)

5. Click the **Program Communicator Toolbars** link. The Program Communicator Toolbars page appears as shown in Figure 118.

![Figure 118: Program Communicator Toolbars Page](image)

6. Click the **New** button. The Program Communicator Toolbar Buttons page appears as shown in Figure 119.
7. In the Name field, enter the name you want to use for this toolbar.

8. Click on the first Function drop-down menu (which should say “All”) and select the category. Options are:
   - All - This lists all operations
   - Contact Center - (For example, Login Group, Logout Group, Answer Call Center Call, etc.)
   - Config - (For example, toggle Handsfree mode, toggle audio path, Agent Wrap-Up, etc.)
   - Other - (For example, Unused)
   - Telephony - (For example, Conference, Intercom, Group Pickup, etc.)
   - Windowing - (For example, Open History Viewer, Open Agent Monitor, Open Control Panel, etc.)

9. Click on the second Function drop-down menu (which should say “Unused”) and select the specific operation this button identifies.

10. Enter a label in the Label field. The maximum is 12 characters.

11. If the Target field becomes active, type or select the information that is appropriate for the type of operation to perform. For example, if the operation is a user-change to Call Handling Mode, then a Call Handling Mode dropdown appears in the Target area. Parameters are mandatory for some functions (such as changes to CHM) and optional for others (such as Blind Transfer). With the optional parameters, the user is prompted for related information the first time that he or she initiates the function in the programmable toolbar.

12. Continue programming the toolbar buttons as desired.

If a button is left unused or blank and this unused button is between some other, used buttons in Director, Communicator interprets this blank button as a divider that it displays on the toolbar.
13. Click **Save** to store changes.

When finished programming the toolbar for a user, the user's Communicator window should now have a toolbar similar to the one shown in **Figure 120**.

![Communicator Window with Programmable Toolbar](image)

**Figure 120: Communicator Window with Programmable Toolbar**

**Creating a Global Programmable Toolbar**

To simplify configuration, you can configure a global Programmable Toolbar for many users instead of configuring the Programmable Toolbar for individuals.

**Creating a global Programmable Toolbar**

1. Launch ShoreTel Director.

2. Click **Administration > Communicator > Global Toolbars**. The Global Toolbars List page appears as shown in **Figure 121**.

![Global Toolbars List Page](image)

**Figure 121: Global Toolbars List Page**

3. Click the **New** button. The Edit Global Toolbar Buttons page appears as shown in **Figure 122**.
4. In the Name field enter a name for this toolbar.

5. Click the first Function field (All is the default) and select a category:
   - All - This lists all operations.
   - 3rd Party - (For example, Login Group, Logout Group, Answer Call Center Call, and so on).
   - Config - (For example, toggle Handsfree mode, toggle audio path, Agent Wrap-Up, and so on).
   - Other - (For example, Unused).
   - Telephony - (For example, Conference, Intercom, Group Pickup).
   - Windowing - (For example, Open History Viewer, Open Agent Monitor, Open Control Panel, and so on).

6. Click the second Function field (which should say “Unused”), and then select the operation that this button should perform.

7. Enter a label in the Label field. The maximum size is 12 characters.

8. If the Target field becomes active, type or select the information that is appropriate for the type of operation to perform. For example, if the operation is user-changes to Call Handling Mode, then a Call Handling Mode dropdown appears in the Target area. Parameters are mandatory for some functions (such as change CHM) and optional for others (such as Blind Transfer). With the optional parameters, the user is prompted for related information the first time that he or she initiates the function in the programmable toolbar.

9. Continue programming the toolbar buttons as needed.

   If a button is left unused or blank and this unused button is between some other, used buttons in Director, Communicator interprets this blank button as a divider that it displays on the toolbar.

10. Click Save when configuration is complete.
Assigning a global programmable toolbar to a user profile

1. Launch ShoreTel Director.

2. Click Administration > Users > User Groups. The User Groups page appears.

3. Select the user group to which you want to assign a global programmable toolbar. The Edit User Group page appears as shown in Figure 123.

4. In the User Profile section, click the Toolbar 1 field and select the desired global toolbar. All members of this user group will now have this toolbar appear on their Communicator.

5. Repeat Step 4 if multiple toolbars are desired - up to three global toolbars can be assigned to a user group.

6. Click Save to store the changes.
Contact Center Integration with Communicator

Description

ShoreTel integrates Contact Center functionality into Communicator, allowing end users to control their contact center state and access Contact Center functions and Communicator operations from a single, unified interface.

Figure 124 displays the non-integrated Contact Center Agent Toolbar.

![Figure 124: Contact Center Agent Toolbar](image)

This interface lets a Contact Center user program the buttons on the toolbar through assignment of common functions and call center operations to the individual buttons. Users can initiate a specific operation by clicking a button.

Contact Center functions integrate with Communicator through the assignment of Contact Center operations to buttons in the Programmable Toolbars. For the configuration steps, see Programming Personal Communicator Toolbars on page 401. Each toolbar can contain 24 buttons. To display additional buttons beyond those normally visible, click the arrow icon on the right side of the toolbar. Figure 125 shows ShoreTel Communicator with the Contact Center Toolbar.

Details

- Up to 24 buttons can be programmed in a single Communicator toolbar.
- Toolbars can be created on a per-user basis or on a global basis. Global toolbars can be deployed to multiple users.
- Three global toolbars can be used per User Group.
- A dedicated toolbar shows Contact Center status information at all times.
- The Contact Center toolbar shows agent status by using color coding.
- The system maximum is 100 per system.
- Six personalized toolbars can be created for each user.
- A user can employ 3 global toolbars in addition to 6 personalized toolbars, (total of 9 toolbars). With 24 buttons per toolbar, a user can deploy a total of 216 programmable toolbar buttons. (24 buttons per toolbar x 9 toolbars = 216 buttons.)
Agent Status Color Coding

On the Contact Center toolbar, the color of the line of the rectangle highlighting the status of an Agent is different for each state. The colors and states are listed in the following table:

<table>
<thead>
<tr>
<th>Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Logged Out</td>
</tr>
<tr>
<td>Green</td>
<td>Logged In</td>
</tr>
<tr>
<td>Blue</td>
<td>Wrap-Up</td>
</tr>
<tr>
<td>Yellow</td>
<td>Released</td>
</tr>
</tbody>
</table>

Release With or Without a Code

The amount of time an Agent spends between calls is displayed in the Contact Center toolbar in the Release message, providing a visual accounting of the time spent from the end of one call to the beginning of the next call.

**Note**

The timer increments from zero when a call is ended, and is reset to zero when the next call is started. The timer displays the time as hh:mm:ss (hours, minutes, seconds).

A Release message can be configured by an Agent to display a code or description of the reason for the Release.

If a Release is started without a code, the timer begins incrementing from zero after the Release is specified by the Agent.

If a Release is started with a code, the timer begins incrementing from zero after the Release and the Release code are specified by the Agent.

Wrap-Up with/without Code

A description of the outcome of a completed call is displayed in Contact Center in the Wrap-Up message, providing a visual description of the nature of the completed call.
A Wrap-Up message can be configured by an Agent to display a code or description of the reason for the Wrap-Up.

If a Wrap-Up is started without a code, the timer begins incrementing from zero after the Wrap-Up is specified by the Agent.

If a Wrap-Up is started with a code, the timer begins incrementing from zero after the Wrap-Up and the Wrap-Up code are specified by the Agent.

If a Wrap-Up is extended by an Agent, the timer continues incrementing from the point at which the extension is specified (the timer is not reset).

### Accessing Contact Center Agent Toolbar Functions

The available Contact Center operations in Table 47 show the name of corresponding operations in the integrated Communicator (if applicable). An operation that does not appear in the Contact Center Agent Toolbar column does not have an analogous function in the integrated Communicator. Often, a Contact Center operation does not have an analogous Communicator operation because the Contact Center operation can be done through an existing function in the regular (non-integrated) ShoreTel Communicator.

<table>
<thead>
<tr>
<th>Contact Center Operation Name</th>
<th>Operation Button or Path in Communicator</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Telephony Operations</strong></td>
<td></td>
</tr>
<tr>
<td>Answer</td>
<td>Answer Call Center Call</td>
</tr>
<tr>
<td>Set Callback - Reinsert Busy</td>
<td>Reinsert Busy Call</td>
</tr>
<tr>
<td>Set Callback - Reinsert No Answer</td>
<td>Reinsert Unanswered Call</td>
</tr>
<tr>
<td>Set Callback - Reinsert Terminate</td>
<td>Reinsert Terminated Call</td>
</tr>
<tr>
<td><strong>ACD Operations</strong></td>
<td></td>
</tr>
<tr>
<td>Groups Manager</td>
<td>Select <a href="#">Contact Center &gt; Agent Manager</a> from Communicator</td>
</tr>
<tr>
<td>Login Primary Groups</td>
<td>Login Primary Groups</td>
</tr>
<tr>
<td>Logout from Primary Groups</td>
<td>Logout Primary Groups</td>
</tr>
<tr>
<td>Login Group</td>
<td>Login Group</td>
</tr>
<tr>
<td>Logout Group</td>
<td>Logout Group</td>
</tr>
</tbody>
</table>
To configure integrated Contact Center for a user, follow these steps:

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
3. Click on the name of the user whose toolbar you would like to configure. The Edit User page appears as shown in Figure 126.

Table 47: Communicator access methods to Contact Center operations (Continued)

<table>
<thead>
<tr>
<th>Contact Center Operation Name</th>
<th>Operation Button or Path in Communicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Wrap Up (Ready)</td>
<td>End Wrap-Up</td>
</tr>
<tr>
<td>Release with Code</td>
<td>Release With Code</td>
</tr>
<tr>
<td>Resume/ Release</td>
<td>Resume/Release</td>
</tr>
<tr>
<td>Supervisor Help</td>
<td>Supervisor Help</td>
</tr>
<tr>
<td>Transfer to Agent</td>
<td>Blind Transfer Agent</td>
</tr>
<tr>
<td>Wrap-Up Code</td>
<td>Wrap-Up Code</td>
</tr>
<tr>
<td>Wrap-Up Manual Control</td>
<td>Extend Wrap-Up</td>
</tr>
</tbody>
</table>

**Accessing Applications Windows**

- Desktop Wallboard: Select Contact Center > Desktop Wallboard from Communicator.
- Call Status: Select Contact Center > Call Status from Communicator.
- Queue Calls: Select Contact Center > Queue Calls from Communicator.
- Agent Log: Select Contact Center > Agent Log from Communicator.
- Contact Center Reports: Select Contact Center > Contact Center Reports from Communicator.

**Other Operations**

- Pop-up window as client is launched: Set Agent ID.
- Execute an Application: Run Contact Center App. (or execute from Command Line).

**Contact Center Functions Not Available in Communicator**

- Divert Incoming Call
- Manage List of Login / Logout ACD Groups
- Open Telephony Window
- Chat Tree
4. In the Access License field, select a license that supports Contact Center (Personal or Professional).

5. Check the Enable Contact Center Integration check box.

6. Click Save to store changes.

To configure the programmable buttons toolbar for this user, follow these steps:

1. Click the Personal Options tab for the user who’s system is to be configured, and then click the Program Communicator Toolbars link.

2. On the Program Communicator Toolbar page, click New. The Program Communicator Toolbar Button page appears, as Figure 127 shows.
3. Enter a name for the toolbar and then click on the **Function** drop-down menu and select **Contact Center**.

4. Then, select the desired operation from the drop-down menu. This operation will be associated with this specific toolbar button.

5. Enter a label in **Label** field.

6. If the function requires **Target** information, the required fields appear to the right of the function. Enter the appropriate information for the type of operation the button is to initiate. (For example, if the chosen operation is Blind Transfer Agent, then an Agent ID field would appear in the **Target** area).

   If a required target field for an operation remains blank or is configured with invalid information, the system opens a dialog box to collect more (or valid) information when the user clicks on the associated button in Communicator. This behavior applies to the following operations:

   - Consult Transfer to Agent
   - Blind Transfer to Agent
   - Login/Login Group
   - Logout Group
   - Release with Reason Code
   - Wrap-up with Code

7. Continue programming the toolbar buttons as desired.

   If a button is left unused or blank and this unused button is between other used buttons, Communicator will interpret the sequence of blank buttons as a divider that will be visible on the toolbar.
8. Once the configuration of the toolbar programmable buttons is complete, click **Save** to store the changes.

**Details**
- Repeat this process of assigning operations to buttons for each new user that will be using the integrated Communicator.
- When finished configuring buttons for each new user, follow the procedure below to configure the Communicator clients.

**Configuring Call Center Options through Communicator**

To configure the Contact Center options for a Communicator user, refer to the *ShoreTel Communicator for Windows User Guide*.

**Integrating ShoreTel Communicator with Enterprise Contact Center**

1. Launch ShoreTel Director; type the user ID and password; and then click **Login**.
2. Click on the **Administration** link if necessary to expand the list.
3. Click on the **Users** link and then click on the Individual **Users** link.
4. Click on the name of the user to select the toolbar to configure.
5. Select **Enable Contact Center Integration**, as shown in Figure 128.
6. Click **Save**. The next task is to program the user’s toolbar buttons.

To configure the programmable Buttons Toolbar for the selected user, follow these steps:

1. Click the user’s **Personal Options** tab.
2. Click the Program Communicator Toolbars link near the center of the Personal Options window. If the user already has a Communicator toolbar configuration, a window like the example in Figure 129 opens. If no configuration exists, a blank space is displayed. For a new toolbar configuration, go to Step 3.
3. Click the **New** button to open a fresh button-programming screen.

   The example in Figure 130 shows a new toolbar window in progress. It shows the choices and illustrates how the choice of operation can activate an additional parameter called Target. (Target can be a text entry box or drop-down menu.) In Figure 130, the two new function/operation combinations have triggered the appearance a Target option related to the selected operation. For the Contact Center’s Blind Transfer Operation, the Target becomes the ID of the agent who should receive the transferred call.

4. Type a name for the new toolbar in the Name field.
5. Select **Contact Center** from the drop-down menu under the Function heading.

6. Select the operation from the drop-down menu to the right of the Function choice. This operation is associated with this toolbar button. (After the Contact Center function is chosen, the available operations apply to Contact Center only.)

7. Type a label in Label field.
8. Specify a target if the selected operation activates the Target option.

If a required target field for an operation is left blank or configured with invalid information, the system opens a dialog box to collect valid information when the user clicks on the associated button in Communicator. This pop-up dialog box appears when inadequate information is configured for the following operations:

- Consult Transfer to Agent
- Blind Transfer to Agent
- Login/Login Group
- Logout Group
- Release with Reason Code
- Wrap-up with Code

9. Continue programming the toolbar buttons as needed.

**Note**

If a button is unused or blank and this unused button sits between other, used buttons, Communicator interprets the sequence of blank buttons as a divider that is visible on the toolbar.
10. When the toolbar button programming is done, click **Save**.

Repeat the process of assigning operations to buttons for each new user who is to use the integrated Communicator.

**ECC Agent Queue**

In a small call center or a sales-oriented call center, calls that are routed to an agent often must be queued for the agent when he or she is not available. The Agent Queue feature in Enterprise Contact Center allows calls to wait in a queue that is specific to an agent. Also, in conjunction with the Agent Queue feature, ShoreTel Communicator has been enhanced to let the agent manage his or her Enterprise Contact Center queue.

After a system administrator enables Transfer to Agent Queue for the individual agent-user in ShoreTel Director, the agent sees a Transfer to Agent Queue toolbar button in his or her ShoreTel Communicator. Subsequently, after logging into Enterprise Contact Center, the agent can press a button in Communicator to transfer an incoming call to his or her individual agent queue.

**Implementation**

This section describes how to enable the Agent Queue capability for an agent-user in Director. The Transfer to Agent Queue toolbar button is enabled in the same manner as other toolbar buttons in ShoreTel Director.

Refer to the Enterprise Contact Center Administrator Guide for additional information on the implementation of the feature.

To enable the Agent Queue capability in Director, follow these steps:

1. Launch ShoreTel Director.

2. Click **Administration > Users > Individual Users**. The Users page appears.

3. Click the **Personal Options** tab.

4. Click the **Program Communicator Toolbars** link. The Program Communicator Toolbars page appears.

5. Click the **New** button or select the user you want to configure. The Program Communicator Toolbar Buttons page appears as shown in Figure 131.
6. In the first Function field, select Contact Center.

7. In the second Function field, select Transfer to Agent Queue.

8. In the Label field, type the label for the button. You can use up to 12 characters for the label.

9. Click Save.

**Error Messages for ShoreTel Communicator Enhancements**

ShoreTel Communicator lets an agent transfer an existing ACD call to an Agent Queue. In addition, the enhancements include failure messages for attempted transfers that fail and a warning message if the agent tries to log out while calls still exist in the Agent Queue.

Table 48 describes the new messages that an agent might see.

**Table 48: Agent Queue Error Messages**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>You have queued calls in your personal queue. Press OK to logout of all queues or Cancel to remain logged in to just your personal queue.</td>
<td>When an agent logs out of all Enterprise Call Center groups from ShoreTel Communicator but still has calls queued in the Agent Queue, a warning message window pops up.</td>
</tr>
<tr>
<td>FAILMSG_FAILED_TO_SEND_CALL_TO_AGENT_QUEUE = 38</td>
<td>An attempt to transfer the call to the agent queue has failed.</td>
</tr>
</tbody>
</table>
ShoreTel Communicator Availability of Workgroup Controls to ECC Agents for Failover

Workgroup controls in the ShoreTel Communicator are available to Enterprise Contact Center (ECC) agents who use ShoreTel Communicator and are also members of a workgroup. The Login/Logout controls reflect their state in both ECC and the workgroups and are synchronized between these two systems.

Figure 132 shows the menu of ECC items for the Workgroup Agent Communicator when ECC integration has been enabled for the user. ECC control and status information includes the following items:

- Logged Out of All Groups (agent status)
- Set Agent ID
- Log In/Out
- Release/Resume
- Wrap-up Code
- Release with Code

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAILMSG_FAILED_TO_SEND_CALL_TO_AGENT_QUEUE_ALREADY_ANSWERED</td>
<td>An attempted call transfer to an agent queue failed because the call was answered by another agent.</td>
</tr>
<tr>
<td>FAILMSG_FAILED_TO_SEND_CALL_TO_AGENT_QUEUE_NON_ACD = 40</td>
<td>An attempt to transfer the call to the agent queue has failed because the call is a non-ACD call.</td>
</tr>
<tr>
<td>FAILMSG_LOGOUT_FROM_AGENT_QUEUE_FAILED</td>
<td>An attempt was made to logout all, logout primary, or logout specific from an agent queue while are calls were queued in the agent queue.</td>
</tr>
</tbody>
</table>

Table 48: Agent Queue Error Messages (Continued)

Figure 132: Workgroup Agent Communicator with ECC Integration Enabled
Agent State Changes in ShoreTel Communicator

When an agent starts up ShoreTel Communicator, the agent’s initial state is logged out of all ECC groups and all workgroups. Upon selecting Log Into All Groups, the agent logs into all ECC groups and all workgroups for which he or she is programmed (see Figure 133). Upon logging out, the agent is logged out of all ECC groups and all workgroups. If the ECC agent state changes to the Release state, the Workgroup state changes to the Wrap-Up state.

Note
ShoreTel recommends that an ECC agent be allowed to log into only workgroups that serve as a backup for the main ECC route. Receiving calls concurrently from ECC and Workgroups that are not backup workgroups could cause inconsistencies in reporting of Non-ACD (NACD) calls in ECC.

Failover Behavior of ShoreTel Communicator

If ECC is unreachable or unavailable, ShoreTel Communicator indicates the system is in “Failover Mode” (while the agent is a member of a Workgroup), as shown in Figure 134. Failover Mode lets an agent continue to log in and out of workgroups through the Contact Center menu or the toolbar menu. As Figure 134 suggests, only the Log Into All Groups and Log Out of All Groups options remain available. Other options are grayed out.
If ECC is unreachable or unavailable and the agent is not a member of a Workgroup, ShoreTel Communicator displays “System Unavailable” as shown in Figure 135.

Figure 135: Failover Behavior of ShoreTel Communicator without Workgroup
Other Behaviors of ShoreTel Communicator

If ShoreTel Communicator loses contact with an ECC server, it keeps the login state locally. (The local state is the state the client was in before disconnection.) When connectivity resumes, ShoreTel Communicator logs in or logs out based on the local login state.

If an administrator disables Contact Center Integration in ShoreTel Director, ShoreTel Communicator logs out of all ECC groups but remains in the last known state that was set for the workgroups (any workgroup) of which the ShoreTel user is a member.

Workgroup Agent Contact Center Integration

To enable Contact Center Integration if you want the agent to also use the Workgroup Agent Access level licensing, follow these steps:

1. Log into ShoreTel Director.
2. Click on the Users > Individual Users link (see Figure 136).
3. In the Access License drop-down list, select Workgroup Agent.
4. Put a check the Enable Contact Center Integration checkbox.
5. Click on the Save button.

Figure 136: Selecting the Workgroup Agent Access License Configuration

Communicator for Mobile

Communicator for Mobile expands the remote user feature set by adding Communicator functionality to mobile devices.

Communicator for Mobile comprises the following components:

- Communicator for Mobile Server (MCMS) is a ShoreTel server component that manages all communications with ShoreTel Communicator for Mobile clients. Installing the ShoreTel Server includes the automatic installation of MCMS.
- The Communicator for Mobile client application is installed on each mobile device. Communicator for Mobile accesses ShoreTel functions, configuration information, voicemail, and calling history by communicating with the MCMS.

The MCMS is located on the main and distributed ShoreTel servers. Secure wireless communication sessions with specified mobile devices are conducted through a Reverse Proxy Server or a Blackberry Enterprise Server.

Mobile devices receive MCM Client Installation Files from the ShoreTel Server through a Blackberry Enterprise Server. After installing these files, the end user can configure the mobile device to access the ShoreTel server through an IP address provided by the system administrator.

ShoreTel Communicator for Mobile enables a mobile device to function as a ShoreTel extension and provides an interface, similar to Communicator, for accessing ShoreTel client information. In addition to initiating calls from the Call History, Voice Mail, and QuickDialer screens, end users can access their voice mail, configure call handling mode settings, set the active call handling mode, configure Extension Assignment settings, and activate Extension Assignment from the ShoreTel Communicator for Mobile user interface.

Communicator for Mobile supports up to 200 conventional users per ShoreTel system.

## Supported Configurations

### ShoreTel Communicator for Mobile Support – Languages

Communicator for Mobile software supports all elements of English (U.S.), English (U.K.), German, Spanish, Swedish, French, Dutch, Danish, Italian, and Norwegian.

### Usability Enhancements

Communicator for Mobile now supports smart type. Smart type means that certain keys do not need a special key to enable character entry. On a BlackBerry, for example, a user can type a "." or ".-" without using the Alt key on numeric fields. This addition expedites the entry of IP addresses or extension numbers.

The left and right direction keys move the cursor so the user can insert one or more characters instead of being required to delete an entire field to correct an error. This feature is available on most supported devices.

### Localization Features

Localization support affects the following area of the product:

- Western languages: the supported languages are English (U.S.), English (U.K.), German, Spanish, Swedish, French, Dutch, Danish, Italian, and Norwegian.

- Keyboard types: on devices that have full keyboards, users can choose from programmed keyboard layouts for their location. For example, the top row of letters on American keyboards includes q w e r t y; German keyboards have q w e r t z; and French keyboards have a z e r t y.

- Character set: Communicator for Mobile utilizes the Latin-1 character set (see http://htmlhelp.com/reference/charset/). This character set includes all accented characters and other global symbols.
Ordering of time and date: based on the language that a user specifies, Communicator for Mobile orders the date and time data according to the custom for that language. For example, with U.S. English, the order is mm/dd/yy; for U.K. English, dd/mm/yy; and for Dutch, dd-mm-yy. A table with the format of dates and times appears in the Localized Date and Time Table on page 438.

Accented characters: Communicator for Mobile supports accented characters (diacritical marks). The keyboard for the selected language supports these marks, and the QuickDialer key filter also supports diacritical marks.

The thumb wheel on the side of the device or other rotating character facility lets the user enter accented characters on the phone. The specific method for rotating through a character set depends on the model, yet the implantation is specific to Communicator for Mobile. (The ShoreTel model mirrors how a user enters characters on the device.)

Localized time on the phone: The server uses a standard GMT format that the client converts to the time according to the time zone that is detected by the device. Therefore, the phone shows the time for the time zone where the phone operates.

**Supported Devices for ShoreTel Communicator for Mobile**

**Devices that Support ShoreTel Communicator for Mobile:**

- Samsung BlackJackII
- BlackBerry 81xx Series
- BlackBerry 83xx Series
- BlackBerry 83xx Series
- BlackBerry 88xx Series
- BlackBerry 90xx Series
- BlackBerry 8900
- BlackBerry 9500, 9520, 9530 series (Storm)
- BlackBerry 9550 series (Storm2)
- BlackBerry 96xx series (Tour)
- BlackBerry 9700 series (Bold)
- Nokia E51
- Nokia E61i
- Nokia E63
- Nokia E71
- Nokia E72
• Nokia E75
• Nokia Surge 6790
• Nokia E90
• HTC Mogul (Sprint PPC-6800)
• HTC P6500 (Sirius)
• HTC TyTn II
• Motorola RAZR V3
• Motorola RAZR V3xx

**ShoreTel Communicator for iPhone**

• iPhone 3G (iOS3.1, iOS4)
• iPhone 3GS (iOS3.1, iOS4)
• iPhone 4 (iOS3.1, iOS4)

The following section describes a few functional differences based on the manufacturer or by model. Most models support all functions in Communicator for Mobile. This section lists the exceptions, so every model supports every function of Communicator for Mobile unless noted under a heading in this section.

**Carrier Support**

ShoreTel Communicator for Mobile is supported across carriers that allow installation of third-party applications onto the BlackBerry device.

The BlackBerry series 8100, 8300, and 8800 models are supported on any network that allows the installation of third party software. Although some mobile carriers restrict the downloading and installation of third-party software through their network, no known restrictions for the BlackBerry devices currently exist in any network.

Carrier support and restrictions on Nokia E65 series devices can be addressed by the end user’s carrier.

ShoreTel Communicator for Mobile supports LBS on the Nokia E71.

Devices supporting LBS must either have internal GPS hardware or the capability of connecting to an external device that provides GPS functionality, such as dongles. The carrier must allow GPS on the device and allow third party applications, such as MCM, to use GPS functionality. External GPS devices may be used to enable LBS features on these devices, depending on carrier limitations.

**PIM Integration**

The Nokia E71 supports PIM entry import. The ShoreTel Communicator for Mobile settings page provides an option to disable PIM loading. The TY TN II does not support PIM.
Screen Transition

Screen transition refers to leaving one screen and going to another screen. Manufacturers offer menu-operations, buttons, or softkeys for moving to another screen. This section lists restrictions that manufacturers have for screen transitions by the clicking of a menu item, physical button, or soft key.

- **Menu**: The Nokia E65 does not have menu-activated screen transitions.
- **E65 screen transitions are done by softkeys.**
- **Button**: None of the current models have button-only screen change activation.
- **Soft key**: Soft key is not supported by any of the BlackBerrys.

Personal Information Manager

Personal Information Manager (PIM) lets a device synchronize information from the Quickdialer feature in Personal Communicator so that this information is automatically loaded and updated in Communicator for Mobile. PIM is supported by all supported devices.

Preview Voicemail

Voicemail cannot be previewed on the BB7290 because this model has no external speaker.

Font Size

Font size in the display cannot be changed on any of the BlackBerry models.

Requirements

**MCMS**

The Communicator for Mobile Server (MCMS) is the ShoreTel server component that manages ShoreTel Communicator for Mobile client communications. The MCMS is installed on the ShoreTel HQ and DVS servers as part of the normal ShoreTel Server installation process. The MCMS contains no configuration parameters and requires no administrator intervention or monitoring during normal ShoreTel operations.

**MCM Client Installation Files**

Communicator for Mobile Client Installation Files are a set of files that provide the ShoreTel Communicator for Mobile client application to mobile devices. Clients download these files to their mobile devices from a server specified by the system administrator. Communicator for Mobile Client Installation Files are maintained and updated by the system administrator.

These files are originally placed on the ShoreTel Server as part of the ShoreTel installation, then moved by the system administrator to a server that can be accessed by the mobile devices of system end users.
Servers

Mobile devices must connect with the ShoreTel server to access MCMS services. Enterprise security requirements affect the structure of the network that provides application support. The following section describes servers that are typically used to implement ShoreTel Communicator for Mobile.

Blackberry Enterprise Server (BES)

The Blackberry Enterprise Server is a middleware application, offered by Research in Motion, that supports ShoreTel Communicator for Mobile by synchronizing email and PIM information through a secure back channel between the MCMS and BlackBerry mobile devices. The BES also supports Client Installation File downloads from ShoreTel to BlackBerry devices.

Reverse Proxy Server

A reverse proxy server is a proxy server that is normally installed in front of web servers. Internet communications addressed to a web server are routed through the reverse proxy server, which can process the request or pass the request to the specified web server. Implementing a reverse proxy server within the corporate DMZ maintains the integrity of the corporate firewall and insulates the ShoreTel Server, along with other corporate assets, from public networks.

A reverse proxy server provides secure wireless communication between Mobile Devices running ShoreTel Communicator for Mobile and ShoreTel server. A reverse proxy server can serve the same role as a BES for conducting ShoreTel Communicator for Mobile wireless communication sessions.

To fully set up a reverse proxy you would need an Apache server version 2.2 or higher, and a SSL certificate from a root certificate authority. The system supports a self-signed certificate, however, the users will receive a warning each time the application is launched. This is not recommended for production deployments.

See the ShoreTel 14.1 Planning and Installation Guide for details on configuring reverse proxy services.

Direct communication between an MCMS with the mobile devices is not recommended. This configuration compromises the integrity of the corporate firewall and exposes the ShoreTel Server and other connected corporate assets to attacks from public networks.

Administrator Configuration

ShoreTel Communicator for Mobile administration comprises two application activities: client application installation file delivery to the mobile devices and ShoreTel Communicator for Mobile communication sessions with the mobile devices. Configuring ShoreTel to support ShoreTel Communicator for Mobile requires the completion of the following tasks:

- Installing at least one additional server
- Acquiring the required ShoreTel Communicator for Mobile license
- Authorizing clients to use ShoreTel Communicator for Mobile
MCMS installation is performed with the installation of a ShoreTel server. The MCMS requires no additional installation or configuration. The following sections describe the tasks required to install and support ShoreTel Communicator for Mobile.

Server Installation (Headquarters and DVS)

Server Configuration Options

- ShoreTel Communicator for Mobile communication sessions with a BlackBerry device are supported by a BES or a Reverse Proxy Server.
- Client Installation File downloads to a BlackBerry are supported through a BES. Systems can use a BES server for all ShoreTel Communicator for Mobile activities.

BlackBerry Enterprise Server (BES)

The BlackBerry Enterprise Server supports ShoreTel Communicator for Mobile communications between the ShoreTel server and BlackBerry devices. BlackBerry devices can also access MCM Client Installation Files located on the ShoreTel server through the BES. The BES implements a secure connection, similar to that of a VPN, to provide access for mobile devices to resources that are protected by the corporate firewall.

For information on installing a BES, refer to BES installation instructions provided by Research in Motion.

Client Installation Files

Installing the ShoreTel Server places the Communicator for Mobile Client Installation Files directly on the ShoreTel Server. BlackBerry devices can access the files directly from the ShoreTel Server if the network includes a BES.

Version numbering for Communicator for Mobile is in sync with the ShoreTel version number. The download format is xx.yy.zz. This format is required by the Nokia E65. In contrast, the BlackBerry does not have such a requirement. Nevertheless, an image with a number like 13.20.8700.0 is listed on the server as 13.20.87.00 for download activities, yet it appears in the device’s About window as 13.20.8700.0.

Client Installation files can be delivered from a system that runs Windows 2003 or 2008 Server and has IIS. The IIS server must be configured to serve WML (Wireless Markup Language) files to the mobile devices. Table 49 lists the MIME types required to serve the installation files.

<table>
<thead>
<tr>
<th>File Extension</th>
<th>MIME Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>.jad</td>
<td>text/vnd.sun.j2me.app-descriptor</td>
</tr>
<tr>
<td>.jar</td>
<td>application/java-archive</td>
</tr>
<tr>
<td>.wml</td>
<td>text/vnd.wap.wml</td>
</tr>
<tr>
<td>.cod</td>
<td>application/vnd.rim.cod</td>
</tr>
</tbody>
</table>
Registering the required MIME types:


2. Select Administrative Tools.

3. Select Internet Information Service.

4. Open the HTTP Headers page, shown in Figure 137, by clicking the HTTP Headers tab at the top of the Internet Information Services page.

5. Open the MIME Types page by clicking the MIME Types... button in the bottom right corner of the HTTP Headers page.

6. Open the MIME Types Dialog box by clicking the New button on the top right corner of the MIME Types page, as shown in Figure 138.
7. Enter the Associated extension and content type data in the corresponding data entry field of the MIME Types Dialog box, shown in Figure 139, for one of the following types:

- Content type: text/vnd.sun.j2me.app-descriptor; extension: .jad
- Content type: application/java-archive; extension: .jar
- Content type: text/vnd.wap.wml; extension: .wml
- Content type: application/vnd.rim.cod; extension: .cod

8. Click the OK button to close the MIME Types dialog box and return to the MIMES type page. The table lists the type entered in Step 7.

9. Repeat Step 6 through Step 8 for each type listed in Step 7.

10. Click OK buttons on each successive page to save your changes and return to the desktop.
ShoreTel Director Configuration

Licenses

One ShoreTel Communicator for Mobile Keyed License is required for each client that is enabled for ShoreTel Communicator for Mobile. To view the number of ShoreTel Communicator for Mobile licenses available on the system, follow these steps:

1. Launch ShoreTel Director.
2. Click Administration > System Parameters > Licenses > Requirements. The License Requirements List page appears as shown in Figure 140.

![Figure 140: License Requirements Page](image)

3. In the Keyed License section, locate the Mobile Access License listing and check the Configured and Purchased columns for information about your mobile license status.

Client Authorization

ShoreTel administrators grant ShoreTel Communicator for Mobile access to clients through ShoreTel Director. To enable ShoreTel Communicator for Mobile access for a ShoreTel user:

1. Launch ShoreTel Director.
2. Click Administration > Users > Individual Users.
3. Click the name of the user in the User List. The Edit User page appears as shown in Figure 141.
4. Check the **Allow Mobile Access** check box.

5. Locate the Voice Mail Password fields and uncheck the **Must Change on Next Login** check.

6. Click **Save**.

**Client Configuration Information Delivery**

The administrator must provide the following information to each client authorized to use ShoreTel Communicator for Mobile:

- URL of the server through which mobile devices download the Client Installation Files.
- IP address and Port Number through which the mobile device accesses the MCMS.
- The client's user extension.
- The client's voicemail password.
Configuring Information upon First-Time Use

This section describes the first-time configuration requirements of the device.

Languages

The first screen that a user sees upon first-time startup of Communicator for Mobile is the language selection screen (Figure 142). The supported languages are English (U.S.), English (U.K.), German, Spanish, Swedish, French, Dutch, Danish, Italian, and Norwegian.

1. To select a language, use the track ball, wheel (at the right side of the device), or other device-specific selector to highlight a language.

2. Press the wheel or press Select to use the highlighted language.

On devices that have a full keyboard, the keyboard selection screen appears after language selection. For devices that do not have a full keyboard, users are taken to the provisioning window.

Keyboard Type

After selecting a language, users see the keyboard selection menu on devices that have a full keyboard as shown in Figure 143:
1. To select a keyboard, use the track ball or wheel at the right side of the device (or other, device-specific selector) to highlight the sequence of letters on the top row of the keyboard.

2. Press the wheel or press Select to use the highlighted keyboard. After the user selects a keyboard, the informational screen appears in the selected language.

3. Press Next to open the next screen, where specific user-details are entered. See next section, Provisioning User Details on page 436.

Provisioning User Details

The following user information is required for the first-time provisioning of a new phone:

- The IP address of the server that hosts the user account (not the DNS) is obtained from a system administrator. This server can be the BES or some other mechanism for reaching the server from the outside, such as a reverse proxy server.

- The Port number on the server that hosts the user account (obtained a system administrator).

- The user’s extension.

- The password is the personal ID number (PIN): the user must enter this ID before hearing voicemail. Upon power up after the first-time specification of the password, the User Information screen does not show the password field.

After these four values are entered upon the initial run, Communicator for Mobile retains the configuration so the user does not need to re-enter it. An example of the regular User Information screen that is displayed after the initial configuration appears in Figure 144.
The user can change the startup screen through the Settings window (“Default Start Page” in Figure 145).

After user information is initially entered, a status message momentarily appears, followed by a welcome message. After the welcome message, the Main Menu appears as the default startup window. The user can choose a different startup window by using the Settings window.

**Specifying Accented Characters**

The rotating character facility lets the user enter accented characters on the phone. This scheme follows the model used on the manufacturer’s device. However, the implantation is specific to Communicator for Mobile, and this model mirrors the way a user enters characters on the device.

If a user enters the string “Andre” but actually wants “André Dupont,” a wide variety of possibilities can come up (if they exist in the user’s directory), for example:

Andre, André, André, André, Andrê, AndrÉ, AndrÊ, AndrË . . . .

All accent marks are available regardless of the selected language.

Now, the user can enter “André” to get André Dupont. Quickdialer can use the specific device’s scrolling mechanism to select an accented character. Different devices have different mechanisms for scrolling through character choices. For the BlackBerry models, the user holds down a key and uses the trackball or thumb-wheel to scroll.
Localized Date and Time Table

This section consists of a table (Table 50) that lists the date and time that appears on a device based on the selected language.

Table 50: Date and Time Formats by Language (Country)

<table>
<thead>
<tr>
<th>Language</th>
<th>Date Format</th>
<th>Time Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deutsch</td>
<td>dd.mm.yy</td>
<td>08:48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23:59</td>
</tr>
<tr>
<td>Español</td>
<td>dd/mm/yy</td>
<td>08:48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23:59</td>
</tr>
<tr>
<td>Svenska</td>
<td>yy-mm-dd</td>
<td>08:48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23.59</td>
</tr>
<tr>
<td>Français</td>
<td>dd/mm/yy</td>
<td>08h48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3h59</td>
</tr>
<tr>
<td>Nederlands</td>
<td>dd-mm-yy</td>
<td>08:48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23:59</td>
</tr>
<tr>
<td>Dansk</td>
<td>dd-mm-yy</td>
<td>08:48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23:59</td>
</tr>
<tr>
<td>Italiano</td>
<td>dd/mm/yy</td>
<td>08:48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3:59</td>
</tr>
<tr>
<td>Norsk</td>
<td>dd.mm.yy</td>
<td>08h48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23h59</td>
</tr>
<tr>
<td>English U.K.</td>
<td>dd/mm/yy</td>
<td>08h48</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23h59</td>
</tr>
<tr>
<td>English U.S.</td>
<td>mm/dd/yy</td>
<td>8:48 AM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11:59 PM</td>
</tr>
</tbody>
</table>

Upgrading Communicator for Mobile

For an administrator, upgrading Communicator for Mobile requires only the installation of ShoreTel Version 12 to the server that runs Communicator for Mobile. This installation automatically places new versions of Communicator for Mobile’s server components and client installer on the server.

Before upgrading a client device, the subscriber must delete the existing application from the device. To perform the upgrade, the subscriber accesses the URL that was used to download client software. Access to the Communicator for Mobile is available through the following URL format:

- http://server/mcm/client/
where server is either a valid DNS name or IP address of the Communicator for Mobile server. Upon entry of the correct URL, the device’s browser is automatically directed to the latest file.

The server needs to be reachable from the mobile phone. This server could be a BlackBerry Enterprise Server (BES) or some other mechanism for reaching the server from the outside, such as a reverse proxy.

The following sequence illustrates an installation from a BES server:

1. The system administrator sends an email with a link to the location of the Communicator for Mobile software to the subscriber.

2. On the mobile device, the subscriber clicks on the email’s enclosed link to get access to the download site.

3. The subscriber removes the current MCM version from the device.

4. The subscriber clicks the link leading to the download site on the browser window.

5. After the Communicator for Mobile software has been downloaded, the subscriber configures the client with the IP address and port allocated on the ShoreTel server for Communicator for Mobile.

As long as the device can reach the ShoreTel server, no other configuration or setup is required between the BES and the ShoreTel Server. (A company could restrict on access to its BES.)

Alternatively, the user can open a browser on the device and enter the URL of the server (in the format http://server/mcm/client). The server window opens with choices for locating the newest client software, as Figure 146 shows.

![ShoreTel Communicator for Mobile](image)

Figure 146: Accessing the Newest Client Software

The user selects the application for the device. In Figure 147, the software is for a BlackBerry 8800 series.
Downloading the client software, the user highlights and presses the Download button (Figure 148).

Upon successful software download a message (Figure 149) shows that the device is ready for the user to make choices for Communicator for Mobile’s operation.
Troubleshooting Tips for Communicator for Windows

This section has two types of troubleshooting for ShoreTel Communicator. The first subsection relates to logging and tracing of calls. The next subsection relates to a break between ShoreTel Communicator and a call application server (CAS).

Logging and Tracing Window

The Logging and Tracing window displays information about session ID and CAS details. ShoreTel Communicator for Web stores the last 100 logging and tracing messages. You can open and close the Logging and Tracing window by placing the cursor inside of the Quick Dialer editor and pressing CTRL+F12.

Investigating a Possible Break between ShoreTel Communicator and a CAS

This section contains information related to a break in the connection between a call application server (CAS) and Communicator for Windows. It is applicable only if CMWin is using a Microsoft Windows CAS. This information might help you confirm a broken communication based on what the end-user reports. Except for information about CAS, this information is something that a system administrator can discuss with Communicator users to address their Communicator symptoms.

If the ShoreTel Communicator application becomes disconnected from the CAS server, users see the disconnect in one of two ways:

- With a minimized application (the icon is in the system tray), the icon is gray because Communicator has disconnected from the CAS, as Figure 150 illustrates.
- If ShoreTel Communicator is maximized, it shows menu items (Call Handling Mode, Extension Assignment, and so on) as disabled. Also, it does not show the sub pages of the Option page.

![Figure 150: Communicator Icon During Communication Break with the CAS](image)

The following details are also the behavior during a CAS to Communicator break:

- For voice mail and history local cached, data access is available to the user with limited functionality (such as sorting or searching into records).
- If the CAS connection is alive but the configuration data channel is not healthy, an error is displayed, and the user should just try again to use Communicator features.
For example, if the Option page is open and the user tries to modify External Assignment list while the data API is down, an error is displayed. The system does not automatically retry to create the connection, so the user needs to attempt the same operation again.

Another example is provided by the assignment menu. If the external number list is not available, an error is displayed, so the user needs to open that menu again for a retry after the data channel comes alive.

## Troubleshooting Tool for Communicator for Mac

This section describes a tracing window that a user of ShoreTel Communicator on a Mac can use to acquire troubleshooting information. The administrator can view the trace results directly or request the user to run the trace and describe the results. ShoreTel TAC might also need the information in the trace window.

The tracing window displays information about a specific session on a particular Call Application Server (CAS). The tracing window shows the session ID and the IP address of the CAS (see bottom Figure 151). ShoreTel Communicator stores the last 100 log and trace messages and tracks all requests to CAS and its responses.

To open and subsequently close the tracing window, the user puts the cursor inside the Quick Dialer editor and presses `CRTL+F9` keys. The user can expand the window by using the window’s handles.

![Figure 151: ShoreTel Communicator for Mac Tracing Window](image)
CHAPTER 12

Configuring User Features

This chapter is about setting up users in the ShoreTel system. The topics discussed include:

- Private Numbers ................................................................. 444
- Configuring Call History Privacy ........................................ 445
- Using Extension Assignment ............................................. 446
  - Special Considerations .................................................. 447
  - Configuring Permission Settings ................................. 448
  - Configuring Extension Assignment .......................... 449
  - Configuring On-Network Extension Assignment ........ 450
- Inbound Call Management .................................................. 451
  - Find Me ........................................................................ 451
  - Automated Call Handling ............................................ 455
  - Personalized Call Handling ......................................... 460
- Call Intervention Methods .................................................. 465
  - Whisper Page ................................................................ 465
  - Monitoring Extensions from an IP Phone .................... 467
  - Call Handling Mode Delegation .................................. 471
  - Intercom, Whisper Paging, Barge In, Record, and Monitor .................................................. 473
Private Numbers

Users can have private numbers that are not listed in the System Directory or in Communicator Quick Dialer and thus have Caller ID information suppressed. This is enabled through the check box on the Edit User page called Make Number Private. When checked, the user's extension becomes a Private Number.

The following conditions apply to private numbers:

- The user’s Private Number extension no longer appears in the QuickDialer for dial-by-name operations or in the ShoreTel Directory Viewer.

- Calls placed by a Private Number user show the caller's name but not their number to the dialed party for internal calls. This applies to analog phones, IP phones, and associated instances of the Communicator. The ring style is a double-ring, indicating an internal call.

- Calls placed from a private number to an external party do not deliver a Direct-Inward-Dial (DID) number as Caller ID when PRI trunks are used for the outbound call. The proper CESID (Caller’s Emergency Service ID) will only be delivered for 911 calls.

- Calls placed from a private number to an off-system extension on PRI trunks with NI-2 signaling deliver calling name information but not calling number information.

- Routing slips and the Communicator and History viewer show the Private Number user's name but not their extension number.

- The Private Number users are listed with name and number in the Extension Monitor extension selection dialog box.

- The user can be dialed directly via the telephone or the Communicator if their extension is known.

- Contacts imported from Microsoft Outlook or Exchange that reference a Private Number user's extension are not blocked and are fully visible in the Communicator Quick Dialer.

- CDR database records show both number and name for Private Number users. The Caller-ID Flags field will indicate that only the name is valid, however.

- CDR legacy log files show the number of Private Number user calls that are inbound or outbound calls.

- The ShoreTel Director shows number information for Private Number users as with other users, for example on the User List page.
### Configuring Call History Privacy

The ShoreTel system tracks all call activity and places call detail records in a database on the ShoreTel server. The system uses these records to generate CDR reports. However, there are some situations that require calls not be tracked and that no records of calls be kept. For example, a high level executive may require that all calls from their phones are private and not tracked in the ShoreTel phone system.

**Note**

The Call History Privacy feature only impacts call tracking within the ShoreTel phone system. Calls to external numbers may generate call records on the recipient’s phone system and trunk calls may generate records with the carriers connecting the calls.

Call History Privacy provides users with an entirely private environment for their phones. When Call History Privacy is enabled, calls are not tracked or recorded in the call detail records. In addition, the calls are not available on the phone redial or shown in the ShoreTel Communicator call history.

**Note**

Call History Privacy is not supported on SIP or Analog phones.

To use Call History Privacy, the user must be a member of a user group that has the Class of Service (COS) configured with the telephony feature Show call history disabled.

**To configure COS permissions for Call History Privacy:**

1. Launch ShoreTel Director.
2. Click **Administration > Users > Class of Service**.
3. Click one of the existing COS profiles or the **Add New** link to create a new class of service for Telephony Features.

   The Edit Telephony Features Permissions page for the class of service you select displays.
4. Clear the **Show Call History** check box.
5. Click **Save** to save your changes.
Extension Assignment is a feature of the ShoreTel system that allows a user to quickly and easily re-assign his or her extension to any telephone on the system or off the system. The user’s communications profile is reassigned to that telephone, and calls placed to the user will be routed to that telephone, while calls placed from that telephone will reflect proper caller ID information.

The Extension Assignment feature might be used by the following types of users:

- Multi-site users, such as executives or managers, who might use the system across multiple locations. Extension Assignment allows these users to pick up a telephone at any location on the enterprise network, log into voice mail, and assign their extension to that telephone. Refer to Configuring On-Network Extension Assignment on page 450.

- Office hotel users, such as contractors or telecommuters, who may occasionally be out of the office or who might share a cubicle, and thus a phone, with another employee. Extension Assignment allows these users to have their own extension and mailbox, yet not have a dedicated switch port. They can simply assign their extension to a telephone on the network when they are in the office while allowing another user to usurp that phone when they are done with it. Refer to Configuring On-Network Extension Assignment on page 450.

- Remote or mobile users, such as employees in sales or support, who might travel frequently and would like to have all calls directed to their cell phone or home office PSTN phone. Extension Assignment allows these users to have their own extension and mailbox, yet not have a dedicated switch port, thus optimizing system resources. Refer to Configuring On-Network Extension Assignment on page 450.

- Legacy PBX Users, such as users with Off-System Extensions working with Communicator. Refer to Configuring On-Network Extension Assignment on page 450.

Extension Assignment also allows the system administrator to configure all telephones as anonymous telephones and all users as virtual users, eliminating administrative costs associated with frequent moves. When a move occurs, users simply assign their extension to the telephone at the new location.

The feature also allows an off network user to manage a call via Communicator, so while the conversation occurs over the cell phone or home phone, the call appears via Communicator and can be controlled using many of the features available via Communicator. Note that this requires the user to be located near a PC that is running Communicator and has access to a broadband connection.

Other benefits to the (Off-Net) Extension Assignment user include:

- Use the existing PSTN line for voice while managing the call via Communicator over an ordinary broadband Internet connection.

- Emulate analog extension hook switch actions via star-star (**) for FLASH and pound-pound (##) for on-hook/off-hook.

- Access the user’s directory numbers at the office.

- The user appears to be calling from the office.

- Keep communication costs minimized with flexible IP and trunking requirements.
- Retain call management features of the ShoreTel system over a broadband connection while maintaining audio quality over PSTN.

**Special Considerations**

The following list shows considerations for Extension Assignment:

- When an Extension Assignment call finishes but the carrier has not reported back to the ShoreTel system that the far side has disconnected, the call remains active for approximately five seconds before it is finally disconnected. To initiate a new call during the five-second window, the user can press ##.

- To use the Extension Assignment feature, the user must be in a user group that has a Telephony Class of Service with Allow Extension Reassignment. Refer to Configuring Permission Settings on page 448.

- ShoreTel supports up to 1,000 virtual users.

- Incoming calls to a user's extension that has been assigned to an off-net location rings on the cell phone or Off-System Extension. If the call is not answered, normal call handling allows the caller to leave a message in the user's ShoreTel mailbox.

- Extension Assignment, when assigned to an off-net location, is fully controllable through ShoreTel Communicator excluding answering a call, which must be done manually. Also, Extension Assignment has limited TUI functionality.

- Extension Assignment calls that are terminated through ShoreTel Communicator are not followed by the standard dial tone. Extension Assignment uses a unique set of internal and external dial tones. This difference in tones can be important in installations where network devices have been configured to listen for normal class progress tones before taking action on a call, such as hanging up.

- Calls placed or answered through Extension Assignment, when assigned to an off-net location, continue to exist in the ShoreTel Communicator call stack. Normal call control functions, such as hold, unhold, conference, transfer, and park, continue to work. In contrast, Park to the Extension Assignment extension is not supported when it is assigned to an off-network location.

- Extension Assignment, when assigned to an off-net location, behaves like an automated Find Me feature except that the caller does not press 1 to find the called party. The PSTN phone number is immediately called. The call recipient can answer the call by lifting the handset, or activating a cell phone, and pressing the DTMF digit 1 in response to the repeating prompt.

- Prompts, such as those used for Find Me, can be used to confirm answering. The answer style can be configured to be one of the following:
  - Wait for DTMF (default) - The call is not forwarded until the user presses 1.
  - Wait for Answer - The ShoreTel system forwards the call as soon it detects the far-end answer.
Terminology

The terms used to describe Extension Assignment are as follows:

- Anonymous telephone: A telephone not currently assigned a user. You can make a call from an anonymous telephone, but you cannot call an anonymous telephone.
- Any IP Phone: The feature that lets users assign their extension to any IP phone on the enterprise network.
- Assign: The command that assigns an extension to a telephone.
- Assigned: The status of a user who is currently assigned to a telephone that is not their home phone.
- Current telephone: The telephone to which the user is currently assigned, which is also known as the current switch port.
- Go Home: The command to assign a user's extension back to his or her home telephone.
- Home: The status of a user who is assigned to his or her home telephone.
- Home telephone: The telephone to which the user is normally assigned, which is also known as the home switch port. This is the telephone to which the user returns when using the Go Home command.
- Extension Assignment: The feature that lets users assign their extension to any telephone, on-system or off-system extension.
- Unassign: The command that unassigns an extension from a telephone.
- Vacated telephone: A home telephone that currently does not have a user assigned. These are listed on the Anonymous Telephones edit page under Vacated Telephones.
- Virtual user: A user who does not have a physical telephone port and is currently assigned to the SoftSwitch.

Configuring Permission Settings

Configuring the Extension Assignment feature, the system administrator must first give the end user permission to use the feature by following the procedure below:

1. Launch ShoreTel Director.
2. Click **Administration > Users > User Groups**.
3. Do one of the following:
   - To create a new user group, click **Add new**.
   - To use an existing user group, click the name of that user group.

4. In the **COS - Telephony** field, click the **Go to this Class of Service** link.
   
   The Class of Service -Edit Telephony Features Permissions page is displayed.

5. Select the **Allow Extension Reassignment** check box.

6. Select the **Allow External Call Forwarding and Find Me Destinations** check box and the appropriate Scope radio button.

7. Click **Save** to store your changes.

**Details**

If you intend for a user to have access to the Extension Assignment feature, verify that he or she belongs to a User Group that is associated with the Class of Service you just modified above.

**Configuring Extension Assignment**

Extension Assignment is intended for mobile users who often work outside the office. These users might travel frequently or work from home, so they could benefit from having all calls directed to an off-network device, such as a cell phone or home office PSTN phone. Extension Assignment lets a user have a ShoreTel extension and mailbox without requiring a dedicated switch port and physical telephone in the office.

**Note**

For an off-network ShoreTel user’s phone to display the ID of a caller who is outside a ShoreTel site, the system administrator must activate the Enable Original Caller Information function on applicable trunk groups. Refer to **Forwarding Original Caller ID Outside a ShoreTel Network** on page 187 for additional information.

**Assigning an Extension to an Off-Network Device**

The following procedure includes the steps for configuring the user’s off-network phones before assigning an extension to one of these phones.

1. Launch Communicator on the client machine.

2. Click the ShoreTel button in the upper left corner of Communicator, and select **Extension Assignment > Configure Phones**.

   The My Phones page of the Options and Preferences window is displayed, as shown in **Figure 152** on page 450.

3. In the appropriate fields, type the user’s mobile phone number, the user’s home phone number, and/or the label and phone number for a different phone to which the user’s calls can be routed. (The number can be that of any PSTN number outside the ShoreTel system.)
4. Click \( \ldots \) to access advanced phone settings, and then do the following:

- Accept the default or specify the number of times the designated phone should ring before the call is sent to voicemail.
- If you want the user to be able to press 1 to answer calls, select the check box.

5. Click OK.

6. Click Apply to store changes.

7. Click the ShoreTel button in the upper left corner of Communicator, and select Extension Assignment > \textit{phone label}.

The user’s extension is assigned to the selected phone.

**Configuring On-Network Extension Assignment**

On-network extension assignment is intended for users who may travel frequently, accessing the ShoreTel system from multiple sites on the network. These users can benefit from not being tied down to a single physical telephone, and Extension Assignment allows them the freedom to pick up a ShoreTel telephone and assign their extension to that telephone via the voice mail menu.
To assign or unassign an extension to any on-network telephone using the voice mail Telephone User Interface or using Communicator. Refer to Using the Telephone User Interface on page 451 for information about assigning and unassigning extensions using the Telephone User Interface. Refer to Inbound Call Management on page 451 for information about assigning and unassigning extensions using Communicator.

Using the Telephone User Interface

Assigning an Extension to a Telephone

1. Log in to voice mail.
2. Press 7 to select Change Mailbox Options.
3. Press 3 to select Re-assign Extension.
4. Press 1 to select Assign.
5. Wait for a dial tone, and then hang up.

This option is available only from telephone ports and is not available from trunk ports.

Un-Assigning an Extension from a Telephone

1. Log in to voice mail.
2. Press 7 to select Change Mailbox Options.
3. Press 3 to select Re-assign Extension.
4. Press 2 to select Unassign.
5. Wait for a dial tone, and then hang up.

If no other user is assigned to the home telephone port, the extension automatically reverts back to the home telephone. If another user is assigned to the home telephone port, the extension will be assigned to the SoftSwitch until the home telephone port becomes available. A user can remove the other user from the home telephone port by assigning the extension from their home telephone using the procedure above.

Inbound Call Management

Find Me

Find Me is a call handling method that allows a user to route inbound calls to a specified extension or phone number as an alternative to sending callers to voice mail.
Find Me call handling provides inbound callers with a method of connecting to their intended call recipient while listening to the recipient’s voice mail greeting. Callers are routed to an extension or phone number callers by pressing 1 while listening to the recipient’s voice mail greeting.

System users configured for Find Me can specify two numbers for receiving call through Find Me. The standard voice mail greeting does not prompt the caller on the availability of Find Me call handling.

Find Me call handling is enabled through call handling mode settings. Find Me destinations are independent of the call handling modes that activate Find Me.

After the caller presses 1, the system informs the caller that Find Me destinations are being called. Calls not answered at either Find Me destination are sent to voice mail.

When a call is forwarded to a Find Me destination, the phone at the Find Me destination displays recipient’s voice mail caller ID to the call originator. When answering a call, the recipient hears a prompt announcing the call and, if available, the caller’s ID information. The recipient can then accept the call or route the caller to voice mail.

Announced Find Me provides for the recording of the caller’s name for calls routed to Find Me destinations. This feature provides the capacity for all inbound callers to be identified when their call is routed to a Find Me destination.

When Announced Find Me is enabled, callers from external numbers or from internal extensions without a recorded name are prompted to record their name before the call is routed to the recipient.

**Find Me and External Assignment Page**

When you click the External Assignment and Additional Phones or Find Me links on the Personal Options page, the Find Me, External Assignment and Additional Phones page is displayed, as shown in Figure 153.
Find Me allows users to configure two phone numbers as forwarding destinations so that if they miss an incoming call, the call will be sent to voice mail, and from there, it will be redirected to one of the pre-configured forwarding destinations. External Assignment is also known as Extension Assignment. Refer to Using Extension Assignment on page 446 for more information.

When a caller dials a user on the ShoreTel system, if the call is not answered, it is sent to voice mail. At this point, the caller is offered the option to press 1 to activate Find Me call handling, and the system subsequently attempts to route the call to one of the Find Me destinations that the user configured.

No system prompt informs callers that they need to press 1. The ShoreTel user must inform callers of this press 1 to activate Find Me option in the outgoing voice mail greeting.

After pressing 1, the caller hears a message that the Find Me destinations are being called. If the call is not accepted at either of the Find Me destinations, the call is sent to voice mail.

Alternatively, users also have the option to automate the Find Me behavior, thus bypassing the requirement for callers to press 1 to activate Find Me. When Auto Find Me is enabled, calls will be immediately sent to the Find Me destination number(s) without any action on the part of the caller.

Details

The following list includes further details about the Find Me and External Assignment page:
Users are authorized to use Find Me through a Telephony Class of Service that enables Find Me.

- Find Me destinations can be extensions or external numbers.
- Find Me call handling can be enabled/disabled for each of the five call handling modes. The same Find Me destinations apply to all call handling modes with Find Me enabled.

### Configuring Find Me Destinations

1. For the primary Find Me destination, select **Extension** or **External**. You can use the **Search** button to find system extensions. Enter external numbers in the **External** text box.

2. Enter a value in the **Number of Rings** field. This is the number of times the phone must ring without being answered before the call is forwarded to the primary Find Me destination.

3. For the backup Find Me destination, select **Extension** or **External**. You can use the **Search** button to find system extensions. Enter external numbers in the **External** text box.

4. Once again, enter a value in the **Number of Rings** field. This is the number of times the phone must ring without being answered at the primary Find Me destination before being forwarded to the backup Find Me destination.

5. Select the **Send Incoming Caller ID** check box if you want the caller ID forwarded to the Find Me destination.

6. Select the **Enable Auto Find Me** check box to automate the process of routing calls to the Find Me destinations. With this feature enabled, users will no longer have to press 1 to activate Find Me. You can deselect the check box if you wish to continue to require callers to press 1 to activate the Find Me feature.

7. Click **Save**.

### Configuring Announced Find Me

Announced Find Me is available for users assigned to a class of service for which Find Me is authorized. ShoreTel provides three methods of enabling Announced Find Me for a user: from Director, from Communicator for Windows, and from Communicator for Web.

Users can receive Announced Call Me introductions for all callers or restrict the introductions to calls for which Caller ID is not available.

Administrators enable Announced Find Me for system users from the Find Me and External Assignment page.

Complete the following steps to enable Announced Find Me for a user:

1. Launch ShoreTel Director.

---

**Tip**

If you enable Auto Find Me, make sure that your outgoing voice mail message is no longer telling callers to press 1 to activate the Find Me feature. The automation aspect of this enhancement means that callers will not have to do anything and calls will be forwarded automatically.
2. Click Administration > Users > Individual Users. The Individual Users list page appears.

3. Select the user whose profile you want to edit. The Edit User page appears.

4. Access the user’s Find Me and External Assignment page, as shown in Figure 153 on page 453, by selecting Personal Options in the selection bar at the top of the Edit User page, and then clicking Find Me at the bottom of the Personal Options page.

5. Select the Enable Record Caller’s Name for Find Me (When Caller ID is unavailable) checkbox.

6. To enable Announced Find Me when Caller ID is available, select the Record Name Even If Caller ID Is Present checkbox.

Automated Call Handling

A Call Handling Mode defines call management conditions and tasks for your inbound calls. ShoreTel defines the following call handling modes for each extension to customize the manner that a user’s calls are handled over a variety of situations:

- Standard
- In a Meeting
- Out of Office
- Extended Absence
- Custom

One call handling mode is always active. ShoreTel automatically selects the active call handling mode on the basis of system schedules maintained by the system administrator. Users can also manually select their active call handling mode.

The following sections describe call management tasks controlled by call handling modes, along with the automatic and manual methods of selecting the active call handling mode.

Setting the Active Call Handling Mode

The active Call Handling Mode specifies the manner in which a user’s inbound calls are handled. ShoreTel automatically activates call handling modes, as specified by system schedules maintained by the administrator. Users can also manually select the active call handling mode.

A ShoreTel schedule is a software component that specifies a set of time periods. Communicator uses schedules to program call handling mode changes for system users.

Each schedule consists of a name and a list of day-time intervals. Communicator pages refer to the schedule by its name and specify an active call handling mode during the intervals.

ShoreTel defines three schedule types:

- On-hour schedules: On-hour schedules specify day and time intervals over a weekly period without referencing a specific date. Figure 154 displays three examples of On-hour schedules.
Holiday schedules: Holiday schedules specify dates. Periods that identify a year are valid once; periods that do not specify a year are valid each year on the listed dates. Holiday schedules take precedence over On-hour schedules during periods covered by each schedule. Figure 155 displays examples of Holiday Schedules.

Custom schedules: Custom schedules specify date and time intervals. Periods that identify a year are valid once; periods that do not identify a year are valid each year on the listed dates. Custom schedules take precedence over On-hour and Holiday schedules during periods listed by multiple schedules. Figure 156 displays examples of Holiday Schedules.

Schedules are configured by the system administrator. To determine the periods specified by an individual schedule, consult your system administrator.
Default active call handling modes are managed through the Schedule parameter of the Call Handling Mode configuration pages, as described in Table 51.

**Table 51: Schedule Parameter Options**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Standard and Out of Office    | Determine the active call handling mode during normal daily activities.  
|                               |   - The available options in the Standard schedule parameter are the On-hour schedules configured by the system administrator. Standard is the default call handling mode during the times listed by the selected schedule.  
|                               |   - The Out of Office schedule is the inverse of the selected schedule in the Standard call handling mode configuration page. Out of Office is the default call handling mode during all periods not covered by the On-hour schedule in the Standard Call Handling Mode page. Schedules are not selected in the Out of Office Call Handling Mode page.  |
| Extended Absence              | Determines the active call handling mode during the selected holiday schedule. The Schedule drop down menu on the Extended Absence call handling mode lists the Holiday schedules configured by the administrator.  |
| Custom                        | Determines the active call handling mode during the selected custom schedule. The Schedule drop down menu on the Custom call handling mode lists the Custom schedules configured by the administrator.  |
| In a Meeting                  | This mode is not associated with a schedule and cannot become active through an automatic mode selection.                                      |

**Note**

For example, assume that Day Shift in Figure 154 is the selected schedule in the Standard Call Handling Mode page. Standard is the default call handling mode between 8 am to 5 pm on Monday through Friday. Out of Office is the default call handling mode all other times.

**Call Handling Mode Defaults**

Call Handling Mode Defaults are the set of call handling parameters assigned each time you add a new user. ShoreTel strongly recommends that you review and change these defaults before you add the bulk of your users.

Once a user is saved on the system, there is no relationship between the user’s call handling modes and the default call handling modes. Changes to the default call handling modes do not affect the call handling modes of current users.

If you need to change the Personal Assistant of some or all users, you can use the Batch Update Utility.
There are five default call handling modes used for initializing each user’s call handling modes. These modes provide a quick and easy way for users to change the way their inbound calls are handled.

The five default call handling modes are:

- Standard
- In a Meeting
- Out of Office
- Extended Absence
- Custom

Each of the call handling modes has the same configuration parameters.

Call handling modes specify how, when, and where calls are forwarded, and whether the user requires message notification when voice mail is received. The links in the Edit Call Handling Modes section under the Personal Options tab on the Edit User page bring up different call handling mode pages. You can edit these copies for each user’s personal options. Users can also modify these options from their desktop client applications.

Users can also change their call handling settings though a web interface on the ShoreTel server. For details and the web URL, refer to the Planning and Installation Guide.

The Call Handling Mode Default parameters are discussed in Table 52.
## Call Handling Mode Default Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Forward Condition</td>
<td>These buttons let you specify when calls are forwarded. The conditions are Always, No Answer/Busy, and Never.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The recommended default is No Answer/Busy.</td>
</tr>
<tr>
<td>Always Destination</td>
<td>When the Always call forward condition is selected, calls are forwarded immediately to this extension.</td>
</tr>
<tr>
<td>Busy Destination</td>
<td>When the No Answer/Busy call forward condition is selected, calls are forwarded to this extension immediately if the user’s call stack is full.</td>
</tr>
<tr>
<td></td>
<td>The recommended default is Voice Mail.</td>
</tr>
<tr>
<td>No Answer Destination</td>
<td>When the No Answer/Busy call forward condition is selected, calls are forwarded to this extension after the specified number of rings.</td>
</tr>
<tr>
<td></td>
<td>The recommended default is Voice Mail.</td>
</tr>
<tr>
<td>No Answer Number of Rings</td>
<td>When the No Answer/Busy call forward condition is selected, this parameter specifies how many times the phone rings before the call is forwarded to the No Answer Destination.</td>
</tr>
<tr>
<td></td>
<td>The recommended default is three rings.</td>
</tr>
<tr>
<td>Personal Assistant</td>
<td>Each user can specify a Personal Assistant, which is the destination to which a calling party is transferred upon dialing 0 in the user’s mailbox. For example, executives often want callers transferred to their own executive assistant rather than to the operator when a caller dials 0 in their mailbox.</td>
</tr>
<tr>
<td></td>
<td>If no personal assistant is defined and a caller dials 0, the call is transferred to the site operator. If no site operator is defined, the call is transferred to auto-attendant.</td>
</tr>
<tr>
<td></td>
<td>Users can also reach the Personal Assistant from the voice mail menu. By pressing 0 from the main voice mail menu, users can access the assistant. Alternatively, users can press 00 while listening to a voice mail message to reach the assistant. This can be helpful if a user is checking voice mails and wants to quickly reach the assistant to communicate something heard in a voice message.</td>
</tr>
<tr>
<td></td>
<td>The recommended default is an operator.</td>
</tr>
</tbody>
</table>
### Personalized Call Handling

Personalized Call Handling (PCH) defines a user-specific method for processing inbound calls. The method is based on the following criteria:

- The end-user
- The caller
- The system
- The environment

#### Table 52: Call Handling Mode Default Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Find Me</td>
<td>This check box enables the Find Me feature by default for new users. When enabled, users can configure up to two numbers where they would like to receive calls that are forwarded from their voice mail. For more information, refer to Find Me and External Assignment Page on page 452.</td>
</tr>
<tr>
<td>Enable Message Notification</td>
<td>This check box enables message notification for this call handling mode. The manner in which the user is notified is determined by the user’s message notification settings. The recommended default is off.</td>
</tr>
<tr>
<td>Enable Calling Additional Phones</td>
<td>Select this check box to allow additional devices to ring simultaneously when an extension is called. When a call is answered on one device, the other devices stop ringing.</td>
</tr>
<tr>
<td>Enable Voice Mail ‘Greeting Only’ Mode</td>
<td>Select this check box to enable the voice mail server to play a greeting and then disconnect the call, without taking a message. When Greeting Only mode is enabled, the voice mail server issues the following prompt: “No messages may be taken for this mailbox”.</td>
</tr>
<tr>
<td>Schedule</td>
<td>This drop-down menu lets you select the schedule that will be associated with this call handling mode. For example, you may want to associate the Standard CHM with a schedule that is active from the hours of 9am to 5pm. Alternatively, you might wish to schedule the Out of Office CHM with a graveyard schedule that becomes active from the hours of 10pm to 6am. For more information, see Chapter 15, Configuring Schedules on page 519.</td>
</tr>
<tr>
<td>Call Handling Note</td>
<td>This text entry option lets you type a note that is visible only to users whose access license is Operator. ShoreTel recommends leaving the field empty.</td>
</tr>
</tbody>
</table>
Personalized Call Handling is available to users with one of the following Access Licenses:

- Professional
- Operator
- Workgroup Agent
- Workgroup Supervisor

Administrator authorization is not required for users with one of these Access Licenses.

**Description**

A Call Routing Plan manages a user's inbound voice calls. The plan consists of call handling rules, each of which specifies a method of processing a call when a condition is true. The plan enables and prioritizes selected rules. The user's inbound calls are evaluated against the call handling rules. The highest priority rule with conditions that are satisfied defines the handling method for the call.

This section first describes the structure and the call handling rules and then describes how to create a call routing plan from these rules.

**Call Handling Rules**

Call handling rules define the evaluation conditions and the handling action. When the rule is active and the condition is satisfied, the specified action is implemented.

Three components make up a call handling rule: name, condition, and action. The bullets that follow describe the components of a call handling rule.

- **Name:** The name is the label by which Communicator and Director refer to a call handling rule. Users specify the name when they create the rule.

- **Condition:** The condition is the filtering criteria that determines if a corresponding call handling action is performed. When a condition statement consists of multiple criteria, each criterion must be satisfied before the action is performed.

  The Call Handling Rules feature defines the following types of criteria:

  - **Phone number match:** The phone number match is satisfied when the caller ID of the inbound call is a subset of the specified match type. Users can select one of the following match types:

    - **Specific number:** a number that must match a caller ID. A number can be an internal extension or phone number that is outside the system.
    - **Off system extension:** an off-system extension that must match a caller ID.
    - **Any internal extension starting with:** the digits that must match the first digits of a number that originates with internal callers.
    - **Any external extension starting with:** the digits that must match the first digits of numbers that originate from phone external to the system.
    - **Private:** all calls that are identified by caller ID as private.
- Out of area / unknown – all calls that caller ID identifies as out of the area or that are unknown.
- Every internal number – all calls originating from a device within the ShoreTel network.
- Every external number – all calls originating on a device that is not located within the ShoreTel network.

**Note**

Users can specify a maximum of 10 phone number match entries.

- I am on the phone: This criterion is satisfied when the user’s phone is busy.
- Call Handling Mode: This criterion is satisfied when the user’s active Call Handling Mode matches the specified mode.
- Time of day: This criterion is satisfied when the call is received during the specified time ranges.
- Day of week: This criterion is satisfied when the call is received on one of the specified days.
- DNIS Match: This criterion is satisfied when the DNIS of the inbound call matches the specified number.

**Note**

Time of day and Day of week entries are based on the time zone setting of the site to which the user is assigned.

**Action:** The action specifies the resolution for calls that match the specified condition. Call Handling Rules define the following five action types:

- Forward Call to Specific Number: This action routes the call to the specified number. Users can select one of the following number types:
  - Specific Number.
  - Off System Extension.
- Forward Call to Voice Mail: This action routes the call to user voice mail.
- Forward Call to Auto Find Me: This action routes the call to voice mail, which then forwards the call to the recipient’s Find Me number.
- Forward Call to Announced Find Me: This action routes the call to voice mail, which then forwards the call to the recipient’s Find Me number. The system attempts to announce the caller’s name to the recipient. The user can specify that the caller must record a name before the call is presented to the recipient.
- Play Ringtone: This action directs the ShoreTel IP Phone to play a designated ring tone that announces the presence of the inbound call to the recipient.
Call Routing Plan

The Call Routing Plan is the data structure that determines the routing method of a user’s inbound calls. This section describes the composition and operation of a call routing plan.

A call routing plan consists of a maximum of 10 call handling rules. The plan specifies the rules that are active and lists the rules in the order by which they are used to evaluate the characteristics of the inbound call.

Before a user actually receives the inbound call, the system evaluates the characteristics against the highest priority call handling rule that is enabled. If all of the criteria in the rule match the call characteristics, the call is routed according to the rule’s action, after which the plan execution is complete. If any of the criteria does not match the call characteristics, the system continues the plan execution by evaluating the call against the next-highest priority call that is enabled.

This process is repeated for all enabled call handling rules. If the call’s characteristics do not match the conditions of any of the enabled call handling rules, the call is routed according to the active Call Handling Mode.

Implementing Personalized Call Handling

Users configure their Personalized Call Handling routing plans through Communicator. For the instructions that the user needs to specify this functionality, refer to the ShoreTel Communicator for Windows User’s Manual.

The Director Personalized Call Handling Rules page, which is shown in Figure 158, lists the Call Handling Rules created by the selected user. The user specifies the rules in the Communicator > Tools > Options and Preferences > Personalize Call Handling window. This Personalized Call Handling Rules page lists the name, condition, action, and status of each rule. The rules appear in the order that the user created them, not according to the priority specified by the user in Communicator. Therefore, you cannot determine priority by looking at this Director window. Rule priority is configurable only in Communicator, and this Director window does not reflect any priority changes that the user specifies.

![Figure 158: Personalized Call Handling Rules Page (Director)](image-url)
Note
An important behavior that relates to one of the actions should be understood. The action is Forward Call to Voice Mail, and the circumstance when this behavior is relevant is when a ShoreTel customer changes its voice mail server to a SIP Unified Messaging (SIPUM) server. Before the migration to SIPUM, any rule that forwards calls to voice mail — or all rules if that is more convenient — should be disabled. If a rule whose action forwards calls to voice mail remains enabled during the migration, the rule fails to migrate.

Accessing the Personalized Call Handling Page

1. Open the Individual User list by selecting Administration > Users > Individual Users in ShoreTel Director.

2. Open the Personal Options page for a specific user by clicking the name of the user in the Individual User List.

3. Click the Personal Options tab near the top of the Edit User page.

4. Click Personalized Call Handling Rules, located in the middle of the Personal Options page, as shown in Figure 159.

![Figure 159: Edit User Page – Selecting Personalized Call Handling Rules](image-url)
Call Intervention Methods

Whisper Page

The Whisper Page feature allows a user to break into an active call in order to speak with an internal user. This occurs without the remote caller hearing the interruption and without the operator hearing the remote caller.

A real-world example illustrates the function: You are on a call with a client when another client arrives in the lobby for an appointment with you. The administrative assistant knows that you are on a call and uses the Whisper Page feature to interrupt the call to announce that someone is waiting for you in the lobby. You hear the voice of the administrative assistant and the client at the same time, but neither of them can hear the other.

Implementation details:

- The Whisper Page feature can be invoked from:
  - Communicator
  - Any phone (analog or IP) by pressing the code *19
  - One of the ShoreTel IP Phone soft keys

- While on a Whisper Page call, the internal user can mute the audio channel to the original caller. The user can respond to the operator without the original caller hearing. This can be accomplished from:
  - One of the ShoreTel IP Phone soft keys rather than the standard mute button
  - Communicator, if you do not have an IP phone

- Both the operator and the internal user hear a tone when the Whisper Page call is connected. The tone is the same as the tone for the Intercom feature.

- To receive a Whisper Page call, the internal user must be on the handset of a multiline ShoreTel IP Phone. If a Whisper Page call is sent to any other phone (SoftPhone) the call will be treated as an intercom call.

- If a Whisper Page call is sent to a phone that is not on an active call, the feature behaves the same as an intercom call.

- The Whisper Page feature does not work if the internal party is on a three-way conference call.

- No call control operations can be performed on a Whisper Page call except to hang up the call. For example, the Whisper Page call cannot be put on hold, transferred, parked, and so on.
Configuring Whisper Page

1. Launch ShoreTel Director and enter the user ID and password.

2. Click Administration > Users > Class of Service. The Class of Service page appears.

3. Select a Telephony Features Permissions profile. The Edit Telephony Features page appears, as shown in Figure 160.

   ![Class of Service Page](Image)

   **Figure 160: Edit Telephony Features Page**

   There is no separate check box specifically for the Whisper Page feature. The functionality has been coupled with the intercom functionality.

4. In the Whisper Paging field, check the **Allow Initiation** check box to allow this user to place a Whisper Page call. This user would most likely be an operator or administrator. The Accept check box enable lets a user be on the receiving end of a Whisper call.

5. Click **Save** to save changes.

   After the Whisper Page feature in a Class of Service profile is enabled, be sure that this Class of Service profile is applied to the appropriate user group to which the target user belongs. For example, the user that should use the Whisper Page feature must belong to a user group that has the COS - Telephony value set to the name of the COS profile.
Monitoring Extensions from an IP Phone

Extension monitoring is one of the available functions you can assign to the custom buttons on a ShoreTel IP Phone. However, due to its complexity, this feature is described separately from the other functions.

The extension monitoring function lets a user monitor the extension of another user and answer the other person's calls if necessary. For example, two secretaries are working on different floors of the same building and are responsible for answering calls from the main phone line. If one assistant already is on a call when another call arrives on the main line — with extension monitoring enabled, the other assistant can see that the first assistant is busy and, therefore, knows to answer the incoming call.

Configuring Extension Monitoring

1. Navigate to Administration > Users > Individual Users in ShoreTel Director.
2. Click on a name to modify that user’s phone.
   The user’s general settings appear.
3. Click the Personal Options tab.
4. Click the Program IP Phone Buttons link.
   The Program IP Phone Buttons page opens, as Figure 161 illustrates.
5. For the intended button, click on the Function drop-down menu for one of the programmable buttons and select Monitor Extension to display the custom key editor.

Note
The 1 key is reserved and is not programmable.

6. In the Long Label and Short Label fields, enter a label to appear next to the button on the phone LED display to remind the user of the button’s function. (For details about labels, see Configuring Programmable Buttons through ShoreTel Director on page 237.)

7. Enter the extension of the monitored party in the Extension field, or click the Search button to locate the appropriate extension.

8. Click on the Ring Delay Before Alert drop-down menu and select the number of rings that should elapse on the monitored party's phone before the monitoring party will receive an alert. This delay gives the monitored party a chance to answer and prevents the monitoring party's phone from ringing incessantly.

9. Select the appropriate radio button in the Caller ID on Monitored Extensions. For a multiline phone, the choices are as follows:
Do Not Show – The Caller ID information does not appear, but an indicator will show that the monitored phone is busy. This option offers the monitored party the most privacy and should be selected if you do not want the monitoring party to know who the monitored party is talking to.

Show Only When Ringing – The Caller ID information appears while the phone is ringing, but disappears once the call has been answered.

Show Always – The Caller ID information appears while the monitored phone is ringing, and continues to appear even after the call has been answered.

10. The custom buttons can be configured to perform different actions based on whether or not the person being monitored is on a call. To associate a secondary function with the custom button that will apply when the phone is inactive, click the drop-down menu and select another action from the No Connected Call Action menu. The action you select here will apply when the custom button is pressed AND while the monitoring party's phone is inactive.

11. To associate a third function with the custom button, click the drop-down menu and select another action from the With Connected Call Action menu. This action will apply when the custom button is pressed while the monitoring party does not have a call that can be picked up or unparked, and the user's own extension has a connected call.

The option to configure custom buttons provides flexibility to define different responses for different scenarios. The button can be configured to pick up incoming calls, or park/unpark calls when the person being monitored is on a call. If the person being monitored is not on a call, then the custom button becomes a speed-dial button, that allows the operator to dial that person's extension at the touch of a button.

12. Click Save to store your changes.

Details

The following list includes further details about extension monitoring:

ShoreTel IP480, IP480g, and IP485g phones support only one custom button per monitored extension. If you designate more than one custom button on a particular phone to monitor the same extension, the specifications are ignored and the additional monitor extension buttons are converted to regular call appearance buttons. ShoreTel Director does not reflect this change.

The custom button shines red on the monitoring-person's phone when the person whose extension is being monitored is on a call. If that call is put on hold and a second call is accepted on the monitored extension, the LED turns green and flashes twice. Similarly, the LED flashes three times if a third call is accepted. For information about LED flash patterns, see Table 53.

The custom button to which extension monitoring has been assigned can serve dual purposes based on whether the monitoring party is in a call or not. The button can be set to speed dial, intercom, or transfer calls to the monitored extension.
- When the Show Caller ID Name and Number on Monitored Extensions Class of Service (Telephony) setting is not enabled, Communicator Contact Viewer (and Agent Viewer) show the number of calls on a user's stack but do not show who the user is talking to. Properties is also disabled.

Table 53: Programmable Buttons LED Flash Patterns

<table>
<thead>
<tr>
<th>State</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALL APPEARANCE STATES</td>
<td></td>
</tr>
<tr>
<td>Idle</td>
<td>Off</td>
</tr>
<tr>
<td>Idle and DND</td>
<td>Orange, Steady On</td>
</tr>
<tr>
<td>Idle and Message Waiting</td>
<td>Off</td>
</tr>
<tr>
<td>Idle, Message Waiting and DND</td>
<td>Orange, Steady On</td>
</tr>
<tr>
<td>Off Hook</td>
<td>Green, Steady On</td>
</tr>
<tr>
<td>Active Call</td>
<td>Green, Steady On</td>
</tr>
<tr>
<td>Active Conference Call</td>
<td>Green, Steady On</td>
</tr>
<tr>
<td>Remote Hold</td>
<td>Green, Steady On</td>
</tr>
<tr>
<td>Offering Call</td>
<td>Green, 1000/1000 ms</td>
</tr>
<tr>
<td>Held or Parked Call (3)</td>
<td>Orange, 250/250 ms</td>
</tr>
<tr>
<td>Whisper Page Call</td>
<td>Red, Steady On</td>
</tr>
<tr>
<td>Active Call Whisper Muted</td>
<td>Red, Steady On</td>
</tr>
<tr>
<td>EXTENSION MONITOR STATES</td>
<td></td>
</tr>
<tr>
<td>Idle</td>
<td>Off</td>
</tr>
<tr>
<td>Idle and DND</td>
<td>Orange, Steady On</td>
</tr>
<tr>
<td>Idle and Message Waiting</td>
<td>Off</td>
</tr>
<tr>
<td>Idle, Message Waiting and DND</td>
<td>Orange, Steady On</td>
</tr>
<tr>
<td>Offering Call</td>
<td>Green, 1000/1000 ms</td>
</tr>
<tr>
<td>Active Call Picked Up</td>
<td>Green, Steady On</td>
</tr>
<tr>
<td>Held or Parked Call [3]</td>
<td>Orange, 250/250 ms</td>
</tr>
<tr>
<td>Monitored Ext. on Active Call</td>
<td>Red, Steady On</td>
</tr>
<tr>
<td>Monitored Ext. on Conference Call</td>
<td>Red, Steady On</td>
</tr>
<tr>
<td>Monitored Ext on Active Call + Offering Call</td>
<td>Green, 200/100/700/1000 ms</td>
</tr>
<tr>
<td>Picked up Monitored Ext. Call + Monitor Ext on Active Call</td>
<td>Green, 800/orange 200 ms</td>
</tr>
<tr>
<td>Picked up Monitored Ext. Call and Held + Monitor Ext on Active Call</td>
<td>Orange, 200/100/200/500 ms</td>
</tr>
</tbody>
</table>
## Call Handling Mode Delegation

The Call Handling Mode Delegation window lets the system administrator specify a list of users who can change the Call Handling Mode of another user. A delegated or authorized user with an Operator Access License can modify another user’s Call Handling Mode through ShoreTel Communicator or Communicator for Web Client. These authorized or delegated users are specified through ShoreTel Director by the system administrator or through Communicator by the user whose active Call Handling Mode is changed.

### Delegating through ShoreTel Director

Selecting the users who are authorized to change another user’s active call handling mode:

1. Navigate to **Administration > Users > Individual Users**.

---

### Table 53: Programmable Buttons LED Flash Patterns (Continued)

<table>
<thead>
<tr>
<th>State</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picked up Monitored Ext. Call + Monitor Ext held Active Call</td>
<td>Orange, 200 ms</td>
</tr>
<tr>
<td></td>
<td>Green, 800 ms</td>
</tr>
<tr>
<td></td>
<td>Orange, 200 ms</td>
</tr>
<tr>
<td></td>
<td>Green, 100 ms</td>
</tr>
<tr>
<td><strong>BRIDGED CALL APPEARANCE STATES</strong></td>
<td></td>
</tr>
<tr>
<td>Idle</td>
<td>Off</td>
</tr>
<tr>
<td>Offering Call</td>
<td>Green, 1000/1000 ms</td>
</tr>
<tr>
<td>Active Call Picked Up</td>
<td>Green, Steady On</td>
</tr>
<tr>
<td>Line In-Use</td>
<td>Red, Steady On</td>
</tr>
<tr>
<td>Held or Parked Call [3]</td>
<td>Orange, 250/250 ms</td>
</tr>
<tr>
<td><strong>FEATURE KEY WITH EXTENSION TARGET STATES</strong></td>
<td></td>
</tr>
<tr>
<td>Idle or Offering Call</td>
<td>Off</td>
</tr>
<tr>
<td>Connected or Held Call</td>
<td>Red, Steady On</td>
</tr>
<tr>
<td>DND</td>
<td>Orange, Steady On</td>
</tr>
<tr>
<td>(Dial/Transfer Mailbox Only) MWI</td>
<td>Red, Steady On</td>
</tr>
<tr>
<td>(Pickup, Pick/Unpark, Pickup NightBell Only) Offering</td>
<td>Green, 1000/1000 ms</td>
</tr>
<tr>
<td>(Unpark, Pick/Unpark Only) Held/Parked</td>
<td>Orange, 250/250 ms</td>
</tr>
<tr>
<td><strong>TOGGLE FUNCTIONS (RECORD, WHISPER MUTE)</strong></td>
<td></td>
</tr>
<tr>
<td>Function Off</td>
<td>Off</td>
</tr>
<tr>
<td>Function Available</td>
<td>Orange, Steady On</td>
</tr>
<tr>
<td>Record Active</td>
<td>Orange, 500/500 ms</td>
</tr>
<tr>
<td>Whisper Mute Active</td>
<td>Orange, 500/500 ms</td>
</tr>
</tbody>
</table>
2. Select the user for whom you are authorizing other users to change the active call handling mode of the selected user.

3. Click the **Personal Options** tab.

4. In the Call Handling Mode Options section, click **Delegation**. The link is next to the Current Call Handling Mode field.

   The Call Handling Mode Delegation window, shown in Figure 162, opens.

   ![Figure 162: Delegating Call Handling Mode to Other Users](image)

5. In the left column, select one or more users to authorize.

6. Click **Add** or **Remove**.

7. Click **Save** at the top of the window when delegation is complete.

**Selecting Delegates through ShoreTel Communicator**

Users can manage the list of individuals who can change their active Call Handling Mode through Communicator. The *ShoreTel Communicator for Windows* guide contains more information.
Intercom, Whisper Paging, Barge In, Record, and Monitor

Feature Descriptions

Monitoring allows one party to eavesdrop on a call. It is a limited conference call where the monitoring party hears the other parties, but the monitored parties do not hear the monitoring party. Monitoring is undetectable by the parties being monitored, except by a warning tone. Monitoring is typically used in workgroups to evaluate agent performance.

A recording warning tone may be played to the customer during call recording and monitoring. The warning tone is enabled for the entire system using a Call Control option. For a specific call, it may be disabled by using an Auto-Attendant menu option. No tone is played during a Barge In call.

Barge In allows one party to join an existing call as a fully conferenced participant. When Barge In is initiated, a brief intrusion tone is played to the other participants and, if present, the monitoring warning tone is discontinued.

To simplify discussion of this feature, we will refer to three parties: the supervisor, the agent, and the customer. The supervisor initiates monitoring by selecting an agent. The agent is on a call with another party, the customer. The customer may be an external caller, but supervisors and agents must be on extensions.

In a monitored call, a supervisor hook flash is ignored. However, a hook flash by the other parties works the same as in a two-party call. In particular, an agent flash puts the call on hold and allows a consultative transfer or conference.

Because there is a limit of three parties in a conference call, if the agent or customer makes a consultative transfer or conference, the supervisor is automatically dropped. Similarly, if another party barges into a monitored extension, then the monitoring is dropped.

If a conference call is already in progress, it cannot be monitored. If monitoring is already in progress, no one else can monitor the call.

The supervisor can barge into a call he or she is monitoring. However it is not possible to revert a barge in to just a monitored call. If desired, the supervisor can hang up and restart monitoring.

After a barge in, the agent remains the controlling party of the call. A subsequent agent hook flash disconnects the supervisor, who was the last party added.

COS Settings

Each telephony COS permission has check boxes and radio buttons in ShoreTel Director for configuring Intercom, Whisper Paging, Barge In, Call Recording, and Call Monitoring. These options appear near the bottom of the Class of Service - Edit Telephony Features Permissions page. Details about the relevant parameters are provided in Table 54. For more information about setting permissions, refer to Telephony Features Permissions on page 338.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow initiation for Intercom/ Paging</td>
<td>If this check box is selected, users with this COS can place an intercom call or page to other system users. If this box is empty, the user with this COS cannot initiate an intercom call or page.</td>
</tr>
</tbody>
</table>
| Accept Intercom/Paging | Radio button choices are:  
- Accept: None: If the choice for Accept is None, users with this COS cannot receive intercom calls or pages.  
- Accept: All: If the choice for Accept is All, users within this COS can receive intercom calls or pages from anyone in the COS.  
- Accept: Only From: If the choice for Accept is Only From, users with this COS may receive intercom calls or pages from only the person or extension specified in the associated field. |
| Allow initiation for barge in | If this check box is selected, users within this COS may barge in on the calls of other system users. If cleared, then no barge in can be initiated. |
| Accept barge in | Radio button choices are:  
- Accept None: If selected, users within this COS may not receive barge-ins from anyone.  
- Accept All: If selected, users within this COS may receive barge-ins from anyone else in this COS.  
- Accept Only From: If selected, users within this COS may only receive barge-ins from the person or extension specified in the field associated with this radio button. |
| Allow initiation for record other’s calls | If this check box is selected, users within this COS may record the calls of other system users. If cleared, then no call recording can be initiated. |
| Accept record other’s calls | Radio button choices are:  
- Accept None: If selected, users within this COS may not have their calls recorded by anyone.  
- Accept All: If selected, users within this COS may have their calls recorded by anyone else in this COS.  
- Accept Only From: If selected, users within this COS may only have their calls recorded by the person or extension specified in the field associated with this radio button. |
No special permissions exist for ShoreTel Enterprise Contact Center agents or supervisors. However, to use center recording, monitoring, and barge in, an agent or supervisor must have a COS with the settings that allow these features.

### Table 54: COS Permissions Fields (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow initiation for silent monitor</td>
<td>If this check box is selected, users within this COS may monitor other system users. If cleared, then no monitoring can be initiated.</td>
</tr>
<tr>
<td>Accept silent monitor</td>
<td>Radio button choices are:</td>
</tr>
<tr>
<td></td>
<td>- Accept None: If selected, users within this COS cannot be monitored by anyone.</td>
</tr>
<tr>
<td></td>
<td>- Accept All: If selected, users within this COS can be monitored by anyone else in this COS.</td>
</tr>
<tr>
<td></td>
<td>- Accept Only From: If selected, users within this COS can only be monitored by the person or extension specified in the field associated with this radio button.</td>
</tr>
</tbody>
</table>
CHAPTER

13

Configuring Voice Mail

This chapter provides information about configuring the voice mail system in the following sections:

- System Distribution Lists ................................................................. 478
- AMIS Voice Mail .............................................................................. 480
  - AMIS Restrictions ........................................................................... 481
  - Enabling AMIS ................................................................................. 482
  - Creating AMIS Systems ..................................................................... 483
  - Disabling AMIS Systems ................................................................... 485
  - Setting Voice Mail User Group Permissions ..................................... 486
  - AMIS Test Mailbox ............................................................................ 486
- Delivery and Notification ................................................................. 486
  - Escalation Profiles and Other Mailbox Options ............................... 487
- Voice Mail Reports ............................................................................ 496
  - Summary Report ................................................................................ 496
  - Server Report .................................................................................... 497
- Voice Mail Synchronization with Gmail for Business ....................... 500
  - Background ..................................................................................... 500
  - Voice Mail Synchronization Terms ................................................... 500
  - Behavioral Details ............................................................................ 501
  - Configuration .................................................................................... 504
System Distribution Lists

System distribution lists provide a mechanism for sending the same message to multiple users at one time. They are managed from the ShoreTel Director. You add and edit system distribution lists from the Voice Mail System Distribution Lists. To access the Voice Mail System Distribution Lists page, do the following:

1. Launch ShoreTel Director.
2. Click Administration > Voice Mail > System Distribution Lists. The System Distribution Lists page appears as shown in Figure 163.

The columns in the System Distribution List page are as follows:

- **Description**: This is the name of the system distribution list.
- **Number**: This is the number that is used for sending messages to members in the distribution list. Users can enter this number in either the ShoreTel client or when addressing a message from the telephone user interface.

The ShoreTel system lets a user with the proper class of service send a broadcast message to all mailboxes. Unlike system distribution lists, the broadcast distribution list cannot be edited. If necessary, the administrator can remove individual mailboxes from the broadcast list on the associated Edit Users page, Workgroup edit page, or Route Point edit page.

To add or edit a system distribution list, click **Add new** or click the name of an existing list that appears in the Voice Mail System Distribution Lists table. When you click either of these items, the Edit System Distribution List page appears as shown in Figure 164.

### Figure 163: Voice Mail System Distribution Lists Page

<table>
<thead>
<tr>
<th>System Distribution Lists</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add new</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Description</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast</td>
<td>400</td>
</tr>
<tr>
<td>Executives</td>
<td>401</td>
</tr>
<tr>
<td>Managers</td>
<td>402</td>
</tr>
<tr>
<td>Staff</td>
<td>403</td>
</tr>
</tbody>
</table>

**Note**

You can also add or remove a user from a system distribution list from the Edit User page. Refer to Configuring a User Account on page 354.
The parameters on the System Distribution List edit page are described in Table 55.

**Table 55: System Distribution List Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name of the distribution list.</td>
</tr>
<tr>
<td>Number</td>
<td>This is the number that is used for sending messages to members in the distribution list. Users can enter this number in either the ShoreTel client or when addressing a message from the telephone user interface. This number cannot go beyond the range of numbers that you defined in the First System Distribution List Number and Last System Distribution List Number fields in the section from Chapter 2, Setting Up System Parameters on page 41. Also, the first system distribution list number is reserved for future use.</td>
</tr>
</tbody>
</table>
Configuring Voice Mail

AMIS Voice Mail

The ShoreTel system sends and receives voice mail messages to and from legacy voice mail systems by using Audio Messaging Interchange Specification (AMIS) protocol Version 1 — Spec February 1992. To send voice mail messages to remote AMIS sites, ShoreTel dials a phone number to access the remote system. Likewise, to receive voice messages from a remote system, the remote system must have the number to dial into the ShoreTel system. To reach the ShoreTel system, the remote system must be configured to dial a number that reaches an auto-attendant menu.

AMIS call support is enabled by default. Incoming AMIS voice mail is delivered in the same manner as other voice mail; however, replies cannot be sent. To send outbound AMIS voice mail, you must create AMIS systems in ShoreTel Director.

ShoreTel negotiates the setup, handshaking, and teardown of AMIS system calls. Each voice mail requires a call over the AMIS delivery and call-back numbers.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorded Name</td>
<td>The buttons that correspond to this item let you Record, Play, Erase, or Import a recorded name for the distribution list.</td>
</tr>
<tr>
<td></td>
<td>Click Record to record a name for the distribution list.</td>
</tr>
<tr>
<td></td>
<td>Click Play to play back the recording.</td>
</tr>
<tr>
<td></td>
<td>Click Erase to erase the recording.</td>
</tr>
<tr>
<td></td>
<td>Click Import to import a sound file.</td>
</tr>
<tr>
<td>Language</td>
<td>Select a language from the drop-down list.</td>
</tr>
<tr>
<td>Select from List: Filter Users By</td>
<td>If you want to search for users with certain extension numbers or names beginning with a specific letter, use the Filter Users By fields. You can sort by Last Name, First Name, or Extension.</td>
</tr>
<tr>
<td></td>
<td>If more names fit the criteria than can be displayed, use the Show Page controls. Either select a page number from the drop-down list or use the arrow keys to scroll through the list.</td>
</tr>
<tr>
<td></td>
<td>After selecting a name or names from the user list, click Add to add it or them to the Distribution List Members box.</td>
</tr>
<tr>
<td></td>
<td>If you want to remove a user from the directory list, select the user name from this box and click Remove.</td>
</tr>
<tr>
<td>AMIS Systems</td>
<td>This lets you add users on AMIS systems to the distribution list.</td>
</tr>
<tr>
<td></td>
<td>To add an AMIS user to the distribution list, select the AMIS system where the user you want to add is located and click Add.</td>
</tr>
<tr>
<td></td>
<td>A dialog box prompts you for the extension number of the user.</td>
</tr>
<tr>
<td></td>
<td>Enter the number and click OK. The AMIS System ID and extension, or Mailbox ID, appears in the distribution list box.</td>
</tr>
</tbody>
</table>
You can configure AMIS systems for two addressing methods. If the system does not use off-system extensions, a System ID number is required to direct the voice mail to the correct site. When a user wants to send a voice mail to a recipient on an AMIS system, he or she first must enter the System ID and then the mailbox number or extension.

### Table 56: Examples of Address with a System ID

<table>
<thead>
<tr>
<th>System ID</th>
<th>Recipient Mailbox Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>8331</td>
<td>1234</td>
</tr>
<tr>
<td>8408331</td>
<td>45657</td>
</tr>
</tbody>
</table>

If the system uses off-system extensions, these extensions become off-system mailboxes. In this case, users simply address the voice mail by mailbox number and without entering the System ID.

Perform the following steps before you create AMIS systems to remote sites:

- Enable AMIS messaging from the Voice Mail Options page. AMIS is enabled by default.
- Set permissions for the Voice Mail User Group to include dialing AMIS numbers. For more information, refer to Voice Mail Permissions on page 348.
- Review the extension plans for all the systems to which you are making a connection. Make sure they use the same extension length and that extension numbers do not overlap.

After these global settings are complete, creating AMIS systems require the following steps:

- Name the AMIS site and enter a System ID.
- Enter the phone number the ShoreTel system calls to connect to each remote AMIS system.
- Enter the phone number that remote AMIS systems call to send AMIS messages. This number must reach an auto-attendant.
- If a system is using off-system extensions, select the extension range for each AMIS system.

### AMIS Restrictions

Some restrictions are placed on AMIS voice messages, as follows:

- ShoreTel establishes a call to an AMIS system for each voice mail. If a voice mail is addressed to multiple recipients, ShoreTel delivers as many as nine voice mails in a single call. If a voice mail has more than nine recipients, ShoreTel makes additional calls until the voice mail is delivered to all recipients. You can optimize AMIS voice mail delivery by using distribution lists at the remote AMIS sites.
- The maximum message length permitted is eight minutes.
- After ten failed attempts to complete a call to an AMIS system, ShoreTel disables the AMIS system and generates an event log.
After ShoreTel establishes an AMIS system call, it tries three times to complete message delivery to each recipient. If ShoreTel fails to deliver a voice message after three attempts, it stops trying and returns the message to the sender. However, if the sender’s voice mailbox is full, they do not receive failed messages.

Outbound voice mail messages for disabled AMIS systems are accepted and queued. To deliver queued messages, enable the AMIS system in question on the AMIS edit page. Refer to Figure 165 for an example of this page.

Enabling AMIS

Enabling AMIS Systems

1. Launch ShoreTel Director.
2. Click Administration > Voice Mail > Options. The Voice Mail Options page shown in Figure 165 appears.
3. Set the AMIS parameters as appropriate. Refer to Table 57 for information about these parameters.
4. Click Save.

![Voice Mail Options Edit Page](image)

Table 57: AMIS Voice Mail Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Message Length Accepted</td>
<td>Specify minimum length, in milliseconds, a message must be to be acceptable. The system default is 2000 milliseconds.</td>
</tr>
<tr>
<td>From Address for Email Notifications</td>
<td>Specify the e-mail address to be placed in e-mail notifications about new messages.</td>
</tr>
</tbody>
</table>
Creating AMIS Systems

After you enable AMIS systems from the Voice Mail Options page, the next step is to create and configure the individual AMIS systems. Enter the AMIS delivery and call back number for each AMIS system you want to configure.

Expand the Voice Mail link in the navigation frame and click AMIS. The AMIS Systems list page appears as shown in Figure 166.

To add a new AMIS system, click Add New. To edit an existing system, click an entry in the AMIS System column. The AMIS edit page appears, as shown in Figure 167.

### Table 57: AMIS Voice Mail Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable AMIS</td>
<td>The Enable AMIS check box enables/disables all AMIS systems. Individual AMIS systems can be enabled and disabled from the AMIS edit page. To enable AMIS systems support, click this check box if it is not already selected. This option is enabled by default. For more information, refer to Creating AMIS Systems on page 483.</td>
</tr>
<tr>
<td>Allow Incoming AMIS access to Broadcast DL</td>
<td>To allow delivery of incoming AMIS messages to the Broadcast Distribution List, click the check box.</td>
</tr>
<tr>
<td>Allow Incoming AMIS access to System DL</td>
<td>To allow delivery of incoming AMIS messages access to the System Distribution Lists, click the check box.</td>
</tr>
<tr>
<td></td>
<td>The Voice Mail application will automatically remove silence from voice messages. If the resultant message after silence removal is less than this minimum message length, the message is assumed to be a hang-up and will be deleted from the system.</td>
</tr>
</tbody>
</table>
Figure 167: AMIS Edit Page

Table 58: Global AMIS Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of this AMIS site.</td>
</tr>
<tr>
<td>System Enabled</td>
<td>Select to enable this AMIS system. Outbound voice mail for this system is queued until the system is reset by selecting the System Enabled check box.</td>
</tr>
</tbody>
</table>
Disabling AMIS Systems

You can disable AMIS systems globally or by individual connection. Individual AMIS systems are automatically disabled when ShoreTel fails to complete a call to an AMIS system.

### Table 58: Global AMIS Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID</td>
<td>The System ID defines the AMIS site where the voice mail for this system is delivered. The System ID plus a mailbox number identifies the site and the voice mail recipient. Plan the System ID to simplify the process of sending AMIS voice mail for your users. The System ID consists of an access code plus a site identifier. The System ID must begin with a digit reserved for trunk access codes, although it can be different from other trunk access codes. To make the System ID intuitive to voice mail users, choose a site identifier related to the public numbers used at the site. For example, if the voice mail delivery number is +1 (408) 555-1234, then System IDs like 8555 or 9408555 will be intuitive to your users. Generally, the shorter the System ID number, the easier it is to use. The System ID plus the mailbox length cannot exceed 15 digits. System IDs are required and can be single digits. Each AMIS system you create must have a unique System ID.</td>
</tr>
<tr>
<td>Delivery Number</td>
<td>This is the number ShoreTel calls to send AMIS voice messages to the remote system. An external number is a public PSTN number and a private number is an internal, off-system extension connecting to an intra-site PBX system.</td>
</tr>
<tr>
<td>Call Back Number</td>
<td>This is the number on which you receive AMIS messages. An external number is a public PSTN number and a private number is an internal, off-system extension connecting to an intra-site PBX system.</td>
</tr>
<tr>
<td>Mailbox Length</td>
<td>Set the mailbox length of the remote sites mailboxes or extensions. If you are using off-system extensions, the length must match the length of your extensions. The System ID plus the mailbox length cannot exceed 12 digits.</td>
</tr>
<tr>
<td>Off-System Extensions</td>
<td>If your system is using off-system extensions, select the extension range for each AMIS system. These extensions function as off-system mailboxes, allowing users to address voice mail to users on remote AMIS sites without entering a System ID. For more information, refer to Adding or Editing a Trunk Group on page 168.</td>
</tr>
</tbody>
</table>
To globally disable AMIS systems, deselect the **Enable AMIS** check box in the Voice Mail Options page. Refer to Figure 165 on page 482 for an example of this page. To disable an individual AMIS system, from the AMIS System list page, double-click the name of the AMIS system you want to disable. The AMIS edit page appears. Clear the **System Enabled** check box and click **Save**.

When you disable AMIS, ShoreTel does not send or receive AMIS voice messages.

Users can address outgoing voice messages while the system is disabled. Outbound messages are queued until the individual AMIS system is re-enabled. Attempts to deliver to a disabled AMIS system fail.

### Setting Voice Mail User Group Permissions

You must set the permissions for the Voice Mail User Group to allow ShoreTel calls to the AMIS system delivery numbers you have configured. For instructions for setting these permissions, refer to Configuring a User Account on page 354.

### AMIS Test Mailbox

ShoreTel allows you to designate a mailbox that a remote AMIS system can use to test AMIS features. When you address a voice mail to the AMIS test mailbox, ShoreTel automatically replies with the same message.

Voice Mail reports are used by administrators to monitor, administer, and manage system resources and user activity.

### Delivery and Notification

The user’s voice mail notification options are edited from the Escalation Profiles and Other Mailbox Options page. Voice mail escalation parameters specify what should happen if notification is enabled at the time a message arrives. These options include the user’s message notification telephone number, pager ID number, and try options.

Voice mail may be auto-forwarded. That is, a mailbox may be configured to send any message it receives to another mailbox. The message sent to the original mailbox can be automatically deleted, as an option. The target mailbox for forwarded messages may be any user, a workgroup, a route point, AMIS address, or a system distribution list other than a broadcast distribution list. A message is prepended to the forwarded message, along with a time-stamp, announcing that the message has been auto-forwarded. As an example, the recipient of an auto-forwarded message might hear, “Auto-forwarded message received at 9:10 AM from Customer Support Mailbox”.

An example of use might be the handling of off-hours calls when few support staff are available. Off-hours calls may be routed to a back-up extension. If no one is available to answer the back-up extension, calls may wind up in a voice mailbox that will not be checked for hours. The back-up extension can be set to auto-forward any calls that are received in its mailbox. Calls can be forwarded to a mailbox that is checked on a regular basis.
Auto-forwarding is available between distributed voice mail servers. The message is handled as any other message would be, including any message waiting indicator, any calling notification, return receipt requests, or urgent markings. Auto-forwarded messages can be forwarded and replied to. If the target mailbox is full, the message is left in the sending mailbox. If a message is being auto-forwarded to a list of mailboxes and one is full, that target is skipped.

**Escalation Profiles and Other Mailbox Options**

The Escalation Profiles and Other Mailbox Options page can be accessed from a link on the User’s Personal Options page. From here, you can configure Escalation Profiles to notify employees when a voice mail is received, which can be helpful in providing your customers with superior service/support after hours. You also can configure Automatic Message Forwarding and Email Delivery Options for a user so that users can be notified when their voice mailboxes are almost full.

The Escalation Profiles and Other Mailbox Options page is shown in Figure 168.

![Figure 168: Escalation Profiles and Other Mailbox Options Page](image-url)
Parameters

The Escalation Profiles and Other Mailbox Options parameters are shown in Table 59.

Table 59: Escalation Profiles and Other Mailbox Options Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Address</td>
<td>This is the user’s e-mail address. By default, it is automatically entered when you enter the user’s first and last names in the First Name and Last Name fields. It consists of the first initial of the user’s first name followed by the user’s entire last name. In addition, the @companyname.com domain is saved in a cookie on the workstation each time you save a user. The system presents this information as a default, which can be changed as needed. Be sure to delete this field if the user does not have or use email.</td>
</tr>
<tr>
<td>Deliver Message as Email</td>
<td>Select one of three e-mail delivery options: Disabled, Email Text Only, or Attach WAV File. The Email Text Only option notifies the user of the time, duration, and Caller ID of the message that was recorded. The Attach WAV File option attaches the voice message to the email as a WAV file. Selecting the Mark Message as Heard results escalation profiles being disabled for messages that are delivered to a generic email address, for example, messages delivered to an email address not listed in the escalation steps.</td>
</tr>
<tr>
<td>Send Email When Mailbox is Full</td>
<td>Select the Send Email When Mailbox is Full check box to enable Voice Mailbox Full Notifications. This feature sends users a notice informing them that their mailbox is almost full. This message is sent when the user’s mailbox approaches maximum capacity and crosses a non-configurable threshold such as space for only 10 messages remaining. Refer to Configuring Voice Mailbox Full Notifications on page 489 for more information.</td>
</tr>
<tr>
<td>Destination</td>
<td>Messages may be auto-forwarded to a user, a workgroup, a route point, or a system distribution list. If the system distribution list includes AMIS destinations, they also receive the auto-forwarded message. The default is None, meaning, no forwarding. The destination may not be a broadcast distribution list.</td>
</tr>
<tr>
<td>Delete Message After Forwarding</td>
<td>Select the checkbox to cause the automatic deletion of the message after forwarding. The default is not to delete.</td>
</tr>
</tbody>
</table>
Configuring Voice Mailbox Full Notifications

The Voice Mailbox Full Notification feature offers a way for users to receive an alert that tells them their mailbox is almost full before it gets to the point that they stop receiving messages.

When a user’s mailbox approaches its maximum capacity and a non-configurable threshold has been crossed, the system sends users a notice informing them that their mailbox is almost full and that there is only enough room for 10 additional messages. Each time users log into voice mail, they will receive a notice telling them how much space remains. In this way, mailbox owners are given adequate notice that they must clean up their mailboxes and they are not caught off-guard by an unexpected and unwanted “mailbox full” notification.

Recall that the maximum number of messages a user can receive ranges from 0 to 500 and can be set on the Class of Service - Voice Mail window in Director. This flexibility implies that not all users in the system will have the same upward limit to the number of voice mail messages they can receive.
Details

The following list includes additional details about configuring notifications for voice mailboxes:

- The mailbox warning threshold occurs when there is room for only 10 more messages in a user’s mailbox. This threshold is non-configurable and is the same for all users, regardless of total mailbox capacity.

- As a user’s mailbox approaches its limit, a warning message will be played indicating that the user has room only for “n” number of messages where the value “n” will be a countdown from 10 to 0. This message will be played when a user logs into the mailbox via the telephone user interface or Communicator.

- The “almost full” notification will be played until a users delete their messages, thereby reducing the number below the threshold.

- When a mailbox has finally reached its limit, the mailbox owner will be notified, if notification has been enabled for this user, and a warning NT event will be logged.

- When a message is deleted, it is no longer counted against the total capacity for a user's mailbox.

- Deleted messages are temporarily held in a deleted messages folder. Up to 200 deleted messages can be temporarily held. Once this limit is reached, the mailbox will be considered full and the user will be unable to receive new messages until the deleted messages have been purged. If this happens, the mailbox owner will receive a notification telling him, “Your mailbox is full. No more messages will be accepted until you purge your deleted messages.”

- Deleted messages can be manually purged by the user or automatically by the system. Automatic purging occurs on a nightly basis.

Complete the following steps to enable the Voice Mailbox Full Notifications feature for a user:

1. Launch ShoreTel Director.

2. Click Administration > Users > Individual User. The Individual Users page appears.

3. Select the user for whom you want to enable notification when their voice mail box is full. The Edit User page for that user appears.

4. Click the Personal Options tab.

5. Scroll to the bottom of the page and click Escalation Profiles and Other Mailbox Options. The Escalation Profiles and Other Mailbox Options for the user appears.

6. Select the Send Email When Mailbox is Full check box.

7. Click Save to store your changes.

8. Repeat this process for each user for which you would like to configure mailbox full notifications.

Moving Voice Mailbox to a New System

The Move Voice Mailbox feature offers a way for users to move their voice mailbox to a new system.

Complete the following steps to move the voice mailbox to a new system:
1. Take a backup of the VMB and delete the existing VMB from the old system.

2. Perform a “Full” factory reset of a VMB by pressing the factory reset button for more than 10 seconds.

3. Add a VMB to the new system.

4. Plug-in the VMB into the new system.

### Configuring Escalation Notification

The ShoreTel system supports Escalation Notification. This voice mail feature allows your organization to know when your customers need help.

For example, if a customer in a small town calls his local utility provider to complain about a power outage at 4 a.m., it is possible nobody would be in the office at that hour to handle his call. However, with ShoreTel’s Escalation Notification feature, the customer could leave a voice mail, and in doing so, he would set in motion a chain of events that would cause support personnel from the utility company to respond to his concerns.

The message left by the customer on the voice mail system would trigger the Escalation Notification feature to send out a page, phone call, or email to an employee in the support department of the utility company. If this first employee ignores the beeping pager, another person will be contacted, and so on. Each of those utility company employees specified in the escalation profile will be contacted until someone dials into the ShoreTel system and listens to the customer’s voice mail message and handles the problem. Refer to Figure 169 for an example of the flow for an escalation profile event.
The following list includes details for creating an Escalation Notification profile:

- Each escalation profile has ten notification steps, allowing the system administrator to specify who will be contacted at each step and the method used to contact that person, for example by phone call or pager notification. An email can be sent to that person in addition to the phone call or pager notification.

- A maximum of nine notification profiles are supported.

- Call handling modes can be associated with different notification profiles.

- If a message is left, and someone listens to it, the notifications will stop. However, if someone marks a message unheard, that will restart the notification process in the same way that receiving a new voice message will.

- Escalation notification is supported on all mailboxes, including user mailboxes, including extension and mailbox users, mailbox-only users, and SMDI mailbox-only users, as well as workgroup mailboxes.

Complete the following steps to configure escalation notifications with ShoreTel Director:

1. Launch ShoreTel Director.

2. Click **Administration > Users > Individual User**. The Individual Users page appears.
3. Select the user for whom you want to enable notification when their voice mail box is full. The Edit User page for that user appears.

4. Click the **Personal Options** tab.

5. Scroll to the bottom of the page and click **Escalation Profiles and Other Mailbox Options**. The Escalation Profiles and Other Mailbox Options for the user appears.

6. In the Message Notification Escalation Options section, select the appropriate radio button:
   - Check the **Escalate for Each New Message** check box to have the system send a new wave of escalation notification messages each time a new voice mail message arrives. If several messages arrive within a short period of time, those who are notified will receive multiple notifications.
   - Check the **Escalate for First Unheard Message** check box to have the system send an escalation notifications to begin at the receipt of the first voice mail message. Subsequent unheard voice mail messages will not trigger another wave of notifications as long as the first message remains unheard.

7. In the Profile section, click the link for the desired escalation profile. The Escalation Profile page appears as shown in **Figure 170**.

8. Do the following to create an escalation profile:
   - In the **Name** field, enter the name that you want to use for the profile.
b. In the **Repeat Count** field, enter a value ranging from 0 to 200. This is the number of times the system will loop through the 10 steps of this profile before it quits trying to contact the various notification members. Selecting 0 will cause the escalation notification profile to execute once, without repeating. Selecting 1 will cause it to execute twice — one time in addition to one repeat loop.

Note
Repeat count does not work for **Notifying by Email** option.

c. In the **Timeout** field, enter the number of minutes (0 - 3600) you want to elapse before the next step within this profile is executed. This is the amount of time a message recipient has to respond to the original voice mail before escalation occurs.

d. Check the **Urgent Only** check box to have notification sent in only when the escalation is determined to be urgent.

e. In the **Deliver Message as Email** field, select the method you want to use for email delivery. The options are as follows:
   - Select **Disabled** to not send email notification.
   - Select **Email text only** to have a text message sent to this user's email inbox. The message will contain basic information about the message such as timestamp, sender, and so on.
   - Select **Attach WAV file** to have a copy of the voice mail sent to the designated user's email inbox. This will allow the recipient to play the message from his or her PC.

f. In the **Email Address** field, enter the email address of the first person that you want to notify.

g. In the Voice Mail Notification Method section, select one of the following radio buttons for the method that you want to use to send voice mail notification: **Pager**, **Phone**, or **None**.

h. In the Notification Number section, select the appropriate radio button for the type of phone you want to send the voice mail message to, **Extension** or **External**, and enter the phone or pager number of the user in the field.

i. In the **Pager ID** field, enter the pager pin number required to access the recipient.

j. In the **Pager Data** field, enter the code the recipient requires to indicate that a page is waiting.

k. Click **Save** to store your changes.

Note
Click on the next Escalation Step, which is above the **Timeout** field, and repeat this process to configure up to ten steps within this escalation profile. Unconfigured steps will be skipped when the escalation profile is executed.
Linking an Escalation Notification Profile to a Call Handling Mode

Complete the following steps to link an escalation notification profile to a CHM:

1. Launch ShoreTel Director.

2. Click **Administration > Users > Individual User**. The Individual Users window appears.

3. Select the user for whom you want to enable notification when their voice mail box is full. The Edit User page for that user appears.

4. Click the **Personal Options** tab.

5. Scroll to the Edit Call Handling Modes section and select the call handling mode that you want to associate with an escalation profile. The CHM page appears, as shown in Figure 171.

6. In the **Escalation Profile** field, select the desired escalation notification profile that you want to use.

7. Click **Save** to store your changes.

8. Repeat this process to associate different escalation notification profiles with each of the different Call Handling Modes as needed.

![Figure 171: Selecting the escalation profile to associate with Out of Office CHM](image)
Voice Mail Reports

When an administrator requests a Voice Mail report, the system retrieves statistics from the main server and all distributed servers. ShoreTel provides two types of reports from this information:

- **Summary Report**: The Summary Report lists voice mail resource data for each application server on the ShoreTel network.
- **Server Report**: The User Report lists voice mail usage information for the specified application server and users assigned to the application server.

### Summary Report

The Voice Mail Servers Maintenance Summary page displays the Voice Mail Summary Report. To open the Summary page, shown in Figure 172, select **Maintenance > Services > Voice Mail** from the **Director** menu.

![Figure 172: Voice Mail Statistics: Totals Report](image)

The table lists all application servers configured on the network. Each row corresponds to one application server and each column lists a server property or resource statistic.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>This parameter lists the site to which the server is assigned, as specified by the Edit Application Servers page.</td>
</tr>
<tr>
<td>Voice Mail Server</td>
<td>This parameter lists the name of the server, as specified by the Edit Application Servers page.</td>
</tr>
<tr>
<td>Mailboxes</td>
<td>This parameter lists the number of mailboxes on the server.</td>
</tr>
<tr>
<td>Messages</td>
<td>This parameter lists the number of messages that are stored in the server's mailboxes.</td>
</tr>
<tr>
<td>Space Used (MB)</td>
<td>This parameter lists the memory the server is using to store mailbox messages, user name recordings, auto attendant prompts, logs, and other data.</td>
</tr>
</tbody>
</table>
Server Report

The Voice Mail Servers Maintenance Server page displays a voice mail statistics report for the specified application server. To open the Summary page, shown in Figure 173, click the link of the desired application server on the Voice Mail Servers Maintenance Summary page.

Table 60: Escalation Profiles and Other Mailbox Options Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Space (MB)</td>
<td>This parameter lists the hard disk memory available on the server. When less than 25% of memory capacity of the server is available, the page displays a red icon next to the free space value for that server. When the available memory is between 25% and 50% of capacity, the page displays a yellow icon next to the free space value.</td>
</tr>
<tr>
<td>Last Successful Backup</td>
<td>This parameter lists the date that information on the server was backed up.</td>
</tr>
</tbody>
</table>

Server Report

The Voice Mail Servers Maintenance Server page displays a voice mail statistics report for the specified application server. To open the Summary page, shown in Figure 173, click the link of the desired application server on the Voice Mail Servers Maintenance Summary page.

The page lists the name of the application server for which the page is reporting statistics below the Voice Mail Servers Maintenance text in the upper left corner of the page. The page comprises two sections:

- **Summary**: The summary section lists resource usage and availability statistics for the specified application server.
- **Details**: The Details section lists resource usage statistics for users assigned to the application server.
Summary

The summary section, located on the top section of the Server page, lists resource usage and availability statistics for the specified application server. Refer to Table 61 for information about the parameters in this section.

Table 61: Summary Section Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mailboxes</td>
<td>This parameter lists the number of mailboxes on the server.</td>
</tr>
<tr>
<td>Messages</td>
<td>This parameter lists the number of messages that are stored in the server's mailboxes.</td>
</tr>
<tr>
<td>Space Used for</td>
<td>These parameters indicate the manner in which the server's memory is allocated:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Users</td>
<td>This parameter lists the memory used to store voice mail and mailbox configuration settings.</td>
</tr>
<tr>
<td>Recorded Names</td>
<td>This parameter lists the memory used to store recordings of all user names.</td>
</tr>
<tr>
<td>Auto-Attendant Prompts</td>
<td>This parameter lists the memory used to store auto-attendant prompts.</td>
</tr>
<tr>
<td>Logs and Other Data</td>
<td>This parameter lists the memory used for log files generated by services hosted by the server.</td>
</tr>
<tr>
<td>Free</td>
<td>This parameter lists the available unused memory resources.</td>
</tr>
<tr>
<td>Total</td>
<td>This parameter lists the total memory resources on the server.</td>
</tr>
</tbody>
</table>

Details

The Details section lists resource usage statistics for the fifty largest mailboxes on the server. Mailboxes are sorted in order of the amount of disk space used to store their contents.

Each row corresponds to one mailbox on the application server. Each column lists a mailbox property or resource statistic.
### Table 62: Details Report Fields

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Information</strong></td>
<td>These parameters identify the user to whom the mailbox is assigned. User information parameters are configured in the Edit User – General page.</td>
</tr>
<tr>
<td></td>
<td>- First Name: This parameter lists the first name of the mailbox owner.</td>
</tr>
<tr>
<td></td>
<td>- Last Name: This parameter lists the last name of the mailbox owner.</td>
</tr>
<tr>
<td></td>
<td>- Mailbox: This parameter lists the extension of the mailbox.</td>
</tr>
<tr>
<td></td>
<td>- User Group: This parameter lists the User Group to which the mailbox owner is assigned.</td>
</tr>
<tr>
<td><strong>Number of Messages</strong></td>
<td>These parameters list the mailbox capacity and contents statistics.</td>
</tr>
<tr>
<td></td>
<td>- Total: This parameter lists the number of messages in the mailbox.</td>
</tr>
<tr>
<td></td>
<td>- Unheard: This parameter lists the number of messages that are marked as unheard.</td>
</tr>
<tr>
<td></td>
<td>- Allowed: This parameter lists the capacity of the mailbox. The number of messages that a mailbox can hold is configured through Class of Service settings.</td>
</tr>
<tr>
<td><strong>Saved / Unheard (Days)</strong></td>
<td>These parameters list the age of the oldest message in the specified mailbox that has not been heard.</td>
</tr>
<tr>
<td></td>
<td>- Oldest: This parameter lists the age, in days, of the oldest message that is marked unheard.</td>
</tr>
<tr>
<td></td>
<td>- Allowed: This parameter lists when messages marked as unheard are removed from the server, in terms of the message age. This parameter is configured through Class of Service settings.</td>
</tr>
<tr>
<td><strong>Heard (Days)</strong></td>
<td>These parameters list the age of the oldest message in the specified mailbox that has been heard.</td>
</tr>
<tr>
<td></td>
<td>- Oldest: This parameter lists the age, in days, of the oldest message that is marked heard.</td>
</tr>
<tr>
<td></td>
<td>- Allowed: This parameter lists when messages marked as heard are removed from the server, in terms of the message age. This parameter is configured through Class of Service settings.</td>
</tr>
<tr>
<td></td>
<td>- Space Used: This parameter lists the memory required to store contents of the specified mailbox. This statistic includes the memory required to store messages that are deleted but not purged.</td>
</tr>
</tbody>
</table>
Voice Mail Synchronization with Gmail for Business

The Synchronization with Gmail for Business feature automatically synchronizes the state of a ShoreTel user’s voice mail with the state of each corresponding email when voice mail status is sent via ShoreTel’s email notification. The HQ or DVS server monitors the state of a user’s voice mails and emails and synchronizes those states. For example, when a user opens the voice mail notification email, the voice mail is marked heard on the voice mail system, and the message-waiting indicator on the phone is turned off.

Note
In the current release, Google Gmail is the only email server that a ShoreTel system can interoperate with for synchronization of voice mail status. The feature currently works on Gmail Premier and Educational email accounts only. These accounts have the APIs that are necessary for the integration to work.

Background

A user account can be configured so that the user receives email notification of a new voice message. This email notification can also arrive with an attached WAV file of the actual voice message. The user can receive both the notification and the voice mail by way of the email client. However, in releases below Release 11.2, the status of the messages is not synchronized.

Note
Below Release 11.2, email notification is not synchronized with the related voice message on the server: After a user listens to a message by playing the WAV file attached to the emailed notification, the message on the voice mail server remains marked as unread. Even though a system administrator could specify in Director that messages be marked as heard after email notification is sent, this approach does not allow the ShoreTel system to determine whether the message has actually been read by the email client.

Voice Mail Synchronization Terms

This section contains definitions of acronyms that are relevant to the feature.

- Gmail: Google’s email service.
- IMAP4: Internet Message Access Protocol 4. An application-level Internet protocol used for accessing email from a remote mail server.
- OAuth2: This open protocol supports secure API authorization from desktop and web apps through a simple, standard method. For more details, see Use of the OAuth2 Protocol section. To research OAuth2, go to http://code.google.com/apis/accounts/docs/OAuth2.html.
Behavioral Details

This section describes a range of details about the feature. Some details are more visible, such as the consequences of user action on a message as described in the Synchronization Rules section. Certain internal and network-level details are also described.

General Details

This section contains some general technical details of the feature.

- To monitor the status of email, Synchronization with Gmail for Business uses the IMAP4 and OAuth2 protocols to access and authenticate with Gmail server. The Secure Sockets Layer (SSL) protocol is used to secure pertinent communications on the network.

- Access to user email by login with the username and password is not used.

Synchronization Service

The service runs on HQ and all DVS servers. The name of this service is ShoreTel-VmEmSync.

Each service is responsible for synchronizing the mailboxes that are on the same server. For example, the service running on HQ syncs the mailboxes located on HQ.

In the case of mailboxes on a Voice Mailbox Server switch (VMB switch), the synchronizing is done by the VmEmSync service that is running on the same server as the TMS that manages the VMB.

Synchronization Rules

The tables in this section contain synchronization rules. The applicable rules depend on whether an email notification has the attached WAV file and whether the server is synchronizing during ShoreTel-VmEmSync service startup or during normal operation.

Synchronization upon Startup

Start-up synchronization refers to initialization of the ShoreTel-VmEmSync service. This service gathers information on all voice mail and related email for each user and then synchronizes the states based on the rules in either Table 63, which is for email text only, or Table 64, which is for email with WAV file attachment. In these tables, the voice mail and email states occupy the two columns at left, and the resulting sync action is in the column at right.

<table>
<thead>
<tr>
<th>Voice Mail State</th>
<th>Email State</th>
<th>Sync Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleted</td>
<td>Not Deleted</td>
<td>Delete Email</td>
</tr>
<tr>
<td>Heard</td>
<td>Unread</td>
<td>Mark Email Read</td>
</tr>
<tr>
<td>All other states</td>
<td>Any state</td>
<td>No action</td>
</tr>
</tbody>
</table>
Synchronization during Normal Operation

Synchronization during normal operation is triggered when a user makes a change to a voice mail or email. In Table 65 and Table 66, the voice mail change is in the left column, and the consequence for the voice mail or email is in the right column.

Table 64: Start-up Synchronization with WAV File Attachment

<table>
<thead>
<tr>
<th>Voice Mail State</th>
<th>Email State</th>
<th>Sync Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heard</td>
<td>Unread</td>
<td>Email Read</td>
</tr>
<tr>
<td>Unheard</td>
<td>Read</td>
<td>Mark Voice Mail Heard</td>
</tr>
<tr>
<td>Deleted</td>
<td>Not Deleted</td>
<td>Delete Email</td>
</tr>
<tr>
<td>Not Deleted</td>
<td>Deleted</td>
<td>Delete Voice Mail</td>
</tr>
</tbody>
</table>

Table 65: Sync with Email-only Text during Normal Operation

<table>
<thead>
<tr>
<th>Event</th>
<th>Sync Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voicemail is deleted.</td>
<td>Delete email.</td>
</tr>
<tr>
<td>Voicemail is heard</td>
<td>Mark email as read.</td>
</tr>
<tr>
<td>All other events.</td>
<td>No sync action.</td>
</tr>
</tbody>
</table>

Table 66: Sync with WAV File Attachment during Normal Operation

<table>
<thead>
<tr>
<th>Event</th>
<th>Sync Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voicemail is deleted.</td>
<td>Delete email.</td>
</tr>
<tr>
<td>Voicemail is heard</td>
<td>Mark email as read.</td>
</tr>
<tr>
<td>Voicemail is undeleted.</td>
<td>Move email to Inbox. Mark email as unread if voice mail is unheard.</td>
</tr>
<tr>
<td>Voicemail is marked unheard.</td>
<td>Mark email as unread if voicemail is in “NEW” folder.</td>
</tr>
<tr>
<td>Email is deleted.</td>
<td>Delete voicemail.</td>
</tr>
<tr>
<td>Email is read.</td>
<td>Mark voicemail as heard.</td>
</tr>
<tr>
<td>Email is undeleted.</td>
<td>Move voicemail to “Saved” folder.</td>
</tr>
<tr>
<td>Email is marked unread.</td>
<td>Mark voicemail as unread if email is not in “Trash” folder.</td>
</tr>
</tbody>
</table>
Usage of Network Resources

Before setting up this feature, consider its use of network resources as described in this section.

The ShoreTel system monitors the state of all user messages so that, for example, when a voice message is heard, the system reflects the state change in a timely manner. To ensure timely updates to the status of all messages, the system uses network bandwidth in proportion to the number of messages.

For example, consider a ShoreTel deployment that supports 1000 users and that each user has 5 messages. The state of 5000 messages total is monitored by the ShoreTel system. For monitoring the state of 5000 messages, the required bandwidth is 75 Kbytes per second. In this scenario, the time to synchronize a message’s state change between voice mail and email is less than 20 seconds.

In the event of a server restart, the initial synchronization time for a system with up to 1000 users is less than 3 minutes.

Synchronization Criteria

Synchronization is automatically enabled for a user if both of the following are true:

1. The user is configured to receive email notifications. The email address must be that of the user’s Premier/Education Gmail account.

2. The system administrator configured an email server with the domain for the user’s email address by using OAuth2 consumer key and secret strings. For example, the system administrator configured OAuth2 access with the domain for the user’s email address. Refer to Google OAuth2 Configuration on page 504 and ShoreTel Director Configuration on page 505 for more information.

Use of the OAuth2 Protocol

The OAuth2 protocol lets a 3rd party gain access to a user’s account without needing the user’s password. By relying on OAuth2, the ShoreTel-VmEmSync service can use the IMAP4 AUTHENTICATE command to examine a user’s email without logging in as the user. Gmail and most Google APIs support OAuth2.

For the Premier and Education versions of Gmail, OAuth2 is set up by the system administrator. The administrator enables certain capabilities and acquires a system-generated private key at the Google OAuth2 management web page. The system administrator must first perform these actions in the applicable Google page before providing access to all accounts on a domain. An example of the Google Apps web page appears in Figure 174. In Figure 174, the machine-generated OAuth2 consumer secret is the value that the admin copies to a new Gmail configuration area of Director.

The private key from Google OAuth2 management and the client email allow the ShoreTel HQ server or DVS to:

- Authenticate with Google mail servers without needing the user passwords.
- Establish a trusted host relationship between the two servers.
Configuration

This section describes how to set up this feature and provides some prerequisite information.

ShoreTel synchronization with Gmail Premier and Education Services utilizes a Google Apps OAuth2 email and private key. The origins of the email and private key are described in the Google OAuth2 Configuration and ShoreTel Director Configuration sections.

Google OAuth2 Configuration

For information on how to create and grant permissions to the service account, refer the Using OAuth 2.0 for Server to Server Applications web page from the Google website.

Creating Service Accounts

To create a service account, you must perform the steps that are provided in the Creating a service account section on the Using OAuth 2.0 for Server to Server Applications page.

Tip
To navigate to the section, scroll down the web page. Alternately, you can click the Creating a service account link that is provided in the Contents section, which is at the right of the page.

Note
In the Service Account window, you must perform the following tasks:

- Ensure that JSON is selected as the key type.
- Select Enable Google Apps Domain-wide Delegation option to grant Google Apps domain-wide authority to the service account.

Tip
To navigate to the section, scroll down the web page. Alternately, you can click the Delegating domain-wide authority to the service account link that is provided in the Contents section, which is at the right of the page.
ShoreTel Director Configuration

An existing Director page has a new area for setting up Synchronization with Gmail for Business. The page is System Parameters – Edit Other Parameters, and the new area is labeled Gmail Configuration, as Figure 174 shows.

Figure 174: New System Parameters - Edit Other Parameters Fields

Complete the following steps to activate the feature in ShoreTel Director:

1. Open Edit Other Parameters by navigating to Administration > System Parameters > Other.

2. Enter the OAuth2 client email specified in the downloaded JSON file in the box labeled Client Email.

3. Enter the private key specified in the downloaded JSON file in the box labeled Private Key.

4. Enter the premier or educational Gmail account domain name in the box labeled Domain Name.

5. Click the Save button at the top of the Edit Other Parameters window.

Note
In the One or More API Scopes field, you must enter https://mail.google.com/ to synchronize user's voice mail with their Gmail account.
CHAPTER 14

Configuring the Auto Attendant

This chapter describes how to configure the auto attendant in the following sections:

Overview ................................................................................................................. 508
Multiple Auto Attendants ......................................................................................... 508
Menus ..................................................................................................................... 508
  Adding and Editing an Auto-Attendant Menu .................................................... 509
  Configuring an Auto-Attendant Menu ............................................................... 515
Overview

An auto attendant is a program that answers and handles inbound calls without human intervention. Auto attendants typically provide menu-driven options through which callers can obtain information, perform tasks, or connect to a requested extension.

The auto attendant can answer incoming calls and transfer a caller to an extension, a mailbox, another menu, a workgroup, or a route point. It also includes a dial-by-name feature that transfers callers to the system directory, where they can connect to an extension by dialing the user’s name.

Multiple Auto Attendants

Multiple auto attendants can be configured for different user groups or departments, and each auto attendant configuration can have multiple levels of menu options.

There are no hard limits to the number of auto attendants that can be configured in a ShoreTel system. However, in most installations, the system can support up to 500 auto-attendant menus. This number may be affected by the complexity of your dialing plan.

When the main auto attendant is reached, it provides options for forwarding calls to individual user extensions. It can also provide options for forwarding calls to the sales department and customer operations department auto attendants. From the sales or customer operations auto attendants, callers are given options that transfer calls to the appropriate extension.

The dial-by-name operation of the auto attendant can be limited to a department or other organizational sub-group by associating the operation with an extension list. To create extension lists, refer to Extension Lists on page 387. Only users that have been selected to be included in the dial-by-name list will be included. For more information, refer to Configuring a User Account on page 354.

When callers are transferred back to the auto attendant, either willingly or because of an error, they are returned to the default auto attendant menu on the associated server.

Menus

The auto attendant Menus page is where you begin the configuration to add a new auto attendant menu or edit an existing menu.
Adding and Editing an Auto-Attendant Menu

To add a new or edit an existing auto-attendant menu, invoke the Menus page. From the Menus page, click Add new, or click an existing menu name in the Name column. This invokes the Edit Menu page, as shown in Figure 176.

Table 67: Auto Attendant Menu Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name of an existing auto-attendant menu configuration. Clicking an auto attendant invokes the Menus edit page.</td>
</tr>
<tr>
<td>Extension</td>
<td>This is the extension that is associated with an existing auto-attendant menu.</td>
</tr>
<tr>
<td>On-Hours</td>
<td>This is the name of the On-Hours schedule, if any, that is associated with an existing auto-attendant menu.</td>
</tr>
<tr>
<td>Holiday</td>
<td>This is the name of the Holiday schedule, if any, that is associated with an existing auto-attendant menu named in the Name column.</td>
</tr>
<tr>
<td>Custom</td>
<td>This is the name of the Custom schedule, if any, that is associated with an existing auto-attendant menu.</td>
</tr>
</tbody>
</table>
Figure 176: Edit Menu Page

Table 68: Auto Attendant Menu Edit Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Name</td>
<td>This is the name of the auto-attendant menu.</td>
</tr>
<tr>
<td>Extension</td>
<td>This is the extension number associated with the auto-attendant menu. It must fall between the first and last menu numbers defined on the Dialing Plan edit page under System Parameters. Refer to Setting Dial Plan Parameters on page 43.</td>
</tr>
</tbody>
</table>
### Table 68: Auto Attendant Menu Edit Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DID</strong></td>
<td>When the check box is selected, a DID number is used to access the associated auto-attendant menu. If you are adding a new menu or editing an existing menu and you want to access it using a DID number, check this box and enter a DID number in the accompanying text-entry field. Refer to Assigning DID Numbers from a Range on page 179 for additional information about DID numbers and ranges.</td>
</tr>
<tr>
<td><strong>DNIS</strong></td>
<td>Click this link to set up one or more DNIS mappings to this menu. For more information about DNIS, refer to Editing the DNIS Digit Map on page 180.</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>This is the name of the Custom schedule, if any, that is associated with an existing auto-attendant menu.</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>Select a language from the drop-down list. This is the language that will be used by the auto-attendant menu for responses such as “invalid entry.” Greetings must be recorded in this language.</td>
</tr>
<tr>
<td><strong>Make Number Private</strong></td>
<td>Checking this box removes this number from the system directory and call handling destination lists.</td>
</tr>
<tr>
<td><strong>Allow Prompt Recording Using Telephone</strong></td>
<td>Select this check box to enable the User Recording of Auto-Attendant Menus via the menu mailbox. User recording of auto-attendant menus allows end users to dial into the system to record auto attendant prompts in the same way that they would change their personal mailbox greeting, for example modifying the greeting without having to access the recording interface through ShoreTel Director. This frees the system administrator from the task of recording auto attendant menus, allowing him or her to delegate the task to more appropriate team members.</td>
</tr>
<tr>
<td><strong>Menu Password</strong></td>
<td>A separate Menu Mailbox is created for each auto attendant menu, allowing users to dial into the system to change the menu prompts. Each auto attendant menu may have its own password and a unique, dialable number. If a password is desired, enter the password in the field provided, and enter it a second time to confirm.</td>
</tr>
</tbody>
</table>
### Table 68: Auto Attendant Menu Edit Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On-Hours / Off-Hours / Holiday / Custom</strong></td>
<td>These are the operating modes for a new or existing auto-attendant menu. You can configure them for different situations. Click the appropriate link to view the schedules. Schedules are set using the Schedules link. See Chapter 15, Configuring Schedules on page 519.</td>
</tr>
<tr>
<td></td>
<td>■ On-Hours mode lets you configure the auto attendant to handle incoming calls during regular office hours.</td>
</tr>
<tr>
<td></td>
<td>■ Off-Hours mode covers all hours not scheduled in other modes. This is typically when the office is closed for the evening and weekend.</td>
</tr>
<tr>
<td></td>
<td>■ Holiday mode lets you configure how the auto attendant functions on holidays.</td>
</tr>
<tr>
<td></td>
<td>■ Custom mode is used for single days that are not covered by the other modes such as a company special event.</td>
</tr>
<tr>
<td><strong>Disable Monitor/Recording Warning Tone</strong></td>
<td>This check box can be used to stop playing the warning tone for call recording and monitoring if the tone is turned on in the Call Control page. To see where the warning tone is first set, refer to the Call Control Options on page 310.</td>
</tr>
<tr>
<td></td>
<td>Before disabling the warning tone, you may wish to consult with legal counsel regarding your intended use.</td>
</tr>
<tr>
<td></td>
<td><strong>WARNING</strong>: ShoreTel, Inc. does not warrant or represent that your use of call monitoring or recording features of the Software will be in compliance with local, state, federal, or international laws that you may be subject to. ShoreTel, Inc. is not responsible for ensuring your compliance with all applicable laws.</td>
</tr>
<tr>
<td><strong>Timeout</strong></td>
<td>Set a timeout between 0-30000 milliseconds. This is the time the caller has to perform an action.</td>
</tr>
<tr>
<td><strong>Prompt Text</strong></td>
<td>Before recording a prompt for a new or existing auto-attendant menu, enter the text for the prompt in this field. This also provides a convenient record of your prompt if you should ever need to re-record the prompt.</td>
</tr>
<tr>
<td></td>
<td>This is an optional parameter.</td>
</tr>
<tr>
<td></td>
<td>Prompts on the ShoreTel system can be imported into the system using µ-law, WAV file format. If you would like your prompts to match the voice of the ShoreTel system, please contact Worldly Voices at <a href="http://www.worldlyvoices.com">www.worldlyvoices.com</a> and request that “Connie” record your prompts. Worldly Voices provides this service with a rapid turnaround time for a nominal fee.</td>
</tr>
</tbody>
</table>
Table 68: Auto Attendant Menu Edit Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>The Record, Play, Erase, and Import buttons associated with this parameter are used to record your auto-attendant menu prompt. Click Record to record the prompt; Play to play it back; Erase to erase the prompt; and Import to import a prerecorded prompt from a sound file.</td>
</tr>
<tr>
<td>Schedule</td>
<td>This drop-down list shows the auto attendant schedules: On-Hours, Off-Hours, Holiday, and Custom. Select a schedule from this list and click Go to this schedule to invoke the schedule so that you can configure a new or existing auto-attendant menu’s schedule. See Chapter 15, Configuring Schedules on page 519, for information about setting up schedules.</td>
</tr>
</tbody>
</table>
Adding and Editing an Auto-Attendant Menu

**Table 68: Auto Attendant Menu Edit Parameters (Continued)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>Each item in the Operation drop-down list lets you select the action that is associated with its dialpad number. This number is located to the left of each Operation drop-down list. When prompted by the auto attendant, the caller is asked to enter this number.</td>
</tr>
<tr>
<td></td>
<td>- Dial by first name lets the caller spell the user’s first name from the dialpad. The auto attendant then transfers the caller to the user’s extension. To limit the dial list to a department or other organizational sub-group, select an extension list from the Ext column.</td>
</tr>
<tr>
<td></td>
<td>- Dial by last name lets the caller spell the user’s last name from the dialpad. The auto attendant then transfers the caller to the user’s extension. To limit the dial list to a department or other organizational sub-group, select an extension list from the Ext column.</td>
</tr>
<tr>
<td></td>
<td>- Go to extension lets the user enter the extension he needs. This functions the same as a transfer but without a voice prompt.</td>
</tr>
<tr>
<td></td>
<td>- Go to menu transfers the caller directly to the user’s mailbox without ringing the user’s extension. This is also used to send the caller to another menu. You must select the destination from the extension (Ext) pop-up dialog box.</td>
</tr>
<tr>
<td></td>
<td>- Hang up lets the caller disconnect the call.</td>
</tr>
<tr>
<td></td>
<td>- Repeat prompt lets the user hear the prompt again.</td>
</tr>
<tr>
<td></td>
<td>- Take a message lets the caller leave a message by selecting a user’s extension.</td>
</tr>
<tr>
<td></td>
<td>- Take a message by first name lets the caller leave a message by selecting a user’s name from the menu.</td>
</tr>
<tr>
<td></td>
<td>- Take a message by last name lets the caller leave a message by selecting a user’s name from the menu.</td>
</tr>
<tr>
<td></td>
<td>- Transfer to extension transfers the caller to the user’s extension where he or she can speak with the user or leave a message if the user does not answer. You must select a destination from the extension pop-up dialog box.</td>
</tr>
<tr>
<td></td>
<td>- Dial by last name is supported by default.</td>
</tr>
<tr>
<td>Ext</td>
<td>This pop-up dialog box lets you select the destination that is associated with the Go to Menu or Transfer to extension operation.</td>
</tr>
<tr>
<td></td>
<td>Used this field to select an extension list to be used by the Dial by First Name and Dial by last Name operations.</td>
</tr>
</tbody>
</table>
Configuring an Auto-Attendant Menu

Complete the following steps to configure an auto attendant menu from the Menus page:

1. Enter the name of the menu in the **Menu Name** field.

2. If this is a new menu, enter the menu extension in the **Number** field. If you are editing an existing menu, enter a new extension in this field if necessary.

3. If the menu will be associated with a DID number, check the **DID** check box and enter the DID number in the DID text-entry field.

4. To associate the menu with a DNIS number, click **Edit DNIS Map** and set the map.

5. Make **Number Private** to remove the number from the system directory.

6. Select the **Allow Prompt Recording Using Telephone** check box to enable the User Recording of auto attendant menus, and enter and confirm a password for the associated mailbox.

7. Click the auto attendant mode — On-Hours, Off-Hours, Holiday, or Custom — to associate with the menu.

---

### Table 68: Auto Attendant Menu Edit Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Out</td>
<td>This drop-down list lets you specify the action that the auto attendant takes when the caller does not press a dialpad key in a system-defined period of time. Typically, the action is Repeat Prompt.</td>
</tr>
<tr>
<td>Too Many Errors</td>
<td>This drop-down list lets you specify the action that the auto attendant takes when the caller presses an invalid key too many times in a row. You might specify a user extension, such as the operator, for this. Typically, the action is Hang Up. If no action is specified, Hang Up is invoked by default.</td>
</tr>
<tr>
<td>Invalid Entry</td>
<td>This drop-down list selects an action to take when a key is pressed that the auto attendant does not recognize. Typically, the action is Repeat Prompt.</td>
</tr>
</tbody>
</table>
| Multiple-Digit    | This drop-down list lets you select a multiple-digit action that the caller takes. The choices are None, Transfer to Extension, Take a Message, Go to Extension, and Go to Menu. The default is None.  
  - None assigns no multiple-digit operation to the menu.  
  - Transfer to Extension assigns a multiple-digit operation to the menu and prompts the caller to dial directly into a user's extension.  
  - Go to Menu assigns a multiple-digit operation to the menu and prompts the caller to dial directly into a user's mailbox. |
8. Set a **Timeout**.

9. Enter the text that you will use for recording the menu’s prompt in the **Prompt Text** field. This is optional.

10. Do one of the following:
    - Click **Record** to record the prompt.
    - Click **Play** to hear the prompt.
    - Click **Erase** to erase it.
    - Click **Import** and select the file from the appropriate directory to import a prerecorded prompt from a WAV file.

11. Select a schedule for this menu from the **Schedule** drop-down list, and click **Go to this schedule**. See Chapter 15, Configuring Schedules on page 519 for information about schedules.

12. Select the action that the auto attendant takes in response to each supported digit from the **Operation** drop-down list.

13. Assign an extension to the **Operation**, if applicable, from the extension (Ext) pop-up dialog box.

14. Select an action from the **Time out** drop-down list, and select an extension from its extension pop-up dialog, if applicable.

![Figure 177: Timeout Errors Drop-Down List](image)

15. Select an action from the **Too many errors** drop-down list and select an extension from its extension pop-up dialog box, if applicable.

![Figure 178: Too Many Errors Drop-Down List](image)

16. Select an action from the **Invalid entry** drop-down list, and select an extension from its extension pop-up dialog box, if applicable. The options are the same as are available in the **Timeout** pop-up.

17. Select an action from the **Multiple digits** drop-down list.
Configuring an Auto-Attendant Menu

Configuring the Auto Attendant

Configuring Multiple Auto Attendant Menus

Configuring multiple auto-attendant menus lets you add menus to your main menu so that callers can be directed to other departments in your company.

Complete the following steps to add multiple auto-attendant menus to your main menu:

1. Go to the Menus page and configure the menu you are adding to the main auto-attendant menu, as described in the Adding and Editing an Auto-Attendant Menu on page 509.

2. Go back to the main auto-attendant menu’s configuration on the Menu edit page.

3. Go to the Operations section on the Menu edit page and select Go to menu.

4. Associate the menu you are adding with a digit and the menu’s extension. For example, if the menu’s extension is 503, select this number from the Ext. drop-down list.

5. Click Save so that your changes are recorded.

You can define the auto attendant schedule when configuring an auto-attendant menu from the Menus page or by invoking the Schedules link. Refer to Chapter 15, Configuring Schedules on page 519 for information about establishing schedules.

The following schedule pages can be edited from the Menus page or from the Schedules link:

- On-Hours
- Holiday
- Custom

With the exception of the Off-Hours mode, each mode has a schedule configuration page. Off-hours is equal to all time not entered in the other schedules.

The following logic determines which schedule is active:

1. The auto attendant first looks for the Custom schedule.

2. If the Custom schedule is not available, the auto attendant looks for the Holiday schedule.

3. If the Custom or Holiday schedule is not available, the auto attendant looks for the On-Hours schedule.

4. If the Custom, Holiday, or On-Hours schedule is not available, the auto attendant looks for the Off-Hours schedule.

18. Click Save to save the configuration.
ShoreTel Director forms the Off-Hours schedule from all the hours not scheduled in the other modes. If you do not create a schedule for at least one of the other modes, the On-Hours schedule will be all possible hours.
This chapter describes how to create schedules for the ShoreTel system in the following sections:

Overview ......................................................................................................................... 520
Accessing the Scheduling Page .............................................................................. 520
Configuring the On-Hours Schedule ....................................................................... 521
Holiday Schedule ..................................................................................................... 523
  Configuring the Holiday Schedule ................................................................. 524
Custom Schedule ................................................................................................... 524
  Configuring a Custom Schedule ................................................................. 525
Overview

Schedules let you to define business hours and can facilitate proper routing of inbound calls. Schedules can be used by Hunt Groups and by the auto attendant.

The ShoreTel system supports the following types of schedules:

- On-Hours
- Holiday
- Custom
- Off-Hours

Hours for on-hour and custom schedules are configurable. Holiday schedules let you identify the days when your organization is otherwise not open for business. Off-hours are considered all time that is not entered in the other schedules.

The following logic determines which schedule is active:

1. The auto attendant first looks for the Custom schedule.
2. If the Custom schedule is not available, the auto attendant or hunt group looks for the Holiday schedule.
3. If the Custom or Holiday schedule is not available, the auto attendant or hunt group looks for the On-Hours schedule.
4. If the Custom, Holiday, or On-Hours schedule is not available, the auto attendant or hunt group looks for the Off-Hours schedule.

ShoreTel Director forms the Off-Hours schedule from all the hours not scheduled in the other modes. If you do not create a schedule for at least one of the other modes, the Off-Hours schedule will be all possible hours.

Accessing the Scheduling Page

Complete the following steps to access the scheduling page:

1. Launch ShoreTel Director.
2. Click Administration > Schedules. The Schedules page appears as shown in Figure 180.
Configuring the On-Hours Schedule

Complete the following steps to configure the On-Hours schedule:

1. Launch ShoreTel Director.

2. Click Administration > Schedules. The Schedules page appears.

3. In On-Hours section in the Name column, click On-Hours to modify the existing schedule. You can also click Add new under the On-Hours heading to create a new on-hours schedule. The Edit On-Hours Schedule page appears as shown in Figure 181.
4. Create hour blocks by clicking in the hour slot for the start-time of a work day and drag the mouse to the end-time for block that day. Right-click to save.

5. Repeat step 4 for each workday. You can modify time frames on the fly by right clicking to display the options shown in Figure 182.

---

The options include the following:

- Click Fill Week to populate the other days of the week with the same schedule.
- Click **Edit** to edit the selected time block.
- Click **Delete** to remove the selected time block.

If you want to change the entire schedule, you must delete all entries in the schedule; otherwise, duplicate entries will be made.

6. Click **Save** to save the schedule in the database.

You can schedule a mode to start and stop multiple times in one day. For example, on Monday, you can set the schedule to start at 4:30 am and stop at 9:00 am, and then schedule it to resume at 2:00 pm until 5:30 pm by performing steps 4 and 5 again.

## Holiday Schedule

The Holiday Schedule edit page is shown in **Figure 183**.

![Figure 183: Holiday Schedule Edit Page](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule Name</td>
<td>Displays the name of a new or existing Holiday schedule. You can enter a name in this field for a new schedule or edit it for an existing Holiday schedule.</td>
</tr>
<tr>
<td>Holidays – Add New Item</td>
<td>Click Add New Item to add a new holiday to the schedule; the Holiday Name and Date text-entry fields are added to the Holiday Schedule edit page.</td>
</tr>
<tr>
<td>Holiday Name, Date</td>
<td>This lets you enter a name and date for a new Holiday schedule. The date format is MM/DD or MM/DD/YY. Not entering a value for the year will repeat the same month and day throughout year.</td>
</tr>
</tbody>
</table>
Configuring the Holiday Schedule

1. Select a holiday from the **Schedule Name** drop-down list or add a new one by clicking **Add New** and entering a name and date in the **Holiday Name** and **Date** text-entry fields.

2. Repeat step 1 for all known holidays.

3. To delete a holiday from the schedule, click **Delete Item**.

4. Click **Save** to save the Holiday schedule to the database.

Custom Schedule

The Custom Schedule edit page is shown in **Figure 184**.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule Name</td>
<td>This displays the name of a new or existing Custom schedule. You can enter</td>
</tr>
<tr>
<td></td>
<td>a name in this field for a new schedule or edit it for an existing Custom</td>
</tr>
<tr>
<td></td>
<td>schedule.</td>
</tr>
<tr>
<td>Custom Ranges – Add New</td>
<td>Click Add New to add a new Custom schedule; the Custom Name, Date, Start</td>
</tr>
<tr>
<td></td>
<td>Time, and End Time text-entry fields are added to the Edit Custom Schedule</td>
</tr>
<tr>
<td></td>
<td>page.</td>
</tr>
<tr>
<td>Custom Name</td>
<td>This displays the name of a Custom schedule. Enter the name of a new</td>
</tr>
<tr>
<td></td>
<td>Custom schedule or edit the name of an existing schedule in this field.</td>
</tr>
<tr>
<td>Date</td>
<td>This displays the date when a Custom schedule is used. Enter the date of</td>
</tr>
<tr>
<td></td>
<td>an existing schedule in this field. The format is MM/DD or MM/DD/YYYY.</td>
</tr>
<tr>
<td></td>
<td>Not entering a value for the year will repeat the same month and day every</td>
</tr>
<tr>
<td></td>
<td>year.</td>
</tr>
</tbody>
</table>
1. Select a holiday from the Schedule Name drop-down list or add a new one by clicking Add New and entering a name and date for the new holiday in the Custom Name and Date text-entry fields.

2. Enter a start time in the Start Time field.

3. Enter an end time in the End Time field.

4. To delete a custom range, click Delete Item.

5. Click Save to save the Custom schedule to the database.
This chapter describes how to configure the Workgroup feature in the following sections:

Overview ................................................................. 528
Call Routing for Workgroups ........................................ 528
Call Distribution ...................................................... 528
Call Queuing .............................................................. 529
Workgroup Communicator ........................................... 530
Reporting on Workgroups .......................................... 531
Workgroup Description ............................................. 531
Workgroups List Page ............................................ 532
The Workgroup Configuration Parameters .................. 533
Selecting a DNIS Trunk Group for DNIS Routing .......... 540
Editing Workgroup Membership ................................ 541
Navigating the Workgroup Membership Edit Page ........ 542
Adding or Removing an Agent from a Workgroup ........ 542
Changing the Member Position to Affect Selection ........ 543
Changing an Agent’s Status or Access License ............. 543
Configuring the Behavior of the Call Queue ................. 544
Introduction to Specifying the Call Queue .................. 544
Definitions of Call Queue Parameters ....................... 546
Specifying Call Queue Behavior for a Workgroup ......... 549
Computing the Wait Time that a Caller Hears ............. 554
Distributed Workgroups .......................................... 555
How Hunt Groups Facilitate Multi-site Workgroups ....... 556
Configuring a Distributed Workgroup ....................... 560
Important Considerations for Distributed Workgroups .... 565
Overview

This section summarizes the capabilities of the Workgroups feature. Subsequent sections define the configurable parameters in Director and the configuration tasks for different functional areas and applications of the Workgroups.

A workgroup is a group of agents that receives and distributes incoming calls to the members of the group. In a large enterprise, a workgroup can function as a small to medium-sized contact center. The ShoreTel Workgroup feature has the ability to provide the following functionality:

- Distribute calls to workgroups and place calls in wait-queues as needed
- Support a maximum of 300 workgroup agents and supervisors
- Report on workgroup activity

Among its possible uses, a workgroup can function as a contact center. With an upper limit of 300 workgroup agents, including supervisors, any number above 300 members means the customer needs to consider using ShoreTel's Enterprise Contact Center (ECC) solution. In addition to supporting many more agents, ECC's extensive capabilities make it the superior solution for a contact center. ECC supports outbound contact center calling, email integration, chat integration, and customizable reporting that can be historical or real-time.

Call Routing for Workgroups

In general, callers reach a workgroup through one of the following routes:

- By calling through a dedicated trunk that connects at the site
- By calling a Direct Inward Dialing (DID) number or Dialed Number Information Services (DNIS) number directed to the workgroup
- Through an auto attendant menu
- An internal extension

Call Distribution

The Workgroups feature has flexible boundaries for distributing calls to a workgroup. If inbound calls reach excessive levels or stay in the call-waiting queue too long, the system can send a warning to the workgroup. The system administrator defines these thresholds.

ShoreTel's implementation of Automatic Call Distribution (ACD) supports four configurable patterns for distributing inbound calls to agents in a workgroup. When no agent is available, calls can go to a voice mailbox for the workgroup, which all agents can access, or to a queue where calls wait until an agent is available.

The following is a summary of the call distribution and call overflow options:

- Round Robin, in which each call goes to the next available agent in the workgroup
- Top Down, in which each search for an agent always starts at the beginning of the workgroup membership list
- Longest Idle, in which the call goes to the agent who has been idle the longest
- Simultaneous, in which all phones ring at once — all agents receive the call simultaneously — useful if agents are far apart, such as when agents work on different floors of a building

Distribution of the inbound calls depends on the status of the agents. An agent’s status can be logged-in, logged-out, or wrap-up. When agents are ready to start receiving calls, they log in. When they complete their day or are otherwise unavailable, agents log out. The other possible status is wrap-up. This status is a configurable amount of time after a call that lets the agent perform a wrap-up task, such as entering information about the call. During wrapup, agents remain logged in but do not receive new calls.

The call overflow options are as follows:
- Hold calls in the queue until an agent is available
- Transfer calls to another workgroup, extension, or external number
- Transfer calls to the shared mailbox for the workgroup.

**Note**
For transferring workgroup queue calls to call forwarding logged out destination when all the agents are logged out, the following registry key must be created and set to 1.

```
HKEY_LOCAL_MACHINE\SOFTWARE\Shoreline Teleworks\WGSvc type REG_DWORD
EnableAllAgentsLoggedOutTransfer = 1.
```

**Call Queuing**

The call queue configuration gives additional flexibility to the administrator of the workgroup for managing the call flow. Regardless of agents’ status, an incoming call can enter a queue where it remains until an agent takes the call. The queue offers up to five configurable steps. The configuration for each step can uniquely specify different caller interactions and also let the caller select the routing of the call.

The following sections summarize the call-queuing options.

**Queue Step Configuration Options**
- Announce the caller’s estimated wait time
- Record a menu of transfer options to callers, which is mandatory for queued calls

**Supported Menu Functions**
- Customer inputs: 0–9, *, #
- Transfers to menus, extensions, or mailboxes
- Repeat prompts or terminate the call

**Call Queue Control Options**

- The Step configuration permits skipping of up to four of the five Steps. For more information about the call queue steps, refer to *Introduction to Specifying the Call Queue* on page 544 and *Definitions of Call Queue Parameters* on page 546.

- Callers are on hold between steps for a configurable amount of time

- The Final Step repeats until an agent takes the call or the call overflows. Skipping the Final Step is not possible.

**Other Features**

Callers hear the main site's music on-hold (MOH) while they are waiting.

**Workgroup Communicator**

The ShoreTel Communicator application provides the call-related information that contact center representatives need. ShoreTel Communicator also provides point-and-click control of voice communication with callers and a large number of customizable buttons whose functions are specific to workgroups.

ShoreTel Communicator provides real-time call information such as Caller ID, call duration, and call states to agents and supervisors. A call's detailed routing information also appears globally so that agents know about every other employee in the enterprise with whom the current caller spoke before reaching the contact center. Additionally, the contact center's mailbox appears to every agent for accessing and helping a caller who chooses to leave a message rather than wait for an agent.

Agents and supervisors have access to the real-time Queue Monitor function. This function provides current information on the activities of the contact center queue. It displays the number of callers, information about each caller, and the time callers have been waiting.

The Agent Monitor lets the supervisor manage the workgroup agents. It lets the supervisor see the current login status of all agents and the state of the agents’ call involvement. Agent Monitor also lets the supervisor change the status of any agent.

The following sections summarize the workgroup Communicator features.

**Communicator Applications**

- Display Caller ID, call duration, and call state
- Display detailed routing information for calls
- Display and access the shared contact center voice messages
- Provide point-and-click access to the system’s call handling features
- Log in and log out of the workgroup call flow
**Real-time Queue Monitor**

- Display a summary of the number of callers waiting and the longest wait time
- Show a detailed view of the information about each waiting call
- Display warnings when the number of calls or longest wait time exceeds the supervisor’s thresholds
- Display or control the call handling mode

**Supervisor’s Agent Monitor**

- Display the current login status of the agents in the workgroup
- Show whether agents are on a call and how long they have been talking
- Control agent’s login status from the supervisor’s position

**Reporting on Workgroups**

As calls arrive and workgroup members take those calls, the system generates data that go into Call Detail Reports. This information can help a supervisor manage the call flows and workgroup resources. The log for each call shows the following information:

- How long the call stayed in the queue
- How it ended
- Which agent took the call
- How long the call lasted

The following reports are available at the ShoreTel server:

- Queue Summary Report
- Agent Summary Report
- Agent Detail Report

See Appendix B, Call Detail Record Reports for information about workgroup reports.

**Workgroup Description**

A workgroup is a logical group of agents that uses Automatic Call Distribution (ACD) to receive and distribute incoming calls among the members of the workgroup. A workgroup member is just an employee whose name is in the list of workgroup members. Each workgroup has a configurable assignment of an extension, mailbox, and other parameters.
By using a unique extension for each workgroup, the ACD system sends inbound calls to the correct workgroup. When a call enters a workgroup, software locates an available agent. The choice of available agent depends on the call distribution pattern that the system administrator has selected for the workgroup.

ShoreTel Director supports the creation of the following:

- A maximum of 256 workgroups
- A maximum of 300 members and supervisors on a system

The Workgroups List page in ShoreTel Director shows all of the workgroups in the system.

**Workgroups List Page**

To see the list of workgroups, click the Workgroups link in the navigation frame. Refer to Figure 185 for an example. On this page, you can create a workgroup or edit an existing workgroup.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name of the workgroup.</td>
</tr>
<tr>
<td>Extension</td>
<td>This is the workgroup extension.</td>
</tr>
<tr>
<td>Agents</td>
<td>This value is the number of agents in the workgroup.</td>
</tr>
<tr>
<td></td>
<td>The maximum number of agents for a ShoreTel system is 300, and 1 workgroup can have this maximum. However, an individual workgroup can have a much lower maximum if the group has a particular function enable from the workgroup’s Class of Service, which is Additional Phones to Ring Simultaneously and to Move Calls. If the group’s COS has this enable, the maximum is 16. Agents can belong to multiple workgroups. For example, an agent can belong to a group whose COS has this enable and to other groups that do not have this enable.</td>
</tr>
<tr>
<td>On-Hours</td>
<td>Each workgroup can have an On-hours schedule.</td>
</tr>
</tbody>
</table>
The Workgroup Configuration Parameters

This section defines the parameters of a workgroup. The two subsections describe the general configuration parameters and the specifics of call handling. Refer to Configuring the Behavior of the Call Queue on page 544 and Distributed Workgroups on page 555 for more detailed information about workgroup configuration.

General Parameters

Figure 186 shows the upper half of the Workgroup Edit page for general configuration parameters.

Table 72: General Workgroup Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>(Required) Each workgroup must have a name.</td>
</tr>
<tr>
<td>Extension</td>
<td>(Required) Each workgroup must have a unique extension number. A ShoreTel system can support up to 256 workgroup extensions.</td>
</tr>
</tbody>
</table>
| Backup Extension| (Required) The backup extension of the workgroup supports back-up call routing in case of failures. This extension can be a hunt group, another workgroup, an agent's extension, or auto attendant. If the workgroup does not answer after the specified number of rings because of a system malfunction such as an unavailable server or network problem, the call goes to this backup extension. The expected traffic volume can affect the level of resources to use for a backup extension:  
  - If the call volume is low, the backup extension can be that of an agent.  
  - If the call volume is high, ShoreTel recommends that these calls go to a must-answer line with a distinctive ring. Agents can use the call pickup feature to choose calls from the must-answer line if the workgroup server is unavailable. |
| Workgroup Server| This list is for selecting the server that hosts the workgroup.             |
| DID             | (Optional) Each workgroup can have one DID number. Refer to Assigning DID Numbers from a Range on page 179 for information about DID numbers and ranges. |
Table 72: General Workgroup Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNIS</td>
<td>(Optional) Clicking Edit DNIS Map opens the Select DNIS Trunk Group dialog box. This box lets you select a trunk group for DNIS routing. The typical use of DNIS is to route toll-free calls (800, 888, and similar numbers in the U.S.) to a workgroup or application. Only trunk groups with a DNIS configuration appear in the dialog box. The system allows multiple DNIS number assignments to a workgroup. See Selecting a DNIS Trunk Group for DNIS Routing on page 540.</td>
</tr>
<tr>
<td>User Group</td>
<td>(Required) The User Group drop-down list is for selecting a user group. The workgroup must inherit permissions from the User Groups COS because workgroups have access to some telephony features, such as Call Forward External, and some voice mail features, such as Incoming Message Length and Message Notification. See Creating a User Group on page 352 and Telephony Features Permissions on page 338. In addition, for users to have the Barge In, Record, or Monitor capabilities, they must belong to groups with the necessary permissions in their group’s COS.</td>
</tr>
<tr>
<td>Mailbox Server</td>
<td>(Optional) A workgroup can have a mailbox on its associated server. If the server with the mailbox changes, the ShoreTel system automatically moves all messages to the new server. Calls to a workgroup that go to voice mail eventually reside in the workgroup mailbox. All workgroup members who run the Workgroup Agent or Supervisor Communicator share the workgroup mailbox. In addition, group members can log into the workgroup’s mailbox over a telephone by using the mailbox number and voice mail password. In contrast, if the Workgroup transfers calls to an individual user, a voice mail ends up in that user’s mailbox.</td>
</tr>
<tr>
<td>Language</td>
<td>Select a language from the drop-down list. This is the language that the Auto-Attendant uses for the prompts that it plays to callers in the queue, such as “Your estimated wait time is . . . .”</td>
</tr>
<tr>
<td>Accept Broadcast Messages</td>
<td>(Optional) This lets the workgroup receive broadcast messages.</td>
</tr>
<tr>
<td>Include in System Dial By Name Directory</td>
<td>(Optional) Enabling this option puts the workgroup in the Auto-Attendant dial-by-name directory.</td>
</tr>
<tr>
<td>Make Number Private</td>
<td>Marking this check box removes this number from the system directory and call handling destination lists.</td>
</tr>
</tbody>
</table>
Recorded Name (Optional) The Record, Play, Enter, and Import buttons let you record a name for the workgroup, play it back, and so on. The system uses this name as a part of the default mailbox greeting. The Dial By Name directory also uses this recorded name.

You can use a plug-in microphone and speakers or a telephone to record or play the name. Refer to the Auto-Attendant options for details.

The Import button is for importing prompts from a folder. Prompts must be CCITT µ-Law, 8 KHz, 8-bit, mono WAV files. By using the system recorder and plug-in microphone, the recording automatically complies with these requirements.

Voice Mail Password (Required) The voice mail password for the workgroup works in conjunction with the mailbox number for logging agents into the workgroup mailbox over a telephone.

The initial default is “1234.” Passwords for voice mail are numbers only.

Enable Automatic Agent Logout On Ring No Answer (Optional) Marking this check box directs the system to log out agents who do not answer a workgroup call after a specified number of rings. The purpose of this function is to prevent calls from repeatedly being offered to an agent who has physically left the workgroup but has forgotten to log out.

Workgroup Membership (Required) The Edit Agents button activates the Workgroup Membership page. For the current workgroup, you can add or remove an agent. You can also change the call distribution pattern of agents in this page.

Workgroup Queue Handling (Required) Clicking the Edit Queue Handling button opens the Workgroup Queue Handling page for editing the actions for the call queue that the current workgroup owns. These actions are the configurable system responses to phone buttons that a waiting caller presses. For detailed information, see Configuring the Behavior of the Call Queue on page 544.

Wrap Up Time (Optional) Wrapup is the number of seconds an agent has to complete post-call tasks before the system presents another call. A wrap-up time of 0 disables wrapup — the agent has no time for wrapup.

Current Call Handling Mode The is a read-only display of the current call handling mode. It reflects the schedule in current use.

Table 72: General Workgroup Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorded Name</td>
<td>(Optional) The Record, Play, Enter, and Import buttons let you record a name for the workgroup, play it back, and so on. The system uses this name as a part of the default mailbox greeting. The Dial By Name directory also uses this recorded name. You can use a plug-in microphone and speakers or a telephone to record or play the name. Refer to the Auto-Attendant options for details. The Import button is for importing prompts from a folder. Prompts must be CCITT µ-Law, 8 KHz, 8-bit, mono WAV files. By using the system recorder and plug-in microphone, the recording automatically complies with these requirements.</td>
</tr>
<tr>
<td>Voice Mail Password</td>
<td>(Required) The voice mail password for the workgroup works in conjunction with the mailbox number for logging agents into the workgroup mailbox over a telephone. The initial default is “1234.” Passwords for voice mail are numbers only.</td>
</tr>
<tr>
<td>Enable Automatic Agent Logout On Ring No Answer</td>
<td>(Optional) Marking this check box directs the system to log out agents who do not answer a workgroup call after a specified number of rings. The purpose of this function is to prevent calls from repeatedly being offered to an agent who has physically left the workgroup but has forgotten to log out.</td>
</tr>
<tr>
<td>Workgroup Membership</td>
<td>(Required) The Edit Agents button activates the Workgroup Membership page. For the current workgroup, you can add or remove an agent. You can also change the call distribution pattern of agents in this page.</td>
</tr>
<tr>
<td>Workgroup Queue Handling</td>
<td>(Required) Clicking the Edit Queue Handling button opens the Workgroup Queue Handling page for editing the actions for the call queue that the current workgroup owns. These actions are the configurable system responses to phone buttons that a waiting caller presses. For detailed information, see Configuring the Behavior of the Call Queue on page 544.</td>
</tr>
<tr>
<td>Wrap Up Time</td>
<td>(Optional) Wrapup is the number of seconds an agent has to complete post-call tasks before the system presents another call. A wrap-up time of 0 disables wrapup — the agent has no time for wrapup.</td>
</tr>
<tr>
<td>Current Call Handling Mode</td>
<td>The is a read-only display of the current call handling mode. It reflects the schedule in current use.</td>
</tr>
</tbody>
</table>

ShoreTel 14.2 System Administration Guide 535
Note
If a system administrator changes the extension number of a workgroup that has a associated mailbox, the system retains the mail messages.

Note
In the current release, if Distributed Database is in operation, this scroll list is inactive (gray) because only the Headquarters server can host the workgroups.

Note
Broadcast messages usually go to non-workgroup lists of employees, so you probably will want to remove the workgroup from the broadcast list by clearing the **Accept Broadcast Messages** checkbox.

Call Handling

Table 73 includes the definitions for the parameters that appear in the lower half of the Workgroup Edit page. Refer to Figure 187 for an example of this page.
### Table 73: Lower Half Edit Page Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation Profile</td>
<td>Select an escalation profile from the drop-down list to associate it with the current workgroup. Refer to Configuring Escalation Notification on page 491 for details.</td>
</tr>
</tbody>
</table>
| Schedule                | (Optional) The schedules for the On-Hours, Off-hours, Holiday, and Custom modes can automatically change the workgroup’s call handling. With no schedule specifications at all, the system uses the On-Hours schedule. The rules for schedules are:  
  - If it is custom time, use Custom mode;  
  - If it is holiday time, use Holiday mode;  
  - If it is on-hours time, use On-Hours mode;  
  - Otherwise, use Off-Hours mode.  
  For the current schedule, such as On-hours, the Edit this schedule link is a quick way to navigate to schedule configuration in Director > Schedules. Clicking this link exits Workgroups and opens the Schedules page. For a description of schedules, refer to Chapter 15, Configuring Schedules on page 519. |
| Distribution Pattern    | (Required) This parameter specifies how ACD distributes calls to agents in the group when a call enters the ShoreTel network:  
  - With Top Down, ACD begins at the beginning of the active agent list and sequentially searches through the list until it finds an available agent.  
  - With Round Robin, ACD selects the next available agent in the list. The search begins after the agent that had the last call. If ACD does not find an available agent, it returns to the beginning of the membership to continue the search. With Longest Idle, the agent with the longest idle time gets the call.  
  - With Simultaneous, all available agents receive the call simultaneously. If the phones are ringing in a closed area, the sound can be disruptive. Therefore, a typical use for this selection setup is where the agents are somewhat separated physically, such as on different floors of a building. |
Call Forward

(Required) The radio buttons in the Call Forward area are for specifying when and where the system forwards a call. The initial specification for forwarding is either absolute — Always — or conditional — No Answer/Busy and Logged Out. The default is the conditional forwarding, No Answer/Busy and Logged Out. After the initial Call Forward choice, additional choices follow.

With the choice of absolute or conditional forwarding, the associated forwarding parameters, such as the destination, become active, while the parameters for the unselected forwarding become inactive.

With either the No Answer/Busy or Logged Out choice, the system forwards calls with the following conditions:

- To the No Answer Destination after the specified number of rings
- To the Busy Destination immediately if the user’s call stack is full

Always

With the Always selection, incoming calls immediately go to the specified destination. The destination is either an extension or an external number. If the choice is an external number, the required access code must be the first number in the text entry box. The typical access code is 9 or 8.

Busy

With the Busy option, if all agents are busy when a call arrives, the call can:

- Immediately go to the specified extension
- Immediately enter the call waiting queue
- Immediately go to an external number

Note: If the selected response is Queue, refer to Configuring the Behavior of the Call Queue on page 544 for more information.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Forward</td>
<td>(Required) The radio buttons in the Call Forward area are for specifying when and where the system forwards a call. The initial specification for forwarding is either absolute — Always — or conditional — No Answer/Busy and Logged Out. The default is the conditional forwarding, No Answer/Busy and Logged Out. After the initial Call Forward choice, additional choices follow. With the choice of absolute or conditional forwarding, the associated forwarding parameters, such as the destination, become active, while the parameters for the unselected forwarding become inactive. With either the No Answer/Busy or Logged Out choice, the system forwards calls with the following conditions: - To the No Answer Destination after the specified number of rings - To the Busy Destination immediately if the user’s call stack is full</td>
</tr>
</tbody>
</table>
No Answer

With No Answer, calls go to the forwarding destination after the specified number of rings in the No Answer Number of Rings box, which is at the bottom of the Call Handling area. After the numbers of rings and no answer, the call can:

- Go to the specified extension
- Enter the call waiting queue
- Go to an external number

**Note:** If the selected response is Queue, refer to Configuring the Behavior of the Call Queue on page 544 for more information.

Logged Out

With the Logged Out condition, calls go to a specified destination if the status of all agents is logged out. The call routing is the same as for Busy:

- Immediately go to the specified extension
- Immediately enter the call waiting queue
- Immediately go to an external number

**Note:** If the selected response is Queue, refer to Configuring the Behavior of the Call Queue on page 544 for more information.

Rings per Agent

After this number of rings on an agents phone, the system sends the call to the next available agent.

No Answer Number of Rings

After this maximum number of rings on an unanswered call, the system sends the call to the No Answer destination.

Mailbox / Workgroup Greeting

(Optional) The Record, Play, Enter, and Import buttons are for managing a mailbox greeting for each call handling mode in the workgroup.

Workgroup Assistant

(Optional) To assign a workgroup assistant, select one from the drop-down list. When a caller connects to the workgroup’s voice mail and presses “0,” the call transfers to the workgroup assistant extension.

Enable Calling Message Notification

(Optional) This check box activates the message notification feature for the workgroup’s mailbox.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Answer</td>
<td>With No Answer, calls go to the forwarding destination after the specified number of rings in the No Answer Number of Rings box, which is at the bottom of the Call Handling area. After the numbers of rings and no answer, the call can:</td>
</tr>
<tr>
<td></td>
<td>- Go to the specified extension</td>
</tr>
<tr>
<td></td>
<td>- Enter the call waiting queue</td>
</tr>
<tr>
<td></td>
<td>- Go to an external number</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the selected response is Queue, refer to Configuring the Behavior of the Call Queue on page 544 for more information.</td>
</tr>
<tr>
<td>Logged Out</td>
<td>With the Logged Out condition, calls go to a specified destination if the status of all agents is logged out. The call routing is the same as for Busy:</td>
</tr>
<tr>
<td></td>
<td>- Immediately go to the specified extension</td>
</tr>
<tr>
<td></td>
<td>- Immediately enter the call waiting queue</td>
</tr>
<tr>
<td></td>
<td>- Immediately go to an external number</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the selected response is Queue, refer to Configuring the Behavior of the Call Queue on page 544 for more information.</td>
</tr>
<tr>
<td>Rings per Agent</td>
<td>After this number of rings on an agents phone, the system sends the call to the next available agent.</td>
</tr>
<tr>
<td>No Answer Number of Rings</td>
<td>After this maximum number of rings on an unanswered call, the system sends the call to the No Answer destination.</td>
</tr>
<tr>
<td>Mailbox / Workgroup Greeting</td>
<td>(Optional) The Record, Play, Enter, and Import buttons are for managing a mailbox greeting for each call handling mode in the workgroup.</td>
</tr>
<tr>
<td>Workgroup Assistant</td>
<td>(Optional) To assign a workgroup assistant, select one from the drop-down list. When a caller connects to the workgroup’s voice mail and presses “0,” the call transfers to the workgroup assistant extension.</td>
</tr>
<tr>
<td>Enable Calling Message Notification</td>
<td>(Optional) This check box activates the message notification feature for the workgroup’s mailbox.</td>
</tr>
</tbody>
</table>
Selecting a DNIS Trunk Group for DNIS Routing

Complete the following steps to add DNIS routing to a trunk group:

1. Click Edit DNIS Map in the Workgroups edit page. The DNIS Trunk Group list opens. Refer to Figure 188 for an example.

2. Select an available trunk group from the list, and then click OK.

Note

For the next three bullets, if the selected response is Queue, then an understanding of the information in Configuring the Behavior of the Call Queue on page 544 becomes mandatory.
Editing Workgroup Membership

This section describes how to build the membership of a workgroup by adding or removing agent names in the Workgroup Membership page. This page also provides other controls. Refer to Figure 189 for an example of this page.

The administrator can change the current status of a workgroup member, such as changing the agent status from logged in to logged out, and can change the agent’s Access License — for example, changing it from Personal to Workgroup Agent.

This section also describes a further level of control that an administrator can have if the call distribution pattern is Top Down or Round Robin. With these distribution patterns, the administrator can influence the choice of workgroup members that the system selects to receive a call. For information on how to select the call distribution pattern, see The Workgroup Configuration Parameters on page 533 and Figure 187.

To open the list of workgroup members for editing, click the Edit Agents button to the right of the Workgroups Membership label in the Edit Workgroup page. Refer to Figure 186 for an example of this page. This page has the following functional areas:

- The Filters Users By area provides filtering capability to ease the search through a long list of agents.
- The Select Agents From List area is the tool for moving agents into or out of the current workgroup.
- Save and Reset buttons are for writing configuration changes to the disk or clearing all changes.
Navigating the Workgroup Membership Edit Page

The list of agents can be very long. Selecting the agents from a long list for membership in the current workgroup can take significant time. A filter can help speed the selection process. The available filter criteria in the Workgroup Membership window are first name, last name, and extension number.

The filtering function provides two ways to specify the filter criterion. The text-entry boxes allow typing of specific values, and a scroll list also provides the same choices of first name, last name, or extension number. With either approach to filtering, click the Apply button to apply the filter to the list of agents. This button is in the Select Agents From List area.

If more members exist than the scroll list can display in one page, use the forward and back buttons to scroll through the members. These buttons are below the Select Agents From List label heading.

Adding or Removing an Agent from a Workgroup

An agent is not a member of a workgroup until the administrator moves the agent's name into the workgroup. To add an agent to a workgroup, select a member's name from the list on the left side of the page, as shown in Figure 189, and click Add. The agent's name moves to the list on the right. By default, the state of a new workgroup member is logged out.

To remove a member from the workgroup, select that member's name from the list at the right side of the page and click Remove. The member's name returns to the list of agents on the left side of the page.
Changing the Member Position to Affect Selection

A workgroup supervisor might have reasons for creating preferences for some agents to receive calls before other agents in the workgroup. If the call distribution pattern is Top Down or Round Robin, the location of the member in the workgroup list can affect who the system chooses to answer an incoming call.

With Top Down, a higher probability exists for the members closer to the top list to be the next agent that the system selects because the hunt for a free agent always starts at the top of the list with each new incoming call.

Even with the Round Robin pattern, the position can affect the frequency or likelihood that the system picks a particular agent because the hunt for a free agent is still moving down the list as new calls come in instead of starting at the top of the list with each new call. For example, if Agent 12 is higher in the list than Agent 18 and Agent 19, and if Agent 12 is busy while Agent 18 and Agent 19 are free when a call comes into the workgroup, Agent 18 is more likely to get the call.

To change the position of a member in the membership list, highlight the member’s name, and then click **Move Up** or **Move Down** until the name is in the intended position.

Changing an Agent’s Status or Access License

To change a workgroup member’s login status, double-click the name in the right-side list in Workgroup Membership. The Edit Workgroup Member dialog box opens, as shown in **Figure 190**.
The selectable agent states are Logged Out, Logged In, and In Wrap Up. The Access License choices are Personal, Professional, Workgroup Agent, Workgroup Supervisor, and Operator. Although pressing OK accepts the changes and closes this popup, the OK button is not enough to change the user configuration on the server’s disk.

**Note**

To keep changes in Edit Workgroup Member, the system administrator must click the Save button at the top of the Workgroup Membership page.

A change in the Access License in this dialog box also appears in the user account configuration when the administrator clicks Save.

---

### Configuring the Behavior of the Call Queue

This section describes how to configure a call-waiting queue in the following sections:

- Introduction to Specifying the Call Queue on page 544
- Definitions of Call Queue Parameters on page 546
- Specifying Call Queue Behavior for a Workgroup on page 549
- Computing the Wait Time that a Caller Hears on page 554

The possibility for incoming calls to enter a queue depends on choices in the Call Forward area of the Workgroups Edit page. For a description of how to send incoming calls to the queue, see Call Forward in The Workgroup Configuration Parameters on page 533 and Figure 187.

---

### Introduction to Specifying the Call Queue

In general, the call queue specification has the following types of focus:

- Five Steps, where each step can have a unique specification within a set of common parameters. These parameters are as follows:
  - The specification of recorded prompts that callers hear
  - The specification of an action that each button on the caller’s phone can initiate
  - An option for skipping the step (except for the mandatory Last Step)
  - In the Last Step, an additional configuration for Overflow and Interflow
  - A number of seconds that the system waits during a period of no-response from the caller, after which the system moves the caller to the next Step
Certain parameters that are independent of the specification of the Steps:

- Thresholds for sending an alarm when the queue has too many calls or when a caller has been waiting too long
- An enable that lets the agents select and answer a particular call in the queue

The five Steps have a common set of parameters with an additional parameter for the Final Step. Each Step can have unique values for these parameters. The definitions of each Step parameters and all other parameters in the Workgroup Queue Handling editor are in "Definitions of Call Queue Parameters" on page 546.

When a call enters the queue, the caller hears the following:

1. One or more recorded prompts. For example, a recording might say, “Press four to make a payment.”
2. The estimated wait time. This announcement is on by default. The system administrator can turn it off.
3. Silence for eight seconds during the “wait for digits” period. This value is static.
4. Music on hold (MOH) for a period of time. The duration of MOH depends on the configured time until the next Step. While hearing MOH, the caller cannot initiate actions by pressing phone buttons: DTMF functionality is not available while the system is sending MOH to the caller.

The recorded prompts must be available to the workgroup before the system administrator can configure the caller’s responses to menu prompts. The system ignores DTMF actions by the caller if the step has no recorded prompts. The description of how to specify prompts is in Specifying Call Queue Behavior for a Workgroup on page 549. The prompts can be either of the following:

- Recordings that a customer makes by using a microphone
- Pre-recorded prompts that the system administrator imports through the workgroup’s specification page for Queue Handling

---

**Note**

- The prompts must be CCITT µ-Law, 8 KHz, 8-bit, mono WAV files. By using the system recorder and a plug-in microphone, the recording meets these requirements by default. Regardless of the source, if a prompt does not meet these requirements, the system rejects it with an explanation when the administrator clicks Save.
- To have prompts that match the default voice of a ShoreTel system, contact Worldly Voices at www.worldlyvoices.com and request that “Connie” record the prompts. Worldly Voices creates prompts at low cost and within a short time.
Definitions of Call Queue Parameters

Table 74 includes the parameters in the Workgroup Queue Handling page, as shown in Figure 191.

**Table 74: Workgroup Queue Handling Page Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Thresholds</td>
<td>Gives access to the configuration pop-up window for setting two thresholds. The thresholds are the number of calls in the queue and a call-waiting time that is too long, such as 100 calls and 10 minutes. When the number of calls or wait time reaches either threshold, the system sends a warning to the Communicator of all the agents in the workgroup.</td>
</tr>
<tr>
<td>Allow agents to pick up from queue</td>
<td>Gives permission to workgroup members to answer a specific call in the queue. Without the enable, agents can see the calls but cannot select and answer a call. This enable applies to the workgroup — it is not uniquely configurable for each Step. When this checkbox is empty, the call distribution pattern is the only basis for sending a call to an active agent. For a description of call distribution, see Call Distribution on page 528.</td>
</tr>
<tr>
<td>Announce Estimated Wait Time</td>
<td>Announces the estimated wait time to callers. It is on by default. The wait time is not user-configurable. To see how the system calculates the wait time, see Computing the Wait Time that a Caller Hears on page 554.</td>
</tr>
<tr>
<td>Time Until Next Step</td>
<td>Number of seconds that the system waits before it activates the next Step. The system waits for the caller to press a phone button. For example, the first prompt in the next Step might ask, “Are you still there?”</td>
</tr>
<tr>
<td>Prompt Text</td>
<td>The text that system administrator or other employee speaks into the microphone that plugs into the microphone port of the computer. The Prompt Text area is a convenience for customers who record their prompts by using a microphone and controlling the recording with the buttons below the text entry box. The alternative to this method is to import the prompts from a folder that stores recorded prompts on the server.</td>
</tr>
</tbody>
</table>
Operation and Ext Columns Specifies the actions that result from a caller pressing a button on the phone. Refer to Figure 191 for an example of this page. For each button on the phone, the choices for Operation are:

- None (therefore, this phone button has no operation in the current Step)
- Go to menu (this operation involves the specification of an extension)
- Repeat prompt
- Transfer to extension (this operation involves the specification of an extension)
- Take a message (this operation involves the specification of an extension)
- Hang up

The Ext field next to the operation is active only when the selection action necessitates a transfer out of the workgroup. For example, the transfer extension could be the voice mail system or Auto-attendant. For a multi-site workgroup, the extension could be a hunt group that is distributing calls to the different sites in this type of distributed workgroup. Refer to Distributed Workgroups on page 555 for details. To illustrate further, with the Go to menu operation, clicking on the dashed lines in the Ext column, or on a number if a number is visible, opens a search-window for locating an extension for a menu.

If only the default extension of 700 for Auto-attendant exists on the system, no search window opens, and the field automatically shows 700.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
</table>
Configuring Workgroups

Definitions of Call Queue Parameters

Step 1, Step 2, . . . Last Step

Five steps, or phases, of queue handling. The reason for multiple steps is that, over the time that a call is in the queue, the importance of specific menu options or the caller’s needs can change. Therefore, the steps have a time dependency. A reflection of the time factor is the specification for Time Until Next Step and the alert for maximum wait time. Step 1 through Step 4 also have an option for skipping the current step, typically to just to go straight to Last Step.

If the customer wants only one queue behavior, the system can bypass the first four steps and use only the Last Step. To enable this quick bypass to the Last Step, the first four pages have a Skip this Step checkbox.

Overflow/Interflow

Visible only in the Last Step. For workgroups, the overflow and interflow capabilities can reduce the wait time for calls in an ACD system.

Calls overflow is a transfer from one workgroup queue to another, higher priority queue when the amount of time the call has waited in a queue reaches a threshold.

Alternatively, a call can interflow to any dialable number when the amount of time the call has waited in a queue reaches a threshold. This external number can be, for example, a cell phone number for a supervisor.

Typically, interflow is the step after a series of overflows. If a call goes from one workgroup queue to another queue with no answer, the call interflows from the Last Step to an external number, such as the supervisor’s cellphone.

Table 74: Workgroup Queue Handling Page Parameters (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1, Step 2, . . . Last Step</td>
<td>Five steps, or phases, of queue handling. The reason for multiple steps is that, over the time that a call is in the queue, the importance of specific menu options or the caller’s needs can change. Therefore, the steps have a time dependency. A reflection of the time factor is the specification for Time Until Next Step and the alert for maximum wait time. Step 1 through Step 4 also have an option for skipping the current step, typically to just to go straight to Last Step. If the customer wants only one queue behavior, the system can bypass the first four steps and use only the Last Step. To enable this quick bypass to the Last Step, the first four pages have a Skip this Step checkbox.</td>
</tr>
<tr>
<td>Overflow/Interflow</td>
<td>Visible only in the Last Step. For workgroups, the overflow and interflow capabilities can reduce the wait time for calls in an ACD system. Calls overflow is a transfer from one workgroup queue to another, higher priority queue when the amount of time the call has waited in a queue reaches a threshold. Alternatively, a call can interflow to any dialable number when the amount of time the call has waited in a queue reaches a threshold. This external number can be, for example, a cell phone number for a supervisor. Typically, interflow is the step after a series of overflows. If a call goes from one workgroup queue to another queue with no answer, the call interflows from the Last Step to an external number, such as the supervisor’s cellphone.</td>
</tr>
</tbody>
</table>
Specifying Call Queue Behavior for a Workgroup

This section describes how to configure queue handling.

To open the page for the Workgroup Queue Handling editor, click the **Edit Queue Handling** button next to the Workgroup Queue Handling label in the middle of the Workgroups page. Refer to the lower part of Figure 186.

Complete the following steps to specify the alert thresholds for calls in the queue and the maximum wait time:

1. Click **Edit Alert Thresholds** near the top of the page. A dialog box for specifying these values opens. Refer to Figure 192.

2. Specify the number of calls in the queue that initiates an alert to the agent via ShoreTel Communicator. The range is 1–999. The default is 3.
3. Specify the number of seconds threshold the wait time in the is range 0–3600. The default is 60 seconds.

<table>
<thead>
<tr>
<th>Workgroup Thresholds</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Workgroup Queue Alert Thresholds</td>
</tr>
<tr>
<td>Calls in Queue Warning</td>
</tr>
<tr>
<td>Calls Waiting Time Warning</td>
</tr>
</tbody>
</table>

To enable agents to select a call in the queue and answer it, select **Allow agents to pick up**. Refer to [Figure 191](#) for an example of where this option is available on the page.

Complete the following steps to specify the Queue Step Menu:

1. To configure the actions for a step, click that step in the Queue Step Menu area. The choices are **Step 1**, **Step 2**, **Step 3**, **Step 4**, and **Last Step**. To skip any Step 1–4, but not the Last Step, select **Skip This Step**.
2. (Optional) To make the system ignore the current Step and go to the next Step, select the **Skip This Step** checkbox.

3. (Optional) By default, the **Announce Estimated Wait Time** enable directs the system to announce the amount of time that the caller can expect to wait before an agent answers. However, you can remove the mark from the checkbox to turn off the wait time announcements.

4. Type the number of seconds in the **Time Until Next Step** box if the default of 60 seconds is not acceptable. This is the amount of time the system waits for the caller to press a phone button. After this time elapses, the system starts the next step. The range is 0–600 seconds.

5. (Optional) To aid mic-recording, type the prompts in the **Prompt Text** box.
6. Get the spoken prompts by recording them or importing them, as follows:

   - With a microphone in the computer's microphone jack, click Record to record the prompts. A small pop-up window opens. In this popup, the red dot is for starting the recording. The black square is for stopping the recording. Click OK to keep the recording.

     Click Play to hear the recording. If necessary, click Erase to erase the recording.

   - Click Import to import the WAV file. Prompts must be CCITT μ-Law, 8 KHz, 8-bit, mono WAV files. By using the system recorder and a plug-in microphone, the recording meets these requirements by default. If a prompt does not meet these requirements, the system rejects it when you click Save. If the system rejects the recording, click Erase to clear the recording.

7. Select an action in the Operation drop-down list for each phone button that you intend to have a function. Some operations must also have an extension assignment. For a definition of the actions, refer to Chapter 16, Definitions of Call Queue Parameters on page 546.

Complete the following steps to configure the Workgroup Overflow / Interflow feature in the Last Step:

1. Click on the Last Step tab and scroll down to the Overflow / Interflow section toward the bottom of the window, as Figure 194 shows.

2. In the Overflow / Interflow section, select one of the following radio buttons:

   - None disables the Overflow / Interflow behavior being disabled.

   - Extension enables the Overflow or Interflow behavior. For this selection, click the Search button to locate the extension where calls go as a result of an overflow or interflow situation.

   - External enables the Interflow behavior. Type a dialable, external number where calls go when the call queue has exceeded one of the thresholds.

3. Put a mark in the Maintain Wait Time check box to record the length of time a call has been waiting in a queues. By maintaining this record, the ShoreTel system can move a call from one queue to another queue and preserve the call’s relative position in the subsequent queue.
If the check box is empty, the system discards the time that the call first entered the queue if the system moves the call to another queue. In this case, counting the time for the call restarts when the call enters the subsequent queue.

If the call interflows to an external number, the ShoreTel system cannot retain the wait time. The system recognizes these conditions and deactivates the **Maintain Wait Time** check box.

4. Click **Save**.

---

**Note**

The sum of the seconds in the Time Until Next Step field for Step 1 through the Last Step is the total time the caller waits before the call goes to overflow or interflow.

---

**Figure 194: Overflow / Interflow Options in the Last Step**

1. In the **Overflow / Interflow** section, select a radio button, as follows:
   - Selecting **None** results in the Overflow / Interflow behavior being disabled.
   - Selecting **Extension** enables the Overflow or Interflow behavior. After selecting **Extension**, click the **Search** button to start searching for the extension to which the system overflows or interflows a call.
Selecting **External** enables the Interflow behavior. Type a dialable number to which the system sends a call when the threshold is exceeded.

2. Put a mark in the **Maintain Wait Time** check box to record the length of time a call has been waiting in a queue. By maintaining this record, the ShoreTel system can move a call from one queue to another queue and preserve the call’s relative position in the subsequent queue.

   If the check box is empty, the system discards the time that the call first entered the queue if the system moves the call to another queue. In this case, counting the time for the call restarts when the call enters the subsequent queue.

   If the call interflows to an external number, the ShoreTel system cannot retain the wait time. The system recognizes these conditions and deactivates the **Maintain Wait Time** check box.

3. Click **Save**.

---

**Note**

The number of seconds in the **Time Until Next Step** field for Steps 1 through the Last Step, when added up, represent the total amount of time the caller waits before overflow / interflow.

---

### Computing the Wait Time that a Caller Hears

The queue’s Announce Wait Time function is on by default. Beginning with the moment that a call enters the queue and with each transition of the queue to one of the Steps, the system computes the wait time and announces it to the caller.

The approximate wait time is a moving average that depends on the duration of the previous calls. The wait time is approximate because the system rounds off the time to the nearest minute. The system announces minutes, not the number of seconds.

To determine the wait time, the system uses the following two formulas in this order:

1. \[
   \text{Average wait seconds} = \frac{\left(\text{Average wait seconds} \times 9\right) + \text{New wait time}}{10}
   \]
   
   Where **New wait time** is the time that the last caller waited before reaching an agent.

2. The wait time that the system announces to the caller is:

   \[
   \text{Announced wait time} = \text{Position in queue} \times \text{Average wait seconds}
   \]

For example, after 10 calls, 61% of the calculated wait time depends on the 10 most recent calls. After 20 calls, 86% of the time is based on the last 20 calls. The announced wait time might be inaccurate during periods of low call volume.

The **Position in queue** refers to the position of the call in relation to other calls in the queue.
Distributed Workgroups

This section describes the operation and configuration of the Distributed Workgroup capability. A distributed workgroup has greater availability and resilience than a regular workgroup because it has a significant level of independence from the HQ server.

Although the database of real-time and historical records resides on the HQ server in the current release, this factor does not keep distributed workgroups from having greater availability and resilience. During a disconnect from the HQ server, the agent logs remain in a buffer until the HQ server and remote server reconnect, at which time the DVS sends the logs to HQ.

Two types of distributed workgroups exist, as follows:

- A site-specific workgroup runs on a local DVS at a remote site. No part of this workgroup resides at other sites.
- A multi-site workgroup:
  - Spans multiple sites and servers that can back up each other
  - Uses the Hunt Group feature to link the workgroup sites into one workgroup

---

**Note**

If a distributed workgroup loses connectivity to the HQ server, that workgroup’s agents who are logged at the time of the disconnect continue to receive calls. Also, if the agents have a wrapup time, the distributed workgroup continues to allow that wrapup time to them.

No supervisor or system administrator can change an agent’s state in the absence of HQ server connectivity. Furthermore, an agent’s ShoreTel Communicator call handling mode cannot change in the absence of HQ connectivity, such as changing from On-line to Off-line.

Two ShoreTel technologies enable the Distributed Workgroups capability:

- The ability of a DVS to host a workgroup
- The ability of the Hunt Group feature to manage a multi-site workgroup

---

**Note**

Voice mail switches can host a hunt group in support of Distributed Workgroups. However, this type of switch cannot host the actual workgroup.

For general backup purposes, a Backup Extension can be a workgroup, hunt group, menu, or any system extension. However, to have backup from another workgroup, a workgroup’s Backup Extension must point to a hunt group.

---

**Note**

In the current release, a ShoreTel system can support Distributed Workgroups or Distributed Database (DDB) but not both at the same time.
If Distributed Database is not active, the drop-down Workgroup Server list is active and shows multiple servers from which you can select a non-HQ application server (a DVS) to host the workgroup.

Complete the following procedures to determine if the system is using DDB (before specifying a workgroup server):

- Examine the checkbox enable at the bottom of the Application Servers editing page for a DVS. The Application Servers editing page for the Headquarters server does not have this checkbox.
- Examine the Maintenance > Quick Look page lists servers. If a remote DVS has a green icon in the DB column in this page, that server is running a DDB.

If DDB is active, the drop-down Workgroup Server list is inactive. The list shows only Headquarters for the choice of database server. The enable for DDB is in the Application Server page. At the bottom of this page, the Enable Local Database checkbox is the enable. A mark in this checkbox means DDB is active, so the Workgroup Server list is inactive.

For information about the configuration of DDB, see Configuring Distributed Application Servers to Host the ShoreTel Database on page 105.

In summary, the Distributed Workgroup capability is either on or off. If it is on, site-specific and multi-site workgroups are possible. If it is off, the HQ server manages all workgroup calls whether the workgroup is on the HQ server or a DVS. If the Distributed Workgroup capability is off and the HQ server becomes unavailable, all workgroups in the network are also inoperative.

### How Hunt Groups Facilitate Multi-site Workgroups

This section is optional. Readers who already understand the concepts and have planned the deployment of the Distributed Workgroup capability can go to the configuration steps in Configuring a Distributed Workgroup on page 560.

The introduction to Distributed Workgroups states that the Hunt Group feature supports a distributed work group. The text in this section and Figure 196 describe how the workgroup operation can fail when it depends on the HQ server alone but remain active when hunt groups are supporting a multi-site workgroup.

Figure 195 shows three separate workgroups (250, 251 and 252). These workgroups are not part of a distributed workgroup because they are not on the HQ server. However, through the Backup Extensions, these workgroups can back up each other, as follows:

- Workgroup 250 is on SVR1. Its backup is Workgroup 251.
- Workgroup 251 is on SVR2. Its backup is Workgroup 252.
- Workgroup 252 is on SVR3. Its backup is Workgroup 250.

Despite the Backup Extensions, link failures in the following two scenarios illustrate the limitations on this type of backup when the connectivity to the WAN is the problem. In one example, Link 1 fails. In the other example, link 3 fails.
If WAN Link 1 breaks:

- Even though Link 1 breaks, the server and switches still connect to each other. Trunk Group 1 can still reach all the agents that SVR1 manages.
- Agents on the switches that SVR2 and SVR3 manage are unavailable to SVR1.

If WAN Link 1 breaks and a call arrives on Trunk Group 2:

- The call is unable to reach Workgroup 250 on SVR1.
- The switch routes the call to back-up Workgroup 251 on SVR2.
- Across the WAN, the agents that SVR3 manages are unavailable.

If WAN Link 1 breaks and a call arrives on Trunk Group 3:

- The call for Workgroup 250 is unable to reach Workgroup 250 on SVR1.
- The switch routes the call to back-up Workgroup 251 on SVR2.

In the next example, WAN Link 3 in Figure 195 is down. A call arrives on Trunk Group 1 and Trunk Group 2 for Workgroup 250:

- The call is unable to reach agents at SVR1 and SVR2.
- Any agent that SVR3 manages is unavailable.
- Furthermore, a call that arrives on Trunk Group 3 for Workgroup 250 is unable to reach Workgroup 250 on SVR1. The Backup Extension for Workgroup 250 is Workgroup 251, but Workgroup 251 is also unavailable. In this situation, calls eventually go to the Backup Auto Attendant on the switch.
As Figure 196 shows, the members of Hunt Group 261 are workgroups 250 and 251. For the calls that arrive on Trunk Group 2:

- The calls go to Hunt Group 261.
- Initially, Hunt Group 261 forwards the calls to Workgroup 250.
- If no agents in Workgroup 250 answer a call, the switch with Hunt Group 261 forwards the call to Workgroup 251 at Site 2.

**Note**

The failure of an agent in Workgroup 250 to answer the call can be for any reason. Because the goal is to find an agent for the caller, the reason does not matter.
At Site 3 in Figure 196, Hunt Group 262 supports workgroups 250 and 252. Calls enter the network on Trunk Group 3 and go to Hunt Group 262. Calls that arrive on Trunk Group 3 go to Workgroup 250. If no agent in Workgroup 250 answers the call, it goes to Workgroup 252 at Site 3.

Returning to the scenario with WAN Link 1 down but with Hunt Groups providing the Distributed Workgroup capability, again refer to Figure 196:

- Calls that arrive on Trunk Group 3 go to Workgroup Extension 252.
- Calls that arrive on Trunk Group 2 go to Workgroup Extension 251.
- Notice that if the ShoreTel loses connectivity to the WAN, calls still enter the local workgroup at the local site.

Figure 196: Hunt Groups Supporting Distributed Workgroups
Configuring a Distributed Workgroup

This section describes how to create a site-specific workgroup and a multi-site workgroup.

For a multi-site workgroup, the administrator first configures the servers in the workgroup and then configures the hunt groups that unite them as a multi-site workgroup.

Configuring a Site-Specific Workgroup

With a site-specific workgroup, the local switch forwards an incoming call to the workgroup’s extension. If the workgroup extension is unreachable because of a server or WAN failure, the switch routes the call to the backup extension. This backup extension can be an agent extension, workgroup, hunt group, menu, or any system extension.

---

**Note**

The routing process lasts until the no-answer number of rings elapses. Reaching this limit activates the backup extension.

---

Complete the following steps to configure a site-specific Workgroup:

1. On the site with the DVS, log into ShoreTel Director.
2. Navigate to **Application Servers > HQ / DVS**.
3. Select the site in the list next to Add new DVS at site and click **Go**. The editing page opens. Refer to the Database area at the bottom of **Figure 197** for an example of where this task takes place on the page.
4. Select the **Enable Local Database** checkbox near the bottom of the window, in the Database area of the HQ / DVS Edit Server page. This step follows the rest of the configuration details for the server. For a description of server configuration, see Chapter 4, Configuring Application Servers on page 89.

5. Select the current server in the list next to **Use Database on Server**.

6. Click **Save** when the Database parameters and other parameters are ready.

7. Navigate to **Administration > Workgroups**.

8. Click **Add New** to create a workgroup, or modify an existing workgroup. See the Edit Workgroup page in Figure 198.
9. Edit the following fields in the Edit Workgroup screen.

   a. **Type a Backup Extension** — the backup extension can be a menu, agent extension, or auto attendant. If a workgroup does not answer after a configured number of rings, the call goes to this backup extension.

   **Note**

   If a workgroup's call volume is low, the backup extension can be the extension of an agent. If the call volume is high, we recommend that you configure the backup extension to be a must-answer phone with a distinctive-sounding ring. Agents with the appropriate configuration can use the call pickup feature to answer these calls on the must-answer line.

   b. **Workgroup Server** — the local DVS to host the workgroup. This list shows other DVSs but not ShoreTel voice mail switches.

   **Note**

   If the system is using the Distributed Database capability, the list shows only one server because the capabilities of Distributed Database and Distributed Workgroups are incompatible in the current release.
10. Click **Save**.

**Configuring a Multi-site Workgroup**

For a multi-site workgroup, the order of configuration is as follows:

1. **Servers.** Note the following special requirement in the current release:

   At the bottom of the Application Server editing page on each DVS in the multi-site workgroup, the checkbox for Enable Local Database must be clear. An explanation is in *Distributed Workgroups* on page 555. For details on server configuration, see *Chapter 4, Configuring Application Servers* on page 89.

2. **Workgroups.** The Backup Extension of each workgroup in a multi-site workgroup is the hunt group extension. For a description of each parameter in a workgroup configuration, see *Workgroup Description* on page 531.

3. **Hunt groups.** The steps in this section are for selecting the workgroup extensions that are to be members of the hunt group. A hunt group can have up to 16 workgroups members.

---

**Note**

If at least one workgroup exists in a hunt group’s membership list, the hunt group can use only Top Down for the choice of Distribution Pattern. To state this another way: the Distribution Pattern can be Simultaneous only if the hunt group membership list contains no workgroups.

Complete the following steps to configure the hunt groups to support a multi-site workgroup:

1. Log into ShoreTel Director.

2. Navigate to **Administration > Call Control > Hunt Groups**.

3. Select **New** to create a Hunt Group, or select an existing Hunt Group to modify. The Edit Hunt Groups page opens see *Figure 199*. 
4. Select the **Top Down** radio button for the Distribution Pattern. The default is Top Down. With Top Down, the system sequentially hunts through the list of workgroups. To affect the order of servers that receive calls, you can modify, as needed, the order that workgroups appear in the hunt group membership list. Refer to step 7 for a description.

5. Select an on-hours schedule from the drop-down list. Select an on-hours schedule or **None**. Selecting **None** causes all calls to be treated as if the schedule is on-hours.

6. Add workgroup servers or other entities to the Hunt Group Members box. The maximum is 16 members. The mechanism for adding, removing, or reordering the hunt group members is in the Choose Members area at the bottom of the Hunt Groups editing page. For each server or other destination, highlight the name in the left-side list, and then click **Add**.

7. (Optional) If necessary, change the position of the members in the hunt group.
With **Top Down**, the position of items in the member list affects the selection of the server or destination that receives the call. For example, if auto attendant is the destination of last resort, then you can use the **Move Down** button to move it to the bottom of the list and, therefore, make it the last place a call can go.

8. Click **Save**.

### Important Considerations for Distributed Workgroups

This section describes important information about the Distributed Workgroup feature.

#### Call Detail Reporting Records

The remote server sends Call Detail Reporting (CDR) records that it collects to the HQ server. If the HQ server is off-line or unreachable because of lost connectivity, the records enter a queue on the remote servers until the HQ server is back on-line. Remote servers keep the CDR records for a limited time while the HQ server is unavailable. The remote server uses the same time limit that the Telephony Management System (TMS) uses.

#### Call Handling Mode Scheduling

For workgroups, the Call Handling Mode (CHM) can vary with the system schedule. For multi-site workgroups, the schedule for call handling depends on the time zone of the server that hosts the workgroup. A user cannot use ShoreTel Communicator or an IP phone to initiate local changes to CHM.

The call-handling specifications combine with the system's scheduling facility to provide different responses to callers at different times. Each mode can support different options and transfer callers to different destinations when no agents are available. The scheduling facility determines the start and stop time of each call handling mode.

#### Hunt Group and Workgroup Scheduling

An additional consideration is the activation time for hunt groups and workgroups. Scheduling for workgroups and hunt groups involves the calculation of the time zone offset that is necessary for the hunt group be active at the same time as the workgroup.

Hunt Group schedule times depend on the HQ server time. Workgroup schedule times depend on the workgroup’s server time.

#### When the Headquarters Server is Unavailable

Because Distributed Workgroups and Distributed Database are mutually exclusive in the current release, during a communication break from the HQ server, the agents change states according to the configuration on the remote server. For example, if the workgroup’s wrap-up time is 10 seconds, that setting remains in effect. However, the state changes are not visible to monitors, and neither the system administrator nor the agent can manually change the agent’s state through either Communicator or on an IP phone. Therefore, in effect, the remote workgroup is using its configuration to run automatically while the HQ server is unavailable.
Local IP phones and Communicator applications do not show the agent enter and leave wrapup. If an agent is in a workgroup that is managed by a server that is outside the off-line site — in a multi-site workgroup, for example — the outside server also is not informed of agent state changes on the isolated, remote site.
This chapter discusses how the system directory is used and provides instructions for adding new entries and editing existing ones in the following sections:

- System Directory
- Adding an Off-system Directory Entry
- Go to This User Link

568
569
571
The system directory is a company-wide list of users and off-system contacts. This directory is read-only for general users. Only the system administrator can update it in ShoreTel Director. Users can copy system directory entries to personal directories.

Individual users automatically populate the system directory when you create them. For more information about creating system users, refer to Configuring a User Account on page 354. You may also add an additional listing to the system directory using the System Directory page in ShoreTel Director.

Complete the following steps to access the System Directory page:

1. Launch ShoreTel Director with administrator privilege.

2. **Click Administration > System Directory.** The System Directory page appears as shown in Figure 200.

ShoreTel Communicator automatically populates each user’s Quick Dialer with entries from the system directory, the user’s personal directory, and all Microsoft Outlook Contact folders. This includes each user’s personal contacts as well as any contacts on the Microsoft Exchange Server.

Accessing the system directory, click System Directory from the navigation frame.
The system directory can be filtered by site or dial number. You can also page through the directory by page, with a configurable number of records per page displayed.

**Table 75: System Directory Page Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>This is the first name of an existing directory entry.</td>
</tr>
<tr>
<td>Last Name</td>
<td>This is the last name of an existing directory entry.</td>
</tr>
<tr>
<td>Ext.</td>
<td>This is typically a contact’s telephone number or extension.</td>
</tr>
<tr>
<td>Type</td>
<td>This is the type of extension, such as workgroup, FAX, and so on.</td>
</tr>
<tr>
<td>Site</td>
<td>This is the site where the extension is located.</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>This is the trunk group associated with the extension.</td>
</tr>
<tr>
<td>DID</td>
<td>This is the direct inward dial number for the user.</td>
</tr>
<tr>
<td>Work</td>
<td>This is the work number for the user.</td>
</tr>
<tr>
<td>Home</td>
<td>This is the home number for the user.</td>
</tr>
<tr>
<td>Fax</td>
<td>This is the FAX number for the user.</td>
</tr>
<tr>
<td>Cell</td>
<td>This is the cell number for the user.</td>
</tr>
</tbody>
</table>

**Adding an Off-system Directory Entry**

You can add commonly accessed off-system contacts to the directory using the System Directory page. To add new off-system contacts, complete the following steps:

1. Launch ShoreTel Director with administrator privilege.
2. Click **Administration > System Directory**. The System Directory page appears.
3. In the **By Site** field, select the site where you want the listing to appear.
4. Click the **New** button. The Edit Entry page appears shown in **Figure 201**.
1. Enter the pertinent information in the fields listed in Table 76.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>This field displays the user’s first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>This field displays the user’s last name.</td>
</tr>
<tr>
<td>Home Phone</td>
<td>This is the user’s home telephone number. Use the format shown next to the field to make this entry.</td>
</tr>
<tr>
<td>Work Phone</td>
<td>This is a work telephone number for the user other than his or her extension. Use the format shown next to the field to make this entry. Do not enter a user extension number in this field.</td>
</tr>
<tr>
<td>Fax Phone</td>
<td>This is the user’s FAX number. Use the format shown next to the field to make this entry.</td>
</tr>
<tr>
<td>Cell Phone</td>
<td>This is the user’s cellular telephone number. Use the format shown next to the field to make this entry.</td>
</tr>
<tr>
<td>Pager</td>
<td>This is the user’s pager number. Use the format shown next to the field to make this entry.</td>
</tr>
<tr>
<td>E-mail Address</td>
<td>This is the user’s e-mail address.</td>
</tr>
</tbody>
</table>

2. Click Save.
Go to This User Link

The “Go to this user” link appears on the System Directory edit entry page when you are editing an existing user directory entry. This link takes you to the Edit User page so that you can edit the user’s general, personal, and distribution list options.
This chapter describes how to configure ShoreTel’s implementation of Session Initiation Protocol (SIP). It contains the following information:

- Overview ................................................................................................................. 575
- Introduction to SIP Profiles .................................................................................. 575
- Current and Legacy Support for SIP Functions .................................................. 575
- A Note about SIP Profiles for Interoperability .................................................... 576
- Operational Behaviors of ShoreTel SIP Trunks .................................................. 576
  - Resource Allocation on a Switch ....................................................................... 577
  - Conferencing and SIP Trunks ......................................................................... 577
  - Dual Tone Multi-frequency Support ................................................................. 578
  - Extension Assignment over SIP Trunks ............................................................ 578
  - General SIP Feature Consideration ................................................................. 578
  - Digit Translation across SIP Trunks ................................................................. 579
- Setting Up SIP Trunks on Voice Switches .............................................................. 579
  - Configuring SIP Trunks .................................................................................... 580
  - Creating a SIP Trunk Group ............................................................................. 584
  - Creating a SIP Trunk ....................................................................................... 591
  - SIP Trunk Profiles ......................................................................................... 593
- Setting Up 3rd-Party SIP Phones and ATAs .......................................................... 602
  - Network Elements .......................................................................................... 602
  - Supporting SIP Devices .................................................................................. 603
  - User Features ................................................................................................. 605
  - System Features ............................................................................................. 608
  - User Assignment ............................................................................................. 609
Configuring SIP Extensions ................................................................. 610
Integrating ShoreTel SIP with Unified Messaging from Third-party Vendors ........ 619
Considerations for Integrating with Third-party UM .................................. 619
Configuring a ShoreTel SIP Unified Messaging Server .............................. 620
Overview

ShoreTel's implementation of SIP can apply to the following:

- SIP trunks
- SIP extensions
- Integration of ShoreTel with a unified messaging system from a third-party vendor

This chapter also contains technical information to help with planning for SIP on a ShoreTel system.

Introduction to SIP Profiles

A SIP profile is a set of parameters that supports interoperability between a ShoreTel SIP component and a component from another source or with a different configuration. The components to which SIP profiles apply are SIP trunk groups, SIP extensions, and SIP servers. The sections about these components describe the SIP profiles that apply to these functional areas.

Among SIP trunk profiles, an important distinction between profiles is whether the profile enables hairpinning of media streams through the switch. Without hairpinning, a ShoreTel SIP trunk supports only the call control tasks and not the media stream. In this scheme, the media stream flows directly between the end-points. (Therefore, switch resources are not needed for controlling media flows.) However, for SIP trunks to support the full set of telephony features in the current release, certain functions are possible only if the media stream flows through a switch. For media streams to flow through a switch, hairpinning must have been applied to the SIP trunk group by a SIP trunk profile that enables it.

ShoreTel provides some SIP profiles, and customers can create custom profiles by using an existing SIP profile as the basis of a new profile. Custom profiles are an advanced task, as further described in A Note about SIP Profiles for Interoperability on page 576.

Current and Legacy Support for SIP Functions

The ShoreTel system includes significant SIP trunking features on its half-width voice switches. (Other trunk types already supported these features.) With SIP trunks, most of this SIP functionality depends on one of the current SIP trunk profiles.

The current release includes generic and default, carrier-specific SIP trunk profiles. The introduction to these SIP profiles, including the list of switches that support the full set of SIP trunk functions, is in SIP Trunk Profiles on page 593, and their effect on individual SIP functions are described in applicable sections throughout this chapter. Customized profiles are also supported. However, customization and the detailed descriptions of SIP trunk profiles exist only in the SIP-related application notes on interoperability from ShoreTel. ShoreTel application notes are available for customers in the ShoreTel Innovation Network Partner Program.
We recommend that existing customers implement the higher trunking functionality on half-width switches by applying SIP trunk profiles, as described in this chapter. However, we also support two legacy SIP profiles for customers that upgrade. Some customers might have no interest in the full feature set after upgrading to Release 13 or later. For example, a customer might have a remote office that uses only the most basic telephony.

When an existing customer upgrades to the current ShoreTel release while the SystemTrunk or the ATTBVOIP SIP trunk profile is in use, the SIP trunk profile remains in use on the trunk group but with the string "_DEPRECATED" appended to the profile name. Therefore, if profiles SystemTrunk and ATTBVOIP were in use at the time of the upgrade, these profiles remain in use but appear in ShoreTel Director to SystemTrunk_DEPRECATED and ATTBVOIP_DEPRECATED.

**Note**

New installations of the current ShoreTel release do not have the old SIP trunk profiles. Only customers who upgrade to the current ShoreTel release and have applied SIP profiles in use at the time of the upgrade can keep the legacy SIP trunk profiles.

Customers wanting to retain legacy configurations need to be aware that, for a specific trunk group, they cannot mix old functions with the new versions of these functions. (Trunk groups cannot mix old and new SIP trunk profiles.)

In this chapter, wherever a difference exists between the current release and the legacy version, the feature section describes the new capability and the limitation of the legacy version. Where a new function is independent of the new SIP profiles, the new capability is described without reference to either to legacy or to new status.

### A Note about SIP Profiles for Interoperability

Although this chapter outlines SIP trunk profiles, SIP extension profiles, and the SIP server profile and how to apply them, SIP profiles are an advanced topic. The chapter provides basic information for most administrators to apply a profile, but in-depth details for every profile parameter are beyond this document’s scope. These details exist in the application notes for interoperability. Application notes are available through the ShoreTel Innovation Network Partner Program. For detailed information on SIP profiles, search the notes available through the ShoreTel Innovation Network Partner Program at:


For information about the benefits of being a ShoreTel technology partner or to become a technology partner, go to: [http://www.shoretel.com/partners/tech_developers](http://www.shoretel.com/partners/tech_developers)

### Operational Behaviors of ShoreTel SIP Trunks

This section contains details about the behavior of SIP on ShoreTel trunks. Some subsections point out specific functions and features that are supported in the current release but not in the legacy configurations that some customers might keep. These details can be very relevant to your choices for the configuration of SIP trunk groups. However, if you are already familiar with ShoreTel’s implementation of SIP on trunks in your system and just want the task descriptions for configuring SIP trunks, you can proceed to Setting Up SIP Trunks on Voice Switches on page 579.
Resource Allocation on a Switch

The use of SIP can involve tradeoffs in the allotment of switch resources. Port tradeoff is unavoidable when the switch provides media hairpinning.

For example, one analog switch port supports up to five SIP trunks. Therefore, if one to five SIP trunks is configured on an analog switch port, one less Time Division Multiplexing (TDM) port is available for analog, T1, and so on.

For SIP Trunk Media Proxy—the switch-level enable for using hairpinning through a SIP profile in a trunk group—the half-width switches do either of the following:

- Dedicate all their resources to serving as a media proxy
- Support both built-in capacity for media proxy and port-specific configuration for making tradeoffs between SIP trunks, SIP proxy ports, or IP phones that use either SIP or media gateway control protocol (MGCP).

The configuration steps in this chapter illustrate these capabilities.

Conferencing and SIP Trunks

When a SIP trunk participates in a conference call, the following behaviors can apply:

- If hairpinning is enabled on the SIP trunk(s) and no phones on the conference are SIP phones, the SIP Media Proxy Resources provide the ports for the conference so that no Make Me ports are involved. However, the following details apply:
  - A three-party conference can use SIP Media Proxy Resources instead of Make Me ports. However, four-party (up to six-party) conferences always go to Make Me conference ports.
  - If even one SIP extension participates in the conference, the conference does not use any SIP Media Proxy Resources, so therefore, reserved Make Me ports must be available for the conference.
  - If most SIP Media Proxy Resources are in use at the time a user initiates a conference, such that an insufficient amount of these resources are available, the switch uses Make Me conference resources instead.
  - If the conference call includes at least one SIP extension, Make Me ports for conferences must be available on the initiating side of the conference call. A conference call consists of three to six terminating endpoints.
- Without the use of SIP Media Proxy Resources and the association of a SIP trunk profile to a trunk group, a minimum of four Make Me conference ports must be reserved—even for a three-way conference.
Dual Tone Multi-frequency Support

In compliance with RFC 2833, ShoreTel switches send and receive DTMF out-of-band. ShoreTel complies with RFC 2833 for all codecs on SIP trunks. However, for a SIP trunk to support the Additional Phones feature and External Assignment, hairpinning is necessary because DTMF is a requirement for supporting these functions. (The user enables these features in ShoreTel Communicator.)

Extension Assignment over SIP Trunks

SIP supports Extension Assignment regardless of the configuration of hairpinning although hairpinning does ensure support for DTMF. With hairpinning, the capabilities and configuration procedures for Extension Assignment are identical to Extension Assignment across other trunks. See Using Extension Assignment on page 446.

The following points need consideration if media streams are not hairpinned:

- The carrier or service provider must provide DTMF through SIP INFO messages.
- If the service provider does not provide DTMF through SIP INFO, Extension Assignment works only if the user’s configuration in ShoreTel Communicator enables “Accept call by answering.”
- The user cannot use keypad features during the call because they rely on DTMF.

Note

According to RFC 2976, an INFO message carries application-level information along the SIP signaling path. The INFO method is not used to change the state of SIP calls or the parameters of the session that SIP initiates. The INFO message just carries optional application layer information generally related to the session.

General SIP Feature Consideration

This section describes various features or functions that ShoreTel SIP supports in the current release as well as functions that ShoreTel SIP does not support.

- In the current release, the following features are supported by SIP only if the trunk has a SIP trunk profile with hairpinning and the trunk is on a half-width switch or a virtual switch:
  - Silent Coach
  - Silent Monitor
  - Barge-In
  - Call recording
- Fax (and modem) redirection works only if the carrier or ITSP supports T.38. For details about T.38, see T.38 Support on ShoreTel Switches on page 137.
The maximum number of music on hold (MOH) streams that a SIP-enabled switch can support varies with the switch model and the switch’s configuration. Also, the allotment of resources for jack-based MOH includes streams for Backup Auto Attendant and transmission of ringback tones. The range of such streams across all the voice switch models is 14–60.

**Note**

For SIP trunks to transport jack-based MOH, the Jack-based music on hold check box must be selected to enabled jack-based MOH for the SIP trunk switch. The MOH source is the SIP trunk switch, as follows: An external source for MOH plugs into the SIP trunk switch at the switch’s MOH jack, and the switch places the stream on the trunk.

Jack-based MOH is not supported on virtual switches.

A SIP switch attempts to transmit MOH over G.711 U. (Switches supports G.711 A-law and U-law.) If the far end does not support G.711, the switch uses G.729.

If Make Me conferences are planned, a minimum of four Make Me ports must be reserved. A three-way Make Me conference uses three Make Me ports, a four-way conference uses four ports, and so on up to the maximum of a six-way conference. For each media stream, up to the maximum of six-way conferencing, an additional Make Me conference port must be available.

End-users can set up Make Me conference calls by using their ShoreTel Communicator. Like extensions with support of Media Gateway Control Protocol (MGCP), SIP extensions require permissions and a minimum of four MakeMe ports to set up MakeMe conference call.

A SIP trunk can be a member of a three-party conference but cannot initiate a three-way conference (unless the SIP device merges the media streams).

ShoreTel SIP supports basic transfers (blind transfers) and attended transfers (consultative transfers).

### Digit Translation across SIP Trunks

Digit translation should be used when number plans overlap two systems that are tied by trunks. The translation tables can translate numbers for extensions, voice mail, auto-attendant, and so on. For a description of how to specify a digit translation table, see Creating Digit Translation Tables on page 49.

### Setting Up SIP Trunks on Voice Switches

The topics in this section are as follows:

- The section begins with the steps for configuring SIP trunks.
- The last section describes SIP trunk profiles and their implementation. (SIP profiles for extensions and servers are described in this chapter in the relevant sections.)
Configuring SIP Trunks

In general, configuring the SIP trunk and applying a SIP trunk profile involves:

1. Reserving SIP trunk resources on an existing switch
2. Creating a SIP trunk group (includes application of a SIP trunk profile)
3. Creating one or more SIP trunks in a trunk group
4. (Opt.) Configure users for trunk group access through membership in a user-group

The sections that follow provide the detailed descriptions of these tasks.

Reserving Switch Resources for SIP

This section describes the preliminary task of reserving port resources for SIP trunks.

Routing the media streams through the switch consumes a large amount of the switch’s resources. A large portion of the resources are reserved when *SIP Trunk Media Proxy* is enabled to support hairpinning. SIP Trunk Media Proxy pertains to the ports that the switch can use for hairpinned media streams. Hairpinning and its prerequisite enable described in this section apply only to the half-width switches listed in this section and in *SIP Trunk Profile List and Supporting Switches* on page 593.

Note

If an existing customer is satisfied with the features and performance supported by the SIP configuration before an upgrade to the current ShoreTel release, enabling SIP Trunk Media Proxy and applying a SIP trunk profile with hairpinning enabled is not necessary. These functions are necessary only if the customer wants the features listed in *General SIP Feature Consideration* on page 578.

This section illustrates the similarities and the differences between two schemes for reserving SIP Trunk Media Proxy, based on switch model. In these two schemes:

- Regardless of whether SIP Media Proxy resources are reserved for ports, the switch must have at least five SIP trunks reserved (in the Built-in Capacity fields).

- On the ShoreTel 220T1, 220T1A, 220E1, T1k, and E1k, all of the switch’s trunk resources are reserved for SIP Trunk Media Proxy though one check-box enable. When SIP Trunk Media Proxy is enabled, the “Built-in Capacity” fields remain active, but the drop-down lists for physical port configuration are deactivated.

When SIP Trunk Media Proxy is enabled on the all-or-none users of this resource, the built-in capacity increases from 70 to 90 on the 220T1, as *Figure 204* illustrates, and from 70 to 100 on the 220T1A and 220E1.
Reserve individual ports for SIP Trunk Media Proxy by way of a drop-down list. Applicable switches are the ShoreTel Voice Switch models 90, 90V, 90BRI, 90BRIV, 50, 50V, 50BRI, 50BRIV, and 30BRI and 30. The ShoreTel Small Business Edition (SBE) models also have the drop-down list for individual ports.

Reserving Resources on the ShoreTel 220T1

Reserving the port resources on a ShoreTel Voice Switch 220T1 if hairpinning is to be used:

1. Launch ShoreTel Director.
2. Navigate to Administration > Platform Hardware > Voice Switches/Service Appliances > Primary.

The editing page for Primary Voice Switches/Service Appliances opens. The left half of this page appears in Figure 202. This part of the Primary Voice Switches/Service Appliances page shows the name of each switch, the site where it resides, the type (model number) of switch, IP address, and so on.

The right half of this page appears in Figure 203. For each switch, it shows the MAC address, serial number, number of SIP trunks reserved, number of SIP trunks in use, and so on.

In the next step, a switch is selected. This switch is configured for SIP trunks in subsequent steps. (For information about adding a new switch, see Chapter 10, Configuring Users on page 335.)

![Figure 202: Left Side of Primary Voice Switches/Service Appliances](image)
3. Click on the name of an existing switch. The Voice Switch editing page opens (Figure 204). This example uses the ShoreTel 220T1 (not seen in Figure 202) to illustrate the necessary enable when the use of hairpinning is expected.

4. Mark the check box labeled Dedicate to SIP Trunk Media Proxy. Figure 204 shows that, with this enable, all port-level reservation is disabled (bottom of screen). A SIP trunk profile is applied later (see SIP Trunk Profiles on page 593.)

5. Click Save.
Reserving Resources on the ShoreTel 50V

Using the ShoreTel Voice Switch 50V as an example, this section describes how to reserve built-in SIP trunk resources and reserve resources at the port-level. You can reserve SIP Media Proxy resources for individual ports on the ShoreTel Voice Switch 50V and other half-width switches. Figure 205 illustrates the selection of SIP Media Proxy for Port 3.
Now that SIP resources have been reserved, the next tasks are the creation of a SIP trunk group and then creation of a SIP trunk.

### Creating a SIP Trunk Group

Creating and configuring a SIP trunk group:

1. Launch ShoreTel Director.

2. Navigate to Administration > Trunks > Trunk Groups.

The Trunk Groups page shows all trunk groups in the ShoreTel system, as illustrated in Figure 206. At the top of this page, two drop-down lists are part of the first step for creating a new SIP trunk group. One selection is for the site where the switch resides, and the other selection is for the type of trunk.
3. Select the site for the new trunk group in the drop-down list to the right of **Add new trunk group at site**. For this example, the site is Headquarters.

4. Select **SIP** in the drop-down list next to “of type,” as illustrated in **Figure 206**.

5. Click **Go**. The Edit Trunk Group page appears as shown in **Figure 207**. This figure shows only the general SIP parameters and the Inbound parameters area. (Subsequent steps and figures illustrate other parts of this page.)
6. Specify the parameters for this SIP trunk group, as follows:

   a. Type a name for the trunk group in the Name box.

   b. Select the language in the Language field for use on this trunk group.

   c. (Optional) Mark the **Enable SIP Info for G.711 DTMF Signaling** check box if the trunk needs to support SIP INFO messaging. SIP INFO messaging must be supported by the SIP trunk provider and is necessary for the passing of DTMF digits for Extension Assignment over SIP Trunks, as described in Extension Assignment over SIP Trunks on page 578. (Extension Assignment is limited using SIP trunks. Either DTMF over INFO must be used, or in—the absence of such support—the features that use DTMF are not supported (including “Accept call by pressing 1.”)

   d. In the Profile field, select a SIP trunk profile for this trunk group:

      - Default Tie Trunk, the default profile for connecting ShoreTel PBXs to other ShoreTel PBXs or to PBX systems from other manufacturers
      - Default ITSP, the default SIP trunk profile for connecting ShoreTel PBXs to a central office
      - **AT&T** for AT&T VOIP service
      - **Verizon** for Verizon VOIP service
Creating a SIP Trunk Group

- CenturyLink for VOIP service from CenturyLink (formerly Qwest Communications)

  e. In the Digest Authentication field, select the type of calls for which authentication should be performed over the trunk. The options are:

- **None**, to disable authentication.
- **Inbound-only**, to challenge the credentials of only incoming calls.
- **Outbound-Only**, to provide credentials when outbound calls are challenged by the call recipient.
- **All**, to authenticate all (inbound and outbound) calls.

  f. (Optional) In the User ID field, type the user ID to use for authentication but only if the SIP trunk uses a modified profile. In each default profile, the user defaults to the billing telephone number (BTN), not a user ID.

  **Note**
  The User ID field is applicable only when the trunk group has a custom SIP trunk profile that does not specify RegisterUser=BTN. If you specify User ID in a trunk group that has one of the SIP trunk default profiles, the system ignores the User ID and uses the BTN. The User ID information is supplied by the SIP Trunk provider.

  g. In the Password field, type the password for the user. The password is provided by the SIP trunk provider. Although the password comes from a SIP trunk provider, ShoreTel allows the following characters:

  !#$%&'()*+,.0123456789;:=@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_/
  `abcdefghijklmnopqrstuvwxyz{|}~

  The system disallows the following characters: ? " <>

7. In the Inbound part of the Trunk Groups page:

  a. This parameter defaults to 0 and must be changed to the length of DID/DNIS digits to be received from the SIP trunk provider. Contact the provider for this information.

  b. Mark the DNIS checkbox to enable the trunk group to support DNIS numbers. Click Edit DNIS Map to create DNIS translation profiles in the page as Figure 208 illustrates.

  **Figure 208**: Creating a DNIS Digit Map for the Current Trunk Group

  c. Mark the DID checkbox to enable the trunk group to support DID numbers.
Click the **Edit DID Range** button to open the page for specifying the range of numbers that the trunk group can accept from the publicly switched telephone network. See Figure 209 for the page for specifying the DID range.

![DID Range](image)

**Figure 209: Specifying a DID Range for the Current Trunk Group**

d. **Mark the Extension checkbox (Figure 207)** to enable the options for modifying the extensions of inbound calls. Modification options are:

   - **Translation Table**—Click this radio button to direct the current trunk group to use a translation table. In the drop-down scroll list, select a translation table that the trunk group should use. (For a description of translation tables, see **Creating a Digit Translation Table** on page 48.)
   
   - **Prepend Dial in Prefix**—Click this radio button to direct the trunk group to place a prefix in front of each inbound number. In the text-entry box, type the prefix that the trunk group should use.
   
   - **Use Site Extension Prefix**—Click this radio button to direct the trunk group to send the extension prefix associated with the site.

e. **To enable tandem trunking support for the trunk group, mark the Tandem Trunking checkbox (middle of Figure 207)** and then do the following:

   - In the **User Group** field, select the name of the group that is to use tandem trunks.
   
   - In the **Prepend Dial in Prefix** field, type a prefix to attach to the front of the number in the inbound calls.

f. **The Destination field is an extension to which an incoming call goes if it cannot find a destination through a DID, DNIS, and so on. The default destination to which this value points is Auto Attendant.**

Subsequent configuration steps apply to Outbound calls on the trunk. Refer to **Figure 210**.
To configure the network call routing parameters for outbound calls from the current trunk group, do the steps that follow. Figure 210 shows the Outbound area in the applicable (bottom) part of Edit SIP Trunk Group.

a. In the **Access Code** field, type an integer that users press to access this trunk. The access code structure must already be established in the dial plan. See Setting Dial Plan Parameters on page 43.

b. In the **Local Area Code** field, type the area code for the location of this trunk group’s services.

c. Click the **Additional Local Area Code Edit** button to add area codes that are adjacent to the area code of this trunk group’s services.

d. Click the **Nearby Area Code Edit** button to specify area codes that this trunk group can dial (to reduce toll charges).

e. Type a billing telephone number (BTN).

9. To configure service parameters for the trunk group for outbound calls.

a. Check the **Local** check box as needed to enable the trunk group to place off-premise local calls.
b. Check the **Long Distance** check box as needed to enable the trunk group to place long-distance calls.

c. Mark the **International** check box to enable the trunk group to allow international calls.

d. Check the **Easy Recognizable Codes (ERC)** check box to enable this trunk group to support services such as toll-free calls (for example, 800, 888, 866).

e. Mark the **n11** check box to let this trunk group reach telephone services but not emergencies services (for example, 411 and 611 but not 911).

f. Mark the **Emergency** check box to enable the trunks in the group to carry emergency calls.

---

**Note**

For details about support for emergency services calls on trunks, see Appendix A, *Emergency Dialing Operations*.

---

g. Mark the **Explicit Carrier Selection** check box to enable the trunk group to let users specify a long-distance carrier.

h. Mark the **Operator Assisted** check box to enable the trunk group to dial the outside operator (for example, 0+).

i. Mark the **Called ID not blocked by default** check box to enable this trunk group to pass caller ID information by default on outbound calls.

---

**Note**

A user can override this option with vertical service codes. For example, pressing *67 blocks, and pressing *82 unblocks. Be sure the SIP trunk provider can provide these types of features.

---

10. **To configure trunk digit manipulation for the trunk group, do the following:**

   a. As needed, mark the check box labeled **Remove leading 1 from 1+10D** to make the trunk drop the leading “1” a user presses for long-distance calls in the U.S. and Canada. As needed, confirm this necessity with the service provider or ITSP.

   b. Mark the **Remove leading 1 for Local Area Codes** check box to delete the leading “1” that users press when dialing the local area code. If necessary, ask the service provider or ITSP to confirm this need.

   c. Mark the check box labeled **Dial 7 digits for Local Area Code** to enable the trunk to dial numbers with seven digits in the local area code if the local service provider requires 7 digits. This setting applies to all prefixes unless a specific local prefix list is provided, as described in a subsequent step.

   d. Mark the check box labeled **Dial in E.164 Format** to enable this trunk group to support E.164 numbers.

   e. In the **Local Prefixes** field, select a local prefix profile that the trunk group uses for local calls.

   f. To create a prefix profile, click the **Go to Local Prefixes List** link.
Creating a SIP Trunk

1. Launch ShoreTel Director.

2. Navigate to Administration > Trunks > Individual Trunks. The list of all trunks (of all types) appears on a page named Trunks by Group.

3. In the Add new trunk at site list, select the ShoreTel site for the new SIP trunk.

4. Pick a trunk group from the in trunk group list to associate with the trunk.

5. Click Go. The Edit Trunk page appears as shown in Figure 211.

6. In the Name field, type a name for the trunk.

**Note**
If a prefix is not listed in the local prefix profile, the system processes the call as a long distance call. Therefore, a long distance trunk service is required for a call whose prefix does not exist in the local prefix profile.

g. In the **Prepend Dial Out Prefix** field, type the string that this trunk group prepends to outbound numbers.

**Note**
A dial-out prefix usually is required for connecting to and leveraging the trunks on a legacy PBX. The **Dial Out Prefix** value does not apply to Off-System Extension calls.

h. For **Off System Extensions**, click **Edit** to add or edit the ranges of extensions that can be accessed through this trunk group. This specification typically applies to connections between a tie trunk and a legacy PBX and configuring coordinated extension dialing. The Dial Out Prefix rules are not applied to Off-System Extensions.

i. Select a translation table for the current group in the **Translation Table** list.

11. Click **Save**.
7. In the **Switch** scroll list, select the switch on which the new trunk resides.

8. Type an IP address. Usually, the IP address is the same for all trunks in the group. Furthermore:
   - For SIP TIE lines, this IP address is on the destination system/PBX.
   - For SIP trunks connected to a provider, this IP Address is on the Endgate SIPerator.

9. Upon the creation of this trunk group, type the number of trunks this group supports in **Number of Trunks** box (visible only when a trunk is created).

10. Click **Save**.

### Deleting One or All SIP Trunks in a Trunk Group

1. Navigate to **Administration > Trunks > Individual Trunks**. The list of individual trunks opens in a page named Trunks by Group. **Figure 212** shows that all trunks are marked for deletion.

   **Note**

   This page can show trunks of all types and has navigation components for reaching any site, trunk group, and trunk in the entire ShoreTel network. The navigation components are at the top of the page, as follows:

   For navigating through long lists of individual trunks after you have chosen the site and trunk group in a large deployment, other navigation components let you find the trunks to delete. In **Figure 212**, the “Show page” scroll list, left and right arrow buttons, and a records-per-page scroll list (not shown but providing choices for a minimum of 10 records up to a maximum of 3000 records per page).

2. Mark the check box associated with the trunk you want to delete.

3. Click the **Delete** button in the upper-left area of the page.
SIP Trunk Profiles

A SIP trunk profile is an advanced facility that provides SIP trunks with:

- Support for features that work only if the media stream passes through a switch. This capability becomes possible when hairpinning is enabled in the profile and the profile is applied to the trunk group.

- The flexibility to interoperate in certain environments or with very specific configurations from third-party services or equipment providers.

Whether provided by ShoreTel or created by a customer, a SIP trunk profile exists independently of the trunks, so the system administrator assigns profiles to a SIP trunk group in the Edit SIP Trunk Group page.

SIP Trunk Profile List and Supporting Switches

The switches that can support hairpinning of media streams are listed in Table 77. A list of the current SIP trunk profiles from ShoreTel appears in Figure 213. This figure also shows that the profile named SystemTrunk_DEPRECATED is in use. The fact that this deprecated profile appears in the SIP Trunk Profiles means that (1) this screen is from an upgraded system and (2) the SystemTrunk profile was in...
use at the time of the upgrade. If SystemTrunk were not in use at the time of the upgrade,
SystemTrunk_DEPRECATED would not be visible. See The SIP Trunk Profiles that ShoreTel Provides
on page 595 for a list of profile contents.

Table 77: Models of ShoreTel Voice Switches that Forward Media Streams

<table>
<thead>
<tr>
<th>30, 30BRI</th>
<th>T1k, E1k</th>
</tr>
</thead>
<tbody>
<tr>
<td>50, 50V</td>
<td>220T1</td>
</tr>
<tr>
<td>90, 90V, 90BRI, 90BRIV</td>
<td>220T1A, 220E1</td>
</tr>
</tbody>
</table>

**Note**
Hairpinning is also supported on ShoreTel Virtual SIP Trunk Switches.

Each row represents a SIP trunk profile. Columns list the following high-level details:

- **A check box lets you select a profile for deletion. The task order is as follows:**
  - a. Modify the trunk-group to use a new profile (Default Tie Trunk for example) before deleting a deprecated profile or any other profile.
  - b. Test the new profile. If the network's operation is acceptable, you can delete the deprecated SIP trunk profile.
  - c. To delete the profile called SystemTrunk_DEPRECATED, for example, mark the check box for the deprecated profile and click the **Delete** button.

- **Name:** This parameter is the label by which Director refers to the profile.

- **User Agent:** (Not used on trunks.)

- **Enabled:** This parameter lists the status of the profile. Only enabled profiles appear in the drop-down SIP Profile configuration in the trunk group page.

- **Priority:** (Not used on trunks, used only for SIP extensions.)

In the SIP Trunks Profiles page, you can initiate the following actions:
To create a SIP trunk profile, copy and existing profile, modify that profile, and save it by another name, or you can click New in the top-left corner of the page. The system creates an empty profile. It shows available parameters, and you must assign a name to the profile and type each parameter line that is to override the list of parameters displayed above the text.

To delete a user-specified SIP trunk profile (predefined profiles cannot be deleted):

- Mark the checkbox that corresponds to the profile.
- Click Delete in the upper-left corner of the page.

To edit a profile: Start by clicking a profile name. The Edit SIP Extension Profile page opens. Modify parameters as needed and click Save when finished.

The SIP Trunk Profiles that ShoreTel Provides

This section introduces the current SIP trunk profiles from ShoreTel.

Whether for a new ShoreTel installation or after an upgrade, customers who want to use all the features that SIP trunks can support must apply a profile with hairpinning enabled. The exceptions are customers who are satisfied with features that do not involve media streams traversing the switch. For a list of features that use hairpinning, see General SIP Feature Consideration on page 578. The upgrade process leaves profiles in their existing state of utilization but renames them by appending the string "_DEPRECATED" to the name of the profile in use. Customers could also disable an old profile in the window that survived the upgrade and apply one of the profiles from the current ShoreTel release.

Knowledgeable users can create custom profiles based on a profile from ShoreTel or any existing SIP trunk profile but must refer to ShoreTel's application notes on interoperability for guidance. (Figure 214 shows the editing window for a SIP trunk profile.)

The tables that follow list the contents of SIP trunk profiles from ShoreTel. The Default Tie Trunk profile is listed in Table 78.
It can apply to different ShoreTel systems linked by a tie trunk or to a third-party PBX linked to a ShoreTel system on the same site.

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Settings</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Tie Trunk</td>
<td>OptionsPing – 0</td>
<td>Hairpinning is disabled in this profile.</td>
</tr>
<tr>
<td></td>
<td>OptionsPeriod – 60</td>
<td>MAC address transmission by a SIP extension is enabled.</td>
</tr>
<tr>
<td></td>
<td>StripVideoCodec – 0</td>
<td>Absence of support for G.729 Annex B is shown as disabled. Therefore, this profile supports G.729 Annex B.</td>
</tr>
<tr>
<td></td>
<td>DontFwdRefer – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SendMacIn911CallSetup – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HistoryInfo – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EnableP-AssertedIdentity – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AddG729AnnexB_NO – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hairpin – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Register – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterUser – BTN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterExpiration – 3600</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CustomRules – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OverwriteFromUser – 0</td>
<td></td>
</tr>
</tbody>
</table>
The AT&T SIP trunk profile is listed in Table 79. It applies to a typical SIP that connects with an AT&T central office.

### Table 79: AT&T SIP Trunk Profile

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Settings</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT&amp;T</td>
<td>OptionsPing – 1</td>
<td>Hairpinning is enabled in this profile.</td>
</tr>
<tr>
<td></td>
<td>OptionsPeriod – 60</td>
<td>MAC address transmission by a SIP extension is enabled.</td>
</tr>
<tr>
<td></td>
<td>StripVideoCode – 1</td>
<td>Absence of support for G.729 Annex B is flagged.</td>
</tr>
<tr>
<td></td>
<td>DontFwdRefer – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SendMacIn911CallSetup – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HistoryInfo – diversion</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EnableP-AssertedIdentity – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AddG729AnnexB_NO – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hairpin – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Register – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterUser – BTN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterExpiration – 3600 secs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CustomRules – 2H</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OverwriteFromUser – 0</td>
<td></td>
</tr>
</tbody>
</table>
The CenturyLink SIP trunk profile is listed in Table 80. It applies to a typical SIP that connects with an Century Link central office.

**Table 80: CenturyLink SIP Trunk Profile**

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Settings</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CenturyLink</td>
<td>OptionsPing – 1</td>
<td>Hairpinning is enabled in this profile.</td>
</tr>
<tr>
<td></td>
<td>OptionsPeriod – 60</td>
<td>MAC address transmission by a SIP extension is enabled.</td>
</tr>
<tr>
<td></td>
<td>StripVideoCodec – 1</td>
<td>Absence of support for G.729 Annex B is flagged.</td>
</tr>
<tr>
<td></td>
<td>DontFwdRefer – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SendMacIn911CallSetup – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HistoryInfo – diversion</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EnableP-AssertedIdentity – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AddG729AnnexB_NO – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hairpin – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Register – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterUser – BTN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterExpiration – 3600 secs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CustomRules – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OverwriteFromUser – 0</td>
<td></td>
</tr>
</tbody>
</table>
The Verizon SIP trunk profile is listed in Table 81. It applies to a typical SIP trunk that connects with a Verizon central office.

Table 81: Verizon SIP Trunk Profile

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Settings</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Verizon      | OptionsPing – 1  
OptionsPeriod – 60  
StripVideoCodec – 1  
DontFwdRefer – 0  
SendMacIn911CallSetup – 1  
HistoryInfo – diversion  
EnableP-AssertedIdentity – 1  
AddG729AnnexB_NO – 1  
Hairpin – 1  
Register – 0  
RegisterUser – BTN  
RegisterExpiration – 3600 secs.  
CustomRules – 0  
OverwriteFromUser – BTN | Hairpinning is disabled in this profile.  
MAC address transmission by a SIP extension is enabled.  
Absence of support for G.729 Annex B is flagged. |
- The Default ITSP SIP trunk profile is listed in Table 82. This generic profile applies to a typical SIP trunk that connects with a central office.

### Table 82: Default ITSP SIP Trunk Profile

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Settings</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default ITSP</td>
<td>OptionsPing – 1</td>
<td>Hairpinning is enabled in this profile.</td>
</tr>
<tr>
<td></td>
<td>OptionsPeriod – 60</td>
<td>MAC address transmission by a SIP extension is enabled.</td>
</tr>
<tr>
<td></td>
<td>StripVideoCodec – 1</td>
<td>Absence of support for G.729 Annex B is flagged.</td>
</tr>
<tr>
<td></td>
<td>DontFwdRefer – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SendMacIn911CallSetup – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HistoryInfo – diversion</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EnableP-AssertedIdentity – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>AddG729AnnexB_NO – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hairpin – 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Register – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterUser – BTN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RegisterExpiration – 3600 secs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CustomRules – 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OverwriteFromUser – 0</td>
<td></td>
</tr>
</tbody>
</table>
Parameters listed on the page include:

- **Name**: This parameter is the label by which ShoreTel Director refers to the profile.
  
  For any predefined profile from ShoreTel, this field cannot be modified.

- **Enable**: This parameter is the operational status of the profile. Director shows the profile in the SIP Trunk Group configuration dropdown only if the profile enabled.

- **System Parameters**: This field lists the device characteristics and default settings.

- **Custom Parameters**: The contents of this field are the additional device settings or overrides of the defaults listed in the System Parameters field.

Documenting all the custom parameters is beyond the scope of this document. To see all the supported custom parameters for SIP profiles, the third-party API documentation for SIP trunks should be consulted. (Consult the ShoreTel Technology Partner Program.)
Editing a SIP Trunk Profile

The parameters for the selected SIP profile are configured on the SIP Profile page (Figure 210). This page is opened from the SIP Trunk Profile List by adding or editing a SIP profile. All parameter fields can be edited for User Defined profiles.

Note

For a predefined ShoreTel SIP profile, Enable is the only parameter you can affect.

Setting Up 3rd-Party SIP Phones and ATAs

This section begins with introductory information on the required resources to support third-party SIP phones in a ShoreTel network and then describes the configuration steps for setting up SIP proxy services to support SIP extensions. A SIP device is typically a phone or an analog telephone adapter (ATA) that can serve as a ShoreTel extension if the device complies with RFC 3261. The ShoreTel Planning and Installation Guide provides important guidance for selecting a source of third-party SIP phone.

Note

Because of variations and ongoing development in phones from third-party vendors, customers might have to test phone models under consideration for interoperability with the ShoreTel system.

Network Elements

This section describes the system and network components that the administrator specifies to enable SIP endpoints to communicate. In a ShoreTel system, SIP endpoints typically are phones. If you are very familiar with these components, you can proceed to the configuration steps for Director in Configuring SIP Extensions on page 610.

In general, the resources that a system uses to support SIP extensions are:

- IP phone resources for SIP extensions: Each SIP extension must point to a SIP proxy server.
- SIP proxy resources: A SIP proxy server is a ShoreTel Voice Switch that you configure to provide the necessary support for SIP extensions. A ShoreTel network can have one primary SIP proxy server that is operational and a backup server.

Implementing SIP extensions involves the following components:

- In general, resources on a ShoreTel Voice Switch can be allocated to trunks, analog extensions, SIP proxy media, or IP phones (which can be SIP endpoints). Two approaches are available for allocating SIP resources: one approach is a switch-level reservation of built-in resources (in the Built-in part of the switch configuration page), and the other approach is called the trade-off method. The trade-off method reallocates resources at the port-level. Both of these approaches are available in the same switch configuration page.
For reallocating resources on each port, the resource tradeoffs are as follows:

- One reallocated trunk resource supports 100 SIP endpoints.
- One reallocated analog extension supports 100 SIP endpoints.
- One reallocated IP phone resource supports 20 SIP endpoints.

Certain ShoreTel half-width switches have a capability that makes reallocation of resources unnecessary: These switches let you specify built-in SIP proxy resources, as described in Reserving Switch Resources for SIP on page 580 and Allocating Switch Resources on page 615.

In particular, a SIP proxy server (also called a registrar server) is a ShoreTel Voice Switch switch that facilitates communication between SIP endpoints, as follows:

- A proxy server forwards requests from a SIP endpoint to another SIP endpoint or another server (when the other server actually processes the request).
- Within a ShoreTel network, proxy server functionality is built into ShoreTel half width and full width switches. You can designate up to two proxy switches per site: one switch is assigned as the primary proxy server, and the other switch acts as the back-up proxy server in case the primary fails.
- A Virtual IP Address is an IP address for the voice switch that you configure to be the SIP proxy server for the site. This IP address must be static. It applies to both the primary (operational) and back-up SIP proxy server. (The Virtual IP Address moves to the backup proxy server if the primary proxy server fails.)

---

Note

If the site does not have a back-up SIP proxy server, you do not need to specify an IP address for the Virtual IP Address. In this case, only the name of the one proxy server is needed.

The page for specifying the Virtual IP Address is ShoreTel Communicator > Administration > Sites. At the bottom of the Sites page, the Virtual IP Address area lets you specify the IP address and the name of the primary and back-up switches (if present) that are to serve as the SIP proxy server.

Supporting SIP Devices

In the current release, the ShoreTel IP 8000 is the only SIP phone that we provide. All other SIP phones that can operate in a ShoreTel network would come from other manufacturers. ShoreTel’s Planning and Installation Guide provides important guidance for selecting a third-party SIP phone.

User Configuration of SIP Phones

A substantial variety exists among the third-party vendors’ approach to phone registration. Some phones have an on-phone set-up dialog, others require a web-browser, and at least one vendor’s ATA is known to require SNMP. The approach can vary from phone to phone, and many manufacturers support configuration by way of a centralized server.
When registration is available through the phone’s interface, the end-user configures the SIP extension in response to prompts that appear on the phone. The user presses phone buttons to enter the requested data at each prompt.

Users must have received a SIP password from the system administrator before starting the configuration tasks. To configure SIP, the user enters the following:

- The ShoreTel username
- SIP password
- SIP proxy address (the Virtual IP Address, configured in the ShoreTel Director > Administrator > Sites page)

The ShoreTel system can recognize the extension, the DID number, or the Client Username. Client Username is the best choice. For information on Client Username (or simply User ID), see Configuring a User Account on page 354.

The phone sends a SIP REGISTER request to the SIP proxy server. For a new registration, the server’s response can take a few seconds.

**Note**

Changing the IP address of a SIP device can result in that device’s being listed twice on the IP phones page. In this case, the last registration takes precedence.

If many SIP phones register simultaneously, a significant delay might result for the completion of SIP phone registration. Distributing SIP phones to multiple switches and multiple sites could help overall with SIP registration.

**SIP Profile Support for SIP Extensions**

SIP device models can support different feature sets on third-party phones. These feature sets can relate to, for example, call control capabilities, codec compatibility, and provisioning procedures. SIP extension profiles are specific for particular SIP device models, as described in Creating a SIP Extension Profile on page 612.

**Extension Assignment**

The Extension Assignment feature lets a user temporarily assign his or her primary ShoreTel phone to another device. Consequently, the other device temporarily functions as an *assigned phone*.

The user can assign the primary extension to a ShoreTel phone or the user’s personal phone. For example, if a user wants to use a personal cellphone for the ShoreTel extension while moving around a ShoreTel site or off-site, that user activates Extension Assignment from the cellphone.

The user configures one or two phone numbers for Extension Assignment in the ShoreTel Communicator Options window to point to the primary phone. Thereafter, whenever the user *enables* Extension Assignment capability in the Options window, he or she can place or receive calls on the assigned phone.
During an Extension Assignment session, if the user’s primary phone is an IP phone, it goes into anonymous mode during the session. Although Extension Assignment is available for SIP phones and regular IP phones, the display on these two phone types behaves differently during an Extension Assignment session. On a regular IP phone, the phone’s display shows the word “Anonymous” during the session. However, because SIP supports only the regular phone display, a SIP phone in the anonymous state still displays the standard information and gives no indication of being anonymous.

When ready to end the Extension Assignment session, the user can disable Extension Assignment from Communicator or the assigned phone.

Note
The user must complete the REGISTER process for the primary SIP phone before activating Extension Assignment. (In contrast, for a regular ShoreTel phone, an end-user must use voicemail to manage Extension Assignment.)

A user has a ShoreTel phone on his or her desk: The user registers a SIP Softphone or wifi phone that temporarily becomes the assigned extension.

User Features

This section describes the user features supported by SIP extensions.

Call Dialing and Initiation

SIP extensions support the following call initiation features:

- **Make Call:** Calls can be made from a SIP phone or from ShoreTel Communicator.
- **On-hook dialing:** On-hook dialing is supported from ShoreTel Communicator.
- **Intercom:** SIP extension users initiate Intercom calls to an extension by pressing:
  - * 1 5 extension number

Note
On a SIP extension, an Intercom call arrives like a regular call.

- **Redial and Speed dial:** Redial and Speed dial initiated from SIP extensions through Communicator operate similar to on-hook dialing.

  Redial and Speed dial methods differ for each SIP device model. Feature keys on a specific model of a SIP device can be programmed to support speed dial.

- **E911:** Calls to emergency numbers from a SIP extension (or regular phone) send an emergency identification number or CESID number with the call. For a description of the extent of ShoreTel’s support for emergency calls, see Appendix A, *Emergency Dialing Operations*.

Unregistered SIP phones cannot place 911 calls.
Dial plans and extension lengths: When the SIP call manager receives an incomplete number or an illegally formed number from a SIP device, the system terminates the call after it transmits “That extension is not valid” to the caller.

Night bell: SIP extensions can pick up the night bell by pressing star code *14.

Call Handling

Call handling operations provide options for answering or routing incoming calls. SIP extensions support the following call handling options:

- Answer call: SIP extensions can answer calls only from the phone.
  Offering calls can be redirected to Voice Mail, an Automated Attendant, or another extension through Communicator.

- Hang-up: SIP extensions can hang up calls from the phone or from Communicator.

- Ring No Answer (RNA): The number of rings that trigger a No Answer response is specified in the Call Handling Mode definition for each user. When the No Answer condition is triggered, the SIP call manager redirects the call to the RNA destination as specified by Director.

- Busy: When the user call stack is larger than the phone call stack, and the SIP phone rejects overflow calls with SIP response 486 Busy, the switch can redirect the call to the busy destination as specified to do so in ShoreTel Director.

- Forward Always: SIP extensions supports Forward Always. When this parameter is set, all calls will be forwarded to the destination specified by Director.

- Call waiting: The specific call waiting implementation differs for each SIP phone model. SIP extensions support call waiting to one or multiple simultaneously-offered calls for the SIP devices that support this feature.

- Call rejection: If the SIP phone rejects the call with 603 Decline response code, the switch fails the call and plays the reorder tone to the caller.

- Call redirect: If the SIP phone returns a 3xx response code, the switch redirects the call to the user’s RNA destination. If the RNA destination is not configured, the reorder tone is played.

- Find Me: SIP extensions support FindMe and Call Message notification.

Caller ID

Caller ID is the caller information transmitted to the other party during a voice call.

- Caller ID presentation: SIP extensions can display caller name and number.

- Caller ID blocking: SIP extensions support caller ID blocking and Make Number Private.

- Caller ID for Workgroup and Hunt Group agents: The system sends the original caller information while the phone rings. After the recipient answers the call, the system continues to display the original caller name and number.
Call Control

Users manage active voice calls through call control operations. ShoreTel SIP extensions can support the following call controls:

- **Hold**: Call hold and unhold are performed on the phone. Implementation of the reminder ring for held calls differs among SIP phone models.

- **Basic transfer**: SIP extensions support blind transfers that use REFER messages. Transfers that use re-INVITE are not supported.

- **Consultative transfer**: SIP extensions support consultative transfers that use REFER. Transfers that use re-INVITE are not supported.

- **Park from SIP phone**: Calls from SIP extensions are parked when the user selects a different line and then presses the following sequence of keys: *11 number.

- **Unpark on SIP phone**: SIP phone users pick up a parked call by pressing *12 and then the extension number, for example: *122508. (On a SIP phone, taking the handset off-hook is not sufficient to resume a parked call.)

- **Pickup**: SIP phone users pick up a call by pressing *13, followed by the number.

- **Unpark**: SIP phone users unpark a parked call by pressing *12 and then the number.

- **Conference Calls**: Three-party conference calls initiated from the phone use the phone’s resident multipoint control unit (MCU).
  - A three-party conference call is initiated from Communicator uses Make Me conferencing.
  - Make Me conferencing is used when a SIP phone joins a conference call.
  - Four to six-party conference calls are supported by using Make Me. Conferences must be initiated through ShoreTel Communicator.

- **Simultaneous phone ringing**: Multiple SIP extensions can be configured to ring simultaneously in response to a call. A user enables the Additional Phones feature and External Assignment in the ShoreTel Communicator’s Tools > Options window.

- **Call recording**: A SIP extension user can record calls that traverse a SIP trunk if the user has permission. The enable for call recording is in the user’s Class of Service. The user initiates call recording in ShoreTel Communicator.

- **Voicemail**: SIP extensions reach voice mail by pressing the “#” key on the phone or by pressing the Communicator VM button.

- **MWI**: SIP extensions support Message Warning Indicator by using NOTIFY or SUBSCRIBE/NOTIFY on phone models that support MWI. MWI is configurable through SIP phone profiles.

- **Agents**: SIP extensions are available for Workgroup and Hunt Group agents.

- **Bridged call appearance**: SIP extensions do not support Bridged Call Appearances.

- **DTMF**: SIP Extensions support DTMF tones as specified by RFC 2833.
- **Huntgroup busyout**: SIP extensions can busyout huntgroups by pressing *18, followed by the hunt group number.

### General Feature Limitations

ShoreTel does not support some special call features on SIP extensions, as follows:

- **Silent Monitor**: SIP extensions cannot initiate or be the recipient of this operation.
- **Silent Coach**: SIP extensions cannot initiate or be the recipient of this operation.
- **Barge In**: SIP extensions cannot initiate or be the recipient of this operation.
- **Whisper Page**: SIP extensions cannot initiate or be the recipient of this operation.

### System Features

SIP extensions support the following system features:

- **Account codes**: Users on SIP extension can be forced to use account codes for external calls.
- **Bandwidth allocation**: ShoreTel allocates bandwidth for SIP voice calls.
- **Backup Auto Attendant (BAA)**: The SIP call manager switch provides BAA to the SIP extension. All BAA prompts are played in G.711 format.
- **Supported Codecs**: ShoreTel default settings support the negotiation of the following codecs:
  - L16/16000
  - L16/8000
  - AAC_LC/32000
  - PCMU/8000
  - PCMA/8000
  - G722/8000
  - DVI4/8000
  - BV32/16000
  - BV16/8000
  - G729/8000
  - T.38

New codecs can be added to the Supported Codec List. To see a list of the current codecs in ShoreTel Director, navigate to **Administration > Call Control > Supported Codecs**.

- **Fax redirection**: Fax calls to SIP extensions are redirected to the site's fax redirect number.
- **Music on Hold (MoH):** ShoreTel does not support jack-based MOH for SIP extensions; file-based MOH is supported for SIP extensions.

- **Extension Assignment – external devices:** A SIP extension user can be configured so that the Extension Assignment feature can be initiated from devices that are external to the ShoreTel system.

- **On-Net dialing:** SIP extensions can use on-net dialing.

- **PSTN failover:** If PSTN Failover is enabled at the time of a WAN disconnection, a user can still reach someone at another site by using the PSTN. For example, if the WAN connection between two ShoreTel sites is down and a user calls the other office and PSTN failover is enabled, the call traverses the PSTN (instead of failing).

- **Packetization period:** The default packetization period for all calls involving SIP extensions is 20 ms.

- **Video call:** The “Allow intersite video calls” setting in a Telephony Class of Service allows or prevents video calls between ShoreTel sites for users with that Class of Service. For a video call to exist, all participating members must be in a Telephony COS that enables intersite video, have a supported camera model, and have currents drivers for the camera and the video graphics card.

**Note**

The ShoreTel system does not allocate bandwidth for video calls. Consequently, heavy traffic on the network can have an impact on video calls and even audio communication.

- **Country Call Progress Tones and Ring Tones:** SIP extensions provide call progress and ring tones for countries supported by ShoreTel.

- **Language support:** SIP extensions provide support for languages as required by the countries supported by ShoreTel.

**User Assignment**

This section briefly mentions the type of information that ShoreTel customers need for configuring third-party SIP phones. The operational variations and regular updates in the phones from individual manufacturers mean that ShoreTel cannot give specific directions for phone models from third parties. However, several items are very commonly configured on a SIP phone to identify it, as follows:

- **User ID** (according to individual deployments, can be extension number, DID, or Client User ID).

- The SIP password is configured in ShoreTel Director and can consist of the following characters:

  ```
  !#$%&'()*+,-.0123456789::=@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_/
  `abcdefghijklmnopqrstuvwxyz{|}~
  ```

  The characters ? " < > are disallowed by system.

- **The IP address of the SIP proxy at the site.**
Configuring SIP Extensions

This section describes the procedures for setting up SIP extensions.

Specifying the SIP Network Elements

The Site Edit page supports the following SIP configuration tasks for a site:

- Defining the IP address for the SIP proxy server.
- Designating the ShoreTel switches that serve as the site's SIP proxy servers. The site can have a primary server and a secondary server.

To configure the SIP network elements for a ShoreTel site:

1. Launch ShoreTel Director.
2. Navigate to Administration > Sites. The Sites page opens.
3. Click the name of the site to edit. The Edit Site page opens (Figure 215).

![Figure 215: Configuring SIP Network Elements on the Edit Site Page](image)

At the bottom of Figure 215, the SIP Proxy section has the following parameters:

- **Virtual IP Address**: This parameter is the virtual IP address of the site's operational SIP proxy server (registrar server). If redundant proxy servers are configured, this box must have a Virtual IP Address.

**Note**

The Virtual IP Address is independent of the switch that performs the server functions. It must be either outside the address range that a DHCP server manages or marked as reserved, and it must be on the same subnet as the regular IP address of the switch.

In a redundant setup, the Virtual IP Address is used for configuring SIP extensions.
The system instantiates the Virtual IP Address on the switch specified as “Proxy Switch 1.” If “Proxy Switch 1” fails, “Proxy Switch 2” activates the Virtual IP Address on its network interface. When the first proxy returns to service, it again uses the Virtual IP Address, and the back-up proxy releases the address.

If no redundant SIP proxy server is implemented:

- The name of the voice switch is required.
- The Virtual IP Address box can be empty, but we recommend that a Virtual IP Address be assigned to ensure a smooth transition to redundancy in the future.
- The proxy switch IP address must be used when SIP extensions are configured.

- **Proxy Switch 1:** This setting specifies the switch that performs the site’s SIP server functions. The drop-down menu lists all the switches at the site that are configured to support proxy functions. For SIP extensions, this parameter is required.

- **Proxy Switch 2:** This setting is the switch that functions as the SIP proxy server when Proxy Switch 1 is not available. This parameter is optional but recommended.

### Setting the SIP Call Controls

The Edit Call Control Options panel configure SIP parameters for the ShoreTel system.

To configure the SIP Network Elements for a ShoreTel Voice Switch:

1. Launch ShoreTel Director.

2. Click **Administration > Call Control > Options**. The Edit Call Control Options page appears as shown in **Figure 216**.

![Figure 216: Editing SIP Parameters in the Call Control Options Page](image-url)
3. Set values for the following call control parameters:

- **Realm**: The Realm parameter is a name the administrator uses for a protected area (realm) to which the SIP authentication parameters are applied. For digest authentication, each domain of this type defines a set of usernames and passwords that the system uses for granting access.

  Modifying the Realm causes active calls on SIP extensions to be dropped.

- **Enable SIP Session Timer**: The SIP Session Timer controls a timeout period. The specified timeout determines when a SIP device transmits or receives a RE-INVITE or UPDATE method to refresh the current session.

  When Enable SIP Session Timer is enabled, the following parameters are activated and available for configuration:

  - **Session Interval**: The keep-alive period for a SIP session: The session timer enables the detection of stale connections. For example, if a SIP extension makes a call but loses power during the call, and the other end does not disconnect (from a system that does not detect inactivity), the call would be stuck. The session timer function detects this condition and tears down the call. The default of 1800 seconds usually is best for most ShoreTel installations.

  - **Refresher**: The device that sends the refresh: the choices in the associated scroll list are UAC (the caller), UAS (the called party), and none (for no preference).

    The method is either RE-INVITE or UPDATE. The method is dynamically selected, based on the methods advertised by the supported header.

**Creating a SIP Extension Profile**

A SIP Extension ShoreTel Profile is a ShoreTel record that lists characteristics, properties, features, and settings for a specific SIP device. A ShoreTel Voice Switch uses SIP Extension Profiles to monitor and service the SIP devices connected to the system. ShoreTel provides predefined profiles and supports user-defined profiles.

- Predefined profiles support generic devices or devices for which a specific profile is not defined. Although predefined profiles cannot be deleted or modified, they can be deactivated or superseded by user defined profiles.

- User-defined profiles are created through Director and specify settings for certain SIP device models.

**SIP Extension Profile List**

The SIP Extension Profiles List page displays the names of all SIP Extension Profiles on the system. To access the SIP Extension Profile list page:

1. Launch ShoreTel Director.

2. Click **Administration > IP Phones > SIP Profiles**. The SIP Profiles page appears as shown in Figure 210.
Configuring SIP Extensions

Session Initiation Protocol

Figure 217: List of SIP Extension Profiles

Each row corresponds to a SIP extension profile. The columns list the following:

- **Name**: This parameter is the label by which Director refers to the profile.
- **User Agent**: This parameter is the regular expression ShoreTel uses to identify devices covered by the profile. ShoreTel compares this expression to the User Agent field in the header of SIP packets handled by the system.
- **Enabled**: This parameter lists the status of the profile. ShoreTel uses only profiles that are enabled when evaluating the characteristic set of a device.
- **Priority**: This parameter determines the order by which the profiles are evaluated against the SIP packet header. The sequence of profile evaluation is from higher number to lower number.

The User Agent field of successive profiles are compared to the User-Agent field of the SIP packet header until a match is found. The profile containing the matching User-Agent field is then used to specify device configuration settings.

If adding a profile, then press the New button in the top-left corner of the page.

If removing a profile, then select the checkbox that corresponds to the profile to be deleted, then press the Delete button in the upper left corner of the page. Predefined profiles from ShoreTel cannot be deleted.

If editing a profile, then open the Edit SIP Extension Profile page by clicking the name of the profile to be modified.

**Editing a SIP Extension Profile**

The parameters for a SIP extension profile are edited in the Edit SIP Extension Profiles page (Figure 218). This window opens when a system administrator does one of the following:

- Clicks the Add button to create a new SIP extension profile.
- Selects an existing profile for editing.

The Enable is the only parameter that can be modified in a page for a predefined SIP extension profile. To override a predefined parameters, your only options are to:

- Disable the built-in profile
- Define a new custom profile with a higher priority.
Parameters listed on the page include:

- **Name:** This parameter is the label by which Director refers to the profile.

  For predefined profiles, the content of the Name field cannot be edited.

- **User Agent:** This parameter is the regular expression that ShoreTel compares to the User-Agent field in the header of inbound REGISTER or INVITE methods handled by the system.

  For predefined profiles, the content of the User Agent field cannot be edited.

- **Priority:** This parameter is used to determine the profile that is used when the User Agent field of multiple profiles match the User-Agent field in the SIP packet header.

  For predefined profiles, the content of the Priority field cannot be edited.

- **Enable:** This checkbox lets you enable or disable the profile. The switch uses only an enabled profile when it evaluates the characteristics set of a device.

- **System Parameters:** This field lists the device characteristics and default settings.

- **Custom Parameters:** The contents of this field either are additional device settings or overwrites of the default settings listed in the System Parameters field. The custom parameters include:
  
  - **OptionsPing:** If this parameter is set to 1, the SIP device can process SIP OPTIONS commands. An OPTION command goes to the SIP device as a keepalive message.
  
  - **SendEarlyMedia:** Set this parameter is 1 if the SIP device is capable of receiving “early media.” Some BAA prompts are streamed as early media.
  
  - **MWI:**

    - Set to none if the SIP device does not support MWI.
Set to **subscribe** when the SIP device subscribes for message waiting service.

Set to **notify** when the SIP device can receive MWI notification without subscribing to the service.

- **1CodecAnswer**: When **1CodecAnswer** is set to 1, only one codec is set in Answer mode for Session Description Protocol (SDP).

- **StripVideoCodec**: When set to 1, the ShoreTel user agent strips video codecs from SIP SDP.

- **AddGracePeriod**: When extra time needs to be added to the expire time for SIP registrations.

- **FakeDeclineAsRedirect**: When set to 1, the response code “603 decline from SIP endpoint” is treated as a redirect to the CHM destination.

### Allocating Switch Resources

A SIP extension can be utilized only if an unused SIP proxy port is available on a switch. Proxy ports are allocated through the Edit Switch page. To select a switch in ShoreTel Director for resource allocation, navigate to Administration > Platform Hardware > Voice Switches/Service Appliances > Primary. Figure 219 shows the Edit ShoreTel 50 Switch.

![Figure 219: Allocating SIP Proxy Ports](image-url)
ShoreTel Voice Switches provide two SIP proxy port sources: Built-in capacity and port assignment. Definitions of these two sources follow.

- **Built-in capacity**: The half-width switches, such as the ShoreTel Voice Switch 50, provide IP phone, SIP trunk, and SIP proxy resources that are independent of port switches. The number of resources varies with each switch model. Each resource unit supports one IP phone, one SIP trunk, or five SIP Proxies.

  The example in **Figure 219** indicates that the ShoreTel Voice Switch 50 provides 20 resource units. The configuration for resource allocation is as follows:
  
  - 10 resources as IP phones
  - 5 resources as SIP trunks
  - 5 resources that provide 100 SIP proxy ports.

  To allocate the Built-in resource for SIP Proxy Ports, type the number of IP Phone and SIP Trunk resources in their respective data entry fields. The remaining resources are available to serve as SIP proxy ports.

- **Port resources**: Switch ports can be configured to support 100 SIP proxy ports.

- **IP Phone ports**. Each SIP extension consumes 1 IP phone port.

  To configure a port for SIP Proxy Port allocation, access the drop down menu of a port in the port section of the page and select the 100 SIP Phones option.

**Setting an Extension Password**

An extension is enabled for SIP if a value is assigned to the User’s SIP Password parameter. The SIP Password parameter is located at the bottom of the Edit User: General page, as shown in **Figure 220**. Clearing the SIP Password data fields disables the extension from supporting SIP.
Monitoring SIP Phones

All SIP extension devices on the ShoreTel network are listed on the IP Phone page in Director, as shown in Figure 221. SIP devices are deleted from this page when they are physically removed from the network.

Clicking on the name of a SIP device opens the Edit IP Phone page for that device. In addition to the information listed on the IP Phones list page, the Edit IP Phone page displays the Credential Name, User Name, Contact, and Address of Record for the device. The only information editable from this page is the name of the device.
Figure 221: SIP Devices Listed on IP Phones List Page

**SIP Register Window**

For rare implementations, a highly skilled, senior system administrator can use the SIP Register pop-up window *Figure 222* for manually configuring a SIP device. For example, the purpose of manual configuration might be to make a particular SIP device operate like another SIP device, but such an effort can be very problematic and error-prone. Therefore, we recommend that administrators not use manual configuration and instead just let the end-user register the SIP phone by using the typical registration steps for the device.

The popup in ShoreTel Director appears when the administrator clicks on the SIP Registration button on the IP Phones page.
Integrating ShoreTel SIP with Unified Messaging from Third-party Vendors

ShoreTel software lets an organization integrate an external, third-party unified messaging (UM) system with the ShoreTel system. ShoreTel also supports customer plans for deploying a separate voicemail or fax server within the ShoreTel environment. After setting up the ShoreTel solution, a customer can deploy a third-party solution (such as Microsoft Exchange) to play voicemail or send faxes (through a ShoreTel-supported UM fax server).

For UM integration, ShoreTel has certified and supports Microsoft Exchange Server 2007 and Microsoft Exchange Server 2010 although other integrations are also feasible.

Considerations for Integrating with Third-party UM

Plans for integrating a ShoreTel network with a third-party UM system should include the consideration of the following behaviors:

- After ShoreTel user accounts move to a third-party UM server, those users’ existing voicemails are deleted from the ShoreTel system. Therefore, we recommend that you save existing voicemails before integrating with ShoreTel.

- ShoreTel does not actually integrate voicemail with Outlook even though you can enable Outlook integration in Communicator. This enable lets ShoreTel partners or outside vendors set up the integration of voicemail with Outlook.

- The message waiting indicator (MWI) that signals a waiting voicemail messages is not available for ShoreTel Communicator.

- The following voicemail features are not available to a user when ShoreTel is integrated with third-party UM systems:
  - Any Phone
  - Find-Me
  - Escalation Profiles

- Switching between ShoreTel and External SIP Unified Messaging voicemail results in the following conditions.
  - Loss of all existing ShoreTel messages (so we recommend initial backup).
  - Users might need to re-create the ShoreTel Communicator rules to reflect the new voicemail number.
Configuring a ShoreTel SIP Unified Messaging Server

This section describes the steps for configuring a ShoreTel SIP UM server.

To integrate ShoreTel with a third-party UM system, the system administrator must:

1. Configure a ShoreTel SIP server through ShoreTel Director.
2. Set up and configure one of the supported third-party UM solutions.

**Note**

Enable a ShoreTel Voice Switch to be the SIP proxy for the site where you add the SIP UM Server.

Configuring the SIP Server

Setting up and configure a SIP unified messaging server:

1. Launch ShoreTel Director and log in as the administrator.

2. Navigate to Administration > SIP Servers > SIP Servers.

3. Click the New button. The window shown in Figure 223 opens.
4. Enter the SIP Server information for the new server.

Table 83 displays the IP Server configuration fields and descriptions.

5. Click **Save** when you finish.

Table 83: SIP Server Info Requirements

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>SIP Server name (usually that of a Microsoft Exchange).</td>
</tr>
<tr>
<td>Site</td>
<td>Site where this UM Server resides. Note that a pop-up message appears if the UM Server site changes later.</td>
</tr>
<tr>
<td>Host (Name/Address/Domain):</td>
<td>Despite the presence of (host) “Name,” you must enter either the IP address or fully qualified domain name.</td>
</tr>
</tbody>
</table>
Creating a User Group to Have Access to SIP Servers

After you have created a SIP server, create a user group with access to the servers. To do so:

1. Launch ShoreTel Director and log in as the administrator.
2. Navigate to Administration > Users > User Groups.
3. Click Add New. The page for creating and editing a user group appears (see Figure 224 for the current example).
4. Specify a name that reflects this user group—SIPUM for this example.
5. In the scroll list Voice Mail Interface Mode (near the bottom of Figure 224, select External Voice Mail, SIP from the drop-down list.
6. Configure other details for the deployment as needed.
7. After finishing the selections, click Save near the top of the page.
The CHM destinations for this user group are set to the selected SIP server extension.

Figure 224: Creating a New User Group to Have SIP Server Access

Configuring a User for Access to a SIP Server

A user has access to the facilities supported on a SIP server by belonging to a user group that has access to a SIP server. The key point for giving SIP server access to the user’s voicemail and other messages is to put the user in a user group that has that access. (Such a user group is described in Creating a User Group to Have Access to SIP Servers on page 622.)

Note
The steps that follow relate to SIP server access only. The complete description of user-configuration tasks are in Chapter 10, Configuring Users on page 335.

Giving the SIP access to a user:

1. Launch ShoreTel Director and log in as an administrator.

2. Navigate to Administration > Users > Individual Users.

3. This step depends on whether the user account is new or already existing:
   a. Click Go at the top of the page to create a new user account.
b. Click the name of the user.

4. For License Type (upper part of Figure 225), select Extension-Only.

5. For User Group, select a group that has SIP server permissions from the drop-down list (middle of Figure 225). In this example, the user group is SIPUM.

Figure 225: Configuring a User for Access to a SIP Server

6. Select a UM server in the drop-down list next to the External Mailbox though Server (bottom of Figure 225).

7. Click Save when done.

Configuring a Third-party Unified Messaging Server

After configuring ShoreTel Director, you must set up and configure the third-party UM server. For more information on configuring ShoreTel-supported, third-party UM solutions, contact the ShoreTel Innovation Network Partner Program.

For general information, go to the following location:

http://www.shoretel.com/partners/tech_developers
**Note**

A Unified Messaging SIP Link license is required for every Unified Messaging (SIP) server added in ShoreTel Director. To add a server, the check box Allow External Voice Mail for Extension-Only User must be marked.
CHAPTER 19

Maintenance

This chapter discusses the procedures for maintaining your ShoreTel system. It contains the following information:

Overview of System Maintenance Tasks ................................................................. 629
Viewing System Information with Quick Look ...................................................... 629
  Opening the Quick Look Page ........................................................................... 630
  Switch Information in Quick Look .................................................................... 630
  Server and Appliance Information in Quick Look .............................................. 630
  Conferencing Information in Quick Look .......................................................... 631
  Applying Commands in Quick Look ................................................................. 632
Accessing the Maintenance Information for Voice Switches .............................. 632
  Viewing the Maintenance Switches Summary .................................................. 633
  Maintenance - Voice Switches and Service Appliances Summary Page ........ 633
  Viewing Maintenance Information for a Specific Voice Switch ....................... 639
Accessing Maintenance Information for a Service Appliance ........................... 640
  Viewing Maintenance Information for a Service Appliance ............................ 640
  Service Appliance Maintenance Page .............................................................. 640
Accessing Server Maintenance Information ....................................................... 642
  Viewing Maintenance Information for a Main Server ...................................... 642
  Main Server Maintenance Page ......................................................................... 642
  Accessing Distributed Voice Server (DVS) Maintenance Information ............. 644
Monitoring Switch Connectivity ......................................................................... 644
Monitoring Voice Mail Servers .......................................................................... 645
Monitoring Make Me Conferencing Information ................................................. 645
Monitoring Audio and Web Conferencing Activity ............................................. 646
Viewing the IM Servers Maintenance Summary .......................................................... 647
Using Event Filters .................................................................................................. 647
  Editing and Creating Event Filters ...................................................................... 647
  Event Filters List Page ....................................................................................... 648
  Event Filter Parameters ..................................................................................... 648
Viewing the Event Log for the Headquarters Server ............................................... 649
Viewing Headquarters Services .............................................................................. 650
Database Maintenance ........................................................................................... 650
  Setting Performance Tuning Parameters for MySQL ........................................ 651
  Monitoring MySQL Services ........................................................................... 651
  Browsing MySQL Database Tables .................................................................. 652
  Ensuring Compatibility with Backup and Antivirus Utilities ............................. 652
  Backing up and Restoring ShoreTel Databases .............................................. 652
Disk Space Reclaim ................................................................................................ 653
  Running the Disk Reclaim Tool on the Headquarters Server ............................ 654
  Running Disk Reclaim on a Distributed Voice Server ...................................... 657
Overview of System Maintenance Tasks

To maintain your ShoreTel system, you need to be able to check the operational status of all components in your ShoreTel system. You also need to monitor system events or errors, maintain the system's database, and periodically reclaim disk space.

You can access system maintenance information using either of the following methods, which are both available in the Maintenance menu of ShoreTel Director:

- Diagnostics & Monitoring system, as described in Chapter 20
- Quick Look and the other options in the Maintenance menu, as described in this chapter

Viewing System Information with Quick Look

The Quick Look page, as shown in Figure 226, provides a snapshot of the entire ShoreTel system. It includes information about each site and its corresponding switches and servers.

The Quick Look page includes the following sections:

- Switches
- Servers and Appliances
- Conferencing

The Quick Look page also includes a section at the bottom that allows you to apply commands (such as Restart, Reboot, and so on) to switches and appliances or commands (such as Publish All) to servers.

Subsequent sections in this chapter describe the information in these sections, as well as the more detailed pages you can access by clicking links in these sections.
Opening the Quick Look Page

1. Launch ShoreTel Director.

2. Click Maintenance > Quick Look.

   The Quick Look page opens.

   **Tip**
   The system updates the information on the Quick Look page every 60 seconds, but you can click the Refresh link at the top of the page to trigger an immediate refresh.

Switch Information in Quick Look

The Switches section lists all of the sites on your system. Sites with no server list the associated server by which they are served. The following information is displayed in the Switches section:

- **Site**: Clicking the name of a site will bring you to the Maintenance - Voice Switches and Service Appliances Summary page.

- **TMS Comm**: This summarizes the communication state of all switches at the site. The first number represents switches with which TMS can currently communicate. The second number is the total number of switches at the site.

- **Usage**: This shows either an Idle or In Use state.

- **Service**: This summarizes the most severe status of any switch or appliance at the site.

Server and Appliance Information in Quick Look

The Servers and Appliances area in Quick Look lists all of the ShoreTel servers and provides high-level status information about the server or appliance. Table 84 provides details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Server/Appliance | The server and appliances associated with the site.  
                      (Any site without a server has a blank line in the Servers and Appliances area.)  
                      To see a list of services running on a server, the status of each service, and a choice between starting and stopping each service, click on the server name link in the Server/Appliance column. |
| Type          | The type/model of server or appliance                                         |
| Status        | The status of the server or appliance                                         |
| Services      | A summary of the status of the ShoreTel services on the server                |
The Conferencing area in Quick Look displays system-wide information about web and audio conferencing capacity and activity in your ShoreTel system. Table 85 provides details.

**Table 85: Fields in the Conferencing Area in Quick Look**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Total Conference Ports | The types of conferencing on the system:  
  ■ Audio  
  ■ Web |
| In-Use              | The total number of audio and web conference ports currently in use |
| Licensed Capacity   | The number of audio and web licenses on the system |
| System Capacity     | The system’s maximum number of audio and web ports available |


Applying Commands in Quick Look

On the Quick Look page, you can apply various commands to all switches and appliances or all servers by using the following drop-down list fields at the bottom of the page:

- **Apply This Command to All Switches and Appliances:** Certain commands are available for specific switches and appliances. For example, you can restart or reboot these devices either immediately or when they are idle. For details about commands that can be applied to switches and appliances, see the description of the “Command” field in Table 86 on page 633.

- **Apply This Command to All Servers:** The drop-down list lets you specify commands to publish wallpaper, ring tones, or both, from HQ server to DVS server. You can write local copies of ring tones and wallpapers from HQ servers to DVS servers and then make them available to the associated HQ/DVS users and user groups.

To publish ring tones and wallpapers:

a. Upload the local copies of ring tones and wallpapers on HQ server.

   For more details on uploading wallpaper, see Chapter 8, Customizing Wallpaper on Color Phone Displays on page 227

   For more details on uploading ring tones, see Chapter 8, Customizing Ringtones on page 223

b. Execute any of the following commands:

   1. **Publish ring tones:** Copies in-used or edited ring tones from HQ server to DVS server.

   2. **Publish wallpapers:** Copies in-used or edited wallpapers from HQ server to DVS server.

   3. **Publish all:** Copies in-used ring tones or wallpapers from HQ server to DVS ring tones or wallpapers folder.

      Publish command does not push ring tones or wallpapers to the phones. Phones get the ring tones or wallpapers when they are assigned to a user group that has in-used ring tones or wallpapers assigned to it.

   4. Navigate to the required User Profile or the User Group and select the publish option as required.

- **Temporarily Disable IP Phone Failover Across Sites:** This command lets you disable automatic IP phone failover in preparation for maintenance.

Accessing the Maintenance Information for Voice Switches

You can access summary or detailed maintenance information for voice switches. This section describes the procedures for viewing this information.
Viewing the Maintenance Switches Summary

1. Launch ShoreTel Director.
2. Click Maintenance > Quick Look.
   The Quick Look page opens.
3. Click a site name.
   The Maintenance - Voice Switches and Service Appliances Summary page opens, listing information about all of the ShoreTel voice switches and service appliances configured at the site.

The drop-down list for the **Apply This Command to All Switches and Appliances** field lets you restart or reboot all switches and appliances. For details about the various commands, see the description of the "Command" field in Table 86 on page 633.

**Maintenance - Voice Switches and Service Appliances Summary Page**

**Voice Switches and Service Appliances Section**

**Table 86** provides details about the fields on the Maintenance - Voice Switches and Service Appliances Summary.

**Table 86: Fields in the Voice Switches and Service Appliances Section on the Maintenance - Voice Switches and Service Appliances Summary Page**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch/Appliance</td>
<td>The name of the voice switch or service appliance. Clicking a device name opens the Diagnostics and Monitoring status page for that device.</td>
</tr>
<tr>
<td>IP Phones</td>
<td>The number of IP phones currently registered with the device and the device capacity</td>
</tr>
<tr>
<td>SIP Trunks</td>
<td>The number of SIP trunks currently registered with the device and the capacity of SIP trunks the device is configured to support</td>
</tr>
<tr>
<td>SIP Proxy</td>
<td>The SIP Proxy capacity configured on the switch. A green dot near the value for this field indicates that this switch is the SITE Proxy Switch.</td>
</tr>
<tr>
<td>BCA</td>
<td>The number of Bridge Call Appearance (BCA) extensions currently registered with the device, and the BCA capacity the device is configured to support</td>
</tr>
<tr>
<td>Type</td>
<td>The type of device</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address assigned to the device</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The MAC address of the device</td>
</tr>
<tr>
<td>Comm</td>
<td>The number of devices with which this switch is currently communicating and the total number of devices on the network with which this device can communicate</td>
</tr>
<tr>
<td></td>
<td>Clicking the Comm fraction takes you to the Switch Connectivity page, which provides more detail on each switch’s communication status.</td>
</tr>
</tbody>
</table>
### Table 86: Fields in the Voice Switches and Service Appliances Section on the Maintenance - Voice Switches and Service Appliances Summary Page (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Ports</td>
<td>The number of audio conference ports the device is currently using and the number of audio conference ports the device is licensed to use. ShoreTel service appliances (SA-100 and SA-400) support conference ports.</td>
</tr>
<tr>
<td>Web Ports</td>
<td>The number of Web conference ports that the device is currently using and the number of Web conference ports the device is licensed to use. Values for service appliances also appear in this area.</td>
</tr>
<tr>
<td>Conference</td>
<td>The number of MakeMe conference ports currently in use and the capacity of MakeMe conference ports configured to support</td>
</tr>
<tr>
<td>Hunt Groups</td>
<td>The number of hunt groups registered with the device</td>
</tr>
<tr>
<td>Usage</td>
<td>The usage state of the device:</td>
</tr>
<tr>
<td></td>
<td>- Unknown—The usage state is unknown, perhaps because communication between the server and the switch has been lost.</td>
</tr>
<tr>
<td></td>
<td>- In Use—At least one port or IP phone has an active call.</td>
</tr>
<tr>
<td></td>
<td>- Off Hook—At least one port or IP phone is off-hook, but no ports are in use.</td>
</tr>
<tr>
<td></td>
<td>- Idle—No ports or IP phones are off-hook or in-use.</td>
</tr>
</tbody>
</table>
Table 86: Fields in the Voice Switches and Service Appliances Section on the Maintenance - Voice Switches and Service Appliances Summary Page (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Service                | The device’s service state. More than one service state can be in effect for a device, but only the most severe service state is displayed until that state is resolved. Possible values are as follows:  
  - D Channel Down—The PRI D channel is down.  
  - Lost Communication—The server lost communication with the voice switch. The voice switch may be fully operational, but the ShoreTel server cannot see the voice switch due to a networking issue. This service state also occurs when the voice switch is powered off.  
  - Upgrade in Progress—The voice switch is currently being upgraded to a new software version.  
  - Restart Pending—A Restart when idle command was issued, but the restart did not occur because ports are still in use.  
  - Firmware Version Mismatch—The voice switch is running a version of software that does not match the version on the server. The voice switch continues to run call control but does not have access to any voice services on the server. This typically happens on software upgrades after the server was upgraded but before the voice switches were restarted and upgraded. Note that voice switches at the same firmware version also continue to operate together.  
  - Firmware Update Available—The server has a new optional version of firmware available for the voice switch. A voice switch in this state continues to run call control as well as access the voice services on the server. This state typically happens when you install a patch on the ShoreTel server. To propagate the patch to the voice switches, you must restart them.  
  - FTP Booted—This ShoreTel voice switch did not boot from FLASH memory but booted from an FTP server, most likely on the ShoreTel server. You can correct this problem by rebooting the voice switch. If this does not correct the problem, contact ShoreTel Technical Support.  
  - Port Out of Service—All ports on the ShoreTel voice switch are out of service.  
  - IP Phone(s) Out of Service—One or more IP phones associated with the switch are out of service.  
  - Port Out of Service—One or more, but not all, ports or IP phones are out of service on the ShoreTel voice switch. Ports or IP phones typically go out of service because either someone manually put them out of service or the call control software automatically put them out of service due to a signaling problem (for example, the dial tone was not received from the central office).  
  - In Service—Configured ports or IP phones are ready for service. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Lets you issue any of the following commands for the device:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Restart</strong>: Select this option to immediately stop and restart all services on each switch. Calls that the switches are servicing when this command is selected are lost. For the following voice switches and service appliances, this option performs an upgrade and reboot if a new firmware version is available: SG-90V, SG-50V, SG-90BRIV, virtual phone switch, virtual trunk switch, SA-100, SA-400, and virtual service appliance.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Restart when idle</strong>: Select this option to stop and restart all services on each switch after the calls which it is managing are completed. Calls that are active when this command is selected are allowed to finish normally. For the following voice switches and service appliances, this option performs an upgrade and reboot if a new firmware version is available: SG-90V, SG-50V, SG-90BRIV, virtual phone switch, virtual trunk switch, SA-100, SA-400, and virtual service appliance.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Reboot</strong>: Select this option to immediately stop all services and reboot each switch. Calls that the switches are servicing when this command is selected are lost. For the following voice switches and service appliances, this option performs an upgrade and reboot if a new firmware version is available: SG-90V, SG-50V, SG-90BRIV, virtual phone switch, virtual trunk switch, SA-100, SA-400, and virtual service appliance.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Reboot when idle</strong>: Select this option to stop all services and reboot each switch after the calls that it is managing are completed. Calls that are active when this command is selected are allowed to finish normally. For the following voice switches and service appliances, this option performs an upgrade and reboot if a new firmware version is available: SG-90V, SG-50V, SG-90BRIV, virtual phone switch, virtual trunk switch, SA-100, SA-400, and virtual service appliance.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Put in service</strong> puts all ports on the switch in service. Ports already in service with active calls are not affected.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Put out of service</strong> places all ports on the voice switch out of service. Active calls are dropped. This command is a forceful way to remove traffic from a voice switch before you replace the switch.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Put out of service when idle</strong> puts all idle ports out of service, and remaining ports are also put out of service when they go idle. This command is a graceful way to remove traffic from a voice switch before you replace it.</td>
</tr>
</tbody>
</table>

**Note**

For SoftSwitches, the command list includes only **Restart** and **Restart When Idle**.

### Spare Voice Switches Area

Table 87 describes the fields in the Spare Voice Switches area on the Maintenance - Voice Switches and Service Appliances Summary page.
Table 87: Fields in the Spare Voice Switches Area on the Maintenance - Voice Switches and Service Appliances Summary Page

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spare Switch</td>
<td>The name of the spare switch</td>
</tr>
<tr>
<td>IP Phones</td>
<td>The number of phones currently registered with the switch and the total number the switch supports</td>
</tr>
<tr>
<td>Type</td>
<td>The switch type</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the spare switch</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The Ethernet address of the spare switch</td>
</tr>
<tr>
<td>Failover Status</td>
<td>The status of the spare switch</td>
</tr>
<tr>
<td>Current Site</td>
<td>The site the spare switch currently supports</td>
</tr>
<tr>
<td>Home Site</td>
<td>The site in which the spare switch is registered</td>
</tr>
<tr>
<td>Usage</td>
<td>The usage state of the device:</td>
</tr>
<tr>
<td></td>
<td>- In Use—At least one port or IP phone has an active call.</td>
</tr>
<tr>
<td></td>
<td>- Off Hook—At least one port or IP phone is off-hook, but no ports are in use.</td>
</tr>
<tr>
<td></td>
<td>- Idle—No ports or IP phones are off-hook or in-use.</td>
</tr>
<tr>
<td></td>
<td>- Unknown—The usage state is unknown, perhaps because communication between the server and the switch has been lost.</td>
</tr>
<tr>
<td>Service</td>
<td>The service state of the device:</td>
</tr>
<tr>
<td></td>
<td>- In Service—Configured ports or IP phones are ready for service.</td>
</tr>
<tr>
<td></td>
<td>- Lost Communication—The server lost communication with the voice switch. The voice switch may be fully operational, but the ShoreTel server cannot see the voice switch due to a networking issue. This service state also occurs when the voice switch is powered off.</td>
</tr>
<tr>
<td></td>
<td>- Upgrade in Progress—The voice switch is currently being upgraded to a new software version.</td>
</tr>
<tr>
<td></td>
<td>- Restart Pending—A Restart when idle command was issued, but the restart did not occur because ports are still in use.</td>
</tr>
<tr>
<td></td>
<td>- Port Out of Service—All ports on the ShoreTel voice switch are out of service.</td>
</tr>
</tbody>
</table>
Table 87: Fields in the Spare Voice Switches Area on the Maintenance - Voice Switches and Service Appliances Summary Page (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Service (continued)           | - Firmware Version Mismatch—The voice switch is running a version of software that does not match the version on the server. The voice switch continues to run call control but does not have access to any voice services on the server. This typically happens on software upgrades after the server was upgraded but before the voice switches were restarted and upgraded. Note that voice switches at the same firmware version also continue to operate together.  
- Firmware Update Available—The server has a new optional version of firmware available for the voice switch. A voice switch in this state continues to run call control as well as access the voice services on the server. This state typically happens when you install a patch on the ShoreTel server. To propagate the patch to the voice switches, you must restart them.  
- FTP Booted—The ShoreTel voice switch did not boot from FLASH memory but booted from an FTP server, most likely on the ShoreTel server. You can correct this problem by rebooting the voice switch. If this does not correct the problem, contact ShoreTel Technical Support.  
- IP Phone(s) Out of Service—One or more IP phones associated with the switch are out of service.  
- Port Out of Service—One or more, but not all, ports or IP phones are out of service on the ShoreTel voice switch. Ports or IP phones typically go out of service because either someone manually put them out of service or the call control software automatically put them out of service due to a signaling problem (for example, the dial tone was not received from the central office). |
Viewing Maintenance Information for a Specific Voice Switch

1. Launch ShoreTel Director.
2. Click **Maintenance > Quick Look**.
   The Quick Look page opens.
3. Click a site name.
   The Maintenance - Voice Switches and Service Appliances Summary page opens.
4. Click a switch name.
   The status page for that device opens in the Diagnostics & Monitoring system. For details, see Chapter 20, *Monitoring and Diagnosing* on page 659.

### Table 87: Fields in the Spare Voice Switches Area on the Maintenance - Voice Switches and Service Appliances Summary Page (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Lets you issue any of the following commands for the device:</td>
</tr>
<tr>
<td><strong>Restart</strong></td>
<td>restarts the voice switch, and active calls are dropped. This command is a</td>
</tr>
<tr>
<td></td>
<td>forceful way to shed traffic from a voice switch when you are performing a</td>
</tr>
<tr>
<td></td>
<td>software upgrade.</td>
</tr>
<tr>
<td><strong>Restart when idle</strong></td>
<td>restarts the voice switch when all ports are idle. All idle ports are</td>
</tr>
<tr>
<td></td>
<td>put out of service and remaining ports are put out of service when they go</td>
</tr>
<tr>
<td></td>
<td>idle. When all ports are out of service, the voice switch restarts. This</td>
</tr>
<tr>
<td></td>
<td>command is a graceful way to remove traffic from a voice switch before you</td>
</tr>
<tr>
<td></td>
<td>perform a software upgrade. Active calls are completed, but no new calls</td>
</tr>
<tr>
<td></td>
<td>can be made or received until the voice switch restarts.</td>
</tr>
<tr>
<td><strong>Reboot</strong></td>
<td>reboots the voice switch.</td>
</tr>
<tr>
<td><strong>Reboot when idle</strong></td>
<td>reboots the voice switch when all ports are idle.</td>
</tr>
<tr>
<td><strong>Put in service</strong></td>
<td>puts all ports on the voice switch in service. Ports already in service</td>
</tr>
<tr>
<td></td>
<td>with active calls are not affected.</td>
</tr>
<tr>
<td><strong>Put out of service</strong></td>
<td>places all ports on the voice switch out of service. Active calls are</td>
</tr>
<tr>
<td></td>
<td>dropped. This command is a forceful way to remove traffic from a voice</td>
</tr>
<tr>
<td></td>
<td>switch before you replace the switch.</td>
</tr>
<tr>
<td><strong>Put out of service when idle</strong></td>
<td>puts all idle ports out of service, and remaining ports</td>
</tr>
<tr>
<td></td>
<td>are also put out of service when they go idle. This command is a graceful</td>
</tr>
<tr>
<td></td>
<td>way to remove traffic from a voice switch before you replace it.</td>
</tr>
<tr>
<td><strong>Failback</strong></td>
<td>clears the parameters assigned to the system for failover and returns the</td>
</tr>
<tr>
<td></td>
<td>switch to the spare-switch state at the home site.</td>
</tr>
</tbody>
</table>
Accessing Maintenance Information for a Service Appliance

The Service Appliance Maintenance page shows information about a service appliance’s operation conference port usage, and IM server usage.

Viewing Maintenance Information for a Service Appliance

1. Launch ShoreTel Director.
2. Click Maintenance > Quick Look.
   The Quick Look page opens.
3. In the Server/Appliance column, click the service appliance whose maintenance information you want to view.
   The Service Appliance Maintenance page is displayed.

Service Appliance Maintenance Page

The Service Appliance Maintenance page includes the Service Appliance Status section and the IM Status section.

Service Appliance Status Section

Table 88 provides details about the fields in the Service Appliance Status section of the Service Appliance Maintenance page.

Table 88: Fields on the Service Appliance Maintenance Page, Service Appliance Status Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Server</td>
<td>The status of the server:</td>
</tr>
<tr>
<td></td>
<td>- Running</td>
</tr>
<tr>
<td></td>
<td>- Stopped</td>
</tr>
<tr>
<td>Collaboration Management Conference Attendant</td>
<td>The status of the Collaboration Management Conference Attendant:</td>
</tr>
<tr>
<td></td>
<td>- Running</td>
</tr>
<tr>
<td></td>
<td>- Stopped</td>
</tr>
<tr>
<td>Software Telephony Switch</td>
<td>The status of the Software Telephony Switch:</td>
</tr>
<tr>
<td></td>
<td>- Running</td>
</tr>
<tr>
<td></td>
<td>- Stopped</td>
</tr>
<tr>
<td>Telephony Management Server</td>
<td>The status of the Telephony Management Server:</td>
</tr>
<tr>
<td></td>
<td>- Running</td>
</tr>
<tr>
<td></td>
<td>- Stopped</td>
</tr>
</tbody>
</table>
Table 89 provides details about the fields in the IM Status section of the Service Appliance Maintenance page.

### IM Status Section

Table 89: Fields on the Service Appliance Maintenance Page, IM Status Section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange Connector</td>
<td>The status of the logical Exchange Connector that supports the synchronization between Microsoft Exchange and a designated service appliance. Status is either ON or OFF. The designated service appliance performs the synchronization on behalf of all other service appliances at the site. Therefore, if the current service appliance shows ON for Exchange Connector, all other service appliances show OFF in this field.</td>
</tr>
<tr>
<td>Last Exchange Sync Time</td>
<td>The timestamp for the last synchronization (or polling time) of data between the service appliance and Microsoft Exchange calendar</td>
</tr>
<tr>
<td>Peak Audio Port</td>
<td>The highest number of simultaneously active audio ports this appliance has used since its last restart. A restart resets this value to 0.</td>
</tr>
<tr>
<td>Current Audio Port</td>
<td>The current number of web-based conferences</td>
</tr>
<tr>
<td>Peak Web Port</td>
<td>The highest number of simultaneously active web ports this appliance has used since its last restart. A restart resets this value to 0.</td>
</tr>
<tr>
<td>Current Web Port</td>
<td>The current number of web-based conferences</td>
</tr>
<tr>
<td>Disk Used</td>
<td>The amount of used disk space on the service appliance. A colored icon indicates disk usage as follows:</td>
</tr>
<tr>
<td></td>
<td>- Yellow indicates 25-50% of the disk is used.</td>
</tr>
<tr>
<td></td>
<td>- Orange indicates less than 25% of the disk is used.</td>
</tr>
<tr>
<td>Disk Capacity</td>
<td>The total disk space capacity</td>
</tr>
<tr>
<td>Total Conferences</td>
<td>The configured number of conferences the service appliance supports</td>
</tr>
<tr>
<td>Total Active Conferences</td>
<td>The total number of active conferences</td>
</tr>
<tr>
<td>Requests per Hour</td>
<td>The number of conference requests per hour to the server. In the current release, an Apache server is the only server whose requests are counted</td>
</tr>
</tbody>
</table>

Table 88: Fields on the Service Appliance Maintenance Page, Service Appliance Status Section (Continued)
Accessing Server Maintenance Information

The types of servers that you might have in the ShoreTel system include the main Headquarters server and distributed voice servers. ShoreTel Director displays different information on the maintenance pages for each type of server.

Viewing Maintenance Information for a Main Server

1. Launch ShoreTel Director.
2. Click Maintenance > Quick Look.
   The Quick Look page opens.
3. In the Server/Appliance column, click the server for which you want to view maintenance information.
   The Main Server Maintenance page opens.

Main Server Maintenance Page

When you click on the Headquarters server in Quick Look, the system displays the Main Server Maintenance page. This page includes the following sections:

- Status
- Database
- Services
- Events

Status Section

The Status area includes the following information about the Telephone Application Programming Interface (TAPI) and Simple Mail Transfer Protocol (SMTP), which carries voice messages between voice mail servers:

- TAPI Status:
  - OK—The TSP on the main server knows that the applications on the server have logged into TAPI.

Table 89: Fields on the Service Appliance Maintenance Page, IM Status Section (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peak Sessions</td>
<td>The peak load observed on the appliance since the last restart. A restart of the appliance resets this value to 0.</td>
</tr>
<tr>
<td>Current Sessions</td>
<td>The current number of active IM sessions at the present moment</td>
</tr>
</tbody>
</table>
Lost TAPI—The TSP on the main server knows that the applications on the server are not logged into TAPI.

SMTP Status:
- OK—The SMTP messages for the server are leaving.
- Failed—The SMTP outbound queue on the server is not sending email messages.

Database Section

The Database area provides the following details about the master database:
- Master State
- Master Log File Name
- Master Log Pos

You can create a database snapshot by clicking Create Snapshot.

Services Section

The Services area provides details about the ShoreTel services. For details about these services, see Table 100 on page 710.

At the bottom of the Services section, you can click Stop All or Start All to stop and start all services.

Note
When you click Stop All, you may receive a message stating the local host is not responding. To continue, click Recover webpage.

Events Section

The Events area summarizes event activity by listing the number of events logged during the last two days—Today and Yesterday. Clicking Go to Application Log takes you to the Application Event Log page. Clicking Go to System Log takes you to the Application Event Log page. For more information, see Monitoring Audio and Web Conferencing Activity on page 646.

The Events area displays the following fields:
- Date: The day the event was reported (Today or Yesterday)
- Errors: The number of reported errors. Errors require your immediate attention.
- Warnings: The number of reported warning messages. Warnings alert you to potential errors.
- Informational: The number of reported informational messages. Informational messages provide the status of a service, switch, or port.
Accessing Distributed Voice Server (DVS) Maintenance Information

The status of distributed voice servers is displayed on the Distributed Server Maintenance page. The Distributed Server Maintenance page is hosted on a web site on the distributed server. The information provided is a subset of the information provided on the Main Server Maintenance page, because not all ShoreTel services run on the distributed voice server. However, the Distributed Server Maintenance page

Database Connection Section

The Database area provides the following details about the master database:

- Master State
- Master Log File Name
- Master Log Pos

You can synchronize the local database with the master database by clicking Resync.

Local Database Section

If Distributed Database is configured, the Local Database section provides the following details about the local copy of the database:

- Replication State status
- Slave IO Thread status
- Slave SQL Thread status
- Master Log File Name
- Read Master Log Position
- Exec Master Log Position
- Pending Local Updates
- Estimated Seconds Behind Master
- Last Error

Monitoring Switch Connectivity

The Switch Connectivity page lists all ShoreTel voice switches when Distributed Routing Service (DRS) is disabled. When DRS is enabled, the switch connectivity table is organized by site.

In the connectivity grid, the following indicators provide information about a switch:

- Green (C) indicates that the switch is connected and communicating with other switches in the system.
- Yellow (U) indicates that the switch connectivity is unknown because it cannot communicate with TMS.
Red (N) indicates that the switch has lost communications with the server.

For more detailed information about a switch, place the cursor over a connectivity cell to display status information in the status bar at the bottom of the browser.

## Monitoring Voice Mail Servers

The Maintenance menu in ShoreTel Director provides pages that show maintenance information for voice mail servers and voice mailboxes configured in the ShoreTel system.

### Viewing Status Information for a Voice Mail Server

1. Launch ShoreTel Director.
2. Click **Maintenance > Voice Mail Servers**.

   The Voice Mail Servers Maintenance Summary page appears, displaying high-level status information.
3. Click the name of a voice mail server.

   The Voice Mail Servers Maintenance page appears, displaying both summary information and details about the voice mailboxes on the voice mail server.

### Voice Mail Servers Maintenance Summary Page

The fields on the Voice Mail Servers Maintenance Summary page are described in Table 104 on page 719.

### Voice Mail Servers Maintenance Page

The fields on the Voice Mail Servers Maintenance page are described in Table 105 on page 720.

## Monitoring Make Me Conferencing Information

The Make Me Conferencing page shows the number of ports currently in use for conferencing and the number of allocated ports that are free for conferencing at each site. The number of Make Me Conference calls that are active at each site is also displayed. Clicking an entry in the Site column opens the Maintenance - Voice Switches and Service Appliances Summary page.
The Make Me Conferencing page contains the following sections:

- **In-Use**
  - Active Calls: The number of calls currently active on the ports at a site
  - Ports: The number of ports that are in use at each site

- **Free**
  - Ports: The number of ports that are free at each site
  - Percent: The percentage of total ports at a site that are currently free

## Monitoring Audio and Web Conferencing Activity

The Audio and Web Conferencing Summary page provides information about the number of ports being used for audio and web conferencing.

1. Launch ShoreTel Director.
2. Click **Maintenance > Audio/Web Conferencing**.
   
The Audio/Web Conferencing Summary page appears, displaying the following information:

- **Name**: The name given to the unit.
- **Site**: The name of the site where the Service Appliance is installed.
- **Audio Port**: Provides information about conference audio ports.
  - Peak: Indicates the maximum number of audio ports requested concurrently.
  - Current: Indicates the number of audio ports currently in use.
- **Web Port**: Provides information about conference Web ports.
  - Peak: Indicates the maximum number of Web ports requested concurrently.
  - Current: Indicates the number of Web ports currently in use.
- **Disk (GB)**: Provides information about disk space on the appliance.
  - Used: Indicates how much disk space is currently in use.
  - Capacity: Indicates the disk capacity.
- **Total**: Provides information about the following items:
  - Conferences
  - Active Conferences
  - Requests per Hour
  - Last Successful Backup
Viewing the IM Servers Maintenance Summary

The IM Servers Maintenance Summary page lists the Service Appliances installed on the system that provide instant messaging services and provides information for each. To access the IM Servers Maintenance Summary page, follow these steps:

1. Launch ShoreTel Director.
2. Click **Maintenance > IM**.

The IM Servers Maintenance Summary page appears, displaying the following fields:

- **Name**: The name of the appliance providing IM services.
- **Site**: The site in which the appliance is installed.
- **Total Users**: Total number of users registered on the site.
- **Total Active Users**: Number of users who are currently logged in to IM on the appliance.
- **Peak Sessions**: Number of the most IM sessions at one time.
- **Current Sessions**: Indicates the number of current active sessions.

Using Event Filters

Event filters specify the criteria that trigger the ShoreTel system to send email notifications after an event has been reported. The Event Filters list page displays a list of the event filters that you have created.

Editing and Creating Event Filters

1. Launch ShoreTel Director.
2. Click **Maintenance > Event Filters** in the navigation frame.
3. Do one of the following:
   - To edit an existing filter, click the filter’s name in the Event Filters page.
   - To create a new filter, click **Add new**.
4. Click **All** or choose a server from the Server drop-down list.
5. Select a source and category, based on the following:
   - If you select ShoreWare, choose an event category from the Category drop-down list or select **Any** for all categories.
   - If you select Services, choose a service in the drop-down list and a category.
   - If you select Other, enter a service name and a category.
6. Enter an event ID number from the Event ID drop-down list or select **Any**.

7. Select an event type by clicking the Error, Warning, Information, or All option.

8. Click **Save** to save the event filter criteria.

9. In the Target E-mail Address field, enter an email address.

---

**Event Filters List Page**

The Event Filters list page provides the following information:

- **Source**: The name of the event source.
- **Category**: The category for the source.
- **Event ID**: The event number that is assigned to the filter.
- **Type**: The event type that is assigned to the filter.
- **Server**: The server that the event filter runs on.
- **Email**: The email address that the filter reports to.

To view the parameters of an existing event filter, click its name in the Source column.

---

**Event Filter Parameters**

The Event Filter edit page lets you create new and edit existing event filters. To add a new event filter, click **Add new** on the Event Filters page, or click **New** or **Copy** on the Edit Event Filter page.

The parameters on the Edit Event Filter page are as follows:

- **Server**: The server the event filter runs on.
- **Source**: The event source for the filter. Select from the following:
  - ShoreWare—Notifies about ShoreTel events. The associated drop-down list lets you select the ShoreTel category. Selecting Any reports events about all ShoreTel categories.
  - Services—Notifies about any non-ShoreTel service.
  - Other—Notifies about any event source.
- **Category**: This lets you select a category when the Services or Other option is selected.
- **Event ID**: This lets you select the event identification number that is referenced in the email notification.

---

**Note**

Sources may have more than one filter associated with them, depending on how you set the criteria. For example, the ShoreTel Event Watch service might have two or more filters, each with different event types assigned to them.
Type: The severity types to include in the filter:
- Error—Requires immediate attention.
- Warning—Alerts to potential errors.
- Information—Provides status of service, switch, or port.
- All—Notifies about all three types.

Target E-mail Address: This is the email address of the intended system administration or technical support entity.

Viewing the Event Log for the Headquarters Server

All events are reported to and viewed from the System Event Log and Application Event Log pages. To refresh these pages, click **Refresh**.

You can also view ShoreTel system events with the Windows Event Viewer.

The event categories for ShoreTel sources that go into the application’s log and subsequently into reports are as follows:
- Event Watch
- Java Client
- Java Server
- Notification
- Port Mapper
- Software Telephony Switch
- Switch
- System Management Database
- System Management Interface
- Voice Mail Application
- Voice Mail Message Server
- Voice Mail Port Mapper
- Workgroup Server

To view an event report, click an entry in the Date column on the System or Application Event Log page. The associated Event Info page is invoked.

The Event Info page provides the following information, from which you can ascertain the severity of the event:
- Source reporting the event
- Category of the event
- Event number
- Event description
- Date and time
- Event type (error, warning, or information)
Clicking **Go back** takes you back to the top-level event log (**System** or **Application**) page.

## Viewing Headquarters Services

The Services page lists all the services that reside on the server. It includes the name of the service, its description, and its operational status (running, not running, or paused). For details about these services, see **Table 100** on page 710.

Green, upward-pointing arrows indicate that the service or application is running. Red, downward-pointing arrows indicate that the service or application is not running or paused.

*To check the status of the services that run on the Headquarters server:*

1. Launch ShoreTel Director.
2. Click **Maintenance > HQ Services**.
   
The Services page opens.
3. To go to a page where you can start or stop a service, click the name of a service.
   
The status page for that service opens.
4. Do one of the following:
   
   - To start the service, click **Start**.
   - To stop the service, click **Stop**.
5. After starting or stopping a service, do one of the following:

   - To return to the Services page, click **Go back**.
   - To launch Quick Look, click **Quick Look**.

## Database Maintenance

ShoreTel uses MySQL to manage the ShoreTel configuration, Call Detail Record (CDR), and Monitoring databases that reside on the Headquarters server and the optional archive database server. ShoreTel configuration and CDR data use the UTF-8 format that MySQL supports.

---

**Note**

ShoreTel supports Unicode Character sets by incorporating v5.1 MySQL Open Database Connectivity (ODBC). Consequently, the databases support Unicode Character sets. Support for Unicode includes the ShoreTel system and CDR databases. Although ShoreTel Director also supports Unicode Character sets, automatic population of some data-entry fields depends on the character set of the original source for the data in those fields.
This section provides information about the following tasks:

- Setting performance tuning parameters
- Monitoring MySQL services
- Browsing MySQL database tables
- Ensuring compatibility with backup and antivirus utilities
- Running database back up and restore utilities
- Database replication

**Setting Performance Tuning Parameters for MySQL**

MySQL performance tuning parameters play an important role in database performance. The MySQL innodb_buffer_pool_size parameter, which specifies the amount of memory MySQL is permitted to use for caching data and indexes, is particularly important. This parameter is set during the ShoreTel installation process based on the system's RAM:

- For 2 GB or less of RAM, the value of the innodb_buffer_pool_size parameter is 256 MB.
- For 4 GB or more of RAM, the value of the innodb_buffer_pool_size parameter is 1024 MB.

The MySQL parameters reside in the following file:

<install location>\ShoreWare Server\MySQLMonitor\MySQL Server\my.ini

---

**WARNING!**

The hardware specification of the HQ server does not meet minimum requirements for this software release. Minimum required RAM size is 2GB. Please update your hardware so that RAM size meets with the minimum requirement to continue.

Should you decide to proceed with less than 2GB of RAM, the system will be in an unsupported configuration, system performance will be adversely impacted, and user may experience degradation of voice quality or delay in feature activation.

For more information about MySQL tuning parameters, see the MySQL documentation on tuning server parameters, which is available on the Internet.

**Monitoring MySQL Services**

The following ShoreTel services support the ShoreTel system databases:

- ShoreTel-MYSQLCDR
- ShoreTel-MYSQLConfig
- ShoreTel-MYSQLMonitor

*To start or stop a MySQL service:*

1. Launch ShoreTel Director.
2. Click **Maintenance > HQ Services.**
The Services page is displayed.

3. In the Services section, locate the ShoreTel MySQL services and check their status.

4. To start or stop a service, click the service name.

The service’s status page is displayed.

5. Depending on the status, do one of the following:
   - To stop a service, click Stop.
   - To pause a service, click Pause.
   - To start a service, click Start.

6. In the confirmation dialog, click OK.

Browsing MySQL Database Tables

MySQL provides a query browser for viewing database tables. To download MySQL tools, open the MySQL home page and download the MySQL Workbench.

Ensuring Compatibility with Backup and Antivirus Utilities

Running a virus scan or a backup utility on a MySQL database file causes the MySQL service to fail. Before running these utilities, you should add the following directories to the exclusion list:

- C:\windows\temp
- <drive>:\Shoreline Data\Database
- <drive>:\Shoreline Data\temp

Backing up and Restoring ShoreTel Databases

ShoreTel provides batch files for running MySQL backup and restore utilities on the following ShoreTel databases:

- configuration database (shoreware)
- CDR database (shorewarecdr)
- monitoring database (shorewaremonitoring)

The default path for these batch files depends on the operating system:

- For 32-bit operating systems:
  
  <drive>:\Program Files\Shoreline Communications\ShoreWare Server\MySQL\MySQL Server\Examples

- For 64-bit operating systems:
  
  <drive>:\Program Files(x86)\Shoreline Communications\ShoreWare Server\MySQL\MySQL Server\Examples
Use the batch files as follows:

- Run `BackupConfig.bat` to back up the configuration database. The backup command creates the `C:\shorewareconfigdump.sql` file. Run `RestoreConfig.bat` if you need to restore the configuration database.

- Run `BackupCDR.bat` to back up the CDR database. The backup command creates the `C:\shorewarecdrdump.sql` file. Run `RestoreCDR.bat` if you need to restore the CDR database.

- Run `BackupMonitoring.bat` to back up the Monitoring database. The backup command creates the `C:\shorewaremonitoringdump.sql` file. Run `RestoreMonitoring.bat` if you need to restore the Monitoring database.

If you would prefer to run these commands from a command line, you can find the command syntax in the batch files.

For documentation on MySQL topics, such as database backup, see the following sources:

- http://dev.mysql.com/doc/index-other

### Database Replication

MySQL provides a built-in database replication tool. Refer to the following sources for information and tools related to database replication:

- http://www.howtoforge.com/mysql_database_replication

MySQL provides these database replication tool and add-ons. ShoreTel does not provide support for MySQL database replication.

### Disk Space Reclalm

MySQL creates tables in the ShoreTel Configuration, CDR, and Monitoring databases. These databases reside on the Headquarters server and on any distributed voices servers (DVSs) that have an enabled database. The tables in these databases steadily grow, occupying an increasingly large amount of disk space. This growth leads to the following problems:

- A system backup or restore takes too long.
- System upgrades can fail or take a long time to perform.
- Databases can become fragmented and cause reports to generate too slowly.

This section describes how to reclaim the disk space that MySQL tables use for the configuration and CDR databases. The process for setting parameters for reclaiming space in the Monitoring database is described in Changing Settings for the Monitoring Database on page 664.
To keep the configuration databases at a manageable size, regularly use the Disk Reclaim Tool during maintenance periods on each server that has an operational database. Run the Disk Reclaim Tool on the Headquarters server before running it on a DVS. The procedure differs on the two types of servers:

- For details on how to run the Disk Reclaim Tool on the Headquarters server, see “Running the Disk Reclaim Tool on the Headquarters Server” on page 654.
- For details on how to run the Disk Reclaim Tool on a DVS (if Local Database is enabled), see “Running Disk Reclaim on a Distributed Voice Server” on page 657.

For the Disk Reclaim Tool to run, the server's hard drive must be at least twice the size of the *ibdata* file located in the following directory:

```
C:\Shoreline Data\Database\ShoreTelConfig\Data
```

---

**Note**

The servers automatically restart after the disk reclaim process finishes, so a manual restart is not necessary.

### Running the Disk Reclaim Tool on the Headquarters Server

Reclaiming disk space on the Headquarters server involves the following tasks:

- Back up the ShoreWare database to a network drive, as described in Backing up the ShoreWare Database to a Network Drive.
- Back up the ShoreWare WebBridge database to a network drive, as described in "Backing Up a WebBridge Database to a Network Drive" on page 655.
- Run the Disk Reclaim Tool, as described in "Running the Disk Reclaim Tool" on page 656.

#### Backing up the ShoreWare Database to a Network Drive

1. On the Headquarters server, open the Command Prompt window.

2. At the command prompt, type the following command (if the server software resides in C:\Program Files):

   ```
   C:\Program Files (x86)\Shoreline Communications\ShoreWare Server\MySQL\MySQL Server\Examples\BackupConfig.bat
   ```

   The system generates a backup copy of the configuration database and places it, by default, in the following location:

   ```
   C:\shorewareConfigDump.sql
   ```

3. Open the following log file generated for the ShoreWare backup:
4. To verify that the backup operation completed, scroll to the messages at the end of the log file and find “The dump is COMPLETE.” If you do not find this message, the backup operation did not complete.

Note
If the dump does not complete, do the following:

- Verify that an antivirus program is not currently running on the server. You might have to suspend the operation of the antivirus program briefly to run the backup utility.
- Verify that the MySQL service is running on the server by using the steps provided in Monitoring MySQL Services on page 651.
- Verify that you have the privileges required to run the command on your server.
- Verify that the ShoreWare database exists on your server.
- Verify that the ShoreWare database on your server is not empty.
- Verify that the hard disk on your server is not full.
- Run the backup command (BackupConfig.bat) again.

Backing Up a WebBridge Database to a Network Drive

The procedure in this section is necessary only if both of the following are true:

- The system is running ShoreTel Server Software Release 12 or later.
- The network includes a Service Appliance (SA-100 or SA-400).

1. On the Headquarters server, open the Command Prompt window.

2. At the command prompt, type the following command (if the server software resides in C:\Program Files):

   C:\Program Files\Shoreline Communications\ShoreWare Server\MySQL\MySQL Server\Examples\BackupWebBridge.bat

   The system places the backup copy in the following location by default:

   C:\shorewareWebBridgeDump.sql

3. Open the following log file, which is generated for the backup:

   C:\BackupWebBridgeDump.log

Note
If your server software is not installed in "C:\Program Files," enter the path where the server software is installed.
4. To verify that the backup operation completed, scroll to the messages at the end of the log file and find "The dump is COMPLETE." If you do not find this message, the backup operation did not complete.

**Note**

If the dump does not finish, do the following:
- Verify that an antivirus program is not running on your server.
- Verify that the MySQL service is running on your server.
- Verify that you have the administrative privilege.
- Verify that the ShoreTel database exists on the server.
- Verify that the ShoreWare database on your server is not empty.
- Verify that the hard disk on your server is not full.
- Run the back up command again (`BackupWebBridge.bat`).

**Running the Disk Reclaim Tool**

**Note**

You must have administrative-level privileges to run the Disk Reclaim Tool.

Before running the Disk Reclaim Tool, download the desired version of the server package of ShoreTel software to the Headquarters server.

To get online Help for the command, type `DiskReclaim.exe ?`. On a server running a 64-bit operating system, the command prompt includes "(x86)."

On a Headquarters server, the syntax for the Disk Reclaim command is:

```
DiskReclaim.exe -cdr | -config | -all
```

where `-cdr` specifies just a hot reclaim of the Call Detail Records database, `-config` specifies just the configuration database, and `-all` specifies all databases.

If the database is already in files-per-table mode, Disk Reclaim (with the `-cdr` argument) does a hot reclaim of the CDR database. If the CDR database is not in files-per-table mode, running the Disk Reclaim tool with the `-cdr` argument first reboots the server and then does the hot reclaim.

1. Log in as a system administrator.

2. Go to the location of the Server package:

   \Shoreline Communications\ShoreWare Server

3. Navigate to the DiskReclaim folder.

4. Enter the executable command with one of the keywords, for example:
DiskReclaim.exe -config

This Disk Reclaim process starts on the configuration database.

**Note**
If the system detects errors, the Disk Reclaim Tool restores the server to its previous state.

Running Disk Reclaim on a Distributed Voice Server

**Note**
By default, the local database on a DVS is disabled. Run the Disk Reclaim tool on a DVS only if the local database is enabled on the DVS.

Running disk reclaim on a DVS involves the following phases:

- Run the Disk Reclaim Tool.
- Re-synchronize the DVS database.

**Running the Disk Reclaim Tool**

Before running the Disk Reclaim Tool, download the desired version of the Remote Server package of the ShoreTel Software Release to the DVS.

1. Log on as Administrator.

2. Navigate to the location of the Remote Server package:

   \Shoreline Communications\ShoreWare Remote Server

3. Navigate to the **DiskReclaim** folder.

4. Select and right-click on the Disk Reclaim Tool:

   DiskReclaim.exe

**Note**
If you see the option to run the tool as Administrator, click that option. If that option does not appear, double-click the tool.

The Disk Reclaim process starts. If the system prompts you to delete data files, click **Y** (yes).

The server automatically restarts after the Disk Reclaim completes.

**Note**
If errors occur, the Disk Reclaim Tool restores the server to its previous state.
Resynchronizing the DVS Database

1. Launch ShoreTel Director.

2. Click **Maintenance > Quick Look**.
   
The Quick Look page opens.

3. In the Server/Appliance section of the page, click the name of the DVS.
   
The Distributed Server Maintenance page opens.

4. Click **Resync** to re-synchronize the DVS database.
CHAPTER 20

Monitoring and Diagnosing

This chapter provides details about using the Diagnostics & Monitoring system available through ShoreTel Director. It contains the following information:

Overview ................................................................................................................. 661
Architectures .................................................................................................. 661
Requirements .................................................................................................. 662
Managing the Monitoring Service and Database ........................................ 663
Changing the Leadership of the Monitoring Service ......................................... 663
Changing Settings for the Monitoring Database ............................................. 664
Navigating the Diagnostics & Monitoring Interface ................................................. 665
Refreshing the View .......................................................................................... 665
Zooming in and Out .......................................................................................... 665
Viewing the Navigation Menu ........................................................................... 665
Changing the Number of Rows Displayed ......................................................... 665
Filtering Information ......................................................................................... 666
Sorting Displayed Information ........................................................................... 667
Viewing Active Alerts with the Alarm Bar .......................................................... 668
Viewing System Status with the Dashboard ......................................................... 669
Selecting the Time Period .................................................................................. 669
Call Volume ...................................................................................................... 670
Call Quality ....................................................................................................... 671
Bandwidth Utilization ......................................................................................... 672
Highest Trunk Group Usage ............................................................................. 673
Highest Feature Usage ......................................................................................... 674
Highest Average CPU Usage ........................................................................... 675
Overview

The ShoreTel Diagnostics & Monitoring solution is a comprehensive set of tools that enables:

- status, fault, and performance monitoring
- system capacity planning
- voice quality monitoring
- root cause analysis
- troubleshooting

Architecture

The Diagnostics & Monitoring system consists of the following components:

- Web application
- Monitoring Service
- Monitoring Agents
- Monitoring Database
- Status Database

Web Application

The user interface for the Diagnostics & Monitoring system is a web application. This chapter explains how to use the web application to monitor the components in your ShoreTel system.

You can launch the Diagnostics & Monitoring web application using any of the following methods:

- Enter http://<server>/shorewaredirector/monitor_login.asp as the URL in your web browser.
- In ShoreTel Director, do any of the following:
  - In the navigation menu, click Maintenance > Diagnostics & Monitoring.
  - On the Quick Look page, click the Go to Diagnostics & Monitoring link at the top of the page.
  - On the Maintenance - Voice Switches and Service Appliances Summary page, click the Go to Diagnostics & Monitoring link at the top of the page.
  - On the Voice Switch Maintenance page, click the IP Phones Maintenance link in the IP Phones section. This link takes you to the IP Phones status page in the Diagnostics & Monitoring web application.
- In ShoreTel Director, do any of the following:
  - Enter http://<server>/shorewaredirector/monitor_login.asp as the URL in your web browser.

Note

To access the Diagnostics & Monitoring web application using Mozilla Firefox, use this URL. Accessing the Diagnostics & Monitoring system through ShoreTel Director, as described in the following methods, is not supported on Firefox.
Monitoring Service

The Monitoring Service receives and processes data from the following sources:

- call quality reports from the Monitoring Agents
- status database (shoreware status)
- the CDR database (shorewarecdr)

To collect statistics, the Monitoring Service requires that switches, service appliances, and softswitches have an active network connection to the Headquarters server. If the network connection is not functioning, statistics are not reported. In addition, because metrics are not collected if the Monitoring Service is not running, any average calculations for a particular time period that includes time when the Monitoring Service was down will not be accurate.

Monitoring Agents

The Monitoring Agents are integrated services residing on switches, servers, and phones in the ShoreTel system. They collect call quality metrics and path trace information, summarize the data in one or more reports, and send the reports to the Monitoring Service at the end of each call. Any media streams without IP media do not send reports.

Monitoring Database

The Monitoring Database (shorewaremonitoring) is installed on the Headquarters server. It stores the raw data collected by the Monitoring Service.

For information about configuring the Monitoring Database, see Changing Settings for the Monitoring Database on page 664.

Requirements

The Diagnostics & Monitoring system has the following requirements:

- The Diagnostics & Monitoring web application runs on Internet Explorer and Mozilla Firefox. See the ShoreTel Release Notes for the supported versions of these Internet browsers.

- If you use Internet Explorer with an enhanced security configuration, to access the Diagnostics & Monitoring system on the Headquarters server ensure that the IP address of the Headquarters server is included in Internet Explorer's “Trusted sites” list.

- To use the Topology feature, Adobe Flash Player 10.2 or higher is required.

- JavaScript and cookies must be enabled.

- Minimum supported screen resolution is 1280 x 720.

- To collect call quality data, switches need active connections to phones and a call’s duration needs to be at least 30 seconds.
Managing the Monitoring Service and Database

The Monitoring Service requires that the local time zone of the computer on which the Headquarters server is running be the same as the local time zone specified for the Headquarters server in ShoreTel Director.

Managing the Monitoring Service and Database

To manage the Monitoring Service and the Monitoring Database, you can do the following tasks:

- Change the leadership of the Monitoring Service from Headquarters to a remote server
- Change the settings for the Monitoring Database

Changing the Leadership of the Monitoring Service

By default, the Monitoring Service is installed only on the Headquarters server, and this configuration should be adequate for most installations. However, if your system has more than 10,000 busy-hour call attempts (BHCA), then you should install an instance of the Monitoring Service on a remote server to reduce the processing load on the Headquarters server. Details are provided in the ShoreTel Planning and Installation Guide.

If you have installed a remote instance of the Monitoring Service, you would assign the Main Service role to the remote instance and the Event Collector role to the instance on the Headquarters server. (The remote server is never in the Event Collector role.)

To change the leadership of the Monitoring Service instance from the Headquarters server to the remote server:

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
3. In the navigation menu, click Configuration > Monitoring Service.
   The Monitoring Service page is displayed.
4. In the Monitoring Service pane at the top of the page, select the row for the Headquarters server.
5. In the Monitoring Service Instance pane at the bottom of the page, in the Role drop-down list, select Event Collector.
   The ✏ indicates that the role has changed.

Tip
To revert to the default settings, click Reset.

6. Click Save.
Changing Settings for the Monitoring Database

Though ShoreTel recommends that you use the default values for the settings related to purging and reclaiming space in the Monitoring Database, you can change the settings. These settings are listed in Table 90.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Quality data</td>
<td>The number of days to retain data related to call quality. The default is 31 days.</td>
</tr>
<tr>
<td>Alerts data</td>
<td>The number of days to retain data related to alerts. The default is 3 days.</td>
</tr>
<tr>
<td>Time of Day to Purge/Reclaim</td>
<td>The time on a 24-hour clock to run the database purge audit process. This process deletes the expired data from the Monitoring Database according to the settings specified in the configuration settings and reclaims the space in the database. Specify a time during non-peak hours for your system. The default is 1 a.m.</td>
</tr>
</tbody>
</table>

To change settings for the Monitoring Database:

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
3. In the navigation menu, click Configuration > Monitoring Database Settings.
   The Monitoring Database Settings page is displayed.
4. If you want to change the default values, use each drop-down list box to select a value for a particular field.

   The ✏ icon indicates values that you have changed.

   **Tip**

   To revert to the default settings, click Reset.

5. To save the settings you selected, click Save.
Navigating the Diagnostics & Monitoring Interface

This section describes the key components and capabilities of the Diagnostics & Monitoring web interface.

Refreshing the View

The Dashboard, Topology, and Status pages in the Diagnostics & Monitoring web application automatically refresh every 30 seconds. To stop automatically refreshing a page, click the Stop Refreshing button at the top right corner of the page. If you want to resume refreshing a page, click the Resume Refreshing button.

The Alerts and Call Quality pages do not automatically refresh. To get real-time status, can refresh those pages by clicking the Refresh button at the top right corner of the page.

Zooming in and Out

In charts such as those on the Dashboard or on the detail panes of the Status pages, you can zoom in or out using either of the following methods:

- Click the and buttons at the top right of each chart.
- Click on the area in a chart where you want to zoom, and use the scroll wheel on a mouse to zoom in or out.

To scroll up or down within a chart, click and drag anywhere on the chart.

Viewing the Navigation Menu

You can show or hide the Diagnostics & Monitoring navigation menu as follows:

- To hide the menu, click at the bottom of the menu pane.
- To show the menu, click at the bottom of the minimized menu pane.

You can expand or collapse the Diagnostics & Monitoring navigation menu as follows:

- To expand the menu, click .
- To collapse the menu, click .

Changing the Number of Rows Displayed

You can control the number of rows displayed in a particular pane in many of the Diagnostics & Monitoring pages.

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.

3. Select an item, such as a Status page, in the navigation menu.

4. On the selected Diagnostics & Monitoring page, select the number of entries to show per pane by clicking the **Show n entries** drop-down list at the bottom of the pane and selecting a number.

5. Adjust the size of the panes as follows:
   - To expand the list pane (top pane) to a full page, click .
   - To expand the details pane (bottom pane) to a full page, click .
   - To show both the list pane and the details pane, click .

6. Use the controls at the bottom of the pane to page through the information.

**Filtering Information**

To find information quickly, you can filter the data displayed in many of the Diagnostics & Monitoring pages.

When you define a filter, the text you enter operates as if it begins and ends with a wild card, and the search is not case sensitive. For example, if you type "sg" in the filter for the Switch column on the Switches status page, you see all switches that contain "sg". **Figure 227** illustrates this example.

![Figure 227: Filter Example](image)

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

3. In the navigation menu, click **Status**.
4. Click the type of component whose status you want to monitor.
   The desired status page launches.

5. Click .
   Text boxes and drop-down lists are displayed under the column headings for the fields you can use as filters.

6. To define a filter, do any of the following:
   - Enter text in one or more text boxes.
   - Select one or more items from the drop-down lists.
   - For date and time columns:
     1. Click in the first text box for the column, and then do one of the following:
        - Select a day from the calendar and use the slider bars to specify the hour and minute.
        - Click Now.
     2. Click in the second text box for the column, and then do one of the following:
        - Select a day from the calendar and use the slider bars to specify the hour and minute.
        - Click Now.
     3. Click Done.

7. To apply the filter, click .
   The rows are filtered to display information that matches the filter you entered.

8. If you want to close the filter box but retain the filtered results, click .

9. To clear the filter, click .
   All rows are again displayed.

**Sorting Displayed Information**

You can sort the information in a list pane. When you sort a column in a list pane, the icon next to the column heading changes from  to  or , which indicates whether the sort is ascending or descending.

---

**Note**
At least one date and time field must be entered to filter on a date and time range. If the start time is left blank, the earliest possible date and time are used. If the end time is left blank, the latest possible date and time are used.
1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

3. In the navigation menu, click the Diagnostics & Monitoring page you want to use.

   The page launches.

4. Click the column heading you want to sort by.

   The rows are sorted accordingly.

---

**Viewing Active Alerts with the Alarm Bar**

The alarm bar displayed at the top of every page in the Diagnostics & Monitoring web application shows alert status for the following major components and functions in the ShoreTel system:

- Connections alerts reflect issues with physical connections between devices such as servers and devices within the ShoreTel system or logical connections between ShoreTel software components, such as TMS, DRS, and voicemail services.

- Trunk Groups alerts involve issues with the trunks on a switch, which are used to route inbound and outbound calls.

- Bandwidth alerts reflect poor throughput in network bandwidth.

- Voice Quality alerts reflect issues involving poor voice quality in calls monitored by the ShoreTel system.

- Switches alerts involve general switch issues that could affect the functionality or quality of ShoreTel services.

- Servers alerts involve general server issues that could affect the functionality or quality of ShoreTel services.

Alerts are issued to flag critical, warning, or informational situations. The color of a button indicates the highest alert severity for components or functions, as follows:

- ▲ (red) indicates at least one critical alert. You can hover over the button to see how many critical and warning alerts are in effect for that component type.

- ▲ (yellow) indicates at least one warning alert and no critical alerts. You can hover over the button to see how many warning alerts are in effect for that component type.
Viewing System Status with the Dashboard

The Dashboard displays real-time performance data up to the current minute, based on data collected by the Monitoring Service. By changing the time period, you can view current performance information or historical performance information.

Selecting the Time Period

You can display monitoring metrics for the following pre-defined time periods:

- Last 1 Hour
- Last 12 Hours
- Last 24 Hours
- Last 7 Days
- Last 30 Days

The time frame you select depends on your purpose. If you want to monitor current system performance, select “Last 1 Hour” (the default) as the time period. If you want to do capacity planning, select “Last 30 Days” as the time period.

To select the time period:

1. Launch ShoreTel Director.

● (green) indicates no critical or warning alerts, but any number of informational alerts might have been issued.

The information displayed in the alarm bar is automatically refreshed every 30 seconds.

You can increase the size of the text in the alarm bar by clicking the icon, which is located to the right of the alarm bar. You can decrease the size of the text in the alarm bar by clicking the icon.

To view active alerts with the alarm bar:

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
3. Hover over a yellow or red button.
   The number of active warning and critical alerts for that category are displayed.
4. Click a button on the alarm bar.
   The Alerts page is launched, and it displays a list of all active alerts filtered by category, severity, and time interval. For detailed information about Alerts, see Monitoring Connect Sync Status on page 724.
2. Click **Maintenance > Diagnostics & Monitoring**.

   The Dashboard page is launched.

3. Use the time chooser in the upper left corner to select a different time period.

   The data displayed in the Dashboard changes accordingly.

## Call Volume

The Call Volume chart shows the total number of calls and the number of bad calls for the system during the specified time interval. In the bar graph, the green segment indicates the number of good calls and the red segment indicates the number of bad calls. A call’s designation as good or bad is derived from the Mean Opinion Score (MOS). A MOS value above 3.6 indicates good call quality, and a MOS value below 3.0 indicates bad call quality.

### Monitoring Call Volume

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

   The Dashboard page is launched.

3. In the Call Volume chart (upper left corner), hover over a bar on the graph to see the following details:

   - The green segment shows the total number of calls (good and bad) and the time range.
   - The red segment shows the number of bad calls, the percentage of total calls that were bad, and the time range.

### Getting Detailed Information About Calls

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

   The Dashboard page is launched.

3. In the Call Volume chart (upper left corner), click a bar in the graph.

   The Call Quality page is launched, and the information it displays varies depending on whether you click a green or red segment of a bar:

   - If you click a green segment, the Call Quality page shows the following information:
     - Calls filtered by the time interval for the bar you clicked, with the most recent call during that interval listed first
     - Metrics for the most recent call (on the Details tab)
     - IP path for the most recent call (on the IP Path Trace tab)
If you click a red segment, the Call Quality page shows bad quality calls filtered by the time interval for the bar you clicked.

For more information about the information displayed on the Call Quality page, see Monitoring Call Quality on page 726.

Call Quality

The Call Quality chart shows the average and worst call quality during the selected time interval. Call quality is measured using the Mean Opinion Score (MOS) scale. A MOS value of 3.6 or higher is considered “toll quality.” A MOS value between 3 and 3.6, which is shown in the yellow area of the chart, indicates substandard but acceptable call quality. A MOS value below 3.0, which is shown in the red area of the chart, indicates poor call quality.

For more information about factors that impact call quality, see Monitoring Call Quality on page 726.

Viewing High-Level Information about Call Quality

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
   The Dashboard page is launched.
3. In the Call Quality chart (upper left corner), hover over a point on the graph to see the following details:
   - To see the average score for a particular time range, hover over a circle on the blue line.
   - To see the worst score for a particular time range, hover over a square on the purple line.

Viewing Details for an Average Quality Call or Worst Quality Call

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
   The Dashboard page is launched.
3. In the Call Quality chart (upper right corner), do one of the following:
   - To view the following details about an average quality call, click a circle on the blue line for the desired time frame:
     - Calls filtered by the time interval for the bar you clicked, with the most recent call during that interval listed first
     - Metrics for the most recent call (on the Details tab)
     - IP path for the most recent call (on the IP Path Trace tab)
To view the following details about the worst quality call, click a square on the purple line for the desired time frame:

- The call with the lowest MOS score during the specified time frame
- Metrics for this worst quality call (on the Details tab)
- IP path for this worst quality call (on the IP Path Trace tab)

For more information about the information displayed on the Call Quality page, see Monitoring Call Quality on page 726.

### Bandwidth Utilization

The Bandwidth Utilization chart shows the trend lines for the five sites that consumed the most intersite bandwidth for media streams for the selected time period. Site names and their associated colors are listed at the top of the chart, and the color of each trend line corresponds to a site’s color. Of the sites with the highest bandwidth utilization, the site with the highest bandwidth utilization is on the left and the site with the lowest bandwidth utilization is on the right.

The information displayed in the Bandwidth Utilization chart could be useful for the following purposes:

- **Capacity planning** — Frequent bandwidth utilization peaks above 80 percent (in the chart’s red zone) could indicate a need for increased WAN bandwidth. But occasional spikes of bandwidth utilization above 80 percent do not necessarily mean that you need to increase bandwidth.

- **Troubleshooting** — Rejected calls or poor audio quality could be the result of a critical shortage of intersite bandwidth.

- **System provisioning** — Reviewing bandwidth utilization and trunk group utilization together can provide information to help you better provision the system.

For more information about how bandwidth impacts your ShoreTel system, see the “Network Requirements and Preparation” chapter in the *ShoreTel Planning and Installation Guide*.

### Viewing Highest Bandwidth Utilization

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

   The Dashboard page is launched.

3. In the Bandwidth Utilization chart (middle left), hover over a point on the graph to see the following details about a site’s bandwidth:

   - Site name
   - Average bandwidth utilization for that site during the given time range
   - Maximum bandwidth utilization for that site during the given time range
   - Time range
### Viewing Detailed Information for a Site

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.
   
   The Dashboard page is launched.

3. In the Bandwidth Utilization chart (middle left), click on a point on a site’s trend line.
   
   The Status > Sites page is launched, and it displays detailed information about the selected site. For more information about the details displayed on the Status > Sites page, see [Monitoring Site Status](#) on page 690.

### Highest Trunk Group Usage

The Highest Trunk Group Usage chart shows trend lines for the five busiest trunk groups. The percentage of total trunk ports used within the group is shown for the specified time interval. Trunk group names and their associated colors are listed at the top of the chart, and each trend line’s color corresponds to a trunk group’s color. Of the five busiest trunk groups, the trunk group with the highest usage is listed on the left and the trunk group with the lowest usage is listed on the right.

The information displayed in the Highest Trunk Group Usage chart could be useful for the following purposes:

- **Troubleshooting** — Failing calls could result when the call volume exceeds the trunk group capacity in your system.
- **Capacity planning** — Trunk group usage over 50 percent (in the chart’s yellow zone) could indicate a need to increase trunk group capacity or WAN bandwidth. But occasional spikes of trunk group usage above 50 percent do not necessarily mean that you need to increase trunk group capacity.
- **System provisioning** — Reviewing trunk group utilization and bandwidth utilization together can provide information to help you better provision the system.

### Viewing Trunk Groups with the Highest Usage

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.
   
   The Dashboard page is launched.

3. In the Highest Trunk Group Usage chart (middle right), hover over a point on the graph to see the following details about the trunk groups with the highest usage:
   
   - Trunk group name
   - Site name
   - Average simultaneous trunk port occupancy for that trunk group for the given time range
   - Maximum simultaneous trunk port occupancy for that trunk group for the given time range
   - Time range
Viewing Detailed Information for a Trunk Group

1. Launch ShoreTel Director.

2. Click Maintenance > Diagnostics & Monitoring.

   The Dashboard page is launched.

3. In the Highest Trunk Group Usage chart (middle right), click on a point on the usage trend line for a trunk group.

   The Status > Trunk Groups page is launched, and it displays detailed information about the selected trunk group and time interval. For more information about the details displayed on the Status > Trunk Groups page, see Monitoring Trunk Group Status on page 717.

Highest Feature Usage

The Highest Feature Usage chart shows the trend line for the five switches with the highest total feature usage. These features include voice mail, conferences, group paging, hunt groups, bridged call appearance, and workgroups. Use of these features impacts CPU utilization on each switch that hosts these features, and heavy use of these features could impact system performance.

Switch names and their associated colors are shown at the top of the chart, and each trend line’s color corresponds to a switch’s color. At the top of the chart, the switches are listed from highest feature usage on the left to lowest feature usage on the right.

Feature usage counts reflect the number of active calls at the time TMS writes to the Monitoring Database, not the cumulative number of active calls between measurement intervals. For this reason, calls less than 30 seconds in duration might not be reflected in feature usage counts.

The information displayed in the Highest Feature Usage chart could be useful for the following purposes:

- Load balancing — High feature usage on a particular switch might indicate a need to move frequently used features to ports on different switches.

- Capacity planning — High feature usage on the switches in your ShoreTel system might indicate a need to add switch capacity to the system.

Viewing Highest Feature Usage

1. Launch ShoreTel Director.

2. Click Maintenance > Diagnostics & Monitoring.

   The Dashboard page is launched.
3. In the Highest Feature Usage chart (lower left), hover over a point on the graph to see the following details about features with the highest usage:

- Name of the site where the ports supporting the features are being used
- Name of the switch on which the feature depends
- Total number of ports used during the specified time range
- Time range

**Viewing Detailed Information for a Switch with Highest Feature Usage**

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

The Dashboard page is launched.

3. In the Highest Feature Usage chart (lower left), click on a point on a usage trend line for a switch.

The Status > Switches page is launched, and it displays detailed information about the switch with the highest feature usage during the selected time interval. For more information about the details displayed on the Status > Switches page, see Monitoring Switch Status on page 693.

**Highest Average CPU Usage**

The Highest Average CPU Usage chart shows the trend line for the five switches or soft switches (servers) with the highest CPU usage by percentage. Switch or softswitch names and their associated colors are listed at the top of the chart, and each trend line’s color corresponds to a switch’s color. Of the five switches with the highest CPU usage, the switch with the highest average CPU usage is on the left and the switch with the lowest average CPU usage is on the right.

The information displayed in the Highest Average CPU Usage chart could be useful for the following purposes:

- **Capacity planning** — Frequent spikes in average CPU usage for a switch could indicate that the switch is overburdened.
- **Troubleshooting** — Average CPU usage above 60 percent could cause performance issues.
- **Load balancing** — High CPU usage on a particular switch or softswitch could indicate a need to add more switches or move frequently used features to ports on different switches.

**Viewing Highest Average CPU Usage**

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

The Dashboard page is launched.
3. In the Highest Average CPU Usage chart (lower right), hover over a point on the graph to see the following details about switches or softswitches (servers) with the highest average CPU usage:

- Site name
- Switch name
- Average CPU usage during the specified time range
- Maximum CPU usage during the specified time range
- Average memory usage during the specified time range
- Maximum memory usage during the specified time range
- Time range

**Viewing Detailed Information for a Switch or Softswitch with Highest Average CPU Usage**

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
   
The Dashboard page is launched.
3. In the Highest Average CPU Usage chart (lower right), click a point on a usage trend line for a switch or soft switch.
   
The Status > Switches page or the Status > Servers page is launched, and it displays detailed information about the switch or softswitch with the highest average CPU usage during the selected time interval. For more information about the details displayed on the Status > Switches page, see **Monitoring Switch Status** on page 693. For more information about the details displayed on the Status > Servers page, see **Monitoring Server Status** on page 707.

**Viewing the Topology of Your System**

The Topology feature displays the real-time status and connectivity for ShoreTel system components. You can view your system components in either of the following visual maps:

- The System view shows all configured sites, including all voice switches and servers for each site. This view provides a high-level overview of your system’s configuration and status.
- The Site view shows all configured components (including servers, voice switches, service appliances, softswitches, voice mail switches, trunk groups, and phones) for a particular site.

In both views, the node icons are color coded, which allows you to see the current status of each site and component at a glance. Status for sites is aggregated to the most severe status based on the site’s components. For example, if a switch at a site is down, the icon for the switch would be red and the icon for the site would be red, even if other switches at the site are green or yellow. The topology node icons and the status colors are described in **Table 91** on page 680.
You can see the status of the connections or associations between nodes by clicking a particular node. The connections or associations are displayed based on the perspective of the node that you click. Therefore, if you click on each of the two nodes that are connected by a line, the line could indicate a different connectivity status based on which node is in focus.

The status of the connectivity between nodes is represented by a colored line or other indicator, as follows:

- A green line indicates that the nodes are connected.
- A dashed yellow line indicates that the connection between the nodes is functional but impaired or limited in some way.
- A dashed red line indicates that there is no communication between the nodes because of a software, hardware, or network issue for at least one of the nodes.
- A gray line indicates one of the following, depending on the nodes connected with it:
  - When DRS is enabled, a gray line connecting two sites indicates that calls can be routed between the sites, but protocol communication between the sites is not necessary. (See Figure 229 on page 679.)
  - In the System view, a gray line between the WAN node and nodes with gray site icons indicates that these sites have been defined in the system but currently have no hardware configured.
  - In the Site view, a gray line between voice switches and trunk groups or phones indicates which switch manages those trunk groups or phones.
  - When you click a voice switch, a small circle (switch management indicator) on the connection line between the switch and a server indicates that the selected switch is managed by the connected server. The color of the switch management indicator matches the status of the connectivity between the switch and the server (from the perspective of the switch). In the topology example shown in Figure 228, the switch management indicator shows that the AustinSG220T1-A2 switch is managed by the AUSMURPHYDVM server.
Connectivity status is independent of device status. For example, a green switch icon means that the device is operating normally, but if you click the switch node icon you might see that it has a dashed red connectivity line to one or more switches, indicating that it cannot communicate with these switches. The example shown in Figure 228 illustrates a different situation, where an impaired switch (indicated by the yellow icon) is in focus and the connection lines from that switch to the server and other switches indicate normal connectivity.

When you click a site node, the site’s connectivity to other sites is aggregated based on the connectivity status of the site’s switches and servers. For example, if a site has a switch that is down (red) and a switch that is operating with some impairment (yellow), the line showing that site’s connectivity to other sites is yellow, indicating some impairment.

Figure 229 shows an example where some site nodes are green, yellow, or red, which indicates the aggregated status of the switches and servers at each site.
When you click a switch or server node, the lines represent switch-to-switch, switch-to-server, or server-to-server connections, depending on the type of node you click. Connectivity between these components relies on one or more of the following ShoreTel proprietary protocols, which are described in the *ShoreTel Maintenance Guide*:

- Distributed Telephony Application Service (DTAS)
- Location Service Protocol (LSP)
- Network Call Control (NCC) Remote Procedure Call (RPC)

The communication protocol for these connections depends on whether Distributed Routing Service (DRS) is enabled or disabled, as follows:

- **If DRS is enabled:**
  - For switch-to-switch connections within the same site, the connectivity line represents a connection using LSP.
  - For switch-to-server connections, the connectivity line represents a connection using LSP. If the switch is managed by the server, the connectivity line also represents an NCC RPC connection.
  - For server-to-server connections, the connectivity line represents a connection using DTAS and LSP.

- **If DRS is disabled:**
  - For switch-to-switch connections, the connectivity line represents a connection using LSP.
- For switch-to-server connections, the connectivity line represents a connection using LSP. If the switch is managed by the server, the connectivity line also represents NCC RPC connections.

- For server-to-server connections, the connectivity line represents a connection using DTAS and LSP connections.

When more than one protocol is used, the color of the connectivity line represents the worst status of any active protocols.

**Note**
Status and connection information displayed in the topology map could be up to two minutes old.

### Table 91: System Topology Node Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Calendar icon] | Represents a site. The color of the icon changes based on status:  
- Green indicates that all switches and servers at the site are in service.  
- Yellow indicates that one or more switches or servers are impaired but not out of service.  
- Red indicates that one or more switches or servers are out of service.  
- Gray indicates that there is no hardware installed at the site. |
| ![Folder and file icon] | Represents a site with one or more servers on premise. The color of the icon changes based on status:  
- Green indicates that all switches and servers at the site are in service.  
- Yellow indicates that one or more switches or servers at the site are impaired but not out of service.  
- Red indicates that one or more switches or servers are out of service. |
| ![Voice icon] | Represents a voice switch. The color of the icon changes based on status:  
- Green indicates that the switch is in service.  
- Yellow indicates that the switch is impaired or FTP booted but not out of service. For example, if some trunk or phone ports on the switch are out of service, that switch’s node icon would be yellow.  
- Red indicates that the switch is out of service. |
| ![Phone icon] | Represents a server. The color of the icon changes based on status:  
- Green indicates that the server is operating normally.  
- Yellow indicates that the server is impaired but still functioning.  
- Red indicates that the server has a critical error state. |
Navigating the Topology Map

To easily focus on the components you want to see, you can adjust the topology map in a variety of ways, as described in this section.

Expanding and Collapsing Nodes

To focus on a particular node in the topology map, you select that node by clicking it. When the node is selected, it is highlighted with a blue circle. By right-clicking a selected node icon, you can access a pop-up menu with commands relevant to that type of node. For example, right-clicking the WAN node displays a menu that lets you expand or collapse all sites.

For sites that include hardware, you can click the site’s node icon and then click on the node.

Refreshing the View

By default, the topology map automatically refreshes every 5 minutes. You can stop or resume automatic refreshing by clicking the Stop Refreshing button or the Resume Refreshing button at the top right corner of the page. You can refresh the view immediately by clicking the Refresh button.

Zooming in and out in the Topology Map

From any view in the topology map, you can use the mouse wheel to zoom in and out so that the size of the map increases or decreases.
Viewing IP Addresses for Servers and Switches

To view the IP address for a switch or server, hover over the node icon for that component.

Accessing a List of Sites

Click the Show Sites Menu button to display the All Sites list, which provides an expandable tree that shows a nested list of all configured sites, reflecting parent-child relationships for the sites. After clicking the top of the tree to expand the list, you can double-click any active site to see a topology map for that site. Each site in the list has a colored icon that corresponds to the site’s status.

You can collapse the All Sites list by clicking at the top of the heading bar, and you can expand it by clicking . To reset the topology map to the high-level System view, click the “All Sites” entry in the All Sites list. To close the All Sites list, click the Hide Sites Menu button.

Repositioning the Node Icons and All Sites List in the Map View

To focus on a particular node within the topology map, you can adjust the view as follows:

- Click and drag any node icon to change its orientation in the topology map.
- Click any point in the background of the topology map and drag to reposition the map.

To reposition the All Sites list on the page, click and drag the expanded or minimized list to a different area on the page.

Expanding All Sites

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
3. In the navigation menu, click Topology.
   The ShoreTel System view is displayed.
4. Click the WAN icon.
   The WAN node is highlighted with a blue circle.
5. Right click the WAN icon and select Expand All Sites.
   All sites, servers, and switches in the ShoreTel system and their logical connections are displayed.

Viewing System Topology

The nodes in the System view represent logical and physical ShoreTel system components: sites, servers, and switches.
1. Launch ShoreTel Director.

2. Click Maintenance > Diagnostics & Monitoring.

3. In the navigation menu, click Topology.

   The high-level ShoreTel System view is displayed, showing sites configured in the system.

4. To see all configured components and associations, click the WAN node icon.

   The node is highlighted with a blue circle.

5. Right-click the highlighted WAN node icon, and select Expand All Sites from the pop-up menu.

   All sites, switches, and servers in the ShoreTel system are displayed.

6. Click any site, server, or switch to see the one-way connectivity for that component to other components in the system.

**Tip**

You can easily remove components from the topology view for a particular site by clicking the site’s node icon and then clicking .

---

**Note**

The System view reflects logical connectivity. For this reason, the network icon labeled as a WAN might actually represent a LAN.

---

### Viewing Site Topology

1. Launch ShoreTel Director.

2. Click Maintenance > Diagnostics & Monitoring.

3. In the navigation menu, click Topology.

   The high-level ShoreTel System view is displayed, showing sites configured in the system.

4. To see the topology for a site where hardware is installed, do one of the following:

   **Use the Sites Menu, as follows:**

   1. Click the Show Sites Menu button.

      The All Sites list is displayed.

   2. Click to expand the menu.

   3. In the All Sites list, double-click the site.
All servers, switches, trunk groups, and phone collections for the site are displayed.

- Use the pop-up command menu as follows:

  1. Click the node icon for that site.

      The site’s node icon is highlighted with a blue circle.

  2. Right-click the highlighted site node icon, and select **Show Site Topology** from the pop-up menu.

      All servers, switches, trunk groups, and phone collections for the site are displayed.

5. Click the icon for any server, switch, trunk group, or phone collection to see the one-way connectivity from that component to other components in the system.

6. To see details on any component, do the following:

   a. Click the component’s icon.

      The component’s node is highlighted with a blue circle.

   b. Right-click the highlighted node, and select one of the following commands from the pop-up menu:

      - For a server, select **Show Server Details**.
      - For a switch, select **Show Switch Details**.
      - For a trunk group, select **Show Trunk Group Details**.
      - For phones, do one of the following:
        - Select **Show Phone Details (This Site)**.
        - Select **Show Phone Details (This Switch)**.

      The status page for the selected component is displayed.

**Viewing Site Connectivity**

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

3. In the navigation menu, click **Topology**.

   The ShoreTel System view is displayed.

4. Click the node icon for a site.

   The site’s icon is highlighted with a blue circle, and the site’s one-way connectivity to other components is displayed.
**Viewing Server Connectivity**

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Topology**.
   
   The ShoreTel System view is displayed.
4. Expand a site by doing one of the following:
   - In the **All Sites** list, click a site.
   - In the topology map, click a site node and then click the plus icon on the site node.
   - In the topology map, click a site node and then right-click it and select **Show Site Topology** from the pop-up menu.
5. Click a server icon.
   
   The server is highlighted with a blue circle, and one-way connectivity to other components is displayed.

**Viewing Switch Connectivity**

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Topology**.
   
   The ShoreTel System view is displayed.
4. Expand a site by doing one of the following:
   - In the **All Sites** list, click a site.
   - In the topology map, select a site and click the plus icon on the site node.
5. Click a switch icon.
   
   The switch is highlighted with a blue circle, and the switch’s one-way connectivity to other components is displayed. The server that manages the switch is indicated by a small circle (switch management indicator) on the connection line.
Monitoring the Status of ShoreTel Components

The status pages in the Diagnostics & Monitoring interface provide a detailed view of real-time status, performance metrics, and call history for the following system components:

- System
- Sites
- Switches
- Servers
- IP phones
- Trunk groups
- Voice mail
- Make Me Conferencing
- Audio/Web Conferencing
- IM
- Connect Sync

The status pages are divided into a top pane and a bottom pane. The top pane (the “list pane”) displays a list of devices and their status, and the bottom pane (the “details pane”) displays detailed information about the specific component highlighted in the top pane. Where appropriate, the bottom pane also provides additional tabs for information such as detailed status, performance, and related calls.

When you click a particular type of status page in the navigation menu, by default the first item in the list pane is selected and that item’s detailed information is displayed in the details pane. You can select another item in the list pane and view its details in the details pane.

Monitoring System Status

The Status > System page provides a high-level summary of the components in your ShoreTel system. The page includes a list pane at the top and a bottom pane that shows the system’s conferencing capacity.

Status > System List Pane

The Sites area on the left side of the list pane displays a list of sites in configuration-hierarchy order and provides high-level information about site status. The Servers and Appliances area on the right side of the list pane shows servers and appliances grouped according to the sites to which they belong.

On the Status > System page, you can click a site name to open the Status > Sites page or a server or appliance name to open the Status > Servers page. For more information, see Monitoring Site Status on page 690 and Monitoring Server Status on page 707.
### Table 92: Columns in the Status > System List Pane

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sites</strong></td>
<td></td>
</tr>
<tr>
<td>site status indicator</td>
<td>High-level status of the site:</td>
</tr>
<tr>
<td></td>
<td>- Green indicates that the site is in service and connected.</td>
</tr>
<tr>
<td></td>
<td>- Yellow indicates a warning state at the site that does not affect the site’s service.</td>
</tr>
<tr>
<td></td>
<td>- Red indicates that the site is down or experiencing a severe service impact.</td>
</tr>
<tr>
<td>Site</td>
<td>The name of the site</td>
</tr>
<tr>
<td>TMS Comm</td>
<td>TMS connections within the site. The first number represents the available connections, and the second number represents the expected total number of connections.</td>
</tr>
<tr>
<td>Usage</td>
<td>The current switch and phone usage for the site. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>- Idle—No ports or IP phones are off-hook or in-use.</td>
</tr>
<tr>
<td></td>
<td>- In Service—The configured ports or IP phones are ready for service.</td>
</tr>
<tr>
<td></td>
<td>- In Use—At least one port or IP phone has an active call.</td>
</tr>
<tr>
<td></td>
<td>- Ports Off-Hook—At least one port or IP phone is off-hook, but no ports are in use.</td>
</tr>
<tr>
<td></td>
<td>- Unknown—The usage state is unknown, perhaps because communication between the server and the switch has been lost.</td>
</tr>
<tr>
<td>Service</td>
<td>The current service status for the site. More than one service state can be in effect for a site, but only the most severe service state is displayed until that state is resolved. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>- Unknown—The state of the switch is unknown. This is typically the case during an upgrade when the switch is disconnected from the system.</td>
</tr>
<tr>
<td></td>
<td>- In Service—All system components are in service and functioning.</td>
</tr>
<tr>
<td></td>
<td>- Firmware Update Available—The server has a new optional version of firmware available for voice switches. A voice switch in this state continues to run call control as well as access the voice services on the server. To propagate the patch to the voice switches, you must restart them.</td>
</tr>
<tr>
<td></td>
<td>- Restart Pending—A Restart When Idle command was issued, but the restart did not occur because switch ports are still in use.</td>
</tr>
<tr>
<td></td>
<td>- Upgrade In Progress—The voice switch is currently being upgraded with a new software version.</td>
</tr>
<tr>
<td></td>
<td>- Platform Version Mismatch—The switch firmware version does not match the build version installed on the Headquarters server.</td>
</tr>
<tr>
<td></td>
<td>- Booting From FTP—The ShoreTel voice switch did not boot from flash memory but booted from an FTP server, most likely on the ShoreTel server. You can correct this problem by rebooting the voice switch. If this does not correct the problem, contact ShoreTel Technical Support.</td>
</tr>
</tbody>
</table>
Service (continued)
- Port Out Of Service—One or more, but not all, trunk or phone ports are out of service on the voice switch. Ports or IP phones typically go out of service because either someone manually put them out of service or the call control software automatically put them out of service due to a signaling problem (for example, the dial tone was not received from the central office).
- Hunt Group Out Of Service—All ports associated with a hunt group are out of service.
- SIP Trunks out Of Service—All ports associated with a SIP trunk are out of service.
- SIP Trunks Out Of Service Operational—All ports associated with a SIP trunk are out of service because of operational trouble, typically on the other side of the trunk connection.
- SIP Trunks Out Of Service Administrative—All ports associated with a SIP trunk are out of service because an administrator has set them to an “out of service” state.
- Ports Out Of Service Busy—All ports are out of service.
- SoftPhones Out Of Service—All softphones are out of service for one or more switches in the system.
- All Ports Out Of Service—All ports (trunk, softphone, analog phone, and IP phone) on a ShoreTel voice switch at the site are out of service.
- Configuration Mismatch—A configuration mismatch has been detected between a switch and a server, between two servers, or between two switches.
- Firmware Mismatch—The firmware on one or more phones does not match the build version installed on the Headquarters server.
- D Channel Down—A PRI or BRI signaling channel (D channel) is out of service.
- Fan Failure—A fan associated at least one switch has failed.
- Temperature Failure—The temperature associated with a switch has exceeded the normal safe range.
- Voltage Failure—The voltage associated with a switch has exceeded the normal safe range.
- Firmware Update Failure—A firmware update was requested for a phone, but it failed.
- Disk Failure—A disk associated with a switch or server has failed.
- Lost Communication—The server lost communication with the voice switch. Note that the voice switch may be fully operational but the ShoreTel server cannot see the voice switch due to a networking issue. This also occurs when the voice switch is powered off.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service (continued)</td>
<td>- Port Out Of Service—One or more, but not all, trunk or phone ports are out of service on the voice switch. Ports or IP phones typically go out of service because either someone manually put them out of service or the call control software automatically put them out of service due to a signaling problem (for example, the dial tone was not received from the central office).</td>
</tr>
<tr>
<td>Hunt Group Out Of Service</td>
<td>All ports associated with a hunt group are out of service.</td>
</tr>
<tr>
<td>SIP Trunks out Of Service</td>
<td>All ports associated with a SIP trunk are out of service.</td>
</tr>
<tr>
<td>SIP Trunks Out Of Service</td>
<td>Operational—All ports associated with a SIP trunk are out of service because of operational trouble, typically on the other side of the trunk connection.</td>
</tr>
<tr>
<td>SIP Trunks Out Of Service</td>
<td>Administrative—All ports associated with a SIP trunk are out of service because an administrator has set them to an “out of service” state.</td>
</tr>
<tr>
<td>Ports Out Of Service Busy</td>
<td>All ports are out of service.</td>
</tr>
<tr>
<td>SoftPhones Out Of Service</td>
<td>All softphones are out of service for one or more switches in the system.</td>
</tr>
<tr>
<td>All Ports Out Of Service</td>
<td>All ports (trunk, softphone, analog phone, and IP phone) on a ShoreTel voice switch at the site are out of service.</td>
</tr>
<tr>
<td>Configuration Mismatch</td>
<td>A configuration mismatch has been detected between a switch and a server, between two servers, or between two switches.</td>
</tr>
<tr>
<td>Firmware Mismatch</td>
<td>The firmware on one or more phones does not match the build version installed on the Headquarters server.</td>
</tr>
<tr>
<td>D Channel Down</td>
<td>A PRI or BRI signaling channel (D channel) is out of service.</td>
</tr>
<tr>
<td>Fan Failure</td>
<td>A fan associated at least one switch has failed.</td>
</tr>
<tr>
<td>Temperature Failure</td>
<td>The temperature associated with a switch has exceeded the normal safe range.</td>
</tr>
<tr>
<td>Voltage Failure</td>
<td>The voltage associated with a switch has exceeded the normal safe range.</td>
</tr>
<tr>
<td>Firmware Update Failure</td>
<td>A firmware update was requested for a phone, but it failed.</td>
</tr>
<tr>
<td>Disk Failure</td>
<td>A disk associated with a switch or server has failed.</td>
</tr>
<tr>
<td>Lost Communication</td>
<td>The server lost communication with the voice switch. Note that the voice switch may be fully operational but the ShoreTel server cannot see the voice switch due to a networking issue. This also occurs when the voice switch is powered off.</td>
</tr>
</tbody>
</table>

**Servers and Appliances**

<table>
<thead>
<tr>
<th>status indicator</th>
<th>Status of the server or appliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server/Appliance</td>
<td>The name of the server or appliance</td>
</tr>
</tbody>
</table>
Status > System Bottom Pane

The bottom pane on the System status page summarizes system-wide audio/web conferencing capacity and provides a section that allows you to apply commands to servers, switches, and appliances. Table 93 on page 690 shows the columns in the Conferencing pane.
For information about how to use the maintenance commands at the bottom of the Status > System page, see the ShoreTel Maintenance Guide.

### Monitoring Site Status

On the Status > Sites page, you can view a list of all sites configured in your ShoreTel system and see a summary of real-time status and performance information for each site. The page includes a list pane and a details pane with Status, Performance, and Calls tabs.

#### Status > Sites List Pane

Table 94 shows the columns in the list pane at the top of the Sites page.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>command check box</td>
<td>Allows selection of one or more sites to apply maintenance commands to the switches at that site</td>
</tr>
</tbody>
</table>
| status indicator    | High-level status of the site:  
  - Green indicates that the site is in service and connected.  
  - Yellow indicates a problem (a warning state) at the site that does not affect the site’s service.  
  - Red indicates that the site is down or experiencing a severe service impact. |
| Site                | The name of the site                                                                                                                          |
| TMS Comm            | The communication state of all switches at the site. The first number represents switches with which the ShoreTel Telephony Management Service (TMS) can currently communicate. The second number is the total number of switches at the site. For more information about TMS, see the ShoreTel Maintenance Guide. |
### Table 94: Columns in the Status > Sites List Pane (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Usage</strong></td>
<td>The current switch and phone usage for the site. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Idle—No ports or IP phones are off-hook or in-use.</td>
</tr>
<tr>
<td></td>
<td>• In Service—The configured ports or IP phones are ready for service.</td>
</tr>
<tr>
<td></td>
<td>• In Use—At least one port or IP phone has an active call.</td>
</tr>
<tr>
<td></td>
<td>• Ports Off-Hook—At least one port or IP phone is off-hook, but no ports are in use.</td>
</tr>
<tr>
<td></td>
<td>• Unknown—The usage state is unknown, perhaps because communication between the server and the switch has been lost.</td>
</tr>
<tr>
<td><strong>Service</strong></td>
<td>The current service status for the site. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Unknown—The state of the switch is unknown. This is typically the case during an upgrade when the switch is disconnected from the system.</td>
</tr>
<tr>
<td></td>
<td>• In Service—All system components are in service and functioning.</td>
</tr>
<tr>
<td></td>
<td>• Firmware Update Available—The server has a new optional version of firmware available for voice switches. A voice switch in this state continues to run call control as well as access the voice services on the server. To propagate the patch to the voice switches, you must restart them.</td>
</tr>
<tr>
<td></td>
<td>• Restart Pending—A Restart When Idle command was issued, but the restart did not occur because switch ports are still in use.</td>
</tr>
<tr>
<td></td>
<td>• Upgrade In Progress—The voice switch is currently being upgraded with a new software version.</td>
</tr>
<tr>
<td></td>
<td>• Platform Version Mismatch—The switch firmware version does not match the build version installed on the Headquarters server.</td>
</tr>
<tr>
<td></td>
<td>• Booting From FTP—The ShoreTel voice switch did not boot from flash memory but booted from an FTP server, most likely on the ShoreTel server. You can correct this problem by rebooting the voice switch. If this does not correct the problem, contact ShoreTel Technical Support.</td>
</tr>
<tr>
<td></td>
<td>• Port Out Of Service—One or more, but not all, trunk or phone ports are out of service on the voice switch. Ports or IP phones typically go out of service because either someone manually put them out of service or the call control software automatically put them out of service due to a signaling problem (for example, the dial tone was not received from the central office).</td>
</tr>
<tr>
<td></td>
<td>• Hunt Group Out Of Service—All ports associated with a hunt group are out of service.</td>
</tr>
<tr>
<td></td>
<td>• SIP Trunks Out Of Service—All ports associated with a SIP trunk are out of service.</td>
</tr>
<tr>
<td></td>
<td>• SIP Trunks Out Of Service Operational—All ports associated with a SIP trunk are out of service because of operational trouble, typically on the other side of the trunk connection.</td>
</tr>
</tbody>
</table>
The details pane at the bottom of the page includes Status, Performance, and Calls tabs.

### Table 94: Columns in the Status > Sites List Pane (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service (continued)</td>
<td>- SIP Trunks Out Of Service Administrative—All ports associated with a SIP trunk are out of service because an administrator has set them to an “out of service” state.</td>
</tr>
<tr>
<td></td>
<td>- Ports Out Of Service Busy—All ports are out of service.</td>
</tr>
<tr>
<td></td>
<td>- SoftPhones Out Of Service—All softphones are out of service for one or more switches in the system.</td>
</tr>
<tr>
<td></td>
<td>- All Ports Out Of Service—All ports (trunk, softphone, analog phone, and IP phone) on a ShoreTel voice switch at the site are out of service.</td>
</tr>
<tr>
<td></td>
<td>- Configuration Mismatch—A configuration mismatch has been detected between a switch and a server, between two servers, or between two switches.</td>
</tr>
<tr>
<td></td>
<td>- Firmware Mismatch—The firmware on one or more phones does not match the build version installed on the Headquarters server.</td>
</tr>
<tr>
<td></td>
<td>- D Channel Down—A PRI or BRI signaling channel (D channel) is out of service.</td>
</tr>
<tr>
<td></td>
<td>- Fan Failure—A fan associated at least one switch has failed.</td>
</tr>
<tr>
<td></td>
<td>- Temperature Failure—The temperature associated with a switch has exceeded the normal safe range.</td>
</tr>
<tr>
<td></td>
<td>- Voltage Failure—The voltage associated with a switch has exceeded the normal safe range.</td>
</tr>
<tr>
<td></td>
<td>- Firmware Update Failure—A firmware update was requested for a phone, but it failed.</td>
</tr>
<tr>
<td></td>
<td>- Disk Failure—A disk associated with a switch or server has failed.</td>
</tr>
<tr>
<td></td>
<td>- Lost Communication—The server lost communication with the voice switch. Note that the voice switch may be fully operational but the ShoreTel server cannot see the voice switch due to a networking issue. This also occurs when the voice switch is powered off.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SIP Trunks</th>
<th>The first number represents the SIP trunks in use (total SIP trunks configured in the database for all switches at each site), and the second number represents the SIP trunk capacity count (the sum of each switch’s built-in and configured SIP port capacity).</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Phones</td>
<td>The first number represents IP phones in use (the total number of IP phone ports configured in the database), and the second number represents IP phone capacity (the sum of all switches’ built-in and configured IP phone ports capacity).</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>The first number represents active bandwidth, and the second number represents admission bandwidth.</td>
</tr>
</tbody>
</table>

### Status > Sites Details Pane

The details pane at the bottom of the page includes Status, Performance, and Calls tabs.
Status Tab

For the site selected in the details pane, the Status tab displays:

- A list of the site’s softswitches, voice switches, voicemail-enabled switches, and service appliances on the left side of the pane
- A list of servers (including Headquarters, voicemail-enabled switches, and servers/appliances) on the right side of the pane

For details about the columns included in the lists, see Table 95 on page 694.

To see details about a particular switch or server:

- On the Status tab, click the name of the switch or server/appliance that you want more information about.
  
  The status page for that switch or server/appliance is displayed.

Performance Tab

The Performance tab includes the following charts:

- The Trunk Group Usage chart shows the five trunk groups with the highest usage on the selected site.
- The Bandwidth Usage chart shows the bandwidth usage trend for the site for the selected time period.

Calls Tab

The Calls tab displays a list of the 10 most recent calls, by default, associated with the selected site. For details about the fields on the Calls tab, see Monitoring Call Quality on page 726.

To see details for a particular call:

- On the Calls tab, click a call stream.

  The Call Quality page, which shows details for the selected call, is displayed.

Monitoring Switch Status

On the Status > Switches page, you can see a list of all switches configured in the system, as well as real-time status and summary statistics for each switch.

Status > Switches List Pane

Table 95 on page 694 shows the columns in the list pane at the top of the Switches page.
Table 95: Columns in the Status > Switches List Pane

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>command check box</td>
<td>Allows selection of one or more switches to apply maintenance commands</td>
</tr>
</tbody>
</table>
| status indicator    | High-level status of the site:  
  - Green indicates that the switch is in service and connected.  
  - Yellow indicates a warning state for the switch that does not affect the switch’s service.  
  - Red indicates that the switch is down or experiencing a severe service impact.  |
| Switch              | The switch name                                                                                                                                                                                            |
| Type                | Switch type abbreviation  
  For a complete list of ShoreTel switch types, see the “ShoreTel Voice Switches” appendix in the *ShoreTel Planning and Installation Guide*. |
| Site                | Name of the site associated with the switch                                                                                                                                                               |
| IP                  | The IP address of the switch                                                                                                                                                                               |
| MAC                 | The MAC address of the switch                                                                                                                                                                             |
| Comms               | TMS connections within the site. Displayed as X/Y where X is the available connections and Y is the expected total number of connections.                                                                  |
| Usage               | The usage state of the switch:  
  - Idle—No ports or IP phones are off-hook or in-use.  
  - In Service—The configured ports or IP phones are ready for service.  
  - In Use—At least one port or IP phone has an active call.  
  - Ports Off-Hook—At least one port or IP phone is off-hook, but no ports are in use.  
  - Unknown—The usage state is unknown, perhaps because communication between the server and the switch has been lost. |
| Service             | The current service status for the switch. Possible values are:  
  - Unknown—The state of the switch is unknown. This is typically the case during an upgrade when the switch is disconnected from the system.  
  - In Service—All system components are in service and functioning.  
  - Firmware Update Available—The server has a new optional version of firmware available for voice switches. A voice switch in this state continues to run call control as well as access the voice services on the server. To propagate the patch to the voice switches, you must restart them.  
  - Restart Pending—A Restart When Idle command was issued, but the restart did not occur because switch ports are still in use.  
  - Upgrade In Progress—The voice switch is currently being upgraded with a new software version.  
  - Platform Version Mismatch—The switch firmware version does not match the build version installed on the Headquarters server. |
Booting From FTP—The ShoreTel voice switch did not boot from flash memory but booted from an FTP server, most likely on the ShoreTel server. You can correct this problem by rebooting the voice switch. If this does not correct the problem, contact ShoreTel Technical Support.

Port Out Of Service—One or more, but not all, trunk or phone ports are out of service on the voice switch. Ports or IP phones typically go out of service because either someone manually put them out of service or the call control software automatically put them out of service due to a signaling problem (for example, the dial tone was not received from the central office).

Hunt Group Out Of Service—All ports associated with a hunt group are out of service.

SIP Trunks Out Of Service—All ports associated with a SIP trunk are out of service.

SIP Trunks Out Of Service Operational—All ports associated with a SIP trunk are out of service because of operational trouble, typically on the other side of the trunk connection.

SIP Trunks Out Of Service Administrative—All ports associated with a SIP trunk are out of service because an administrator has set them to an “out of service” state.

Ports Out Of Service Busy—All ports are out of service.

SoftPhones Out Of Service—All softphones are out of service for one or more switches in the system.

All Ports Out Of Service—All ports (trunk, softphone, analog phone, and IP phone) on a ShoreTel voice switch at the site are out of service.

Configuration Mismatch—A configuration mismatch has been detected between a switch and a server, between two servers, or between two switches.

Firmware Mismatch—The firmware on one or more phones does not match the build version installed on the Headquarters server.

D Channel Down—A PRI or BRI signaling channel (D channel) is out of service.

Fan Failure—A fan associated at least one switch has failed.

Temperature Failure—The temperature associated with a switch has exceeded the normal safe range.

Voltage Failure—The voltage associated with a switch has exceeded the normal safe range.

Firmware Update Failure—A firmware update was requested for a phone, but it failed.

Disk Failure—A disk associated with a switch or server has failed.

Lost Communication—The server lost communication with the voice switch. Note that the voice switch may be fully operational but the ShoreTel server cannot see the voice switch due to a networking issue. This also occurs when the voice switch is powered off.

Table 95: Columns in the Status > Switches List Pane (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service (continued)</td>
<td>- Booting From FTP—The ShoreTel voice switch did not boot from flash memory but booted from an FTP server, most likely on the ShoreTel server. You can correct this problem by rebooting the voice switch. If this does not correct the problem, contact ShoreTel Technical Support.</td>
</tr>
<tr>
<td></td>
<td>- Port Out Of Service—One or more, but not all, trunk or phone ports are out of service on the voice switch. Ports or IP phones typically go out of service because either someone manually put them out of service or the call control software automatically put them out of service due to a signaling problem (for example, the dial tone was not received from the central office).</td>
</tr>
<tr>
<td></td>
<td>- Hunt Group Out Of Service—All ports associated with a hunt group are out of service.</td>
</tr>
<tr>
<td></td>
<td>- SIP Trunks Out Of Service—All ports associated with a SIP trunk are out of service.</td>
</tr>
<tr>
<td></td>
<td>- SIP Trunks Out Of Service Operational—All ports associated with a SIP trunk are out of service because of operational trouble, typically on the other side of the trunk connection.</td>
</tr>
<tr>
<td></td>
<td>- SIP Trunks Out Of Service Administrative—All ports associated with a SIP trunk are out of service because an administrator has set them to an “out of service” state.</td>
</tr>
<tr>
<td></td>
<td>- Ports Out Of Service Busy—All ports are out of service.</td>
</tr>
<tr>
<td></td>
<td>- SoftPhones Out Of Service—All softphones are out of service for one or more switches in the system.</td>
</tr>
<tr>
<td></td>
<td>- All Ports Out Of Service—All ports (trunk, softphone, analog phone, and IP phone) on a ShoreTel voice switch at the site are out of service.</td>
</tr>
<tr>
<td></td>
<td>- Configuration Mismatch—A configuration mismatch has been detected between a switch and a server, between two servers, or between two switches.</td>
</tr>
<tr>
<td></td>
<td>- Firmware Mismatch—The firmware on one or more phones does not match the build version installed on the Headquarters server.</td>
</tr>
<tr>
<td></td>
<td>- D Channel Down—A PRI or BRI signaling channel (D channel) is out of service.</td>
</tr>
<tr>
<td></td>
<td>- Fan Failure—A fan associated at least one switch has failed.</td>
</tr>
<tr>
<td></td>
<td>- Temperature Failure—The temperature associated with a switch has exceeded the normal safe range.</td>
</tr>
<tr>
<td></td>
<td>- Voltage Failure—The voltage associated with a switch has exceeded the normal safe range.</td>
</tr>
<tr>
<td></td>
<td>- Firmware Update Failure—A firmware update was requested for a phone, but it failed.</td>
</tr>
<tr>
<td></td>
<td>- Disk Failure—A disk associated with a switch or server has failed.</td>
</tr>
<tr>
<td></td>
<td>- Lost Communication—The server lost communication with the voice switch. Note that the voice switch may be fully operational but the ShoreTel server cannot see the voice switch due to a networking issue. This also occurs when the voice switch is powered off.</td>
</tr>
</tbody>
</table>
Table 95: Columns in the Status > Switches List Pane (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phones</td>
<td>The first number represents IP phones in use (the total number of IP phone ports configured in the database), and the second number represents IP phone capacity (the sum of all switches’ built-in and configured IP phone ports capacity). For a virtual phone switch, a red number indicates that the number of IP phones in use exceeds the provisioned capacity.</td>
</tr>
<tr>
<td>SIP Trks</td>
<td>The first number represents the SIP trunks in use (total SIP trunks configured in the database for all switches at each site), and the second number represents the SIP trunk capacity count (the sum of each switch’s built-in and configured SIP port capacity). For a virtual trunk switch, a red number indicates that the number of SIP trunks in use exceeds the provisioned capacity.</td>
</tr>
<tr>
<td>Conf</td>
<td>The first number represents conferences in use, and the second number represents conference capacity. For a virtual phone switch, a red number indicates that the number of active conferences exceeds the provisioned capacity.</td>
</tr>
<tr>
<td>HG</td>
<td>The number of hunt groups configured for the switch</td>
</tr>
<tr>
<td>Role</td>
<td>Specifies whether the switch is operating as a primary switch or a failed-over spare switch.</td>
</tr>
</tbody>
</table>

Status > Switches Details Pane

The details pane at the bottom of the Status > Switches page includes Status, Performance, and Calls tabs.

Status Tab

The Status tab on the Status > Switches page lets you monitor details for each switch. The details displayed depend on the type of switch selected. All fields displayed on the Status tab, regardless of switch type, are described in Table 96.

Note

If you select a softswitch in the list pane, the details pane does not include a Status tab.
Table 96: Fields in the Status > Switches Details Pane (Status Tab)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ports</td>
<td>status indicator</td>
<td>Status of the port:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Green indicates that the port is in service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Yellow indicates a problem (a warning state) for the port.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Red indicates that the port is down.</td>
</tr>
<tr>
<td>Port</td>
<td>The port number</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>The full name of the port or the trunk name</td>
<td></td>
</tr>
<tr>
<td>Usage</td>
<td>The usage state of the port. The following values are possible:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unknown—The state is unknown, likely because communication between the server and the switch has been lost.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Use—The port has at least one active call.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off Hook—The port is off-hook and has no active calls.</td>
<td></td>
</tr>
<tr>
<td>Service</td>
<td>The service state of the port. The following values are possible:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Service—The port is in service.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out of Service—The port is out of service.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On telephone ports, outbound calls are not possible because no dial tone is available. Also, the system does not offer inbound calls to the user.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On trunk ports, outbound calls do not seize the trunk, and inbound calls are not answered.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On loop start trunks, calls seize the trunk to emulate a busy condition to the central office.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out of Service (operational)—The port is out of service due to a manual “put out of service” command.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For trunks, the switch automatically attempts to seize the trunk on a periodic basis. When successful, the trunk is automatically put back in service.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 96: Fields in the Status > Switches Details Pane (Status Tab) (Continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ports (applies to service appliances)</td>
<td>Conference Ports</td>
<td>Type of conference port</td>
</tr>
</tbody>
</table>
| | Active Conferences (In Use) | The number of audio or web conferences that are currently active  
For a virtual service appliance, a red number in this field indicates that the number of active conferences exceeds the provisioned capacity. |
| | Ports (In Use) | The number of ports used for audio or web conferences  
For a virtual service appliance, a red number in this field indicates that the number of ports in use exceeds the provisioned capacity. |
| | Ports (Free) | The number of dedicated conference ports available but not currently being used for audio or web conferences |
| | Percent (Free) | The percentage of dedicated conference ports that are currently available |
### Table 96: Fields in the Status > Switches Details Pane (Status Tab) (Continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels</td>
<td>command check box</td>
<td>Allows selection of one or more channels to apply maintenance commands (Reset, Put in service, Put out of service, Put out of service when idle)</td>
</tr>
<tr>
<td></td>
<td>status indicator</td>
<td>Status of the port:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Green indicates that the port is in service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Yellow indicates a problem (a warning state) for the port.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Red indicates that the port is down.</td>
</tr>
<tr>
<td>Port</td>
<td>Description</td>
<td>The port number</td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td>Description of the port</td>
</tr>
<tr>
<td>Usage</td>
<td></td>
<td>The usage state of the port. The following values are possible:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Unknown: The state is unknown, likely because communication between the server and the switch has been lost.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ In Use: The port has at least one active call.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Off Hook: The port is off-hook and has no active calls.</td>
</tr>
<tr>
<td>Service</td>
<td></td>
<td>The service state of the port. The following values are possible:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ In Service: The port is in service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Out of Service: The port is out of service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On telephone ports, outbound calls are not possible because no dial tone is available. Also, the system does not offer inbound calls to the user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On trunk ports, outbound calls do not seize the trunk, and inbound calls are not answered.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On loop start trunks, calls seize the trunk to emulate a busy condition to the central office.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▪ Out of Service (operational): The port is out of service due to a manual “put out of service” command.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For trunks, the switch automatically attempts to seize the trunk on a periodic basis. When successful, the trunk is automatically put back in service.</td>
</tr>
</tbody>
</table>
Hardware Fan Provides status for the switch's fan. Possible values are as follows:
- OK
- Slow
- Failed
- Unknown

Temperature Provides status about the temperature of the switch. Possible values are as follows:
- OK
- Yellow Alarm
- Red Alarm
- Unknown

Voltages Provides status the switch's talk battery and ring voltages. Possible values are as follows:
- OK
- Failed
- Unknown
### Table 96: Fields in the Status > Switches Details Pane (Status Tab) (Continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Status</td>
<td>D-Channel</td>
<td>For a PRI, displays the status of the D-Channel. Possible values are as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Down</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- In Service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Out of Service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Unknown</td>
</tr>
<tr>
<td></td>
<td>Line Coding</td>
<td>Displays the status of the line coding for the switch. Possible values are as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bipolar Violations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Loss of Signal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Unknown</td>
</tr>
<tr>
<td></td>
<td>Framing</td>
<td>Displays the status of the framing for the switch. Possible values are as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Yellow Alarm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bit Error</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Out of Frame</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Unknown</td>
</tr>
<tr>
<td></td>
<td>Loopback</td>
<td>Displays the status of loopback for the switch. Possible values are as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Unknown</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can apply a loopback command (Off, Line, PayLoad) by selecting a command from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>Span</td>
<td>Using the check box, provides the option to apply the following commands:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Reset</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Put in service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Put out of service when idle</td>
</tr>
</tbody>
</table>
Table 96: Fields in the Status > Switches Details Pane (Status Tab) (Continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Error Summary</td>
<td>Error Free Seconds</td>
<td>The number of error-free seconds that occurred in the last 15 minutes and 24 hours.</td>
</tr>
<tr>
<td></td>
<td>Errored Seconds</td>
<td>The number of errored seconds that occurred in the last 15 minutes and 24 hours.</td>
</tr>
<tr>
<td></td>
<td>Severe Error Seconds</td>
<td>The number of severely errored seconds that occurred in the last 15 minutes and 24 hours.</td>
</tr>
<tr>
<td></td>
<td>Unavailable Seconds</td>
<td>The number of seconds the server was not available.</td>
</tr>
<tr>
<td></td>
<td>Out of Frame</td>
<td>The number of times the link has been out of frame in the past 15 minutes and 24 hours.</td>
</tr>
</tbody>
</table>
### Table 96: Fields in the Status > Switches Details Pane (Status Tab) (Continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Last Boot Time</td>
<td>The last time the switch booted</td>
</tr>
<tr>
<td></td>
<td>Boot Source</td>
<td>The source of the last time the switch booted. Possible values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Flash</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- FTP boot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- unknown boot source</td>
</tr>
<tr>
<td></td>
<td>Connect Time</td>
<td>The most recent time that the server reestablished a connection with the switch</td>
</tr>
<tr>
<td></td>
<td>Boot ROM Version</td>
<td>The boot ROM version number</td>
</tr>
<tr>
<td></td>
<td>Firmware Version</td>
<td>The version number of the firmware the switch is running</td>
</tr>
<tr>
<td></td>
<td>Platform Version</td>
<td>The version number of the platform for the virtual service appliance</td>
</tr>
<tr>
<td></td>
<td>CPU Board Version</td>
<td>The version number of the switch’s CPU board</td>
</tr>
<tr>
<td></td>
<td>CPU Board FPGA Version</td>
<td>The version number of the switch’s CPU board field-programmable gate array</td>
</tr>
<tr>
<td></td>
<td>CPU Usage</td>
<td>The current CPU utilization (by percentage) for the switch</td>
</tr>
<tr>
<td></td>
<td>Memory Usage</td>
<td>The current memory utilization (by percentage) for the switch</td>
</tr>
<tr>
<td></td>
<td>Active Calls</td>
<td>The number of calls currently in progress on the switch</td>
</tr>
<tr>
<td></td>
<td>Number of CPU Cores</td>
<td>The number of CPU cores configured for the virtual machine hosting the virtual switch</td>
</tr>
<tr>
<td></td>
<td>CPU Speed (MHz)</td>
<td>The CPU speed of the virtual machine that hosts the virtual switch</td>
</tr>
<tr>
<td></td>
<td>Memory Configured (MB)</td>
<td>The amount of memory configured on the virtual machine that hosts the virtual switch</td>
</tr>
<tr>
<td></td>
<td>Disk Total (GB)</td>
<td>The total disk space capacity of the virtual machine that hosts the virtual service appliance</td>
</tr>
<tr>
<td></td>
<td>Link Status</td>
<td>The status of the connection</td>
</tr>
<tr>
<td></td>
<td>Active Interface</td>
<td>The name of the active network interface card</td>
</tr>
<tr>
<td></td>
<td>Time Server</td>
<td>The IP address of the time server</td>
</tr>
</tbody>
</table>
### Table 96: Fields in the Status > Switches Details Pane (Status Tab) (Continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hunt Groups</td>
<td>Status Indicator</td>
<td>Indicates the status of the hunt group:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Green indicates that the hunt group is operating normally.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Yellow indicates that the hunt group is out of service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Red indicates that the hunt group is not functional.</td>
</tr>
<tr>
<td></td>
<td>Extension</td>
<td>The extension number for the hunt group</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>The name of the hunt group</td>
</tr>
<tr>
<td></td>
<td>Usage</td>
<td>The current usage state of the hunt group. Possible value are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Idle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Normal</td>
</tr>
<tr>
<td></td>
<td>Service</td>
<td>The current service state of the hunt group. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Normal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Out of Service (Operational)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Out of Service (Administrative)</td>
</tr>
<tr>
<td>IP Phones</td>
<td>status indicator</td>
<td>High-level status for the IP phones configured on the switch:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Green indicates that all phones on the voice switch are in service.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Yellow indicates that the Firmware Status of at least one phone on the voice switch is “Firmware Version Mismatch”.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Red indicates that at least one phone is out of service.</td>
</tr>
<tr>
<td></td>
<td>IP Phones Maintenance</td>
<td>Click this link to go to the IP Phones status page.</td>
</tr>
<tr>
<td></td>
<td>link</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Phones</td>
<td>The number of IP phones configured on the switch and the current IP phone capacity for the switch</td>
</tr>
<tr>
<td></td>
<td>Usage</td>
<td>The current usage state of the IP phones. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Idle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Normal</td>
</tr>
<tr>
<td></td>
<td>Service</td>
<td>The current service state of the IP phones. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- In Service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Out of Service (Operational)</td>
</tr>
</tbody>
</table>
### Table 96: Fields in the Status > Switches Details Pane (Status Tab) (Continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SIP Trunks</strong></td>
<td><strong>command check box</strong></td>
<td>Allows selection of one or more trunks to which to apply maintenance commands (Reset, Put in service, Put out of service, Put out of service when idle), as specified in the Command field at the top of the pane</td>
</tr>
<tr>
<td><strong>Status indicator</strong></td>
<td></td>
<td>Indicates the status of the trunk group based on the percentage of In Service trunks divided by the ports within the trunk group:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Green indicates that the ratio of In Service trunks to Configured trunks is greater than 50 percent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Yellow indicates that the ratio of In Service trunks to Configured trunks is between 20 and 50 percent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Red indicates that the ratio of In Service trunks to Configured trunks is 20 percent or less.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Blank indicates that no trunks are configured for this trunk group.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td></td>
<td>The name of the SIP trunk</td>
</tr>
<tr>
<td><strong>Trunks</strong></td>
<td></td>
<td>The name of the SIP trunk group. Click the link to open the Trunk Group Status page for the trunk group.</td>
</tr>
<tr>
<td><strong>Usage</strong></td>
<td></td>
<td>The current usage state of the SIP trunks. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Idle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Normal</td>
</tr>
<tr>
<td><strong>Service</strong></td>
<td></td>
<td>The current service state of the trunk group. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- In Service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Out of Service</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Unknown</td>
</tr>
<tr>
<td><strong>Span x</strong> <strong>(Disabled or Enabled)</strong></td>
<td><strong>Category</strong></td>
<td>Possible values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Layer 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Layer 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Loopback</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Span</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td></td>
<td>Possible values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Active</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td></td>
<td>Use the command drop-down lists to turn Loopback on or off and to apply various commands to the Span.</td>
</tr>
</tbody>
</table>
Performance Tab

The Performance tab includes the following charts:

- The Feature Usage chart shows the maximum and average number of calls related to specific features during the specified time interval. The features included in the chart are voicemail, Hunt Groups, Workgroups, BCA, and Paging Groups. Each feature is displayed separately so that you can see the extent to which each feature has been used for a given time interval.

  Feature usage counts reflect the number of active calls at the time TMS writes to the Monitoring Database, not the cumulative number of active calls between measurement intervals. For this reason, calls less than 30 seconds in duration might not be reflected in feature usage counts.

- The Platform Resources chart shows the CPU and memory usage trend for the selected switch for the selected time period.

  Because high feature usage can lead to an increase in CPU and memory usage, the information in these charts might be correlated.

Calls Tab

The Calls tab displays a list of the 10 most recent calls, by default, associated with the selected switch. For details about the fields on the Calls tab, see Monitoring Call Quality on page 726.

To see details for a particular call:

- On the Calls tab, click a call stream.

  The Call Quality page, which shows details for the selected call, is displayed.
Monitoring Server Status

From the Status > Servers page, you can view a list of all servers and appliances configured in the system, as well as the real-time status and summary statistics for each server and appliance.

Status > Servers List Pane

Table 97 shows the columns in the list pane at the top of the Servers page.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status indicator</td>
<td>Shows the status of the server:</td>
</tr>
<tr>
<td></td>
<td>- Green indicates that the server is operating normally.</td>
</tr>
<tr>
<td></td>
<td>- Yellow indicates that the server is in a warning state but still functioning.</td>
</tr>
<tr>
<td></td>
<td>- Red indicates that the server is in an error state.</td>
</tr>
<tr>
<td>Server/Appliance</td>
<td>The name of the server</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the server</td>
</tr>
<tr>
<td>Type</td>
<td>The device type of the server or appliance</td>
</tr>
<tr>
<td>Site</td>
<td>The name of the site where the server resides</td>
</tr>
</tbody>
</table>
## Table 97: Columns in the Status > Servers List Pane (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Status      | The status of the server. Possible values are:  
|             | ■ Unknown—The status of the server or appliance is unknown. This typically occurs during upgrade or when the server is disconnected from the Headquarters server for an extended period of time.  
|             | ■ In Service—The server or appliance is in service.  
|             | ■ Software Upgrade Available—A new software version is available for the server or appliance.  
|             | ■ Software Version Mismatch—The version of the server software does not match the Headquarters server, which could cause instability.  
|             | ■ Database Version Mismatch—The schema version of the distributed database instance on the server does not match the version expected by the server.  
|             | ■ SMTP Send Error—The SMTP server is having persistent trouble sending email.  
|             | ■ Error Initialize TMS—The TMS instance on the server has encountered an error upon initialization.  
|             | ■ Lost Database Connection—The connection to the Headquarters database or local distributed database has failed.  
|             | ■ Lost TAPI—TAPI connectivity has failed.  
|             | ■ Lost Communication—The connection to one or more switches has failed.  
|             | ■ Unexpected Error—An unknown error has occurred, which indicates a critical problem. |
| Services    | The running state of the server’s services. Possible values are:  
|             | ■ Running  
|             | ■ Not Running  
|             | ■ Unknown |
| DB          | The status of the server’s local database if it has one:  
|             | ■ A green icon indicates that the server’s local database is functioning normally.  
|             | ■ A red icon indicates that the database is down or, if distributed database is enabled, is not synchronized with the Headquarters database. |
| Disk Used   | The percentage of the server’s disk space in use |
Status > Servers Details Pane

The details pane provides more status information about the selected server, including database information, services running on the servers, and a list of calls associated with the selected server. The details pane includes Status and Calls tabs.

Status Tab

The Status tab displays different information based on the server type you select in the list pane. The fields for the various types of servers are described in the following tables:

- Table 98 describes the fields on the Status tab for a Headquarters server.
- Table 99 describes the fields on the Status tab for a Distributed Voice Server.
- Service appliances include only an Application Service Status area on the Status tab, which lists services relevant to service appliances.

Table 98: Fields in the Status > Servers Details Pane (Status Tab) for a Headquarters Server

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Database Snapshot button</td>
<td>Provides a means to create a snapshot of the master database</td>
</tr>
<tr>
<td>Status</td>
<td>Shows status of TAPI and SMTP Send, as follows:</td>
</tr>
<tr>
<td></td>
<td>- TAPI status can be OK or Lost TAPI.</td>
</tr>
<tr>
<td></td>
<td>- SMTP Send status can be OK or Failed.</td>
</tr>
<tr>
<td>Database</td>
<td>Provides the following status information for the master database:</td>
</tr>
<tr>
<td></td>
<td>- status indicator</td>
</tr>
<tr>
<td></td>
<td>- Master State</td>
</tr>
<tr>
<td></td>
<td>- Master Log File Name</td>
</tr>
<tr>
<td></td>
<td>- Master Log Position</td>
</tr>
<tr>
<td>Application Service Status</td>
<td>Provides a list of services running on the server and their status,</td>
</tr>
<tr>
<td></td>
<td>and allows you to apply commands to these services. For more information</td>
</tr>
<tr>
<td></td>
<td>about these services, see Table 100 on page 710.</td>
</tr>
</tbody>
</table>

Table 99: Fields in the Status > Servers Details Pane (Status Tab) for a Distributed Voice Server

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resync Database command button</td>
<td>Provides a means to resynchronize the remote database with the master</td>
</tr>
<tr>
<td></td>
<td>database on the Headquarters server. For more information, see Creating</td>
</tr>
<tr>
<td></td>
<td>a Database Snapshot and Resynchronizing Databases on page 713.</td>
</tr>
<tr>
<td>Status</td>
<td>Shows status of TAPI and SMTP Send, as follows:</td>
</tr>
<tr>
<td></td>
<td>- TAPI status can be OK or Lost TAPI.</td>
</tr>
<tr>
<td></td>
<td>- SMTP Send status can be OK or Failed.</td>
</tr>
</tbody>
</table>
The Application Service Status area, which is included on the Status tab for Headquarters servers, Distributed Voice Servers, and service appliances, provides current status for the ShoreTel services, which are listed in Table 100 on page 710. For service appliances, the Application Service Status area lists only the services that are relevant to the service appliance.

Table 100: ShoreTel Services

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShoreTel Monitoring Service</td>
<td>ShoreTel Monitoring Service</td>
<td>This service enables the monitoring processes necessary for the ShoreTel Diagnostics &amp; Monitoring system.</td>
</tr>
<tr>
<td>ShoreTel-CDR</td>
<td>ShoreTel Call Accounting</td>
<td>This service records call accounting information, workgroup and call queueing data, agent activity, and media streams in call detail records (CDRs).</td>
</tr>
<tr>
<td>ShoreTel-CSISSVC</td>
<td>ShoreTel CSIS Server</td>
<td>This service manages communications between the server and ShoreTel clients.</td>
</tr>
<tr>
<td>ShoreTel-CSISVMsvc</td>
<td>ShoreTel CSIS VM Server</td>
<td>This service provides notification for clients and voicemail.</td>
</tr>
<tr>
<td>ShoreTel-DBUpdateSvc</td>
<td>ShoreTel Database Update</td>
<td>This service accepts database updates from remote computers.</td>
</tr>
<tr>
<td>ShoreTel-Director</td>
<td>ShoreTel Director</td>
<td>This service provides diagnostics and monitoring capabilities for ShoreTel system components.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ShoreTel-DirectorProxy</td>
<td>ShoreTel Director Proxy</td>
<td>This service is a web server and a reverse proxy for the ShoreTel-Director service.</td>
</tr>
<tr>
<td>ShoreTel-DirectorUtil</td>
<td>ShoreTel Director Utilities</td>
<td>This service provides miscellaneous capabilities for ShoreTel Director, including controlling services, browsing the NT event log, and generating content for Quick Look.</td>
</tr>
<tr>
<td>ShoreTel-DRS</td>
<td>ShoreTel Distributed Routing Service</td>
<td>This service allows the ShoreTel system to scale beyond 100 switches.</td>
</tr>
<tr>
<td>ShoreTel-EventSvc</td>
<td>ShoreTel Event Service</td>
<td>This service distributes events to ShoreTel applications and services.</td>
</tr>
<tr>
<td>ShoreTel-EventWatch</td>
<td>ShoreTel Event Watch Server</td>
<td>This service monitors the event log and delivers email notifications on certain events.</td>
</tr>
<tr>
<td>ShoreTel-IPDS</td>
<td>ShoreTel Client Application Service</td>
<td>This service manages client interaction for desktop, web, and device clients.</td>
</tr>
<tr>
<td>ShoreTel-MailServ</td>
<td>ShoreTel Voice Mail Message Server</td>
<td>This service provides user mailbox capabilities, AMIS features, and system auto-attendant menus. It also manages the voicemail message store.</td>
</tr>
<tr>
<td>ShoreTel-MYSQLCDR</td>
<td>ShoreTel-MYSQLCDR</td>
<td>This service is a database process related to the Call Accounting Database.</td>
</tr>
<tr>
<td>ShoreTel-MYSQLConfig</td>
<td>ShoreTel-MYSQLConfig</td>
<td>This service is a database process related to the configuration database for ShoreTel Director.</td>
</tr>
<tr>
<td>ShoreTel-MYSQLMonitor</td>
<td>ShoreTel-MYSQLMonitor</td>
<td>This service is a database process related to the monitoring database for the Diagnostics &amp; Monitoring system.</td>
</tr>
<tr>
<td>ShoreTel-Notify</td>
<td>ShoreTel Notification Server</td>
<td>This service notifies ShoreTel application services of changes to the ShoreTel configuration.</td>
</tr>
<tr>
<td>ShoreTel-PortMgr</td>
<td>ShoreTel Voice Mail Port Manager</td>
<td>This service is part of the ShoreTel voicemail system and acts as the platform for voicemail operations. It provides user mailbox capabilities, AMIS features, and system auto-attendant menus.</td>
</tr>
<tr>
<td>ShoreTel-Portmap</td>
<td>ShoreTel Port Mapper</td>
<td>This service manages the registration ports for ONCD RPC applications. It initiates RPC communication connections between TMS and IPBX switches.</td>
</tr>
<tr>
<td>ShoreTel-RemoteLogSvc</td>
<td>ShoreTel Remote Logging</td>
<td>This service accepts logging from remote computers.</td>
</tr>
</tbody>
</table>
Starting or Stopping a Service

1. Launch ShoreTel Director.

2. Click Maintenance > Diagnostics & Monitoring.

3. In the navigation menu, click Status > Servers.

   The Servers page is displayed.

4. In the list pane at the top, click the Headquarters server.

   The details for the Headquarters server are displayed on the Status tab.

5. On the Status tab, scroll to the Application Server Status area, and in the Command drop-down list select Start or Stop.

6. Select the check box of the service or services you want to start or stop.

7. Click Apply.
8. In the confirmation dialog box, click OK.

Creating a Database Snapshot and Resynchronizing Databases

You can determine if you need to create a database snapshot by determining how far out of synchronization the remote database is from the Headquarters database. To determine the database synchronization status, compare the master log file name and the master log file position for the Headquarters database (available in the Database section of the Status tab for the Headquarters server) with the details for the remote database (available in the Local Database section of the Status tab for the remote server). You can synchronize the two database systems. The synchronization point is the last snapshot performed on the master database.

To create a database snapshot:

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Status > Servers**.
   The Servers page is displayed.
4. In the list pane at the top, click the Headquarters server.
   The details for the Headquarters server are displayed on the Status tab.
5. Click the **Create Database Snapshot** button.
6. In the confirmation dialog box, click **OK**.

To resynchronize a remote database with the Headquarters database:

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Status > Servers**.
   The Servers page is displayed.
4. In the list pane at the top, click the remote server.
   The details for the remote server are displayed on the Status tab.
5. Click the **Resync Database** button.
6. In the confirmation dialog box, click **OK**.

Calls Tab

The Calls tab displays a list of the most recent 10 calls, by default, for the selected server. For details about the fields on the Calls tab, see **Monitoring Call Quality** on page 726.
Monitoring IP Phone Status

The Status > IP Phones page lets you view a list of all IP phones configured in the system, along with status information and call details for each. The page includes a list pane at the top and a details pane at the bottom.

Status > IP Phones List Pane

The list pane displays a list of all IP phones currently available in the system and lets you view current status information for any phone listed. Table 101 shows the columns in the list pane on the IP Phones page.

You can use the filtering capability to quickly find a particular phone. For details on filtering, see Filtering Information on page 666.

The process for updating firmware on ShoreTel 400-Series IP phones is different than for earlier ShoreTel phone models. While earlier ShoreTel phones automatically download available new firmware upon rebooting, ShoreTel 400-Series IP phones download new firmware only after you select the phones and apply the appropriate commands (such as Download and Update) on the IP Phones list pane. Rebooting the 400-Series IP phones does not update the phone firmware. Details are provided in the ShoreTel Maintenance Guide.

Rebooting earlier ShoreTel phone models updates phone firmware, but you can also manage the reboot process for these phones by using the commands on the IP Phones list pane.

Table 101: Columns in the Status > IP Phones List Pane

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>command check box</td>
<td>Allows selection of one or more phones for application of maintenance commands</td>
</tr>
<tr>
<td>status indicator</td>
<td>The current status of the phone:</td>
</tr>
<tr>
<td></td>
<td>- Green indicates that the phone is in service.</td>
</tr>
<tr>
<td></td>
<td>- Yellow indicates that the firmware version is not up to date.</td>
</tr>
<tr>
<td></td>
<td>- Red indicates that the phone is not in service.</td>
</tr>
<tr>
<td>Name</td>
<td>The configured name of the IP phone. By default, this is the MAC address of the phone.</td>
</tr>
<tr>
<td>Site</td>
<td>The name of the site where the phone resides</td>
</tr>
<tr>
<td>Switch</td>
<td>The name of the switch that manages the phone</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user who is assigned to the phone</td>
</tr>
<tr>
<td>Model</td>
<td>The phone model</td>
</tr>
<tr>
<td>Hardware Version</td>
<td>The hardware version of the phone</td>
</tr>
<tr>
<td>IP</td>
<td>IP address of the phone</td>
</tr>
<tr>
<td>MAC</td>
<td>MAC address of the phone</td>
</tr>
</tbody>
</table>
### Table 101: Columns in the Status > IP Phones List Pane (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Usage**   | The current usage state for the phone. Possible values are:  
  - Idle—The phone is not off-hook or in use.  
  - In Service—The phone is ready for service.  
  - In Use—The phone has an active call.  
  - Off-Hook—The phone is off-hook.  
  - Unknown—The usage state is unknown, perhaps because communication between the server and the switch has been lost. |
| **Service** | The current service status for the phone. Possible values are:  
  - In Service—The phone is registered with the system and functioning properly.  
  - Out Of Service (Operational)—The phone is not registered with the system and is in an “out of service” state. |
Firmware Status 

- **Up to Date** indicates that the phone’s current firmware version is greater than or equal to the minimum firmware version required for the phone.
- **Update Available** indicates that the phone is running an acceptable firmware version, but a more recent firmware version is available for download. In other words, the phone is running a firmware version above or equal to the minimum version, but less than the recommended version.
- **Firmware Version Mismatch** indicates that the phone’s current firmware version is less than the minimum firmware version required for the phone.
- **PBX Mismatch** indicates that the current PBX version is not compatible with the phone’s current firmware version.
- **Download Pending** indicates that all download resources are busy and the phone is waiting for a resource to become available before initiating the download.
- **Download In Progress** indicates that a firmware download is currently in progress on the phone.
- **Download Ready** indicates that a firmware download on the phone was successful.
- **Download Failed** indicates that a firmware download on the phone failed.
- **Update In Progress** indicates that an update is in progress.
- **Reboot Failed** indicates that the reboot of the phone was not successful.
- **Unknown** indicates that the phone firmware status cannot be determined. This could be because the phone cannot be reached over the network or the switch the phone is assigned to is disconnected from the server.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>The firmware version that the phone is currently running</td>
</tr>
<tr>
<td>Alt Version</td>
<td>The firmware version that has been successfully staged to the alternate partition (applies only to ShoreTel 400-Series IP phones)</td>
</tr>
</tbody>
</table>
**Status > IP Phones Details Pane**

**Calls Tab**

The Calls tab provides a detailed view of call information for the selected IP phone. The phone extension and user name are displayed in either the Source or Destination endpoint column. For details about the fields on the Calls tab, see Monitoring Call Quality on page 726.

**Monitoring Trunk Group Status**

The Status > Trunk Groups page lets you view a list of all trunk groups configured in the system, along with status information, performance information, and call details for each. The page includes a list pane at the top and a details pane at the bottom.

**Status > Trunk Groups List Pane**

The list pane displays a list of all trunk groups configured in the system and lets you view current status information for any trunk group listed. Table 102 shows the columns in the list pane on the Trunk Groups page.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status indicator</td>
<td>Indicates the status of the trunk group based on the percentage of In Service trunks divided by the ports within the trunk group:</td>
</tr>
<tr>
<td></td>
<td>- Green indicates that the ratio of In Service trunks to Configured trunks is greater than 50 percent.</td>
</tr>
<tr>
<td></td>
<td>- Yellow indicates that the ratio of In Service trunks to Configured trunks is between 20 and 50 percent.</td>
</tr>
<tr>
<td></td>
<td>- Red indicates that the ratio of In Service trunks to Configured trunks is 20 percent or less.</td>
</tr>
<tr>
<td></td>
<td>- Blank indicates that no trunks are configured for this trunk group.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the trunk group</td>
</tr>
<tr>
<td>Type</td>
<td>The type of trunk group</td>
</tr>
<tr>
<td>Site</td>
<td>The name of the site in which the trunk group is configured</td>
</tr>
<tr>
<td>Trunks In Use</td>
<td>The first number represents the number of trunks/ports that are currently in use, and the second number represents the total number of configured trunks.</td>
</tr>
<tr>
<td>Trunks In Service</td>
<td>The first number represents the number of trunks/ports that are in service, and the second number represents the total number of configured trunks.</td>
</tr>
</tbody>
</table>
**Status > Trunk Groups Details Pane**

The details pane provides more status information about the selected trunk group. The details pane includes Status, Performance, and Calls tabs that provide real time status details for the trunks/ports in the trunk group, trending information, and recent calls for the trunk group.

**Status Tab**

The Status tab displays detailed information about the trunk group selected in the list pane. The fields displayed on the Status tab are described in Table 103.

**Table 103: Columns on the Status > Trunk Groups Details Pane (Status Tab)**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>command check box</td>
<td>Allows selection of one or more trunks to which to apply maintenance commands (Reset, Put in service, Put out of service, Put out of service when idle), as specified in the Command field at the top of the pane</td>
</tr>
<tr>
<td>status indicator</td>
<td>The service status for the trunk/port:</td>
</tr>
<tr>
<td></td>
<td>- Green indicates that the trunk/port is in service.</td>
</tr>
<tr>
<td></td>
<td>- Red indicates that the trunk/port is out of service.</td>
</tr>
<tr>
<td>Name</td>
<td>The configured name for the port</td>
</tr>
<tr>
<td>Type</td>
<td>The trunk group type</td>
</tr>
<tr>
<td>Site</td>
<td>The name of the site where the trunk group is configured</td>
</tr>
<tr>
<td>Switch</td>
<td>The name of the switch on which the port is configured</td>
</tr>
<tr>
<td>Port/Channel</td>
<td>The port number on the switch for the trunk group</td>
</tr>
<tr>
<td>Usage</td>
<td>The current usage state of the trunks. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>- Idle</td>
</tr>
<tr>
<td></td>
<td>- Normal</td>
</tr>
<tr>
<td>Service</td>
<td>The current service state of the trunk group. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>- In Service</td>
</tr>
<tr>
<td></td>
<td>- Out of Service</td>
</tr>
<tr>
<td></td>
<td>- Unknown</td>
</tr>
</tbody>
</table>

**Performance Tab**

The Performance tab includes the following charts:

- The Trunks Occupancy chart shows how many trunks out of the total configured trunks were used on average (and at the peak) for each point within the selected time interval. The information this chart provides can be helpful in planning for trunk allocation.
The Call Volume chart shows call volume, including the number of good calls, the number of bad calls, and the intersite calls for the selected trunk group.

Calls Tab

The Calls tab on the Trunk Group details pane lists the 10 most recent calls, by default, for the selected trunk group. For all calls, the selected trunk group appears in either the Source or Destination User/TG column.

For details about the fields on the Calls tab, see Monitoring Call Quality on page 726.

Monitoring Voice Mail Status

The Status > Voice Mail page provides status and call history information for voice mail servers and voice mailboxes configured in the ShoreTel system.

List Pane

The list pane displays a list of all voicemail servers configured in the system and lets you view current status information for any voice mail server listed. Table 104 shows the columns in the list pane on the Voice Mail page.

<table>
<thead>
<tr>
<th>Table 104: Columns in the Status &gt; Voice Mail List Pane</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column Name</strong></td>
</tr>
<tr>
<td>status indicator</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Voice Mail Server</td>
</tr>
<tr>
<td>IP Address</td>
</tr>
<tr>
<td>Site</td>
</tr>
<tr>
<td>Mailboxes</td>
</tr>
<tr>
<td>Messages</td>
</tr>
<tr>
<td>Space Used (MB)</td>
</tr>
<tr>
<td>Free Space (MB)</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Last Successful Backup</td>
</tr>
</tbody>
</table>
Status > Voice Mail Details Pane

The details pane provides more status information about the selected voice mail server. The details pane includes Performance and Calls tabs that provide real time status details for the voice mail server.

Performance Tab

The Performance tab provides details for the selected voice mail server, including mailboxes and disk usage.

The Mailboxes Summary area shows the number of mailboxes and the number of messages on the selected server.

The Disk Summary area shows the free space and the total space as well as the space used for the following components:

- users
- recorded names
- auto-attendant prompts
- music-on-hold files
- logs and other data

The Details section on the Performance tab provides information about all the mailboxes assigned on the selected voice mail server. The fields are described in Table 105.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status indicator</td>
<td>Shows the status of the voice mailbox:</td>
</tr>
<tr>
<td></td>
<td>■ Blank indicates that voice mailbox is within acceptable limits.</td>
</tr>
<tr>
<td></td>
<td>■ Red indicates that the voice mailbox is full.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the voice mailbox owner.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the voice mailbox owner</td>
</tr>
<tr>
<td>Mailbox</td>
<td>The extension of the mailbox</td>
</tr>
<tr>
<td>User Group</td>
<td>The user group to which the mailbox owner is assigned</td>
</tr>
<tr>
<td>Number of Messages</td>
<td>The number of messages in the mailbox</td>
</tr>
<tr>
<td>Total</td>
<td>The number of messages that are marked as unheard</td>
</tr>
<tr>
<td>Unheard</td>
<td>The number of messages that have been deleted</td>
</tr>
<tr>
<td>Allowed</td>
<td>The capacity of the mailbox</td>
</tr>
<tr>
<td>Saved/Unheard (Days)</td>
<td>The age, in days, of the oldest message that is marked unheard.</td>
</tr>
</tbody>
</table>

Table 105: Columns in the Status > Voice Mail Servers Details Pane (Performance Tab)
The Calls tab displays a list of voicemail calls associated with the selected voice mail server. For details about the columns on the Calls tab, see Table 110 on page 727.

### Monitoring Make Me Conferencing Status

The Status > Make Me Conferencing page provides a list of switches focused only on the conferencing-related statistics. The details pane on this page provides a list of conference calls placed on the selected switch.

#### Status > Make Me Conferencing List Pane

The Make Me Conferencing list pane includes the columns shown in Table 106.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch</td>
<td>The name of the switch</td>
</tr>
<tr>
<td>Site</td>
<td>The site where the switch resides</td>
</tr>
<tr>
<td>Type</td>
<td>The type of the switch</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the switch</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>In Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Calls</td>
</tr>
<tr>
<td>Ports</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Free</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ports</td>
</tr>
<tr>
<td>Percent</td>
</tr>
</tbody>
</table>
Status > Make Me Conferencing Details Pane

The Make Me Conferencing details pane includes a Calls tab.

Calls Tab

The Calls tab displays a list of conference calls associated with the selected switch. For details about the columns on the Calls tab, see Table 110 on page 727.

Monitoring Audio/Web Conferencing Status

The Status > Audio/Web Conferencing page provides a list of ShoreTel service appliances and related statistics.

Status > Audio/Web Conferencing List Pane

The Details pane includes a Calls tab that provides a list of audio and web conferences placed on the selected service appliance. For details about the columns on the Calls tab, see Table 110 on page 727.

Table 107: Columns in the Audio/Web Conference List Pane

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>status indicator</td>
<td>Shows the status of the service appliance:</td>
</tr>
<tr>
<td></td>
<td>- Green indicates that the service appliance is in service and connected.</td>
</tr>
<tr>
<td></td>
<td>- Yellow indicates a problem (a warning state) in the service appliance's status.</td>
</tr>
<tr>
<td></td>
<td>- Red indicates that the service appliance is down or experiencing a severe service impact.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the service appliance</td>
</tr>
<tr>
<td>Site</td>
<td>The name of the site where the service appliance resides</td>
</tr>
<tr>
<td>Audio Ports</td>
<td></td>
</tr>
<tr>
<td>Peak</td>
<td>The peak number of audio ports used during the last 24 hours</td>
</tr>
<tr>
<td>Current</td>
<td>The number of audio ports currently in use</td>
</tr>
<tr>
<td>Web Ports</td>
<td></td>
</tr>
<tr>
<td>Peak</td>
<td>The peak number of web ports used during the last 24 hours</td>
</tr>
<tr>
<td>Current</td>
<td>The number of web ports currently in use</td>
</tr>
<tr>
<td>Disk Used (GB)</td>
<td></td>
</tr>
<tr>
<td>Used</td>
<td>Total disk space currently in use</td>
</tr>
<tr>
<td>Capacity</td>
<td>Total disk space available on the service appliance</td>
</tr>
<tr>
<td>Conferences</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>The number of registered conferences</td>
</tr>
</tbody>
</table>
The Audio/Web Conferencing details pane includes a Calls tab.

**Calls Tab**

The Details pane includes a Calls tab that provides a list of audio and web conferences placed on the selected service appliance. For details about the columns on the Calls tab, see Table 110 on page 727.

### Monitoring IM Status

The Status > IM page provides a list of service appliances that support an IM service instance and some related statistics for that instance.

### Status > IM List Pane

The IM list pane includes the columns described in Table 108.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the service appliance that is providing IM services</td>
</tr>
<tr>
<td>Site</td>
<td>The site where the service appliance is installed</td>
</tr>
</tbody>
</table>

### Table 108: Columns in the Status > IM Page’s List Pane

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>check box</td>
<td>Allows selection of one or more service appliances for stopping and starting the appliance</td>
</tr>
<tr>
<td>status indicator</td>
<td>Shows the status of the service appliance:</td>
</tr>
<tr>
<td></td>
<td>■ Green indicates that the service appliance is in service and connected.</td>
</tr>
<tr>
<td></td>
<td>■ Yellow indicates a problem (a warning state) in the service appliance that does not affect the service appliance’s status.</td>
</tr>
<tr>
<td></td>
<td>■ Red indicates that the service appliance is down or experiencing a severe service impact.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the service appliance that is providing IM services</td>
</tr>
<tr>
<td>Site</td>
<td>The site where the service appliance is installed</td>
</tr>
</tbody>
</table>

**Table 107: Columns in the Audio/Web Conference List Pane (Continued)**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The number of conferences currently in progress</td>
</tr>
<tr>
<td>Requests per Hour</td>
<td>The number of conference requests made per hour</td>
</tr>
<tr>
<td>Last Successful Backup</td>
<td>The timestamp of the last backup of the service appliance database</td>
</tr>
</tbody>
</table>
Monitoring Connect Sync Status

The Status > Connect Sync page provides information about the status of the Connect Sync service. For information about ShoreTel Connect, visit the ShoreTel knowledge Base.

Monitoring Alerts

Alerts provide a mechanism for notifying you of possible issues within the ShoreTel system. The alerts can identify issues at a variety of levels, such as in the overall system, within a site, or in an individual component such as a switch.

The Alerts tool in the Diagnostics & Monitoring system includes the following types of alerts:

- Event Correlation Alerts
  
  Many ShoreTel system components use the Windows Event Log to report status updates, inconsistencies, misbehavior, and critical system issues. The Monitoring Service captures all events logged by these components and attempts to find any correlations involving system issues. The Monitoring Service raises the appropriate alert and attaches all associated events.

- Composite Alerts

  The Monitoring Service identifies when several common issues occur within a physical or logical range. For example, if alerts are raised for a number of problematic switches within the same site, it would create an alert for that site that references the individual alerts as the cause.

- Threshold Alerts

  The Monitoring Service analyzes metrics from call quality reports as well as periodic status reports for the system and its components and compares these metrics to thresholds that indicate when an alert is necessary. The Monitoring Service continues to monitor when these metrics fall below the threshold limits and determines when the alerts can be safely cleared.
Clearing Alerts

You can clear an alert, which marks the alert as cleared. Cleared alerts are not deleted; they remain in the system so that they are available for investigative purposes and to provide historical perspective for troubleshooting and other analysis.

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
3. In the navigation menu, click Alerts.

The Alerts page is displayed.

---

**Note**

Because a small set of events for Distributed Voice Servers are not captured in the Diagnostics & Monitoring system, some alerts are missing or get stuck. Status pages correctly reflect the current state of a local or remote server.

---

**Table 109: Columns on the Alerts Page**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check box</td>
<td>Used with the Command drop-down list box to designate which alert records should be cleared</td>
</tr>
<tr>
<td>Severity</td>
<td>The severity level of the alert:</td>
</tr>
<tr>
<td></td>
<td>■ Blank—Information</td>
</tr>
<tr>
<td></td>
<td>■⚠️—Warning</td>
</tr>
<tr>
<td></td>
<td>■🔺—Critical</td>
</tr>
<tr>
<td>Time Created</td>
<td>The time that the alert was generated</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date and time when the alert was created or cleared</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the alert. See the ShoreTel Maintenance Guide for more information.</td>
</tr>
<tr>
<td>Site</td>
<td>If the alert involves a switch, the name of the site where the switch resides</td>
</tr>
<tr>
<td>Switch</td>
<td>If the alert involves a switch, the name of the switch</td>
</tr>
<tr>
<td>Trunk Group</td>
<td>If the alert involves a trunk group, the name of the trunk group</td>
</tr>
<tr>
<td>State</td>
<td>The state of the alert. Possible values are Active or Cleared.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the alert</td>
</tr>
</tbody>
</table>
4. In the Command drop-down list, select Clear.

5. In the list pane at the top, select the check box for the alert you want to clear.

6. Click Apply.

7. In the confirmation dialog, click OK.

**Monitoring Call Quality**

The Call Quality page enables easy troubleshooting of problems related to call and network quality by providing access to records of every media stream that occurs in the ShoreTel system. The call quality metrics are derived from monitoring IP network impairments such as packet loss and delay.

### Aspects of Call Quality

Call Quality is evaluated based on thresholds for packet loss, delay/latency, and jitter.

#### Packet Loss

Packet loss refers to the percentage of media packets lost over the duration of a media session. The Diagnostics & Monitoring solution tracks the following metrics related to packet loss:

- average packet loss, which is the ratio of lost packets to total packets over the entire call
- maximum packet loss, which is the highest ratio of lost packets measured in any 10-second interval

Calculation of packet loss is performed per RFC 3550 using RTP header sequence numbers.

The causes of packet loss include queue drops, corrupted packets dropped in transit, and jitter buffer drops due to late arrival.

#### Delay/Latency

Delay or latency refers to the amount of time it takes for speech to exit the speaker’s mouth and reach the listener’s ear. Latency sounds like an echo or a two-way radio.

The causes of delay or latency include network congestion, route flapping, extremely long routes between endpoints, and satellite hops.

#### Jitter

Jitter, also known as Per Packet Delay Variation (PPDV), is the measure of the variability over time of the latency across a network. VoIP endpoints require media packets to be received in a steady stream at a consistent rate, or audio quality quickly degrades, which users hear as clicks or pops.

Applications that run on standard operating systems could inject jitter from the sending or receiving side due to process scheduling delays (timing drift). Network congestion can also cause jitter.
To address problems with jitter, use a dynamic jitter buffer and configure Quality of Service settings to reduce the impact of network congestion.

**Call Quality Page**

The Call Quality page has two panes:

- The List pane at the top provides a list of call streams (the media stream from the source to the destination endpoint).
- The Details pane at the bottom has multiple tabs that show metrics and configuration data for both media streams involved in the call, along with both path traces.

**Note**
The Details pane does not show all media streams involved in conference calls that include multiple parties.

**Note**
The Call Quality page does not automatically refresh, but you can manually refresh the page by clicking the refresh button on your browser.

**Call Quality List Pane**

The Call Quality list pane includes the columns described in Table 110.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Quality Indicator</td>
<td>A green, yellow, or red bubble that represents the voice quality for the media stream. This rating includes MOS and jitter.</td>
</tr>
<tr>
<td>Call ID</td>
<td>A unique identifier for the call that is assigned by the ShoreTel system</td>
</tr>
<tr>
<td>Start Time</td>
<td>The time that the media stream originated</td>
</tr>
<tr>
<td>End Time</td>
<td>The time that the media stream ended</td>
</tr>
<tr>
<td>Dest Site</td>
<td>The name of the destination site</td>
</tr>
<tr>
<td>Switch</td>
<td>For a phone, the name of the switch at the destination site with which the phone is registered. For a trunk, the name of the switch at the source site on which the trunk is configured</td>
</tr>
<tr>
<td>Ext/Port</td>
<td>The extension number at the source site associated with the endpoint involved in the call</td>
</tr>
<tr>
<td>User/TG</td>
<td>The name of the user or trunk group at the source site that is involved in the call.</td>
</tr>
<tr>
<td>Source Site</td>
<td>The name of the destination site with which the endpoint is associated</td>
</tr>
</tbody>
</table>
The Call Quality details pane includes the Details tab and the IP Path Trace tab. The information provided is from the perspective of the receiver of each stream in the two-way path.

### Details Tab

The information on the Details tab is displayed in separate columns for Endpoint A and Endpoint B. The rows in the table provide the collected values for the configuration and metric information from the individual media stream record. The values displayed are described in Table 111.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User/TG</td>
<td>The name of the user or trunk group</td>
</tr>
<tr>
<td>Ext/Port</td>
<td>The system extension or port for the endpoint, if known</td>
</tr>
<tr>
<td>Site</td>
<td>The name of the site at which the endpoint is configured</td>
</tr>
<tr>
<td>Switch</td>
<td>The name of the switch with which this endpoint is registered,</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the phone or switch</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The MAC address of the phone</td>
</tr>
<tr>
<td>Start Time</td>
<td>The start time for the stream</td>
</tr>
<tr>
<td>End Time</td>
<td>The end time for the stream</td>
</tr>
</tbody>
</table>
| Codec      | The audio codec and sample rate used in the stream  
If more than one codec is used for a call, only the last codec used for the call is displayed. |

---

**Note**

For calls longer than 60 minutes, statistics are collected for only the most recent 60 minutes of the call.
Viewing High-Level Call Quality

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Call Quality**.

   The Call Quality page launches, displaying the following information:
   - The 10 most recent stream records, sorted by End Time
   - On the Details tab, details for the most recent media stream

### Viewing Call Quality Details for a Particular Call

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Call Quality**.
4. To select a particular media stream, click on a row in the list pane at the top of the page.
5. Choose one of the following:
   - To see metrics for the selected media stream, review the details on the Details tab.
   - To see the IP path for the selected media stream, click the IP Path Trace tab.

   The path from A to B and B to A is displayed.
Finding All Recent Calls for a Site

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Call Quality**.  
   The Call Quality page launches.
4. Click  on the bottom left corner of the Call Quality list pane.
   Text boxes are added under each column heading in the Call Quality list pane.
5. Click in the text box under the Source Site column heading, and type the site name for which you want to find all recent calls.
6. Click  to apply the filter.
   The list is filtered to include only streams where the source site matches the site name that you entered in the text box.

Finding Calls for a Particular User and Time Range

1. Launch ShoreTel Director.
2. Click **Maintenance > Diagnostics & Monitoring**.
3. In the navigation menu, click **Call Quality**.  
   The Call Quality page launches.
4. Click  on the bottom left corner of the Call Quality list pane.
   Text boxes are added under each column heading in the Call Quality list pane so that you can enter a filter.
5. Click in the text box under the User/TG column heading in the Source area, and type the user name for which you want to find all recent calls.
6. Click in the text box under the Start Time column heading, and choose a date from the calendar and a time (hour and minute), and click done.
7. Click  to apply the filter.
   The list is filtered to include only streams where the source endpoint user matches the entered user and that started during the specified time range.
Sorting Calls Using the Call Quality Indicator

1. Launch ShoreTel Director.

2. Click Maintenance > Diagnostics & Monitoring.

3. In the navigation menu, click Call Quality.
   The Call Quality page launches.

4. Click in the column heading for the call quality status indicator.
   The list is sorted from worst call quality to best call quality.

Diagnosing Switch or Phone Problems through Remote Packet Capture

Through the Remote Packet Capture tool in the Diagnostics & Monitoring system, the ShoreTel system provides the capability to capture network protocol information for certain switches and phones. The packet trace information is captured in .pcap format, which can be viewed with Wireshark or another network protocol analysis tool. Typically, you would need to capture network protocol information only when ShoreTel Technical Support directs you to do so for problem diagnosis.

The following limitations apply for remote packet capture operations:

- Only the switches and phones on which remote packet capture is supported are listed on the Remote Packet Capture page.

- A switch or phone can be part of only one capture session at a time.

- You can capture packet information for up to 25 devices simultaneously. If you select more than 25 devices when you initiate a capture operation, the system notifies you that some capture operations will not begin immediately. If you proceed, some of the capture operations are put into a pending state.

- The maximum size of a capture file is 70 MB. When the maximum file size is reached, the capture session stops.

- The total maximum disk usage allowed for capture files is 4 GB. If this limit is reached, the system notifies you to delete capture files to clear space before you can initiate more capture sessions.

- A capture session can run for a maximum of 120 minutes. The capture operation stops running when it reaches this limit.
Remote Packet Capture List Pane

The Remote Packet Capture list pane provides a list of phones and switches for which you can run a remote packet capture. Table 112 describes the information displayed in the Remote Packet Capture list pane.

Table 112: Columns on Remote Packet Capture List Pane

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>check box</td>
<td>Allows selection of one or more phones or switches for application of maintenance commands</td>
</tr>
<tr>
<td>Device Type</td>
<td>The type of device (phones or switches).</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the switch or phone</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The MAC address of the switch or phone</td>
</tr>
<tr>
<td>Device Name</td>
<td>The name of the device or the MAC address of the phone</td>
</tr>
<tr>
<td>Submitted By User</td>
<td>The name of the user who submitted the packet capture command</td>
</tr>
<tr>
<td>Last Logged Start Date</td>
<td>The starting date and time of the most recent capture process for this component</td>
</tr>
</tbody>
</table>
The protocols selected when the packet capture process was initiated.

The following protocols are included for switches:
- BWMGR*—Bandwidth Manager Protocol
- DRS*—Distributed Routing Service
- LSP*—Location Service Protocol
- NCC*—Network Call Control
- SIP plus TLS—Session Initiation Protocol with Transport Layer Security
- SHORESIP*—ShoreTel's version of Session Initiation Protocol
- MGCP—Media Gateway Control Protocol

The following protocols are included for phones:
- CAS*—Client Application Server
- Secure CAS*—Secure Client Application Server
- SM*—Session Manager
- Secure SM*—Session Manager
- SIP plus TLS—Session Initiation Protocol with Transport Layer Security
- ARP—Address Resolution Protocol
- RARP—Reverse Address Resolution Protocol
- DNS—Domain Name Server
- ICMP—Internet Control Message Protocol

When you run a capture against switches and phones, the protocols are limited to the protocols common to both types of devices.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocols</td>
<td>The protocols selected when the packet capture process was initiated. The following protocols are included for switches: - BWMGR*—Bandwidth Manager Protocol - DRS*—Distributed Routing Service - LSP*—Location Service Protocol - NCC*—Network Call Control - SIP plus TLS—Session Initiation Protocol with Transport Layer Security - SHORESIP*—ShoreTel's version of Session Initiation Protocol - MGCP—Media Gateway Control Protocol</td>
</tr>
<tr>
<td>Bytes Written</td>
<td>The number of bytes captured</td>
</tr>
</tbody>
</table>

*ShoreTel proprietary protocol
Starting Remote Packet Capture

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

3. In the navigation menu, click **Diagnostics > Remote Packet Capture**.
   
The Remote Packet Capture page launches, showing the list of eligible switches and phones in the top pane.

4. Optionally, to filter the list of phones and switches, do the following:
   
a. Click ![search]
   
The filter list boxes are displayed under column headings.

b. Enter text in one or more filter text boxes for the columns you want to use as a filter.

c. Click ![go]
   
A subset of the list matching your filter is displayed.

5. To designate the phones and/or switches for which you want to capture packets, select the check box for one or more phones or switches.
   
A dialog box that lets you choose settings for the log capture is displayed.
Enter the number of minutes in the **Capture Duration** field.

7. If you want to capture only SIP + TLS and SHORESIP protocols on one or more switches for an indefinite period of time, select the **Ignore the duration for the SIP and SHORESIP protocols for switches** check box. In this case, the value entered in the Capture Duration field is ignored and the capture runs until one of the following events occurs:

- You stop the capture
- The Headquarters server is rebooted
- The switch is rebooted

8. Do one of the following:

- To capture log information for all protocols listed, select the **Capture every protocol** check box.
- To select specific protocols, clear the **Capture every protocol** check box and select the check boxes for the protocols you want to capture.

9. To submit the packet capture request, click **Save**.

A message notifying you that the capture request was submitted successfully is displayed.

10. Click **OK**.

The packet capture begins.

---

**Stopping Remote Packet Capture**

1. Launch ShoreTel Director.

2. Click **Maintenance > Diagnostics & Monitoring**.

3. In the navigation menu, click **Diagnostics > Remote Packet Capture**.

   The Remote Packet Capture page launches. The list pane at the top lists switches and IP phones.

4. Optionally, to filter the list of phones and switches, do the following:

   a. Click ![search_icon](image)

      The filter text boxes are displayed under the column headings in the list pane.

   b. Enter text in one or more filter text boxes for the columns you want to use as a filter.

---

**Note**

If you select both switches and phones, the list of protocols that you can specify is limited to protocols common to switches and phones.
c. Click ➡. A subset of the list matching your filter is displayed.

5. To designate the phones or switches for which you want to stop capturing packets, select the check box for one or more switches or phones in the list. A confirmation dialog box is displayed.

6. Click OK.

Viewing Remote Packet Capture Log Files

You can view a list of remote packet capture log files (.pcap files) in the Previous Log Files pane at the bottom of the Remote Packet Capture page. The columns in the Previous Log Files pane are described in Table 113.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>The type of device (phone or switch)</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the device</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The MAC address of the device</td>
</tr>
<tr>
<td>Device Name</td>
<td>The name of the device</td>
</tr>
<tr>
<td>Submitted By User</td>
<td>The name of the user who submitted the capture request</td>
</tr>
<tr>
<td>Last Logged Start Date</td>
<td>The date and time that the capture process started</td>
</tr>
<tr>
<td>Protocols</td>
<td>The names of the protocols selected for the capture process</td>
</tr>
<tr>
<td>Bytes Written</td>
<td>The number of bytes in the capture log</td>
</tr>
<tr>
<td>File</td>
<td>The name of the log file generated in the capture session</td>
</tr>
</tbody>
</table>

To open a capture file:

1. Launch ShoreTel Director.
2. Click Maintenance > Diagnostics & Monitoring.
3. In the navigation menu, click Diagnostics > Remote Packet Capture.

The Remote Packet Capture page launches, showing the list of available capture files in the bottom pane.
4. In the All Previous Log Files pane, locate the capture session whose log file you want to view.

5. Open a log file using one of the following methods:
   - In the File column, click the log file you want to open.
   - In the File column, right-click the log file you want to open and select **Open** or another option from the pop-up menu.

   **Note**
   This step assumes that you have a network protocol analysis tool (such as Wireshark) installed that allows you to open .pcap files.

6. Review the capture log file.

7. Save the file in a new destination if desired.
CHAPTER 21

System Backup and Restore

This chapter describes the procedures for backing up and restoring system files. The tools for performing these tasks are scripts and, optionally, batch files. The topics discussed in this chapter include:

- Overview ................................................................. 741
- Introduction to Backup and Restore .................................................. 741
  - Estimated Backup and Restore Times ................................................. 742
  - Backup Strategy ............................................................................. 743
  - Restoration .................................................................................... 743
- Configuring the Backup and Restore Scripts ...................................... 744
- Preliminary Task for Remote Devices .............................................. 746
- Backing Up the Headquarters Server ............................................... 747
  - Backing Up All of the Files ................................................................. 748
  - Backing Up Selected Files ................................................................. 748
- Backing Up Distributed Voice Servers .............................................. 749
  - Performing a Complete Backup of a DVS ......................................... 749
  - Performing a Selective Backup of a DVS ........................................... 750
- Backing Up Voice Mail Switches ....................................................... 750
  - Requirements ................................................................................ 750
- Backing Up All Service Appliances .................................................. 751
- Restoring the Headquarters Server ................................................... 752
  - Performing a Complete Restore ....................................................... 752
  - Performing a Selective Restore ....................................................... 752
- Restoring Distributed Voice Servers .................................................. 753
  - Performing a Complete Restore of a DVS ........................................ 753
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performing a Selective Restore of a DVS</td>
<td>754</td>
</tr>
<tr>
<td>Restoring a Service Appliance</td>
<td>754</td>
</tr>
<tr>
<td>Operational Behavior for Manual Restore</td>
<td>754</td>
</tr>
<tr>
<td>Performing the Manual Restore</td>
<td>755</td>
</tr>
<tr>
<td>Using Batch Files</td>
<td>757</td>
</tr>
<tr>
<td>Log Files</td>
<td>758</td>
</tr>
<tr>
<td>Failover Support</td>
<td>758</td>
</tr>
<tr>
<td>Configuring a Secondary IP Address</td>
<td>758</td>
</tr>
<tr>
<td>Conditions during the Failover and Failback Operations</td>
<td>760</td>
</tr>
<tr>
<td>System Failover Conditions and Requirements</td>
<td>760</td>
</tr>
<tr>
<td>System Failback Conditions and Requirements</td>
<td>761</td>
</tr>
<tr>
<td>Failover and Restoration of IP Phones</td>
<td>761</td>
</tr>
<tr>
<td>Re-assigning the Primary Switch Profile to a Replacement Switch</td>
<td>762</td>
</tr>
<tr>
<td>Moving IP Phones to Primary Switch</td>
<td>762</td>
</tr>
<tr>
<td>Failing Back the Spare Switch</td>
<td>764</td>
</tr>
<tr>
<td>Verifying Spare Switch Return Status</td>
<td>765</td>
</tr>
</tbody>
</table>
Overview

A system administrator can use the default scripts that we provide or use the default scripts to create new scripts. Also, the system administrator can back up and restore all files or selected files.

When following the descriptions in this chapters, readers need to understand that two types of interfaces can apply to the topics of back up and restore. The choice of interface depends on the task that the system administrator is doing:

- To search for and modify scripts or other components, the system administrator uses Windows Explorer and, when necessary, a text editor for modifying a script.
- To initiate a backup or restore, the administrator uses the server’s command prompt.
- To cache an RSA key for each ShoreTel Voice Switch and ShoreTel Service Appliance, the administrator uses the server’s command prompt.

Introduction to Backup and Restore

We recommend that customers regularly back up the files on the Headquarters server, Distributed Voice servers (DVS), ShoreTel Voicemail Switches, and ShoreTel Service Appliances. Customers can use the backed-up files to restore existing devices or add the files to hardware that replaces other hardware (such as defective components). We provide scripts to back up or restore these ShoreTel devices. Customers can modify these scripts.

The system copies the script file to a directory on the ShoreTel Headquarters and DVS servers when the system administrator installs the server software.

By design, the backup and restore scripts support a server. Therefore, by default, the script backs up and restores only the server on which the script exists. However, with the correct configuration, the script can also back up and restore any voicemail switch or service appliance in the network. Furthermore, the system can use a batch file to initiate system-wide backup or restore. A ShoreTel installation includes default batch files in the folder that contains the backup and restore scripts. System administrators can use programs such as Microsoft Scheduler to configure automatic backups.

Table 114 shows the files that the system can back up.
Estimated Backup and Restore Times

The duration of a backup or restore operation depends on many factors. For example, the amount of information to back up or restore, the configuration, and the environment affect the duration. This section provides approximate durations for backing up or restoring different parts in the ShoreTel system.

The following two system loads illustrate approximate times for a ShoreTel backup:

- **Clean System**—no voicemail or Call Data Records (CDRs) and no service appliance
  - Total – 379 secs
  - VM – 2 secs
  - CDR – 35 secs

- **Loaded System** (VM: 100 messages/13.5 MB; CDR: 500,000 calls)
  - Total – 508 secs
  - Backup VM – 21 secs
  - Backup CDR – 104 secs

The following is an estimate of the time to restore ShoreTel Server files:

- **Clean System**
Backup Strategy

Before a server backup begins, server activity must be stopped prior to prevent file corruption. We provide the procedures for stopping server activity before a backup and restarting the server after the backup is complete. We recommend system backup during scheduled down times or periods of low activity.

When backing up an entire system, we recommend starting with the DVSs (if present) and backing up the Headquarters server last. You can back up multiple DVSs simultaneously. After DVS backup is complete, the system administrator can back up the files on the Headquarters server. This sequence allows the Headquarters server to operate while other servers are unavailable.

Restoration

The ShoreTel restore scripts perform all necessary tasks to restore the Headquarters server, DVSs, voicemail switches, and service appliances. The scripts can do either a complete restore or a selective restoration of specific files.

Operations and files saved on a server after the backup was created are lost when the files are restored to the server. When restoring a Headquarters server, all files on distributed servers that do not require restoring remain intact; however, voicemail received for mailboxes created since the backup was created may be lost regardless of the server upon which they reside.

During file restoration, the server must have no activity. The ShoreTel restore scripts stop the server before restoring the files and restarts the server after the restoration is complete. Restored files must come from the same folder where the backup operation stored them.

For restoring an entire system, ShoreTel recommends first restoring the headquarters server. Doing so establishes a functioning system. After the headquarters server restore, restore distributed servers while the headquarters server is active. This sequence minimizes the down time of the headquarters server.

Note

While running Anti-virus scan, if you perform a backup on Configuration (shoreware) or CDR (shorewarecdr) database, the backup process fails.
Files can only be restored to the server from which they were backed up. Backup files from the headquarters server can restore only the headquarters server. For systems with more than one distributed server, backup files are not interchangeable between the servers.

Configuring the Backup and Restore Scripts

Before using a script for backup or restore, modify the scripts to have the information in the list that follows (task descriptions follow this list):

- In the script, type the path to the folder that is the destination of the backup. For a restore operation, this same path points to the folder as a source.
- IP addresses of voicemail switches to back up or restore.
- IP addresses of the service appliances to back up or restore.
- Letter of the disk drive where the script file resides (if different from the C drive).
- Type path to the script file on the Headquarters server or DVS—if the path is different from the default path that we provide.
- Type the path on the server where the PLINK and PSCP functions reside—if the path is different from the default).

Note

The default folder path for 32-bit and 64-bit operating systems differs as follows:

- For a 64-bit OS, the path begins \Program files (x86)\...
- For a 32-bit OS, the path begins \Program files\...

Configuring the Headquarters Server or DVS to Back Up Files

1. Using Windows Explorer on the ShoreTel server (Headquarters or DVS) that performs backups, navigate to the appropriate directory:

   - For a 64-bit OS on a Headquarters server:
     C:\Program Files (x86)\Shoreline Communications\ShoreWare Server\Scripts\Sample_Backup_Restore
   - For a 32-bit OS on a Headquarters server:
     C:\Program Files\Shoreline Communications\ShoreWare Server\Scripts\Sample_Backup_Restore
   - For a 64-bit OS on a DVS:
     C:\Program Files (x86)\Shoreline Communications\Shoreware Remote Server\Scripts\Sample_Backup_Restore
For a 32-bit OS on a DVS:

C:\Program Files\Shoreline Communications\Shoreware Remote Server\Scripts\Sample_Backup_Restore

2. Open the sw_backup_restore.ini file by using a text editor, such as Notepad.

3. Locate the Window.Install.Drive line in sw_backup_restore.ini.

4. On the line "Window.Install.Drive – “, type the letter of the drive that has the Windows operating system. The default drive is C:.

5. In the Back Options section, specify where to create the backup files:

   a. On the line "Backup.Drive – “, type the path for the volume to which the ShoreTel system backs up the files.

   b. On the line "ShoreWare.Drive – “, type the letter of the drive on which the ShoreTel system files go. The default value is C.

   c. On the line "Backup.Root.Directory – “, type the path that you want to use for backing the files up. The default path is:

      \ShorewareBackup\Backup

   d. On the line "Backup.Shoreware.Directory – “, type the name of the file to which the system backs up the files. The default name is: \Shoreline Data.

6. In the Shoreware File Location section, specify the location of the ShoreTel files on the current server. The Headquarters server and DVSS have different default paths.

   For a Headquarters server, on the line "ShoreWare.Scripts.Root.Directory – “, type the path to the server backup scripts. The default is one of the following:

   - On a 32-bit system:
     C:\ProgramFiles\ShorelineCommunications\ShoreWare Server\Scripts

   - On a 64-bit system:
     C:\ProgramFiles(x86)\ShorelineCommunications\ShoreWareServer\Scripts

   For a DVS, on the line "ShoreWare.Scripts.DVM.Root.Directory – “, type the path to the ShoreTel DVS server backup scripts. The default path is:

   - On a 32-bit system:
     C:\ProgramFiles\ShorelineCommunications\ShoreWareRemote Server\Scripts

   - On a 64-bit system:
     C:\ProgramFiles(x86)\ShorelineCommunications\ShoreWareRemote Server\Scripts

7. On the line "VMB.ip.list – “, type the IP addresses of the voicemail switches that this server backs up. Type a comma (,) between the addresses.
8. On the line "UCB.ip.list -", type the IP addresses of the service appliances that this server is backing up. Separate each address with a comma.

9. For the plink command: on the line “PLINK.CMD -", type the path to the plink command. The default path is (keep in mind the difference between the servers and the operating systems):

   ▪ On a 64-bit or 32-bit Headquarters server:
     C:\ProgramFiles(x86)|ProgramFiles\Shoreline Communications\ShoreWareServer\Scripts\Sample_Backup_Restore\plink

   ▪ On a 64-bit or 32-bit DVS:
     C:\ProgramFiles (x86)|ProgramFiles\Shoreline Communications\ShoreWareRemoteServer\Scripts\Sample_Backup_Restore\plink

10. For the pscp command: on the line: “PSCP.CMD -", type the path to the pscp command. The default path is (keep in mind the 64-bit and 32-bit OSs):

    ▪ On a 64-bit or 32-bit Headquarters server:
      C:\\Program Files(x86)|ProgramFiles\Shoreline Communications\ShoreWareServer\Scripts\Sample_Backup_Restore\pscp

    ▪ On a 64-bit or 32-bit DVS:
      C:\\Program Files(x86)|ProgramFiles\Shoreline Communications\ShoreWareRemoteServer\Scripts\Sample_Backup_Restore\pscp

11. Click File > Save to save changes.

---

**Preliminary Task for Remote Devices**

An RSA key must exist in a server registry cache for each ShoreTel Voice Switch or ShoreTel Service Appliance. The system uses this RSA key for backups and restores. This section describes the preliminary task of placing an RSA key in a cache on a server.

In the context of backup or restore, ShoreTel Voice Switches and ShoreTel Service Appliances are remote devices. These devices are remote from the standpoint of the Headquarters server or a DVS. On the Headquarters server or a DVS, the system administrator initiates the backup or restore operation for a voicemail switch or a service appliance.

To perform backup or restore, an SSH connection must exist between the server and the remote device. The PuTTY commands plink and pscp provide the access to remote devices. These commands use RSA keys for validation.

To place an RSA key in a server registry cache for a remote device:

1. Open a command prompt window on the server that initiates the backup and restore for the voicemail switch or service appliance.

2. Change directories to one of the following:
Backing Up the Headquarters Server

This section describes how to back up the headquarters server. Its subsections describe a complete backup of the server and a partial backup of the server.

Note
Server activity must stop before file backup to prevent file corruption. The processes from ShoreTel stop the server before the backup and restarts the server after the backup finishes. ShoreTel recommends backing up files during scheduled down times or periods of light activity.

- **On a 32-bit system:**
  C:\Program Files\ShorelineCommunications\ShoreWare Server\Scripts\Sample_Backup_Restore

- **On a 64-bit system:**
  C:\Program Files (x86)\Shoreline Communications\ShoreWare Server\Scripts\Sample_Backup_Restore

3. At the command prompt, type the following:

   > plink <IP address of voice switch or IP address of service appliance>

4. **Press Enter.** The system response includes the storage status of the RSA key in the registry on the server. Figure 230 illustrates the response if the key is not present. It states “The server's host key is not cached in the registry.”

![Figure 230: Caching the Registry Key by Using the plink Command](image)

5. If the key is not cached to the registry, press **y** at the prompt (“Store key in cache? (y/n)”).

6. Repeat Step 3 through Step 5 for each remote device for which this server is to initiate backup and restore operations.

7. Save and close the file.
Back Up All of the Files

Performing a complete backup of the Headquarters server:

1. Access the command prompt on the headquarters server.

2. Navigate to the directory where the ShoreTel backup and restore scripts reside. The default path is:
   - On a 32-bit system: C:\Program Files\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore
   - On a 64-bit system: C:\Program Files (x86)\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore

3. At the prompt, enter:
   
   cscript.exe shoreware_backup.wsf hq all

Back Up Selected Files

Using the Headquarters server to back up selected file types on specific components:

1. Open a command prompt on the Headquarters server.

2. Navigate to the directory where the ShoreTel backup and restore scripts reside. The default path is:
   - On a 32-bit system: C:\Program Files\ShorelineCommunications\Shoreware Server\Scripts\Sample_Backup_Restore
   - On a 64-bit system: C:\Program Files (x86)\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore

3. At the prompt, type:
   
   cscript.exe shoreware_backup.wsf x y

   where x is the component type to back up, and y is the file type. For the definitions of possible x and y values and their combinations, see Table 115 on page 749. As Table 115 shows, for example, if x equals ucb, then y must be all.

4. Click Enter.
Table 115: Backup Arguments

<table>
<thead>
<tr>
<th>Component (x)</th>
<th>File Type (y)</th>
<th>Applicable Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument</td>
<td>Definition</td>
<td></td>
</tr>
<tr>
<td>hq</td>
<td>Headquarters server</td>
<td>all - Applicable for all types of servers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>db - Applicable for Headquarters and DVSs only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>vm - Applicable for Headquarters and DVSs only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cdr - Applicable for Headquarters only</td>
</tr>
<tr>
<td>dvm</td>
<td>Distributed Voice server</td>
<td>all - Applicable for all types of servers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>db - Applicable only for Headquarters and for DVSs that have a distributed database (DDB)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>vm - Applicable only on Headquarters and DVSs</td>
</tr>
<tr>
<td>vmb</td>
<td>Voicemail Model Switch</td>
<td>all - Applicable for all types of servers</td>
</tr>
<tr>
<td>ucb</td>
<td>Service Appliance</td>
<td>all - Applicable for all types of servers</td>
</tr>
</tbody>
</table>

**Backing Up Distributed Voice Servers**

This section describes how to back up a distributed voicemail server. It describes how to do a complete backup and a partial backup. To facilitate the process, we recommend that you back up files during scheduled maintenance times or periods of low system activity.

**Note**

To prevent the system from corrupting files during the backup, server activity must stop before the backup begins. The processes that ShoreTel provides stop the server before the backup and restarts the server after the backup finishes.

**Performing a Complete Backup of a DVS**

1. Access the command prompt on the DVS you want to back up.
2. Navigate to one of the following directories where the ShoreTel backup and restore scripts reside.
   - **On a 32-bit system:**
     
     C:\Program Files\Shoreline Communications\Shoreware Remote Server\Scripts\Sample_Backup_Restore
   - **On a 64-bit system:**
     
     C:\Program Files (x86)\Shoreline Communications\ShorewareRemoteServer\Scripts\Sample_Backup_Restore
3. At the prompt, enter the following command:
Performing a Selective Backup of a DVS

1. Access the command prompt on the DVS you want to back up.

2. Navigate to one of the following directories where the ShoreTel backup and restore scripts reside.

   - On a 32-bit system:
     C:\Program Files\Shoreline\Communications\ShorewareRemote Server\Scripts\Sample_Backup_Restore

   - On a 64-bit system:
     C:\Program Files (x86)\ShorelineCommunications\ShorewareRemote Server\Scripts\Sample_Backup_Restore

3. At the prompt, enter:

   cscript.exe shoreware_backup.wsf x y

   where x is component type and y is the file type. See Table 115 on page 749 for the possible values of x and y.

Backing Up Voice Mail Switches

This section describes how to back up voice mail switches. Backup of voice mail switches must begin on the Headquarters server or a DVS. The modified backup script on the server must include the IP addresses of the voice mail switches to back up (see Configuring the Backup and Restore Scripts on page 744 for information about modifying the script file).

Requirements

- Headquarters server or DVS to implement the backup.
- sw_backup_restore.ini file on implementation server that include IP address of each voice mail switch.
- Ability to establish an SSH connection with the voicemail switch.

Backing up voice mail switches:

1. Access the command prompt on the ShoreTel server that is configured to backup to the voice mail switches.

2. Navigate to one of the following directories where the ShoreTel backup and restore scripts reside.

   - On a 32-bit system:
     C:\Program Files\ShorelineCommunications\Shoreware Server\Scripts\Sample_Backup_Restore
Backing Up All Service Appliances

Backing up service appliances begins on the Headquarters server or a DVS. The back-up script on the server must include the IP address of each service appliance to back up. For the description of how to modify a script by adding IP addresses, see Configuring the Backup and Restore Scripts on page 744.

The necessary elements for backing up service appliances are as follows:

- Headquarters server or DVS to implement the backup
- `sw_backup_restore.ini` file on the server that initiates the backup (a file that contains the IP address of the service appliances to back up)
- Capability of the server to establish an SSH connection with each service appliance

To back up all service appliances:

1. Open a command prompt on the ShoreTel server that backs up the service appliances.
2. Navigate to one of the following directories where the ShoreTel backup and restore scripts reside.
   - On a 32-bit system:
     
     C:\Program Files\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore
   - On a 64-bit system:
     
     C:\Program Files (x86)\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore
3. Enter the following on the command line:

   cscript.exe shoreware_backup.wsf ucb all

**Note**

Running the `hq_backup_all` batch file also calls the command in Step 3. For details about using a batch file, see Using Batch Files on page 757.
Restoring the Headquarters Server

This section describes how to use the ShoreTel backup and restore script to perform complete and selective restores to the headquarters server.

Performing a Complete Restore

1. Access the command prompt on the headquarters server.
2. Navigate to one of the following directories where the ShoreTel backup and restore scripts reside.
   - On a 32-bit system:
     C:\Program Files\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore
   - On a 64-bit system:
     C:\Program Files (x86)\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore
3. At the prompt, enter:
   cscript.exe shoreware_restore.wsf hq all

Performing a Selective Restore

The system has a script for restoring selected files. Follow this procedure to restore selected files:

1. Open a command prompt on the headquarters server.
2. Navigate to the appropriate directory where the ShoreTel backup and restore scripts reside.
   - On a 32-bit system:
     C:\Program Files\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore
   - On a 64-bit system:
     C:\Program Files (x86)\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore
3. Type the following at the prompt:
   cscript.exe shoreware_restore.wsf x y
   where x is the component type to restore, and y is the file type. For the definitions of possible x and y values and their combinations, see Table 116. For example, if x – ucb, then y must be all. (See ucb in Table 116.)
4. Press Enter.
Restoring Distributed Voice Servers

This section describes how to use the ShoreTel backup and restore script to perform complete and selective restores to DVSs.

Performing a Complete Restore of a DVS

Performing a complete restore (all files) of a DVS:

1. Access the command prompt on the DVS to restore.
2. Navigate to the directory where the ShoreTel backup and restore scripts are found. The default path is:
   - On a 32-bit system:
     C: \ Program Files \ Shoreline Communications \ Shoreware Remote Server \ Scripts \ Sample_Backup_Restore
   - On a 64-bit system:
     C: \ Program Files (x86) \ Shoreline Communications \ Shoreware Remote Server \ Scripts \ Sample_Backup_Restore
3. At the prompt, enter the following command:

   cscript.exe shoreware_restore.wsf dvm all

Table 116: Restore Arguments

<table>
<thead>
<tr>
<th>Component (x)</th>
<th>File Type (y)</th>
<th>Applicable Arguments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argument</td>
<td>Definition</td>
<td></td>
</tr>
</tbody>
</table>
| hq                | Headquarters server | all - Applicable for all types of servers  
                      | db - Applicable for Headquarters and DVSs only  
                      | vm - Applicable for Headquarters and DVSs only  
                      | cdr - Applicable for Headquarters only |
| dvm               | Distributed Voice server | all - Applicable for all types of servers  
                      | db - Applicable only for Headquarters and for DVSs with distributed database (DDB)  
                      | vm - Applicable only for Headquarters and DVSs |
| vmb               | Voicemail Model Switch | all - Applicable for all types of servers |
| ucb               | Service Appliance | all - Applicable for all types of servers |
Performing a Selective Restore of a DVS

The ShoreTel system allows restoration of selected files to a DVS. To use the headquarters server to restore selected files to a DVS:

1. Access the command prompt on the DVS to restore.
2. Navigate to the appropriate directory where the ShoreTel backup and restore scripts are found.
   - For a 32-bit system:
     C:\Program Files\Shoreline Communications\Shoreware Remote Server\Scripts\Sample_Backup_Restore
   - For a 64-bit system:
     C:\Program Files (x86)\Shoreline Communications\Shoreware Remote Server\Scripts\Sample_Backup_Restore
3. At the prompt, enter the following command:
   cscript.exe shoreware_restore.wsf x y
   where x is component type that you want to restore and y is the file type. For definitions of the component and files types, see Table 116 on page 753.

Restoring a Service Appliance

A full system restore includes all connected ShoreTel service appliances. However, reasons might exist for restoring just the conference recordings and other files to a service appliance. For example, if a customer replaces a defective service appliance with a new unit, a system administrator uses the commands in this section to restore the files to the new unit. (ShoreTel Director has no way to restore specific files to a service appliance.)

In general, the method consists of the following tasks:
- Creating an SSH or serial connection from the main server to the service appliance
- Executing the restoreweb command on the CLI of the service appliance.

Note
Backupweb and restoreweb are Services Manager CLI (SVCCLI) commands.

Operational Behavior for Manual Restore

This section lists the restored files and describes the behavior of the file system in conjunction with a manual restore. The section describes regular behavior and variations in behavior of the file system during the restore. The variations depend on file system activity that does not directly involve either the backup or the restore—for example, file saves that happen after a backup.
Performing the Manual Restore System Backup and Restore

Performing the Manual Restore

Executing the `restoreweb` command restores the following:

- **Library files**
  - Public: `/site/vlibrary`
  - Private: `/site/<user_id>/vlibrary`
- **Recordings**: `/site/<user_id>/vmeetings/<rec_meeting_id>`
- **IM/Presence data**: `/cf/shorelinedata/UserData`
- **SSL certificates**: `/cf/certs`

The following are notable behaviors:

- During the restore, all services on the service appliance stop running.
- The restore operation can occur on non-empty directories.
- The restore operation does not delete files that are in the file system and are not part of the last backup.
- Files that are created after the previous backup remain intact.
- If a backed-up file on the system changes after the most recent backup, the restore operation replaces the modified file with the backed-up version.
- The restore process can appear to restore files that have been deleted since the previous backup. However, these files are not accessible through the service appliance GUI because the system does not maintain database links to deleted files. To retrieve these disconnected files (if necessary), start an SSH session or serial connection to the appliance and retrieve them by using the correct Linux command.

Consider the following scenario:

1. Some files are uploaded after a backup.
2. The service appliance fails before a subsequent backup.
3. The failed unit is replaced and the content restored.
4. Entries are visible for the files that were not backed up before the device failure.

**Performing the Manual Restore**

The DB links point to files that do not exist. Manually delete the dead links by using the Personal Library tab of the ShoreTel Conferencing web-based user interface. Recordings without links must be removed in the same way.

Although a restore job might accidentally restore deleted files, you cannot access them through the Conferencing web interface because the Headquarters database does not link to them. However, you can use Linux commands to log into the system and extract the deleted files.
ShoreTel supports backup of multiple service appliances to one machine. If multiple service appliances use the same machine for backup, a unique backup destination directory must exist for each service appliance. Although the backup or restore operation relies on command prompt commands, the enable or disable and the configuration of a multi-device backup also depends on information in ShoreTel Director. Specifically, the location for the backed-up files is the destination directory in Director.

For a subsequent file restoration, the restore process copies files from the right directory to restore each service appliance.

**Note**
If the network has more than one service appliance, back up or restore the database and all the service appliances at the same time to avoid dead links.

Restoring the backed-up files to a service appliance:

1. Activate the SCV command prompt by entering the command at the Linux prompt ("$" for admin access or "#" for root access).
2. Start the restore using the `restoreweb` command.
3. Wait for the restore to complete. The restore is complete when the `restoreweb` command returns you to the svccli prompt (">`).
4. Verify that the restore is complete by checking the `/cf/shorelinedata/Logs/`.
5. `FtpSync-<date>.<time>.Log` file, where `<date>` is the current date and `<time>` is the time when the log file was created.
6. Figure 231 illustrates all of the steps for accessing a service appliance through SSH and then running the `restoreweb` command.

![Figure 231: The SVC Command Prompt with restoreweb Command Appliance](image)
Using Batch Files

The batch files reside in the same folder as the scripts. These batch files let you back up or restore different ShoreTel components on the site, including the following components:

- Headquarters
- Distributed Voicemail
- Voicemail Model Switches
- Service Appliances

To batch file commands for backup are as follows:

- hq_backup_all.bat
- dvm_backup_all.bat
- vmb_backup_all.bat
- ucb_backup_all.bat

The batch commands for restore are as follows:

- hq_restore_all.bat
- dvm_restore_all.bat
- vmb_restore_all.bat
- ucb_restore_all.bat

Using a batch file to back up or restore files:

1. Access the command prompt on the ShoreTel server.

2. Navigate to the directory where the scripts reside. The default path is:

- On a 64-bit system:
  C:\Program Files (x86)\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore

- On a 32-bit system:
  C:\Program Files\Shoreline Communications\Shoreware Server\Scripts\Sample_Backup_Restore

3. At the prompt, enter the batch file to use for backup or restore.
Log Files

Log files display the commands that are performed during backup and restore operations at SwBackupRestore.log. By default, Windows maintains three log files. The log files reside in the same directory as the scripts.

Failover Support

To support high availability, ShoreTel provides failover at two points in the network:

- The Headquarters server
- ShoreTel Voice Switches

For the headquarters server, you can install a backup server that mirrors and monitors the primary server. If the primary server fails, operations are immediately transferred to the back-up server with minimal interruption of services. After the primary server is repaired, you must manually fail back the secondary server to return operations to the primary server and return the backup server to its backup role.

For switches, you set up the failover capability by either of the following methods:

- Configuring the switches with extra port capacity
- Installing spare switches that can temporarily manage the phones upon switch failure. Spare switches can reside on a network that is remote to the failed switch and its phones, but the level of service might not equal the switches in the local network.

This section discusses failover at the server level. For more information about switch failover, see "Failover for IP Phones: Spare Switch" on page 129.

To provide failover protection for ShoreTel servers, ShoreTel recommends that you use Double-Take. For a description of how to implement Double-Take, refer to the Double-Take application note on the ShoreTel website.

Configuring a Secondary IP Address

After you have created a backup server for your system, you must designate the backup server for failover function. To designate a backup server for the failover function:

1. Launch ShoreTel Director.
2. Click Administration > Application Servers. The Application Servers page appears.
3. Select the Headquarters Server. The Edit Server page for the Headquarters server appears as shown in Figure 232.
4. In the Secondary IP Address field, enter the IP address of the ShoreTel server that you want to use for failover.

To convert a system to single Headquarters Server mode, remove the address from the secondary IP address field, then reboot the Headquarters server. If you are modifying the IP address of a DVM server, then reboot the DVM.

When the primary and secondary servers reside in different subnets, their IP addresses must be static. The DNS server that a ShoreTel system accesses must associate the same server name to the primary and secondary servers if:

- The primary and secondary servers are configured with static IP addresses.

and

- The Headquarters server supports Communicator clients or clients on Citrix or Windows Terminal servers.

**Note**
The primary and secondary Headquarters servers cannot be running at the same time. However, they can be on the network at the same time.
Conditions during the Failover and Failback Operations

ShoreTel performs a failover operation when the primary server fails to transfer the Headquarters server functions to the secondary server. After the failover operation is complete, the secondary server performs all Headquarters server functions.

The administrator can initiate a failback operation to restore Headquarters server function to the primary server. After the failback is complete, the system structure that existed before the failback operation is restored.

Failover and failback operations typically last 5 to 20 minutes. The times depend on the system configuration. During these operations, no server services are available. The effects failover and failback operation are resolved after the operations are complete and the secondary (for failover) or primary (failback) server is functioning as the Headquarters server.

The effects of failover and failback operation on Communicator include the following:

- Users whose configuration exists on the Headquarters server lose most connectivity capabilities. The operations disrupt telephony and video but not IM connectivity.
- Users on distributed servers maintain all connectivity capabilities.
- Configuration changes are unavailable.
- Users logging into Communicator while the secondary server controls the system must specify the IP Address of the secondary server.

Refer to the ShoreTel Communicator User’s Manual for instructions on specifying the server IP address.

Failover and failback operation can affect voicemail in the following ways:

- Sites that receive voicemail through the Headquarters server lose voicemail access.
- Mailboxes lose access to any voicemail whose routing includes the Headquarters server.
- Sites that receive voicemail from distributed servers retain voicemail access.

Failover and failback operation can affect other system components in the following ways:

- Account Code and Workgroup services are not available.
- Director, Web Client, and Communicator configuration changes are not available.
- If DRS is enabled, intersite calls are unavailable to users residing on sites whose only access to a DRS server is through the Headquarters’ DRS.

System Failover Conditions and Requirements

After the failover operation is complete, the secondary server performs all distributed server and application connectivity activities managed by the Headquarters server. The following sections describe required administrator tasks after the failover operation.
License Compliance

After a failover operation transfers the Headquarters server control to the secondary server, license status on the secondary server is non compliant. To restore the system to compliance, reinstall all licenses that were originally purchased for the secondary server.

Communicator Failover Requirements

To assure proper Communicator client operation and performance after a Failover or a Failback, the browser cache must be cleared. The system administrator should send messages to all MCM clients after a failover operation advising them to clear the browser cache on their devices.

System Failback Conditions and Requirements

After the failback operation is complete, the primary server resumes all distributed server and application connectivity activities managed by the Headquarters server. The following sections describe required administrator tasks after the failback operation.

License Compliance

After a failback operation transfers Headquarters server control to the primary server, license status on the primary server is non compliant. To restore the system to compliance, reinstall all licenses that were originally purchased for the primary server.

MCM Failback Requirements

To assure proper MCM client operation after a failback, the browser cache must be cleared. The system administrator should send messages to all MCM clients after failback procedures advising them to clear the browser cache on their devices.

Failover and Restoration of IP Phones

When you enable the system parameter to fail-over IP phones, the IP phones automatically fail over to another switch on the same site or to a spare switch when they lose connection with their primary switch. The spare switch is designed as a temporary measure to ensure that IP phone users have basic phone connectivity if the primary switch fails. To ensure that users have full connectivity, you must repair or replace the failed primary switch as soon as possible. If you are using the ShoreTel's Disaster Recovery solution, you must configure a secondary IP address.

The sections under the following headings in this section describe how to restore normal operation after a failover occurs:

- Re-assigning the Primary Switch Profile to a Replacement Switch on page 762.
- Moving IP Phones to Primary Switch on page 762.
- Failing Back the Spare Switch on page 764.
Re-assigning the Primary Switch Profile to a Replacement Switch

If you replace a primary switch, you can re-assign the original switch profile to the new physical switch rather than create a new profile. This section describes how to re-assign the switch profile.

The requirements are:

- Obtain a replacement switch that has the same capabilities as the failed switch.
- Physically install the replacement switch on the same network as the old switch.
- Assign the new switch an IP address.
- Unplug the port connections (telephones, trunks) from the existing voice switch and plug them into the new voice switch.

Reassigning the switch profile:

1. Launch ShoreTel Director.
2. Click Administration > Platform Hardware > Voice Switches/Service Appliances > Primary. The Primary Voice Switches/Service Appliances page appears.
3. Select the voice switch that is being replaced. The Edit Switch page for the switch appears.
4. In the IP Address field, enter the IP address (or Ethernet address) of the new switch that you want to use to replace the downed switch.
5. Select the new voice switch and click Save. It can take up to two minutes for the switch to come online.

Note
You can also use the Find Switch button.

Moving IP Phones to Primary Switch

Moving IP phones from the spare switch to the primary switch:

1. Launch ShoreTel Director.
2. Click Administration > IP Phones > Individual IP Phones. The IP Phones page appears as shown in Figure 233.
3. In the By Sites field, select the site where the failover has occurred and you want to perform restoration.

4. In the Use the Switches field, select All Switches.

5. In the Show Pages field, select the page that contains the IP phones that you want to move. The first name and the last name of the phones listed on the page are shown in the field along with the page number.

6. Use the Site column to identify phones that have failed over to the spare switch that you want to move to the primary switch and check the check box to the left of the phone names (the MAC or IP address are often used as name).

---

**Note**

You can select multiple phones to move at one time. The phones do not have to be registered to the same switch.

---

7. In the field to the left of the Move button, select the switch to which you want to move the IP phones.

8. Click **Move**. The phones are moved to the target primary switch.
Failing Back the Spare Switch

After you move the IP phones to the primary switch on the site, you must manually failback the spare switch. To failback the spare switch:

1. Launch ShoreTel Director.

2. Click **Maintenance > Quick Look**. The Quick Look page appears.

3. Select the site where the failover occurred and to which the spare switch is currently assigned. The Voice Switches and Service Appliances Summary page appears similar to the Maintenance Summary page in Figure 234.

4. In the Spare Switches section, identify the spare switch to fail back and in the Command column field, select **Failback**. The failback process starts.

**Note**

Make sure that zero (0) IP phones are connected to the switch. (The listing in the IP Phones column should be 0/N where 0 is the number of phone currently registered with the switch and N is the switch capacity.)

The process takes a few minutes to complete and includes rebooting the spare switch. When the process is complete and successful, the spare switch returns to the spare state.
Verifying Spare Switch Return Status

Verifying the switch has returned to the spare state:

1. Launch ShoreTel Director.
2. Click Administration > Platform Hardware > Voice Switches/Service Appliances > Spare. The Spare Voice Switches page appears.
3. Verify the following columns:
   - The Current Site column is empty.
   - The IP Phones in Use column lists zero (0).
A ShoreTel system can generate reports from the information it gathers throughout the ShoreTel network. The report categories are Call Details and Web Conferences. You can also set up alternative report output, enable archiving, and set language parameters. This chapter provides information about ShoreTel’s reporting capabilities in the following sections:

- Accessing the Call Details Reports Page ................................................................. 768
- Call Details Reports Page ..................................................................................... 769
- Web Conference Reports ..................................................................................... 770
- Reporting Options ................................................................................................. 771
- Supporting Asian Fonts ......................................................................................... 773
- Installing a Font on a Machine Where Web Reports are Required .................... 773
- Configuring Send CDR Out SMDR Interface ......................................................... 773
- Creating the Archive Database .............................................................................. 774
Accessing the Call Details Reports Page

Complete the following steps to access the Call Details Reports screen:

**Note**
The system can run a maximum of five reports at a time. For example, a system administrator can start one report and then start another report before the first report is complete. The maximum number of simultaneous reports is five.

1. Launch ShoreTel Director.
2. Click Reports > Call Details. This page, as shown in Figure 235, has the primary method for accessing and viewing the CDR data in the MySQL database.

![Call Details Report Page](image)

3. In the **Please select...** field, select the report that you want to run.

Reports can be run from ShoreTel Director. After the report has been generated, it can be printed, exported, and navigated interactively, similar to compiled reports.
Call Details Reports Page

**Note**
No more than two users should run reports at the same time. Having more than two people generating reports simultaneously can adversely impact system performance.

**Call Details Reports Page**

**Note**
The CDR data that is collected from different time zones is adjusted to the time zone of the ShoreTel Headquarters server.

**Reports section**

- **Please select the report you want to run:** This drop-down lists all of the different types of reports that can be run.
  - Account Detail Report
  - Account Summary Report
  - Media Stream Detail Report
  - Media Stream Summary Report
  - Trunk Activity Detail Report
  - Trunk Activity Summary Report
  - Workgroup Queue Summary Report
  - Workgroup Service Level Summary Report
  - User Activity Detail Report
  - User Activity Summary Report
  - Workgroup Agent Detail Report
  - Workgroup Agent Summary Report

Refer to Appendix B, Call Detail Record Reports for more information.

**Table 117: Reports Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the account code(s) you want to report on</td>
<td>Account codes are typically used to assist ShoreTel users in the billing of their clients (for example, a law firm tracking the length of a call). Enter the account code(s) that corresponds to one or more clients in the field provided and click the <strong>Add</strong> button to enter the number.</td>
</tr>
<tr>
<td>Enter the extension, or range of extensions, you want to report on</td>
<td>Enter a single extension or a range of extensions in the fields provided to generate a report on only those extensions. You can also leave the fields blank to run the report on all extensions. You can enter an upper or lower extension and then select the <strong>No lower value</strong> or the <strong>No upper value</strong> radio button and to run a report on all extensions up to a specified extension.</td>
</tr>
</tbody>
</table>
Web Conference Reports

ShoreTel Director provides the means to run Web Conference Reports from a local host or a remote server.

Complete the following steps to generate Web conference reports:

1. Launch ShoreTel Director.

2. Click Reporting > Reports > Web Conference. The Web Conference Report screen appears as shown in Figure 236.
Reports can be generated based on the date of the conference, the type of device, such as Service Appliance, or the access code assigned to scheduled conferences.

**Note**
This process may cause some implementations of Microsoft Internet Explorer 8 to fail. If downloading Web report files causes your implementation of Microsoft IE8 to fail, enable the IE8 security parameter “Websites in less privileged web content zone can navigate into this zone.” To navigate to this parameter in IE 8, click Tools > Internet Options > Security Tab > Local Intranet > Custom Level. Scroll down the page to the parameter and click Enable.

### Reporting Options

The Reporting Options page as shown in Figure 237 is accessed by clicking on the Options link under Reporting.

The ShoreTel system supports the ability to send CDR data out a serial port on the main ShoreTel server. The Reporting Options page allows a system administrator to designate which COM port to enable. CDR data is subsequently sent out this port, in addition to being sent to the regular text file and/or a database. Sending the CDR data out the serial port does not change the formatting.
### Table 118: Reporting Options Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh this page</td>
<td>Click this link to update the information displayed on the page. The <strong>Reporting Options</strong> page automatically updates every 60 seconds.</td>
</tr>
<tr>
<td>COM Port for CDR Output</td>
<td>Select the COM port on the HQ server that is the destination of CDR data. The range is 1–10. The default value is none.</td>
</tr>
<tr>
<td>Retention Period for CDR Data</td>
<td>This range of this value is 1–2000 days. The default value is 36 days.</td>
</tr>
<tr>
<td>Enable CDR Archiving</td>
<td>Select this check box to enable archiving.</td>
</tr>
<tr>
<td>Retention Period for CDR Archive</td>
<td>This range of this value is 1–2000 days. The default value is 125 days.</td>
</tr>
<tr>
<td>Archive Database Name</td>
<td>Type the name of the archive database. Saving the name of the database does not create the archive database; a separate utility is necessary. See <a href="#">Creating the Archive Database</a> on page 774 for details on creating an archive database.</td>
</tr>
<tr>
<td>Archive Database IP Address</td>
<td>Type the IP address of the server where the archive database resides.</td>
</tr>
<tr>
<td>Select Language Variant</td>
<td>The field specifies the Asian Font that is supported on the computer running Director. Refer to <a href="#">Supporting Asian Fonts</a> on page 773 for more information.</td>
</tr>
<tr>
<td>Include Unanswered Calls</td>
<td>Select this check box to include unanswered calls in the report. All unanswered calls are reported with a duration of zero.</td>
</tr>
</tbody>
</table>
Supporting Asian Fonts

Ascender Corporation provides four font files — Arial Unicode for ShoreTel, Arial Unicode for ShoreTel Bold, Arial Unicode for ShoreTel Italics, and Arial Unicode for ShoreTel Bold Italics — for three languages: Japanese, Simplified Chinese, and Traditional Chinese. Only one set of files, which supports one language, can be installed on a computer at any time.

Installing a Font on a Machine Where Web Reports are Required

1. Open the Edit Reporting Options page by selecting Reporting > Options in the main Directory window. Figure 238 shows the Reporting Options editor.

2. Select the desired language from the Select Language Variant drop-down menu.

3. Click Install Fonts. ShoreTel installs the requested font set.

The HQ server has a Chinese Traditional font by default. Accessing reports from a client machine or using another Asian font necessitates a font installation in Reporting Options.

Configuring Send CDR Out SMDR Interface

The ShoreTel system captures CDRs in a database in a text-file format. However, for legacy call accounting systems that cannot read CDR from a database, the CDR data can be delivered as a Station Messaging Detail Record (SMDR) using a serial (COM) port on the main ShoreTel server. When using SMDR, the following applies:

- Formatting of the CDR data remains the same, regardless of whether it is sent out the COM port or written to the database.
The application should auto-detect the serial port configuration by extracting information about the status of the serial port configuration, for example the baud rate, from the Windows registry.

The feature will be disabled by default and must be enabled by selecting a COM port.

If the serial port should become unavailable through an event such as becoming locked by extremely high volumes of traffic, the CDR data will be queued in a buffer for 300 seconds to help prevent the loss of data. If the serial port returns to service within the 300-second time period, the streaming resumes.

Complete the following steps to designate a COM port for sending CDR Out SMDR Interface through ShoreTel Director:

1. Launch ShoreTel Director.
2. Click Reporting > Options. The Reporting Options page appears.
3. Click COM Port. The CDR Output drop-down menu appears, as shown in Figure 239.
4. Select the COM port that you want to use for SMDR on the headquarters server.
5. Click Save to store changes.

After COM port configuration, the system directs CDR data to the SMDR port as calls move through the system.

Creating the Archive Database

The following procedure describes the process of creating a separate, optional archive database using the MakeCDRArchive.exe command line utility.

1. On the ShoreTel headquarters server, navigate to C:\Program Files\Shoreline Communications \ ShoreWare Server and make sure the following files are installed in the same directory:
   - MakeCDR.dll
2. Open the command prompt window in the directory shown above and run the following command:

```bash
MakeCDRArchive -d databasename
```

- **Database** is the name of the archive database to be created. The database name must be the same as the name created on the **Options** page.
- If no name is defined, the default name of `shorewarecdrarchive` will be created within the following directory:

  ```bash
  C:\Shoreline Data\Database\ShoreTelCDR\Data
  ```

Records from the main database are written to the archive database when the services start up and every night at approximately 12 am.

---

**Note**

Instructions for installing MySQL on a secondary server are provided in the **MySQL Database** on page 806.
Emergency Dialing Operations

This chapter explains the chain of events in the call flow when an emergency call is placed. This chapter also provides instructions for configuring your ShoreTel system to ensure that emergency services are dispatched to the correct location. And finally, the chapter tells you how to select which of the various pieces of caller ID information will be used to identify callers when an emergency call is placed. These topics are discussed in the following sections:

How Emergency Calls Work ................................................................................... 779
Emergency Call Scenario ..................................................................................... 779
Roles and Responsibilities ..................................................................................... 780
Using a PS/ALI Service Provider ........................................................................ 781
Feature Operation .................................................................................................. 781
Digit Collection for Emergency Calls ............................................................... 781
Ensuring Proper Routing of Emergency Calls .................................................... 782
Trunk Signaling for Emergency Calls ............................................................... 784
Selecting Caller ID Type for Emergency Calls .................................................... 784
Available Caller ID Options ................................................................................. 785
Configuring a System for Emergency Calls ....................................................... 789
Trunk Groups ....................................................................................................... 789
User Groups ......................................................................................................... 790
Users .................................................................................................................... 791
Specifying CESID for IP Phone Address Range .............................................. 793
Switch ................................................................................................................... 794
Sites ....................................................................................................................... 794
Planning Your Emergency Response ................................................................. 795
Call Notification ................................................................................................... 796
How Emergency Calls Work

This section provides a simple scenario of how emergency calls are handled with the ShoreTel system. Figure 240 displays a simple emergency call-flow scenario.

![Simplified Emergency Call Flow Scenario](image)

**Figure 240: Simplified Emergency Call Flow Scenario**

### Emergency Call Scenario

The following is a description of the call flow depicted in the figure.

1. An emergency call is placed from a ShoreTel desk phone.
2. The ShoreTel system identifies the call as an emergency and automatically routes it to an outbound trunk. Caller ID information is provided in either of the following ways:
   - When the call is sent over a PRI trunk, the ShoreTel system provides caller ID information.
   - When the call is sent over a non-PRI trunk, the service provider provides caller ID information.
3. The call is passed over the Public Switched Telephone Network (PSTN) to the exchange of the service provider.
4. The service provider passes the call to a Public Safety Answering Point (PSAP). This is the location of the emergency services dispatcher.
5. The dispatcher at the PSAP gets a “screen pop” which displays information contained in a emergency database. The database contains a mapping between the caller ID number and the geographic location of the caller.
6. The dispatcher sends emergency response personnel to the calling party's location.
For emergency calls placed from residential or a single-site businesses, determining the location of the calling party is fairly simple and straightforward. However, when dealing with large offices and campus environments, your emergency configuration can get complex. If you are maintaining a configuration that has many remote sites, it is imperative that you do the following:

- Keep your emergency information current with your PSAP.
- Work with your service provider to find out what kinds of caller ID information they will accept.
- Work with the local PSAP to ensure that any changes in your emergency configuration (i.e. names, phone numbers, locations of the members) are mirrored in the PSAP’s database.

**Roles and Responsibilities**

Each participant in an emergency call has a different role to fill and a different set of responsibilities to handle.

The role of the PBX is to:

- Identify the call as an emergency call.
- Route the call to an outbound trunk, preferably a dedicated trunk.
- Pass the correct caller ID information to the exchange of the service provider when a PRI trunk is used to send the call.

The role of the exchange of the service provider is to:

- Work with the customer to ensure the correct caller ID number is passed to the PSAP.
- Pass the caller information to the PSAP.

**Note**

The billing number of the trunk is used if no other caller information is available.

The role of the PSAP is to:

- Receive emergency calls.
- Host a database that maps the caller ID numbers to the physical location of the users.
- Display information about the calling party to a dispatcher.
- Send the proper emergency response personnel to the caller’s location.

The role of the user is to:

- Decide which type of caller ID information best fits your needs for emergency calls.
- Work with the service provider to verify that they will accept your preferred type of caller ID information.
- Communicate any changes to your emergency configuration to ensure the PSAP is current.
Using a PS/ALI Service Provider

In addition to working with your local PSAP to provide accurate logistical information, we recommend that you subscribe to a Private Switch/Automatic Location Information (PS/ALI) service provider as well.

A PS/ALI service provider maintains a database that stores specific address information for each extension or DID on your system. Subscribing to PS/ALI services ensures that accurate automatic number identification (ANI) information is passed to the PSAP in the event of an emergency call, and prevents the emergency responder from showing up at the wrong location.

A subscription to a PS/ALI service provider is particularly recommended in situations where a ShoreTel system is deployed in an environment where a single PRI is used to serve multiple locations, such as a single PRI being used for several schools in the same district. In such environments, it is possible for a user to make an emergency call from one of the elementary schools and have the emergency crews dispatched to the wrong location. This can happen if the local trunks are busy and the call gets routed across an analog trunk and across the WAN to the first available PRI, which might be at one of the other schools in the district. With no PS/ALI database to provide accurate information about the origination of the call, the emergency services providers see the call originating at the wrong location. While the correct phone number is sent to emergency services, the association is with the PRI instead of the school where the call originated.

This critical error can be prevented if a PS/ALI database is in place. Such a database, which is maintained by a PS/ALI service provider, can identify the location associated with a specific DID.

Note
ShoreTel does not provide PS/ALI service. Contact the local telco carrier for information about PS/ALI service providers in the relevant areas.

Feature Operation

This section describes the following features:

- Digit Collection for Emergency Calls on page 781
- Ensuring Proper Routing of Emergency Calls on page 782
- Trunk Signaling for Emergency Calls on page 784

Digit Collection for Emergency Calls

A ShoreTel user who dials an emergency number (or <access_code> + emergency number) will be routed to an emergency-capable trunk.

- If the user dials an access code followed by an emergency number, digit collection terminates immediately and the call is routed to an emergency-capable trunk.
If the user forgets to dial an access code before dialing the emergency number, the system waits five seconds before routing the call to an emergency-capable trunk. This pause has been introduced to eliminate accidental calls to the emergency number.

Note

Systems that use 911 for the emergency number often also use 9 as an access code for outbound calls. This makes it easy for users to mistakenly dial 911 on a long-distance call by adding an extra 1 before the area code, such as dialing the following number: 9-1-1-408-555-1212. If additional digits are entered after 9-1-1 during the five-second timeout period, the system will consider it a dialing error and the calling party will hear a reorder tone.

Ensuring Proper Routing of Emergency Calls

Without a dedicated emergency-enabled trunk, emergency calls may not be properly routed under the following circumstances:

- If all available emergency-enabled trunks are busy, the ShoreTel system will not route the emergency call.
- If a site has no emergency-enabled trunk and ‘Parent as Proxy’ is enabled for that site, the ShoreTel system will not route the call to the emergency-enabled trunks of the parent site if the admission control bandwidth is exceeded at either site.
- If the SIP tie-trunk is unavailable, the ShoreTel system will not failover and route the call through the parent site when the following are true:
  - The site is connected to the parent site by an emergency-enabled SIP tie-trunk.
  - Parent as proxy is enabled for the site.
  - The site has no available emergency-enabled trunk.

Note

At sites with multiple trunks, the trunk selection order is SIP, ISDN, Digital, Analog. Additionally, when trunk groups are configured in the ShoreTel system, the default programming enables emergency services in each trunk group.

System administrators should consider that emergency calls will be routed over SIP if a SIP trunk is available and are encouraged to configure a dedicated, non-SIP, non-emergency trunk and disable Emergency Services in SIP Trunk Groups.

WARNING!

A dedicated emergency-enabled trunk must be configured at each site to ensure emergency calls always reach the CO and PSAP.

Call permissions are ignored when an emergency call is placed to ensure that a user can dial emergency number from any extension on the system, regardless of the permissions associated with that user or the extension from which he or she is calling.
Once the user dials an emergency number, the call leaves the extension, arrives at the switch, and is routed to any available emergency-capable trunk at the originating site. If the user belongs to a user group that does not have access to any emergency-capable trunks, then the call will not be placed.

**WARNING!**

When adding users to the ShoreTel system, make sure each user is placed in a user group that has access to an emergency-capable trunk group. If a user is placed in a user group that does not have access to an emergency-capable trunk, such as a user group with long distance trunks only, members of that user group will not be able to dial emergency numbers, and they will get a reorder tone when attempting to do so.

To better understand this, you must realize that users are placed into user groups when added to the ShoreTel system. The user groups are assigned to trunk groups, and these trunk groups have different capabilities, one of which is the ability to place emergency calls. If a user belongs to only one user group, that group must have access to an emergency-capable trunk. It is crucial that each site have at least one emergency-capable trunk.

For details about adding users to a user group that has access to an emergency-capable trunk, see Configuring User Groups on page 351.

Always confirm with your service provider that a trunk supports emergency calls. In some instances, this may not be the case, such as with long-distance trunks. If the trunk does not support emergency, be sure to un-check the emergency parameter as an available service in the associated trunk group in Director.

If you have mistakenly set up a site that has no available emergency-capable trunks, emergency calls will be routed to the emergency-capable trunk at the proxy site if one has been designated. By routing the call to a proxy site, the ShoreTel system is making a "last ditch" attempt to place the emergency call. This failover behavior can be unreliable and should not be relied upon to ensure that users on your system can dial emergency numbers. If you use the "parent as proxy" configuration, make sure the boundary between the two sites never traverses geographic locations that would send an emergency call to the incorrect emergency-service provider. For example, if improperly configured, a caller in Houston could pick up a phone, dial 911, and reach a 911 service in Boston because the system was configured to have the Boston site as the parent of the Houston site with "parent as proxy" checked.

Each site should have at least one emergency-capable trunk. If there will only be one trunk at a particular site, that trunk should be capable of placing an emergency call. You should also be aware that if there is only one trunk at a site, only one emergency call can be placed at a time. Therefore, you should make sure you have enough emergency trunks at each site to accommodate the realistic potential emergency traffic for that site.
Emergency Dialing Operations

Trunk Signaling for Emergency Calls

When an emergency call is routed out an analog or digital loop-start or a digital wink start trunk, the service provider is responsible for passing caller ID information to the PSAP.

When an emergency call is routed through a T1 PRI trunk, the ShoreTel System sends the proper caller ID information to the service provider, and the service provider must forward the information to the PSAP.

Contact your local telecommunications service provider to communicate your emergency implementation plans and have them approved. It is important to ensure that the service provider will accept, and subsequently pass to the PSAP, the caller ID information configured within the ShoreTel system. In some cases, without proper planning, a provider will reject the caller ID information as configured in the ShoreTel system and will simply pass the caller ID information associated with the trunk to the PSAP. If this happens, the dispatcher may get a number telling them to go to the wrong location.

User’s have a home port defined in ShoreTel Director. If a user is not at his home port, it could change the caller ID number delivered to the service provider on emergency calls.

For mobile workers who travel between sites, the user must have access to an emergency-capable trunk at every site. In remote locations, the user should use the emergency trunk associated with that remote location.

Selecting Caller ID Type for Emergency Calls

There are a number of different caller ID choices available within ShoreTel that can be used by the PSAP to identify callers when they place an emergency call. The list below summarizes the available choices for sending the caller ID to the service provider for emergency calls. Options are listed in the order of precedence, meaning that if the first item on this list is not configured within the ShoreTel system, then the next piece of information on the list will be sent. Additional details about each of these caller ID options appears after the list.

WARNING!
If ShoreTel VPN phones are to be deployed in locations that are different from the site with which they are associated, placing an emergency call from a ShoreTel VPN phone requires special consideration.

In the default case, an emergency call dialed from a VPN phone will be sent to the PSAP associated with the site that hosts the switch and VPN concentrator. The emergency call would be answered but likely by a response center that is out of area for the VPN phone user which could delay or prevent an appropriate response.

ShoreTel strongly recommends that you deploy a 3rd party solution that can send a VPN phone's emergency call to the appropriate response center. Otherwise you should clearly mark VPN phones to alert users that emergency calls should not be attempted from such phones and you should educate your VPN phone users about the emergency-number limitations of the VPN phone.
1. User’s Caller ID number
2. User’s Direct Inward Dialing (DID) number
3. Caller’s Emergency Service Identification ID (CESID) for an IP address range
   The CESID is the telephone extension that a switch sends to a Public Safety Answering Point (PSAP). A CESID helps to locate callers who require emergency services.
4. CESID of the controlling switch
5. CESID of the site
6. Nothing sent by ShoreTel system (the service provider sends the caller ID number associated with the trunk)

For details on selecting the best choice for your situation, refer to Available Caller ID Options on page 785.

If you are configuring a system in the Netherlands, please see Special Considerations for Netherlands on page 798.

Available Caller ID Options

Refer to the following sections for information about caller ID options.

User’s Caller ID Number

Each user can be assigned a caller ID number that will identify him during outbound calls. This caller ID number is typically used for outbound calls from the ShoreTel system when you do not want the receiving party to know the calling party’s DID number. For example, an ACD agent may use caller ID to ensure that returned calls will go to a queue of sales agents, rather than directly to his desk. Similarly, this caller ID number can be sent to the service provider to identify the user when he places an outbound emergency call. The user’s caller ID number is a very specific way of identifying the location of an individual user and is therefore likely to become less accurate over time as the PSAP’s emergency database becomes out of date. Sending the CESID for outbound emergency calls is best for smaller organizations (see Figure 241) and is defined on the User Edit page. You must select the “Send Caller ID as Caller’s Emergency Service Identification” check box on the user group page.

In the scenarios described above and below, the user’s caller ID number will only be sent when the user is at his home port. If the user is not at his home port, then the next available caller ID type is sent.

User’s DID Number

The DID number (Direct Inward Dialing) is the number someone dials from outside the ShoreTel system to reach a user at her desk. The DID is what most people would consider to be a “normal” telephone number. This DID number can be sent to the service provider to identify the user when she places an outbound emergency call. Although this is the most granular way of identifying users, it is also the most likely to become out of date in the PSAP’s emergency database as people come and go. Sending the DID number for outbound emergency calls is most appropriate for smaller organizations (see Figure 241) and is defined on the User Edit page. You must select the “Send DID as Caller’s Emergency Service Identification” check box on the user group page.
CESID of the Specified IP Address Range

The CESID of an IP address range can also be delivered to the service provider during outbound emergency calls. A single CESID number is assigned to a range of IP addresses such that any IP phone that has an IP address that falls within the specified range will have this CESID sent for outbound emergency calls. This option works best for identifying a phone in an office that has many floors and many extensions. Typically, a specific IP address range is configured for each floor of a building so that all users on that floor use the same CESID for emergency calls.

If a DHCP server is present, an IP phone will automatically receive an IP address within the specified range when it is connected to the network.

Sending the CESID for a specified IP address range for outbound emergency calls works best for larger organizations where simply identifying the site’s street address would not provide enough information for an emergency response team to locate the caller (see Figure 242). Furthermore, this option offers the best flexibility, the highest accuracy, and is the least likely to become out of date in the PSAP’s emergency database. This option is defined on the IP Phone Address Map page.
Available Caller ID Options

Emergency Dialing Operations

Figure 242: IP Address Mapping – Best for Larger Offices

CESID of the Controlling Switch

Similar to the previous option, the Caller’s Emergency Service Identification ID (CESID) of the controlling switch can also be sent to the service provider during outbound emergency calls. With this option, a CESID number is assigned to a phone switch and for any phone plugged into this switch, the switch’s CESID is sent for outbound emergency calls. This option is best for larger organizations in which users are calling from analog phones (see Figure 242). Using the IP Phone Address Map method will not work with analog phones. This approach ensures that the emergency response team is sent to the approximate vicinity of the calling party. This option is defined on the Switch Edit page.

Site (Caller’s Emergency Service Identification (CESID) – This option delivers the CESID associated with the site to the service provider during emergency calls. This approach might not be granular enough for larger enterprises, but it could work well for single-site organizations or for situations in which it would be adequate to provide the emergency response personnel with a building address. This option is defined on the Site Edit page. (See Figure 243).
Table 119 shows several customer scenarios and provides recommendations for how to configure E911 along with reasons for the recommendation.

Rules and regulations for E911 can vary between geographical regions. Consult with the local public safety agency to ensure the system configuration meets the local requirements.

### Table 119: E911 Configuration Options

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small site with analog trunks</td>
<td>■ No emergency configuration necessary</td>
</tr>
<tr>
<td>College dormitory rooms (with PRI)</td>
<td>■ Emergency response personnel must be dispatched to a specific room</td>
</tr>
<tr>
<td></td>
<td>■ Consider sending Caller ID or DID. ShoreTel recommends turning off</td>
</tr>
<tr>
<td></td>
<td>extension assignment for this application. Refer to Using Extension</td>
</tr>
<tr>
<td></td>
<td>Assignment on page 446 for more information about extension assignments.</td>
</tr>
</tbody>
</table>

*Figure 243: Send the Site CESID for Medium-Sized Offices*
Configuring a System for Emergency Calls

The following sections provide information for configuring a ShoreTel system for emergency calls.

### Trunk Groups

Make sure you have an outbound trunk group with outbound access that also supports the emergency trunk service. If there is no emergency-capable trunk group configured, create one on the appropriate Trunk Group edit page. Refer to Figure 244 for an example of this page.

**Note**

You should uncheck 911 option while configuring SIP tie trunk groups.

---

### Table 119: E911 Configuration Options (Continued)

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Note</th>
</tr>
</thead>
</table>
| Classroom (with PRI) | - Emergency response personnel must be dispatched to a specific room  
- Send DID or Caller ID. Consider turning off the extension assignment feature. Refer to Using Extension Assignment on page 446 for more information about extension assignments. |
| Multi-building campus or office complex (with centralized PRI) | - Caller ID or DID might be too granular and involve too much management overhead.  
- Consider using IP phone address mapping and/or the switch’s CESID. |
| Large building with multiple floors (with PRI) | - Caller ID or DID may be too complex.  
- Consider using IP phone address mapping and/or the switch CESID. |
| SoftPhones or travelling user | - Use home phone or hotel phone for emergency calls. |
| Remote IP phones (with PRI at headquarters) | - Dial an emergency number with home phone.  
- Use the IP phone address map (home CESID) as a backup. |
| VPN Phone – Fixed Location | - Remote worker install phone once, then never moves it.  
- Configure Caller ID of phone to reflect geographic location. One option is setting Caller ID to be identical to worker’s home phone number. |
| VPN Phone – Variable Location | - Remote worker uses phone when traveling from various locations.  
- Use home phone or hotel phone for emergency calls. |
Complete the following steps to configure a trunk group to support emergency service:

1. Launch ShoreTel Director.

2. Click **Administration > Users > Trunks > Trunk Groups**. The Trunk Groups page appears.

3. Select the trunk that you want to configure to support emergency dialing. The Edit Trunk Group page appears as shown in **Figure 244**.

   ![Figure 244: Trunk Group Edit Page (T1 PRI Trunk Group)](image)

4. Check the emergency option, which in **Figure 244** is 911.

5. Click **Save**.

As a precaution, you should review all other trunk groups to ensure that the emergency check box is not inadvertently enabled on a trunk that is not emergency-capable.

**User Groups**

Make sure each user group has access to a emergency-capable trunk group. You can select the desired emergency Caller ID choice on the **User Group** edit page.

- To send the Caller ID as the CESID number, verify the **Send Caller ID as Caller’s Emergency** check box is selected.
To send the DID as the CESID number, verify the **Send DID as Caller's Emergency** check box is selected.

Complete the following steps to enable a user group to support emergency dialing:

1. Launch ShoreTel Director.

2. Click **Administration > Users > User Groups**. The User Groups page appears as shown in **Figure 245**.

![User Group Edit Page](image)

3. Check the **Send Caller ID as Caller's Emergency** check box to send the Caller ID as the CESID number.

4. Check the **Send DID as Caller's Emergency** check box to send the DID as the CESID number.

5. Click **Save**.

Make sure you give access to trunk groups at other sites in case users in the group use the Extension Assignment feature from another site. Refer to **Using Extension Assignment** on page 446 for more information about extension assignments.

**Users**

Make sure the **Caller ID** field is configured if you are sending Caller ID as CESID for this user. Similarly, make sure the **DID** check box is selected (and contains a valid number in the **DID** field) if you are sending DID as CESID for this user.
Verify each user belongs to the correct user group. Use the Edit User page (Figure 246) to associate users with the appropriate user group. See Configuring a User Account on page 354 for more configuration information.

Complete the following steps to configure a user to send Caller ID as CESID:

1. Launch ShoreTel Director.

2. Click Administration > Users > Individual Users. The Individual Users page appears.

3. Select the user that you want to send caller ID as CESID. The Edit User page appears as shown in Figure 246.

- Do one of the following:
  - In the Caller ID field, enter the number that you want to send for this user.
  - Check the DID Range check box and make sure there is a valid number listed in the field.
  - In the DID field, enter the DID number that you want to use for the user.

4. In the User Group field, select a user group that has the type of emergency support enable that users must have.

5. Click Save.

You cannot configure any user, workgroup, or route points to have a 911, 911n, or 911nn extension. The 911 feature reserves these extension ranges.
Specifying CESID for IP Phone Address Range

When you have sites in different geographical areas, you must make sure that the correct local emergency number is associated with the site. You can do this by associating the local CESID number with the IP address range the system uses to assign number to new phones at the site. To associate the CESID with numbers assigned to phone at the site, do the following:

1. Launch ShoreTel Director.
2. Click Administration > IP Phones > IP Phones Address Map. The IP Address Map List page appears.
3. Click the site to which you want to associate the local CESID. The IP Phone Address Map Info dialog box appears as shown in Figure 247.
4. In the Caller Emergency Service Identification (CESID) field, enter the emergency phone number that is local for the site.
5. Click Save.

Note

Outside the U.S., be sure that extension numbers do not overlap or otherwise conflict with local emergency phone numbers.
Switch

Complete the following steps to configure a switch with a CESID:

1. Launch ShoreTel Director.
2. Click Administration > Platform Hardware > Voice Switches/Service Appliances > Primary. The Primary Voice Switches/Service Appliances page appears.
3. Select the switch that you want to configure with a CESID number. The Edit Switch page appears.
4. In the Caller’s Emergency Service Identification (CESID) field, enter the CESID number that is local for the area the switch services.
5. Click Save.

Sites

Use the Site edit page to configure a site’s CESID number. Refer to Chapter 3, ShoreTel Sites on page 77, for additional information about configuring sites.

Complete the following steps to configure a site to support emergency numbers:

1. Launch ShoreTel Director.
2. Click Administration > Sites. The Sites page appears.
3. Select the site that you want to configure to support emergency numbers. The Edit Site page appears as shown in Figure 248.
4. In the **Caller's Emergency Service Identification (CESID)** field, enter the number that you want the site to send for emergency responses.

**Note**
Make sure this field is configured with the appropriate number for the country or area the site services. For example, sites serving phones in the United States and Canada use 911.

5. In the Emergency Number List section, check the **Trunk Access Code Required** check boxes with the trunk access code over which you want to send emergency calls.

6. Click **Save**.

**Planning Your Emergency Response**

When an emergency call is made, the system automatically generates an event in the Windows event log at the beginning of the call. With the use of an event filter, you can automatically send an e-mail message to the appropriate people in your organization to help coordinate your local response, for example, at the organizational level, whenever the emergency number is dialed.
We recommend training the personnel at all sites on the emergency operations of your ShoreTel IP voice system. All users should know how to access emergency services during normal and power outage situations.

**Call Notification**

You can set up an event filter to generate an e-mail message to help coordinate your emergency response. For more information about event filters, refer to Database Maintenance on page 650 for more configuration information. Use the Event Filter edit page to configure the event filter for the following parameters:

1. Launch ShoreTel Director.

2. Click **Maintenance > Event Filter**. The Event Filters page appears.

3. Click **Add New** to create an event filter for emergency calls. The Edit Event Filter page appears as shown in **Figure 249**.

   ![Event Filter Edit Page](image)

   **Figure 249: Event Filter Edit Page**

4. In the Server section, select the **Server** that you want to monitor for emergency events.

5. In the Source section, select **Switch in ShoreWare**.

6. In the **Event ID** field, enter **1319**.

7. In the Type section, select **All**.

8. In the Target email address field, enter the email address of the party to whom you want emergency notification sent.

9. Click **Save**.

**Figure 250** shows a typical logging message that would result after an emergency call was placed – assuming notifications had been properly configured.
We suggest naming your switches with location information such that you can understand which site the call was made from.

International Emergency Numbers

The ShoreTel system allows dialing of emergency numbers with and without trunk access codes. For this reason, you should reserve the dialing plan space for this feature. Consider the following:

- “112” is used in Europe and other countries.
- “000” is used in Australia.
- “999” is used in Asia.

Ensure extensions do not begin with “112”, “911,” or “999”.

Note

Extensions should never begin with “0”.

Each site can have a maximum of ten emergency numbers to accommodate locations where multiple emergency service numbers are required.

For more information on international installations, refer to the Planning and Installation Guide.
Special Considerations for Netherlands

It is against the law in the Netherlands to “spoof” Caller ID. Caller ID will only be sent if the configured caller ID corresponds to the incoming DID that is associated with a particular trunk.

Any number entered in the CESID field in the Switch Edit Page and Site Edit Page will only be sent if the number matches the number associated with the incoming DID for that trunk.

Verifying Your Emergency Configuration

After you have finished configuring your system for emergency operation, we recommend working with your local emergency dispatch center to test your configuration in order to verify that it has been correctly configured, is sending out the desired caller ID information, and is dispatching emergency response personnel to the proper location.

We recommend calling your local law enforcement agency’s non-emergency number to understand how to go about the test and to arrange a call time during non-peak hours. Do not place your emergency test call without making prior arrangements. Depending on your location, an officer may be required on-site when making test calls.

Table 120 is intended to help you plan your test call to the local dispatch center.

<table>
<thead>
<tr>
<th>Site</th>
<th>Extension</th>
<th>User</th>
<th>Expected Caller ID</th>
<th>Actual Caller ID</th>
<th>Pass or Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Additional Recommendations

All sites should be configured with a designated power failure emergency phone configured appropriately. Each designated power failure emergency phone should be configured on the following ports, based on type of switch, to take advantage of ShoreTel’s emergency line power failure feature:

- SG40 – Port 4: Analog Trunk; Port 5: Analog Emergency Phone
- SG60 – Port 8: Analog Trunk; Port 9: Analog Emergency Phone
- SG120 – Port 8: Analog Trunk; Port 9: Analog Emergency Phone
- SG30 – Port 1: Analog Trunk; Port 12: Analog Emergency Phone
- SG50 – Port 1: Analog Trunk; Port 12: Analog Emergency Phone
- SG50V – Port 1: Analog Trunk; Port 12: Analog Emergency Phone
- SG90 – Port 1: Analog Trunk; Port 12: Analog Emergency Phone
- SG90V – Port 1: Analog Trunk; Port 12: Analog Emergency Phone
- SG220T1A – Port 1: Analog Trunk; Port 12: Analog Emergency Phone
Call Detail Record Reports

Call detail record (CDR) reports allow the system administrator or other individual to review the ongoing call activity on the ShoreTel system. Sections in this appendix include:

- Overview ................................................................................................................. 803
- Call Accounting Service .................................................................................... 803
- Active CDR Database ....................................................................................... 803
- Legacy CDR Text Files ..................................................................................... 804
- Talk Time Record .................................................................................................... 806
- MySQL Database .................................................................................................. 806
  - Compatibility and Pre-Configuration Requirements ........................................ 807
  - Archival and Backup Utilities ........................................................................... 807
  - Installing MySQL on a Secondary Server ..................................................... 810
- Installing and Upgrading MySQL Archive and ODBC Connector on a Secondary Server ...................................................................................................................... 810
  - Installing MySQL on a Secondary Server ..................................................... 810
  - Performance Tuning for Report Generation ................................................... 817
  - Report Generation Time – CPU Utilization .................................................... 817
  - MySQL CDR Database and Internationalization ............................................ 817
  - Monitor MySQL service .................................................................................. 817
  - Tools for browsing MySQL database tables .................................................. 818
  - Restrictions in the Number of Records Returned by the MySQL CDR Query.. 818
- CDR Reports .......................................................................................................... 818
  - TMS-CDR Media Stream Statistics ................................................................. 819
  - Generating CDR Reports ................................................................................ 823
  - Interpreting CDR Reports ................................................................................ 823
User Activity Summary Report ................................................................. 823
User Activity Detail Report ..................................................................... 826
Trunk Activity Summary Report ............................................................. 831
Trunk Activity Detail Report ................................................................... 833
Workgroup Agent Summary Report ....................................................... 837
Workgroup Agent Detail Report ............................................................... 839
Workgroup Service Level Summary Report .......................................... 843
Workgroup Queue Summary Report ...................................................... 846
WAN Media Stream Summary Report .................................................... 849
WAN Media Stream Detail Report .......................................................... 850
Account Code Summary Report ............................................................. 853
Account Code Detail Report ................................................................... 854
CDR Database ....................................................................................... 856
  Creating a CDR Archive Database ....................................................... 857
  Call Table ............................................................................................. 857
  Enumeration Tables: Use for the Call Table ......................................... 860
Connect Table ......................................................................................... 860
  Connect Table Field Descriptions ....................................................... 861
  Enumeration Tables Used for Connect Table ........................................ 864
  MediaStream Table .............................................................................. 867
  AgentActivity Table ............................................................................. 869
    Enumeration Tables Used for AgentActivity ...................................... 871
  QueueCall Table .................................................................................. 871
    Enumeration Tables Used for QueueCall ........................................... 874
QueueStep Table ..................................................................................... 875
Web Tables ............................................................................................. 876
  Audio Only Conference ....................................................................... 876
  Web Only Conference ......................................................................... 876
  Audio & Web Conference .................................................................... 876
  Web Session Table .............................................................................. 876
  Web Attendee Table ............................................................................ 877
Overview

The ShoreTel system tracks all of the call activity and places CDRs in a database and a text file on the ShoreTel server. The system uses the records to generate CDR reports. A new ShoreTel system has 12 CDR reports based on data from the CDR database. In addition, the text files provide a simple and standard way to access the call data to third-party call accounting systems.

If the ShoreTel server is not running, it does not generate call detail records, and calls from the associated period do not appear in CDR reports.

In the WAN fails, CDR data is stored for up to two hours on the distributed server. When WAN connectivity returns, the stored data goes to the Headquarters database. After two hours, the distributed server deletes the data and logs an error to the NT event log.

Call Accounting Service

The ShoreTel system operates a call accounting service on the main server. This service generates and then places call detail records in a database and a space-delimited text file for use by accounting applications from third-party vendors. The call accounting service is also responsible for archiving all the CDR data. The CDR files reside in C:\Shoreline Data\Call Records 2.

Active CDR Database

The call accounting service generates call detail records into the active CDR database. This file includes all call activity for the period of time specified in the Retention Period for CDR Data parameter in the Director Reporting Options page, as shown in Figure 251. To access this page, select Reporting > Options from the Director menu.

Note
All collected CDR data from sites in different time zones are adjusted to the time zone of the HQ (Director) server.

Note
Call activity is not tracked and call detail records are not recorded for users who have the Call History Privacy feature enabled. For more information about this feature, see Configuring Call History Privacy on page 445.
When Enable Archiving is selected on the Reporting Options page, a nightly routine automatically moves call detail records that are older than the limit specified by the Retention Period for CDR Data into the Archive database.

**Legacy CDR Text Files**

The call accounting service automatically generates a daily legacy CDR text file for use by third-party call accounting applications. These packages typically provide numerous reports, including:

- Call accounting, cost allocation
- Most frequently dialed numbers
- Most costly dialed numbers
- Most costly users
- Trunk utilization
- Toll fraud

The CDR*.log files are text files created daily at midnight. It contains call records from midnight to midnight. Any call records that span the midnight hour will be recorded on the day that calls are completed.

**Format**

The file name format for the daily `CDR-YYMMDD.HHMMSS.log` file is where

- YY, MM, and DD are zero-padded character strings that represent the year, month, and day of the date when the file was created.
- HH, MM, and SS are zero-padded character strings that represent the hour, minute, and second of the time when the file was created.

Call records are entered in the log file in the order of when the call was completed and not when it began.
It is the responsibility of the third-party reporting application to delete the daily log files.

The format of the record is column based, must be justified correctly, and end with a carriage return and line feed. A single blank character is inserted between each data field for readability. Table 121 provides information about elements in the CDR text file.

**Table 121: CDR Text File Field Definitions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Column</th>
<th>Length</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call ID</td>
<td>1</td>
<td>10</td>
<td>A unique ID that represents the call. The Call ID is meant to be unique for the duration while it’s active.</td>
</tr>
<tr>
<td>Date</td>
<td>12</td>
<td>10</td>
<td>Date of the call given in month, day, and year: mm/dd/yyyy</td>
</tr>
<tr>
<td>Time</td>
<td>23</td>
<td>8</td>
<td>Start of the call given in hours, minutes, and seconds: hh:mm:ss</td>
</tr>
<tr>
<td>Extension</td>
<td>32</td>
<td>16</td>
<td>Inbound or outbound extension ID. Last valid party on the call. Valid parties include user extension and operator but not voice mail or auto-attendant.</td>
</tr>
<tr>
<td>Duration</td>
<td>49</td>
<td>8</td>
<td>Call duration given in hours, minutes, and seconds. hh:mm:ss</td>
</tr>
</tbody>
</table>
| Call Direction | 58 | 1 | Incoming/outgoing flag  
|             |        |        | 0 – Incoming  
|             |        |        | 1 – Outgoing  
|             |        |        | 2 – Tandem Trunking – Inbound Tandem Call   |
| Dialed Number | 60 | 16 | Contains the number dialed but does not include any access code, such as 9, to seize the trunk. Valid only for outbound calls. |
| Caller ID   | 77     | 16     | Blocked or unavailable information will be reported as blocked or unavailable in text. Valid only for incoming calls. |
| Trunk Member| 94     | 4      | The Port ID of the trunk.                                              |
| Trunk Group | 99     | 3      | The Trunk group ID.                                                    |
| Account Code| 103    | 20     | The account code entered by the caller.                                 |
| CR /LF     | 124    |        | Carriage return.                                                       |
Call Detail Records provide a complete logging of all non "Private" calls placed in or out of the ShoreTel system. These logs include call volume, call origination, call destination and the length of each call.

The Talk Time Enhancement feature increases the usability of log data from the Call Detail Records by compiling only the actual time spent in a conversation between the calling parties. All call ring back time is eliminated from the Call Detail Records retaining only the actual Talk Time spent on the call.

When a call is placed the destination phone acknowledges and a ring tone is provided to both parties. The time of the call starts on the first ring and terminates when the calling parties hang up. The ShoreTel Appliance uses the Telephony Management Service (TMS) to report the call and it's the time to the HQ server. There the call is captured in the Call Detail Records. The entire length of the call is logged here, including the first ring up to the entire call tear down.

Talk Time Enhancements uses the FarEndAnswered event provided by certain trunks to determine when the called party answers the call. The length of time the call has been answered is reported to the CDR. If you choose to include unanswered calls in the CDR, these calls are reported with a duration of zero. For information about including unanswered calls in the report, see Reporting Options on page 771.

Calls placed over Digital Wink, PRI, BRI or SIP trunks support FarEndAnswered events. These events mark the moment when the called party answers the call. Talk Time Enhancement uses this event to report the Talk Time of the call to the Call Detail Records. The Call time represents only the actual Talk Time of the call. Calls over Analog loop start and Digital loop start trunks do not support FarEndAnswered events. These calls still report to the CDR through TMS, but their time values include the time for Ring Back.

As administrators evaluate CDR reports, an understanding of the trunk types that support Talk Time Enhancement helps them to gain an accurate picture of the talk time being reported in the CDR.

The system supports CDR records and related queries in a MySQL database. The maximum MySQL database size is 64 terabytes (TB). The maximum size of a database table is 2 TB.

The data in the MySQL files can be viewed using a new Web-Based Reporting feature from ShoreTel Director. (See the Accessing the Call Details Reports Page on page 768 for more information.) Alternatively, administrators can use common database command utilities in a command line interface to dump and restore files.

ShoreTel Director provides the access for generating CDR reports, as Accessing the Call Details Reports Page on page 768 describes.

ShoreTel Director also lets you start, stop, and monitor the health status of MySQL databases. To do so, navigate to Maintenance > Services and then select MySQL in the table on the Services page.
Compatibility and Pre-Configuration Requirements

This section describes the issues that an administrator must understand and accommodate before installing or upgrading the MySQL databases.

Disk Space Requirements

Storing call detail records for 50,000 workgroup calls requires a 1.5 GB MySQL database. Implementing a database of this size typically requires 4.0 GB of disk space. This requirement includes disk space for the main database (1.5 GB), the archive database (1.5 GB), and temporary space required to generate reports (1.0 GB).

Although the main and archive databases are typically stored on the same server, MySQL permits the storage of the databases on different servers.

Compatibility with Utility Programs

ShoreTel should run on a dedicated server. Other programs that access MySQL databases might not be compatible with ShoreTel, resulting in installation and data integrity issues. Before installing ShoreTel on a server, remove all existing MySQL programs and databases.

Virus Checkers: Virus checker utilities that run on the server must exclude MySQL database files. Specifically, if a virus checker is running on the server, it must exclude the MySQL CDR Database file from the anti-virus utility (wherever ShoreLine Data installed, such as \Shoreline Data\Call Records 2\Data\ibdata1, ib_logfile0, ib_logfile1). If these files are not in the exclusion list, the MySQL service stops.

Disk or Backup utilities: MySQL database files must be excluded from all disk or backup utilities running on the server. Failure to exclude the database causes a MySQL failure.

To restart the database after a failure, access the MySQL Service page from ShoreTel Director by selecting Maintenance > Services in the menu page and then selecting ShoreTel MySQL in the table on the Services page.

Archival and Backup Utilities

This section introduces the database archival, backup, and replication tools. Table 122 summarizes the service availability for these features.

<table>
<thead>
<tr>
<th>Field</th>
<th>Backup</th>
<th>Archive (Secondary Server)</th>
<th>Replication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Assistance Support</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Additional MySQL License Required</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Execution</td>
<td>Manual</td>
<td>Daily</td>
<td>Online</td>
</tr>
</tbody>
</table>
Record Retention Periods

In the Reporting Options page, you can specify the number of days that a database keeps a Call Detail Record. To access the Report Options page, navigate to Reporting > Options in ShoreTel Director (Figure 252). The default for each of the following parameter is 125 days.

- **Retention Period for CDR Data** specifies the number of days that records remain in the main CDR database. The system deletes the oldest records from the archive database each day.

- **Retention Period for CDR Archive** specifies the number of days that records remain in the MySQL archive database on a secondary server. The system deletes the oldest records from the archive database each day.

<table>
<thead>
<tr>
<th>Field</th>
<th>Backup</th>
<th>Archive (Secondary Server)</th>
<th>Replication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports run on remote machine</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Complete restoration if HQ fails</td>
<td>Yes</td>
<td>Possible through manual recovery</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Figure 252: Reporting Options Page**

Database Archive Utility

The archive utility provides a method of removing older records from the main database and storing them in an archive database. Archiving older records into a separate database reduces the storage requirements of the main database, which reduces the time required to search for specific records or generate reports. The archived database provides the same set of services as the main database.

Archival services are configured and enabled in ShoreTel Director, where you can specify the number of days that records are maintained in the main database and in the archive database. When archiving is enabled, archival services are performed daily. The archival service copies records to the archive database that exceed the main database age limit, then removes those records from the main
A sample implementation sets a 30 day limit on the main database and a 365 day limit on the archive database. In this case, the main database contains records for calls handled during the past 30 days while the archive database contains records for calls handled during the past 365 days.

Creating an archive database:

1. Run MakeCDRArchive –d databasename, where databasename is the name of the archive database to be created.
2. Access the Reporting Options page in ShoreTel Director (Reporting | Options from the Menu page) to configure ShoreTel to access the archive database.

**Database Backup Utility**

The Backup utility creates a copy of a database. The copy can be restored at a later time and at a different location. The Backup utility differs from the Archival utility as follows:

- Archiving is configured once then performed daily. Backups are performed only when a command is executed.
- Archival operations are configured from ShoreTel Director. Backups are performed from the command line.
- Archive databases can be accessed directly to generate reports. Backup databases must be restored before performing search and report generation tasks.

Backup and Restore operations can be performed without shutting down the MySQL service. Performing these operations during off peak hours reduces the execution time and the impact on other system services.

The file located at “\Program Files\Shoreline Communications\Shoreware Server\MySQL\MySQL Server 5.0\Examples\dump1.bat” is an example of a batch file that backs up a MySQL CDR database under generic default conditions. This file can be used as a template for creating a batch file that backs up the database under specific conditions. The password is shorewaredba. Backing up a 1.5 GB database requires 200 seconds.

Search at [http://dev.mysql.com](http://dev.mysql.com) for MySQL backup tools, add-ons, and documentation.

**Database Restore Utility**

Restoring a database copies the records in the backup database file to the database specified in the restore command. Records in the backup file that are duplicates of records in the target database are listed in the log file and are not restored.
The file located at “C:\Program Files\Shoreline Communications\Shoreware Server\MySQL\MySQL Server 5.0\Examples\restore1.bat” is an example of a batch file that restores a MySQL CDR database under generic default conditions. This file can be used as a template for creating a batch file that restores the database under specific conditions. The password is “shorewaredba.” Restoring a 1.5 GB database typically takes 1200 seconds.

Database Replication

MySQL provides a Database Replication tool. For information, see the following websites:

- http://www.howtoforge.com/mysql_database_replication provides information for setting up the replication of MySQL databases.

Installing and Upgrading MySQL Archive and ODBC Connector on a Secondary Server

ShoreTel supports the archiving of MySQL databases on a secondary server (separate from the Headquarters server). This section describes how to:

- Install and activate an archive of the CDR database on a secondary server
- Upgrade the archive on a secondary server to MySQL 5.1 (in the current release)

For a new MySQL installation, the tasks are as follows:

- Install the MySQL database on the secondary server.
- Specify that database as an archive.

Although similar to a new installation, the upgrade of the archive, from MySQL 5.0 to 5.1, for example, has additional tasks.

To conserve resources on the main server, the most logical place for an archive database is a secondary server (although the archive can also exist on the main ShoreTel server). For the current release of ShoreTel software, a separate, licensed copy of MySQL Enterprise Server 5.1 is the requirement for a new ShoreTel system or an upgrade of the database that exists on a secondary server.

Installing MySQL on a Secondary Server

To install MySQL on a secondary server, perform the steps that follow. In these steps, replace the default location of C:\Program Files (x86)\... with the location on the server of the installed MySQL id the location is different from the default.
In general, this task includes the following details:

- The type of installation is Custom (for specifying individual features).
- Changing the default User ID from "root" to the customer’s preference.
- Changing the default password from "shorewaredba" to the customer’s preference.
- Specifying the UTF8 character set as part of the installation.
- Specifying port 4309 and it specifying pacing the port in firewall exception list.

**Note**
For the current release of the ShoreTel system, the version of MySQL to install on the secondary server is MYSQL Server 5.1.46 (mysql-essential-5.1.46-winx64).

1. Begin the installation by navigating to the following default location or to an alternative of the customer’s choosing:

   C:\Program Files (x86)\Shoreline Communications\ShoreWare Server\MySQLCDR\MySQL Server.

   If the MySQL folder is a location other than this default, navigate to that location.

2. Click **Install** to launch the installation wizard. The first window to appear is the Welcome window (Figure 253). It shows the version of MySQL to install.

3. Click **Next** in the Welcome window. The installation wizard presents the choices for the type of installation.

4. Select the default option and then click **Next**.

**Note**
While installing MySQL on the secondary server, use the default MySQL installation options unless otherwise specified in this Administration Guide.
Figure 253: MySQL Install Wizard Welcome

Figure 254: Selecting a Setup Type of “Custom”
Installing MySQL on a Secondary Server

Figure 255: Identifying Location for C/C++ Files and Lib Files

Figure 256: Subscribing to MySQL Enterprise
Figure 257: Setup Wizard Completed

Figure 258: Selecting Detailed Configuration for MySQL Instance
5. Click Next.

6. Back up the file to C:\Program Files\MySQL\MySQL Server 5.0\my.ini from the Secondary server to a safe location (C:\MySQL_backup, for example).

7. Back up the files C:\Program Files\MySQL\MySQL Server 5.0\Data\[ib_logfile*] from the Secondary server to a safe location (C:\MySQL_backup, for example).

8. Select Start > Administrative Tools > Services > MySQL on the server.

9. Click Stop the service and check that MySQL service status is blank.

10. Compare the following values of specific fields in the archive_MySQL_my.ini file from the Main server directory with the secondary server's my.ini file:

    Main server directory—C:\Program Files\Shoreline Communications\ShoreWare Server\MySQL\MySql Server 5.1\Examples\archive_MySQL_my.ini

    Secondary server file— C:\Program Files\MySQL\MySql Server 5.1\my.ini

Make sure that all the values in the archive_MySQL_my.ini are appropriate and update the same values to my.ini file of the secondary server. The archive_MySQL_my.ini values should be:

```
[mysql]
default-character-set – utf8

[mysqld]
```
default-character-set – utf8

tmp_table_size – 30M

key_buffer_size – 2M

read_buffer_size – 2M

read_rnd_buffer_size – 2M

sort_buffer_size – 2M

innodb_additional_mem_pool_size – 2M

innodb_flush_log_at_trx_commit – 0

innodb_file_per_table

innodb_log_buffer_size – 5M

innodb_buffer_pool_size – 150M

innodb_log_file_size – 24M

default-storage-engine – INNODB

11. Delete the file `ib_logfile*` from the Secondary server directory (C:\Program Files\MySQL\MySQL Server 5.0\Data).

12. Be sure that the value for `innodb_flush_log_at_trx_commit – 0` on the secondary server (C:\Program Files\MySQL\MySql Server 5.0).

Note

If the value is not 0, the archiving operation is more than 20 times slower.

13. Select Start > Administrative Tools > Services > MySQL

14. Click Restart the service and verify that MySQL has returned to service.

To convert the database on the secondary server into an archive database:

1. Verify the following files are placed in an equivalent location on the Secondary Server to that on the Main servers (default location is \Shoreline Communications \Shoreware Server):

   - Archive.ini
   - MakeCDR.dll
   - MakeCDR.sql
   - MakeCDR_sp.sql
   - MakeCDRArchive.exe
2. Run `MakeCDRArchive -d databasename`, where `databasename` is the name for the archive.

   Navigate to Reporting -> Options to specify the name of the archive database.

Performance Tuning for Report Generation

When improving on the CDR report generation performance, increase `INNODB_BUFFER_POOL_SIZE` defined in C:\windows\my.ini based as specified:

Default setting:

- `INNODB_BUFFER_POOL_SIZE` – 150 MB

If the database contains more than 350,000 records, set:

- `INNODB_BUFFER_POOL_SIZE` – 200 MB

If the database contains more than 500,000 records, set:

- `INNODB_BUFFER_POOL_SIZE` – 250 MB

Report Generation Time – CPU Utilization

The time to display a report from the first page to the last page can take up to ten minutes (for the largest possible report). Although the priority of Report Generation process is low, generating large reports can affect the performance of call processing. To avoid performance degradation, do not generate large CDR reports during peak call loads.

MySQL CDR Database and Internationalization

MySQL CDR Database supports the UTF-8 character set. All CDR data in the database is stored in the UTF-8 character set.

Monitor MySQL service

To monitor and, when necessary, restart the MySQL service from ShoreTel Director, access the Services page by selecting Maintenance | Services in the menu page, then select MySQL in the table on the Services page.

Note

Before you run `MakeCDRArchive.exe`, install the MySQL 5.1.5 ODBC connector software.
Tools for browsing MySQL database tables

MySQL provides MySQL Query Browser as part of their GUI Tools (http://dev.mysql.com/doc/query-browser/en/gui-tools-upgrade.html). MySQL Query Browser can be used to browse and view the queries. The open source tool (http://www.webyog.com/en/downloads.php) is available to view the CDR tables defined in MySQL.

Browsing a large CDR database on the Main server may potentially degrade the call processing server.

Large amount of temporary disk space may be used by these MySQL browser tools. To avoid affecting call processing performance on HQ, a query with LIMIT criteria can be used to show a subset of rows.

Restrictions in the Number of Records Returned by the MySQL CDR Query

A CDR database query that exceeds 300,000 records might degrade performance if it includes certain reports, such those for Trunk Activity Detail and Trunk Activity Summary. Increasing the amount of free disk space can reduce this problem. Changing the query filter so the number of returned records is under 300,000 can also help.

CDR Reports

A new ShoreTel system includes 12 CDR reports that it can generate by using data from the CDR database on the ShoreTel server. CDR reports present information about users, trunks, WAN links, workgroup queues, account codes, and workgroup agents. The two categories of reports are summary and detail.

Summary reports provide a high-level view of the activity that occurred in a particular area, and detail reports provide a detailed view of activity. The most common use of the summary report is to identify discrepancies or problems. The detail report uncovers specific information.

- User Activity Summary: Summarizes all calls for each user.
- User Activity Detail: Lists every call for each user.
- Trunk Activity Summary: Summarizes all calls for each trunk.
- Trunk Activity Detail: Lists every call for each trunk.
- Workgroup Agent Summary: Summarizes all inbound workgroup calls for each agent. The workgroup queue report has only a summary report.
- Workgroup Agent Detail: Lists every inbound workgroup call for each agent and optionally, outbound calls. Non-workgroup calls for the agent are also reported.
- Workgroup Queue Summary: Summarizes queue activity for every workgroup, including calls that went directly to agents.
- Workgroup Service Level Summary: Summarizes data on call processing by the workgroup server.
- WAN Media Stream Summary: Summarizes media stream traffic and call quality for calls made over the WAN in multi-site deployments.
- WAN Media Stream Detail: Lists media stream made over the WAN in multi-site deployments.
- Account Code Summary: Summarizes call information for each account; counts of calls each day, along with their total and average duration. There are also totals for the reporting period.
- Account Code Detail: Provides a detailed list of calls that occurred for each account. For each call the date/time of the call, number dialed, the extension making the call and the duration of the call is included. For each account, a summary is provided of the number of calls, along with their total and average duration.

**TMS-CDR Media Stream Statistics**

The TMS-CDR Media Stream Statistics feature offers a method of formatting and storing Call Detail Records (CDR) data on media streams and stores that formatted information into a log file on the system, making it easier for the ShoreTel system to integrate with various third-party SNMP monitoring tools, and enabling users to acquire a more accurate picture of the traffic patterns in their network. This information can be useful in performing load analysis, identifying peak traffic times, and assisting the customer in setting up competitive pricing strategies.

The system processes media statistics for all calls and formats the raw data into separate lines, with each line partitioned into several columns separated by a comma. Formatted data is then saved in a text file and is subjected to appropriate rollovers similar to the other ShoreTel server logs.

One media stream statistic record will be generated for each RTP stream on a call. Thus, a 3-way fully-meshed conference call would generate 6 records.

**Formatting**

Media statistics are collected and deposited line by line into a file. A delimiter separates one column from the previous one, with no delimiter prior to the first column and none after the last column. The column values will be left-justified and padded with spaces to the right. A value that exceeds the fixed-width column limit will be truncated so that it fits within the limit.

Each line looks like the following line:

- `value-1,value-2,value-3,...,value-n`

The Table 123 summarizes the details of the individual columns.
### Table 123: CDR Media Stream Statistics Formatting

<table>
<thead>
<tr>
<th>Column number</th>
<th>Type</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Integer</td>
<td>20</td>
<td>ID of the line in decimal</td>
</tr>
<tr>
<td>2</td>
<td>String</td>
<td>20</td>
<td>Extension Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For anonymous calls, extension number is not available. In such cases, an empty string will be placed at this column.</td>
</tr>
<tr>
<td>3</td>
<td>String</td>
<td>16</td>
<td>Name of Extension or Trunk or Phone (UTF-8)</td>
</tr>
<tr>
<td>4</td>
<td>Integer</td>
<td>2</td>
<td>Party type, decimal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 Unknown</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 Station</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 Trunk</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 Virtual</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 Workgroup</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 AutoAttendant</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 VMForward</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7 VMLLogin</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8 BackupAA</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9 Anonymous Phone</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10 Nightbell</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>11 Paging</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>12 Workgroup Agent</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>13 Unknown</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>14 RoutePoint</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>15 ACC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>16 Hunt Groups</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>17 Group Paging</td>
</tr>
<tr>
<td>4</td>
<td>Integer</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>String</td>
<td>32</td>
<td>SIP Call ID</td>
</tr>
<tr>
<td>6</td>
<td>String</td>
<td>16</td>
<td>Local IP Address (Switch, Trunk Switch, or IP Phone etc.) in dotted decimal form</td>
</tr>
<tr>
<td>7</td>
<td>String</td>
<td>16</td>
<td>Remote IP Address (Remote end point. Switch or Trunk or IP Phone etc.) in dotted decimal form</td>
</tr>
</tbody>
</table>
This feature applies only on the main (headquarter) ShoreTel server. By default, it is disabled. Enabling the TMS-CDR Media Stream Statistics feature requires making the appropriate changes to the registry settings.

Table 123: CDR Media Stream Statistics Formatting (Continued)

<table>
<thead>
<tr>
<th>Column number</th>
<th>Type</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Integer</td>
<td>20</td>
<td>Local Site ID (Site ID of extension or trunk or phone that generated starts)</td>
</tr>
<tr>
<td>9</td>
<td>String</td>
<td>16</td>
<td>Local Site Name (UTF-8)</td>
</tr>
<tr>
<td>10</td>
<td>Integer</td>
<td>3</td>
<td>Code Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 ALAW, PCMA/8000 (or G711A)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 MULAW, PCMU/8000 (or G711µ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 LINEAR, L16/16000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 ADPCM, DVI4/8000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 G729A, G729A/8000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 G729B, G729B/8000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7 LINEAR, WIDEBAND, L16/16000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8 G722, G722/8000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9 BV32, BV32/16000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10 BV16, BV16/8000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>11 AAC_LC32000, AAC_LC/32000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>12 CustomCodec added by administrator</td>
</tr>
<tr>
<td>11</td>
<td>Integer</td>
<td>10</td>
<td>Payload size (in milliseconds)</td>
</tr>
<tr>
<td>12</td>
<td>Integer</td>
<td>2</td>
<td>Status code</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 – Norma</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 – Failure</td>
</tr>
<tr>
<td>13</td>
<td>String</td>
<td>12</td>
<td>Starting time of the collection in string HH:MM:SS.MSEC format</td>
</tr>
<tr>
<td>14</td>
<td>Integer</td>
<td>20</td>
<td>Number of seconds of this collection, in decimal.</td>
</tr>
<tr>
<td>15</td>
<td>Integer</td>
<td>20</td>
<td>Number of received packets</td>
</tr>
<tr>
<td>16</td>
<td>Integer</td>
<td>20</td>
<td>Number of lost packets</td>
</tr>
<tr>
<td>17</td>
<td>Integer</td>
<td>20</td>
<td>Max jitter</td>
</tr>
<tr>
<td>18</td>
<td>Integer</td>
<td>20</td>
<td>Underruns</td>
</tr>
<tr>
<td>19</td>
<td>Integer</td>
<td>20</td>
<td>Overruns</td>
</tr>
</tbody>
</table>
WARNING!
Do not make changes to the registry settings unless you are certain of what you are doing!

1. Click **Start** and select **Run**.

2. Select the **regedit** application to display a window similar to the one shown in Figure 260.

3. Navigate to `SOFTWARE\Shoreline Teleworks\Call Accounting`.

4. Double-click the file named **LogMediaStatsToFile** to open the Edit DWORD Value dialog box shown in Figure 261.
5. Type 1 in the Value data field.

6. Click OK to store changes and enable this feature.

Generating CDR Reports

Refer to Accessing the Call Details Reports Page on page 768 for instructions on generating CDR Reports. As that chapter section warns, the system allows a maximum of five simultaneous report generations.

Interpreting CDR Reports

This section provides information on interpreting each of the 12 CDR reports.

User Activity Summary Report

The User Activity Summary Report (Figure 262) shows a summary of all inbound and outbound calls for each user. This includes the type of calls made, as well as the total duration for all calls. This report can be run as an interval report in which user activity is subtotaled by the selected interval. Additionally, the summary can be run for selected extensions.
The User Activity Summary Report always displays External Calls and can be configured to display Internal Calls. External calls are those calls where the record in the Call table has a CallType of 2 (Inbound) or 3 (Outbound).

**Name (Extension Field)**

For outbound calls, the Name (Extension) field of the Call record always reports the party that initiated the call.

Inbound calls are reported according to the last party involved in the call (excluding voice mail and the auto-attendant). For example, if a call to extension 320 is not answered and the user’s Call Handling Mode (CHM) forwards the call to the assistant at extension 452—who answers the call—the Extension field in the Call record contains 452.

When an inbound call is forwarded to voice mail, the Name (Extension) field records the party involved in the call before it was forwarded to voice mail. For example, if a user with extension 320 doesn’t answer a call and his or her Call Handling Mode (CHM) forwards the call to voice mail, the extension field is set to 320.

The User Activity Summary Report is described in Table 124.
<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (Extension)</td>
<td>Once for each</td>
<td>The name of the user, last name first. Users without a last name are presented first. Non-users such as Workgroups, Voice Mail, Voice Mail Login, and Auto-attendant are included in the report. The names for these extensions are reported for calls that only interact with these extensions (not a user extension). Like many other non-user extensions, the ShoreTel Audio Conference extension and Route Points are also not displayed.</td>
</tr>
<tr>
<td></td>
<td>extension reported.</td>
<td></td>
</tr>
<tr>
<td>Inbound All</td>
<td>Once for each</td>
<td>The quantity, total duration, and average duration for inbound calls during the reporting period are presented. A call is considered inbound if the CallType field of the Call table record is set to 2 (Inbound). If the report is run with intervals, the call is only reported for the interval in which it started, even if it ends in a different interval. The StartTime field in the Call table is used to determine when the call started. Duration represents that extensions time on the call. This is found in the Connect table record's Duration field for this connection (where the Connect.CallTableID matches the Call.ID and Connect.PartyID matches Call.Extension). Since a call is reported during the period in which it starts, but may end during another interval, the duration can be longer than the 30-minute interval period—the total call duration time is reported during the interval in which the call begins. Total Duration during any period is the sum of the duration for the Inbound calls during the period. Average duration is found by dividing this total by the number of calls during the period.</td>
</tr>
<tr>
<td>All - Qty, Duration,</td>
<td>period reported.</td>
<td></td>
</tr>
<tr>
<td>Average Duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outbound All</td>
<td>Once for each</td>
<td>The quantity, total duration, and average duration for Outbound calls during the reporting period are presented. A call is considered outbound if the CallType field of the Call table record is set to 3 (Outbound). Duration is calculated here in the same manner as for Inbound calls. Please see that description for details.</td>
</tr>
<tr>
<td>All - Qty, Duration,</td>
<td>period reported.</td>
<td></td>
</tr>
<tr>
<td>Average Duration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total All - Qty</td>
<td>Once for each</td>
<td>The quantity, total duration, and average duration of all calls during this period. This simply represents both the Inbound and Outbound columns. Inbound and Outbound quantity and total duration are added together and then averaged.</td>
</tr>
<tr>
<td>Qty</td>
<td>period reported.</td>
<td></td>
</tr>
<tr>
<td>Outbound Non-Local Trunk -</td>
<td>Once for each</td>
<td>The quantity, total duration, and average duration for Outbound non-local calls during the reporting period are presented. A call is considered outbound if the CallType field of the Call table record is set to 3 (Outbound). A call is considered Non-Local if the LongDistance field in the Call table is set to true. This flag indicates whether or not the call was long distance from the perspective of the trunk that was used for the call. The calls reported here, are a subset of the calls reported under Outbound all. Duration is calculated in the same manner as for Inbound calls. Please see that description for details.</td>
</tr>
<tr>
<td>Qty</td>
<td>period reported.</td>
<td></td>
</tr>
</tbody>
</table>
The User Activity Detail Report (Figure 263) shows a list of every call for each user by user. This includes the time a call was received or made, the number dialed, and the trunk used. This report can be run as an interval report in which user activity is sub-totaled by the selected interval.

**Outbound WAN Trunk- Qty**

The quantity, total duration, and average duration for Outbound non-local calls during the reporting period are presented. A call is considered outbound if the CallType field of the Call table record is set to 3 (Outbound). A call is considered a WAN call if a media stream was established between 2 sites. This is determined by looking in the MediaStream table for any records of media stream for this call (the MediaStream CallID will equal the CallID in the Call table record for the call.

The calls reported here, are a subset of the calls reported under Outbound all. Duration is calculated here in the same manner as for Inbound calls. Please see that description for details.

**Grand Total**

The totals for all the users in the system.

**Note**

Conference calls that use a ShoreTel conferencing device have two entries in the User Activity Detail Report. The first entry shows the amount of time (duration) used to enter a pass code or user prompt. The second entry shows the duration of the entire conference call.
Calls Included

The User Activity Detail Report always displays External Calls and can be configured to display Internal Calls. External calls are those calls where the record in the Call table has a CallType of 2 (Inbound) or 3 (Outbound).

By default, all specified calls that have at least one leg with a TalkTime greater than zero are included in the report. You can also select to include unanswered calls in the report. Unanswered calls are displayed with a TalkTime of zero. For information about including unanswered calls in the report, see Reporting Options on page 771.

Name (Extension Field)

For outbound calls, the Name (Extension) field of the Call record always reports the party that initiated the call.

Inbound calls are reported according to the last party involved in the call (excluding voice mail and the auto-attendant). For example, if a call to extension 320 is not answered and the user’s Call Handling Mode (CHM) forwards the call to his or her assistant at extension 452 who answers the call, the Extension field in the Call record contains 452.

When an inbound call is forwarded to voice mail, the Name (Extension) field records the party involved in the call before it was forwarded to voice mail. For example, if a user with extension 320 doesn't answer a call and his or her Call Handling Mode (CHM) forwards the call to voice mail, the extension field is set to 320.

The User Activity Detail Report is described in Table 125.

Table 125: User Activity Detail Report Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (Extension)</td>
<td>Once for each extension reported.</td>
<td>The Last Name, First Name, and Extension being reported upon. These come from the PartyIDLastName, PartyIDName, and PartyID for the Connect record that matches the extension in the Call table. Non-users such as Workgroups, Voice Mail, Voice Mail Login, and Auto-attendant are included in the report. The names for these extensions are reported for calls that only interact with these extensions (not a user extension). Like many other non-user extensions, the ShoreTel Audio Conference extension is also not displayed.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Once for each call reported.</td>
<td>The date and time when the call being reported started. These fields come from the StartTime field in the Call table record for the call being reported. When interval reports are generated, the actual time the call started is reported even if the call continues into another interval.</td>
</tr>
</tbody>
</table>
Table 125: User Activity Detail Report Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
</table>
| In/Out               | Once for each call reported. | Indicates if the call is inbound/outbound/internal/external.  
If the CallType field of the Call record for the call is 2 (Inbound), **In-Int** is displayed for internal calls and **In-Ext** for external calls.  
If the CallType is 3 (Outbound), **Out-Int** is displayed for internal calls and **Out-Ext** is displayed for external calls.  
ShoreTel Audio Conference Service calls in which the service calls the user, **In-Int** is displayed. |
| WG (Workgroup)       | Once for each call reported. | The Workgroup field of the Call record for the call is examined. “Yes” or “No” is displayed depending upon whether or not the field indicates a workgroup call. |
| WAN-VPN-Secured      | Once for each call reported. | To avoid duplicate calls, WAN and VPN information should be disabled by enabling the registry key. Once the registry key is enabled, only Secured information will display.  
The registry key is:  
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Shoreline Teleworks\Call Accounting\CDR\UserActivityWANFlag  
DWOD set to 0 for displaying Secured and st 1 for displaying WAN-VPN-Secured. |
A call is considered a WAN call if a media stream was established between 2 sites. This is determined by looking in the MediaStream table for any media stream records for this call. The MediaStream CallID will equal the CallID in the Call table record for the call.

Based on the CDR data, the following are displayed:

- “Y” or “N”
  (Y – Yes; N – No)
- “S” or “NS”
  (S – Secure; NS – Not Secure)
- “N-S” or “Y-S”
  (N-S – No, Secure; Y-S – Yes, Secure)
- “N-NS” or “Y-NS”
  (N-NS – No, Not Secure; Y-NS – Yes, Not Secure)
- “N-VPN-S” or “Y-VPN-S”
  (N-VPN-S – No, Virtual Private Network, Secure)
  (Y-VPN-S – Yes, Virtual Private Network, Secure)
- “N-VPN-NS” or “Y-VPN-NS”
  (N-VPN-NS – No, Virtual Private Network, Not Secure)
  (Y-VPN-NS – Yes, Virtual Private Network, Not Secure)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAN</td>
<td>Once for each call reported.</td>
<td>A call is considered a WAN call if a media stream was established between 2 sites. This is determined by looking in the MediaStream table for any media stream records for this call. The MediaStream CallID will equal the CallID in the Call table record for the call. Based on the CDR data, the following are displayed: “Y” or “N” (Y – Yes; N – No) “S” or “NS” (S – Secure; NS – Not Secure) “N-S” or “Y-S” (N-S – No, Secure; Y-S – Yes, Secure) “N-NS” or “Y-NS” (N-NS – No, Not Secure; Y-NS – Yes, Not Secure) “N-VPN-S” or “Y-VPN-S” (N-VPN-S – No, Virtual Private Network, Secure) (Y-VPN-S – Yes, Virtual Private Network, Secure) “N-VPN-NS” or “Y-VPN-NS” (N-VPN-NS – No, Virtual Private Network, Not Secure) (Y-VPN-NS – Yes, Virtual Private Network, Not Secure)</td>
</tr>
</tbody>
</table>
### Table 125: User Activity Detail Report Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
</table>
| User Activity Time Stamp     | Once for each call reported. | Indicates the user action taken with the time stamp in HH:MM:SS 12-hour format. For instance, the action taken by the user can be one of the following:  
- Originate: The user initiated the call or conference.  
- Called: The user received the call or joined the conference after the host.  
- Pick up: The user answered the call.  
- ForwardNoAnswer: The call was forwarded without being answered by the user.  
- Transfer: The call was transferred to another user.  
- ForwardAll: The user chose to forward all calls.  
- WGA Agent: The user was an agent for the workgroup.  
- Unpark: The user unparked the receiver.  
- Conference: The user joined the conference call.  
- SilentCoach: The user was silent on the call.  
- Parked: The user was parked.  
- SilentMonitor: The user was silently monitoring a call between two or more users. |
| Dialed #                     | Once for each call reported. | For outbound calls, this is the number the user dialed and is reported in full, canonical format (including country code). For inbound calls, this is the destination of the call. If the call was a DID or DNIS call, this is the DID or DNIS information for the number dialed. For other types of calls, this is the extension where the call first terminates. The dialed number is retrieved from the Dialed Number field of the Call table record for the call. For ShoreTel conferences, the dialed number is the same as the number the first user dialed to join the conference. |
| Calling #                    | Once for each call reported. | For inbound calls, this is the calling number—ANI or Caller ID—received by the ShoreTel system and is reported as delivered by the PSTN (may or may not include the 1 in front of the area code). The dialed number is retrieved from the CallerID field of the Call table record. For outbound calls, this is the extension of the user that placed the call. In the case of Outbound calls, this data is retrieved from the PartyID field of the Connect record for the party that initiated the call. For ShoreTel conferences, the calling number is the same as the number the first user called from to join the conference. |
The Trunk Activity Summary Report (Trunk Activity Summary Report on page 831) shows a summary of all calls for each trunk by trunk group. This includes the type of calls, durations, and average durations made on each trunk.

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/ Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk</td>
<td>Once for each call reported.</td>
<td>This is the first trunk that was used for the call. This data is retrieved from the PortName field of the Connect record for the trunk’s involvement in the call.</td>
</tr>
<tr>
<td>Duration</td>
<td></td>
<td>The duration of the call at the indicated extension. Duration is from the time media is established till it ends. Ring time is not considered in IN/OUT calls. Duration should match Talktime+Hold time (if talk time is non-zero value) This applies to all the reports. This data is retrieved from the Duration field of the Connect table’s record for this connection (where the Connect.CallTableID matches the Call.ID and Connect. PartyID matches Call.Extension).</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>The total number of calls, total duration, and average duration for the user.</td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td>The total number of calls, total duration, and average duration for all users.</td>
</tr>
</tbody>
</table>

**Trunk Activity Summary Report**

The Trunk Activity Summary Report (Trunk Activity Summary Report on page 831) shows a summary of all calls for each trunk by trunk group. This includes the type of calls, durations, and average durations made on each trunk.

![Trunk Activity Summary Report](image.png)

*Figure 264: Trunk Activity Summary Report*
Calls Included

Any trunk activity is reported in the Trunk Activity Summary Report. These calls always have Call records with CallType of 2 (Inbound), 3 (Outbound), or 4 (Tandem). However, with ShoreTel, Release 2.0 and greater, the report is based on the TrunkDirection field in the Connect records representing trunk usage, not the CallType record. There is a 30-day change-over period for upgrades, during which the report reflects both methods of collecting this data.

The Trunk Activity Summary Report is described in Table 126.

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Group Name</td>
<td>Once for each TrunkGroup being reported upon.</td>
<td>This is the name of the TrunkGroup being reported upon. It's retrieved from the GroupName field of the Connect record representing a trunk's involvement in a call.</td>
</tr>
<tr>
<td>Trunk Name</td>
<td>Once for each trunk being reported upon.</td>
<td>The name of the specific trunk used for a call. This is retrieved from the PortName field of the Connect record representing a trunk's involvement in a call.</td>
</tr>
<tr>
<td>Inbound Qty, Duration, and Average Duration</td>
<td>Once for each trunk being reported upon.</td>
<td>The quantity, total duration, and average duration for all inbound trunk activity for this trunk during the reporting period are presented. Trunk activity is considered inbound if the TrunkDirection field in the Connect record is set to 2 (Inbound). The quantity is simply a count of the Connect table records during the reporting period for this trunk that indicate inbound trunk usage. Duration is the sum of all the Duration fields for the Connect table records during the reporting period for this trunk that indicate inbound trunk usage. The average duration is found by dividing this total by the quantity reported here.</td>
</tr>
</tbody>
</table>
Trunk Activity Detail Report

The Trunk Activity Detail Report (Figure 265) shows a list of every call for each trunk by trunk group. This includes the date and time, the number dialed, and the user’s name.

Table 126: Trunk Activity Summary Report Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound Qty, Duration, and Average Duration</td>
<td>Once for each trunk being reported upon.</td>
<td>The quantity, total duration, and average duration for all outbound trunk activity for this trunk during the reporting period are presented. Trunk activity is considered outbound if the TrunkDirection field in the Connect record is set to 3 (Outbound). The quantity is simply a count of the Connect table records during the reporting period for this trunk that indicate outbound trunk usage. Duration is the sum of all the Duration fields for the Connect table records during the reporting period for this trunk that indicate outbound trunk usage. Average duration is found by dividing this total by the quantity reported here.</td>
</tr>
<tr>
<td>Total Qty</td>
<td>Once for each trunk being reported upon.</td>
<td>The total calls for the trunk.</td>
</tr>
<tr>
<td>Duration</td>
<td>Once for each trunk being reported upon.</td>
<td>The total duration of calls, in hours, minutes, and seconds.</td>
</tr>
<tr>
<td>Average Duration</td>
<td>Once for each trunk being reported upon.</td>
<td>The average duration of calls, in hours, minutes, and seconds.</td>
</tr>
<tr>
<td>Total</td>
<td>The totals for all trunks in the trunk group.</td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td>The totals for all trunks in the system.</td>
<td></td>
</tr>
</tbody>
</table>
Calls Included

Any trunk activity is reported in the Trunk Activity Detail Report. These calls always have Call records with CallType of 2 (Inbound), 3 (Outbound), or 4 (Tandem). However, with ShoreTel Release 2.0 and greater, the report is based on the TrunkDirection field in the Connect records representing trunk usage, not the CallType record. There is a 30-day crossover period for upgrades during which the report will reflect both methods of collecting this data.

The Trunk Activity Detail Report is described in Table 127.
### Table 127: Trunk Activity Detail Report Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Group Name</td>
<td>Once for each TrunkGroup being reported upon. If the trunk activity for a TrunkGroup requires more than one page to report, then the name is repeated at the top of each additional page.</td>
<td>This is the name of the TrunkGroup being reported upon. This data is retrieved from the GroupName field of the Connect record representing a trunk's involvement in a call.</td>
</tr>
<tr>
<td>Trunk Name</td>
<td>Once for each TrunkGroup being reported upon. If the trunk activity for a TrunkGroup requires more than one page to report, then the name is repeated at the top of each additional page.</td>
<td>The name of the specific trunk used. This data is retrieved from the PortName field of the Connect record representing a trunk's involvement in a call.</td>
</tr>
<tr>
<td>Date</td>
<td>Once for each trunk activity in the report.</td>
<td>The date is extracted from the ConnectTime field in the Connect record representing the trunk's involvement in the call. This is the date the trunk was added to the call.</td>
</tr>
<tr>
<td>Time</td>
<td>Once for each trunk activity in the report.</td>
<td>The time is extracted from the ConnectTime field in the Connect record representing the trunk's involvement in the call. This is the time the trunk was added to the call.</td>
</tr>
<tr>
<td>In/Out</td>
<td>Once for each trunk activity in the report.</td>
<td>Trunk activity is considered “In” if the TrunkDirection field in the Connect record is set to 2 (Inbound), otherwise it is considered “Out.” When an external user calls the external number of the a service appliance, two records appear in the report, and each record is “In.”</td>
</tr>
</tbody>
</table>
### Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialed #</td>
<td>Once for each trunk activity in the report.</td>
<td>For outbound calls, this is the number the user dialed and is reported in full, canonical format (including country code, etc.). For an inbound call this is the destination of the call. If the call was a DID or DNIS call, this is the DID or DNIS information for the number dialed. For other types of calls, this is the extension where the call first terminates. For inbound calls (CallType – 2 in Call record) this data is retrieved from the DialedNumber field in the Call record. For other calls, it is retrieved from the PartyId field of the Connect record for the trunk activity. Inbound and outbound are relative to the call, not trunk usage.</td>
</tr>
<tr>
<td>Calling #</td>
<td>Once for each trunk activity in the report.</td>
<td>For inbound calls, this is the calling number—ANI or Caller ID—received by the ShoreTel system and is reported as delivered by the PSTN (may or may not include the 1 in front of the area code). For outbound calls, this is the extension of the user that placed the call. For outbound calls (CallType – 3 in Call record) this data is retrieved from the Extension field in the Call record. For other types of calls, it is retrieved from the CallerID field in the Call table. Inbound and outbound are relative to the call, not trunk usage.</td>
</tr>
<tr>
<td>User</td>
<td>Once for each trunk activity in the report.</td>
<td>The name associated with the extension that was the initial target of the call. For outbound calls (CallType – 3 in Call record), the user is the extension that first initiated the call. For inbound calls (CallType – 2 in Call record), the user is the extension that was the initial target of the call. In the case of tandem calls (CallType – 4 in the Call record), nothing is shown. This data is retrieved from the PartyIDName and PartyIDLName fields of the Connect record for the party that initiated the call (ConnectReason – 19, “Originate” for an outbound call) or was the target of the call (ConnectReason – 17, “Called” for inbound call). Inbound and outbound are relative to the call, not trunk usage.</td>
</tr>
</tbody>
</table>
The Workgroup Agent Summary Report (Figure 266) shows a summary of inbound workgroup calls and agent activity by the workgroup.

**Table 127: Trunk Activity Detail Report Field Descriptions (Continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Once for each trunk activity in the report.</td>
<td>The duration of the trunk activity. This data is retrieved from the Duration field of the Connect record for the trunk's involvement in the call. For an inbound call, the duration of the call begins when the trunk is seized and includes the ring time, talk time, and hold time. The duration ends when the user hangs up or when the external party hangs up and disconnect supervision is received by the ShoreTel system. For an outbound call, the duration of the call begins when the trunk is seized. The duration ends when the user hangs up, or when the external party hangs up and disconnect supervision is received by the ShoreTel system.</td>
</tr>
<tr>
<td>Subtotal</td>
<td></td>
<td>The total of calls for the trunk.</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>The total of calls for the trunk group.</td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td>The total of calls for all trunks in the system.</td>
</tr>
</tbody>
</table>

**Workgroup Agent Summary Report**

The Workgroup Agent Summary Report (Figure 266) shows a summary of inbound workgroup calls and agent activity by the workgroup.

**Calls Included**

This report includes calls routed to workgroup agents by the workgroup server, and non-workgroup calls (both inbound and outbound). The report assigns non-workgroup calls to an agent's membership within a workgroup by examining the workgroup the agent was logged into during or before the call. No calls are reported when an agent is logged out. You can find Agent logins by examining the AgentActivity table for records with State – 5 (LogInOut).
Workgroup agents can be a member of more than one workgroup. When they log in, their login time is reported for all workgroups of which they are a member.

Non-workgroup calls are reported against the workgroup with the lowest dial number that the agent is a member of when the call is made. For example, if the agent is a member of workgroups with dial numbers of 1100, 1200, and 1250, non-workgroup calls are reported against 1100.

The StartTimeStamp field in these Agent Activity records represents the time that an agent logged into a specific workgroup (identified by the WorkgroupDN and WorkgroupName fields). The EndTimeStamp field records the time the agent logged out (this can be null when the agent is still logged into the workgroup).

This report is call centric. While it does report agent activity, which consists of agent wrap-up and login time, the report will only show this information for periods during which there was a call for the agent (workgroup or non-workgroup).

**Note**

If you are using on-net dialing, enter the workgroup number with the dash. For example, enter 12-345 instead of 12345. If you do not do this, the generated report can turn up blank, without the required entries.

The Workgroup Agent Summary Report is described in Table 128.

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup Name</td>
<td>Once for each workgroup being reported upon.</td>
<td>The name of the workgroup agent.</td>
</tr>
<tr>
<td>Agent Name</td>
<td>Once for each agent reported upon (within an interval if intervals are selected when running the report).</td>
<td>The name of the agent and his or her extension. These come from the AgentActivity table’s AgentLastName, Agent-FirstName, and AgentDN fields.</td>
</tr>
<tr>
<td>Inbound WG Calls Qty, Duration, and Average Duration</td>
<td>Once for each agent reported upon (within an interval if intervals are selected when running the report).</td>
<td>The quantity, total duration, and average duration for all inbound workgroup calls during the reporting period are presented. Call is considered to be inbound if the CalType is set to 2 (Inbound). The quantity is simply a count of the Connect table records during the reporting period for this workgroup that indicate the call as inbound. Duration is the sum of all the Duration fields for the Connect table records during the reporting period for this workgroup. Average duration is found by dividing this total by the quantity reported here.</td>
</tr>
</tbody>
</table>
Workgroup Agent Detail Report

The Workgroup Agent Detail Report shows a list of every call for each agent by workgroup.
An agent appears in the Workgroup Agent Detail Report if the agent had any workgroup call activity during the reporting period.

**Note**

If you are using on-net dialing, enter the workgroup extension with the dash. For example, enter 12-345 instead of 12345. If you do not do this, the generated report can turn up blank, without the required entries.

**Calls Included**

This report includes calls routed to workgroup agents by the workgroup server, and non-workgroup calls (both inbound and outbound). The report assigns non-workgroup calls to an agent's membership within a workgroup by examining the workgroup the agent was logged into during or before the call. Non-workgroup calls made while an agent is logged out are not reported.

Workgroup agents can be a member of more than one workgroup. When they log in, their login time is reported for all workgroups of which they are a member.

Non-workgroup calls are reported against the workgroup with the lowest dial number that the agent is a member of when the call is made. For example, if the agent is a member of workgroups with dial numbers of 1100, 1200, and 1250, non-workgroup calls are reported against 1100.

You can find agent logins by examining the AgentActivity table for records with State = 5 (LogInOut). The StartTimeStamp field in these AgentActivity records represents the time that an agent logged into a specific workgroup (identified by the WorkgroupDN and WorkgroupName fields). The EndTimeStamp field records the time the agents logged out (this can be null when the agent is still logged into the workgroup).

The Workgroup Agent Detail Report is described in Table 129.
### Table 129: Workgroup Agent Detail Report field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup Name</td>
<td>Once for each workgroup being reported upon.</td>
<td>The name of the workgroup agent.</td>
</tr>
<tr>
<td>Agent Name</td>
<td>Once for each agent reported upon (within an interval if intervals are selected when running the report).</td>
<td>The name of the agent and his or her extension.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>These come from the AgentActivity table's AgentLastName, AgentFirstName, and AgentDN fields.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Once for each call reported.</td>
<td>The date and time for the call being reported. These fields come from the StartTime field in the Call table record for the reported call. When interval reports are generated, the call is reported for the time when it starts even if it continues into another interval.</td>
</tr>
<tr>
<td>Dialed #</td>
<td>Once for each call reported.</td>
<td>For inbound calls, this is the destination of the call. If the call was a DID or DNIS call, this is the DID or DNIS information for the number dialed. For other types of calls, this is the extension where the call first terminates. The number dialed to initiate the call. This comes from the Call record's DialedNumber field.</td>
</tr>
<tr>
<td>Calling #</td>
<td>Once for each call reported.</td>
<td>The caller that initiated the call. For inbound calls, this is the calling number—ANI or Caller ID—received by the ShoreTel system and is reported as delivered by the PSTN (may or may not include the “1” in front of the area code). This comes from the Call table’s CallerID field.</td>
</tr>
</tbody>
</table>
Table 129: Workgroup Agent Detail Report field descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Type</td>
<td>Once for each call reported.</td>
<td>Indicates whether this is an incoming workgroup call (“InWG”), an inbound non-workgroup call (“In”), or an outbound call (“Out”). A call is categorized as an inbound workgroup call if the user joined the call as a workgroup agent. This is determined by examining the Connect record for the user's time on the call. The PartyType in the Connect record must be 12 (Workgroup Agent). A call is categorized as an inbound non-workgroup call if the Call record's CallType – 1 or 2 (internal or inbound), and the user's Connect record has PartyType – 1 (station), and the user was not the originator of the call (ConnectReason in the Connect table not equal to 19-- originate). A call is categorized as outbound if the user originated the call (as shown by the Connect record having ConnectReason – 19). These calls have CallType – 1 or 3 (internal or outbound) in the call record. Note that for all calls, those calls with CallType – 1 (internal) are included only if the option to include internal calls is chosen. Calls that involve multiple legs are also reported as: Transfer—Call was transferred. Conference—Call was conferenced Monitor—Call was monitored Barge-In—Call was barged</td>
</tr>
<tr>
<td>Other Calls</td>
<td>Once for each call reported.</td>
<td>Indicates calls that do not belong to Call Type (i.e. those that are no In, InWG, or Out). This includes: Transfer — Call was transferred. Conference — Call was conferenced Monitor — Call was monitored Barge-In — Call was barged</td>
</tr>
<tr>
<td>Trunk</td>
<td>Once for each call reported.</td>
<td>This is the first trunk that was used for the call. This data is retrieved from the PortName field of the Connect record for the trunk's involvement in the call. In the case of calls not involving a trunk, it will be blank (this can occur with internal calls).</td>
</tr>
</tbody>
</table>
The Workgroup Service Level Summary Report provides information related to the workgroup server call processing. Every time the workgroup server processes a call, a record about its disposition is added to the QueueCall table. Generally, this occurs once when the call gets processed by the server. However, in the case of call forwarding, the same call can pass through the workgroup server more than once.

For example, a call made to the workgroup server is transferred to an extension. If that extension's call handling mode forwards the call to the same or a different workgroup, the call passes through the workgroup server more than once. The rule in these cases is simple—for each time the workgroup server disposes of a call, a record is added to the QueueCall table.

### Call Duration

The duration of the call. Duration reports the time of the user's involvement in the call. It's reported by summing the TalkTime, RingTime, and HoldTime fields in the Connect record representing involvement in the call.

Since a call is reported during the period in which it starts (as identified by the StartTime in the Call table record for the call) but may end during another interval, the duration can be longer than the 30- or 60-minute interval period. The total duration is reported during the interval in which the call begins.

### Wrap-Up Duration

Only applicable to inbound workgroup calls. This is the amount of time, if any, the agent spent in wrap-up after completing the call.

The Wrap-up Duration is the difference between the StartTime Stamp and End Time Stamp in the wrap-up record in the AgentActivity table for that agent.

### Queue Duration

Only applicable to inbound workgroup calls, the amount of time that the call was in the workgroup queue before it was assigned to the agent. This data is retrieved from the Duration field of the QueueCall table record for the call.

### Total Duration

The Total Duration includes the Queue Duration, Call Duration, and Wrap-up Duration. It is generally less than the total time the call spends within the ShoreTel system. The time between when the trunk was seized and the call was accepted by the workgroup, or any time the call spends with a menu or other extension, is not reflected.

### Table 129: Workgroup Agent Detail Report field descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Duration</td>
<td>Once for each call reported.</td>
<td>The duration of the call. Duration reports the time of the user's involvement in the call. It's reported by summing the TalkTime, RingTime, and HoldTime fields in the Connect record representing involvement in the call. Since a call is reported during the period in which it starts (as identified by the StartTime in the Call table record for the call) but may end during another interval, the duration can be longer than the 30- or 60-minute interval period. The total duration is reported during the interval in which the call begins.</td>
</tr>
<tr>
<td>Wrap-Up Duration</td>
<td>Once for each call reported.</td>
<td>Only applicable to inbound workgroup calls. This is the amount of time, if any, the agent spent in wrap-up after completing the call. The Wrap-up Duration is the difference between the StartTime Stamp and End Time Stamp in the wrap-up record in the AgentActivity table for that agent.</td>
</tr>
<tr>
<td>Queue Duration</td>
<td>Once for each call reported.</td>
<td>Only applicable to inbound workgroup calls, the amount of time that the call was in the workgroup queue before it was assigned to the agent. This data is retrieved from the Duration field of the QueueCall table record for the call.</td>
</tr>
<tr>
<td>Total Duration</td>
<td>Once for each call reported.</td>
<td>The Total Duration includes the Queue Duration, Call Duration, and Wrap-up Duration. It is generally less than the total time the call spends within the ShoreTel system. The time between when the trunk was seized and the call was accepted by the workgroup, or any time the call spends with a menu or other extension, is not reflected.</td>
</tr>
</tbody>
</table>

### Workgroup Service Level Summary Report

The Workgroup Service Level Summary Report provides information related to the workgroup server call processing. Every time the workgroup server processes a call, a record about its disposition is added to the QueueCall table. Generally, this occurs once when the call gets processed by the server. However, in the case of call forwarding, the same call can pass through the workgroup server more than once.

For example, a call made to the workgroup server is transferred to an extension. If that extension's call handling mode forwards the call to the same or a different workgroup, the call passes through the workgroup server more than once. The rule in these cases is simple—for each time the workgroup server disposes of a call, a record is added to the QueueCall table.
The report always includes external calls to a workgroup. Internal workgroup calls are included in the report only if the option to include them is selected (the default is not included). The CallType field in the Call table is examined to determine if the call is internal or external. If the CallType is 1 (extension to extension), it is an internal call; otherwise it is an external call. The QueueCall record for a call processed by the workgroup server has a ConnectTableID that identifies the Connect table entry for the workgroup server being added to the call. The Connect table entry has a CallTableID field that is examined to determine the Call table record for the call, whether the call is internal or external.

If the workgroup service is not operational, the call is not processed by the workgroup server (it simply goes to the backup extension). Calls directed to the workgroup but not processed by the service because it is down are not included in this report. When this occurs, there is no record of the call in the QueueCall table since records are only added to the table when the workgroup server processes the call. Figure 268 is an example of a Workgroup Service Level Summary Report.

The Workgroup Service Level Summary Report is described in Table 130.
<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/ Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait Time (sec.)</td>
<td>Showed once for each 30-second period in workgroup/internal where there are calls to be reported.</td>
<td>Range of wait-for-service times. The wait time is divided into 30-second intervals. Information for the calls is reported for the interval in which it falls, according to when the call moved off the workgroup. The actual wait or service time for each workgroup call is found in the Duration field of the QueueCall table. This duration is the time from when the call is offered to the workgroup server until it leaves the call queue.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>Once for each period reported.</td>
<td>Number of callers who abandoned the call (hung up) during the period. Those QueueCall records with the ExitReason set to 7 (Abandoned) are counted as abandoned.</td>
</tr>
<tr>
<td>Handled by Agent</td>
<td>Once for each period reported.</td>
<td>Number of calls handled by agents during the period. Those QueueCall records with the ExitReason set to 1 (TransferToAgent) are counted as handled by an agent. A call that is picked up or unparked by an agent that is a member of the same workgroup is also counted as Handled by Agent.</td>
</tr>
<tr>
<td>Handled by Voice Mail</td>
<td>Once for each period reported.</td>
<td>Number of calls that went to the workgroup’s voice mail (either as a result of call handling, or when the caller chose the transfer to voice mail option). Those QueueCall reports with the TargetType set to 3 (mailbox) and ExitReason set to 2, 3, 4, or 5 (ForwardAlways, ForwardBusy, ForwardNoAnswer, or ForwardNoLoginAgent), or 9 (TransferVM) with the TargetDN field equal to the workgroup DN itself are counted as Handled by Voice Mail.</td>
</tr>
<tr>
<td>Queue Transfer</td>
<td>Once for each period reported.</td>
<td>Displays the number of calls transferred by the WorkGroup Queue function.</td>
</tr>
<tr>
<td>Interflow / Overflow</td>
<td>Once for each period reported.</td>
<td>Number of automatic call transfers, based on caller wait time to a dialable number (interflow) or to another WorkGroup queue (overflow).</td>
</tr>
<tr>
<td>Handled by Others</td>
<td>Once for each period reported.</td>
<td>Number of calls handled by others (not workgroup agents or voice mail). Any call for the workgroup that isn’t reported as Abandoned, Handled by Agent, or Handled by Voice Mail is counted as Handled by Others. Calls that are picked up by non-agents, or agents that do not belong to the group are counted as Handled by Others.</td>
</tr>
<tr>
<td>Total Calls</td>
<td>Once for each period reported.</td>
<td>Sum of Abandoned, Handled by Agent, Handled by Voice Mail, Picked Up from the Queue, Unparked from the Queue, and Handled by Others for the period.</td>
</tr>
</tbody>
</table>
Workgroup Queue Summary Report

The Workgroup Queue Summary Report (Figure 269) is a summary of queue activity and how the calls interact with the queue. The report can run with fixed interval sub-totals.

**Note**

If you are using on-net dialing, enter the workgroup number with the dash. For example, enter 12-345 instead of 12345. If you do not do this, the generated report can turn up blank, without the required entries.

![Figure 269: Workgroup Queue Summary Report](image)

**Calls Included**

The key determinant in this report is which workgroup server processes the call. Each time the workgroup server processes a call, a record about the call’s disposition is added to the QueueCall table. In most cases the call is recorded just once, but if forwarded, a call can be recorded twice. Normally the call comes in and is processed by the server where it is routed to an agent. The caller then chooses to go to voice mail or another destination, or hangs up (abandons the call) before it is routed beyond the workgroup. Since the report shows how the call was disposed of by the workgroup server, the call is reported once in the report. However, if the call is forwarded, the same call can pass through the workgroup server more than once.
For example, a call goes to a workgroup server. While on the call, the user transfers it to another extension. The user’s extension’s call handling mode forwards the call to the same or a different workgroup. In this case, the call passes through the workgroup server more than once and is reported each time the workgroup server processes the call. For each time the workgroup server processes the call, a record is added to the QueueCall table.

External calls to a workgroup are always included in the report. Internal workgroup calls are only included in the report if the option to include them is enabled (by default they are not). The CallType field in the Call table is examined to determine if the call is internal or external. If the CallType is 1 (extension to extension), it is an internal call; otherwise it is an external call. The QueueCall record for a call processed by the workgroup server has a ConnectTableID that identifies the Connect table entry for the workgroup server being added to the call. The Connect table entry has a CallTableID field that is then examined to determine the Call table record for the call. It is this record’s CallType that is examined to determine whether the call is internal or external.

If the workgroup service is not operational, the call is not processed by the workgroup server (it simply goes to the backup extension). These calls are not included in the report. When this occurs, there is no record of the call in the QueueCall table, since records are only added to that table when the workgroup server processes the call.

The Workgroup Queue Summary Report is described in Table 131.

Table 131: Workgroup Queue Summary Report Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/ Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workgroup Name</td>
<td></td>
<td>The name of the workgroup.</td>
</tr>
<tr>
<td>Calls Abandoned</td>
<td>Once for each period reported.</td>
<td>The number of callers who hung up or otherwise disconnected while waiting in queue. Those QueueCall records with the ExitReason set to 7 (abandoned) are counted as Abandoned.</td>
</tr>
<tr>
<td>Calls Handled by Agent</td>
<td>Once for each period reported.</td>
<td>The number of calls that were answered by agents in the workgroup. Those QueueCall records with the ExitReason set to 1 (TransferToAgent) are counted as Handled by Agent.</td>
</tr>
<tr>
<td>Calls Handled by Voice Mail</td>
<td>Once for each period reported.</td>
<td>Number of calls that went to the workgroup's voice mail (either as a result of call handling or when the caller chose to transfer to voice mail). Those QueueCall records with the TargetType set to 3 (Mailbox), and ExitReason set to 2, 3, 4, or 5 (ForwardAlways, ForwardBusy, ForwardNoAnswer, or ForwardNoLoginAgent) or 9 (TransferVM) with the TargetDN field equal to the workgroup DN itself are counted as Handled by Voice Mail.</td>
</tr>
<tr>
<td>Transfer</td>
<td>Once for each period reported</td>
<td>Number of calls transferred by WorkGroup agents.</td>
</tr>
<tr>
<td>Overflow / Interflow</td>
<td>Once for each period reported.</td>
<td>Number of automatic call transfers, based on caller wait time to a dialable number (interflow) or to another WorkGroup queue (overflow).</td>
</tr>
</tbody>
</table>
### Table 131: Workgroup Queue Summary Report Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/ Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calls Handled by Others</td>
<td>Once for each period reported.</td>
<td>Number of calls handled by others (not workgroup's agents or voice mail). Any call for the workgroup that isn't reported as Abandoned, Handled by Agent, Picked Up from the Queue, Unparked from the Queue, or Handled by Voice Mail is counted as Handled by Others.</td>
</tr>
<tr>
<td>Maximum Abandoned Time</td>
<td>Once for each period reported.</td>
<td>The maximum time during the period that a caller who abandoned the call stayed on the line. The QueueCall records are examined for calls reported as abandoned during this period. The DurationSeconds field with the largest value for abandoned calls is reported.</td>
</tr>
<tr>
<td>Average Abandoned Time</td>
<td>Once for each period reported.</td>
<td>The average time during the period that those callers who abandoned the call stayed on the line. The sum of the DurationSeconds field in all of the QueueCall records for abandoned calls during the period divided by the number of such calls to report the average time abandoned.</td>
</tr>
<tr>
<td>Maximum Handled Time</td>
<td>Once for each period reported.</td>
<td>The maximum time during the period that a caller stayed on the line before the call was handled (by agent, voice mail, or others). Note that the maximum time could be zero even though there were handled calls in the case of the call being forwarded immediately to voice mail. The QueueCall records are examined for calls reported as handled during this period. The DurationSeconds field with the largest value for abandoned calls is reported.</td>
</tr>
<tr>
<td>Average Handled Time</td>
<td>Once for each period reported.</td>
<td>The average time during the period that a caller was on the line before the call was handled (by an agent, voice mail, or others). Note that the average time could be zero even though there were handled calls in the case of the call being forwarded immediately to voice mail. The sum of the DurationSeconds field in all of the QueueCall records for handled calls during the period divided by the number of such calls to report the average time abandoned.</td>
</tr>
<tr>
<td>Total Calls</td>
<td>Once for each period reported.</td>
<td>All calls passed through the workgroup. This includes calls that go straight to agents without waiting in queue. Sum of Abandoned, Handled by Agent, Handled by Voice Mail, and Handled by Others for the period.</td>
</tr>
</tbody>
</table>
WAN Media Stream Summary Report

The WAN Media Stream Summary Report (Figure 270) shows the summary of call quality and call traffic for calls made over the WAN in multi-site deployments. By understanding the amount of time the WAN is used for calls, you can estimate the amount of toll charges your organization is saving. In addition, by understanding the jitter and packet loss, you can get an approximation of the quality of the WAN link and use this to influence your service provider if required.

The Media Stream Report lists a matrix of all sites and the links to other sites on the system. Media streams are reported rather than calls, since this report focuses on the exact amount of bandwidth used. Calls can be quite complex involving multiple parties, including users, voice mail, and auto-attendant. Each media stream that is reported includes the associated Call ID (Call Identification) that can be correlated to the parties on the call for troubleshooting purposes using the CDR database. Figure 270 is an example of the Media Stream Summary Report.

Calls Included

This report summarizes media streams (not calls) between the two sites. Media streams can be for extensions or trunks. You can configure the report to display information for all calls or for only intersite calls. IP phone media streams are not included in this report.

The Media Stream Summary Report is described as follows:

Table 132: WAN Media Stream Summary Report Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site A</td>
<td>Once for each pair of sites being reported.</td>
<td>The name of the site. This data is retrieved from the ASiteName field in the MediaStream table.</td>
</tr>
<tr>
<td>Site B</td>
<td>Once for each pair of sites being reported.</td>
<td>The name of the site that communicates to Site A. This data is retrieved from the BSiteName field in the MediaStream table.</td>
</tr>
</tbody>
</table>
The WAN Media Stream Detail Report (Figure 271) shows details of each media stream placed over the WAN. You can configure the report to display information for all calls or for only intersite calls.

### WAN Media Stream Detail Report

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality - Avg Jitter</td>
<td>Once for each pair of sites being reported.</td>
<td>The average jitter is the average of the per-media stream maximum jitter between the sites given in milliseconds. This data is retrieved from the A MaxJitter and B MaxJitter fields in the MediaStream table.</td>
</tr>
<tr>
<td>Quality - Max Jitter</td>
<td>Once for each pair of sites being reported.</td>
<td>The maximum jitter is the worst jitter encountered on any media stream between the sites given in milliseconds. This data is retrieved from the A MaxJitter and B MaxJitter fields in the MediaStream table. The jitter buffer should be larger than this value for proper operation. The 'max jitter' value in this report is only recorded up to the maximum jitter buffer value configured in Director.</td>
</tr>
<tr>
<td>Quality - % Packet Loss</td>
<td>Once for each pair of sites being reported.</td>
<td>This is the number of packets that were expected to arrive but did not arrive at the destination. Lost packets were mostly likely dropped on their way through the network.</td>
</tr>
<tr>
<td>Quality - Blocked Calls</td>
<td>Once for each pair of sites being reported.</td>
<td>The number of media that were not routed across the WAN due to insufficient WAN bandwidth (admission control reached). This could indicate that more WAN bandwidth is required. This is a count of the number of records in the MediaStream table between the two sites with FailureCode = 1 (Admission Control Inhibited Call).</td>
</tr>
<tr>
<td>Traffic Volume - Total</td>
<td>Once for each pair of sites being reported.</td>
<td>The number of media streams used between the two sites as recorded in the MediaStream table.</td>
</tr>
<tr>
<td>Traffic Volume - Duration</td>
<td>Once for each pair of sites being reported.</td>
<td>The duration of all the media streams used between the two sites. The value is the sum of duration for all records between the two sites in the MediaStream table.</td>
</tr>
<tr>
<td>Traffic Volume - Avg Duration</td>
<td>Once for each pair of sites being reported.</td>
<td>The average duration of all the media streams used between the two sites. The average is total duration of the media streams between the two sites divided by the number of such media streams.</td>
</tr>
</tbody>
</table>
Figure 271: WAN Media Stream Detail Report

Call Included

See the Media Stream Summary Report for information about selection. This report calls out each media stream established between two sites.

IP phone media streams are not included in this report.

The Media Stream Detail Report is described in Table 133.

Table 133: WAN Media Stream Detail Report Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site A</td>
<td>Once for each media stream.</td>
<td>The name of the site. This data is retrieved from the ASiteName field in the MediaStream table.</td>
</tr>
<tr>
<td>Site B</td>
<td>Once for each media stream.</td>
<td>The name of the site that communicates to Site A. This data is retrieved from the BSiteName field in the MediaStream table.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Once for each media stream.</td>
<td>The time the media stream began. This data is retrieved from the StartTime field in the MediaStream table.</td>
</tr>
<tr>
<td>WAN</td>
<td>Once for each media stream</td>
<td>“Yes” indicates the media stream accessed the WAN. “No” indicates the media stream did not access the WAN.</td>
</tr>
<tr>
<td>CallID</td>
<td>Once for each media stream.</td>
<td>The Call Identification number for the media stream listed on the detail report. By matching the CallID in the report to the CallID of a WAN call with voice quality issues, you can understand the cause of the problems. This data is retrieved from the CallID field in the MediaStream table.</td>
</tr>
</tbody>
</table>
### Table 133: WAN Media Stream Detail Report Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
</table>
| Encoding       | Once for each media stream. | The method of voice encoding used for the media stream. This data is retrieved from the EncodingType field in the MediaStream table. The EncodingType field can have the following values for encoding methods:  
1. ALAW – PCMA/8000 (or G711A)  
2. MULAW – PCM/8000 (or G711µ)  
3. LINEARL16/16000  
4. ADPCM/8000  
5. G729AG729A/8000  
6. G729BG729B/8000  
7. LINEARWIDEBANDL16/16000  
8. G722G722/8000  
9. BV32BV32/16000  
10. BV16BV16/8000  
11. AAC_LC32000AAC_LC/32000  
12. CustomCodec added by administrator |
| Max Jitter     | Once for each media stream. | The maximum jitter encountered. This value is the maximum of the A MaxJitter or B MaxJitter for the record in the MediaStream table for the media stream.  
If a significant number of calls are reported with a Max Jitter value close or equal to the Maximum Jitter Buffer value, you may want to increase the Maximum Jitter Buffer or investigate the cause of excess jitter in the network. |
| % Packet Loss  | Once for each media stream. | This is the number of packets that were expected to arrive but did not arrive at the destination. Lost packets were mostly likely dropped on their way through the network. |
| Duration       | Once for each media stream. | The duration of time the media stream was used across the WAN connection.  
This data is retrieve from the DurationSeconds field of the MediaStream table record for this call. |
Account Code Summary Report

Summarizes call information for each account, including number of calls each day, along with their total and average duration. There are also totals for the reporting period. This report allows the administrator to indicate whether there should be summary information for each account. If this is desired, each extension’s use of the account is summarized. If not, there's a simple total for the entire account code.

Account Codes are only applicable to outgoing calls. Outgoing calls are identified in the Call table of the CDR database with the CallType field set to 3 (Outbound). The only outgoing calls that appear in the report are those calls for which an Account Code was collected (the account code is recorded in the BillingCode field of the Call table). If the user does not provide an account code on an outgoing call (because it isn’t required, or it is optional and they choose not to provide it), that call does not show up on the report. Figure 272 is an example of the Account Code Summary Report.

![Account Code Summary Report](Image)

**Figure 272: Account Code Summary Report**

The Account Code Summary Report fields are described Table 134.
The Account Code Detail Report (Figure 273) provides a detailed list of calls that occurred for each account. For each call the date and time of the call, number dialed, the extension making the call, and the duration of the call is included. For each account, a summary is provided of the number of calls, along with their total and average duration.

### Table 134: Account Code Summary Report Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Shown once for each account being reported on.</td>
<td>The account code that users enter to identify the account that a call is logged against. The name of the account code as configured in Director is also shown. For example, “300 (Marketing),” where “300” is the account code and “Marketing” is the name. For each call where account code information is collected, the account code is stored in the BillingCode field of the Call table. The name of the account code is stored in the FriendlyBillingCode field.</td>
</tr>
<tr>
<td>User</td>
<td>Only shown if the report option is selected to “Enable User Breakdown.” Shown once for each user who made calls for the account being reported upon.</td>
<td>The name and extension of the user who originated calls summarized in the report. For example, “John Smith (x3415).” The Extension field in the Call table identifies the party who originated the account code call. The extension field is where the report gets the extension number information. The name of the user comes from the PartyID (the first name) and PartyIDLastName (the last name) fields of the Connect record for the party that originated the call. The Connect record is tied to the Call table record, by the CallTableID field in the Connect table. All the Connect records for a particular call have the same CallTableID setting.</td>
</tr>
<tr>
<td>Total Calls</td>
<td>Repeated for each row.</td>
<td>The total number of calls for a particular day for the account. The total is broken down by user within each account if the “Enable User Breakdown” option is selected. A call is reported for the day on which the call started. That is, if a call starts on one day but ends on the next day, it is only reported for the day on which it started. The start of the call comes from the StartTime field in the Call table record for each call.</td>
</tr>
<tr>
<td>Total Duration</td>
<td>Repeated for each row.</td>
<td>The total duration of the calls being reported on the row. The duration is the total call duration, even if the call was transferred to parties such that the originator of the call was not on the call for the entire period. Duration is reported in the day the call started, but includes the entire call duration. For example, a call starts on 1/17 (with 20 minutes on 1/17) and ends on 1/18 (with 30 minutes on 1/18). The call is reported on 1/17 with duration of 50 minutes. This is then included in the total duration for all calls on 1/17. The duration of each call in this report comes from the Duration field in the call table.</td>
</tr>
<tr>
<td>Average Duration</td>
<td>Repeated for each row.</td>
<td>Calculated by dividing the total duration for a row by total calls.</td>
</tr>
</tbody>
</table>
Account codes are only applicable to outgoing calls. Outgoing calls are identified in the Call table of the CDR database with the CallType field set to 3 (Outbound). The only outgoing calls that appear in the report are those calls for which an account code was collected (the account code is recorded in the BillingCode field of the Call table). If the user does not provide an account code on an outgoing call (because it isn't required, or it is optional and they choose not to provide it) that call does not show up on the report.

![Account Code Detail Report](image)

The Account Code Detail Report fields are described in Table 135.

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Shown once for each account being reported on</td>
<td>The account code that users enter to identify the account that a call is logged against. The name of the account code as configured in Director is also shown. For example, “300 (Marketing),” where “300” is the account code and “Marketing” is the name. For each call where account code information is collected, the account code is stored in the BillingCode field of the Call table. The name of the account code is stored in the FriendlyBillingCode field.</td>
</tr>
<tr>
<td>Date</td>
<td>Repeated for each call.</td>
<td>The date on which the call started. A call is reported for the day on which the call started. That is, if a call starts on one day, but ends on the next day, it is only reported for the day that it started on. The Date is extracted from the StartTime field in the Call record for each call in the report.</td>
</tr>
<tr>
<td>Time</td>
<td>Repeated for each call.</td>
<td>The time at which the call started. Time comes from the StartTime field in the Call table record for each call in the report.</td>
</tr>
</tbody>
</table>

Figure 273: Account Code Detail Report

Table 135: Account Code Detail Report Field Descriptions
This appendix describes how the system stores data in the CDR database tables. The CDR database records the call data in the following tables:

- **Call Table**: An entry is made in the Call table for each call in the ShoreTel system. Other tables often reference the entries to the Call table.

- **Connect Table**: An entry is made in the Connect table for each connection to a call. When used with the Call table, a complete call history is provided.

- **MediaStream Table**: An entry is made in the MediaStream table each time there is a media stream between two switches that are at different sites. In some cases, such as for conference calls, there may be multiple media streams per call.

- **AgentActivity Table**: An entry is made in the AgentActivity table each time a workgroup agent logs into a workgroup and when he or she completes wrap-up.

- **QueueCall Table**: An entry is made in the QueueCall table for each call that is handled by a workgroup server. The entry identifies how the call leaves the workgroup—either by abandonment or for handling.

- **QueueStep Table**: An entry is made in the QueueStep table for each step where the workgroup server either hunts for agents or walks through workgroup queue steps. This provides more detailed information about how the call was disposed of by the workgroup server.

- **QueueDepth Table**: An entry is made in the QueueDepth table each time the depth of a workgroup server’s call queue changes.

### Table 135: Account Code Detail Report Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Presence/Frequency</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialed Number</td>
<td>Repeated for each call.</td>
<td>The number that was dialed to begin the call. Dialed Number comes from the DialedNumber field in the Call table record for each call in the report.</td>
</tr>
<tr>
<td>Calling Extension</td>
<td>Repeated for each call.</td>
<td>The number of the user that originated the call. Calling Extension comes from the Extension field in the Call table record for each call in the report.</td>
</tr>
<tr>
<td>Duration</td>
<td>Repeated for each call.</td>
<td>The total duration of the calls being reported on the row. The duration is the call duration, even if the call was transferred to parties such that the originator of the call was not on the call for the entire period. The duration of each call in this report comes from the Duration field in the Call table.</td>
</tr>
</tbody>
</table>
In addition to these tables, the database contains enumeration tables, which are documented below when discussing the tables that reference these enumeration/lookup tables.

Logged data reflects the time of its logging. For example, certain records contain the name of a trunk group from the configuration database. The name of the trunk group can be changed in the configuration database. New log entries reflect the changed name, but existing logs continue to have the old name.

**Creating a CDR Archive Database**

You can create a CDR archive database by using the MakeCDRArchive.exe command line interface on the ShoreTel HQ server, as described in the following procedure:

1. Navigate to `C:\Program Files\ShorelineCommunications \ ShoreWare Server` and check if the following files are installed in the same directory:
   - MakeCDR.dll
   - MakeCDR.sql
   - MakeCDR_sp.sql

2. Open the command prompt window in the same directory and run the following command.

   `MakeCDRArchive -d databasename`

   **Note**

   `databasename` is the name of the archive database to be created. The database name must match the name entered on the Reporting > Report Options page on ShoreTel Connect Director. If no name is specified, the default name of `shorewarecdrarchive` is created in the `C:\Shoreline Data \ Call Records2 \ Data` directory.

3. The archive database is created and the records from the active CDR database are written to the archive database when the services begin every night (approximately 12:00:00 AM).

**Call Table**

The CDR database reflects all calls within the system with a few exceptions which are listed below. These exceptions reflect the ShoreTel Telephony Management Server (TMS) that allows calls to continue even when portions of the system or network are not available. As the TAPI service provider for the ShoreTel Server, TMS manages the call control communications between all other ShoreTel services.

The exceptions are:

- If TMS is not connected to any of the call endpoints, the call is not recorded in the Call table. Because of network outages, TMS may not be connected to call endpoints, yet the call endpoints may have the connectivity necessary to complete the call (for example, the switches are able to communicate with each other but not to TMS).
- If TMS is not connected to some of the call endpoints (for example, a switch involved in the call), the information about the call can be incomplete (for example, the information in the Connect table as explained in the next section would only reflect some of the parties involved in the call).

- If TMS is restarted, any call entries that were incomplete, along with their associated Connect entries are destroyed. Incomplete calls do not show “Yes” in the locked field.

- Also at TMS restart time, TMS logs any calls in progress.

Figure 274 illustrates how new entries are added to the Call table whenever there is a call in the ShoreTel system. Note that an entry is added to the Call table when the call begins (or when TMS starts up, for any calls in progress) and is updated when the call ends.

The Call table is reference by other tables, most important among them being the Connect table. You can analyze the Call and Connect tables to understand the complete disposition of a call as attempts are made to add parties, transfers occur, and so on. Other tables can index the Call table, through the primary key “ID,” which is unique for each record.

There is a CallID field that is used internally by the ShoreTel system to identify calls. This, however, should not be used as the index into the table).

Close examination of the Call table shows that there are more calls recorded than you may initially expect. For example, if a call is made to a workgroup, you will see an initial call, generally from an incoming trunk. As agents are hunted, calls are made by the workgroup server to agents. If multiple
agents are hunted, there will be multiple calls. Once one of the agents is successfully hunted, if you looked at the Connect table you see the agent being attached to the original call. Table 136 provides information about the elements in the Call Table.

### Table 136: Call Table Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>AutoNumber</td>
<td>Unique identifier. (4-byte integer, required)</td>
</tr>
<tr>
<td>CallID</td>
<td>Number</td>
<td>Number for the existence of the call. (4-byte integer)</td>
</tr>
<tr>
<td>SIPCallId</td>
<td>Text</td>
<td>SIP Global ID number (31 characters)</td>
</tr>
<tr>
<td>StartTime</td>
<td>Date/Time</td>
<td>For an inbound call, this is when the trunk has been seized. For an outbound call, this is when the user has completed dialing. (8-byte date/time, required)</td>
</tr>
<tr>
<td>StartTimeMS</td>
<td>Number</td>
<td>Append this information to the StartTime to reduce the absolute start time to the millisecond when the call began. (2-byte integer, required)</td>
</tr>
<tr>
<td>EndTime</td>
<td>Date/Time</td>
<td>Time when the call terminates (either by the near end hanging up or when the end external to the system hangs up) and the ShoreTel switch receives the notification of the disconnect. (8-byte date/time)</td>
</tr>
<tr>
<td>EndTimeMS</td>
<td>Number</td>
<td>Append this information to the StartTime to reduce the absolute start time to the milliseconds of when the call began (milliseconds). (2-byte integer, required)</td>
</tr>
<tr>
<td>CallNote</td>
<td>Text</td>
<td>User entered Call Note. This can be added from the ShoreTel desktop client. (64 characters, 0-length)</td>
</tr>
<tr>
<td>BillingCode</td>
<td>Text</td>
<td>Account code assigned to the call. (32 characters, zero-length)</td>
</tr>
<tr>
<td>Locked</td>
<td>Yes/No</td>
<td>Read-only status for this call (set once call has ended). Not locked means the call is still in progress. (boolean)</td>
</tr>
<tr>
<td>Extension</td>
<td>Text</td>
<td>For an outbound or extension-to-extension call, the extension has the dialed number of the originator of the call. This field is blank for an outbound call from an anonymous phone with no currently assigned DN. For an inbound call, the extension field contains the DN of the last party involved in the call (excluding voice mail or auto-attendant). For example, an incoming call to an extension that transferred the call to extension 300 has “300” in the extension field (the complete history of parties connecting to the call is in the Connect table). All calls to an extension that are forwarded to voice mail have the extension of the called party and not the voice mail number (15 characters, 0-length).</td>
</tr>
<tr>
<td>Duration</td>
<td>Date/Time</td>
<td>Elapsed time of the call from beginning to end. Calculated by subtracting StartTime from EndTime. Start time begins when the first party is added to a call. End time is when the last party leaves resulting in the end of the call. (8-byte date/time)</td>
</tr>
<tr>
<td>CallType</td>
<td>Number</td>
<td>See enumeration in CallType table. (1-byte integer, required)</td>
</tr>
</tbody>
</table>
Table 136: Call Table Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WorkGroupCall</td>
<td>Yes/No</td>
<td>Is this a workgroup call? Yes indicates that the workgroup server was involved in processing the call.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the call was directed toward a workgroup server, but that server was unavailable, then this field is set to “No” because the workgroup server never becomes involved in the call. (boolean)</td>
</tr>
<tr>
<td>LongDistance</td>
<td>Yes/No</td>
<td>From the perspective of the trunk for the call, did this call involve a long distance connection? The first connect record of the call is used to determine whether a call is long distance. If the first leg is an extension call, the value is always No.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A trunk call can be transferred or conferenced, so the total long distance time can only be determined by examining all Connect records. (boolean)</td>
</tr>
<tr>
<td>DialedNumber</td>
<td>Text</td>
<td>Extension-to-extension and outbound: Number dialed plus trunk access code if any. (15 characters, zero-length)</td>
</tr>
<tr>
<td>CallerID</td>
<td>Text</td>
<td>For CallType=Inbound only: Caller-ID number if present. If blocked or unavailable text is provided by the PSTN to indicate caller ID as unavailable it is included here; for example, the text may be “blocked” or “unavailable” (15 characters, zero-length)</td>
</tr>
<tr>
<td>Archived</td>
<td>Yes/No</td>
<td>Has this call been archived? (boolean)</td>
</tr>
</tbody>
</table>

Enumeration Tables: Use for the Call Table

Call Type

Table 137: Call Type Descriptions

<table>
<thead>
<tr>
<th>Call Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>ExtToExt</td>
<td>Extension-to-extension call.</td>
</tr>
<tr>
<td>2</td>
<td>Inbound</td>
<td>A trunk is the originating party.</td>
</tr>
<tr>
<td>3</td>
<td>Outbound</td>
<td>An extension is originating and a trunk is called.</td>
</tr>
</tbody>
</table>

Connect Table

The Connect table contains a record for each party in a call. There are many different types of parties that can be reflected in the table including individual user extensions, workgroups, workgroup agents, and trunks.
Figure 275 illustrates how new entries are added to the Connect table each time a party is added to a call within the ShoreTel system.

Figure 275: New Entries in the Connect Table

Connect Table Field Descriptions

Table 138 describes the Connect Table data fields.

Table 138: Connect Table Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Auto-Number</td>
<td>Unique identifier. (4-byte integer – required)</td>
</tr>
<tr>
<td>PartyType</td>
<td>Number</td>
<td>Party that initiated the call. Value corresponds to value from Connect Type Party Type table (Table 139). (6-bit integer – required)</td>
</tr>
<tr>
<td>CallTableID</td>
<td>Number</td>
<td>Link to Call Table ID Key. (20-bit integer – required)</td>
</tr>
<tr>
<td>LineID</td>
<td>Number</td>
<td>TAPI permanent line ID for this party. (20-bit integer – required)</td>
</tr>
</tbody>
</table>
### Table 138: Connect Table Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwitchID</td>
<td>Number</td>
<td>Party’s Switch ID – unique ID assigned to configuration database to ShoreTel switch. Data only available through database – not Director.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value of 0 indicates the party is a workgroup, voicemail, or an unassigned user. In these cases, DN is are not assigned to a switch/port. (11-bit integer)</td>
</tr>
<tr>
<td>PortNumber</td>
<td>Number</td>
<td>Party’s port number corresponding to physical port or channel number on the ShoreTel switch.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value of 0 indicates the party is a a workgroup, voicemail or unassigned user. This is a 11-bit integer.</td>
</tr>
<tr>
<td>PortID</td>
<td>Number</td>
<td>Party’s port ID – if any. Unique ID assigned to ShoreTel switch port by configuration database. Data is available through the database, not ShoreTel Director.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A value of 0 indicates the party is a workgroup, voicemail, or an unassigned user. This is a 20-digit integer.</td>
</tr>
<tr>
<td>PortName</td>
<td>Text</td>
<td>Name of port (Trunk or Extension) – user defined in Director. (50 characters)</td>
</tr>
<tr>
<td>GroupID</td>
<td>Number</td>
<td>Unique ID assigned by configuration database. (11-bit integer)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value is a TrunkGroupID if PartyType – Trunk.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value is UserGroupID if PartyType – Station.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value is 0 if it is not applicable.</td>
</tr>
<tr>
<td>GroupName</td>
<td>Number</td>
<td>Data is defined is Director by use. (50 characters)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If PartyType – Station, value is name of the User-Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If PartyType – Trunk, value is Trunk-Group.</td>
</tr>
<tr>
<td>ConnectTime</td>
<td>Date/Time</td>
<td>Time when party was added to call.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Initial parties on inbound call, value indicates time trunk was seized.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Initial parties on outbound call, value indicates time dialing was complete.</td>
</tr>
<tr>
<td>ConnectTimeMS</td>
<td>Number</td>
<td>Append to ConnectTime to determine start time of call with millisecond precision. (11-bit integer, milliseconds)</td>
</tr>
<tr>
<td>DisconnectTime</td>
<td>Date/Time</td>
<td>Time when party disconnected from call.</td>
</tr>
<tr>
<td>DisconnectTimeMS</td>
<td>Number</td>
<td>Append to DisconnectTime to determine end time of call with millisecond precision. (11-bit integer, milliseconds)</td>
</tr>
<tr>
<td>ConnectReason</td>
<td>Number</td>
<td>Connect reason code. Refer to Table 141. (6-bit integer – required)</td>
</tr>
<tr>
<td>DisconnectReason</td>
<td>Number</td>
<td>Disconnect reason code. Refer to Table 142. (6-bit integer – required)</td>
</tr>
</tbody>
</table>
### Table 138: Connect Table Field Descriptions (Continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartyIDFlags</td>
<td>Number</td>
<td>Caller ID flags that specifies the data available in ID and Name fields</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Internal party: number, name and last name from system address book.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>External party: data corresponds to caller ID field provided by the PSTN.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to Table 140. (6-bit integer – required)</td>
</tr>
<tr>
<td>PartyID</td>
<td>Text</td>
<td>Number of party. Refer to PartyIDFlags field. (50 characters)</td>
</tr>
<tr>
<td>PartyIDName</td>
<td>Text</td>
<td>Name of party. Refer to PartyIDFlags field. (50 characters)</td>
</tr>
<tr>
<td>PartyIDLastName</td>
<td>Text</td>
<td>Last name of party. (50 characters)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Field is blank for external party – PartyIDName contains first and last name,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>as provided by PSTN Caller ID service.</td>
</tr>
<tr>
<td>CtrlPartyIDFlags</td>
<td>Number</td>
<td>Caller ID flags that specifies the data available in ID and Name fields for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the controlling party. Controlling party causes the event. Example: for an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>entry listing a call was transferred from extension 400 to extension 300,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the controlling party is extension 400. Original call will not have a control</td>
</tr>
<tr>
<td></td>
<td></td>
<td>party. Refer to Table 140. (6-bit integer – required)</td>
</tr>
<tr>
<td>CtrlPartyID</td>
<td>Text</td>
<td>Number of controlling party. Refer to CtrlPartyIDFlags field. (50 characters)</td>
</tr>
<tr>
<td>CtrlPartyIDName</td>
<td>Text</td>
<td>Name of controlling party. Refer to CtrlPartyIDFlags field. (50 characters)</td>
</tr>
<tr>
<td>CtrlPartyIDLastName</td>
<td>Text</td>
<td>Last name of controlling party. (50 characters)</td>
</tr>
<tr>
<td>MailboxID</td>
<td>Text</td>
<td>Mailbox ID if PartyType – VMForward or VMLogin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PartyType – VMForward – specifies mailbox receiving forwarded message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PartyType – VMLogin – specifies original target mailbox.</td>
</tr>
<tr>
<td>RelatedCallTableID</td>
<td>Number</td>
<td>Reserved. (20-bit integer).</td>
</tr>
<tr>
<td>TalkTime</td>
<td>Date/Time</td>
<td>Total connect time. Calls with more than 24 hours include the date. Date not</td>
</tr>
<tr>
<td></td>
<td></td>
<td>included on calls shorter than one hour. (8-byte date/time)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Example:</strong> A 25 hour call has a TalkTime of 1 day and 1 hour.</td>
</tr>
<tr>
<td>TalkTimeSeconds</td>
<td>Number</td>
<td>The seconds component of the TalkTime. (20-bit integer, seconds)</td>
</tr>
<tr>
<td>HoldTime</td>
<td>Date/Time</td>
<td>Time on hold. Includes date on calls with more than 24 hours hold time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Date not included on calls with less than one hour hold time. (8-byte date/</td>
</tr>
<tr>
<td></td>
<td></td>
<td>time)</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Example:</strong> A call with 25 hour time has a HoldTime of 1 day and 1 hour.</td>
</tr>
<tr>
<td>RingTime</td>
<td>Date/Time</td>
<td>Inbound calls: time spent offering</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Outbound calls: ringback time.</td>
</tr>
<tr>
<td>Duration</td>
<td>Date/Time</td>
<td>The time between ConnectTime and DisconnectTime</td>
</tr>
<tr>
<td>LongDistance</td>
<td>Number</td>
<td>Lists trunk connected long distance for outbound calls if PartyType – trunks</td>
</tr>
</tbody>
</table>
### Enumeration Tables Used for Connect Table

#### PartyType

Table 139 lists the Connect Table party types.

**Table 139: Party Type Enumeration Table**

<table>
<thead>
<tr>
<th>Type #</th>
<th>Party Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Station</td>
<td>User extension which is currently assigned a home port; sometimes referred to as a “logged in user”.</td>
</tr>
<tr>
<td>2</td>
<td>Trunk</td>
<td>Trunk (of any kind).</td>
</tr>
<tr>
<td>3</td>
<td>Virtual</td>
<td>A user extension which does not currently have an assigned home port (sometimes referred to as a “logged out user”).</td>
</tr>
<tr>
<td>4</td>
<td>Workgroup</td>
<td>Workgroup extension.</td>
</tr>
<tr>
<td>5</td>
<td>AutoAttendant</td>
<td>Auto-Attendant extension.</td>
</tr>
<tr>
<td>6</td>
<td>VMForward</td>
<td>Voice mail forward extension (take a message).</td>
</tr>
<tr>
<td>7</td>
<td>VMLogin</td>
<td>Voice mail login extension.</td>
</tr>
<tr>
<td>8</td>
<td>BackupAA</td>
<td>Backup auto-attendant (built into switch).</td>
</tr>
<tr>
<td>9</td>
<td>AnonPhone</td>
<td>Anonymous telephone.</td>
</tr>
<tr>
<td>10</td>
<td>Nightbell</td>
<td>Nightbell extension.</td>
</tr>
<tr>
<td>11</td>
<td>Paging</td>
<td>Paging extension.</td>
</tr>
<tr>
<td>12</td>
<td>WorkgroupAgent</td>
<td>Records marked as WorkgroupAgent for calls transferred from a Workgroup to an Agent. Direct inbound calls to an agent are Station type.</td>
</tr>
<tr>
<td>13</td>
<td>Unknown</td>
<td>Unknown type.</td>
</tr>
<tr>
<td>14</td>
<td>RoutePoint</td>
<td>Route point.</td>
</tr>
</tbody>
</table>

#### PartyIDFlag

Table 140 lists the Connect Table party ID flags.
**Table 140: Party ID Flag Enumeration Table**

<table>
<thead>
<tr>
<th>Flag #</th>
<th>Party ID Flag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Blocked</td>
<td>Blocked</td>
</tr>
<tr>
<td>2</td>
<td>OutOfArea</td>
<td>Out-Of-Area</td>
</tr>
<tr>
<td>4</td>
<td>Name</td>
<td>Name</td>
</tr>
<tr>
<td>8</td>
<td>Address</td>
<td>Address</td>
</tr>
<tr>
<td>12</td>
<td>NameAddress</td>
<td>Name &amp; Address</td>
</tr>
<tr>
<td>16</td>
<td>Partial</td>
<td>Partial</td>
</tr>
<tr>
<td>32</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>64</td>
<td>Unavailable</td>
<td>Unavailable</td>
</tr>
</tbody>
</table>

**ConnectReason**

*Table 141* lists the Connect Table connect reason codes.

**Table 141: Connect Reason Enumeration Table**

<table>
<thead>
<tr>
<th>Connect #</th>
<th>Connect Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Direct</td>
<td>TMS was not available when the party connected to the call. Connection information is logged, but there is no more ConnectReason information.</td>
</tr>
<tr>
<td>2</td>
<td>ForwardBusy</td>
<td>The party was connected because the previous party's call handling mode was set to forward calls if the previous party was busy.</td>
</tr>
<tr>
<td>3</td>
<td>ForwardNoAns</td>
<td>The party was connected because previous party's call handling mode was set to forward calls if the previous party didn't answer.</td>
</tr>
<tr>
<td>4</td>
<td>ForwardAll</td>
<td>The party was connected because previous party's call handling mode was set to forward all calls.</td>
</tr>
<tr>
<td>5</td>
<td>Pickup</td>
<td>The call was connected because the called party answered the call.</td>
</tr>
<tr>
<td>6</td>
<td>Unpark</td>
<td>Unpark</td>
</tr>
<tr>
<td>7</td>
<td>Redirect</td>
<td>Redirect</td>
</tr>
<tr>
<td>8</td>
<td>Completion</td>
<td>Completion</td>
</tr>
<tr>
<td>9</td>
<td>Transfer</td>
<td>The call was connected after the call was transferred to the party.</td>
</tr>
<tr>
<td>10</td>
<td>Reminder</td>
<td>Reminder</td>
</tr>
</tbody>
</table>
### Connect Reason Enumeration Table

<table>
<thead>
<tr>
<th>Connect #</th>
<th>Connect Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>12</td>
<td>Unavailable</td>
<td>Unavailable</td>
</tr>
<tr>
<td>13</td>
<td>Intrude</td>
<td>Intrude</td>
</tr>
<tr>
<td>14</td>
<td>Parked</td>
<td>Parked</td>
</tr>
<tr>
<td>15</td>
<td>CampedOn</td>
<td>CampedOn</td>
</tr>
<tr>
<td>16</td>
<td>RouteRequest</td>
<td>RouteRequest</td>
</tr>
<tr>
<td>17</td>
<td>Called</td>
<td>The party was added to the call because it was the initial target of the call.</td>
</tr>
<tr>
<td>18</td>
<td>Forward</td>
<td>Forward</td>
</tr>
<tr>
<td>19</td>
<td>Originate</td>
<td>The party initiated this call.</td>
</tr>
<tr>
<td>20</td>
<td>Conference</td>
<td>The party was added to the call because the party was conferenced into the call.</td>
</tr>
<tr>
<td>21</td>
<td>Silent Monitor</td>
<td>Silent monitoring was initiated.</td>
</tr>
<tr>
<td>22</td>
<td>Barge In</td>
<td>Barge In was initiated.</td>
</tr>
<tr>
<td>23</td>
<td>Record</td>
<td>Call recording was initiated.</td>
</tr>
<tr>
<td>24</td>
<td>Silent Coach</td>
<td>Silent Coach was initiated.</td>
</tr>
<tr>
<td>25</td>
<td>StartMeetMeConf</td>
<td>A Meet Me conference was started.</td>
</tr>
<tr>
<td>26</td>
<td>JoinMeetMeConf</td>
<td>A user joined a Meet Me conference.</td>
</tr>
<tr>
<td>27</td>
<td>RingAllCalled</td>
<td>RingAll called.</td>
</tr>
</tbody>
</table>

### Disconnect Reasons

Table 142 lists the Connect Table disconnect reason codes.

### Disconnect Reason Enumeration Table

<table>
<thead>
<tr>
<th>Reason #</th>
<th>Disconnect Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td>Normal termination</td>
</tr>
<tr>
<td>1</td>
<td>Normal</td>
<td>Normal reason</td>
</tr>
<tr>
<td>2</td>
<td>Unknown</td>
<td>Unknown reason</td>
</tr>
<tr>
<td>3</td>
<td>Reject Call</td>
<td>Call was rejected</td>
</tr>
<tr>
<td>4</td>
<td>Pickup Call</td>
<td>Call picked up by other destination</td>
</tr>
<tr>
<td>5</td>
<td>Forwarded Call</td>
<td>Call forwarded to another destination</td>
</tr>
</tbody>
</table>
Table 142: Disconnect Reason Enumeration Table

<table>
<thead>
<tr>
<th>Reason #</th>
<th>Disconnect Reason</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Busy</td>
<td>Busy destination</td>
</tr>
<tr>
<td>7</td>
<td>NoAnswer</td>
<td>No answer by destination</td>
</tr>
<tr>
<td>8</td>
<td>BadAddress</td>
<td>Bad address</td>
</tr>
<tr>
<td>9</td>
<td>Unreachable</td>
<td>Destination cannot be reached</td>
</tr>
<tr>
<td>10</td>
<td>Congestion</td>
<td>Inadequate bandwidth</td>
</tr>
<tr>
<td>11</td>
<td>Incompatible</td>
<td>Destination is incompatible</td>
</tr>
<tr>
<td>12</td>
<td>Unavailable</td>
<td>Destination is unavailable</td>
</tr>
<tr>
<td>13</td>
<td>NoDialTone</td>
<td>No dial tone from the trunk</td>
</tr>
<tr>
<td>14</td>
<td>NumberChanged</td>
<td>Destination number changed</td>
</tr>
<tr>
<td>15</td>
<td>OutOfOrder</td>
<td>Destination out of order</td>
</tr>
<tr>
<td>16</td>
<td>TempFailure</td>
<td>Temporary failure</td>
</tr>
<tr>
<td>17</td>
<td>QoSUnavailable</td>
<td>QoS not available</td>
</tr>
<tr>
<td>18</td>
<td>Blocked</td>
<td>Destination blocked</td>
</tr>
<tr>
<td>19</td>
<td>DoNotDisturb</td>
<td>Do not disturb</td>
</tr>
<tr>
<td>20</td>
<td>Cancelled</td>
<td>Call cancelled</td>
</tr>
<tr>
<td>21</td>
<td>Unpark</td>
<td>Call unparked to different destination</td>
</tr>
<tr>
<td>22</td>
<td>EndConsultCall</td>
<td>End consult call</td>
</tr>
<tr>
<td>23</td>
<td>RingAllAnsOther</td>
<td>RingAllAnsOther</td>
</tr>
<tr>
<td>24</td>
<td>HangUp</td>
<td>Hang up</td>
</tr>
</tbody>
</table>

**Trunk Direction**

Table 143 lists the Trunk Direction flags.

Table 143: Trunk Direction Enumeration Table

<table>
<thead>
<tr>
<th>Flag #</th>
<th>Party ID Flag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Inbound</td>
<td>The trunk direction is established by the central office</td>
</tr>
<tr>
<td>3</td>
<td>Outbound</td>
<td>The trunk direction is established by the local system.</td>
</tr>
</tbody>
</table>

**MediaStream Table**

The MediaStream table logs media information about InterSite Calls. At a high level, there is one such entry for each InterSite call. Information about both parties involved in the call is recorded. Table 144 describes the elements in the MediaStream Table.
Table 144: Media Stream Data Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>AutoNumber</td>
<td>Unique identifier. (4-byte integer, required)</td>
</tr>
<tr>
<td>CallID</td>
<td>Number</td>
<td>Unique number for the existence of the call. (4-byte integer)</td>
</tr>
<tr>
<td>SIP CallId</td>
<td>Text</td>
<td>SIP Unique Global ID number (31 characters)</td>
</tr>
<tr>
<td>EncodingType</td>
<td>Number</td>
<td>Encoding type used for media stream. (1-byte integer)</td>
</tr>
<tr>
<td>PayloadSize</td>
<td>Number</td>
<td>Media payload size in bytes for each media packet. (4-byte integer)</td>
</tr>
<tr>
<td>StartTime</td>
<td>Date/Time</td>
<td>Date and time the call started.</td>
</tr>
<tr>
<td>Duration</td>
<td>Date/Time</td>
<td>Elapsed time of call from begin to end. (8-byte date/time)</td>
</tr>
<tr>
<td>DurationSeconds</td>
<td>Number</td>
<td>Elapsed seconds time of call from begin to end. (4-byte integer)</td>
</tr>
<tr>
<td>FailureCode</td>
<td>Number</td>
<td>Error code. See MediaFailureCode table for enumeration. (1-byte integer)</td>
</tr>
<tr>
<td>A PartyType</td>
<td>Number</td>
<td>Party A’s type enumeration. See the PartyType table. (1-byte integer)</td>
</tr>
<tr>
<td>A SiteID</td>
<td>Number</td>
<td>Party A's Site ID. (4-byte integer)</td>
</tr>
<tr>
<td>A SiteName</td>
<td>Text</td>
<td>Party A’s Site Name. (50 characters, zero-length)</td>
</tr>
<tr>
<td>A LineID</td>
<td>Number</td>
<td>TAPI permanent line ID for party A. (4-byte integer)</td>
</tr>
<tr>
<td>A Name</td>
<td>Text</td>
<td>Call type name for party A. (50 characters, zero-length)</td>
</tr>
<tr>
<td>A Extension</td>
<td>Text</td>
<td>Call extension number for party A (32 characters, zero-length)</td>
</tr>
<tr>
<td>A IP Address</td>
<td>Text</td>
<td>Local IP Address for party A. (15 characters, zero-length)</td>
</tr>
<tr>
<td>A TotalPackets</td>
<td>Number</td>
<td>Total packets received by party A. (4-byte integer)</td>
</tr>
<tr>
<td>A LostPackets</td>
<td>Number</td>
<td>Total packets lost by party A. (4-byte integer)</td>
</tr>
<tr>
<td>A MaxJitter</td>
<td>Number</td>
<td>Maximum jitter (ms) for party A. (4-byte integer)</td>
</tr>
<tr>
<td>A Underruns</td>
<td>Number</td>
<td>Number of receive underruns for party A. (4-byte integer)</td>
</tr>
<tr>
<td>A Overruns</td>
<td>Number</td>
<td>Number of receive underruns for party A. (4-byte integer)</td>
</tr>
<tr>
<td>B PartyType</td>
<td>Number</td>
<td>Party B’s type enumeration. (1-byte integer)</td>
</tr>
<tr>
<td>B SiteID</td>
<td>Number</td>
<td>Party B’s Site ID. (4-byte integer)</td>
</tr>
<tr>
<td>B SiteName</td>
<td>Text</td>
<td>Party B’s Site Name. (50 characters, zero-length)</td>
</tr>
<tr>
<td>B LineID</td>
<td>Number</td>
<td>TAPI permanent line ID for party B. (4-byte integer)</td>
</tr>
<tr>
<td>B Name</td>
<td>Text</td>
<td>Call type name for party B. (50 characters, zero-length)</td>
</tr>
<tr>
<td>B Extension</td>
<td>Text</td>
<td>Call extension number for party B (32 characters, zero-length)</td>
</tr>
<tr>
<td>B IP Address</td>
<td>Text</td>
<td>Local IP Address for party B. (15 characters, zero-length)</td>
</tr>
<tr>
<td>B TotalPackets</td>
<td>Number</td>
<td>Total packets received by party B. (4-byte integer)</td>
</tr>
<tr>
<td>B LostPackets</td>
<td>Number</td>
<td>Total packets lost by party B. (4-byte integer)</td>
</tr>
</tbody>
</table>
AgentActivity Table

The AgentActivity Table has information about the workgroup agents’ availability. Entries are made to record agents’ Login/Logout from the workgroup and to reflect their time in Wrapup mode. Figure 276 illustrates the flow of new entries being added to the AgentActivity table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B MaxJitter</td>
<td>Number</td>
<td>Maximum jitter (ms) for party B. (4-byte integer)</td>
</tr>
<tr>
<td>B Underruns</td>
<td>Number</td>
<td>Number of receive underruns for party B. (4-byte integer)</td>
</tr>
<tr>
<td>B Overruns</td>
<td>Number</td>
<td>Number of receive overruns for party B. (4-byte integer)</td>
</tr>
<tr>
<td>InterSite</td>
<td>Yes/No</td>
<td>Indicates a logged call is InterSite. Only InterSite calls are logged.</td>
</tr>
<tr>
<td>Archived</td>
<td>Yes/No</td>
<td>Has this entry been archived? (boolean)</td>
</tr>
</tbody>
</table>

Table 144: Media Stream Data Field Descriptions (Continued)

Figure 276: Entries to the AgentActivity Table

The left flow shows how each time a workgroup agent logs in, a LogInOut entry is added, which is then updated at logout time. The right flow shows how the AgentActivity table is also updated as agents complete their handling of workgroup calls. Table 145 describes the elements in the Agent Activity table.
Two types of records are placed in the AgentActivity table. The State field identifies the type of record.

- **LogInOut Records** record the time that an agent is logged into the workgroup.
- **Wrapup records** record the time that an agent is in wrapup state.
- All records in the table should have ID, AgentDN, AgentFirstName, AgentLastName (unless blank), State, WorkGroupDN, WorkGroupName, StartTimeStamp, and Archived.
- LogInOut Records may exist for agents that have logged into the workgroup but have not yet logged out. For these records the StartTimeStamp indicates the time when the agent logged into the workgroup. The EndTimeStamp is updated when the agent logs out of the workgroup with the time of the logout.
- For wrapup records the StartTimeStamp indicates the time when the agent entered wrapup time and EndTimeStamp indicates when they exit wrapup state.

### Table 145: Agent Activity Table field descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>AutoNumber</td>
<td>Unique identifier. (4-byte integer, required)</td>
</tr>
<tr>
<td>CallID</td>
<td>Number</td>
<td>Unique number for the existence of the call. Provided in wrapup records. (4-byte integer)</td>
</tr>
<tr>
<td>AgentDN</td>
<td>Text</td>
<td>WorkGroup Agent's dialed number (extension). (15 characters, zero-length)</td>
</tr>
<tr>
<td>AgentFirstName</td>
<td>Text</td>
<td>WorkGroup Agent's First Name (50 Characters, zero-length)</td>
</tr>
<tr>
<td>AgentLastName</td>
<td>Text</td>
<td>WorkGroup Agent's Last Name (50 Characters, zero-length) (may be blank if the agent doesn't have a last name in the configuration database)</td>
</tr>
<tr>
<td>State</td>
<td>Number</td>
<td>Enumerated Agent State—set AgentStateLUT for possible values.</td>
</tr>
<tr>
<td>WorkGroupDN</td>
<td>Text</td>
<td>WorkGroup dialed number (extension) for which this agent activity is for (15 characters, zero-length)</td>
</tr>
<tr>
<td>WorkGroupName</td>
<td>Text</td>
<td>Workgroup's name. (50 Characters, zero-length)</td>
</tr>
<tr>
<td>StartTimeStamp</td>
<td>Date/Time</td>
<td>Start time stamp. For LogInOut records, StartTimeStamp indicates the time when the agent logged into the workgroup. For wrapup records, the StartTimeStamp indicates the time when the agent entered wrapup time. See notes below. (8-byte date/time).</td>
</tr>
<tr>
<td>EndTimeStamp</td>
<td>Date/Time</td>
<td>End time stamp (8-byte date/time).</td>
</tr>
<tr>
<td>Archived</td>
<td>Yes/No</td>
<td>Has this entry been archived? (boolean)</td>
</tr>
</tbody>
</table>
Wrapup records can contain a CallID to identify the Call that the agent was wrapping up from for the Wrapup record. This will not be provided in cases where the agent is manually placed in wrapup state when not on a call.

There is always a wrapup record when an agent wraps up a call, even for the case where wrapup time is set to zero.

Enumeration Tables Used for AgentActivity

Table 146 lists the Agent Activity Enumeration Tables.

<table>
<thead>
<tr>
<th>State #</th>
<th>AgentState</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Reserved</td>
<td>Previously used for Login</td>
</tr>
<tr>
<td>2</td>
<td>Reserved</td>
<td>Previously used for Logout</td>
</tr>
<tr>
<td>3</td>
<td>Wrap_Up</td>
<td>Agent performing post-call wrap-up</td>
</tr>
<tr>
<td>4</td>
<td>Reserved</td>
<td>Temporarily used for Outcalls</td>
</tr>
<tr>
<td>5</td>
<td>LogInOut</td>
<td>Agent Login later updated with Logout time.</td>
</tr>
<tr>
<td>6</td>
<td>SecLogInOut</td>
<td>Secondary login activity for agents belonging to multiple Workgroup.</td>
</tr>
</tbody>
</table>

Login and Logout are no longer used.

QueueCall Table

Each time a call is processed by the workgroup server, an entry is made in the QueueCall table. A workgroup is a call queuing mechanism, thus the name “QueueCall” in the CDR database.

Each time a call is made to a workgroup when the workgroup server is operational, an entry is made in the QueueCall table; moreover, there is only one entry for each call. In other words, one and only one entry appears for each call. A call can be made to the workgroup dialed number, but if the workgroup server does not process the call, an entry is not made in the QueueCall table for the call. Moreover, the call will not be marked as a workgroup call in the call table.

Figure 277 illustrates how updates are made to the QueueCall table.
Each entry in the QueueCall table contains the following fields as shown in Table 147.

**Table 147: Queue Call Table Field Descriptions**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>AutoNumber</td>
<td>Unique identifier. (4-byte integer, required)</td>
</tr>
<tr>
<td>CallID</td>
<td>Number</td>
<td>Unique number for the existence of the call. (4-byte integer)</td>
</tr>
<tr>
<td>ConnectTableID</td>
<td>Number</td>
<td>Link to Connect Table ID Key. You can find more information about the connection to the call in the connect table. The Connect table entry here is for the Workgroup DN's connection to the call. If you want information from the Call table entry for this call, the reference to the Call table in the Connect entry should be used to find the Call table entry. (4-byte integer)</td>
</tr>
<tr>
<td>StartTime</td>
<td>Date/Time</td>
<td>The time at which the call is answered by the workgroup server, thereby beginning it's time on the call queue (workgroup) DN. (8-byte date/time)</td>
</tr>
</tbody>
</table>
Partial records are never written. A record is written only once, either when the call is abandoned, the call is connected to an agent, or leaves the queue for other reasons as enumerated in QueueExitReasonLUT.

- If QueueExitReason – Abandon, target information (TargetType, TargetFirstName, TargetLastName, TargetDN) is meaningless and will be blank.
- If QueueExitReason is TransferToAgent, the TargetFirstName and TargetLastName are filled in with information about the agent.
- If the QueueExitReason is Forwarding (2, 3, 4, or 5 for forward always, busy, no answer, or no logged in agent) or transfer (9, 10, and 11 for transfer to a menu, extension or voice mail), the DN that the call is being forwarded or transferred to is provided in the TargetDN field. However, the TargetFirstName and TargetLastName are not provided.
- A QueueExitReason is always entered. The field will never be blank. “Unknown” will only be used in the case of failure (and maybe not at all).

### Table 147: Queue Call Table Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Date/Time</td>
<td>Time from when the call is offered to the workgroup DN until it leaves the call queue. The call leaves the queue when it is answered by an agent, is abandoned by the calling party, or leaves the queue for other reasons. The complete lists of reasons for leaving the queue are found in the QueueExitReasonLUT table. (8-byte date/time)</td>
</tr>
<tr>
<td>DurationSeconds</td>
<td>Number</td>
<td>Duration expressed in number of seconds. (4-byte integer)</td>
</tr>
<tr>
<td>QueueName</td>
<td>Text</td>
<td>Name of the call queue (workgroup). (50 characters, zero-length)</td>
</tr>
<tr>
<td>QueueDN</td>
<td>Text</td>
<td>Extension number of the call queue (workgroup). (15 characters, zero-length)</td>
</tr>
<tr>
<td>ExitReason</td>
<td>Number</td>
<td>Enumerated reason the call left the call queue (see the QueueExitReasonLUT for enumerations). (1-byte integer)</td>
</tr>
<tr>
<td>TargetType</td>
<td>Number</td>
<td>Enumerated type of handoff target (see TargetTypeLUT for enumerations). (1-byte integer)</td>
</tr>
<tr>
<td>TargetFirstName</td>
<td>Text</td>
<td>Name or first name of target. (50 characters, zero-length)</td>
</tr>
<tr>
<td>TargetLastName</td>
<td>Text</td>
<td>Last name of target if applicable (blank if the target agent doesn’t have a last name in the configuration database). (50 characters, zero-length)</td>
</tr>
<tr>
<td>TargetDN</td>
<td>Text</td>
<td>Dialed number of target. (15 characters, zero-length)</td>
</tr>
<tr>
<td>Archived</td>
<td>Yes/No</td>
<td>Has this entry been archived? (boolean)</td>
</tr>
</tbody>
</table>
Enumeration Tables Used for QueueCall

Table 148 describes the elements in the Queue Call Exit Reason Enumeration table.

Table 148: Queue Call Exit Reason Enumeration Table

<table>
<thead>
<tr>
<th>ExitReason</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>TransferToAgent</td>
<td>Hunt succeeded and transferred to agent.</td>
</tr>
<tr>
<td>2</td>
<td>ForwardAlways</td>
<td>Workgroup forwarding all calls.</td>
</tr>
<tr>
<td>3</td>
<td>ForwardBusy</td>
<td>All logged in agents on call.</td>
</tr>
<tr>
<td>4</td>
<td>ForwardNoAnswer</td>
<td>All available agents did not answer.</td>
</tr>
<tr>
<td>5</td>
<td>FwdNoLoginAgent</td>
<td>No logged in agents.</td>
</tr>
<tr>
<td>6</td>
<td>ForwardMaxRings</td>
<td>Reached max number of rings before agent found.</td>
</tr>
<tr>
<td>7</td>
<td>Abandon</td>
<td>Call dropped while in WG or Queue.</td>
</tr>
<tr>
<td>8</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>TransferVM</td>
<td>Option taken to transfer to voice mail</td>
</tr>
<tr>
<td>10</td>
<td>TransferExtension</td>
<td>Option taken to transfer to an extension.</td>
</tr>
<tr>
<td>11</td>
<td>TransferMenu</td>
<td>Option taken to transfer to a menu.</td>
</tr>
<tr>
<td>12</td>
<td>Pickup</td>
<td>Agent picked up call from queue.</td>
</tr>
<tr>
<td>13</td>
<td>Unpark</td>
<td>Agent picked up from queue out of order.</td>
</tr>
<tr>
<td>14</td>
<td>Overflow</td>
<td>Overflow</td>
</tr>
<tr>
<td>15</td>
<td>Interflow</td>
<td>Interflow</td>
</tr>
</tbody>
</table>

- ForwardMaxRings is no longer used.
- Exit Reasons for Forwarding (2-5) reflects the call being forwarded from the workgroup. These are used when the call leaves the workgroup as a result of call handling and the call handling indicates to forward the call to an internal or external number. Call handling can also indicate that the call is entering the call queue for the workgroup. In that case, these exit reasons are not used because the call does not exit the queue at that point.
- Exit Reason 8, Abandon, is used when the caller drops the call either by physically hanging up or by taking an option on a Queue Step to hang up.
- Even after a call is forwarded to the queue, it remains on the queue and it may still be successfully transferred to an agent or abandoned. Exit Reason 1 or 7 is recorded if either of these occurs.
In addition to a call being successfully hunted or abandoned while on the queue, it may exit the queue because of an option taken during a queue step. The call will exit the queue if the caller takes any of the following options:

- Take a message
- Transfer to extension
- Go to menu
- Exit reasons 9, 10, and 11 have been added to cover these cases.

Table 149 describes the elements in the Queue Call Target Type Enumeration table.

### Table 149: Queue Call Target Type Enumeration Table

<table>
<thead>
<tr>
<th>Target #</th>
<th>TargetType</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Agent</td>
<td>Workgroup agent.</td>
</tr>
<tr>
<td>2</td>
<td>Menu</td>
<td>A menu on the ShoreTel system.</td>
</tr>
<tr>
<td>3</td>
<td>Mailbox</td>
<td>A mailbox on the ShoreTel system.</td>
</tr>
<tr>
<td>4</td>
<td>OtherIntrnExtrn</td>
<td>Any other extensions to which the call is targeted.</td>
</tr>
</tbody>
</table>

### QueueStep Table

The QueueStep table logs data about time spent in queue steps or in hunting for agents. Table 150 describes the elements in the QueueStep table.

### Table 150: Queue Call Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>AutoNumber</td>
<td>Unique identifier. (4-byte integer, required)</td>
</tr>
<tr>
<td>QcallTableID</td>
<td>Number</td>
<td>Link to the Autonumber field in the QueueCall table. This essentially identifies the QueueCall that this step is associated with. (4-byte integer)</td>
</tr>
<tr>
<td>StartTime</td>
<td>Date/Time</td>
<td>Time at which the call first enters this step. (8-byte date/time)</td>
</tr>
<tr>
<td>Duration</td>
<td>Date/Time</td>
<td>Elapsed time spent in this step. (8-byte date/time)</td>
</tr>
<tr>
<td>DurationSeconds</td>
<td>Number</td>
<td>Elapsed seconds spent in this step. (4-byte integer)</td>
</tr>
<tr>
<td>StepNumber</td>
<td>Number</td>
<td>Step number if this is not a hunting record (as identified by the Hunting field set to Yes). The step number corresponds to the step number in the workgroup configuration.</td>
</tr>
<tr>
<td>ExitReason</td>
<td>Number</td>
<td>Enumerated reason for exit from step. (1-byte integer)</td>
</tr>
<tr>
<td>Hunting</td>
<td>Yes/No</td>
<td>If true the times correspond to hunting, or else this indicates a queue step. (boolean)</td>
</tr>
</tbody>
</table>
There is a record for each period that the call spends hunting and for each period a call spends in a queue step. For example, if a call to a workgroup initially hunts for agents, then goes to the queue and exits the workgroup from that queue step, there will be two records for the call in the QueueStep table. The first record would be for hunting (the duration may be zero if, for example, no agents were logged in). The second record is for the first queue step from which the call exited.

**Web Tables**

Web tables log call data for audio only, web only, and audio and web conferences.

**Audio Only Conference**
- The Connect table includes a record for each leg of the conference.
- All legs in the same conference have a similar Call.CallID.
- No records are added to web_session and web_attendee tables

**Web Only Conference**
- A meeting session record is written to the web_session table after the meeting ends.
- A record is written to the web_attendee table for each attendee.
- No records are added to the Call and Connect tables.

**Audio & Web Conference**
- The Connect table includes a record for each leg of the conference.
- All legs in the same conference have a similar Call.CallID.
- A meeting session record is written to the web_session table after the meeting ends.
- A record is written to the web_attendee table for each attendee.
- The Web_session table holds a CallID that references Call.CallID. If a web attendee reconciles his or her audio leg, web_attendee.caller_id references Connect.PartyID.

**Web Session Table**

Table 151 provides information about the elements that appear in the log for web sessions.
### Table 151: Elements in the Web Session Log

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>AutoNumber</td>
<td>The session ID referenced by the attendee table</td>
</tr>
<tr>
<td>meeting_title</td>
<td>Text</td>
<td>Title of the meeting</td>
</tr>
<tr>
<td>meeting_desc</td>
<td>Text</td>
<td>Description of the meeting</td>
</tr>
<tr>
<td>meeting_type</td>
<td>Text</td>
<td>Normal, open or panel</td>
</tr>
<tr>
<td>start_time</td>
<td>Date/Time</td>
<td>Local time of the service appliance when the meeting session started</td>
</tr>
<tr>
<td>start_local_time</td>
<td>Date/Time</td>
<td>Local time of HQ server when meeting session started</td>
</tr>
<tr>
<td>start_utc_time</td>
<td>Date/Time</td>
<td>UTC time meeting session started</td>
</tr>
<tr>
<td>start_local_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set the service appliance server dst flag</td>
</tr>
<tr>
<td>start_hq_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set HQ dst flag</td>
</tr>
<tr>
<td>end_time</td>
<td>Date/Time</td>
<td>Local time of service appliance server when meeting session ended</td>
</tr>
<tr>
<td>end_local_time</td>
<td>Date/Time</td>
<td>Local time of HQ server when meeting session ended</td>
</tr>
<tr>
<td>end_utc_time</td>
<td>Date/Time</td>
<td>UTC time meeting session ended</td>
</tr>
<tr>
<td>end_local_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set local dst flag of service appliance server</td>
</tr>
<tr>
<td>end_hq_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set HQ dst flag</td>
</tr>
<tr>
<td>host_login</td>
<td>Text</td>
<td>Login name of meeting host</td>
</tr>
<tr>
<td>login_type</td>
<td>Text</td>
<td>Name, password, registration, none</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Yes/No</td>
<td>'Y' or 'N'</td>
</tr>
<tr>
<td>Public</td>
<td>Yes/No</td>
<td>'Y' or 'N'</td>
</tr>
<tr>
<td>Server</td>
<td>Text</td>
<td>IP address of a ShoreTel Service Appliance</td>
</tr>
<tr>
<td>moderator_code</td>
<td>Text</td>
<td>Moderator’s access code</td>
</tr>
<tr>
<td>Attendee_code</td>
<td>Text</td>
<td>Attendee’s access code</td>
</tr>
<tr>
<td>CallID</td>
<td>Number</td>
<td>CallID associated with conference call. NULL for web only conference.</td>
</tr>
<tr>
<td>Archived</td>
<td>Yes/No</td>
<td>Has this entry been archived?</td>
</tr>
</tbody>
</table>

### Web Attendee Table

Table 152 provides information about the elements that appear in the log for web session attendees.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>session_id</td>
<td>Number</td>
<td>References ID from web_session table</td>
</tr>
<tr>
<td>start_time</td>
<td>Date/Time</td>
<td>Local time of service appliance server when attendee joined session</td>
</tr>
<tr>
<td>start_local_time</td>
<td>Date/Time</td>
<td>Local time of HQ server when attendee joined session</td>
</tr>
<tr>
<td>start_utc_time</td>
<td>Date/Time</td>
<td>UTC time attendee joined session</td>
</tr>
<tr>
<td>start_local_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set service appliance server dst flag</td>
</tr>
<tr>
<td>start_hq_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set HQ dst flag</td>
</tr>
<tr>
<td>end_time</td>
<td>Date/Time</td>
<td>Local time of service appliance server when attendee left session</td>
</tr>
<tr>
<td>end_local_time</td>
<td>Date/Time</td>
<td>Local time of HQ server when attendee left session</td>
</tr>
<tr>
<td>end_utc_time</td>
<td>Date/Time</td>
<td>UTC time attendee left session</td>
</tr>
<tr>
<td>end_local_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set service appliance server dst flag</td>
</tr>
<tr>
<td>end_hq_dst_flag</td>
<td>Yes/No</td>
<td>Flag to set HQ dst flag</td>
</tr>
<tr>
<td>break_time</td>
<td>Number</td>
<td>Time attendee is absent from meeting</td>
</tr>
<tr>
<td>user_name</td>
<td>Text</td>
<td>Login name of attendee</td>
</tr>
<tr>
<td>user_ip</td>
<td>Text</td>
<td>Attendee's IP address</td>
</tr>
<tr>
<td>caller_id</td>
<td>Text</td>
<td>Caller's phone number</td>
</tr>
</tbody>
</table>
ShoreTel supports Centralized Dial Numbers (DN). Centralized DN guarantees the data integrity for DN references within the system. When administrators delete a particular DN, Centralized DN checks all the references to that DN across the system. Depending upon the significance of references to the DN to be deleted, the system either allows the deletion by removing all the DN references or prevents the deletion by prompting administrator with a message indicating the referenced DN and that it cannot be deleted.

To delete non-significant references together with the DN eliminates the unnecessary pop-up messages when administrators delete an unwanted DN, which simplifies DN management for the administrator. Table 153 provides information about the centralized dial number table as it relates to the ShoreTel system.

<table>
<thead>
<tr>
<th>Deleting an Extension</th>
<th>System Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hunt Group</td>
<td></td>
</tr>
<tr>
<td>Backup Extension</td>
<td>deletion not available</td>
</tr>
<tr>
<td>CF destination - call stack full</td>
<td>delete silently</td>
</tr>
<tr>
<td>CF destination - no answer</td>
<td>delete silently</td>
</tr>
<tr>
<td>Members</td>
<td>delete silently</td>
</tr>
<tr>
<td>Escalation Profile</td>
<td></td>
</tr>
<tr>
<td>Automatic Message Forwarding</td>
<td>delete silently</td>
</tr>
<tr>
<td>Escalation Step (Notification Number)</td>
<td>delete silently</td>
</tr>
<tr>
<td>Find Me</td>
<td></td>
</tr>
<tr>
<td>Primary destination</td>
<td>delete silently</td>
</tr>
</tbody>
</table>
### Table 153: Centralized Dial Numbers (DN) Table (Continued)

<table>
<thead>
<tr>
<th>Deleting an Extension</th>
<th>System Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup destination</td>
<td>delete silently</td>
</tr>
<tr>
<td><strong>Users</strong></td>
<td>-----------------</td>
</tr>
<tr>
<td>Mailbox for Recorded Calls</td>
<td>delete silently</td>
</tr>
<tr>
<td>Delayed Ringdown</td>
<td>delete silently</td>
</tr>
<tr>
<td><strong>Programmable Button</strong></td>
<td>-----------------</td>
</tr>
<tr>
<td>Toolbars</td>
<td>delete silently</td>
</tr>
<tr>
<td><strong>User Call Handling Modes</strong></td>
<td>-----------------</td>
</tr>
<tr>
<td>Always Destination:</td>
<td>set to DN Type = 4</td>
</tr>
<tr>
<td>Busy Destination</td>
<td>set to DN Type = 4</td>
</tr>
<tr>
<td>No Answer Destination</td>
<td>set to DN Type = 4</td>
</tr>
<tr>
<td>Personal Assistant</td>
<td>delete silently</td>
</tr>
<tr>
<td><strong>Extension List</strong></td>
<td>-----------------</td>
</tr>
<tr>
<td>User Ext List</td>
<td>delete silently</td>
</tr>
</tbody>
</table>

| User Call Handling Modes Defaults | -----------------|
| Always Destination:              | set to DN Type = 4 |
| Busy Destination                 | set to DN Type = 4 |
| No Answer Destination            | set to DN Type = 4 |
| Personal Assistant               | delete silently  |
| Call Handling Modes Delegation   | delete silently  |

| Bridge Call Appearance (BCA)     | -----------------|
| Backup Extension                 | delete silently  |
| Call Stack Full                  | delete silently  |
| No Answer                        | delete silently  |
| System Dist Lists                | delete silently  |
| WorkGroup                        | delete silently  |
| Backup Extension                 | set to DN Type = 4 |
| Call Handling Modes Work Group Assistant | delete silently |
| Work Group Assistant             | delete silently  |
| Members (Work Group Agents)      | manual deletion required |
| Queue Handling Steps (Operation)  | manual deletion required |
| Over Flow DN (Queue Handling Steps) | manual deletion required |
### Table 153: Centralized Dial Numbers (DN) Table (Continued)

<table>
<thead>
<tr>
<th>Deleting an Extension</th>
<th>System Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route Point</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Call Handling Modes</td>
<td>set to DN Type = 4</td>
</tr>
<tr>
<td>Assistant</td>
<td>delete silently</td>
</tr>
<tr>
<td>AA Menu</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Extension in Steps</td>
<td>manual deletion required</td>
</tr>
<tr>
<td>Group Paging</td>
<td>delete silently</td>
</tr>
<tr>
<td>Pickup Group</td>
<td>delete silently</td>
</tr>
<tr>
<td>AMIS</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Delivery Number</td>
<td>no impact</td>
</tr>
<tr>
<td>Callback Number</td>
<td>no impact</td>
</tr>
<tr>
<td>COST/ClassofService</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Directed Pagin</td>
<td>delete silently</td>
</tr>
<tr>
<td>Barge In</td>
<td>delete silently</td>
</tr>
<tr>
<td>Record Other's Calls</td>
<td>delete silently</td>
</tr>
<tr>
<td>Silent Monitor</td>
<td>delete silently</td>
</tr>
</tbody>
</table>